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Spike2 version 11

With Spike2 version 11 and a modern CED 1401 interface (Powerl1401, Power1401 mk II, Power1401-3,
Micro1401 mk II, Micro1401-3 or Micro1401-4), you can capture and analyse waveform, event and marker
data and output precisely timed pulses and voltages using the familiar and easy to use Windows environment. If
you have a 1401plus or the original micro1401 you can capture date with Spike2 version 7, which is also on the
installation medium. You can extend your data capture, or capture data without a 1401 using Talker interfaces.

You can arrange the windows to display the data within them to best advantage and cut and paste the results to
other applications. Alternatively, you can obtain printer hard copy directly from the application. When you
close a data file, Spike2 saves the screen format and channel display settings. When you open a file, Spike2
restores the configuration, so it is easy to resume work where you stopped in a previous session.

You can analyse sections of data by reading off values at and between cursors, or by applying the built-in
functions, for example waveform averaging, digital filtering, spike detection, histogram formation and power
spectra. More ambitious users can automate both data capture and analysis with scripts and the output
sequencer.

New features in version 11

We have tried very hard to keep version 11 of Spike2 compatible with version 10. It reads data files from all
previous versions. Resource files are compatible; some resource formats are extended to support new features.
Scripts that ran with version 10 should work unchanged with version 11 unless they used some of the new built-
in functions as names. New features in version 11 include:

e The Sampling configuration can now hold a list of pre-set TextMark data items that can be applied during
sampling.

¢ Improvements to interactive use of TextMark data during sampling..

e TextMark data captured from serial line inputs can trigger the output sequencer and arbitrary waveform
output.

e Overdraw list dialog supports addition of arbitrary trigger times.

¢ 3D Overdraw adjustment by dragging.

¢ Info windows can now display recent TextMark text or Marker channel codes.

¢ Active Horizontal cursors have two new modes: Median and Median + factor * size.

e Graphical sequencer improvements including a visual indication that a Wait command interrupts the time
base and a time out when waiting for a digital input change.

There are many other improvements and more are planned. You can find a full list of new features, bug fixes
and changes in the Revision History. Licensed users of Spike2 version 11 can download updates of version 11
from our Web site ced.co.uk as they become available.

Hardware required

The minimum supported system for Spike2 version 11 is a computer running Windows 10 on an x86 or x64
CPU with at least 4 GB of memory. It may run on older operating system, in virtual machines or on different
CPU types using emulation, but we do not test or support this. The more powerful the processor and the more
memory your system has, the better Spike2 runs. If your CPU is 32-bit only (very old), it must support the
SSE2 instruction set. If your CPU is 64-bit, the Spike2 installer will install a 64-bit version of Spike2 unless
you choose Custom install and select a 32-bit version.

To sample data, you need a CED Power1401 or a Micro1401 (mk II, -3 or -4) or a suitable Talker. See the
Owners Handbook that came with your 1401 for hardware installation instructions. Spike2 comes with all
required 1401 drivers and will install the Try1401 test program to verify correct 1401 operation.

File icons

The various file types in Spike2 have similar icons so that you can recognise them in directory listings. If your
file icons do not display correctly, run Spike2 once as Administrator to allow it to register the file types. To do
this, right-click the Spike2 application and select Run as Administrator. You will be asked if it is OK for
Spike2 to make changes to the system (which you must allow). This will then trigger a rebuild of all the system
icons (which can be slow). After this, the icons should be correct.

This is the Spike2 application icon that you double-click to launch Spike2.
|||I_
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nP- q The icon on the left is for Spike2 data files. The icon on the right is for saved result views. The
o dlf| central icon is for an XY file. If you double-click one of these it will launch the Spike2
application (if it is not already running) and open the file.

it

Spike2 can output sequences of pulses, sine waves and voltage levels as it samples data. Output
sequence files have this icon.

This icon is for Spike2 script files. A Spike2 script can automate data capture and analysis
operations and extend the capabilities of the Spike2 program.

1]l [0k

This is the icon for Spike2 grid files. Grids are useful for storing and presenting tables of
information. Columns can be left, right or centre aligned.

The icon on the left is for CED configuration files; these hold all the information needed to
sample a new data file. The icon on the right is for CED resource files; these are usually
associated with a data file and control how it is displayed.

=l
&

Direct access to the raw data

Some users may wish to write their own applications that manipulate the Spike2 data files directly. A C library
Spike2: Son data storage library is available from CED together with documentation sufficient for an
experienced C programmer to use it. This library is for the 32-bit library, as used up to version 7 of Spike2. The
library documentation is also available as a PDF file on the Spike2 distribution CD. To install it, select Custom
Install and check the Additional documentation box.

The library used by Spike2 version 11 is written in C++ and includes the old 32-bit library. The interface has
similar functions (in most cases there is a one to one mapping between the old functions and the new), but it is
written taking advantage of the features of C++ and can be used to manipulate both the old and new files. There
is a MatLab interface to the new format available on our web site. This interface can also be used from other
languages that can access external DLLs.

Printed manuals

Since Spike2 version 8, we no longer provide printed manuals. This is to save paper (the manual is more than
1000 pages), reduce shipping costs and to reflect the fact that few users read them as the on-line and context
sensitive help is much easier to use. You can get help in Spike2 in most situations where the system is waiting
for input from you by pressing the F1 key or clicking a Help button. There are two PDFs of the on-line help on
the distribution disk. These are mechanically generated from the on-line help (that is, it is not hand-optimised
for reading as a manual). One version, spikell.pdf, is intended for use in a PDF reader and includes
highlighted links, the other, spikellprint.pdf (the version you are reading), is intended for printing and
does not include highlighted links (so there may be invitations to find more information "here" that make no
sense).

Upgrading from earlier versions

Sampling configurations from Spike2 version 7 or earlier write 32-bit smr files for backwards compatibility.
Use the Sampling Configuration dialog Resolution tab to change to the new format. Although we allow
sampling to old smr files, the program is optimised for the 64-bit smrx file format. Sampling to the 32-bit
format is slower as we convert data from 64-bit to 32-bit. Unless you have pressing reasons for sticking with the
32-bit format we encourage you to migrate to the 64-bit format.

Scripts that explicitly use smr file extensions (32-bit files) will need modification to work with smrx files.
However, if a file with a smr extension fails to open as a 32-bit file we try to open it as a 64-bit file, so a short
term fix is to change the 64-bit file extensions to smr.

Feature 64-bit smrx file 32-bit smr file

Maximum file length in clock ticks More than 108 2x10°

Maximum file length with 1 ps tick 255 thousand years 35 minutes 47 seconds
Maximum file size in bytes 16 EB (16 million TB) 2 GB or 1 TB (big file)
Maximum channels in a file 65534 (2000 in Spike2) 451

Big file data search time proportional to Log(file size) file size

Waveform channel gap overhead 16 bytes 0-32746 bytes, average 16374

This table compares some of the features of the two filing systems. The 64-bit system is designed with future
developments in mind, the idea being that it is the basis of a format that can remain stable for many years.
Particular emphasis has been placed on coping with very large files and long run times.
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Old-style configuration and resource files

Spike2 originally used binary configuration and resource files, stored in files with the extensions s2c and s2r.
In version 7.11 (in February 2013) we stopped writing the binary format and changed to using XML format
files with extensions s2cx and s2rx, which gave us more flexibility. Spike2 versions 7 and 8 continued to read
the old format, but only wrote the new format. Spike2 versions 9 onwards no longer read the old format; if you
must read the old formats, install version 8 and use it to write files with the new format. To convert
configuration files, load the old configuration into version 8, sample data with it, then save the configuration.
To convert resource files, open the associated data file, then close it.

On-line Help

There is on-line Help available in the program, usually activated by the F1 key or by clicking a Help button.
The help is generally context-sensitive, which makes it easier to use than this manual (even if used in a PDF
reader) as it will often open at exactly the information you require. The manual you are reading is mechanically
generated from the on-line Help and although there are differences between the on-line help and this manual,
the main emphasis has been on making the on-line help as useful as possible. The result is that sometimes, the
order of information in this manual will suffer.

CED Software Licences

CED software is protected by both United Kingdom Copyright Law and International Treaty provisions. Unless
you have purchased additional licences as described below, you are licensed to run one copy of the software.
Each copy of the software is identified by a serial number that is displayed by the Help menu About Spike2...
command. You may make archival copies of the software for the sole purpose of back up in case of damage to
the original. You may install the software on more than one computer as long as there is No Possibility of it
being used at one location while it is being used at another. If multiple simultaneous use is possible, you must
purchase additional software licences.

Additional software licences

The original licensee of a CED software product can purchase additional licences to run multiple copies of the
same software. CED does not supply additional software media. As these additional licences are at a
substantially reduced price, there are limitations on their use:

1. The additional licences cannot be separated from the original software and are recorded at CED in the name
of the original licensee.

2. All support for the software is expected to be through one nominated person, usually the original licensee.

3. The additional licensed copies are expected to be used on the same site and in the same building/laboratory
and by people working within the same group.

4. When upgrades to the software become available that require payment, both the original licence and the
additional licences must be upgraded together. If the upgrade price is date dependent, the date used is the
date of purchase of the original licence. If some or all of the additional licences are no longer required, you
can cancel the unwanted additional licences before the upgrade.

5. If you are the user of an additional licence and circumstances change such that you no longer meet the
conditions for use of an additional licence, you may no longer use the software. In this case, with the
agreement of the original licensee, it may be possible for you to purchase a full licence at a price that takes
into account any monies paid for the additional licence. Contact CED to discuss your circumstances.

6. If you hold the original licence and you move, all licences are presumed to move with you unless you notify
us that the software should be registered in the name of someone else.

Installation

Your installation media is serialised to personalise it to you. Please do not allow others to install unlicensed
copies of Spike2.

You can run the installation by opening the folder Spikell on the installation media, then open the diskl
folder and run setup.exe.
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During installation

You can have multiple Spike2 versions on the same system as long as they are in different folders. The
installation program will propose a standard location for Spike2 which differs for each major version (Spike9,
Spikel0, Spikell...). You can modify the folder name and, if you wish, you can install in a non-standard
location (not recommended). If you want to keep a previous minor revision of Spike2, we suggest you modify
the proposed folder name by appending the minor revision, for example Spikel10 01. You must personalise
your copy with your name and organisation.

The installation program copies the Spike2 program plus help, demonstration, example and tutorial files. It also
copies and installs all required 1401 support (device drivers and control panels). In rare cases you may need to
install the drivers manually; the installation program will tell you if this is the case and give you detailed
instructions. Your system may require a restart after installation to get all drivers up to date.

The installation process creates several folders for use by Spike2. Some of these folders are created for the user
account under which Spike2 was installed. If you run Spike2 from another account, Spike2 attempts to create
the missing folders, but if it fails you may need Administrator assistance.

Due to driver signing requirements in 64-bit versions of Windows 10, if you install Spike2 onto a new
Windows 10 system that has never seen a 1401 driver before, the driver must be signed for the new version of
Windows. We cannot sign drivers until Microsoft releases the tools to do this, so you may find that a previous
Spike2 installation will install the program, but the 1401 driver will not work. You can get the latest 1401
support from our web site.

Custom install

To install without 1401 support, or to copy additional documentation or to exclude example Talker support,
choose Custom installation. You can run the installation multiple times to the same folder to apply different
Custom options. Installations will not delete files that you have created in data directories.

After Installation

If you are new to Spike2, please work through the Getting Started tutorial. Where you go next depends on your
requirements. The Spike2 Training Course Manual is more descriptive than this help file, which is organised as
reference material. The Training Course manual covers all versions of Spike2 and you will occasionally need to
refer to this on-line Help for version 11 specific details. If you prefer printed documentation, there is also a
PDF version of this manual.

Where is Spike2 installed?
Unless you specifically choose a folder for installation, Spike2 version 11 is installed into:

"Program Files"\CED\Spikell

"Program Files" is typically:

C:\Program Files

but could be on a different drive. If you install a 32-bit version of Spike2 on a 64-bit system, the folder is:
C:\Program Files (x86)

This folder path is protected; you need Administration rights to modify files in the Spike2 installation folder.

Updating and removing Spike2

You can update your copy of Spike2 to the latest release from our Web site: ced.co.uk. You can only update a
correctly installed and licensed copy of Spike2 within the same major version. There are full instructions for
downloading the update on the Web site. If your copy is not the latest major version you can upgrade to the
latest major version by purchasing an Upgrade.

Once you have downloaded the Spike2 update, you will find that the update program is very similar to the
original installation, except that you must already have a properly installed and licensed copy of Spike2 for
Windows on your computer.
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Updates will include both bug fixes and new features. If we know your email address we will notify you of new
releases. You can also register for this service on our web site. To stop emails, reply to them and ask to be
removed from the list.

Support and development policy

We actively develop the latest major release of Spike2, and support (that is make our best efforts to fix bugs) in
the latest major release and the previous major release. We may choose to make changes to older versions for
reasons of backwards and forwards compatibility. We will always answer questions and give advice on working
with older versions; however in some cases the advice might be that upgrading to the latest version is the best
way forward.

Removing Spike2
To remove Spike2: open the system Control Panel, select Add/Remove Programs, select CED Spike2
version 11 and click Remove. This removes files installed with Spike2; you will not lose files you created.

Versions of Spike2

This manual describes Spike2 for Windows version 11. We have generated the following versions of “Spike2
for ...”, listed in more or less chronological order of release:

DOS Data and output sequencer files are still readable with later versions of Spike?2.

Macintosh 68k Data files, scripts and output sequences are compatible with later versions.

Windows version 2 This version ran on Windows 3.1 and 3.11.

Macintosh PowerPC This was equivalent to Spike2 for Windows version 2. The last Macintosh version.

Windows version 3 The last version to sample with the standard 1401.

Windows version 4-6 These versions of Spike2 do not support the standard 1401.

Windows version 7 The last version to sample with a 1401plus or the original micro1401 (Microl).

Windows version 8 Introduced the new 64-bit smrx filing system. It runs in Windows XP service pack
3 onwards.

Windows version 9 Allowed up 2000 data channels, more arbitrary waveforms, Talker-only sampling.
Windows 7 onwards.

Windows version 10 Added Info windows, real-time data processing and derived channel, variable
length gating...

Windows version 11 The version described in this manual. It runs in Windows 10 onwards.

You can read about all the version of Spike2 on our web site, here.

We continue development of the latest released version, adding new features and improving the existing code.
We actively support (fix bugs) in the latest released version and the one before that. We may choose to fix bugs
in earlier versions, and may even add features for forwards compatibility. We will always offer help,
workarounds and advice for users of older versions, but that advice may be: 'you should upgrade to the latest
version' - especially if the problem is related to changes in the operating system.

Spike2 version references

We mark features that do not exist in earlier versions of Spike2 with [M.nn], where M is the major version and
nn the minor version of Spike2 in which it first appeared. You can assume that all higher versions have this
feature. If a feature is marked with two or more versions, for example [8.17, 9.03] this means it was added at
versions 8.17 and 9.03 and is present in all version 10, 11 and later releases.

In the case of script documentation, if you use a marked feature, your script will not work on earlier versions.

You can find the full list or revisions, fixes and changes in the current major version of Spike2 here. The list of
previous major versions of Spike?2 is here.
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CED 1401 interfaces

The 1401 family of interfaces are intelligent peripherals that generate and receive waveform, digital and timing
signals. Using their own processors, clocks and memory, under the control of the host computer, they make
complex real world jobs easy to control. In 2022 there are eleven family1401 family members: standard 1401,
1401plus, microl401, Micro1401 mk II, Microl1401-3, Powerl401, Power1401 625, Power1401 mk II,
Power1401-3, Power1401-3a, Micro1401-4. We place a lot of emphasis on software compatibility; it is easy to
write programs that can drive all the family members.

Obsolete and Modern 1401s

The standard 1401 and 1401plus are obsolete and not supported by Spike2, though a few still survive more than
30 years after issue. They interfaced to the host computer via a proprietary CED interface card that was
implemented initially with an ISA interface, and later a PCI interface. The term Modern 1401s refers to all units
after these.

The standard 1401 (first available in 1984, now obsolete)

The standard 1401 had a 4 MHz, 8-bit processor, a 12 us ADC (Analogue to Digital Converter) for sampling
16 channels of waveform data with a separate processor (the Z8 channel sequencer) for automatic channel
changing and burst generation, 4 DACs (Digital to Analogue Converters) for waveform output, five clocks,
event inputs, digital input and output with clock links and a memory space of around 60 kB for data and
commands.

The last Spike2 version to support the standard 1401 was Spike2 version 3.

Front panel of 1401 and 1401plus

DAC (Digital to Analogue Converter) The 5 clocks in 1401 can either
outputs for waveform and voltage run from the internal crystal source
levels.The Bri output is used as a or from an external signal on the

bright up pulse when DACs 0 and 1 Tpe Test lamp indicates appropriate F input. Out is the
drive a sco e (see the D command)  opropg during system output from clock 2.

self-test anf during use.

SRICE cséoéééﬂﬂ

ols ¢ 6 66&)“66665‘

The 5 clocks can be controlled
by external signals on the E
inputs. Some applications use
these as timing inputs ,others

ADC (Analogue to Digital Converter)
inputs for reading waveform and
voltage inputs. Channels 0-7 have

The Digital input and
output ports provide 24 bits

BNC inputs. Channels 8-15 are on o otk this cldeke. of digital control with clocked
the Cannon connector. Ext is the output options and the ability
ADC External convert input. to time input changes.

In addition, there were several option cards that included:

MassRAM card for 2 or 8§ MB of extra data storage memory and faster sampling
Expansion of the 16 ADC channels to 32 channels

Programmable 8 channel event detector

Programmable gain and filter card options

Fixed gain and filter cards

The 1401plus (first available in 1991, now obsolete)

The 1401plus used a 20 MHz 32-bit processor for 20-40 times more processing power and increased the data
space from 59 kB of the standard 1401 to more than 900 kB (16 MB with expanded memory). It was hardware
compatible with the standard 1401.

The 1401plus supported the same options as the standard 1401 except for the MassRAM, which was emulated
by a 1401plus with expanded memory. It used the same analogue card as the standard 1401 with the Z8 channel
sequencer. However from 1993 it was fitted with a more advanced analogue card ‘Issue-M’ Channel Sequencer
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with a fast 3 us ADC complete with ADC-silo and high-performance hardware sequencer. There were also
analogue card options with 2.5 and 10 ps 16-bit ADC and 4 16-bit DACs for higher accuracy.

The last Spike2 version to support the 1401plus was Spike2 version 7.

The micro1401 (first available in 1996)

The microl1401 (microl) had the speed and almost all the features of a 1401plus with the issue-M analogue
card, packed into a much smaller space. Some sacrifices were made in the basic unit; there are only 4 ADC
channels and 2 DAC channels as standard. However, there are benefits too: it is small and easily portable, all
inputs have LED indicators to show when inputs or outputs are in use, interrupt driven commands generally run
faster than 1401plus, trigger inputs (as seen by the user) are easier to understand and the unit can be expanded
with more channels. It also has the option of a USB interface.

The last Spike2 version to support the micro1401 was Spike2 version 7.

micro1401 front and rear panels

MICRO
1401

Test

Host interface Digital inputs Digital outputs Events Serial No: 0 Power in

The Power1401 (first available in 2000, Power1401 625 in 2004)

The Power1401 (Powerl) took the best features of the 1401p/us and the micro1401 and added a more powerful
processor (up to 30 times faster than the micro1401 or the plus), a 16-bit analogue section and up to 256 MB of
memory. Like the plus, it has 4 DAC channels and 16 ADC channels as standard, like the micro it has a small
chassis and LED indicators. It also supports both the standard 1401 interface (ISA or PCI bus) and USB 1. The
software and hardware configuration is held in flash memory and can be updated without opening the unit. The
Power1401 625 was a revision in 2004 with USB 2 and faster multi-channel sampling.

Power1401 front and rear panels

Hasi interipee

The Micro1401 mk Il (first available in 2001)

The Microl401 mk II (Micro2) looks like the original micro1401 from the front, but it takes much of the
internal structure from the Power1401. The processor is more than three times faster than the micro1401, it has
a 16-bit 500 kHz ADC, a memory size of 1 or 2 MB and has firmware stored in flash memory for easy update
without opening the box. It supports both the standard CED interface and USB.

Micro1401 mk Il rear panel

Host Interface ."":'\\ use Digital Inputs Digital Outputs Everts

)

The Power1401 mk Il (first available in 2007)
The Power1401 mk II (Power2) is similar to the Power1401, but with a processor some 3 times faster, up to 1
GB of memory and a faster multi-channel sample rate. It has a USB 2 interface.
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The Micro1401-3 (first available in 2009)
The Micro1401-3 (Micro3) is very similar in appearance to the mk II, but has a faster processor, 4 MB of base
memory and 16-bit DACs in place of the 12-bit DACs of the mk II. It has a USB 2 interface.

The Power1401-3 (first available in 2012, -3a in 2016)

The Power1401-3 (Power3) is similar to the Power1401 mk II, but with a faster processor, up to 2 GB of
memory and a USB interface that has about twice the throughput. The Power1401-3a was available from 2016
and has the same processor with a faster ADC block and FPGA and provision for more DACs. It uses the same
loadable commands as the Power1401-3.

The Micro1401-4 (first available in 2019)
The Microl1401-4 (Micro4) is similar in appearance to the Micro1401-3, but uses a different and much faster
processor (typically 3 to 8 times faster) and 32 MB of memory. It has an option to fit 2 extra DACs.

Software compatibility

All members of the 1401 family use the same software interface. It is easy to write applications that will run
with any 1401. The language support libraries are written to conceal differences between family members;
however, applications that wish to take advantage of 1401-specific features are also supported.

Downloadable commands

The basic capabilities of each 1401 can be extended by loading '1401 commands' into each 1401 to add
additional functionality. The commands used by Spike2 are held in the 1401 folder inside the folder holding the
Spike2 program. The loadable commands for the 1401 types have different file extensions:

1401 type  Microl Powerl Micro2 Power2 Micro3 Power3(a) Micro4

Extension arm arn aro arp arqg arr ars

The commands used by Spike2 version 11 are:
Name Purpose
DADC  Used when setting up signal conditioners to monitor the waveform input.

MEMDA Replay of waveform data through the 1401 DACs when not sampling data.
C

SP11D Arbitrary waveform output through the 1401 DACs during data capture.
AC

SP11D The main command that controls the 1401 during sampling and handles data transfer between the 1401
1G  and the PC.

SP11F Setting up WaveMark (spike shape) data capture.
CH

SP11P Implements the output sequencer.
UL

SP11T Implements real-time WaveMark (spike shape) template matching.
MP

For example, the command used for the output sequencer in the Micro4 is:
PathToSpike2\1401\SP10PUL.ars

Nomenclature

In this document ‘1401’ refers to all 1401 family types. To be specific we use ‘micro1401°, ‘Micro1401 mk II,
‘Microl401-3°, ‘Powerl401°, ‘Power1401 625°, ‘Power1401 mk II’ and Power1401-3. As shorthand, we also
use ‘microl’, ‘Micro2’, ‘Micro3’, ‘Micro4’, ‘Powerl’, ‘Power 625, ‘Power2’, ‘Power3’ and ‘Power3a’.
Micro1401 means mk II, -3 and -4, micro1401 (lower case) is the original.
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Getting started with Spike2

This tutorial teaches you the basic operations that manipulate Spike2 data files. Spike2 is a large program with
many features; this short tutorial will get you started finding your way around.

Demonstration script

There is a demonstration script supplied with Spike2, called BaseDemo. s2s, that will give you an introduction
to interacting with Spike2 data files using the keyboard and mouse.

Use the Help menu Getting started... command to load and run the BaseDemo script. If this command is
disabled, it means that Spike2 could not locate the script; re-installing Spike2 should restore it. You can control
the script by clicking buttons or using the keyboard. Please remember to click OK or press the keyboard Enter
key to keep the demonstration moving. If you prefer to just watch the demonstration, start it and click the
Options button. Set the Auto OK time to 2 (this is how long to wait, in seconds, before the demonstration
moves on).

If you are running the demonstration version of Spike2, you will find that this script has already been loaded for
you. You will only need to select it from the list when you use the Script menu Run Script command.

The demonstration script loops back to the start, so you will need to interrupt it to continue with the tutorial. Hit
the Exit! button on the toolbar at the top of the screen to stop it running.

There are video tutorials for various aspects of Spike2 on our web site: http://ced.co.uk/tutorials/introduction

If you are not a fan of demonstration scripts or videos, you can get an introduction by reading on...

Opening a file to view

In this step you will open the demonstration data file that was shipped with Spike2. Follow these steps:

1. Open the File menu and select the Open... command

2. Navigate to My Documents folder and within that there should be a Spike11 folder (Spike2 Demo in the
demonstration version) and within that Data; open Data and double click on demo.smr (if you have
moved files since your installation you may have to search around to find this file, if all else fails, use any
Spike?2 file). Spike2 can read data files with the extensions . smr (an old format file with 32-bit times and a
maximum size of 1 TB) and . smrx (a new format file with 64-bit times and a maximum size limited by the
operating system).

3. A new window will open. Arrange the help window and this new window so that you can see both.

4. To follow the tutorial, you should see a window holding at least one data channel and with a horizontal
scroll bar at the bottom. If this is not the case your file is in a mess!

Spike2 displays the file in the state in which it was last saved (as long as it can find a file with the same name
and the extension .s2rx). You are looking at the raw data in the file. We call this a time view because it
displays a time history of the data and the axis at the bottom is in seconds.

Clean up a messy file

You can tidy up by following these instructions:

1. Click on the window titled demo . smr
2. From the View menu select the Standard Display option

3. If the fonts used seem too large or too small open the View menu Font dialog and select Times New
Roman, Regular 10 point

4. If the colours are grotesque open the View menu and select the Change Colours... option and click Reset
for a standard colour scheme or choose a better combination. As a last resort, the View menu Use Black
And White converts everything into a black foreground and a white background.
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Data channels and channel numbers

There are several data channels displayed in the window. These channels can hold different types of data:
channel 1 holds a waveform, channels 2 and 3 holds events and channel 31 holds keyboard markers.

# Selecting channels

You select channels by clicking on the channel number. The channel number is usually to the left of the
channel, but can also be on the right if this is selected in the View menu Show/Hide Channel dialog. If the
channel number has been hidden you can click the region a few pixels wide in the place where the channel
number would be if it were displayed. Spike2 highlights the channel number. Hold down the shift key and
click on a channel to select all channels between it and the last selection. Hold down ctrl to select
discontinuous channels. Several commands work on a list of selected channels (for example y axis display
optimisation).

The mouse pointer changes when you move it over a channel number to remind you that you can select the
channel.

Deselect and select all channels

If any channel is selected, you can deselect all channels by clicking in the empty screen area below the channel
number, title and y axis. The mouse pointer includes a # when you are over this region to remind you it is
active. If you click here with no channel selected, all channels are selected. You can also use the Ctr1+a key
combination to select all channels, or if all channels are selected to clear all channels.

Channel modified indicator

If the channel number is displayed in red, this means that the channel data has a Channel process or a Marker
Filter applied to it or is not displaying the first marker code. If you hover the mouse over the channel y axis
area, a tool tip will appear that has more information about the modified status of the channel. From [10.02] this
also works for hovering over the channel number area.

Overdrawn (grouped) channel identifier
If you overdraw channels the channel numbers take the main colour used to draw the channel data, which can
help you to know which channel is which (but only if you give the channel different colours).

Zoom buttons

The bottom window edge holds four buttons and a scroll bar. The scroll bar controls movement through the file.
If you resize the window, the same data is drawn, scaled to the window. The two buttons to the left of the scroll
bar change the time range.

rf'? This button halves the time range (zoom in). The left edge of the display remains fixed. You can zoom
4 in until the display is one time unit wide.

.}:.!ﬂ This button doubles the time range (zoom out). The left edge of the window does not move unless the
I start plus the new width exceeds the length of the file. If the new width exceeds the file length, the
entire file is displayed.

X axis short cut keys

The following short cut keys combinations can be used to navigate the x axis:

Key Operation

Left arrow Scroll 1 pixel left.

Right arrow  Scroll 1 pixel right.
Shift+Left Scroll several pixels left.
Shift+Right  Scroll several pixels right.
Ctrl+Left Scroll half a screen left.
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Ctrl+Right Scroll half a screen right.

End Scroll to the end of the data.

Home Scroll to the start of the data.

Ctrl+k Expand (zoom out) the data view around the left edge of the window.
Ctrl+4R Reduce (zoom in) the data view around the left edge of the window.
Ctrl+U Expand (zoom out/Up) the data view around the centre of the window.
Ctrl+l Reduce (zoom In) the data view around the centre of the window.

Time views only

Key Operation

Ctrl+Shift+Le Search selected event channels for the previous event that is nearest to the centre of the

fr screen and make it the centre or make a sound if there are no selected channels or no more
events.

Ctrl+Shift+Ri Search selected channels for the next event that is nearest to the centre of the screen and

ght make it the centre of the screen or make a sound if there are no selected channels or no more
events.

Alt+Shift+Lef [f Triggered display mode is enabled, steps to the previous event or by a page.
t

Alt+Shift+Rig If Triggered display mode is enabled, steps to the next event or by a page.
ht

The full list of keyboard commands in a data view can be found in the General information chapter.

Cursor buttons

Vertical
This button adds a vertical cursor to the display (up to 10 vertical cursors can be present in a window).
A cursor is a dashed line used to mark positions. You remove cursors with the Cursor menu Delete
option. You can add vertical cursors in five ways.

1. Click and release the button to add a cursor in the centre of the window.
2. The Cursor menu New cursor command adds a cursor in the centre of the window.

3. Click and release the right mouse button at the position where you want the new cursor. When the context
menu appears, select New Cursor and a cursor will appear at the mouse click position.

4. The short cut keys ctr1+0, Ctrl+1 through Ctr1+9 place cursors 0 to 9 in the centre of the window.

5. From a script you can use the CursorNew () or CursorSet () commands to create cursors. Script users
have more control over cursors and can set custom cursor labels.

You can also use a short cut key to scroll the x axis to locate a cursor. Ctr1+Shift+0 through Ctrl+Shift+9
will scroll so that the selected cursor is as near to the centre of the window as possible. You can read more
about vertical cursors in the Cursor menu chapter.

Beware that Microsoft have grabbed ctrl+shift+0 for IME language from Vista onwards. You can get
instructions to defeat this in the Technical support, Frequently asked questions.

Horizontal

"~ | There are also horizontal cursors. A horizontal cursor belongs to a channel and has a value that

@l matches the channel y axis. You can use them in dialogs that expect a y axis value and they are often
used as part of a script. You can create them interactively from the cursor menu or from the right
mouse click context menu or by clicking the horizontal cursor button. Click the button to add a new
horizontal cursor to the lowest channel with a y axis on the screen. If channels are grouped, the head
channel of the group gets the cursor. You can read more about horizontal cursors in the Cursor menu
chapter.
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Cursor style and pointers

Click on the cursor button so that at least one vertical cursor is visible. The mouse pointer changes over a
cursor or a cursor label:

—* This indicates that you can drag the cursor. If you drag beyond the window edge, the window scrolls.
The further beyond the edge, the faster the scroll. Dragging hides the label unless the ctr1 key is down
or you drag the label. If a horizontal cursor is outside the range of the y axis of a channel, you can still
see the cursor label and even drag it sideways. Hold down ctr1 and click and drag to bring it back into
the channel area.

4%; I If you position the mouse pointer over the cursor label, the pointer changes to a 4-headed arrow to
indicate that you can drag both the cursor and the label. This can be useful when preparing an image
for publication and you need the cursor label to be clear of data. If you move the pointer to one side, or
hold down the shift key, the pointer becomes a two-headed vertical arrow and you can drag the label,
but not the cursor. If a cursor is off the edge of the display area and you can still see the label, hold
down ctrl and click and drag to move it back into view.

There are four labelling styles for the cursor: no label, position, position and cursor number, and number alone.
You select the style with the Cursor menu Label mode option.

Active cursor modes

Type ctrl+0 to centre cursor 0 on the screen. Drag any other cursors away from cursor 0. Now right click on
cursor 0 and select Cursor 0->Active mode... from the context menu to open the Cursor mode dialog.

All vertical cursors can be Static or Active. A static cursor stays where you leave it. An active cursor can
reposition itself by searching for user-defined data features.

Set cursor 0 to Peak find on channel 1. Set Amplitude to 0.1, Minimum Step to 0 and click the OK button.
Now try the Ctrl+shift+Right key combination (Right is the right arrow key). Each time you press these
keys, cursor 0 seeks the next peak on channel 1 that is at least 0.1 y axis units high. Ctrl+Shift+Left moves
cursor 0 in the opposite direction. You can set any vertical cursor into active mode. When cursor 0 moves, any
other active cursors apply their search method in rising cursor number order.

There are a wide variety of search methods that can be used to locate data features. You can read more about
active cursors in the Cursor menu active cursors description, or by pressing the 1 key when the Cursor mode
dialog is open. For now, leave cursor 0 in Peak search mode and move on to the next step.

Automatic measurements to XY view

Now use the Analysis menu Measurements->XY view command to open the Settings for XYPlot dialog.

This dialog lets us take a set of measurements over a time range and generate a graph which you can print, save
or copy as either a picture or as a table into other applications. It is likely that the dialog settings will be suitable
for this demonstration, but check that the Cursor 0 stepping region holds: Channel=1 Sinewave, Method=Peak
find, Amplitude=0.1 and Minimum step = 0. Make sure that the Ignore cursor step if field is blank and that
the User check positions box is not checked.

Check in X Measurements that: Type=Time at Point, Time=Cursor(0). Check in Y Measurements that:
Type = Value at Point, Channel=1 Sinewave, Time=Cursor(0), Width=0.

Finally check that Points=0 and then click the New button. The Process XYPlot dialog opens so that you can
set the region of the data file to analyse. It should hold a sensible start and end time range, so just click the
Process button.

Spike2 will generate a new window that displays a graph of the x and y measurements. In this case you will get
a graph of peak amplitudes against time in seconds. You can adjust the appearance of the new XY view
(remove joining lines, change the markers used for each data point , and the like), but we are here for a quick
tour, so close the XY view (click in the X box at the top right).

To find out more about the measurement system you can read more in the Analysis menu Measurements
description or press the F1 key in the Settings for XYPlot dialog.
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Zoom in on an area

Move the mouse pointer to the waveform channel. Click the left mouse button and drag a rectangle round a
waveform feature and release the button. The window displays the area within the dragged rectangle. If the
rectangle covers more than one channel, only the time axis changes. If your rectangle lies within a channel and
has zero width, only the y (vertical) axis changes. If you drag past the right or left edge of the window, the view
scrolls sideways.

The mouse pointer changes to a magnifying glass when you hold the left mouse button down in the data
channel area to show that you are about to magnify the data.

If you hold down the ctrl key and left click, the mouse pointer is the zoom out symbol and the
% rectangle holding the channel area shrinks to the rectangle you drag

Whichever method you use to scale the data, you can return to the previous display using the Edit menu Undo
command or the keyboard short-cut ctr1+z. If you release the mouse button with the pointer in the same
position from which you started the drag, the display does not change.

On screen measurements

If you hold down the A1t key before you click and drag, Spike2 displays the size of """""""""
the dragged rectangle next to the mouse pointer and does not zoom the display. With “
the mouse button held down, release Alt, then use the C key to copy the current
measurement to the clipboard or the T key to copy it to the Log view.

' 0.00334s, 39.60uV

Zoom a channel

You can zoom one channel to use the entire display area!
Double click anywhere in the waveform channel. The channel will expand to occupy the entire window.
Double click in the waveform channel again and your previous display is restored.

You can also change the display to show a channel and all duplicates of it by holding down the ctrl key, then
double-clicking on a channel. This is useful with sorted spikes, where duplicates of a channel are used to
display spike classes.

Double clicking a channel works with Time view (and Result view) channels. Before Spike2 version [10.12] it
worked only for channels that have a y axis.

Using x and y axes to scroll and zoom

[\}E [% When the cursor is over the tick marks of an axis, you can drag the axis. This maintains the current

+—+ axis scaling and the window moves to keep pace with the mouse pointer. You can do this with
most x and y axes in Spike2. This is particularly useful for y axes as they do not have a vertical
scroll bar. The window does not update until you release the mouse button. If you hold down the
ctrl key, the window will update continuously.

+

F- [% When the cursor is over the axis numbers, a click and drag changes the axis scaling. The effect

% ¥ =z depends on the position of zero on the axis. If the zero point is visible, the scaling is done around
the zero point; the zero point is fixed and you drag the point you clicked towards or away from
zero. If the zero point is not visible, the fixed point is the middle of the axis and you drag the point
you clicked towards and away from the middle of the axis

In a time view, result view, or XY view, you can drag the y axis so as to invert the axis. You can prevent this
happening by setting an option in the Edit Preferences command Display tab. You are not allowed to invert the
X axis. You are not allowed to invert or scroll the y axis in the spike shape dialogs.

Spike2 hides horizontal cursors when you drag the y axis. This makes the drag operation a bit faster, but is
mainly done because when filled cursors were set, dragging the y axis (particularly during data sampling) could
cause the screen area behind a label to become a mess until the drag ended.
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X Range dialog

Click this toolbar button or double-click the time (x) axis of the display to open the X Range dialog.
Experiment with the time axis. You can type new positions or use the pop-up menus next to each field
to access cursor positions and the maximum time in the file. The most important dialog controls are:

Units

Left

Right
Width

Show All
Draw
Close

Cancel

In a time view you can choose between an x axis in seconds, in hours, minutes and seconds and
as time of day. Time of day works for files sampled with versions of Spike2 from 4.03 onwards
that save the start of sampling time in the file.

Sets the window start time. You can enter times as seconds, for example 3665.2, or in a time
format as 61:05.2 (61 minutes, 5.2 seconds) or as 1:01:05.2 (1 hour, 1 minute, 5.2 seconds). The
time format extends up to days, so 1:1:1:1 is 1 day, 1 hour, 1 minute and 1 second. At the
moment, times are relative to the start of the file, even with time of day mode selected.

In addition to typing times, or selecting a time from the drop-down list, you can type in
expressions using the maths symbols + (add), - (subtract), * (multiply) and / (divide). You can
also use round brackets. For example, to display from 1 second before cursor 1 to one second
past cursor 1 set Left to Cursor(1)-1 and Right to Cursor (1)+1. The Draw button is
disabled if you type an invalid expression, or if the Right value is less than or equal to the Left
value or if the new range is the same as the current range.

Sets the window end time using the same format as the Left field.

Shows the window width. You can either set the left and right positions, or the left position and
the width. Check the box to keep the width the same when the Left field changes.

Expands the time axis to display all the file and closes the dialog.
If the axis range had been edited, use this to redraw the data to match the new range.
This closes the dialog; it does not update the axis range.

This undoes all changes made with the dialog and closes it.

The Large tick spacing and Tick subdivisions fields let you customise the axis. Values that would produce an
illegible axis are ignored. Changes to these fields cause the axis to change immediately; you do not need to
click Draw. See the X Axis Range dialog documentation for full details of all dialog items.

Drop-down menus

A drop-down menu item is marked in a dialog by a triangle pointing downwards (.1!) that displays a list of
possible values for the field when you click the mouse on it. You can select one of the items in the list, or in
some cases you can type in your own value.

Y Range dialog

Click this toolbar button or double-click on the y axis of the waveform channel to open the Y Range
dialog. This dialog changes the y axis range of one or more channels. The Top and Bottom fields set
the values to display at the ends of the axis. Experiment with the y axis range.

Channel

Optimise

Show All

A pop-up menu from which you can select any channel with a y axis, or all channels with y axes,
or all selected channels.

This button changes the y axis ranges of the set channel(s) to fit the data and closes the dialog.
You can optimise the y axis without opening this dialog. The ctr1+0 key combination optimises
all selected channels, or all channels if no channel is selected.

This shows the full range of a waveform channel and closes the dialog. Sampled waveform data is
stored on disk as 16-bit integers with a numeric range of -32768 to 32767. The y axis is set to
display the full range. For other channels it will display a sensible range.
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Draw If the axis range had been edited or the channel locking fields have changed, use this to redraw the
data to match the new settings. It does not close the dialog.

Close This closes the dialog; it does not update the axis range.

Cancel This undoes all changes made with the dialog and closes it.

The Lock axes and Group offset fields are hidden unless you have selected a channel that is part of an
overdrawn group. These fields are disabled unless the current channel is the first of a group. If you check the
Lock axes box, all the grouped channels use the y axis of the first channel in the group to set their display
range. The Group offset field sets a vertical display offset, in y axis units, to apply between channels in the
group. You would use this if you wanted to draw many channels with the same mean level on the same axis and
waned to separate the channels vertically. The offset only applies to the visual display, not to any measurement
made on the data.

The Large tick spacing and Tick subdivisions fields customise the axis. Values that would produce an
illegible axis are ignored. Changes to these fields are applied immediately; you do not need to click Draw.

If no channel has a y axis, open this dialog from the View menu. See the Y Axis Range dialog for full details.

Channel draw mode dialog

Data files hold two basic channel types: waveform and event. Waveform channels hold a list of values
representing the waveform amplitude at successive time intervals. Event channels hold the times at which
something happened (and more data, depending on the channel type).

Open the View menu Channel Draw Mode dialog. Experiment with different drawing modes for channel 3.
Click Draw to update the display without closing the dialog. Click OK to close the dialog.

Show and Hide channels

Open the View menu Show/Hide Channel dialog. This sets the channels to display in your window. With up
to 2000 channels in a file plus memory, duplicate and virtual channels, this ability is quite important if you are
to see any detail!

The list on the left of the dialog holds all the channels that can be displayed. Check the box next to a channel to
include it in the display list. You can turn all channels on and off with the buttons at the bottom of the dialog.
There are also controls to filter the list of displayed channels with regular expressions based on the channel
number, title and type.

You can also show and hide the channel number, axes, background grid and the horizontal scroll bar in the
window from this dialog and position the y axis on the right and choose to draw axes as scale bars.

Click the Draw button to see the result of your changes without closing the dialog, or click OK to close the
dialog and see the changes. If you make a complete mess of your window you can use the View menu
Standard Display command to clean things up.

Channel order

Make sure that the demo file is the current window and use the View menu Standard Display command to tidy
things up. Click on the Keyboard channel number (31) and drag it down over the other channel numbers.

As the mouse pointer passes over each channel, a horizontal line appears above or below the channel. This
horizontal line shows where the selected channel will be dropped. Drag until you have a horizontal line below
channel 1 and release the mouse button. Channel 31 will now move to the bottom of the channel list. Type
Cctrl+z or use the Edit menu Undo to remove your change.

You can move more than one channel at a time. Spike2 moves all the channels that are selected when you start
the drag operation. For example, hold down ctr1l and click on the channel 3 number. Keep ctrl down and
click and drag the channel 2 number. When you release, both channels will move. The mouse pointer shows a
tick when you are in a position where dropping will work.
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The usual Spike2 channel order is with low numbers at the bottom of the screen. If you prefer low numbers at
the top of the screen, open the Edit menu Preferences and check Standard Display shows lowest
numbered channel at the top, then use the View menu Standard Display command.

Channel spacing

Change the channel 3 drawing mode to Mean frequency. Hold down the Shift key and move the mouse over
the data area. Hold the shift key down and click. Drag up and down and release the mouse.

When you click with shift down, the mouse jumps to the nearest channel boundary and you can change the
boundary position by dragging. With Shift down, you can move the edge up and down as far as the next
channel edge. You can undo changes or use Standard Display to restore normal sizes.

If you add ctr1, all channels with a Y axis are scaled. If there are no channels with a Y axis above or below the
drag point, then all channels scale. You can force all channels to scale by lifting your finger off the shift key
(leaving ctrl down) after you start to drag the boundary.

Channel grouping (overlay)

You can group (overlay) data channels with a Y axis in a time view or a result view. This is done interactively
by dragging channel numbers on top of each other or from a script by using the ChanOrder () command.
When you drag channels, you can drop them on top of another channel with a Y axis or on top of a channel
group. As you drag, a hollow rectangle appears around suitable dropping zones. You can also drop between
channels when a horizontal line appears.

To do this in the demo . smr example file:

Click the "3" of channel 3 and drag it on top of the "1" of Channel 1 and release.
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Steps in overdrawing channels

Channels 1 and 3 now share the same space with the channel numbers stacked up next to the Y axis. The visible
Y axis is for the top channel number in the stack. In this case, this is channel 1, which is the #ead of the group.
Only a channel with a y axis can be the head of a group. The other channels in the group are referred to as
members of the group. You can promote another channel in the stack to the head by double-clicking the channel
number (as long as the channel has a y axis). The channels retain their own y axes and scaling. You can remove
a channel by dragging the channel number to a new position.

Grouped channels are drawn such that the head channel with the visible Y axis is drawn last. If you have a
channel that fills in areas, such as a sonogram or an event channel drawn as rate mode or in state mode, put it at
the bottom of the stack, as it will mask channels below it in the stack. If overdrawn channels have been given
their own channel primary colours, the channel numbers for the overdrawn channels are displayed in the
channel primary colour.

Before Spike2 version [10.07] only channels with a y axis could be grouped. From [10.07] you are allowed to
group any channels, but only channels with a y axis can be the head of a group. This change allows the
background of a channel to be coloured by a Marker channel drawn in State mode.
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Common (locked) y axis

If you want all grouped channels to draw at the same scale as the displayed y axis, double-click the Y axis scale
to open the Y axis dialog and check the Lock axes box. If you have very similar channels, they will tend to lie
on top of each other. You can use the Group offset field to set the vertical displacement between adjacent
channels in y axis units. The head of the group has no offset, the first member has the offset, the second has
twice the offset, and so on. If you have included channels without a y axis in a group, you will likely want to
place them last so the channels with y axes are equally spaced.

Effect of grouping on cursors
Grouping channels has no effect on vertical cursors.

Horizontal cursors are hidden if the y axis they belong to is hidden. This means that if you drag a channel with
horizontal cursors into a group, the horizontal cursors will vanish. You can make them appear if you lock the Y
axis axes (as then the y axis they belong to is logically visible).

Effect of grouping on context menu

When channels are grouped, the context menu that appears when you right-click in the channel data area is for
the topmost channel in the group. From version [10.10], you can see context menus for 'underneath' channels by
right-clicking on the channel number.

Tidy up
Use the View menu Standard Display command to tidy things up before you continue.

Cursor values

'-".,I Make sure there are cursors in the window, then click this toolbar button or use the Cursor menu

Display Y Values option to open the Cursor Values dialog. The columns show the cursor times and

values. For channels without a y axis, the value is the next event time after the cursor. If you move

cursor or alter a channel display mode, the values change. If you add or remove channels in the display, they are
added or removed in the dialog.

The Time zero and Y zero check-boxes select relative rather than absolute measurements; the radio buttons set
the reference cursor. Reference cursor values are unchanged; values at other cursors have the reference value
subtracted.

You can copy dialog fields to the clipboard. Click and drag for multiple selections. Click a top or left hand cell
to select an entire column or row. Hold down Ctr1 to make non-contiguous row or column selections.

Cursor regions

~ L Click this toolbar button or use the Cursor menu Cursor Regions command. Experiment with
| ¥ changing cursor positions and channel display types. The regions dialog looks at the data values
between cursors. There are several modes set by the drop down list at the bottom of the dialog:

Area The area between a waveform and the y axis 0.0 level or the number of events in the region.
Mean The average level of a waveform, or the number of events divided by the region width.
Slope The gradient of the least-squares best fit line to the waveform, no meaning for events.

Sum The sum of waveform values between the cursors or the number of events in the region.

Area(scaled)  This mode is the same as Area, except that when a Zero region is set, the value in the zero
column is scaled to allow for the relative column widths before being subtracted.

Curve area Each data point makes a contribution to the area of its amplitude above a line joining the end
points multiplied by the x axis distance between the data points.
Modulus Each data point makes a contribution to the area of its absolute amplitude value multiplied by

the x axis difference between data points. This is equivalent to rectifying the data, then
measuring the area. If a zero region is specified, the amount subtracted from the other regions
is scaled by the relative width of the regions.

Maximum The maximum value found between the cursors.
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Minimum The minimum value found between the cursors.
Peak to Peak The difference between maximum and minimum values found between the cursors.

SD The standard deviation from the mean of the values between the cursors. If there are no
values between the cursors the field is blank.

RMS The value shown is the RMS level of the values found between the cursors. If there are no
values between the cursors the field is blank.

Extreme The value shown is the maximum absolute value found between the cursors. Thus if the
maximum value was +1, and the minimum value was -1.5, then this mode would display 1.5.

Peak The value shown is the maximum value found between the cursors measured relative to a
baseline formed by joining the two points where the cursors cross the data.

Trough The value shown is the minimum value found between the cursors measured relative to a

baseline formed by joining the two points where the cursors cross the data.

You can also make relative measurements by checking the Zero region box and choosing a reference region.

Result views

Windows holding raw, unprocessed data are called Time views. There is another type of data window, called a
Result view, that holds the result of analysing time view data. These windows hold one or more channels of
data, each channel has the same number of data points and x axis are suitable for waveforms or histograms.
Channels can also have event times associated with them for raster displays. There are two steps in the analysis:

1.

2.

You set the type of analysis, the channels to analyse, the number of points or bins to generate and any other
parameters required. This creates a new, empty result window.

You set a time region of the time window and Spike2 calculates the result and adds it to the result view.

You may repeat step 2 as many times as is required to accumulate results from different sections of data. The
new window behaves like a time view containing a single channel of data. Result views can also be created
from a script.

Make an interval histogram

Close all windows except the original time view of demo . smr. Then:

1.

2.

H]Ih- Click this button on the toolbar or use the Analysis menu New Result View command to select
Interval Histogram.

Set the channel to analyse. The channel list in the pop-up menu includes event channels only. Channel 3 of
the demo file is the best for this example.

Set the number of bins in the histogram, we suggest 150.

Set the width of each bin, in seconds. Bins must be at least one Spike2 clock tick wide. The bin width is
rounded to a multiple of this clock tick. We suggest 0.01 seconds (this is 10 milliseconds).

Leave the last field set to 0.0 seconds. This is the minimum interval that appears in the new window.
Click the New button to create a new window and open the Process dialog.

Process dialog

Now set the region of the data file to analyse:

1.
2.

Set the start time for analysis to 0

Set the end time to View(-1).MaxTime() (this is the time of the last data item in the file), this is in the pop-
up menu.

Check the Optimise Y axis after process box to scale the y axis to the data automatically.
Click Process to analyse the data and display the result.
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The Clear result view before process check box sets the result window contents to zero before you analyse
the data, otherwise each new result is added to the previous one. The Settings button takes you back to the
previous step.

Repeating and extending a process

You can add more data into the result or change the process settings and process again:

1. Recall the process dialog by selecting the Process command from the Analysis menu.

2. Click the Process button again. The data in the result window will double in size (as long as you have not
checked the Clear result view before process box).

3. Recall the process settings dialog by selecting the Process settings command from the Analysis menu.

4. Change the number of bins to 400, and the time resolution to 0.004 then click the Change button and
confirm that you wish to continue.

5. Select a region for processing with the new settings.

Result view drawing modes

Experiment with the Channel Draw Mode command in the View menu.

There are four different drawing styles available for result windows: Histogram, Line, Dots and SkyLine.
These styles are self-explanatory. The various analysis routines that create result windows will select an
appropriate style.

See the View menu Result view drawing modes documentation for more detailed information.

Result view cursors

Experiment with cursors in this new window.

You will find that the cursors behave in a very similar manner to the original time window and that you can use
the Cursor menu Cursor Values and Cursor Regions commands in the same way.

XY Views

XY views have a wide variety of uses, from displaying user-defined graphs to drawing pictures. XY views have
the following features:

¢ One x axis and one y axis shared between all data channels in the XY view, so all the channels share the
same space; you can overdraw one channel with another.

e Up to 2000 data channels allowed in the view (the limit was 256 before Spike2 version 9).

e Channels are numbered consecutively from 1. If you delete a channel, the channel numbers of any higher-
numbered channels change. For example, if you have three channels (1, 2, 3) and you delete channel 2, the
old channel 3 becomes channel 2.

e Each data channel is a list of (x,y) data points. The number of data points in a channel is limited only by
available memory and drawing time. However, you can limit the number of data points on a channel, in
which case new data points replace the oldest data points.

e The data points can be drawn with markers at each data point. The range of marker styles currently includes:
dots, boxes, plus signs, crosses, circles (Windows NT only), triangles, diamonds, horizontal lines and vertical
lines. The size of the markers can also be set, and they can be made invisible.

e The data points can be joined with solid, dotted or dashed lines, and the line thickness can be varied. You can
also choose to join the last point in a channel to the first point to make a loop.

¢ You can sort the order of the data points in a channel by x, by y or by order of insertion in the channel. This
is only important if the data points are joined.
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e The colour of the lines and markers can be chosen. If no colour is set, the same colour as for a waveform
channel in a time view is set.

e You can process data from a time view to generate an XY view with multiple channels; see Measurements to
XY views.

As we do not display separate y axes for each channel, there is no selectable channel number field; you cannot
select a channel in an XY view.

Make XY view

The simplest way to create an XY view is to take some measurements from a time view:
1. Close any extra views so that only the demo time view remains.

2. Select the Analysis menu Measurements->XY View... option or click on the Measurements icon in the
toolbar and select XY View... from the pop-up menu.

3. A complicated dialog will appear (see here for details or click the Help button). The default state of this
dialog will find all the peaks on channel 1 of the demo file and generate an XY view with the peak positions
as the x value and the peak amplitude as the y value. Accept this by clicking the New button at the bottom
right.

4. The familiar process dialog will open. It will be set to process all the time range in the demo file, so click
the Process button.

5. You will get a graph that is fairly convincing, but may have a few negative values that do not 'feel' like
peaks. We can fix these...

6. Click the Settings... button on the Process dialog to go back to the previous dialog.

7. The problem is that we have accepted the default value in the Cursor 0 stepping dialog region Amplitude
field (0). This accepts the smallest upwards wobble of the data as a peak. For now, just edit the Amplitude
field to 0.1 and click the Change button.

8. The output data is removed; this is done because the analysis has changed. The Process dialog opens again
and you should click Process to generate the data again.

9. This time, the dubious points will not be present.

You can modify the drawing style of the XY view. The easiest way to do this is to right-click in the view and
experiment with the context menu that appears.

The Measurements system uses the Active Cursor system to iterate through a time view. Each successful active
cursor iteration results in a new (x,y) data value. The x and y values that are selected in the X measurements
and Y measurements regions of the XY Measurements Settings dialog.

Instead of measuring to an XY view you can measure to a RealMark channel in a Time view. This can be more
convenient when you need to see the results in the context of the time view data.

Other sources of information

There are video tutorials for various aspects of Spike2 on our web site: http://ced.co.uk/tutorials/introduction
that demonstrate specific features in detail.

If you have worked through the Getting started tutorial, you have the basic skills required to make use of
Spike2 for interactive data analysis. You can find more detailed information in the following sections:

Sampling data This describes the different data types Spike2 supports and how to configure Spike2 to
sample them. It also covers arbitrary waveform output (output through the 1401 DACs
of previously sampled waveforms or waveforms generated by the script language).

Data output during  This describes the output sequencer, which allows you to produce precisely timed
sampling digital pulses, voltage ramps and steps and cosine waves. You can also detect changes
in external signals in real time and respond to them in much less than a millisecond.
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File menu This describes all the commands in the File menu: Opening and saving files and
configurations, exporting data from Spike2 and Printing.

Edit menu This describes the commands in the Edit menu including the Preferences (well worth a
visit).

View menu This describes the View menu, which covers all aspects of what you see in each data
window.

Analysis menu This describes how you can generate result views from time view data, how to take

measurements to a new XY view, how you generate Memory channel (for example by
picking peaks from waveforms), the marker filter, spike shape creation and editing and

the digital filter.
Window menu Describes the commands in the window menu.
Cursor menu Covers the use of vertical and horizontal cursors, how to set active cursors and how to

use the Cursor regions and Cursor values dialogs.

Sample menu Describes the commands in the sampling menu including off-line waveform output and
the use of TextMark data during sampling.

Script menu This is a brief overview of the commands in the script menu. There is a separate
manual The Spike2 script language which has a detailed description of the language.
You should also see the Spike2 Training Course Manual for more details of selected
script topics.

Spike shapes This chapter has a more detailed explanation of the use of Spike2 to sample spike
shapes and the use of the template system to identify spike shapes.

Digital filtering This describes the digital filter dialog in detail, and also has a more technical section
which discusses the use of digital filters.

XY views This has a brief introduction to XY views from the point of view of a script writer and
introduces a script that can generate "waterfall" displays.

Signal Conditioners ~ Spike2 can control programmable signal conditioners such as the CED 1902, the Axon
CyberAmp and the Power1401 with the ADC gain option fitted.

Utilities There are additional programs provided with Spike2 to fix damaged data files and to
check out your 1401.

To learn about using the script language for analysis you should read about the script language and investigate
the example scripts provided with Spike2:

Script language Basic introduction to the script language including a "Hello world" script and how to record
Introduction simple actions and then edit them into a more useful script.

Script window  Working with the script window and the associated script commands and how to use the
and debugging  built-in script debugging system.

Script language An explanation of the script language structure, keywords, variable types, data arrays and
syntax basic programming structures together with simple programming examples.

Functions by Spike2 has more than 500 built-in script functions. This section groups them together by
topic function. For example, if you want to find all the script functions that relate to sampling,
then start here.

Alphabetic This is the full list of all built-in functions arranged alphabetically. Each function comes
function list with a description and some also include examples of use.

The Spike2 Training Course Manual is another resource you can use. It contains getting started chapters on
many topics, and is an invaluable reference for the script writer as it has worked examples that cover many
common requirements.
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General information

This covers topics that are important throughout Spike2 and miscellaneous items that don't fit anywhere else.

View types and files

We often refer to Views when we describe features of Spike2. The types of views that an interactive user of
Spike2 has to deal with have a window on the screen with an associated menu and a data file on disk. These
views come under the categories of Data based views and Text based views. If you write scripts you will also
have to deal with two other types of views: External views (with no associated window) and Other). There is a
more technical description of views and view handles in the Script language section.

Data based view
There are three types of data views in Spike2:

Time views (*.smrx, *.smr)

These display data that is being sampled or has been sampled by Spike2 or imported into Spike2. They are
created by the File New command (to create a new file for sampling based on the current sampling
configuration), or by opening an existing file or by importing a foreign format file. You can also create a time
view from the script language and use the script language to fill the channels.

Result views (*.srf)

Result views are generated based on Time views and hold channels of similar data that can be displayed as
waveforms or histograms. You can open saved result views with the File menu Open command and create new
ones when the current view is a Time or Result view from the Analysis menu New Result View command. You
can also create them from the script language.

XY views (*.sxy)

XY views are generated from analysis of Time views or by the script language. They display multiple channels
of data points defined by (x,y) co-ordinates. The data can be drawn as dots, lines, closed curves or as
histograms, allowing a wide variety of displays to be created. Existing XY files are opened by the File menu
Open command.

Text based views

Text-based views correspond to standard text files. From Spike2 version 8 onwards, we expect text files saved
on disk to be in UTF-8 format, but we will attempt to read text in an range of formats and translate as
appropriate. We save text files in UTF-8. If you are firmly of the ASCII text persuasion, do not worry as this is
a subset of UTF-8. We distinguish the varieties of text file we support by the file extension used to store them
on disk. The Text file view types that Spike2 supports are:

The Log view

The log view is unusual in that it does not have an associated data file, though you can save it as a text file. The
Log view is used as a convenient place for Spike2 to display messages and there is a dedicated script command,
PrintLog (), to make it easy to write to from the script language, regardless of the current view.

Text views (*.txt)

These views are created by opening an existing .txt file or by creating a new text file with the File New
command or from the script language with FileOpen (name$, 1,...) or FileNew(l,...) commands.
They display the text in the file and the text can be added to it with the script Print () command. You can
choose to display a gutter margin which can hold bookmarks, and a line number margin, which is normally
hidden. Text views are normally used from the script language to build output files that the user can view.
Script users can also create external text files, which are faster but have no display window.

Script views (*.s2s)

These views are created by opening an existing script file or by creating a new one with the File New command
or from the script language with the FileOpen (name$, 3,...) or FileNew (3, ...) commands. Scripts are
used to automate Spike2 operations. Most Spike2 interactive functionality can be controlled by a script, and
there is a lot of functionality that is only available from a script.
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Script views display the text in a window. Script views highlight your script files based on the syntax of the
script language, which can make scripts easier to understand and write. They are also used to debug scripts.
They have additional folding margin which shows the structure of the script and allows you to fold away blocks
of code based on the script structure.

Output sequencer views (*.pls)

These views are created by opening an existing output sequence file or by creating a new one with the File New
command. Output sequences are used when sampling data with a 1401 interface to sequence DAC and digital
outputs. They can also be used to respond to inputs very quickly, enabling real-time responses to external
signals. Like scripts, output sequences support syntax highlighting and folding.

There is an alternative way to create output sequences using a graphical editor. The output of the graphical
editor is converted to a text sequence before it is used.

Grid views (*.s2gx)

These were added at version 8.05. They are mainly intended for use from the script language, but can be used
interactively. They provide a spreadsheet-style grid that can be used to store data and to build tables for
printing. They are not intended for vast quantities of data. You can read more about them here.

External views
These views have data files and view handles, but no display windows. They are used for text and binary data
files and are only available to users of the script language.

External text files (*.txt, *.*)

These files are opened and created with the FileOpen (name$, 8, ...) script command. You can read data
from the files with Read () and write data with Print (); the files are accessed sequentially, that is you will
read from the start of the file through to the end or write from the start to the end or append to the end. Because
there is no associated screen image to update when you write or to scroll through on a read, external text files
can be much faster to use than a text view with an associated window, particularly if the file is very big.

External binary files (*.*)

These files are opened and created with the FileOpen (name$, 9,...) script command. You can read and
write real, integer and text data to these files in a wide variety of formats. The files allow random access. See
the BRead (), BReadSize (), BWrite (), BWriteSize () and BSeek () commands for details. You can read
or write just about any type of file as a binary file, but to do it usefully you need to know the exact file format.
The example for the BuriteSize () command shows you how to create a .bmp file using the script language.
The example for Spline2D () has an example of generating a bitmap file.

Other view types

These view types are for objects that are controllable by the script using view handles, but that do not fit the
view types listed above. These are things like Info windows, control bars, the Sampling status view, the Spike2
application window, the spike sorting window, the multimedia windows and so on.

Data file topics

Spike2 clock tick

Data file versions

Data channel types

Channel search expressions
Channel lists

Dialog expressions

Data view keyboard shortcuts
Overdrawing data in Spike2
Interrupting drawing

Recycle Bin
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Spike2 clock tick

All items in a Spike2 .smrx or .smr data file exist at an integer multiple of a basic time unit, the underlying
clock tick or time resolution for the file. This unit is typically very small, and usually lies between 1 and 100
microseconds. A 64-bit smrx data file can run for 8 x 10'8 of these clock ticks, which at 1 microsecond per tick
would be 255 thousand years. Put another way, if you use a 64-bit smrx data file, the length of the file is not a
consideration and you should probably run at 1 microsecond per tick unless there is a pressing reason to run
slower.

However, if you use a 32-bit smr data file, it can only run for a little more than 2 billion (2 x 10°) of these clock
ticks. At a clock tick of 1 microsecond, a file is limited to around 36 minutes. A 10 microsecond clock tick file
can run for almost 6 hours. At 100 microseconds the file could run for more than 2 days.

The value of the clock tick is usually some multiple of microseconds or tenths of microseconds when the
original source of the data is a CED 1401 data acquisition unit. However, when data is imported or a data file is
created by a script, the clock tick could be any value.

The clock tick used when sampling is set in the Resolution tab of the Sampling configuration dialog. From
the script language, the clock tick is set by the FileNew() command when creating a file. The
FileTimeBase () script command can be used to read the clock tick and it can also be changed to adjust the
time base of a file (for instance when a EEG data is played back from a recorder at several times the normal
rate).

Data file versions

Spike2 data is stored in files with the extensions .smr (for the original 32-bit times format) and .smrx (for the
64-bit times format).

The 32-bit file format was designed around 1987 and has been much extended since. It was limited to 2 GB in
size until version 9, which allowed sizes up to 1 TB. There were 9 major version changes to the 32-bit format;
we are on the second version of the 64-bit format. We have always made sure that more modern versions of
Spike2 will read older file versions. Occasionally we are asked why the 32-bit file extension was .smr and not,
for example, .spk. It stands for son of MRate - MRate was a CED MS-DOS program that was the predecessor of
Spike2 in that it sampled both waveforms and event times.

The 64-bit format was released with Spike2 version 8 in 2013. We strongly recommend that you use the new,
64-bit . smrx version of the library for all new work.

Unless you are interested in history, or you have an old version of Spike2 and cannot read a data file, you can
stop reading this page now.

If you are interested in the technical details of the library, or need to interface to it, there is documentation and
header files on the CED web site (follow links to Downloads and then Son library). You can read the file
version with the FileInfo () script command and from the View menu File Information... command.

Version Change history
1 The original SON filing system, written in Pascal, supported waveform and Event data only.

2 New Marker data type. Added extra space to the file header for future expansion. The library was
much faster reading large data files as it remembered the last accessed data.

3 Added the FilterMarker function. Changed the meaning of the waveform channel divide to prevent
an apparent change of sampling rate if a waveform channel was added or deleted. This effectively
removed the use of the time per ADC value stored in the file.

4 Added the WaveMark data type. Changed the use of FilterMarker. The library now caches the
current data block to avoid re-reading when the required block is already in memory.

5 Added the TextMark and RealMark data types and the MaxTime and ChanMaxTime functions. C
library versions written for the IBM PC in DOS and Windows and for the Macintosh. The version 5
libraries write version 3 and 4 files if the data does not need new features.
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In 1998, we extended the C version to support read-only files and to allow more data to be written per
call. We added lookup tables to speed up data access in long files and write buffering to remove the
need for Fastiirite, allow peri-triggered sampling, and speed up writing).

6  Documented for C/C++ use only with information on use as a DLL by other languages. Added the
RealWave channel type. WaveMark channels have multiple traces. Waveform rate divider is now 32-
bits. Added support for time and date stamp, basic time unit and an application identifier. Files still
compatible with versions 3, 4 or 5 if they do not use version 6 features.

7 You can choose to round the sizes of WaveMark and TextMark extended marker types up to a
multiple of 4 bytes so that we can build the library on systems that insist on aligned data access.

8  Altered storage of channel numbers to avoid the bit used to hold the initial state for a level channel,
allowing the maximum number of channels to be increased to 451. Extended the lookup table so that
the table for a channel starts small and grows up to a limit (larger than the old fixed size).

9 Added support for big files (up to 1 TB), rewrote the internal lookup table system to improve speed
and saves the table as part of the file in Big file mode. Macintosh (big-endian format) support was
removed. Linux support is added. Pointers to disk space that were previously byte offsets (but
multiples of 512) are now block pointers (a pointer value 10 means offset 5120). This increases the
maximum file size by a factor of 512. There are changes to the file header to support a lookup table
on disk and to channel headers to track the block counts. There were also type changes to allow
compiling as 64-bit code on Windows and Linux.

256  64-bit times. A complete redesign of the filing system to remove the time and disk space limitations
0x100 of the original while leaving a system that is similar enough to the original to store the same data and
behave in similar ways. Times are stored as 64-bits and the files can theoretically be of any size up to

2 to the power 64 bytes (around 10 to the power 19 bytes).

Practical considerations, such as the need to copy files in reasonable time will limit file sizes to a
small number of TB for the next few years. Times are stored to 64-bit accuracy, but some operations
within Spike2 use floating point numbers to manipulate file times, and a floating point number has
some 53 bits of precision, so this also limits the available maximum time. However, with 1
microsecond ticks, you can still sample for tens of years before this becomes an issue.

You can access both 32-bit and 64-bit files using the same API, so although there is software effort
required to use the new format, once done you can read and write both old and new formats with the
same code. Also, if the son64.dll file is placed in the same folder as a recent son32.dll file, old code
that reads old 32-bit files can also read a new file (as far as the first 32-bits of clock ticks).
257  This fixed a bug where a data file, usually created by importing a file with a lot of channels and with
0x101 quite long channel comments, titles and units, could end up being unreadable. You can recover a file
in this state with S64Fix, but you may lose some of the text strings. There is no change to the file
format; the version number change is to help us recover the file.

Data channel types

In a Spike2 time view there are two basic data types: Waveforms and Events. These are then further sub-
divided into more types. You can always find out the type of a channel by hovering the mouse over the channel
y axis area and a tool tip will pop up displaying (amongst other things) the channel type.

Waveform and RealWave

Waveforms are stored as a list of data values that represent a signal amplitude. The time gaps

between the samples are all the same, and this is known as the sampling interval. The

reciprocal of the sampling interval is known as the sampling rate. So a signal with a sampling

interval of 0.01 seconds (or 10 milliseconds) has a sampling rate of 100 Hz. The sampling —— ———
interval must be an integer multiple of the clock tick for the file. For example, if the underlying clock tick was 1
microseconds waveform sample intervals of 1, 2, 3, 4...n microseconds are possible. Put another way, sampling
rates of 1000 kHz, 500 kHz, 333.3 kHz, 250 kHz... 1000/n kHz are possible.

Spike2 stores waveforms on disk as either 16-bit integers in the range -32768 to 32767 (a Waveform channel)
or 32-bit floating point values (a RealWave channel). Both these channel types have an associated scale and
offset value plus a text string that defines the user units to use for the y axis when displaying the data. For a
Waveform (integer) channel, the scale and offset are used to convert the stored integer values into user units.
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This is arranged so that a scale value of 1.0 and an offset value of 0.0 map the input of a 1401 device with a £5
Volt range into Volts. That is:

user units = integer value * scale / 6553.6 + offset

RealWave channels are stored in user units. They use the scale and offset values whenever a RealWave channel
needs to be converted to an integer value for use as a Waveform. In this case:

integer value = (user units - offser) * 6553.6 / scale
If the result of this would exceed 16-bit integer range (-32768 to 32767), it is limited to -32768 or 32767.

Waveform and RealWave channels can have gaps in them where there is no data. The very first data point of
the channel determines the possible positions of all subsequent points as all points lie at a time that is:

time of first point + n * sampling interval

where n is an integer value. You can read about sampling waveform data in the Sampling data chapter.

Effect of Scale factor on Text output to Clipboard, File and Spreadsheet

When outputting Waveform data, the number of decimal places is set so that the equivalent of half a bit change

is visible. This means that for a scale factor of 1.0, we display 5 decimal places. For every change of a factor of
10 in the scale factor, the number of decimal places changes by 1:

Channel scale factor 100.0 10.0 1.0 0.1 0.01
Decimal places 3 4 5 6 7

From version [10.20], when formatting RealWave data for text output, the number of decimal places used is
also set based on the scale factor. Prior to this version, 6 decimal places was always used.

Event
The basic concept of an event is that it is a time stamp. The time stamp is a 64-bit number that is the
count of the number of underlying clock ticks from the start of the file to the event. The time of the «
event in seconds is: @
time in seconds = time stamp * underlying clock tick period =
Spike2 has two event types that are exactly equivalent: B s
Event+ and Event-. The + and - relate to how the data

Event- (falling edge} Event+ (rizing edge}

was captured. The plus means that the time was from a
signal rising through a trigger level, the minus means that the signal was falling through a level. This is only
important when data is captured. You can read about sampling event data in the Sampling data chapter.

Level

There is a third simple event type, Level. In the 32-bit filing system, this was stored +_
in exactly the same way as Event data and each data block had a flag that indicated

the direction of the first edge in the block. This had the advantage of being
compact, but the disadvantage that deleting an edge caused all following edges (but only in the block) to invert
and caused all kinds of logical problems. The new son64 system implements Level channels as Marker data
using marker code 00 for a low-going edge and code 01 for a high-going edge.

Level (both edges)

When stored in a memory channel, we still treat Level data as a list of times to make it easy to insert and delete
edges and to maintain backwards compatibility with Spike2 version 7. However, when we write Level data to a
son64 file we save it in Marker format.

Marker

Spike2 extends the event concept by attaching data to each event. The simplest form of
attached data is the Marker, which adds 4 8-bit marker codes (in the range 0-255 decimal,
00-FF hexadecimal) to each event time. These codes can then be used to filter the event
data. For example, the keyboard marker channel that Spike2 always adds to a sampled data
file stores the keys pressed during data capture in the first marker code. If you associate a
particular key with a recurrent event during sampling, you can filter the channel to show only events with that
particular key code. Marker data stored in 64-bit .smrx files also has a 32-bit integer value stored with each
marker. Currently, all sampled data sets this extra data to 0, but file importers can set it and it is accessible with
the LastTime (), NextTime (), ChanData () and MarkEdit () script commands.

Code 0
Code 1
Code 2

Code 3
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As a Marker is exactly like an event, anything that you can do with an event channel can be done with an
(optionally filtered) Marker channel. You can read about sampling Marker data in the Sampling data chapter.
You can also create such channels as memory channels and then save them to make a permanent channel.

TextMark

A TextMark channel is exactly the same as a Marker (so anything that can be
done with a Marker can be done with a TextMark), except that it has a text
string attached. There is a maximum size of string set for each TextMark
channel. You can set a TextMark channel for use during sampling. You can also
create such channels as memory channels and then save them to make a
permanent channel.

RealMark

A RealMark channel is exactly the same as a Marker, but with the additional rr: 1896
ability to store a list of real numbers. RealMark channels can be created as the Code i 2.304
result of an active cursor measurement processor they can be created as a codE g 128
memory channel and saved to a permanent channel. An example of the use such Code 3 ;32_17292

a channel would be store a list of blood gas parameters that are sampled from
time to time during an experiment.

Since version [9.02] you can attach separate title and units to each item and from [10.18] you can duplicate a
RealMark channels as a waveform for each item.

WaveMark

A WaveMark channel is exactly the same as a Marker, but also stores 1, 2 or 4
short waveforms (stored as 16-bit integers). These are normally used to store
Spike shapes. The marker codes are usually used to store codes that represent
the result of sorting the spike shapes into different classes. You can read more
about sampling spike shapes in the Spike sorting chapter .

Channel search expressions

In most places where you can type a channel list, you can also type a channel search expression. This allows
you to select channels with Titles, Units or Comments that match a regular expression.

A channel search expression is a string of the form "what=regexpr", where what specifies what we search
and regexpr is an ECMAScript regular expression that specifies the text that must be matched (found within
the expanded what string) to include this channel. The text of what is scanned and each T, U and C (case is
important) in what is replaced by the Title, Units and Comment of a channel. Then the resulting string is
searched by the regular expression. If what is empty, it is treated as T (title search).

This is a very powerful feature; however, it requires you to understand how regular expression syntax is used.

Examples

"T U=y V" would match channels with a title that ended with y and units that start with v (assuming that you
did not use the underline characters in the title or units). The text to be searched for each channel is the channel
Title followed by underscore followed by the channel Units. The idea of the underscore is to use an unusual
character to mark the end of the title and the start of the units as we want to match the end of the title. If your
title might hold an underscore, you would need to use a different character as a separator. For example, if the
Title was "Funny" and the Units string was "volts", this would expand to "Funny Volts", which is matched
as it contains "y V".

"=~G\\d+ x" would match channel titles like "G2 x™ or "G29 x". In this case we have not supplied a what,
so the channel title is searched. We need two backslash characters as backslash is an escape character. The
regular expression that is used is "~G\d+ x". This means: find a G at the start of the text followed by 1 or more
decimal digits followed by a space and an x.
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Channel lists

In many places where you are prompted for a channel, you can select a channel from a drop down list, or you
can type a channel list. A channel list is a list of channel numbers or channel ranges separated by commas. A
channel range is two channel numbers separated by two periods or a hyphen, for example 4. .7, which is
equivalent to channels 4, 5, 6 and 7. The channel range 7-4 is equivalent to channels 7, 6, 5 and 4. The
following channel list:

1,3..5,7

means channels 1, 3, 4, 5 and 7. In most cases, Spike2 checks channel lists and removes channels that are not
suitable for the operation. For example, if you open the demo . smr file supplied with Spike2, select an Interval
histogram and type a channel list of 1. .32 and then click on another field, Spike2 reformats the list to 2,3,31 as
these are the only suitable channels. It is not an error for a channel list to include unsuitable channels, however
it is an error for a channel list to include no suitable channels.

You can replace channel numbers with symbolic names using m for a memory channel or v for a virtual
channel. For example m1 for the first memory channel or v2a for the first duplicate of virtual channel 2. If you
specify a range of duplicates of the same channel, the range expands by duplicates, not by channel numbers. For
example: 2. .2c means 2, 2a, 2b, 2c. We allow up to 52 duplicates of a channel using upper case A. . z for
the second set of 26. So 2. .2C isthe same as 2. .2z, 2A..2C.

Channel lists can also be used in script commands, for example: ChanShow ("1..4"). Script commands that
will accept this format describe the argument as cSpc. You can find more information about channel specifiers
in the script language documentation.

Anywhere that you can you a channel list you can also use a channel search expression to match channel titles,
units and comments.

Dialog expressions

Many dialogs in Spike2 accept an expression in place of a number. These expressions can be divided into two
types: numeric expressions and view-based expressions.

Numeric expressions

A numeric expression is composed of numeric values, the arithmetic operators +, -, * and /, the logical
operators <, <=, =, >=, <> and ?, arithmetic functions and round brackets ( and ). The result of a logical
comparison is 1 if the result is true and 0 if the result is false. You may not have come across 2 (the ternary
operator), which is used as:

exprl ? expr2 : expr3

The symbols expr1, expr2 and expr3 stand for expressions. The result is expr2 if exprl evaluates to a non-
zero value and expr3 if exprl evaluates to zero.

If you write expressions involving more than one operator, for example 1+2*3 you need to know if this is
evaluated as (1+2) *3 or as 1+ (2*3). This is determined by the operator precedence, described below (where
you will find the answer).

Arithmetic functions
Dialog fields that allow expressions will also accept the following functions. In these examples, x stands for a
numeric value or valid dialog expression. [9.02]

Abs (x) If x is negative, return -x, otherwise x.
Cos (x) Return the cosine of x (x is in radians).
Sin(x) Returns the sine of x (x is in radians).

Min (x1,x2{,x3...}) Returns the most negative of the arguments.
Max (x1,x2{,x3...}) Returns the most positive of the arguments.

Sqr (x) Returns x * x.
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Sqrt (x) Returns the square root of x, or 0 if x is negative.

View-based time/x-axis expressions

These expressions follows the rules for numeric expressions and allow references to positions along the x axis.
If a dialog field is documented as allowing expressions, and the field supplies an x axis position (for example a
time), then you can use the following:

BinSize () In a time view, this returns the time resolution of the file, in seconds. In a result view
it returns the bin width, in seconds. In an XY view it returns 1. New at version
[10.04].

BinSize (n) In a time view, if n is a waveform channel it returns the sample interval of the channel

as displayed, in seconds. In all other cases it returns the same value as Binsize ().
New at version [10.04].

Cursor (n) Where n is 0 to 9 returns the position of the cursor. If the cursor does not exist or the
position is invalid, the expression evaluation fails.

C0 to C9 This is shorthand for Cursor (0) to Cursor (9).

CursorX(n) Where n is 0 to 9 returns the position of the cursor before the move to the current
position. If the cursor does not exist the expression evaluation fails. [8.09]

CXO0 to CX9 This is shorthand for CursorX (0) to CursorX(9), and returns the previous position
of cursors 0 through 9. [8.09]

XLow () The left hand end of the visible x axis in x axis units (seconds in a time view, else axis
units).

XHigh () The right hand end of the visible x axis in x axis units.

MaxTime () The right hand end of the x axis in x axis units. It is not valid in an XY view. In a time

view that holds WaveMark data, this will be slightly more than the value of
MaxTime () returned by the script language as it includes the width of the widest
WaveMark data item (so it can be displayed).

MaxTime (n) The time of the last data item on channel n in a time view.
Beware: Most of these have an identically named equivalent in the script language that operates in the same

way in Time and XY views. However, in a Result view, the script language cursor-related routines return bin
numbers whereas the dialog expressions always return x axis units.

You can combine these expressions with any of the operators or arithmetic functions (it is up to you to ensure
that what you use makes sense). For example:

Cursor (2)>Cursor (1) ? Cursor(2) : Cursor(l)

evaluates the position of the rightmost of cursors 1 and 2.

View-based channel/y-axis expressions
If a dialog field is documented as allowing expressions and the field supplies a y axis position associated with a
specific channel, then you can use the following command.

HCursor (n) Where n is 1 to 9 returns the position of the horizontal cursor. If the cursor does not
exist or the position is invalid, the expression evaluation fails.

H1 to HO This is shorthand for HCursor (1) to HCursor (9).

HCursorX(n) Where n is 1 to 9 returns the position of the cursor before the move to the current
position. If the cursor does not exist the expression evaluation fails.[8.09]

HX1 to HX9 This is shorthand for HCursorx (1) to HCursorX(9), and returns the previous
position of cursors 1 through 9. [8.09]

YLow () The bottom end of the visible y axis.

YHigh () The top end of the visible y axis.

At (t{,c}) The value on the relevant channel at time t, which can be a view-based time
expression.

Mean (t1,t2{,c}) The mean level on the relevant channel between times t1 and t2, both or either of

which can be view-based time expressions.

SD(tl,t2{,c}) The standard deviation of the values on the relevant channel between times t1 and t2,
both or either of which can be view-based time expressions.
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Meas (m, t1l,t2{,c}) Any available measurement (selected by m) on the relevant channel between times t1
and t2, both or either of which can be view-based time expressions. See the
ChanMeasure () script function for a list of the possible values of m and the
corresponding measurements.

Several of these commands with {, c} allow you to specify a channel number to override the channel to be
used. The curly braces mark optional arguments; you don't type them! For example, to use the At () command
at the time of cursor 1 on channel 3 you would type: At (C1, 3) but to use the default channel you would type
At (C1).

You can add view (-1) . before these expressions to force the expression to be evaluated for the time view
linked to the current view, for example View (-1) .Cursor (0). This is required when the current view is a
result view and you wish to access timing information from the time view that the result view is based on.

Times as numbers

All times are in units of seconds. However, where a time is typed into a dialog you can use {{{days:}
hours: }minutes: }seconds where the seconds may include a decimal point and items enclosed in curly
brackets are optional. Each colon promotes the number to the left of the colon from seconds to minutes to hours
to days. Times may only contain numbers and colons, white space is not allowed. One decimal point is allowed
at the end of the time to introduce fractional seconds. We also allow a number with no colons to be followed by
ms or us (with no spaces) to interpret the time in milliseconds or microseconds. So the following are
equivalent: 1.6,00:00:01.6,1600ms, 1600000us.

Time of Day format

From [10.11] we also allow you follow a number (usually in the days:hours:minutes:seconds format)
with tod (no spaces between the number and tod). This allows you to type in a time that matches the value
displayed on a time view x axis in Time of Day mode. Examples: 1:13:27.5tod, 12:00:00tod. The Cursor
Position dialog (activated from the vertical cursor context menu) uses this format when the x axis is in Time of
Day mode. Adding this suffix offsets the number to remove the time of day of the start of the file from the typed
in value so the result is an offset in seconds from the start of the file.

Operator precedence

In the table, LHS means the value of the expression to the left of the operator as far as the next operator of same
or lower precedence, RHS means the value of the expression on the right up to the next operator of the same or
lower precedence. Where operators have the same precedence, evaluation is from left to right. The precedence
order from highest (Level 1) to lowest (Level 5) is:

Level Name Return value
1 () |Brackets Everything inside a pair of brackets is evaluated before considering the effect
of an adjacent operator.
2 * [Multiply LHS multiplied by RHS
/ |Divide 1Hs divided by RHES. It is an error for RHS to be zero
3 + |Add LHS plus RHS
= |Subtract LHS minus RHS
4 < |Less than If LHS less than RHS then 1 else 0
<=|Less or equal If LES less than or equal to RHS then 1 else 0
= [Equal If LHS equal to RHS then 1 else 0
>=|Greater or equal |If LHS greater than or equal to RHS then 1 else 0
> |Greater than If LHS greater than RHS then 1 else 0
5 ? |Ternary operator [LHS ? A : B has the value A if LHS is not 0, and B is it is 0. Put spaces
around the colon to distinguish it from a time.

1+2*3-4 has the value 3 because multiply has a higher precedence than add. Put another way, the operator with
the highest precedence (lowest level) is used first, so 2*3 is evaluated, leaving 1+6-4. The remaining operators
both have the same level, so are evaluated left to right, first the 1+6 leaving 7-4, and thus the result is 3. Use
brackets to force other orderings: (1+2) * (3-4), for example.
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Script language compatibility

The expressions are compatible with the script language except for the use of C0 to C9 and H1 to H9 (and the
CnX and HnX) as shorthand for Cursor (0) to Cursor (9) and HCursor (1) to HCursor (9) and the use of
colons, ms and us to denote times. If you use these in a script you will get syntax errors. However, you can use
these constructs in strings passed as expressions to CursorActive () or MeasureChan ().

Data view keyboard shortcuts

The following short cut key combinations can be used in a time, result view or XY view except for
Ctrl+shift+Left/Right and Alt+Left/Right, which are only available in a time view. Items marked
Always available can be used, regardless of the current view.

Key

Operation

Left arrow
Right arrow
Shift+Left
Shift+Right
Ctrl+Left
Ctrl+Right

Ctrl+Shift+
Left/Right

Alt+left
Alt+Right

Alt+Shift+
Left/Right

Home /End
Ctrl+n

Ctrl+Shift+n

Ctrl+Shift+A
Alt+n
Ctrl+A

Ctrl+Alt+A

Ctrl+C
Ctrl+E
Ctrl+G

Ctrl+I
Ctrl+Shift+I
Ctrl+K
Ctrl+N
Ctrl+O
Ctrl+p
Ctrl+Q
Ctrl+L
Ctrl+R
Ctrl+Shift+R

Scroll 1 pixel left.

Scroll 1 pixel right.
Scroll several pixels left.
Scroll several pixels right.
Scroll half a screen left.
Scroll half a screen right.

Time views only. If cursor 0 is active, search for the next/previous feature and scroll the
screen to make it visible.

Time views only. Search selected event channels for the previous/next event that is nearest
to the screen centre and make it the screen centre or make a sound if there are no selected
channels or no more events.

Time views only. Jump to the next display trigger point (only if the display trigger is
enabled). This is equivalent to the manual stepping buttons at the bottom left of the view.

Scroll to the start/end of the data.

Where n is 0 to 9. Fetch vertical cursor 0 to 9. If the cursor does not exist it is created.
Cursor 0 exists only in time views.

Where n is 0 to 9. Centre the window on the cursor, if it exists. Beware that Microsoft have
grabbed Ctrl+shift+0 for IME language from Vista onwards. You can get instructions to
defeat this in the Technical support, Frequently asked questions.

Fetch all vertical cursors.
Where n is 1 to 9. Fetch horizontal cursor n to the first visible channel with a Y axis.

Select all channels. If all channels are selected, deselect all channels. Equivalent to a click in
the bottom left-hand corner of a Time or Result view.

Abort sampling; unless no data has been captured or you have been running for only a very
short time you will be asked to confirm this.

Copy the image of the view to the clipboard.
Expand (zoom out) the data view around the left edge of the window.

Open the Graphical Sequence editor during sampling. Currently you cannot use this option
until sampling has started and the initial graphical sequence is running.

Reduce (zoom In) the data view around the centre of the window.

Open the View Information dialog for the current view (where supported).

Show the x axis dialog.

Open a new data file choice dialog. Always available.

Open the file open dialog. Always available.

Print the current view. Always available.

Optimise selected channels in the current view. If none selected, optimise all channels.
Open the Evaluate window to run script commands. Available unless a script is running.
Reduce (zoom in) the current view around the left edge of the window.

Reset sampling. You will be queried unless no data has been captured or you have been
running for a very short time. Always available when sampling.
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Ctrl+s Save the current view (where supported). Equivalent to the File menu Save command.
Ctrl+Alt+S Start sampling (if a data view is ready to sample) or stop sampling if already sampling data.
Ctrl+T Create a TextMark during sampling (if the TextMark channel exists), open the TextMark

review dialog offline.
Ctrl+U Expand (zoom out/Up) the current view around the centre of the window.
Ctrl+Shift+W Toggle writing data to disk on all channels. Always available when sampling.
Ctrl+y Show the y axis dialog.
Ctrl+z Undo the last undoable operation for the current view.
Ctrl+Break Break out of long drawing or calculation operations.

Overdrawing data in Spike2

There are several ways to overdraw data in Spike2:

e Overdraw Time or Result view data channels so that they share the same vertical space and optionally share
the same y axis. Use this to compare two or more channels, or to group similar channels. You can apply a
per-channel vertical shift to visually separate channels within a group.

e Overdraw all the WaveMark data (spikes) in a Time view time range so that they all start at the same
horizontal position on the screen and all share the same y axis. Use this so you can see different spike classes
and locate outliers. There are special mouse clicks you can use in this mode to locate individual spikes or to
give a selection of spikes a defined code.

e Overdraw data copied to an XY view for various graphical effects. Use this to generate user-defined images
and waterfall plots.

e Overdraw multiple triggered frames of data in a time view based on a list of trigger times with optional 3D
display. Use this to see how the response to a stimulus changes with time.

Interrupting drawing

Despite our best efforts to draw huge data files quickly, drawing can take a long time. You can interrupt it with
the Ctrl+Break key combination. The Break key is usually at the top right of the keyboard and is often
labelled Pause with Break on the front. If your system has sound enabled and you have selected a sound for
“Exclamation”, Spike2 plays this sound to confirm that drawing has been abandoned for the current channel.
Screen areas that have not been filled with data are filled with a uniform background colour.

Spike2 can detect that a drawing operation is likely to be slow. If it is, the mouse pointer changes to the
hourglass cursor to indicate that you have to wait. If a drawing operation takes more than 1 second, the window
title changes to remind you that you can use Ctrl1+Break to interrupt the drawing.

Spike2 may interrupt drawing during data sampling if the host computer is not keeping up with the data capture.
This is unusual, and normally only happens when you run at high sample rates with a slow interface (such as
USB 1). It can also happen with a severely fragmented disk system that has become very slow, or if you have
very little free memory and a lot of paging to disk is taking place.

If a drawing operation to a time view takes more than 2 seconds, Spike2 will try to break it up into multiple
drawing operations as long as the channels that require painting are not in Overdraw WM mode, are not
overdrawn and are not in triggered overdraw mode. If this is not possible, after 5 seconds of uninterrupted
drawing, the operating system may mark Spike2 as "Not Responding". This can lead to problems, as once the
drawing operation ends, the system may decide that the invalid area that was being redraw still needs to be
redrawn, which restarts the process.

Recycle Bin

If you do not save a created Time view, the default Spike2 behaviour when Spike2 closes the file is to move it
to the Recycle bin. We do this out of an excess of caution; some files may be very valuable and very difficult to
replace. However, this can result in the Recycle bin being filled with a large number of files, especially if you
often abandon sampling sessions and restart them.
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If you accumulate a very large number of files in the Recycle Bin, this can be time-consuming to empty. We
suggest that you check your Recycle Bin periodically and Empty it from time to time.

From version [10.20] there is a new Edit menu Preferences option in the Sampling tab that sets the minimum
duration of a created file that will be Recycled if not saved.

If you control sampling from a script, the FileClose () command has an option to not move a closed and
unsaved file to the recycle bin.

Text view topics

Text view features
Text view keyboard shortcuts

Text view features

The Log view, script views, the output sequencer and text windows created by a script all count as Text views
and they have common features. This section deals with editing features:

Drag and drop

Virtual space

Multiple selections

Select rectangular text area
Read only text

Drag and drop

The editor supports drag and drop of text both within Spike2 and between Spike2 and other applications that
support it (for example the Spike2 Help system). Spike2 also supports drag and drop for rectangular text areas.

Operation Method

Move block Select the text to move. Move the mouse pointer over the selected text and hold down the
left mouse button and drag. The mouse pointer will indicate that you can now drag the text
and the text caret will show the insertion point. Drag the text to the desired insertion point
and release.

Copy block Select the text to copy. Hold down the ctrl key and move the mouse pointer over the
selected text, click and drag. A small + symbol indicates the copy operation and the text
caret will show the insertion point for the duplicate. Drag the text to the target position and
release the mouse button to duplicate the text. The ctrl key must be down when you
release the mouse button or the operation will move the text.

Virtual space

If virtual space is enabled you can position the caret beyond the end of the text in a line by clicking in a blank
area with the mouse, or using the cursor right key. You cannot position the text caret below the last line of text.
When the caret is beyond the end of the line, it is said to be in virtual space. If you type with the caret in virtual
space, space characters will be added to fill in the virtual space up to the text you type.

There are two main uses for virtual space: to add comments without having to space along to the required
column, to make rectangular selections without having strange visual effects due to short lines.

If you use the script language to manipulate the text caret and make selections, virtual space is ignored; a caret
in virtual space will be treated as if it is at the end of the line. There are no script commands that will move the
caret into virtual space. If there is a requirement for the script to report or use virtual space, we will extend the
script in a compatible way to incorporate it.
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Multiple selections

You can make multiple selections in a text view. To do this, hold down the ctr1 key and click and drag. Each
time you make a new selection in this way it becomes the current selection; all previous selections are shown
with a different selection colour. When you have a multiple selection, each selected area has a flashing text
caret at the insertion point. If you type characters, these will appear at all insertion points, replacing all the
selected text. If you use the delete or backspace key, all selected text will vanish. Note that pasting into a
multiple selection will clear all the selected text, then insert the pasted text at the current (last made) selection.

Multiple selection can be useful when you want to move several non-consecutive script functions to make them
consecutive. Select all the sections you want to move, use Ctr1+Xx to cut them all, release Ctrl, click at the
insertion point, then use Ctr1+V to paste the result.

Select rectangular text area

You can select, cut, paste and drag rectangular selections within Spike2. To select a rectangular area hold down
the A1t key then select text with the mouse. The point where you hold down the mouse button will be one
corner of the selection, the point where you release the mouse will be the other corner. You can use this feature
to change the alignment of comments in a script, or to convert a single column of numbers into multiple
columns. You can also paste such text into other applications as plain text.

A rectangular selection will paste within Spike2 as a rectangular selection. Beware that Ctr1+X (cut) on a
rectangular selection followed by Ctr1+V (paste) will not leave the text unchanged (unless you select the text
from bottom to top). The cut operation will leave a vertical flashing line (assuming a fixed pitch font) with the
insertion point marked by a more visually obvious caret. The paste operation will paste the cut text as a
rectangular block at the insertion point. A rectangular selection is a multiple selection.

Read only text

If you open an output sequence or script file that is held in a read only file, the text window will also be marked
read only and you will not be allowed to change it. This is to allow users to protect sequences and script from
inadvertent change. If you want to edit such a text file you have two options:

1) Close the file, remove the read only status on disk, then open it
2) Save the file to a new file with a different name

You can use the Modified () script command to get and change the read only status of a text file. However, if
the original disk file is marked read only, using Modified () to allow you to edit the text will not change the
status of the disk file, so you will not be able to save it to the same file name.

Text view keyboard shortcuts

Text views have more keyboard short cuts than any other area of Spike2. We have grouped them by function to
make the huge list more digestible.

Find Replace and Bookmarks

The Find and Replace commands can be accessed from the Edit menu, from the Edit Toolbar and by keyboard
short cuts:

Key Operation

Ctrl+F Open the Edit menu Find dialog. In addition to searching for text you can also use this
dialog to bookmark all matching text.

Ctrl+G, F3 Find next.
Ctrl+Shift+G Find previous.
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Ctrl+H This short-cut key opens the Edit menu Replace dialog.

F2 Move the text caret to the next bookmark. You can use the edit toolbar to move to the next
or previous bookmark.

Shift+F2 Move the text caret to the previous bookmark.

Ctrl+F2 Toggle bookmark on the current line. You can use the edit toolbar to set or clear a bookmark
and to clear all bookmarks.

ALt+F2 Clear all bookmarks

Bookmarks tag a line for future reference. They are displayed as a blue mark to the left of the text. Bookmarks
are kept as long as the current file is open; they are lost when you close the file. The easiest way to use a
bookmark is from the Edit Toolbar. You can show and hide this from the Edit menu (when a text-based window
is active), or by clicking the right mouse button on any toolbar or on the Spike2 application title bar and using
the pop-up context menu that appears.

Text caret control

The text caret is a flashing vertical bar that indicates the current position. Do not confuse this with the I-beam
mouse pointer which does not flash and which indicates the mouse position. Each time you click and release the
left mouse button (we assume you haven't swapped the mouse buttons), the caret moves to the nearest character
position to the click point. To select text with the mouse, click at one end of the text you want to select and drag
(move the mouse with the button held down) to the other end of the text. You can also use the keyboard to
move the caret and select text:

Key Operation (+shift to extend a text selection, +a1t+shi £t for rectangular)

Left arrow  Move the caret one character left. At the start of a line it wraps to the previous line end.

Right arrow Move the text caret one character right. You can move it into uncharted territory beyond the
end of the line. It does not wrap to the next line.

Up arrow Move up one line.

Down arrow  Move down one line.

Ctrl+Left Move one word to the left/right. This means move the caret to the next boundary between a
Ctrl+Right

word character and a non-word character. Word characters are defined to be useful and vary
depending on the view type. In a script view, they are A-2, a-z, 0-9, , $ and %. In an output
sequence, they are A-7, a-z and 0-9. All other text views use A-Z, a-z, 0-9 and _ as word
characters.

Ctrl+Up/Down Scroll the text window up and down, leaving the selection unchanged.

Alt+Up/Down Move the lines containing the selection up or down by one line.

End Move the caret to the right of the last character on the line.

Home Move the text caret to the first non-white space character in the line. If already at that point,
move to the start of the line.

Alt+Home Move the text caret to the start of the current line.

Ctrl+End Move the text caret to the right of the last character in the file.

Ctrl+Home Move the text caret to the left of the first character in the file.

Ctrl+] () Start of next (previous) paragraph (after empty line)

Ctrl+\ (/) Word part right (left).

PgUp Move upwards by one window of lines.

PgDn Move downwards by one page of lines.

Insert Swap between insert mode caret | and over-type caret

Cut Copy Paste Delete Undo and Redo

Some of these operations are also available from the Edit menu and the main toolbar.

Key Operation

Ctrl+a Select all the text in the document.
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Ctrl+C Copy selected text to the clipboard. If no text is selected, nothing is copied. Some keyboards
CtrltInsert  phaye Ins in place of Insert.

Ctrl+Shift+T Copy the current line to the clipboard.

Ctrl+v Paste the contents of the clipboard into the text at the caret. If there is a selection, the
Shift+Insert gelection is replaced.

Ctrl+X Cut the selected text and copy it to the clipboard.

Shift+Del Cut the selected text and copy it to the clipboard.

BackSpace Delete the selection or the character to the left of the text caret.

Del Delete the selection or the character to the right of the text caret.

Ctrl+Del Delete word right. Add Shift to delete to the end of the line.

Ctrl+D Duplicate the selection. If it is empty, duplicate the line containing the text caret.

Ctrl+shift+L Delete the current line.

Alt+Up/Down  Move all the lines in the current selection up or down by one line. Note that this does not
work with the numeric keypad Up and Down keys. This is because holding down A1t, typing
a number on the numeric keypad and releasing Alt enters the character with the typed in
code.

Ctrl+z Undo the last interactive text operation. The editor supports more or less unlimited levels of
Alt+Backspace Undo.

Shift+Ctrl+Z Redo the immediately previous Undo operation.

Miscellaneous

These commands do not fit into any other category!
Key Operation
Ctrl+U Convert the selection to upper case. Add shift for lower case

Ctrl+Add, Sub Change font size (Add and Sub are numeric keypad + and - ). You can also change the
displayed text size by holding down the Ctrl key and using the scroll wheel on your mouse
(if you have one). The View menu Standard Display command will remove any zooming.
The script equivalent is ViewZoom ().

Indent and Outdent

The Log

The structure of Spike2 scripts is often made clearer by indenting program structures. To make this easier, you
can indent and outdent selected blocks of text to the next or previous tab stops. The tab size is set in the Edit
menu Preferences option.

Key Operation

Tab If there is a multi-line selection, all lines included in the selection are indented so that the
first non-white space character is at the next tab stop. If there is no selection, a tab character
is inserted (or spaces to the next tab stop depending on theEdit menu Preferences
settings).

Shift+Tab If there is a multi-line selection, all selected lines are out-dented so that the first non-white
space character on the line is at the previous tab stop. If there is no selection, the text caret
moves to the previous tab stop unless it is already at one.

view

The log window is a useful scratch text area that is always available. It behaves exactly like any other text
window except that deleting the Log window only hides it; use the Window menu Show command if it is
hidden or type Alt+w then 1. You can clear the contents interactively with the Edit menu Clear command.

You can type text into the window, or text may be added by a script or when an error occurs or to help us to
diagnose problems. You can also save the contents of the log view as a text file. You can limit the number of
text lines in the Log view from the Edit Menu Preferences General tab.
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The log window is the destination for output from the PrintTLog (), DebugList () and DebugOpts () script
commands, for any output from the Evaluate toolbar, for interactive commands that need to report detailed
information, to save information from the Cursor Regions and Cursor Values dialogs and is used to dump
information if a script hits an error. You can also write the current sampling configuration as text to the Log
window from the Sampling Configuration Channels tab and write useful information to it from the Spike2
About box and from Talker Info windows.

When Spike?2 starts up, it writes where is loaded the sampling configuration from to the Log view and if there
are start up problems, these are saved in the Log view.

Script uses can get the handle of this window with the LogHandle () script command. Once you have the
handle you can manipulate the view and its contents.

Grid View topics

You can create a Grid view interactively with the File menu New command or from a script with the
FileNew (17, mode%, rows%, cols$%); command. The grid can be controlled from menu commands and
from a script.

You can save and restore grid views with .s2gx files (these are XML files internally). Grids support cut and
paste of text using a Tab character to separate columns and an end of line character "\n" to separate rows.
There is also the Grdxxx. .. () family of script commands to support the grid.

What the Grid is and is not

Our implementation of a Grid is not attempting to be a spreadsheet program. It is implemented as a utility to
make it relatively easy to generate tabulated data. The initial implementation stores data as text, but we may
extend this to allow data to be stored as integers, or real numbers with some user-control of formatting. There is
no capability in the grid to refer to other cells or to allow expressions to be evaluated.
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Grid properties
The underlying grid implementation is capable of giving each cell its own font, alignment, type, frame and
colouring. In the current implementation we have restricted the grid as follows:

Size

The grid is currently restricted to 1000000 rows and 1000 columns (version 8 was limited to 10000 rows and
1000 columns). We may change this to a limit based on the product of rows and columns (so you can have
more or one at the expense of the other). Rows and columns are numbered from 0,0 at the top left. There is a
default size for grids created interactively (with an option to set the size and to resize an existing grid); from a
script you can create a grid with a defined size with FileNew (17, ...) and you can resize it with
GrdSize (). The grid is held in memory; you can exhaust memory (and make things run very slowly) with a
huge number of grid cells. In particular, saving a huge grid to a file and reading it back can take a long time,
especially if you modify properties of individual cells.
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Headers

The grid has one header row at the top and one header column on the left. You can choose to hide or show
these headers. By default the header column displays the 0-based row number and the column header displays
columns as letters: A-z for columns 0 to 25, Aa-AZ for columns 26 to 51, AAA-AAZ for columns 702-727 and
so on. The status bar at the bottom of the window (if enabled), displays the co-ordinates of the current grid
selection as numbers. Double-click on a header cell to edit it. You are not allowed to set the column headers to
empty or to white space. From a script you can set column headers with the Grdset (text$, col%, -1)
command.

Font
All cells in the body of the grid use the same font. The headers use a bold version of the same font. You can set
the font with the View menu Font... command and from a script with FontSet ().

Row and column spacing
For simplicity, all rows are the same height, which is based on the font. Columns can be sized individually, or
you can set a standard size, or you can optimise the columns widths to match the data displayed in them.

Alignment
You can apply Left, Centred or Right alignment on a column by column basis with the View menu Align
column command or from a script with Grdalign ().

Colouring
From [10.05] the you can change the background and text colouring of the entire grid, and from the script set it
by column and by cell.

Grid cell properties

Cell properties are stored at three levels: a grid default (only used when creating a new column to set the
column default), a column default (used for all cells in a column that do not set their own state), and cell
properties attached to each cell. You can set the grid default colouring with the View menu Change colours...
command and the script GrdColourSet () command. From the script you can set default column width,
alignment and colouring. You can also set individual cell colouring and contents.

Grid view history
Spike2 versionFeature

8.05 Grids added to Spike2

8.06 Grdsize () command added.

8.10 Print Screen knows about grid views, GrdAlign (n%, -2) sets alignment of all columns.

8.18 Grid views support Selection$ ()

9.10 FileList () supports grid views

10.05 GrdColourSet () and GrdColourGet () added, extensions to ViewColourSet () and
ViewColourGet ().

10.16 GrdColwWidth () extended to get width of row titles, available column space and vertical
scroll bar.

11.01 GrdInsertCols (), GrdInsertRows(), GrdDeleteCols() and GrdDeleteRows ()
added.

Information window topics

The information window is a specialised type of view which can display times and special information using a
very large font for extra visibility. Information windows are attached to a time, result or XY view and when
saved to disk these views will also save the information needed to re-create any associated information
windows when the file is re-opened.
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You can create an information window interactively with the View menu New Info window command or from
a script with the TnfoOpen () function, other script functions can be used to manipulate information windows.
An information window display is set by a string which includes special fields that are replaced by other
information (for example, the last data value on a channel or a timer).

Information windows can also display an image file instead of the standard background and either the area
containing the buttons or the window title area (or both) can be hidden if desired. These and other options are
available via a menu generated when you right-click on the information window.

In addition to displaying information and images, an Info window can be set to Speak the text contents. This
can be very useful when you cannot look at the screen during an operation, for example, when using a
microscope to make adjustments and you require audio feedback of the result of an adjustment.

From version [10.15], all features of the Information window can be set interactively from the Settings dialog;
previously hiding all the Info window buttons and title and the ability to lock the font size were available from
the InfoSettings () script command only.

When information windows are used from a script, they require idle time to allow them to update.

Copy file path, edit title

When working with file views (Time, Result, XY, Grid or text-based) you can copy the full path to the file (if
the view has an associated file) by right clicking on the view title bar and then selecting the Copy path item
that appears. This is especially useful if you have set the operating system to not display full path names.

The script language equivalent of this is EditCopy (FileName$ ()); to copy the path to the file associated
with the current view to the clipboard.

The context menu that pops up also has an option to set the Window Title. The script equivalent of this is the
WindowTitle$ () command.

Other file types

In addition to the document file types (data, result, XY, Grid, text, script and output sequencer), Spike2 also
uses:

Result view files

These hold result views (file extension .srf). Result views are created as the result of an analysis, or from the
script language, not with the File menu New command. Version 11 reads result view files written by previous
versions of Spike2. We write result view files in the oldest format compatible with the data for backwards
compatibility. Files holding raster data with event times that exceed the 32-bit timing capability of older
versions of Spike2 are only readable by Spike2 version 8 and later.

Resource files

Spike2 creates and reads resource files with the extension . s2rx. These files hold additional information about
data files, such as screen positions, channel order, virtual channels and Process information. Resource files are
associated with data files of the same name, but with the extensions .smrx, .srf and .sxy. They hold
configuration information so that Spike2 can restore the display. These files are not essential to Spike2 and if
deleted, the associated data file is not damaged in any way.

Old format resource files

Originally, Spike2 wrote resource files with a binary format and the extension .s2r. This format was compact
and fast, but inflexible. We changed to the current XML-based format at Spike2 version 7.11 and versions 7
and 8 can read old format files and write the modern format. Spike2 versions 9 and later do not read old-format
resource files. If you have old-format resource files you can use Spike2 version 7 or 8 to convert them. Open
and close the associated data file to write the new format. The Spike2 installation media includes an older
version of Spike2 for this purpose.
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Configuration files

Spike2 stores sampling configuration information in files with the file name extension is .s2cx. Spike2
versions 9 onwards do not real old format files with the extension .s2c. To convert them, load the
configuration into Spike2 version 7 or 8, sample with them, then save the configuration.

Filter bank files

These files hold descriptions of digital filters and have the extension .cfbx. They are used by the Analysis
menu Digital filters command. Spike2 does not read the old format . cfb files. To convert them open them in
Spike?2 version 7 or 8 and save them.

Multimedia files
These files have the extension .mp4 and .avi. They are created by the separate s2video program and are
opened by the View menu Multimedia Files command.

Compatibility with Spike2 version 7
The .s2rx, .s2cx and .cfbx files hold their contents in XML format. Spike2 version 7.11 onwards can read
these files; earlier versions of Spike2 cannot. The compatibility of . srf files is described above.

The Spike2 command line

When Spike?2 starts, it checks the command line for option switches and files to load. If there is no command
line, Spike2 looks in the current directory for startup.s2s and runs it if it exists. If startup.s2s is used or
the command line loads a file, start up messages that need a user response are suppressed.

The command line holds options and file names separated by white space characters (space and tab). If a file
name contains spaces, you must surround the file name with quotation marks. Options start with / or — followed
by a character to identify the option.

/M When Spike? starts, it checks if it is already running and quits if it is. /M removes the check, allowing
multiple copies to run. You need a Spike2 licence for each copy except when using multiple synchronised
1401s to capture related data on one computer under the control of a single operator, when one licence is
sufficient. Set separate file names for each 1401 in the Automation tab of the Sampling Configuration.

/Unn is 1-8 to select a 1401 when you have more than 1. The default is /U0, which uses the lowest-numbered
unused 1401. You set a device number in the CED 1401 device settings in the Device Manager (My
Computer->Properties->Hardware).

/0 Quiet start. Suppress all message boxes, the Spike2 "splash screen" and the new Spike2 version detected
help page. It does NOT suppresses the check for a sampled file that was not closed properly as this is
considered to be too important to suppress.

/Tn Where n is 0 to 9 and sets the pipe number to use when communicating with Talkers. This is for use when
sampling with multiple copies of Spike2 running and you need to associate a particular copy of Spike2 with
a particular Talker. With this option set, Spike2 will only detect Talkers that have the same /T option set.

The remaining items in the command line are assumed to be file names. Spike2 attempts to load the files in
command line order (from left to right). The files must have extensions so that the file type is known. If a script
file is included in the command line, Spike2 runs it before continuing with the remainder of the command line.

As an example, suppose we want to launch Spike2 so that it automatically opens a data file called 1ots of
data.smrx and runs doit.s2s to process it. Follow these steps:

1. Create a short cut to sonview.exe (this is the Spike2 program). To do this right-click on the Spike2
program icon and choose Create shortcut.

2. Right-click on the new short cut and select Properties and open the Shortcut tab.

3. Add "lots of data.smrx" doit.s2s to the end of the Target field. The quotes are needed because
the file name includes spaces.

4. Set the Start in field to the folder that contains your files.

5. Click OK.

This example assumes that both files are in the same folder. You could also have included the full path to each
file in the command line.
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Unrecognised command line switches and the System$ command

Spike2 ignores command line switches that it does not recognise. If you have a command line that runs a script,
it can be useful to pass other information to Spike2 using the command line. As anything that does not start with
/ or - is treated as a file to be loaded, if you want to pass additional information, you should make sure it has a
switch on the front. For example, if you want to pass a file to be processed by a script, you could have a
command line:

pathtosonview/sonview.exe -XMyFileName.dat runme.s2s
In this case, System$(0) would return "/XMyFileName.dat" and System$(1l) would return

"runme.s2s". To simplify parsing, the System$ command converts options started with a - character into
options started with a /. To pass in a string that holds spaces you must wrap the string in quotation marks:

pathtosonview/sonview.exe "-XMy File Name.dat" runme.s2s

and Systems$ (0) would return "/XMy File Name.dat".

Shell extensions

Previous Spike2 versions added shell extensions that displayed additional information in Windows Explorer
when the mouse pointer hovered over Spike2 data and script files. In Windows NT2000 and XP you could also
display file comments. These shell extensions were held in SonCols.dl1 and SonInfo.dl1 in the Spike2
installation folder. Regretfully, we removed these shell extensions at version 8, because:

1. From Vista onwards, Microsoft has removed the underlying operating system support used by SonCols
(which displayed file comments in Explorer if you enabled the Comments column).

2. There are problems with library versions that make installing SonInfo problematic. These can prevent
libraries being updated correctly when new versions of Spike2 are installed, leading to obscure crashes.

We may reinstate them at a future date if we can do it without causing problems.

Removing the shell extensions
To remove shell extensions installed by a previous version of Spike2 without uninstalling the old copy of
Spike2, open a command prompt and navigate to the old Spike2 installation folder and type:

C:\>cd \Spike7 Change to the old Spike? folder
C:\Spike7>regsvr32 /u SonInfo For all Windows versions
C:\Spike7>regsvr32 /u SonCols Only for NT2000 or XP

You may need to run as administrator to do this (particularly for SonCo1ls). To do it:

1. Click on the start menu at the bottom left of the screen.

2. In the box with "Search programs and files" type cMD

3. A list of matching files should appear including cmd. exe.

4. Right-click on cmd. exe and select "Run as administrator".

5. In the command prompt you can then issue the commands listed above to remove the shell extensions.

64-bit operating systems

Before Spike2 version 8, all versions of Spike2 were 32-bit programs, even if the operating system was 64-bit.
From Spike2 version 8 onwards, by default, we will install a 64-bit version of the program on 64-operating
systems and a 32-bit version on 32-bit operating systems. The advantages of 64-bit code on a 64-bit operating
system are:

1. The 64-bit version of the CPU has more registers and instructions; "typical code" runs maybe 10% faster.

Calls into the operating system do not transition from 32-bit Spike2 code to 64-bit system code and back.

3. A 32-bit program is limited to a 4 GB memory space, and of this, quite a bit (typically 1GB) is reserved for
the 32-bit operating system. With a 64-bit program you can use a lot more memory.

4. The new son library uses 64-bit integers to hold times; these are faster to manipulate with 64-bit registers
than with 32-bit registers.

There are some disadvantages, too:
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1. 64-bit code is typically larger (for example the sonview.exe file is 20% larger as 64-bit code).
2. Pointers in memory are double the size, so memory usage increases.

Unless your system has limited installed memory or you need access to external features (such as importers or
signal conditioners that only exist as 32-bit code), we recommend that you use the 64-bit version of Spike2 on a
64-bit operating system.

Since the advent of Windows 10, It is extremely unusual for users to install Spike2 onto anything other than a
64-bit operating system. It is likely that at some point Spike2 will become 64-bit only; this will only happen
when there is no need for 32-bit versions due to compatibility requirements with non-CED software.

Mouse buttons

Throughout the Help we assume that you have not swapped your mouse buttons over. That is, the left button is
the standard click and the right button is used for context menus. If you have swapped your mouse buttons, then
you must interpret the descriptions accordingly.

The left-hand mouse button selects items. Most items that are selectable will indicate their state by a change in
appearance. For instance the title bar of a selected window or a channel number in a time or result view.

The right-hand mouse button generally opens a 'context' menu. This is a list of items that we think are likely to
be useful in the current situation for the item you clicked on.

Folders (or where are my files?)

This topic applies to Spike2 versions 7 onwards, so we refer to installation directories as SpikeN where N
stands for 7, 8, 9 or 10, as appropriate. It should help users who are migrating from the old-style arrangement
of running Spike2 from a top level folder such as C:\SpikeN to the Microsoft-preferred installation within C:
\Program Files. Ifyou are interested in the special Spike2 folders created by the installer, see here.

Note:  The example file paths in this section relate to English language versions of Windows. Program
Files can have different names depending on the language set for the system. Similarly, My
Documents can be different in different languages.

Previously, we installed Spike2 in a top level folder such as C:\SpikeN. While this practice was satisfactory
when used with earlier versions of Windows, it has become deprecated, mainly for security reasons. We have
altered Spike2 so that it can be installed in the protected C: \Program Files folder as expected by Microsoft.
Some users prefer to keep their existing arrangements so we still allow installation into C:\SpikeN or similar;
we do not recommend or support this and the ability to install in this way will be removed at some future point.

The main change caused by installing inside C:\Program Files is that this location is expected to be read-
only as seen by users. While there is no problem in storing data files, sampling configurations, scripts and other
files in C:\SpikeN, you are not allowed to modify anything inside C:\Program Files. Therefore as part of
the Spike?2 installation new folders are created for the current user's data, for data shared between all users and
for data generated by the application.

New folders created by the installer

User data folders
User data folders are used to hold data that is directly saved or loaded by the user, for example data files,
sampling configurations and scripts. Two such folder are created by the Spike?2 installer:

e Current user data: called SpikeN in the My Documents folder for the current user. When installing
Spike2 inside C:\Program Files, the installer puts all data intended for the user's direct use here. The
folder contains the Data, Scripts, Sequence, ExtraDoc and TrainDay folders and an empty
Include folder for your own script include files. If there are other Spike2 users on the system, they
should create a SpikeN folder inside their own My Documents folder. When searching for a user data
folder, Spike2 seeks the current user data folder first and if it is not found, looks for the all-users data
folder:

o All-users data: called SpikeNShared in the Documents folder provided for all users of the system. This
is typically C:\Users\Public\Documents\SpikeNshared\ The folder contains a copy of the Data,
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Scripts and Include folders. These folders are available for multiple system users to store and shared
data and files.

Application data folders

Application data folders are used to store data that is generated by the application without any direct user
involvement, for example the default filter bank settings and the last-used and default sampling configuration.
As for the user data folders, two application data folders are created by the Spike2 installer:

o Current-user specific. This folder location has varied with the operating system version but in Windows 7
onwards the folder is C:\Users\User\AppData\Local \CED\SpikeN where User is the user name.
From [10.02], if this folder does not exist, Spike2 attempts to create it during program start up. If the
folder is not found and a different user is logged-on to the system they must either create it manually or
rely upon the shared all-users application data directory. This is the location used for saving importer
configuration files, filter bank settings, default sampling configurations and the text version of the
graphical sequence. When searching for an application data directory, Spike2 generally looks for the
current user's application data directory first and if this is not found looks for the all-users application
data directory:

e All-users application data. This folder location varies with the operating system version but in Windows 7
onwards the folder is C:\ProgramData\CED\SpikeN. If there are multiple Spike2 users on the system
this directory ensures that there is always a suitable folder available for application data. However, there
can be Access Rights problems with this folder for users without Administrator privilege. This folder is
created when Spike?2 is installed.

Usage tip

These folders can be tricky to find, especially if you are under pressure. You can make this easier by adding
them to your Favourites folder. The Favourites folder holds short-cuts to other folders; this means that you can
give the folders descriptive names in the Favourites (otherwise three of the four folders end up called SpikeN,
which is not so helpful).

The Help menu About Spike2 box Copy button includes these folders as part of the information copied to the
clipboard.

Moving your files to a new-style location

After installing inside C:\Program Files, the original C:\SpikeN folder (or whatever was used) will be
unchanged, holding both your own files and the previous installation of Spike2. You can continue to load
sampling configurations from and save data files into C:\SpikeN just as before and some users may prefer to
do this, perhaps after cleaning up (see below). Alternatively you can choose to keep your data and other files in
the new location. To do this, copy (or move) all .smr, .sxy, .s2rx, .s2cx, .s2s and .pls files, plus
any other files you might want to keep and any folders of your own into the SpikeN directory inside your My
Documents folder. Once you do that you will be able to use your data files, scripts, sampling configurations
and other files from the new location.

If the old location held .s2r or .s2c files, these are not read by this version of Spike2; you can use Spike2
version 8 to update them to the modern formats.

There can be issues in moving files. If you copy (rather than move) files to the new location and if they are
referred to in scripts or sampling configurations by their full path name, the original versions of the files will be
used, which can cause confusion. After moving your data to a new location you should check the following:

Application-level issues:

e The Sampling page of the Preferences dialog sets the folder for the temporary smr data file that is created
by sampling. By default in older versions of Spike2 this was set to be the application data folder, so you
may find that it is set to C: \SpikeN. You can set this as you prefer, or clear the path and click OK and
Spike2 will set it to an application data folder. Do not set a folder in C:\Program Files as this may
cause problems with write permissions.

¢ Global resources - some options for the global resource file location use the Spike2 installation folder.
While this location will still be used, Spike2 now uses a list of folders which are searched in turn for the
required file. The list starts with the current user's data folder inside My Documents - if you are using
global resources you should make sure the resource files are in a suitable location; the SpikeN folder
inside My Documents is probably the best place.
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e The Sample and Script bars hold lists of sampling configuration and script file names. These lists hold the
complete path to the file so if you use either of these you should update the file names so that they point
at the new file locations.

Data and XY file issues: There should be no problems with the data files themselves as they do not contain any
information relating to folder locations. However if a background image file has been set up for a data or XY
file the background image settings will contain a complete path to the image file which should be updated.

Sampling configurations: Sampling configuration files can contain a number of folder paths which may need to
be adjusted. Note that (as documented here) Spike2 now only writes sampling configuration files using the new
XML file format with a new . s2cx file extension so your adjusted sampling configuration files will have to be
converted to the new format by using them for sampling before they can be saved as XML. Therefore the
changed files will all use the new file name extension and your old configuration files will remain unchanged.
You should take care to only use the new-style configuration files once they have been adjusted and checked.

e Sequence file. If the sampling configuration Sequencer page specifies a sequence file, you may need to
edit the file path to point to the new file location.

e Automatic file-naming. If the sampling configuration Automation page sets a folder for automatically-
named files this path might be unsuitable for the new arrangement and should be adjusted.

Sequence files: If the file uses #include commands you may need to check that these still work.

Script files: 1f the file uses #include commands you may need to check that these still work. If the script uses
file path string constants, these may need adjusting. Any use of FilePath$ (2) to get the Spike2 installation
folder is likely to give problems as you should not create or write to files inside Program Files. The
parameters to FilePath$ () have been adjusted to allow you to find the My Documents folder where Spike2
data files are installed - we suggest that you change to using this location wherever possible.

Cleaning up the old installation location without moving your own files

If you change from C:\SpikeN to C:\Program Files and you want to leave your own files in C:\SpikeN,
you may want to clean out redundant files. If the new installation is a different Spike2 major version, for
example moving from version 8§ to version 11, the easiest way to remove the old installation without deleting
files that you created is to un-install the old version using the system control panel. However, if you are moving
within the same major version this would delete the current version; you can do the following instead:

e Delete the 1401, BaseDemo, ExtraDoc, Export and import folders from the old install location. If
you not put any of your own files into them, you can also remove the data, scripts, sequence, include
and trainday folders.

¢ Inside the old Spike2 installation folder itself, delete all .exe, .d11, .chm, .s21, .t14 and .tip files.
These are files specific to the Spike2 installation and will have been replaced by the newly installed files.

See Also:
Special Spike folders, View types and files, Other file types, The Spike2 command line, Shell extensions, 64-bit
operating systems, Mouse buttons, Unicode, Resource limitations, File recovery, Drag and Drop

Special Spike2 folders

The standard Spike?2 installation process creates several file system folders that Spike2 expects to find and use.
Some of these data folder are created based on the current user name. These folders are:

Public shared data
This folder is typically: C: \Users\Public\Documents\SpikellShared\ and is used to store:

e Example data file in the Data folder

e Standard script include files in the Include folder
e Standard scripts in the Scripts folder

o Talker licence information (from [10.07] onwards

This folder and the contents are created and set by the Spike installer (also see below). Most users can survive
without this folder, but various Spike2 examples and some of the scripts on our web site rely on the standard
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Include folder being found. It is the recommended place to save items that should be accessible to all users of
Spike2. From a script, you can get the path to this folder as FilePath$ (-5) ;

User data
This folder is typically: C: \Users\<UserName>\Documents\Spikell\, it is:

e Where we suggest you store user-specific data, scripts, configurations, sequences and the like
o Part of the search tree used to locate #include files

o Part of the search tree when looking for global resources

o Fallback location for information about used Talkers.

This folder is created for the current user by the Spike installer (also see below). Most users can survive without

it, but it is useful for saving user-specific items. From a script, you can get the path to this folder as
FilePath$ (-4);

Local application data
This folder is typically: C: \Users\<UserName>\AppData\Local\CED\Spikell\ and is:

e Used to store S2PSEQS . PLS - the compiled version of the graphical sequence file for sampling.

e The default New file path if no path is set in the Registry for the Edit Preferences or a problem with the
supplied path.

e The location to store the 1ast.cfgx sampling configuration and the default location for default.cfgx.
o Part of the search path for loading default configurations and #include files.

e The default location for saving IIR and FIR filter banks (filtbank.cfbx).

e From [10.07], information about used Talkers in the file sp2talks.datx.

This folder is created by the Spike installer (also see below). The lack of this folder can cause problems on
system that have separate logins for different users. This is because if this folder is missing, Spike2 will try to
use the ProgramData folder in its place. If the user has insufficient privilege to access that folder, various
aspects of Spike2 may cease to function. From a script, you can get the path to this folder as FilePaths (-3) ;

ProgramData
This folder is typically: C: \ProgramData\CED\Spikel1l and is used to store:

e Crash Dumps in the CrashDumps folder.

e Prior to [10.07] this was used for talker licence information

This folder is created by the Spike installer (also see below). It is also one of the places searched to find the last
used and default configurations and the FIR and IIR filter banks. If this folder is missing it is likely that your
copy of Spike2 was not installed properly (perhaps it was copied from another location), or that you do not

have sufficient privilege to access the location. From a script, you can get the path to this folder as
FilePath$ (-6);

Actions on start up
Spike2 version [10.02] onwards tests for the presence of 4 folders during start up. If any folders are missing, a
message is written to the log view:

The following data folders are missing:

Public, User, Local application, ProgramData

Either reinstall Spike2 for the current user or create them manually
Lookup 'Missing folders' in the Spike2 Help Index

The list of missing folders will hold one or more of the 4 possibilities. The start up process attempts to create
these folders if they are missing, so it is unusual to see this message. If you do, it likely means that you do not
have sufficient privilege to create the missing folder(s) and you will need to consult your system administrator.
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Unicode

Before Spike2 version [8.03], all text in Spike2 was represented by 8-bit characters with codes in the range 0 to
255 (hexadecimal 0x00 to Oxff). In the 8-bit character world, characters with codes 0 through 127 are pretty
much universal, for example character 32 (0x20) is a space anywhere on the planet. These are sometimes
referred to as the ASCII character set. However, character codes 128 to 255 (0x80 to 0xff) had meanings that
depended on which code page your computer was set to. As some cultures have many more characters than can
fit in the 255 available, in some cases pairs of 8-bit characters were used to represent characters. The result of
this was that you could use characters with codes above 127 to represent national characters in text views, but if
you sent a data file or text file that used such characters to someone with a computer set to a different code
page, the result was unpredictable (and often gibberish).

The solution to this problem is to use a character encoding that does not limit us to 8-bit characters. The
Unicode Consortium has defined a standard set of characters (1,112,064 valid code points) that can encompass
all the cultures on the planet. The characters are grouped into 17 'planes' of 65536 characters, of which the most
important is the first, known as the Basic Multilingual Plane (BMP). Character codes 0-127 of the BMP have
the same meanings as the ASCII codes 0-127, which is very convenient for backwards compatibility. The BMP
holds the vast majority of the characters used in everyday communication by most cultures. The remaining
planes hold more infrequently-used and specialist characters, such a music clefs, historic scripts (hieroglyphs),
playing card symbols and the like.

There are a variety of ways of storing Unicode characters in memory and in data files. Only two need concern
us: UTF-8 and UTF-16LE.

UTF-8

This is a method of storing Unicode characters using a sequence of 8-bit characters. It has the property that if
your text only uses character codes 0 to 127 (0x00-0x7f), then it is identical to ASCII text. So any Spike2 script
that you have that does not use any characters with codes above 127 is already coded in UTF-8. Character
codes in the range 128 to 2047 (0x80-0x7ff) are coded in two bytes, character codes in the range 2048-65535
(0x800-0xffff) need three bytes and character codes greater than that take 4 bytes. If your text is mainly ASCII,
or uses only European characters, this is the most compact coding. The encoding is arranged so that you can
always tell if a particular byte is the start of a character or the continuation of a character.

We use UTF-8 as the encoding for all external files (scripts, output sequences, XML resources, text in Spike2
data files). The text editor within Spike2 uses UTF-8 internally (though this is of no consequence to most
users). UTF-8 is probably the most common format used for storing Unicode in files; in March 2025 it
accounted for 98.6% of all web pages with a known encoding. All other encodings share the remaining 1.4%
and this share is falling.

UTF-16LE

This uses 16-bit Little Endian values to store the characters. This is the format that Windows uses internally for
all text. Unicode builds of Spike2 uses this format internally everywhere except where we have to use 8-bit
characters (1401 communications, serial line input and output, external text files, resource files, the script
editor, data import, MATLAB interface). In UTF-16LE, characters in the BMP (Basic Multilingual Plane) are
all represented by one 16-bit value. Characters in all other planes require a pair of 16-bit values.

Surrogate pairs

Character codes in the range 0xd800 to Oxdbff are reserved for the first (lead) of a two word pair and
characters in the range 0xdc00 to 0xdf £ £ are reserved for the second (trail) part of a two word pair. These are
known as surrogate pairs; they encode all characters that are not in the BMP.

Updating to a Unicode version of Spike2 [8.03]
Spike2 version 8.03 and onwards uses Unicode characters internally and stores output text in UTF-8 compatible
files. When you update from an ASCII (8-bit character) to a Unicode version of Spike2 our aim is that you
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should see no difference. We achieve this by assuming that any characters that we read above code 127 that are
not valid UTF-8 sequences are local code page characters, and we convert text appropriately:

e When we open a script or sequencer or text file in a text editor, we attempt to guess the format. If it starts
with a BOM (Byte Order Mark: a special code that indicates the file format) for UTF-8 or UTF-16LE, we
assume that is the format. Otherwise, if it holds no characters above code 127 or if it holds correctly formed
UTF-8 (this is easy to detect), we assume it is UFT-8. If the text is an even number of bytes long and holds 0
bytes in odd positions, we assume it is UTF-16LE. If it is none of these, it must hold 8-bit characters above
code 127 and we assume these are code page characters and we translate the text using the local code page
set on the computer. It is possible that we might be fooled into interpreting code-page text as UTF-8, but this
is unlikely for text of any length.

e When we read text from a resource or from a Spike2 data file we test to see if it holds correctly formed UTF-
8. If it does not, we assume it holds code-page characters.

However, for performance reasons, we do not convert text from #included script files. If you have included a
script file that use characters codes above 127 you must convert these by opening it in the script editor and
saving it. Note that we do not count changing the format of a text, script or sequencer file from code-page based
to Unicode as a change (the result should appear identical). To force a converted file to write you will need to
use the File Save As command or edit the file.

Backwards compatibility

If you update to Unicode by saving a script or a modified data file or a resource and you used character codes
above 127, the modified files will no longer read correctly into non-Unicode versions of Spike2 (before version
8.03). This will not stop you opening the files or resources, but any character codes above 127 will not appear
correctly. If you write all your text as ASCII characters this will not be a problem for you; you will see no
change.

The .smr (32-bit) file format has limited size fields for channel titles, units and comments. The channel units
field can be a problem as this is limited to 5 8-bit characters. If you use extended European characters, these
typically code as 2 UTF-8 bytes each, so you are limited to 2 of these, or 1 of these and three ASCII characters.
If you use a Far East typography, such as Chinese or Japanese, each character uses 3 UTF-8 bytes, so you only
have space for one such character and 2 ASCII codes.

If you require 100% backwards compatibility with old versions of Spike2 you must stick with the . smr 32-bit
file format and use only ASCII character codes for channel titles, units comments and file comments.

Character set used in scripts and sequences

The characters that are accepted as numbers, punctuation, keywords and variable and constant names in the
script language and in the output sequencer are restricted to the ASCII set. There are additional sets of numbers,
punctuation and a-z and A-Z in Unicode. For example Japanese defines wide versions of numbers and A-Z;
these cannot be used. You have a free choice of Unicode characters for comments and for string literals in the
script language.

Resource limitations

There are some limitations that are imposed on us by the operating system and the computer environment.
Some of these are obvious, some less so:

Memory

Your computer will have a fixed amount of memory (typically several GB). This is shared out between all the
competing programs as they require it. If you use a lot of memory, for example by using Memory buffer
channels and copying vast quantities of data into them, Windows will try to cope with this (especially if you run
under a 64-bit operating system), but at some point the operating system will start swapping allocated memory
to disk. This makes things much slower. If you keep allocating more memory, at some point Spike2 will start
reporting that it is out of memory. The more memory your system has, the more you can use.

If you run under particularly restrictive rights you may find that you get error -544 when Spike2 tries to allocate
the memory Working Set.
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Disk space

This is a pretty obvious limitation. Once you have filled your disk, you cannot use more space. If you use a
Hard Disk Drive (HDD) rather than a Solid State Drive (SSD) you may well find that once a disk becomes
significantly full (this may be as low as 50% full), disk operations start to get slow. It is usually well worth
periodically cleaning up your disk system by deleting unwanted files. It may also be worth de-fragmenting your
disk (though this seems less important in modern versions of Windows).

Solid State Drives (SSDs)

If you are fortunate enough to use a SSD as your drive, fragmentation is not a problem. However, be aware that
SSDs (in 2020) have limited rewrite capabilities. You SSD manufacturer will have specified a TBW figure
(Total Bytes Written) that they 'guarantee' you can write. If you divide the total drive size in bytes by this
figure, you get the number of times you can rewrite every block of memory on the drive. This figure is typically
in the range 300-1000 in 2020. This does not mean that the drive will fail at this point; it is likely that you can
write much more than this, but is does mean that SSDs are more suitable for write infrequently, read often data
than for streaming data at high speed all day long.

If you have a 1 TB drive that you use only for data capture, sampling continuously at an aggregate waveform
rate of 1 MHz, you will use around 5 GB/hour. So one total disk write will take 200 hours, and disk endurance
is not much of a problem. However, if you have a 256 GB SSD with maybe 100 GB already used for the
operating system and other programs (which will also be writing data), this may start to be a consideration and
you might consider a separate drive for data.

GDI and User Handles

Windows tracks the use of GDI objects (things like fonts, bitmaps, brushes, pens and drawing surfaces) and
User objects (things like desktops, windows, menus, cursors, icons and menu short cuts). For reasons tied up in
the history of Windows and for backwards compatibility, these have 16-bit identifiers, which meant that there
can only be 65535 GDI and 65535 User handles. Each application is limited to 10,000 GDI objects and 10,000
User objects. Most programs do not use a huge number of either (typically a few hundred of each), so this is not
usually a problem.

It starts to be a problem when an application creates lots of windows as each window will use quite a few
handles. Beware that data channels and axes all live in their own windows). You can track the number of GDI
and User objects with the App () command. Each new view (visible or not) uses some 20 to 100 of each of
these objects. This means that you can run out of handles by opening 300-400 data views (or even fewer if they
all have a lot of channels). We refuse to allow you to create new views if you have used more than 9900 of
either object. If this happens, you are probably running a script that is not deleting windows that it has created.

Symptoms of resource exhaustion
Windows does not manage running out of resources very gracefully. The symptoms include:

e Messages from Spike2 warning that there was not enough memory or resources to complete an action
e Missing areas or channels in window or screen repainting problems

e Text appearing in degraded fonts

e Poor system performance (to the point of appearing to stop)

e Crashes

If you start to suffer from these problems while using Spike2, do the following:

e Save any volatile data in case things get so slow that you cannot continue.

e Check for a lot of hidden windows in the Windows menu Show list or in the Windows... command. Close
down (and save, if required) unwanted, hidden windows.

e If you are running a script, check that you are closing all windows that you have opened. Each FileNew () or
FileOpen () should have a matching FileClose ().

e If you are running a script, have you used a huge array space, and could you reduce it? Script users can use
DebugHeap () and App (-4) commands to get information on used memory resources.

If none of the above fixes it and you suspect that some operation in Spike?2 is 'leaking' resources, please let us
know and give us the information to reproduce the effect.
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File recovery

To protect against power failure and program crashes, Spike2 makes backup copies of modified but not saved
text-based, result and grid views once every 5 minutes. These file types are held in memory and changes would
otherwise be lost in the case of an uncontrolled program exit. You can recover these files the next time you start
Spike2.

Data files (.smrx and . smr) are not saved in this manner as they could take a very long time to save and they
are not held in memory. If power is lost or the program crashes during data capture, there are other
arrangements for data recovery.

Drag and Drop

You can drag Spike2 document and configuration files from other applications and drop them on Spike2 unless
Spike2 is sampling or is running a script and has forbidden use of the File menu or is busy. This works for
applications that use standard formats to do this. The files are opened in whatever location they are dragged
from.

Microsoft Outlook

Microsoft Outlook uses its own format for Drag and Drop. From Spike2 [10.20] we have enabled use with
Outlook. To do this, we have to store the dropped files (as they may not exist in a physical form). We generate
a folder called outlook (or Outlook (n) if this folder already exists) in the current user Downloads folder.
This is typically located at:

C:\Users\<username><.domain>\Downloads

Large files can take a detectable time to save.
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Sampling data

If you worked through the Getting started with Spike2 section you already have most of the skills to sample
data. Sampling a new document is the same as working with an old one, except that the length increases with
time.

Hardware requirements to sample data

To sample data you need a CED 1401 interface: Power1401, Power1401 mk II, Power1401-3, Micro1401 mk
II, Micro1401-3 or Microl401-4. If you have a 1401plus or the original micro1401 you can capture date with
Spike2 version 7 (contact CED if you need to install this).

You can extend your data capture, or capture data without a 1401 using Talker interfaces.

Sampling configuration

Before you start to sample data you must set a sampling configuration. This defines the channels to capture, the
file type and timing resolution, how the sampling is to start, time limits for sampling and outputs to generate
during sampling. You can load a previously saved configuration with the File menu Load Configuration
command, manipulate the configuration from a script or you can set the configuration interactively with the
Sample menu Sampling Configuration dialog. This dialog holds several pages activated by the tabs at the
top, each page controlling a different aspect of data capture.

The title bar holds the name of the configuration file from which the configuration was read. There is a * at the
end of the name if the configuration has been changed. You can extract the current configuration file name and
the last user-defined name by right-clicking on the title bar. Options are:

Copy Path Copy the path to the current configuration file to the clipboard.

Copy Last New at [10.07]. This is present if the current path ends with LAST.s2cx or
DEFAULT.s2cx and Spike2 knows the file that the current configuration was derived
from. It copies the last known configuration source file name to the clipboard.

Close Close the dialog

You can copy the full path to the configuration file by right-clicking in the title bar and selecting the copy
option from the drop down menu. This is equivalent to the SampleConfig$ (0) script command. If the
configuration is modified by sampling, <s> is added to the name in the title bar.

The OK button accepts the current state, Cancel rejects any changes you have made since you opened the
dialog and the Run now button opens a new data document, ready to sample. You can also open this dialog
from the toolbar.

The sampling configuration also holds windows positions, channel arrangements and settings for on-line data
processing into result and XY views or into time view data channels. These properties are set by opening a file
for sampling, setting the window, channel and processing as you need it, then saving the configuration. To see
the script language equivalent of a configuration, load or set the desired configuration, turn recording on, open
a new file ready to record, then turn recording off.

You can open this dialog when you are sampling. Most items are disabled as most features are fixed during data
acquisition. However, you can adjust and apply changes to the graphical sequence editor.

Channels

The Channels tab lists the channels to sample. Channels are taken from a 1401 interface, from the keyboard
(TextMark data can also be read from a serial port), or from a Talker, or are Derived from one of these. For
most channels there is a free choice of channel number, but there are three Special channels (keyboard marker,
Text Marker and Digital Marker) that have forced numbers.

The top line of the Channels tab lists the number of Waveform, WaveMark and Event channels and an
estimate of the overall data rate written to the data file. As we cannot know the rates of event channels in
advance, we use the estimated maximum sustained rate set for each event channel. Note that the length of the
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available data buffering (used in triggered sampling mode to save old data) is approximately 8 MB divided by
this rate. There are also buttons to copy the configuration as text to the clipboard or to the Log window.

The main part of the dialog holds the list of channels that are configured for sampling. If the list length exceeds
the available space, you can scroll the list. Alternatively, you can resize the dialog by dragging the top or
bottom edges vertically. You can click the header of the channel list to sort the channels by most of the fields;
the A symbol on the # column (below) indicates that the list is sorted on the # column in ascending order. Click
the channel header a second time to invert the sort order.

M Sampling configuration - C:\Users\Greg\Documents\manual11.s2cx = O X

Channels Resolution Mode Sequencer Play waveform Automation

Waveforms: 2 WaveMarks: 5 Events: 2 Data rate: 38.7 kB/s Copy As Text Log
# Type Source Port Title EvtRate AdcRate Scale  Offset Units Pnts Pre
1 Waveform 1401 0 ECG 1042 1 0 Vot
2 Waveform 1401 1 AP 100.4 40 20 mmHg
3 Event 1401 0 Stimulus 10
4 Level 1401 1 Infuse 20
5 WaveMark 1401 2 untitled 100 16667 1000 0 mV 32 10
6 WaveMark 1401 3-6 untitled 100 16667 I\\ 1000 0 mv 32 10
30 TextMark COM 1 TextMark 1 "
31 [Matker pre Keybeard i ‘6 Traces 4, |deal rate 20000,No comment
32 Marker 1401 DigMark 50

New... v Duplicate n Delete 32 channels per file = Set... Reset

oK Cancel Run now Help

If you hover the mouse pointer over a channel in the list, a tool tip appears holding additional channel
information (ideal waveform sampling rate, debounce time for event and marker channels, WaveMark trace
count, channel comment, explanation of problems with Talkers). This dialog is resizeable; drag the bottom edge
to make more space to display long channel lists.

The # column holds the channel number as it will appear in the sampled data file.

The Type column displays the channel type as it is sampled. This is followed by an asterisk (*) if the channel
has an attached process. A channel with a process may be stored in the file as a different type. For example, a
Waveform channel with a process will be stored as a RealWave channel.

The Source column indicates the device from which the data is obtained: 1401 for a channel sampled by a
1401 interface, COM for a marker taken from a COM port (serial line), User for keyboard input, or the name
of a Talker. If this is a Talker that is not available, the entire line is drawn in grey text. If the Talker is available,
but there is a problem with the channel, the text is drawn in red.

The Port column indicates the physical connection on the source device that is used for the channel.
The EvtRate column is the expected (estimated) event rate for the data.

The AdcRate column displays the sample rate that waveform-based channels will use to collect data. If this is
too different from the Ideal rate set for the channel, the background of this field set to a shade of §&d (there are
controls in the Resolution tab to improve the match). The red is a darker shade for a larger difference. If a
Waveform channel has a process that divides the rate by n displays the division ratio after the sample rate
as /n. A derived channel displays only the division ratio, so a derived channel with no divide down set
shows /1 here.

The Scale, Offset and Units columns are used when scaling between user units and 16-bit integer Waveform
values.

The Pnts and Pre columns are used by WaveMark channels.

You edit the channel settings by double-clicking on a channel, or by selecting a channel with the mouse or
keyboard and clicking the Edit button. The Reset button deletes all editable channels and sets a standard
sampling state. The buttons in the dialog are:

Edit...
This opens the appropriate dialog for the channel selected in the Channel list. You can also edit a channel by
double-clicking a channel in the list.
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New...

This opens the New channel dialog to add a channel sampled by a 1401. If you know the channel type, or you
want to add a Talker channel or a Derived channel, click the down arrow to the right of the button and select the
channel type. If you want to create several channels without opening a channel configuration dialog, hold down
Ctrl when selecting the option.

Duplicate
The Duplicate button is enabled if it is possible to duplicate the selected channel. In all cases, there must be
spare channels in the file. You can duplicate a 1401-based channel if there is a spare port for that channel type.

You can duplicate a Talker-based channel if another higher-numbered channel of the same type is available
from the Talker. If you hold down the ctr1 key, the requirement that the channel is the same type is removed.

Duplicate n
The small n button next to the Duplicate button lets you duplicate a channel a set | pypiicate channel x
number of times or until the duplicate operation fails. If you need more channel
space in the file you can increase the allowed channel count with the Set
channels command.

RealWave channel 2 from StelTalk
Number of duplicates 2

[[] Allow any channel type

If the current channel is from a Talker, the Allow any channel type check box | Use the Set... button for more channels
appears. If you check this, the duplicate operation will start by looking for higher- | hep Cancel
numbered channels of any type that are free. Once these are exhausted, the search
will start at the beginning of the list of talker channels. To see the full list of channels available in a Talker,
create a single channel, open this dialog, set the number of duplicates to a large number, check the box and
click OK.

Delete
Remove the selected channel from the list of channels. If there are derived channels that depend on this
channel, they are also deleted. You cannot delete the Keyboard channel.

Copy As Text, Log
These two buttons render the sampling configuration as text in a format suitable for a laboratory notebook.
Copy As Text places the text on the clipboard. Log copies the text to the Log window (so you can print it).
The SampleConfigs () script command gets this text with additional formatting opportunities. From version
[10.07], if you hold down the ctrl key and click Copy As Text, the copied text uses Tab characters to
separate the columns.

Set channels

The Set... button opens a dialog in which you can set the maximum number of channels that can be stored in a
data file created by the File menu New command. You can also set where the special channels should be
placed. The script equivalent is the SampleChannels () command.

Reset

The Reset button clears all the sampling information in the Sampling Configuration dialog to a default state.
As this is destructive, you are asked if you really want to do it. Even if you do reset your configuration, changes
can be forgotten with Cancel. Once you use OK or Run now the changes are confirmed. The Reset button
does not clear information on duplicate windows and channels; see the Sample menu->Clear configuration
command for this.

Special channels

Most channels have a free choice of channel number, but there are three that for reasons buried in history have
forced numbers. These channels are the Keyboard Marker channel, the Text Marker channel and the Digital
Marker channel. Originally, these were at fixed channels number of 31, 30 and 32, but from Spike2 [9.01]
onwards, you can move these channels to a consecutive list of three channels in the sampling configuration by
setting a special channel number by clicking the Set... button in this dialog. The script equivalent is the
SampleChannels () command.

Special channel number Keyboard channel TextMark channel Digital Marker channel
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0 = Original scheme 31 30 32
special >=3219.01] special special-1 special-2

Moving the special channels away from their original position makes the sampling configuration incompatible
with versions of Spike2 before 9.01.

Set maximum channels

Set channels in new data files X

-

Maximum number of channels in the new file (32-2000) 200

-

Spike2 version 5.15 to 8 support a maximum of 400 channels. 4.02 to 5.14
can read 256 channels. 4.01 and earlier read data files with 32 channels.
32-bit .smr files support up to 400 channels.

Special channels (keyboard, text, digital markers) run down from lzl

Sampling to channel numbers above 100 or moving the special channels by
entering a number other than 0 generates a sampling configuration that
cannot be read by versions of Spike2 before 9.01.

Help e

The Set... button in the Sampling configuration dialog opens the Set channels in new data files dialog. In
this dialog you can set the number of available channels in the new data file and you can also choose if the
Keyboard marker, TextMark and Digital Marker channels (the Special channels) are positioned at channels 31,
30 and 32 or are positioned elsewhere in the channel map. The script equivalent of this dialog is
SampleChannels ().

Maximum number of channels in the new file

The minimum number of channels in a data file is 32 and the maximum is currently limited to 2000 (64-bit files
have a theoretical limit of 65535 channels, but this is not yet supported by Spike2). If you reduce the number of
data channels and there were channels defined in the Sampling Configuration dialog with numbers above the
new limit, these higher numbered channels are deleted from the configuration.

Currently a CED1401 interface can sample a maximum of 100 channels (you will need a 1401 interface with
expansion top boxes to use all of these channels). Before Spike2 9.01, all channels sampled by a 1401 or a
Talker had to have channel numbers in the range 1 to 100. From 9.01 onwards you can use any channel number
you wish (except a channel number reserved for a special channel).

Extra channels are often required in a data file for subsequent analysis operations, or to save additional
channels generated during sampling.

Setting a larger number of channels increase the size of the file header, which holds the channel title and any
units and sample rate information. It does not allocate data space in the file, so apart from an increase in the
channel header size per channel and in memory usage per file, there is no other penalty. The 32-bit filing
system does not allow you to change the number of channels once the file is created. The 64-bit filing system
theoretically can add more channels after the file has been created and used, but there is no support for this in
Spike2 yet. It is a good idea to allocate enough channels for your foreseeable data analysis needs. You can, of
course, export a file to create a new file with the same data and more channels.

If you select the 32-bit .smr file format in the Resolution tab but select more channels than can be stored in a
32-bit file, Spike2 will open a 64-bit . smrx file.

If you will share your files with people using old versions of Spike2 you should be aware that before Spike2
version 4.02, only (32-bit) data files with 32 channels were readable. Version 5 reads 32-bit files with up to 256
channels (5.15 onwards can read 400 channels). Version 8 can only read 64-bit files with up to 400 data
channels.

Special channels (keyboard, text, digital markers) run down from
Up to Spike2 version 9.01, the Keyboard marker, TextMark and Digital Marker channels have been treated
specially, and have always been at fixed channel numbers 31, 30 and 32 in sampled data files. It can be
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somewhat inconvenient to have these fixed channels numbers, especially in systems with many waveform
channels where it would be convenient to have then in a continuous range.

You have the option to move these channels elsewhere in the channel map by setting this field to a value from
32 to the maximum number of channels in the file. If you set a value less greater than the maximum number of
channels in the file it is limited to the maximum number of channel in the file. If you set a value less than 32, it
is set to 0 (meaning use the old scheme).

If you set a value of n, the keyboard channel is set to n, any TextMark channel is set to n-1 and any Digital
Marker channel is set to n-2. If there were channels already set at these channel numbers, the channels are
deleted.

Backwards compatibility

If you set a sampling configuration with a sampled channel at a channel number above 100 or with more than
400 channels in the file or with the special channels moved, this is not compatible with Spike2 version 8 or 7.
Spike2 version 7.20 and 8.13 onwards will reject such configurations, but older releases will not and may fail if
you attempt to load such a configuration.

Create a new channel

Mew... B The New... button creates a new channel at | channel parameters
the lowest free channel number and opens

. . i v v i ECG
the Channel parameters dialog where you can edit | <™™™ ENNNCIR Tve [E5 |
the new channel to the desired state and set the channel | 1401 Port 0 & Ideal waveform sample rate | 1000 Hz

number. To make several similar 1401-based channels, | comment | Signal from the green wire |

set up the first channel, then click Duplicate to insert a | yye  [mv | = 1oputi d J+o |
’ ) u g put in Volts X +0 |

new channel at the next free channel and physical 1401

port with the same settings. To remove an unwanted

channel, select it and click Delete. Help Quick Calibration... | | Process... Cancel

You can also use the small button to the right of New... to select the type of the new channel from a drop-down
list that also includes the names of any Talker devices that can be used as data sources and allows you to create
Derived channels from 1401 data. Selecting one of these channel types opens a Channel parameters dialog with
the channel type set.

You can also open the Channel parameters dialog from the Sampling Configuration by a click on the Edit...
button or a double-click on a channel.

Channel parameters dialog
There are five fields that apply to all data types.

Channel  The channel number identifies the channel. Channels 30 to 32 are reserved for Text, Digital and
keyboard markers (unless you have moved them). The remaining channels are for waveform,
WaveMark and event data and data from Talkers. You can change a channel number, but not to a
channel that is already in use.

Type The type of the data to sample on the channel. You can set any of the following:

Off The channel is unused, equivalent to deleting the channel.

Waveform The channel holds waveform data, stored as 16-bit integers that are scaled to user
units.

RealWave The channel holds waveform data, stored as 32-bit floating points values (useful
with signal conditioners).

Event- Event channel timed on the falling edge of the data.

Event+ Event channel timed on the rising edge of the data.

Level Event channel with the times of both data edges saved.

TextMark  The channel holds (short) text messages and their times.

Marker The data is an event with either a keyboard character or a digital value attached

WaveMark The data is a small waveform fragment, usually a spike shape

If you change the type of a waveform or RealWave channel to a non-wave type, any dependent
Derived channels are deleted.
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Title Text to identify the channel. This was limited to 9 characters before [10.07]. You can now use
longer titles. However, if you sample to a 32-bit . smr file the title will be truncated. We suggest
that you keep short titles, where possible; long titles can cause a cluttered screen. Title can include
place holders (for example %c for the channel number) that are replaced when creating the data
file, see below.

1401 port  For a waveform or WaveMark channel, this is the 1401 ADC input number. For an event channel,
this is the digital input port number. Marker channels do not use this field. You will not be
allowed to sample if you request a physical port number that does not exist in your 1401.

Comment Text to describe the channel. There is a limit of 71 characters of comment to encourage you to
keep it relatively short. The comment can include place holders (for example %c for the channel
number) that are replaced when creating the data file, see below.

Title and Comment place holders (new at [10.09])

It is a common requirement to include channel and port numbers in title and comment strings. To make channel
duplication simpler, we allow some channel properties to be included symbolically with $x markers (where x
determines the replacement). The current set of replacements are:

o\

c The channel number.

sd The source device name. This is 1401 for a 1401 channels, the talker name for a Talker channel or
Chan n for a channel derived from channel n.

Sp The ADC or Event port number for a 1401 device, the serial port number (0 if unused) for a TextMark
channel, the 0-based source channel index for a Talker device or the source channel for a Derived
channel.

su

The channel units (before any changes made by processing).

oe
oe

Replaced by a single % character.

For example, if you want to generate 16 Waveform channels you could create one on ADC port 0 and give it a
channel title "ADC %p", the use the Duplicate n command to make 15 copies that will also get the same title.
When used to generate a data file, the titles will be: ADC 0, ADC 1, ...,ADC 15.

Quick Calibration...

The Quick Calibration... button is present for Waveform and WaveMark channels if there is no signal
conditioner support installed for the channel and opens the Quick calibration dialog for the current 1401 port.
You can find the documentation for using the Scale and Offset fields in the documentation for creating a new
Waveform channel.

Conditioner...
The Conditioner... button is present for Waveform, RealWave and WaveMark data types if a signal
conditioner is connected for the 1401 port. It opens the Signal conditioner control panel.

Process...
Channel parameters
Channel |1 v ‘ Type Waveform ~ Title ‘ECG slope

1401 Port 0 v Ideal waveform sampling 1000 Hz

Comment ‘ ECG + Difference + Low-pass filted ‘

Units ‘ Volt ‘ = Input in Volts x ‘1 +(0 ‘

2 processes, scale: 1000, units: Volt/s

Help Quick Calibration... Process... Cancel

The Process... button is present for Waveform (and RealWave from [10.08]) channels sampled from a 1401. It
allows you to add real time data processing to the waveform channel that is applied before the data is written to
disk. This is a new feature in Spike2 version [10.01]. If you apply any process, the channel is saved as
RealWave data, even if sampled as Waveform. When you add processes, a text line appears in the dialog listing
the number of processes and any changes these make to the scale, offset, units and sample rate of the channel.
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Quick Calibration dialog

This d.1a10g is av.a.llable for Waveform and WaveMark channels that do not ADC 0 quick calibration >
have signal conditioner support. It if for use in the common case where:

. [ . Required calibrati its V v
e The channel units are kV, Volts, millivolts, microvolts or nanovolts SquiSCeiReERon anis: 8

' . 10

e An input of 0 at the 1401 ADC input is to be recorded as 0 Yol zmplicrgan -

¢ You know the total gain between the measured signal and the 1401 ADC Help Cancel
input

e The total amplifier gain is in the range 0.0005 to 10°

If these conditions are satisfied, you can type in the gain, click OK and the correct gain and unit values for
Spike2 to use will be set in the Channel parameters dialog. If the channel units are already set to a scaled Volt
value the dialog will pick up the current settings. We accept most forms of the units (microvolt, microV, uV...)
and ignore case. The channel units are set to one of: kV, V, mV, uV or nV.

There is no special script language support for this dialog. If recording is turned on, the effect of this is
recorded when you open a new file for sampling. When you turn recording off you will see the following in the
recorded file for a 1401 with a +5 Volt input range:

SampleCalibrate(1,"mV",100, @); 'scale and offset

If the front end amplifier has a gain of 10, the full range of the input represents £500 mV, rather than +5 Volts
(for unity gain), so we need a scale factor of 100.

Maximum sampling rates

The ultimate limit on the sampling rate is how fast data can be transferred from your 1401 to the host. If you
use a USB 2 interface, this can manage rates between 10 and 40 MB/second (depending on the type of 1401),
so this is not usually a limit. However, if you have an early Power1401 with a USB 1 interface or if you plug
your USB 2 capable 1401 into a USB 1 port, you will be limited to around 1 MB/second. The PCI interface has
a similar limit to USB 1. If your 1401 has a choice of interface, USB 2 is by far the quicker.

Another limit on throughput is the maximum ADC sampling rate that your 1401 can achieve. You should
consult the Owners Guide that came with your 1401 to get the details. The sampling configuration allows you to
specify the target 1401 type. You are limited to achievable rates for the selected target.

Waveform channels

The waveforms you record are continuously changing voltages. Spike2 stores

waveforms as a list of 16-bit numbers in the range -32768 to 32767 that represent the

waveform amplitude at equally spaced time intervals. The process of converting a

waveform into a number at a particular time is called sampling. The time between two

samples is the sample interval and the reciprocal of this is the sample rate, which is the ~—. " ——
number of samples per second. The dots in the diagram represent samples; the lines

show the original waveform. The 1401 interface samples data as 16-bit values, so it is natural, and space
efficient to store the data as 16-bit values in a Waveform channel. From Spike2 version [9.01] onwards you can
also choose to sample data as 32-bit floating point values in a RealWave channel.

Minimum sample rate

Original waveform O——0O- Resulting waveform
0 1 2 3 4 5 6 7 8 9
samples
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The waveform sample rate must be high enough to represent the data. The sample rate must be at least double
the highest frequency contained in the data. If you do not sample fast enough, high frequency signals are aliased
to lower frequencies (as shown as the resulting waveform in the diagram). On the other hand, you want to
sample at the lowest frequency possible, otherwise your disk will soon fill. Unlike many data capture systems,
Spike2 lets you capture different waveform channels at different rates to minimise data file sizes.

Use of filters
Many users pass waveform data through amplifiers or signal conditioners with filter options such as the CED
1902 to limit the frequency range. Some transducers have a limited frequency response and require no filtering.

Input connections

Channel 89 ]10]11[12[13]14] 15| Gnd
Power (37 pin) | 28 [ 29 [ 30 | 31 | 32| 33 [ 34 | 35 | 1-19
Power (44 pin) | 33 [ 34 [ 35| 36 | 37 | 38 [ 39 | 40 | 3-10

Connect your waveform channels to the 1401 ADC inputs. Channels 0-7 (0-3 for a Micro1401) are the labelled
BNC connectors. Channels 8-15 are on the Power1401 rear panel 37-way Cannon connector except for late
model mk I and all Mk II, which have a 44-way high density connector and each signal has its own ground. Pin
numbers are given in the table. If you have an ADC expansion fitted you will have more channels; see the
accompanying documentation for the connections. Power1401 top boxes can reassign the rear panel channels.
The standard input Voltage range is £5 Volts. If you have a 10 Volt system check that the Voltage range is set
correctly in the Edit menu Preferences.

Waveform dialog

Channel parameters

Channel |1 v ‘ Type Waveform ~ Title ‘ECG
1401 Port 0 & Ideal waveform sample rate | 1000 Hz

Comment ‘ Slgnal from the green wire ‘

Units ‘ mV ‘ = Input in Volts X + 0 ‘

Help Quick Calibration... Process... Cancel

The Waveform channel dialog has the standard fields, plus:

Ideal rate Set the Ideal waveform sampling rate field to the desired sampling rate for this channel. The
actual sample rate will be as close to this ideal rate as possible. The AdcRate column in the
Sampling Configuration dialog displays the actual rate (in varying shades of red if it differs to much
from the ideal rate). If the rates differ too much, adjust the optimisation and clock settings in the
Resolution tab. If you sample with a rate that is outside the range 10% less than ideal to 30%
more, a warning is added to the Sampling Notes.

This determines the rate that the 1401 uses to capture data. If you add a real time process to the
channel that down-samples the data, this will change the rate that is written to the disk file and the
rate that is visible within Spike2. For example, you might capture a channel at 1 KHz, then use real
time processes to low-pass filter it to 40 Hz and down sample it to 100 Hz.

Units This field holds the waveform units. Units are limited to 10 characters in 64-bit smrx files and to 5
in .smr files. Shorter strings are preferred. The following fields are the scale and offset to convert
the 16-bit input into user units. If your target units are some variety of Volts (for example mV or
uV) you may be able to use the Quick Calibration option. Note that if a channel has Processes, from
version [10.09] if the process causes a change to the scaling, offset or units, these changes are
applied to the values set here. Prior to this, no changes were made to allow fro processes.

input in user units = (16-bit input value/6553.6) * scale + offset

This is arranged so that with a 5 Volt input range, the scale is the number of user units for every
one Volt increase in input; offset is the value represented by 0 Volts at the input. In this case:

input in user units = Volts at the input * scale + offset

However, some systems have +10 Volt inputs. In this case:

4-9



Spike2 version 11 for Windows

input in user units = 0.5 * (Volts at the input) * scale + offset

When used with a RealWave channel, the scale and offset are used to convert the floating point
values into 16-bit values for situations where the channel is required in integer form.

Scale See the Units description.

Offset See the Units description. If your offset is 0, see the Quick Calibration option.

As an example, consider a situation where a waveform represents a position. 1 Volt is equivalent to 10 mm and
3 Volts is equivalent to 50 mm and the 1401 has +5 Volt input range. In this case you would set:

scale = (50-10)/(3-1)=20.0 mm V-!

offset = 10 - (1 Volt) * scale =-10.0 mm

Units = mm
To display in metres in place of mm, set scale to 0.02, offset to -0.01 and units to m. You can calibration a
channel after sampling from known input data with the Analysis menu Calibrate command.

A common requirement is to display the sampled data in millivolts. In this case, just set the Units to mV, the
scale to 1000 and the offset to 0.

For the scaling to work as expected, the Edit menu Preferences option for Voltage range (5 Volt range or 10
Volt range) must be set correctly for your 1401; this should happen automatically for a modern 1401 where we
can read back the voltage range. Since version 6.12, we store the voltage range in the sampling configuration
and adjust matters as appropriate. If you open an old sampling configuration, we will assume that the voltage
range is whatever is currently set.

Note that the scale value associated with a channel of sampled data and accessed by the ChanScale () script
command is the same as the scale value defined here for 5 Volt systems, but will be double the value here for
10 Volt systems. The scale and offset values defined here are also set by the ChanCalibrate () script
command.

Process...

The Process... button is present for Waveform channels sampled from a 1401. It allows you to add real time
data processing to the waveform channel that is applied before the data is written to disk. This is a new feature
in Spike2 version [10.01].

Event data

Spike?2 stores time stamps efficiently as integer multiples of the time resolution set in the Resolution
tab of the sampling configuration. Simple time stamps with no other attached data are called events.
Each event uses 8 bytes of storage. The 1401 recognises events as changes of state of TTL
compatible signals connected to the 1401 digital input bits 15-8. We refer to these inputs as event
ports 7-0. There are three types of event:

VY[ 1A Y f

Event- (falling edge) Event+ (rising edge) Level (both edges)

Event-  Spike2 saves the time of the falling edge of the input signal. The minimum input pulse width is 1 ps;
wider is better.

Event+  The same as Event-, but Spike2 saves the time of the rising edge.

Level Spike2 saves the time of both edges. Pulses should be a minimum of 20 pus wide or the time
resolution set for sampling, whichever is the larger. Do not use this type unless you need the times of
both edges. From Spike2 version 8.00, Level events are actually a form of Marker data and the state
of the event (low going or high-going) is stored in the marker code.

Micro1401 and Power1401 event port connections

Event ports 0 and 1 are BNC sockets on the front panel. If you have (&.1 ®2 @2 @ 5 6.7 .8 .0 .10 11 .12 .7
the optional Spike2 top box, event ports 7-2 are also on BNC sockets,

otherwise you must use digital input bits 15-10. The digital input

connector is on the rear panel. If you want to use the rear panel digital input connector for event ports 0 and 1
there is an option in the Edit menu Preferences... to use the rear panel connector for all events.

0,058,581 19 20721 2023 04 25
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Input connections (digital input)
Digital input bit 15| 14 [ 13|12 |11 [10] 9 | 8 |Gnd
Digital input pin 1 | 14| 2 |15 3 | 16| 4 | 17 | 13
Event port 7 6 5 4 3 2 1 0

The pin connections for the digital input connector are the same for all 1401s:

Event dialog
The event channel dialog is similar to the waveform | channel parameters
dialog. There is no Units field and there are new fields

. . 1] : v itle | Stimul
for the Debounce period and the Maximum event <= [t -] Tpe [Foem Tite | Stimulus |
rate. If two events are closer together than the 1401Pot[0(Diging) Maximum event rate | 50 Hz
debounce period, the second event is ignored. You can | comment [Marker for stimulus pulses |
also set a negative value (-1 recommended) to convert Debounce () [0 |

simultaneous events into events at consecutive clock
ticks. Set this field to 0 to disable this feature; setting 0
saves processing time. Help Cancel

The Maximum event rate should be set to your

estimate of the maximum mean event rate sustained over a few seconds. When used with Level data, the rate is
the rate of edges. This is not the maximum instantaneous rate, which may be much higher. Spike2 uses this
information to optimise buffer space allocation. The buffer allocation also determines how far backwards in
time triggered sampling can extend so setting a realistic value can be important.

As an example, an event channel might have a mean rate of 30 events per second, but it could have an
instantaneous maximum rate of 1 kHz if two events fell within 1 millisecond of each other. In this case, the rate
you should enter is 30 Hz, not 1000 Hz.

Debounce

This field appears for Event-, Event+ and Digital Marker channels. It sets the minimum acceptable interval
between consecutive events in milliseconds. Events closer that this to the previous event are not saved to disk.
This is typically used when events are logged from a mechanical switch. Mechanical switches commonly have
bouncy contacts, such that when you activate the switch you can get multiple switch actions in a short period of
time. You can use this setting to keep the first of a series of pulses and reject all the extra ones within the
debounce period of the first. There is a time penalty for setting this value non-zero, so you should only use this
option if you need it.

In terms of system performance it is always better to fix the bouncy signal (for example by using a better switch
or an electronic switch debouncer) as all the extra events use up 1401 resources to capture them and transfer
them to the host computer where additional resources are used up in eliminating them.

There is a Channel Process option to debounce event channels off-line.

Level event channels

There is no on-line debounce option for Level event channels. If you sample to a 32-bit smr file we save all the
data, as sampled; duplicated event times may cause some problems with subsequent analysis. You can use
SonFix to repair such files.

The 64-bit smrx file system implements a data buffering scheme that allows us to delete pairs of duplicated
times. This means that any even number of level events at the same time are deleted and an odd number are
recorded a single event. There is still the possibility of a problem with this scheme if a commit happens that
writes a level event, then the next event is at the same time. As a future extension, it may be possible to keep
pairs of level events at the same time by setting the second event one tick later; this would at least preserve the
event if not the timing of it. This would probably need to be an option; most multiple events are not intentional.

There is a Channel Process option to debounce Level event channels off-line.
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Keep all events
You can also set the debounce period to -1 to ask the system to attempt to keep simultaneous events by giving
simultaneous events consecutive clock ticks.

When to use this option

If you get a message from sampling stating that there were multiple events at the same time and suggesting that
you use this option and it is not practical to fix the event source, then enable this option. This warning only
occurs if the repeated events are so quick that two or more get the same time stamp. It is more common that you
have events that look correct, but the number of events counted between cursors is more than you expect.
Zooming in on the data will reveal that what looked like single events were, in fact, multiple ones. A simple
way to find these is to display the event channel as an instantaneous frequency.

TTL compatible signals

TTL stands for Transistor-Transistor Logic, a method for passing logical information between devices using
voltage levels. Levels above 3.0 Volts are in the High state, levels below 0.8 Volts are in the Low state. Levels
in between 0.8 and 3.0 Volts are undefined.

Do not subject 1401 TTL inputs to voltages above 5.0 Volts or less than 0.0 Volts. CED hardware has special
circuits on TTL compatible inputs to provide some protection, however determined abuse will damage them.
The 1401 TTL compatible inputs are pulled up by a resistor to 5 Volts. They require a current of no more than
0.8 mA to pull them into the Low TTL state. Alternatively, you can connect them to ground to pull them low
(this can be useful for the Trigger input). See the Owners handbook of your interface for full details of all input
ports.

Marker data

Spike2 samples keyboard markers and digital markers. The keyboard marker channel is
always sampled, the digital marker channel is optional. A Marker is a 64 bit time plus 4
bytes of marker information (codes). The first of these 4 bytes is the ASCII code of the
keyboard character pressed by the user or an 8 bit digital code read by the 1401. The
remaining three bytes are set to zero. When marker data comes from other sources (such as
Talkers or the script), all 4 codes may be used. There is also an additional 4 bytes that are reserved for future
use, either as 4 more marker codes, or as an addition 32-bit value.

Code 0
Code 1
Code 2

Code 3

Spike2 treats all marker types identically once the data has been captured; they differ only in their source. You
can also treat data types that are derived from markers (such as WaveMark, TextMark and RealMark) as if they
were markers.

The keyboard and digital markers are sampled on particular channels numbers, see Special channels for details.

Keyboard markers

The timing of Keyboard markers is not precise; it depends on the load on the computer. Use the event inputs for
exact timing. Any keyboard character that is not trapped for a special purpose (for example Ctr1+L opens the
Evaluate window) is recorded, but only when the sampling document window is the current window. In the
special case where keyboard markers trigger writing data to disk, the exact time at which the trigger took effect
is stored. The keyboard marker channel is always enabled.

From [10.10], the Keyboard marker channel can be the target of an online Measurement to data channel
process.

Keyboard markers can cause the output sequencer to jump to a particular instruction and the arbitrary waveform
output to play a particular waveform. In both cases this happens when the key pressed matches a key set in the
sequencer or waveform output.

Keyboard markers are not only used to record key presses. During data sampling, keyboard markers with
specific codes are added on the following events:
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Timed mode sampling start and stop
Each time sampling starts due to timed sampling mode code 00 is added. Each time sampling stops, code 01 is
added.

Channel gain change and no TextMark channel
If a signal conditioner changes the state of a channel, the system attempts to add code 02 to the TextMark
channel. If there is no TextMark channel, it adds code 02 to the Keyboard marker channel.

Special keyboard codes
Codes 00, 01 and 02 are reserved and mark sampling changes. Do NOT use them, or codes above 0x7F, to link
the keyboard markers as they will not trigger other actions (PlayWave, Output sequencer).

Talker drift diagnostics
From Spike2 version [10.16], when a Talker is asked to provide drift information it adds diagnostic codes Dx (x
is a hexadecimal digit) to

Data overrun

If a data overrun occurs that causes data to be lost, but that does not cause the integrity of the data sampling to
be compromised, special keyboard markers with a first marker code of OxFF are written to the keyboard marker
channel. From Spike2 8.04a onwards, the second marker code is a sum of codes for the source that caused the
problem. The source codes are:

2 Event channel overflow. There are so many changes happening on the event inputs that we have had to
ignore some of them. This is usually caused by noisy input signals. Setting a debounce period will not fix
this as debounce only applies after the data has been captured and stops excessive events from being
added to the data file. You should fix this problem as the work being done in the 1401 to deal with these
inputs may block other 1401 activities.

4 There are more WaveMark channel spikes being captured that can be transferred and we have had to
ignore some. This has never been reported in normal use. It is likely that sampling would be stopped for
other reasons before this error could be generated.

64 The output sequencer was unable to keep up with the sequencer interval you set. In many cases this will
not be a problem, but if you were relying on the sequencer timing being exact you may need to check that
this did not occur in a timing critical part of the sequencer code.

Digital markers

The digital markers are timed as accurately as the event data. They T .2.3 2@ @° 0 @ 9 0.1 @
record 8 separate channels of on/off information, or one channel of 8 14 015 V15 V17 913 @10 €200 1 20@23®)4 V05
bit numbers, or any combination in between. Digital marker data is

sampled when a low going TTL compatible pulse is detected as described below. The data is read from bits 7-0
of the 1401 digital input. Recording of the digital marker can also be triggered from the output sequencer.

Digital marker dialog
The Maximum event rate field is used to allocate the | channel parameters
system resources for data capture on this channel. Set a

. . . Channel || 32 < Type [Mark - Title | DigMark
reasonable estimate of the maximum sustained data rate  ~ | Tupe [Merker e | Dighark |
over several seconds. Do not set the peak rate or you Marinuen eventit= | 30 bz
will waste resources. Comment ‘ Digital marker input, digital input bits 7-0 |
The Debounce (ms) field sets the minimum period Deboupea (ns)l| 0 |

between digital marker events with the same marker
code that you expect and is used to reject spurious
markers caused by bouncy mechanical switches.
Markers with different codes can be spaced closer than
this time as long as the time difference is not 0. You can also set a negative value (-1 recommended) to assign
markers at the same time to consecutive clock ticks. Set this to 0 to disable this feature (which saves time on
every Marker).

Help Cancel

Digital marker connections
IMJ;rkerdatabit [7] 6] 5] 4] 3[2]1]0]acndl]
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[Digitalinputpin | 5] 18 6 | 19| 7 [ 20] 8 [ 21 ] 13 |

The digital marker is read from data bits 7-0 of the digital input connector. The Micro1401 and Power1401
require a pulse on digital input pin 23 to flag a digital marker. In addition to the data lines, there is an optional
handshake (h/s) signal.

] Micro & | To flag an event, apply a low going TTL pulse at least 1 us wide to the Event flag
Signal Power | input. When the 1401 detects a falling edge at the Event flag input, it sets the h/s line
pin 23 active (within a few microseconds). The falling edge of the Event flag input latches the
input data in the Micro1401 and the Power1401. The h/s returns to a non-active state
after the 1401 reads the input (meaning external equipment can send another value
without danger of it being lost). There is no requirement to make use of the h/s signal.

Event flag
h/s pin 24
h/s active TTL low

Digital marker output sequencer link

There are links between the digital marker channel and the output sequencer. If the REPORT instruction is used
in an output sequence, this simulates a digital marker input pulse and causes the digital input to be read and the
time to be recorded. As this is an internal activity, the handshaking described here is not available.

You can also use the MARK output sequence instruction to record a digital marker without reading the digital
inputs (the instruction sets the 8-bit marker code). This instruction is often used to record output sequencer
actions as part of the data file.

You can mix externally and internally generated digital markers, but this is not recommended unless care is
taken to differentiate between the two sources of markers during analysis. This could be done by connecting the
external marker handshake line to one of the digital marker data bits so that all external markers were flagged.

Warning: The DIBEQ, DIBNE, DIGIN and WAIT sequencer instructions use the same inputs as the digital
marker and can cause digital marker events to be missed with old 1401 hardware and firmware. This is only an
issue with Powerl and Micro2 units with very old FPGA images. Spike2 will warn you if this is an issue with
your hardware and you can download up-to-date firmware from our web site to fix this.

Marker codes

When Spike2 displays markers, or data derived from markers, such as WaveMark or TextMark data, by default
it shows the code of the first of the four markers. Marker codes occur in several other guises, for example to set
trigger codes, in the TextMark dialogs, as arbitrary waveform output codes and in the spike shape module.

Marker codes have values from 0 to 255. The first half of this range (0-127) is the same range of numbers that
the ASCII character set uses, and it is often convenient to treat the codes as ASCII character codes (for instance
when dealing with keyboard markers). At other times it is more convenient to deal with the codes as numbers.

Whenever Spike2 displays a marker code that is the same as the ASCII code of a printing character, it shows
the printing character, otherwise it displays the character as a two digit hexadecimal code. Hexadecimal (base
16) numbers use the standard digits 0 to 9, but also use a to £ or A to F (for decimal 10 to 15). Thus 00 to 09
hexadecimal is equivalent to 0 to 9 decimal. 0a to 0f is equivalent to 10 to 15 decimal. 10 to 1 f hexadecimal is
16 to 31 decimal, 20 to 2f is 32 to 47 decimal and so on. This behaviour can be changed so that only
hexadecimal codes are displayed on a channel by channel basis using the Draw Mode dialog or with the
MarkShow () script command.

+0123456789abcde £ Theprinting characters are 20 to 7e hexadecimal, 32 to 126
20 'Y 4 $ % & M () *+, - ./ decimal as in the table. Character 7f may or may not print,
300123456789 :; <=2>7? depending on the character set. To find the hexadecimal code
40 @ ABCDEFGHIJKLMNO ofaprinting character, add the number above it to the number
28 PQ E S (1; U \é w i Yz }E i ] —  to the left of it. For example, the hexadecimal code for A is

abdcdaetgnh Ll M ™9 41, To convert a code to a character, look up the first digit in
MM pgrstuvwxyz{ ]|} ~

the left column and the second in the top row. For example,
3f codes to ?, the intersection of the row for 30 and the
column for f.
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When typing marker codes (for example in the Gate Settings dialog, or when assigning codes in the spike
shape module), type two hexadecimal digits for a code or type a single character to stand for itself. Most places
that accept marker codes will not let you type in an illegal combination.

TextMark data

This type is a combination of a marker and a text string. It is stored as a time
and 4 bytes of marker information followed by a text string that can be up to 80
characters long. This type allows you to insert timed comments into a data file.
In the special case where the TextMark channel triggers data sampling, the
precise trigger time is stored. From a script you can set longer or shorter strings
when you create the sampling configuration with the SampleTextMark () command. Most files have at most
one TextMark channel, but you can create more with memory channels or by importing data with multiple
TextMark channels. The Sampling Configuration dialog allows you to create one TextMark channel.

Code 0
Code 1
Code 2

Code 3

This is one of the Special channels and the channel & cpannel parameters
number is fixed to either 30 (for compatibility with old

sampling configurations), or is the special channel checral [0~ vee R v
number -1. The Special channel number is set by the |S°euce [COMport5 ~ Meumenicventate | 1 e
Set channels in new data file dialog, or by the |Comment |Text can come from a serial port or by typed by a user |
SampleChannels () script command. If you select the | go mark ein | Match [ M[(72)8 | 7ISequencer link (] PlayWave
channel number reserved for the TextMark channel, the : -

X 3 Baud rate 9600 v Data 8 bits, no parity  Flow None v
data type is forced to TextMark. The Maximum event
rate sets the expected maximum TextMark rate over Help TextMark List... Cancel
several seconds and is used to allocate sampling
buffers.

COM port (serial line) input

The Source field can be set to Manual (data is added by user interaction) or a choice of COM ports. COM
ports, also called by names such as Serial line, RS-232 or RS-423 ports or UART ports, are a relatively slow
communication protocol that has largely been overtaken by USB. However, many devices still use these ports,
or simulate them with USB. RS-232 ports have been deprecated in modern computers since the 1990s, but
serial line devices and USB devices that emulate serial interfaces are commonly in use. If you have a device
that generates serial line output it is likely that you will be using a USB to Serial converter to generate the
external serial port, so consult the documentation that came with the converter for pin connections.

From [10.09] we identify ports that currently exist on your computer as COM port n (from [11.00] the drop
down list includes the port friendly name), and ports that you can select, but that do not currently exist on this
machine as (COM n) with n in the range 1 to 19.

Spike?2 is set to expect to read 'lines' of ASCII text that may contain one or more marker codes. The time
associated with each line of text is the time at which the first character of the text was collected by Spike2. The
end of each line is marked by a terminator, which you can define.

If you select a serial port more fields can be set.

Line termination

The EOL mark field (End Of Line mark) sets the input that terminates a text line. Spike2 needs to know the
final character(s) of a message from a device, otherwise it cannot tell when the device message is complete.
This field allows you to specify the character or characters that terminate a line. These characters can be typed
as text. You can also include \r for carriage return (ASCII code 13), \n for line feed (ASCII code 10) and \t
for Tab (ASCII code 9). If the field is left empty, the system uses carriage return (\r or ASCII code 13) as the
line terminator. You can also use \xNN, where NN stands for two hexadecimal digits. For example if all lines
ended with the letter £, N and D followed by the ASCII code 0 you could set the terminator to:

END\x00

You are allowed up to enter up to 7 characters to define the terminator. Note that the line end characters are not
included in the text that is saved. All received characters are included in the captured text except character code
0 (which terminates text strings).

We expect that the received text is either ASCII characters, or UTF-8 characters. If you need to receive binary
data from a serial port you can do this from a script using the serial line support routines.
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Before Spike2 [10.18], you could supply one termination character only and characters codes less than ASCII
32 were ignored unless they were the terminator. The field was called Terminate and used the same coding as
for marker codes, so a single character stood for itself; two characters were interpreted as a hexadecimal code.
Common codes were 0D for carriage return (the default) and 0a for line feed; 00 could not be used. If you did
not set a terminator, or set 00, 0D was used.

From [11.01a], if an input line reaches 200 characters without a terminator, the line is considered terminated.
This is done so that the user gets some indication that line termination is probably set incorrectly.

Match the text to use for the code

The serial data can set the marker code associated with each data item. Prior to version [11.00] this was done
by ending the text with a vertical bar followed by a decimal or hexadecimal number (starting with 0x) that
encoded the marker codes c0, c1, c2 and c3 as: cO + 256* (c1+256* (c2+256*c3). Each code is in the
range 0 to 255.

The Match field allows you to override this method, which can be useful if you do not have control over the
format of the serial line data. If the field is empty, the old method is used. See here for details and examples.
The script equivalent is SampleTextMarkLink ().

Serial line settings

You can also set the standard serial line parameters for Baud rate, data bits and parity and handshaking (Flow).
These must match the data source for reliable operation (so you need to read the manual that came with your
data source device). You can set the flow control to None (works in the majority of cases), Hardware (needs
additional RS-232 pins to be connected) and XON/XOFF (uses transmitted characters for flow control). Set
None unless your data source requires you to use one of the other protocols. If you have a choice of Baud rate,
choose the highest one available on your device. If your device does not talk about data bits and parity, choose
8 bits, no parity.

It may be that your device has a USB interface and that when you plug it in, it appears on your computer as a
COM port. In this case, it is quite possible that the it does not matter what serial line parameters you select as
there is no serial line involved.

When reading the serial line, characters codes below 32 are ignored unless they match the terminator. The
marker time is set when the first character arrives except for the special case where the TextMark channel
triggers data sampling, when the precise trigger time is stored.

The script language can also access the same COM port as is being used for TextMark input. The script
language will usually use this ability to write text to the port; this will often be used to configure or to trigger
the device attached to the port. The port is opened for TextMark input when the sampling file is created and is
closed when sampling stops. However, if it has been opened in the interim by the script language, it will remain
open for script use until closed by the script. Both the script and TextMark input can open the COM port
without blocking each other. Beware that on open, they both configure the port and flush the buffers.

Time of serial line input

The time attached to the input is the latest data acquisition time known when the first character of the message
was read. Prior to Spike2 version 9.04, it was the time for which all data had been received, which was typically
a few (2-5) milliseconds in the past. Data transmitted via a serial line will always have some latency. At 9600
Baud it takes around 1 millisecond to transmit a character, at 115200 Baud it takes around 0.08 ms. Even if no
serial line is involved (your device is purely USB and emulates a COM port), there is still time latency through
the USB system of order 0.2 ms in USB 2.0. If you need more precise timings, use an event channel.

Sequencer and PlayWave link

These check boxes allow codes received from the serial line to trigger output sequencer jumps and arbitrary
waveform (PlayWave) output) normally done by the Keyboard Marker channel. The script equivalent is
SampleTextMarkLink ().

Trigger...

This button is enabled when a COM port is set as the source of the data. The button opens the TextMark
Trigger dialog, which sets a prompt string to send to the COM port and the time interval at which to repeat the
prompt. This is for devices that require an input to cause them to send information. This was new at version
[11.02].

4-16



Sampling data

TextMark List

Click this button to open the Set TextMark list dialog in which you can edit the pre-set list of TextMark items
that can be applied during sampling. This dialog also has separate controls to link manually applied TextMarks
to the output sequencer and arbitrary waveform output.

Manual input

B! Create TextMark for Dataf X
Codes | 03 : 00 : | 00 : 00 : at save time Set Time Clear Time Save
‘ This is an example comment with a marker code of 03 ‘

TextMark data is added to your file during sampling from a serial line and with the Sample menu Create a
TextMark... command. You can also activate the dialog from the system toolbar and with the Ctr1+T key
combination as long as the sampling data file is the active window.

|:| TextMark data is drawn as small rectangles. The rectangles are yellow unless the first marker code is non-

zero, in which case the same colour coding as for WaveMark data is used. Move the mouse pointer over a
marker to see the attached text. Double click to view and edit the text and codes and display a list of the
markers in the file.

If you enable this channel, Spike2 logs any programmable signal conditioner changes as TextMark items.

Link to signal conditioner changes
If the TextMark channel is enabled during data capture with a programmable signal conditioner and a signal
conditioner change occurs, a TextMark with an explanatory message and code 02 is added to the channel.

High TextMark sample rates

TextMark data was not (originally) designed with high sample rates in mind. However, some users have taken
to using this channel type to store large quantities of data at relatively high sample rates. Some steps were taken
at version 7.11c to make this work better, and more changes were made in version 8. If you have large numbers
of TextMark data items in a file we limit the number of displayed items in an attempt to maintain performance.
If you are using an old . smr file with huge numbers of TextMark items, this dialog may be noticeably slow to
open.

Extracting a code

The Match field holds optional text that can locate the marker code in an input serial text line and that can
determine how the located text is converted into marker codes. The format of the line is (items within curly
braces are optional):

{X*}{regular expression}

The first optional part is a single character followed by *. This controls how to decode the located text into a
32-bit number that encodes the marker codes c0, c1, c2 and c3 as: c0 + 256% (c1+256* (c2+256*c3). Each
code is in the range 0 to 255. Currently, the recognised options are:

c” The code is expected to be either a single character, and the number is set to the ASCII code of the
character, or 2 or more hexadecimal digits that generate a 32-bit number that is used as the 4 codes.
This matches the default setting for displaying Marker codes in Spike2.

h” The code is expected to be hexadecimal digits (no leading 0x) that are decoded into a 32-bit number.
"27" is interpreted as decimal 39.

n” The code is a decimal number, or if it starts 0x or 0X it is a hexadecimal number, that is decoded into a
32-bit number.

We use ~ in the second character position to indicate that the first character is a format code because in a
regular expression, ~ means the start of a line, so would not occur after the first character unless the input text
had multiple lines, which is unlikely in this usage. You can also use the upper case versions of these letters (C*,
H~, N*). This causes the entire matched regular expression to be removed from the input string before it is set in
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the TextMark. If any other letter than c, h or n (or C, H or N) is used, n~ is assumed. If you have decoding
requirements not covered by these options, contact CED and we will see what can be done.

The second optional part is an ECMAScript regular expression that isolates the code in a capture group. If there
are multiple capture groups (as can happen with alternatives), the last, non-empty capture group is used. If
(unusually) there are no capture groups, the text matched by the entire regular expression is used to locate the
code.

Extracting a code when no regular expression provided

If the {regular expression} part of the Match field is empty, the code is located as the text following the
last vertical bar in the input line (this was the method used prior to version [11.00]. Originally, the text was
expected to be either a decimal number, or a hexadecimal number introduced by 0x or 0x. However, now the
number format can be set by the first two characters of the Match field. Here are some acceptable inputs with
n” format set, or a completely empty Match field. In the examples, <term> stands for the line termination:

This text has no code, so will be coded @e<term>
This input has decimal code 49, which is ASCII A|49<term>
This sets codes ©-3 as hexadecimal @1, 23, 45, 67|0x67452301<term>

If you use this method, the text from the vertical bar onwards is not included in the text stored in the TextMark.

Examples of regular expressions

The following are simple-minded examples of how to locate marker codes. Much fancier expressions are
possible, for example, if you know that the code is a decimal number you could replace the .*? used to match
anything with \d*? to match only decimal digits.

Match code after a vertical bar
This is equivalent to the original method, and could be used to locate the text after any single character used to
mark the code. There are many ways to express this search, but the simplest is:

nM|(*?)$

The n” at the start indicates that the matched group is to be interpreted as a number. The \| means: find a
vertical bar. We have escaped (placed a backslash before) the vertical bar because it is a special character that
means alternation and adding \ makes it a normal character. The pair of brackets means capture the text within
the brackets to be interpreted as a code and $ means the end of the text.

A dot means match any character. The * means match the previous item as many times as possible, but

following this with ? means a non-greedy match, which matches the shortest possible sequence consistent with
what went before (the vertical bar) and what follows (end of text). An input line this would work with might be:

Treatment type 3 started|3<term>

This would store a TextMark data item holding "Treatment type 3 started|3". To eliminate the |3 from
the end of the string you could use:

NA(*2)$

This flags we want numeric interpretation of the code and we should delete the entire matched text (not just the
text captured for the code). The TextMark data item would get the text "Treatment type 3 started".

If you wanted to find the text after the last colon on the line you could use:
NA:(*?2)$

Colon is not a special character, so does not need escaping.

Match code surrounded by markers

If we had input lines of the type:

Treatment type <3> started<term>

We could match this with:

<(_*?)>

We have omitted any control of how the captured text is interpreted, so it will default to n”. In this case, the
captured text would be "Treatment type<3> started"

If more that one type of enclosing marker is possible, for example <3> or [3] we could use:
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<27

This generates two alternate capture groups, one of which will be empty.
Match code at a particular position in a line

Some equipment generates output in a fixed format:

Temperature: 23.6 State: 04 Time: 12:23:06<term>

If we wanted to convert the state to a code we could do it with:

State: (.*?) Time:

but if the surrounding text is not fixed, but the field widths are fixed, we can match based on position. In this
case we want the 27th and 28th characters on the line. We can express this as:

A {26)(..)

This translates as: beginning of text, any character 26 times, then capture the next two characters.

TextMark trigger dialog

There are devices that require a command to be sent to them to trigger a COM port output. In this dialog you
can set the text to trigger the output and how often to send it.This dialog is opened with the Trigger... button in
the Sampling Configuration TextMark setup dialog when COM port input has been enabled. The script
language equivalent is the SampleTextMarkTrig () command.

TextMark trigger X

Text to trigger the connected device ‘ Statr ‘

Interval between triggers (0 to disable) seconds
Help Cancel

Text to trigger the connected device

This text is expected to be fairly short; up to 64 characters are allowed. If the text holds non-ASCII characters,
it is converted to UTF-8 before being transmitted, which may not be what you intend. Otherwise it is
transmitted as typed except you can embed non-typeable characters: \ r for carriage return (ASCII code 13), \n
for line feed (ASCII code 10) and \t for Tab (ASCII code 9). You can also use \xNN, where NN stands for two
hexadecimal digits. In the example above the device requires the text Start followed by a carriage return
character. If the field is blank, nothing is sent.

Example using non-ASCII characters
If your device requires the byte value sequence 200, 50, 60 to trigger it, convert these values to hexadecimal:
C8, 32, 28, then type them in the field as:

\xC8\x32\x28

If your sequence requires values greater than decimal 127 (hexadecimal 7F), the COM port must be set to have
8 data bits.

Interval between triggers

The text is transmitted at the interval set in this field. If this field is 0 the transmissions are disabled. Please note
that text is transmitted as a low-priority background task. Non-zero intervals less than 0.1 seconds will be
treated as 0.1 seconds to prevent clogging up the output. The rate will be further limited if the Baud rate is so
low that it takes longer to send the data than the interval. The first prompt is sent shortly after sampling starts
and subsequent prompts happen when time permits. If Spike2 has no idle time, prompts will not be transmitted.

Spike2 attempts to send the prompt at multiples of the interval you set. The prompts are buffered, but once the
buffer becomes full attempts to add new prompts are ignored. This may matter if the selected COM port uses
flow control or a slow BAUD rate.
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RealMark data

RealMark stores a 64-bit time, 4 bytes of marker information, then a user- s 1.896
defined number of single precision floating point numbers. You can create and Code i 2.304
manipulate this data type via a Talker, from the script language or by using - 128

active cursors to process measurements to a channel or through memory Code 3 3217292

channels.

If you import waveform data into a RealMark memory channel, the first of the floating point numbers is set to
the peak, trough or level value that was used to detect the event.

Titles and Units

From Spike2 version [9.02] onward, you can assign separate titles and units to each attached data value for use
when the channel is displayed as a waveform from the Channel Information dialog or with the ChanUnitss ()
and ChanTitle$ () script commands. You can select which index is displayed from the channel draw mode
dialog or with the ChanIndex () script command. The format of multiple titles and units is described in the
ChanUnits$ () and ChanTitle$ () script command documentation. Talkers and File import filters can use
this to generate data with titles and units set for each item.

From version [10.20], Talkers that generate RealMark data have an extra 64 characters of space to set separate
titles and units for each item. This is usually sufficient for RealMark data with up to 10 items.

Duplicate channel
From Spike2 version [10.18] you can duplicate a RealMark channel to generate one channel per attached item
and display it as a waveform.

RealWave data

This is identical to waveform data except that the data is stored as 32-bit IEEE floating-point data, not as 16-bit
integers. The channel has a scale and offset. These are used to convert between waveform data and RealWave
data:

RealWave data = integer data * scale / 6553.6 + offset

From Spike2 version [9.01] onwards you can sample RealWave data and from [10.01] Derived channels are
stored as RealWave data. You can also create RealWave data as a memory or virtual channel and with scripts.
RealWave data is used when importing data from sources that provide floating point data channels or channels
with more than 16-bits of integer resolution. Spike2 versions before [4.03] cannot open data files holding this
data type.

Sampling 1401 data as RealWave uses twice the disk space of waveform data. However, if you are using a
programmable signal conditioner, using a RealWave channel allows you to change the conditioner gain and
offset without affecting all the previously sampled data (as is the case with a waveform channel).

Using RealWave data as integers

There are several places in Spike2 where you can specify RealWave data for use where integer values are
required. For example, if you specify a RealWave channel as a source for data written to a DAC for playing
offline or for an arbitrary waveform. In these cases, the channel scale and offset are used to convert the data
from user units into integers:

integer data = (RealWave data - offset)*6553.6/scale

If the result would exceed the range -32768 to 32767 it is limited to these values.
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Not a Number and Infinity values

When RealWave data is imported or sampled from a Talker it is possible to get values that are not representable
on the y axis. For example, dividing a value by zero can generate positive or negative infinity. Some Talker
devices can use special Not a Number (NaN) values to denote corrupted or missing data sampled over a radio
or other link.

Spike2 copes with infinities by drawing them as very big positive or negative values. Spike2 copes with NaN
values by treating them as 0.0 for drawing purposes. You can make Spike2 skip NaN values (treating them as
gaps in the data) with the Skip NaN channel process. You can fill gaps automatically with the Fill Gaps channel
process. Short gaps can be filled by Linear Prediction. It is possible to replace NaN values with estimated
values from a script using the ChanWriteWave () command, but the only way to find then is to convert them to
gaps and then use the fact that ChanData () reads end at a gap.

Beware that NaN values are contagious. A single NaN value makes the result of all calculations it takes part in
a NaN, so operations such as filtering and cubic splining that generate results from a range of data points will
spread a single NaN value.

WaveMark data

This type combines waveform and marker data. It is stored as a 64-bit time and
4 marker bytes, followed by up to 126 waveform points on 1, 2 or 4 traces. The
traces hold a spike shape stored as 16-bit integers. The first marker byte holds
the spike classification code or 0 if it is unclassified. Script users can create
WaveMark data for use off-line with up to 1000 data points.

Use WaveMark data where a high waveform sampling rate is needed to characterise very short events, for

example nerve spikes. When the incoming waveform crosses a trigger level, the signal is tracked to the next
peak (or trough), and data around the peak is saved.

WaveMark dialog

The Maximum event rate is the expected maximum | channel parameters
spike rate averaged over several seconds. Spike2 uses e

. Channel [4 v] Type WaveMark Title [St
this value to calculate how best to share out the |~ | e R Tte [Sioreo ]
buffering space used during data capture; an exact  1401ort0-1 OIS Trace< BRE | Maririim sventinat=r) 30 35
ﬁgure is not required. Comment ‘ Example Stereotrode setup |
The WaveMark sample rate field sets the desired U (™ | =  Iputinvats  x[1000  [+o |
waveform rate for all WaveMark channels. Spike2 will | Points 32 | Pretrigger 10 | WaveMark sample 20000 |tz
ample at a rate as close to this as it can achi iven
S pie . ¢ as close o S as ¢ chieve give Help Quick Calibration... Cancel
the constraints of the sample rates set for the other

sampled Waveform, RealWave and WaveMark channels.

The Units field is the same as for a waveform channel. You can use the Analysis menu Calibrate command to
calibrate known values. There are fields to set the number of data and pre-trigger points per event; these can be
adjusted during template formation.

Points The waveform points per trace to store for each WaveMark on this channel in the range 6 to 126.
You should set this to the smallest value you can (the larger the value, the more space is used on
disk, and the slower it is to process). The lower limit is set by the requirements of template
matching, the upper by the requirement to write efficient code within the 1401.

Traces A Microl1401 mk IT or -3 or a Power1401 can sample multiple traces for stereotrode and tetrode
data. By default, traces use consecutive ports; the 1401 Port field sets the port for the first trace.
For example, if the 1401 Port field is set to 2 and you have 4 traces, data will be sampled on
1401 ports (ADC inputs) 2, 3, 4 and 5.

D However, with multiple traces you can click the ... button to open a dialog where you can set
non-sequential ports. The first port set for each WaveMark channel must be different, the
following ports are a free choice.

Pre-trigger The number of data points to keep before the first peak or trough to exceed the trigger level for
this channel.
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WaveMark This field sets the ideal sample rate for all WaveMark channels. Spike2 will adjust the sampling

sample rate parameters to get as close to this rate as it can. See the Resolution Tab description for more
information about rates. If the rates differ too much, adjust the optimisation and clock settings in
the Resolution tab. If you sample with a rate that is outside the range 10% less than the ideal
rate to 30% more, a warning is added to the Sampling Notes.

The total number of WaveMark traces you can sample depends on the 1401 type: 32 for Power1401 and 16 for
Micro1401 mk II. For example, a Power1401 could sample 4 WaveMark channels with 4 traces plus 4 with 2
traces plus 8 with one trace.

The Conditioner... button is enabled if a programmable signal conditioner is present.

Spike sorting

Spike2 can match waveforms to a set of templates. This is normally used to extract single spike units from
multi-unit recordings, but other uses are possible (for example extracting R waves from ECG data). If you
record WaveMark data, a template set up window appears when you open a file for sampling.

Set WaveMark codes

When you display WaveMark data as a waveform in a time view you can change the marker codes of items that
you select with the mouse. Hold down Alt+Ctrl and click and drag a line over the events you want to identify.
On mouse up, a dialog opens in which you can set codes for the intersected events.

Non-sequential ports for traces

Talkers

From Spike2 version 8 onwards, the ports used for tetrode and
stereotrode data need not be sequential. If you click the ... button in the
WaveMark set up dialog when 2 or 4 traces are active you can use this | Trace 0: 0 = E = E =
dialog to set the ports.

WaveMark trace ports X

W
|\1
)

The port for trace 0 is fixed (it is set by the WaveMark dialog). The == Help Cancel Sequential
remaining ports are a free choice; there is currently no check that these
are different from each other. The Sequential button sets the ports into sequential order.

You can sample additional data channels from plug-in devices, called Talkers. Each Talker can provide one or
more channels of data; these channels can be of any data type that Spike2 supports. A talker can also provide
additional keyboard marker channel input.

For example, consider a blood pressure monitor that automatically inflates a cuff every 10 minutes and
measures systolic, diastolic and mean blood pressure. If this device has a computer interface, the output could
be added automatically to a Spike2 data file by writing a Talker interface. It could either provide three channels
of RealMark for the three outputs, or it could provide a single channel of RealMark data with three attached
data items.

Talkers include mechanisms to compensate for timing rate differences between the Talker data and Spike2, we
call this drift compensation.

If you want to experiment with talkers, you can use the example talkers that are installed with Spike2 (unless
you excluded them in a Custom installation). The web site also has information about talkers that can be used to
connect to real devices. Note that while some Talkers are free issue, others are licensed and require a fee for
use.

Steps to allow Spike2 to be aware of a talker

Spike2 maintains a list of Talkers that it knows about. When you first run Spike2, it will not list any talkers.
Spike2 adds Talkers to this list when they connect to Spike2. For example, to connect the TalkerEx (one of the
example talkers provided with Spike2), you should start Spike2 then run the TalkerEx.exe program. Open the
Talker File menu and select the Auto-connect option or Connect. The talker should display a list of available
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channels. Once a connection has been established, Spike will be able to refer to this Talker. Each time you add
a new talker you should repeat this procedure (though the connection details may vary).

From Spike2 version [10.16] Talkers can tell Spike2 where they are located, allowing Spike2 to start them
automatically if they are not already running. There is also a Run command in the Sample->Talkers-
>TalkerName menu to launch a Talker if it is not running and Spike2 knows where to find it.

From Spike2 version [10.16] Talkers remember the drift state at the end of a sampling session and apply it at
the start of the next. As most Talkers have very similar drift characteristics each time they are used, this can
improve the initial drift compensation. Spike2 assumes that you have run with the same conditions as the last
time you used the Talker. Before you use a Talker for the first time, it is a good idea to sample with it for 15
minutes or so with the sampling configuration you will be using (you can turn of writing to disk to save space, if
you wish), so that Spike2 can make an initial assessment of the timing characteristics. If you do not do this, the
new Talker will be assumed to keep perfect time until sufficient data has been acquired to calculate a drift
factor.

Adding Talker-based channels

| New... F] Channels from Talkers are added to Spike2 from the Channels tab of the Waveform
— Sampling Configuration dialog by clicking on the small button to the Event-

right of the New... button. A drop-down list of possible channel types appears, with any

-

Talkers known to the system at the bottom and the Derived option (to create a channel E:j;t

derived from an existing one) in the middle. If you select one of the normal channel types Marker

at the top of the menu, this is equivalent to clicking the New... button and selecting a

. . . . WaveMark

channel type. You can choose to skip the channel configuration dialog by holding down

the ctr1 key when you select the item. This will create a channel of the desired type with Teuthiark

a standard configuration. RealWaye
Derived

The lower section of the menu displays a list of Talkers registered with Spike2. If a TalkerEx! >

Talker is not currently connected to Spike2, the talker name is followed by an SoundCard! >

exclamation mark (!) to warn you that you cannot sample with it until it is connected. In XKeys! >

the example, taken from my test machine, there are all the example talkers (not loaded) MouseTalk! 5

and one loaded talker (StelTalk). You will likely have at most one or two. If you have set SkelTalk! X

any Talker to Load always, there is a final option to clear all Load always settings. StelTal 2
MKeys!»i >

When you use this menu to add a channel, it appears in the channel list as the current
(selected) item. Whenever you add a Talker channel, the Source field in the list of channels displays the Talker
name. If the Talker becomes unavailable to Spike2, the lines describing the channel in the sampling
configuration become gray. If the talker is running, but has a problem, the Source field displays in red.

If you select a Talker name, in this example StelTalk, this opens a new pop- Add first unused channel...
up menu. The menu is in two sections. Add: Tenjierature...

. ) Add: Battery...
The first section of this menu allows you to add a channel from the selected Add: LV

Talker. If you select one of these options, the new Talker channel dialog Add: DriftDB..
opens to allow you to adjust the channel and giving you the opportunity to
add a channel process.. You can create the channel without opening this
dialog by holding down the Ctr1 key before selecting the option.

Configure...
Info...
Clear 4 channels

The second part of the menu has options that relate to the Talker itself, Load always

rather than to individual channels. Only options that are relevant in the
current situation display.

The full list of possible menu options are:

Add first unused channel...
This option is active if the selected Talker has channels that have not already been selected for sampling. If all
talker channels are in use, this option is present, but is disabled (gray). Select this option to open the Talker
channel dialog. If you select this option with the ctr1 key held down, the channel is added to the configuration,
but the dialog does not open.

Add <Channel Title>...
This option appears for each channel that is available in the Talker. Some talkers have a lot of channels, so we
attempt to group channels together. To do this, we scan all the available channel titles and replace all
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consecutive digits (0-9) with the # symbol, then amalgamate all the titles that are the same. For example, a
device with channels called EMG 00, EMG_01, ... EMG 63 would list all these channels as EMG_# (x64); the
number in brackets indicates the number of channels that match this title. Once the total number of remaining
channels becomes manageable we list all the channels without compressing the names. There is a limit
(currently 12) on the maximum items we will list. When you select this option, the first available channel that
matches the selected title is added to the sampling configuration and the the Talker channel dialog opens unless
you also hold down the ctr1 key.

Configure...

This option appears if the Talker has a configuration option and is running, or if Spike2 knows the Talker
location, so can run it. If you select this option, Spike2 will attempt to run the Talker (if not already running)
and if this succeeds, it will open the Talker Configuration dialog. You can also access this option from the
Talker channel dialog. Configuration often affects the entire Talker and in extreme cases can cause all
previously set channels for the current Talker to become invalid.

Run...

This option appears if the selected Talker is not currently running and Spike2 knows its location, and this
location is on the current computer. If you select this option, Spike2 will attempt to run the Talker. Some
Talkers can take a while to start up, so it can be useful to get them loaded early. This is the same option as in
the Sample menu Talkers command.

Info...
This displays information about the current Talker. This is the same option as in the Sample menu Talkers
command.

Clear <n> channels

If you have already set one of more channels of this particular Talker, you can use this command to remove
them all from the sampling configuration. The <n> is replaced by the number of existing channels. This can be
useful if you use the Configure... command and several channels become invalid.

Load always

This command toggles the Load always status of this Talker (shown by a check mark next to the option). From
version [10.20], the sampling configuration holds a list of Talkers that are always loaded when the sampling
configuration is used to sample regardless of whether any data channels are captured from them. This allows
you to cause a Talker that is used to extend the Keyboard to log keyboard markers to load; the XKeys example
talker does this. We can also imagine future talkers that use the Talker communications facilities to manage
data capture, but that do not capture data themselves. For example, we could control programmable stimulators
via the Talker interface. If any talker has Load always enabled, the Clear Load always (n) option will appear
in the parent menu.

Using Talkers without a 1401 interface

Before Spike2 version 9, a 1401 was always required to sample data and to provide a time base to synchronise
Talker input. From version 9 you can sample data using Talkers without a 1401. To do this the sampling
configuration must not use any of the following 1401 features:

e The output sequencer
o Arbitrary waveform output
e Data channels sampled through the 1401 interface

When Spike2 detects a sampling request in this state it will not open a 1401 (even if one is available). Instead,
it uses the high resolution timer of the host computer for all timing purposes. You still use the sampling
configuration to set the time resolution and select Talker channels and you can also use the keyboard marker
and TextMark input channels to annotate your data. Note that you can still set a triggered start, but this will be
ignored and the Trigger check box in the sampling control bar is disabled.

As the timing drift for a talker is measured against the computer high-precision clock when no 1401 is used and
against the 1401 internal clock when a 1401 is used, the drift rate in these two situations will differ, so be
careful if you switch and consider running a 'calibration' run before using the Talker for important data. We are
researching the best way to deal with this for a future Spike?2 release.
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Talker timing synchronisation and timing drift

The talker system allows data from a wide range of devices to be piped into a Spike2 data file. The timing
systems in most devices are based on crystal oscillators, which are typically accurate to a few seconds a day, so
absolute timings between devices will tend to drift apart. The Talker system has built-in features that allow us
to detect timing drift and compensate for it. We assume that devices have a stable clock (or that if it does
change, it does so slowly). If a 1401 device is used to control sampling, it acts as the timing master. Otherwise,
the high-resolution timer of the host computer is the timing master. Timing corrections for event-based data is
straightforward; corrections for waveform data require interpolation (implemented with cubic splines).

If a talker can connect to different hardware devices for each sampling session (typically an animal implant), it
can store different drift information for each device using a Device qualifier. This removes the need to
manually clear the saved drift information for the last device and potentially improves the quality of data
capture.

Relative timings between channels sampled by a 1401 are very accurate (microsecond accuracy). Timings
between a Talker and a 1401 or a different Talker are as accurate as we can make them, and should not have
systematic timing drift. If you depend on timings between different Talkers or a Talker and a 1401, you should
record the same signal into both devices and measure the timing accuracy. Do NOT assume the microsecond
accuracy of the 1401 family.

First use of a talker

When you use a Talker for the first time, or after changing between sampling with a 1401 and sampling without
one, it is a good idea to run a dummy sampling session (you can turn writing to disk off to save disk space if
you wish) for 15 minutes or so to get a reasonable estimate of the drift rate. If you do this, make sure that
equipment used has been on long enough for temperatures to stabilise (temperature seems to be one of the
strongest causes of timing changes).

Running multiple copies of Spike2 and Talkers
If you have multiple copies of Spike2 running and you want more than one of them to use a Talker you must
use the /Tn command line option (n is 0 to 9, with 0 being the default setting) for both Spike2 and the Talker so
that they can find each other. If you do not do this, the first copy of Spike2 that runs will grab the default Talker
communication pipe and will be in control of all talkers.

If you want to use multiple instances of a talker you must use the /Nn command line option (n is 0-9 with 0
being the default setting) when the talker is run to tell it which Talker instance it is. If the talker number is other
than 0, the number is appended to the talker name. For example, if you wanted to run two instances of
TalkerEx (an example talker that simulates data) you would run the second copy with the command line /N1
and it would show up with the name TalkerEx1. The talker name is important as we keep a registry of known
talkers on a machine and the registry is indexed by the talker name.

Talker Log

Most talkers have a Help menu with the item Enable Log file output. If you enable this, each Talker session
writes a log file to the folder Documents\CED Talker logs with the title: <TalkerName> log <Date>.txt,
for example: TalkerEx log Wed Sep 14 12-03-29 2022.txt. The contents of this file are inscrutable and
likely only of interest to a CED engineer.
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Talker dialog

For the purposes of this example we will assume that Data from TalkerEx - Example talker for testing
you have selected a Talker called TalkerEx that we o
. . . . Ch | |1 v | T RealMark[10 Il ~ Title | DriftDB

provide with Spike2 as an example. This example |~ [t -] Reabariic] A -

Talker can generate data items of all possible type& Item DriftDB: Internal drift compensation debug information b4
Comment ‘ Internal drift compensation debug information |

TO run Ta/kerEX 10 values per item, expected range -1 to 1 Units | ms

Locate Spikel1 in the Windows Start menu and within Expected eventrate| 250 Hz

it select Talker example emulate data types.

Alternatively, you will find this Talker as | Hebp Configure TalkerEx... Cancel

TalkerEx.exe in the Talker folder in the Spike2
installation folder. Double-click it to set it running. Once running, use the TalkerEx File menu to select the
Auto Connect command. Navigate back to Spike2 and select TalkerEx from the drop down list next to the
New... button in the Channels tab of the Sampling Configuration dialog.

For other Talkers the process is similar, but the name of the device is different. See the documentation that
comes with the talker for details.

If you run a Talker on the same machine as Spike2 and connect to it, Spike2 saves the Talker location and the
command line used to run it. Subsequently you can run it again with the Sample menu Talkers-
>TalkerName->Run command. Spike2 will run the Talker automatically if you open a file for sampling that
requires the Talker and Spike2 knows the talker location.

Talker dialog fields
When you select a Talker in the Sampling Configuration dialog by clicking on an enabled talker name, a new
dialog opens. The editable fields are:

Channel This field sets the channel in the Spike2 data file to use to store the Talker data. You can change
the channel number, but not to a channel that is already in use.

Type The type of data in the channel (determined by whichever Talker Item you select). If this is a
RealMark channel, the type is followed by [n] where n is the number of data items attached to
every RealMark. For RealMark data there is also a drop-down list that allows you to set the Title
and Units of each RealMark data item. This is set to All to set the default title and units and 1-n to
select a particular item.

Title The channel Title. This is usually set by the Talker, but you can edit it. In the case of RealMark
items with multiple data values you can choose to set individual titles for each item. Any item with
a blank title is given the default title. If you set a long title and sample to a 32-bit . smr file, the title
will be truncated.

Item Every Talker that can generate this dialog provides one or more data channels to write to the data
file. This field selects the Talker channel to add to the sampling configuration. When you add an
Item, it is removed from the list of available items for this Talker. Once all available items have
been added for a Talker, the Talker name is disabled so you cannot add further channels.

If an item is marked as currently unavailable, this may be because it requires configuration. In the
case of the example talker use the Configure TalkerEx... button and enable the channels to make
them available.

Comment Text to give more information about this channel, stored in the data file.

Units If this field is present, it sets the units for the channel. If the channel holds RealMark data, you an
set units for each data item, as for the Title field.

The remaining fields are not editable and give information about the channel. The values displayed here are
supplied by the Talker.

Configure TalkerName...
This button is enabled if the Talker supports configuration and is connected. It leads to a Talker Configuration
dialog, which can be local (part of Spike2) or remote (part of the Talker application).
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Configure Talker dialog

You open this dialog from either the Configure <TalkerName> button in the Talker Channel dialog or from
the Configure... pop up menu option in the New... drop down menu in the Sampling Configuration dialog.

This command opens either a simple, generic dialog controlled by Spike2, or if the Talker needs more complex

setup, we tell the Talker driver to display a configuration dialog and wait for this Talker set up process to end.

In the case of the TalkerEx example, it opens the local, simple, generic
dialog allowing you to modify simple Talker parameters. This dialog is
constructed based on information exchanged with the Talker, and is a list
of items that can be integer or real values, check boxes, choices from a
list or strings. The Talker can also request that consecutive items (the
channel enables, in this case) are grouped. For the TalkerEx example,
the Enables must be checked to allow you to use the corresponding
talker channel. The Initial direction field lets you set the edge of the
example Level event channel. The remaining fields are just examples of
what is possible and have no effect.

Important
You must read the documentation included with your Talker for a

TalkerEx configuration
Waveform rate
Enables
Enable chan 1
Enable chan 2
Enable chan 3
Enable chan 4
Initial direction
Integer value

String prompt

Eo—

Falling %

Cancel

description of the configurations options available to you.

Changes made in this dialog can have a radical effect on the capabilities of the Talker and may make the current
(or all) Talker channel(s) unavailable. If this is the case, you may need to clear all existing channels for the
Talker before configuring the system.

Consider a Talker for a device that can handle several different remote items that are selected by this dialog. If
you change the remote item, the list of available channels can also change. Depending on the device, Spike2
may be able to match existing channels in the configuration to the new device, or it may not.

Caution
Complex talkers that provide their own set up dialog system run it as a separate entity from Spike2. If a talker is
hosted on a remote computer, the configuration dialog will run on the remote system.

Apart from the problem of physically finding the machine running the dialog, remote dialogs can take a while to
open. In some cases, where we must interface with third-party software, even when the dialog is on the same
computer you may need to locate the dialog yourself; in at least one case, the dialog opens but does not move
itself to the front of the display, so can be hidden under other open windows.

Talker file location and documentation

Standard installations of Spike2 install example talkers in the Talker folder and the optional talker
documentation in the ExtraDoc folder inside the Spike2 installation folder. You can exclude the example
talker support and documentation by choosing a Custom install. The Talker documentation is in the file
Talker.pdf and is technical in nature; you do not need to read this to use the example talkers.

As Talkers are independent of Spike2; apart from the example talkers described here, you will not find
documentation for specific Talkers in the Spike2 documentation. A Talker that is written by CED to support
specific hardware will have its own documentation, and we would hope that any Talkers provided by third
parties to support their hardware will be suitably documented. If you have a problem with a non-CED
originated Talker, it is unlikely that we will be able to provide you with support; you will need to take this up
with the authors.

Communications between the Talker and Spike2 are done using named pipes. This allows the Talker to run on
the same computer as Spike2, or on a separate computer linked by a network. There is documentation and
example code available to allow anyone (with the requisite programming skills) who wishes to write their own
Talker to do so..

If you run multiple copies of Spike2 on one computer, the first one run will create the Talker communication
service using the default pipe (equivalent to running with command line option /T0) and will connect with all
talkers on the default pipe. Most talkers support the /Tn command line arguments that lets you set the
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communication pipe number they will use. Each copy of Spike2 will only see Talkers that communicate on the
same pipe. Once a copy of Spike2 has grabbed a particular pipe, no other copy can use it.

You can download the Talker development kit, including the source code of the example talkers, from our web
site. This download contains sufficient information for a programmer to create their own talker.

List of talkers

Spike2 keeps a list of all Talkers that it has been exposed to in a repository called sp2talks.datx in the all
users application data directory (for example, C:\ProgramData\CED\Spikell). This allows Spike2 to
configure sampling for talkers that are not currently connected. If you delete this file, all previous knowledge of
Talkers will be lost, but Spike2 will still run and will start accumulating information again.

Example Talkers

The standard Spike?2 installation copies example talkers and the talker technical documentation to the Talker
folder in the Spike2 current user data folder. Custom installations can choose to exclude the example talkers so
if you cannot find the example talkers, run the Spike2 installation again, choose Custom and check the box to
include the example talkers.

How Talkers communicate with Spike2

When Spike2 runs, it creates a master named pipe called Spike2Talkers that can be opened by Talkers
running on the same machine or on the same network. If Spike2 is running on a machine called SIDO00O (this
name is displayed as the Computer name field of the Spike2 About box), the master pipe is referred to on the
network as \\SID0000\pipe\Spike2Talkers and within the computer where Spike2 is running as \\.
\pipe\Spike2Talkers. Talkers open this master named pipe, write a packet of information announcing
themselves, wait for a response, then close the master pipe. The Spike2 end sets up a process to handle the
Talker and creates a new named pipe for use by the Talker. The Talker opens the new pipe and the Spike2
process and the talker communicate through it. The details of the communication are described in the Talker
documentation; you do not need to know the details to use a Talker.

Almost all problems with Talkers are in establishing the link between the Talker and Spike2 across a network.
It is important that the talker machine can connect to the Spike2 machine without needing to input a user name
and password. You can check this in Windows on the Talker machine by opening the File explorer Network
folder and checking that you can see the name of the Spike2 machine. Double-click the Spike2 machine name.
If all is well, you will see a display of any shared objects (for example folders and printers) on the Spike2
machine. However, if you get a dialog box asking for a user name and password, you must log into the Spike2
machine using the user name and password for an account with access to the Spike2 machine; once this is done,
the Talker will connect.

It is usually much more convenient, and timing is more certain, when a Talker runs on the same computer as
Spike2.

Domains
It is our experience that if Spike2 is running on a machine that is logged into a Domain, to connect with a talker
over the network, the Talker must be logged into the same Domain.

Using a Talker
For Spike2 to connect with a Talker, it must be running, either on the same computer as Spike2 or an a remote
computer that is accessible over a network. There are several ways to run a Talker locally:

1. By locating the Talker application and running it. You must do this the first time you use a Talker.

2. You can run the example talkers provided with Spike2 by locating Spikell in the Windows Start menu;
there are links to the example talkers within the Spikel1 folder.

3. With the menu command Sample->Talkers->TalkerName->Run command. This works from Spike2
version [10.16] onwards for recent versions of Talkers that have been previously connected to Spike?2.

Running a Talker on the same computer as Spike2
There are several ways to run a Talker on your local machine by hand:
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1. If Spike2 already 'knows' about the talker you can use the Sample menu Talkers->TalkerName->Run
command.

2. Use the Windows File Explorer to navigate to the Talker .exe file and double-click it.

3. Open a Command window and type in the path to the .exe file (for example C:\Program
Files\CED\Spikell\Talker\TalkerEx.exe).

4. Create a short cut to the Talker .exe file on your desktop and double-click it. You can use the short cut to
set talker command line options.

Running a Talker on a different computer

If you have a local area network connecting your computers, you can run them on a different computer by using
a command line parameter to identify the remote machine that is running Spike2. The following assumes you
are on the remote machine and have opened a command prompt:

C:\PathToTalker\TalkerName -sComputerName -nl

Where C:\PathToTalker\ represents the location of the talker and TalkerName is the name of the talker.
The -s option sets the name of the computer that is running Spike2. If you omit the -s option, the host
application (Spike2) is assumed to be running on the same computer as the Talker. Talkers are identified by
name and if you have multiple talkers, they must have different names. The -n option allows you to run
multiple identical talkers; the number immediately after the n is appended to the Talker name, so TalkerEx -
nl generates a talker called TalkerEx1. If the computer running Spike?2 is called Samuel and your talker is in
the folder C: \Program Files\CED\Spikell\Talker, you can connect with:

C:\Program Files\CED\Spikell\Talker\TalkerEx -sSamuel

Example Talkers provided with Spike2

Unless you chose a custom Spike2 installation and excluded the example Talkers, they are copied to the
Talker folder inside the Spike2 installation folder. The example talkers we provide can all run locally or
remotely:

TalkerEx  Provides dummy channels of every type and generates dummy data. It also logs key presses and
sends them to the keyboard marker channel. This is purely an example; it has no practical use
beyond getting you comfortable with Talkers. Note you must use the Configure button and
enable some of the channels to use them. This is useful as a learning and diagnostic tool.

MKeys Provides an additional marker channel that logs key presses to a Marker channel (nof the
keyboard marker channel). This acts as a remote keyboard, so only makes sense if run on a
different computer. You could use this to log responses from multiple subjects.

XKeys Provides additional input to the standard keyboard marker channel. This acts like a remote
keyboard that works in parallel with the keyboard on your computer, so only makes sense if run
on a different computer. You could use this to log responses from a single subject.

MouseTalk Uses the mouse position to provide a RealMark channel with two values, being the x and y co-
ordinates. This probably makes more sense when run on a different computer, but does work on
the same computer as is running Spike2. We have seen this used with an XY window to get a
subject to track a position with the mouse.

SoundCard Uses the Windows audio input (if present) as a 1 (mono) or 2 (stereo) channel waveform source.
This can be useful to record audio or other waveform signals. You can combine this with the
Activity detect online process to generate an audio commentary channel that only records when
you speak.

Talker startup displays

When you start a Talker, you will see a message confirming connection or giving you a reason why the
connection could not be made. Talkers that cannot connect will keep trying to connect until you close them,; it is
OK to start a Talker before you start Spike?2.

Once the Talker and Spike2 are connected, you can open the Spike2 Sampling configuration, go to the
Channels Tab, and drop down the list next to the New. .. button. In addition to the standard list of channel
types, you should also see the name(s) of the connected talker(s). Spike2 remembers Talkers it has been in
contact with; if it knows about talkers that are not currently connected, these talker names appear in the list
followed by an exclamation mark (!) to warn that they are not currently available.
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Select the name of the Talker in the drop down list to open the Talker dialog to add a talker channel to your
sampling configuration.

Standard Talker command line options
The following command line options are the same for all talkers. Talkers may have additional options; these
will be described in the Talker-specific documentation.

Option Param Purpose

Sors ServerName  Talkers detect a server by searching for a named pipe. The default search is on the
same computer as the Talker runs on. However, you can search different machines
on the network by setting the name of the machine to search. If the target machine
name contains a space you must enclose the name in double quotes: /S"Lab
machine"

Tort 1-9 Should match the command line /T option that the host program (Spike2) used or
omit it if the server omitted it. Talkers search for a pipe on the host computer with a
known name to initiate communications. If there are multiple hosts running on a
machine the second (and third) host must use /T options followed by one of 1
through 9 to change the pipe name by appending 1 through 9 to it. You can use 0 as
a parameter, but this is equivalent to omitting the option and does not append 0 to
the pipe name. Example: /T1

Norn 1-9 Once a Talker has found a host program (Spike2), the host creates a named pipe to
transmit data between the Talker and the host. The pipe name includes the Talker
name and the Host number (/T option). The /N option appends the parameter (1 to
9) to the Talker name so that if you run a second copy of the same talker, the server
can tell them apart. The server also uses this name to save information about the
Talker. Omit this option unless you want to run multiple copies of the Talker with
the same server. You can use 0 as a parameter, but this is equivalent to omitting the
option and does not append 0 to the pipe name. Example: -n1

Horh HardwareName Qptional. Some Talkers can connect to their hardware across a network; see the
detailed Talker documentation. If this is supported by a Talker, HardwareName is
the network name of the machine. If the name contains a space you must enclose the
name in double quotes: —h""Data source"

When a Talker runs it parses the command line to find these options (which it expects to find separated from
each other by spaces) and sets itself up accordingly. You can also set these options interactively within the
Talker from its Connection settings dialog. Note that if you have two talkers of the same type connected to a
computer, they must use the /N option to make the pipe names different. This applies even if they are
connecting to different hosts (for example you can run multiple copies of Spike2 or a mix of Spike2 and
Signal). Likewise, if you have more than one host running on the same computer, you must use the /T option
when starting each server to make the pipe used for setup unique.

Automatic Talker connection

From Spike2 version [10.16] onwards, Spike2 will attempt to start all local (not remote) Talkers used by the
current sampling configuration that are not already running when it creates a new data file for sampling. The
Talkers will start with the same command line as the previous time they ran. This works for the latest generation
of Talkers (which includes all the example Talkers).

Talker source code and documentation

You can get the example Talkers source code and Talker documentation from our web site by going to the
Downloads page and then selecting the Talker software development kit. The installation program places the
example Talker applications and the documentation for writing talkers (Talker.pdf) in the installation folder.
It also copies folders holding the Talker source code, set up to be built with Microsoft Visual Studio.
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Talker errors when loading sampling configurations

When you load a sampling configuration that contains Talker channels it is possible to be warned about Talker-
related problems.

Unknown or incompatible talker(s)

This message can occur if you load a sampling configuration that references a Talker that you have not
connected to previously. The solution is to connect the Talker to Spike2. Having done this, you should load the
sampling configuration again to ensure that any Talker-specific configuration information in the configuration
is loaded.

You can also get this message if you load a sampling configuration that requires a version of a Talker that is not
compatible with Talker connected to your computer. Make sure the named Talker is connected and is up to date
(you can download the latest version from our web site, subject to licences). If the sampling configuration is
using an old talker version that is not compatible with the latest version you will have to delete the affected
channels from the sampling configuration and reconfigure them with the updated Talker.

Error reading/setting talker Name configuration, code n

If a Talker saves configuration information in the sampling configuration and that information has become
corrupt or is incompatible, you will get this message. Follow the same steps as for an unknown or incompatible
Talker. If all else fails, you will have to delete the Talker channels and reconfigure them

SoundCard.exe talker

The SoundCard talker allows you to record input from your Windows sound card as part of your data file.

To use this talker, start Spike2, then run the SoundCard.exe program in the Spike2 program folder (usually C:
\Program Files\CED\Spikell). The first time you run this you will need to configure the program to select
a sound source and the channels and sampling rate. You should use the lowest sampling rate that is suitable for
your purposes. Do not use multiple channels unless you really need them to optimise disk space use. If you have
a choice of data widths, choose 16-bit (Waveform data is stored as 16-bit data, so choosing 8-bit just reduces
the quality). If you choose higher resolution than 16-bit, the data is saved as RealWave, which uses double the
disk space of Waveform data.

You can use this together with the Triggered sampling mode and the Derived channel activity detect feature to
make a voice-triggered memo taker that only uses disk space when you speak. To set this up, start by recoding
some speech to get an idea of a suitable trigger level. Then use the Activity Detect process in Activity mode to
generate markers when you start to speak and a different code when 'activity' (in this case, speech) falls to a low
level. Then sample in Triggered mode and set a trigger group to control recording of the sound channel and set
it to trigger on the derived channel with enough pre-trigger time to capture the start of each memo with a
duration long enough to cover your longest memo. Set the off code to the one set for end of activity.

Time drift compensation

One very difficult problem when importing data from non-synchronised devices is how to cope with the
inevitable time base differences between time as seen by a 1401 interface and time as seen by a Talker. There
are generally two components to this problem:

1. Where is time zero.
2. How fast is time passing.

You can solve the first part of the problem if the Talker supports a triggered start, in which case you can use the
same trigger for both the 1401 and for the Talker. However, many talkers do not support this. The second way
to resolve this is to record the same signal on both a 1401 channel and a Talker channel (or superimpose it on
channels). after recording you can apply a time shift to the Talker (or 1401) data to align the data if the time
offset is significant.

The second part of the problem is more difficult to fix. Most modern electronic equipment runs at a rate
determined by crystal oscillators. Unless these are specially selected to be high-accuracy and high-stability, they
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will typically have an accuracy of 50 ppm (parts per million), a few seconds per day. Recent 1401s use an
oscillator with an accuracy of around 5 ppm over a reasonable temperature range (though we only claim 50
ppm in the handbook).

We would expect that most modern electronics would be accurate to around 50 ppm (though we have seen
equipment with a time base much worse than this). This means that if you sampled a waveform with a 1401 and
with a Talker, without any form of correction, the two signals would slowly drift out of alignment, maybe by
200 ms per hour.

To compensate for this, the Talker system accepts that this is the case and attempts to compensate for it by
warping waveforms and adjusting event times to hold signals to be within a millisecond or so. It makes the
assumption that the time base is not grossly wrong and that any change in the rate of drift is small.

If you want to visualise the time base drift correction, all Talkers have an option to generate Drift information
as a channel of RealMark data. To enable this, use the Talker File menu Drift compensation options...

command:
Drift compensation options X
Scaler for time range for analysis (0.25 to 10)
Scaler for allowed timing jitter (0.5 to 3) ‘ 1

Allow generation of drift compensation information channel

Scaler for time range for analysis (0.25 to 10)

This value is used to adjust the time range over which the analysis of the data timing drift occurs. The standard
and recommended value is 1. Values less than 1 will cause Spike2 to use a smaller time range for the drift
analysis, values greater than 1 will give a greater time range.

If the drift timing information shows cyclical variations (such as a saw-tooth often caused by the USB bus) or is
otherwise a bit messy you can set a value greater than 1 (values from 2 to 3 seem to work well) to cause the
drift analysis to occur over a longer time range and thus smooth out any timing variation, but at the expense of a
quick analysis and compensation that adapts quickly to changes in the drift.

If your drift timing information is clean and noise-free but the rate of drift varies significantly over time, you
could set a value less than 1 to make the timing analysis more responsive to changes in the rate of drift. You can
enter values from 0.25 to 10, but setting values less than 1 is not recommended. Most users leave this value set
to 1.

Scaler for allowed timing jitter

This value is used to adjust the limits of acceptable timing variations. Spike2 uses these limits to discard
occasional extreme timing values rather than allowing them to interfere with the drift analysis. The standard and
recommended value is 1. Values less than 1 will cause Spike2 to discard more drift timing information, values
greater than 1 will cause Spike2 to make use of more information. This is most commonly used to set a value
greater than 1 if it appears that the drift compensation system is not operating correctly because there is too
much variation in the drift timings. You can enter values from 0.5 to 3. Most users leave this value set to 1.

Allow generation of drift compensation channel

Check this box to allow the Talker to generate an extra channel of RealMark data with 10 values that show how
the drift analysis and compensation is working. Normally you will leave this box unchecked; if you are having
trouble with a Talker, a CED engineer may ask you to enable it. Once enabled, a new channel becomes
available for this talker in Spike2. To try this out, you can enable this option in the TalkerEx example talker and
add a TalkerEx channel and select the DriftDBL: Internal drift compensation debug information item. You
can run the following script (make a data file holding sampled data the current view and adjust the script dc%
constant to hold the channel number you set for the drift compensation values:

'8DriftShow[Display annotated Drift information

const dc% := 1; 'Channel holding drift info - you must edit this

if ViewKind() then Message("Select time view holding drift data");halt endif;

if (ChanKind(dc%) <> 7) then Message('Channel %d is not a RealMark", dc%); halt endif;

var nItems% := ChanIndex(dc%, -2); 'Number of attached values

if (nItems% < 10) then Message("Channel %d has %d items, needs 10", dc%, nItems%); halt endif;

var i%,c%;

ViewStandard();

Draw(@, MaxTime()),

ChanTitle$(dc%, "Drift info|Raw delta|Av. delta|StDev delta|Fit value|# fit|fit slope|fix intcpt|Av. s
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ChanUnits$(dc%, "ms|||||Count|ms/s||ms/s|]|[|");
for i% := @ to 9 do
c% := 1% = @ ? dc% : ChanDuplicate(dc¥%); 'original or duplicate
DrawMode(c%, 3); 'Display as waveform
ChanIndex(c%, i%); 'Set trace to display
ChanShow(c%) ; 'ensure channel 1is visible
next;
Optimise();

The drift analysis looks at the difference between the data time seen by the talker and the data time as seen by
Spike2 when each data packet arrives from the Talker. There will be some jitter in this due to the uncertainty of
how long it takes for data to be sent to Spike2 and timing jitter in the Talker and Spike2 due to system activity.
However, when averaged out over time, we can discern the general drift in timing. This is done by fitting a
straight line to the data time differences. The slope of this line indicates the rate of time drift and the intercept is
the time offset. The 10 items of data returned are:

# Title Units Meaning

0 Raw delta ms Difference of last packet of Talker time to Spike2 time (may be rejected if sudden
change)

1 Av.delta ms Average time difference over analysis time range

2 StDev delta ms Standard deviation of time differences from average (used to decide if we reject a
value)

3 Used delta ms Input values used for fitting (excludes values with a sudden change)

4 Delta pts Count The number of data points used to average differences.

5 Slope ms/s  The most recent slope of the fit. This would be 0.0000 if the data were perfectly
timed with no noise.

6 Slope pts Count The number of difference points used for fitting.

7 Avgslope ms/s  The running average of the calculated slopes.

8 Used slope ms/s  The slope value we are using

9 Drift ms The deduced drift, which is the time correction applied to the data at this point.

Keyboard channel markers

The drift calculations go through several phases while Spike2 accumulates drift timing information. When you
enable the drift compensation channel, Spike2 adds markers to the keyboard channel to indicate when the
phases change. From [10.16] onwards, these markers have codes Dx (x is a hexadecimal digit). These codes are
for CED diagnostic use. The current codes and their uses are:

Code Meaning

D1 Got initial baseline data, correction using saved drift value from previous sessions (0 if no previous
value)

D2 Able to produce smoothed time differences
D3 Able to start generating drift values from the sampled data
D4 Current drift values start being used for correction

D5 Fully switched-over to using current values values for correction

Initially, we use the last saved drift rate for this talker (on the grounds that most Talker sources run at a pretty
constant rate that tends to remain much the same between sessions). If there is no saved rate we start with an
assumed drift rate of zero. We start by establishing a baseline of time differences to give us some idea of the
distribution of timing errors. Typically we get a fairly tight distribution of errors with occasional large errors
caused by other processes running in the computer or by some activity in the Talker. Once we have a baseline
and some idea of the distribution of errors we start generating smoothed time differences. Once we have
sufficient values we start predicting time drift values. However, we wait a while so that we are confident that
the drift value is not changing wildly. We then start adjusting the drift value to get the data to align; this is not
done suddenly, as that would cause a discontinuity in the data. At some point, when we have sufficient data, we
rely on the newly sampled data entirely to control the sample drift.
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Device qualification

From Spike2 version [10.19] we allow talkers to qualify the talker drift information with a device identifier.
This is for use in situations where a talker can detect to a choice of devices, each with different drift rates. For
instance, a Talker might link to a wireless base station that can connect to one of a choice of multiple devices,
each with their own drift rate. It would make no sense to restore the drift rate for the last connection to this
talker as it might be for a different target device and using the previous drift rate could well make the drift
situation worse, not better. If you connect to a talker than knows how to qualify the drift information, this
happens automatically. There is no action required by you to enable this. The Talker Info... dialog will show the
current qualifier, if your Talker supports this feature.

Setting up on a new system

Talkers load the last-known drift rate when they start. This improves the initial drift compensation a great deal.
However, the first time you use a Talker, or after changing a system component that might affect timing (of the
computer or the Talker), or if you have told the Talker to forget about timing information, we have no saved
information. In this state, the Talker data will drift away in time until enough timing information has been
gathered to allow a correction.

When the drift rate is unknown, we recommend that you run a dummy sampling session, ideally for 30 minutes
or more. Follow this procedure:

1. Switch on the hardware and allow it to warm up (maybe 30 minutes) to reach thermal equilibrium. The rate
at which most electronic clocks run is temperature dependant.

2. Run the Talker(s). If you have never run them previously, or they are on a different computer, you will have
to locate and run them yourself. Otherwise you can use the Sample menu->Talkers->TalkerName->Run
command.

3. Open the Sample menu->Talkers->TalkerName->Info... dialog and make sure that the Lock talker drift
rate check box is clear and close the dialog.

Configure the channels and Talker(s) as you would for a sampling session.
Open a new file, ready to sample. You can disable writing to disk unless you really want to keep the data.

Start sampling and sample for 30 minutes or more.

N e

Stop sampling and Save the data file (do not Abort sampling - if you do not Save the file, the drift rate is not
updated).

From this point onwards, each time you sample with a Talker, Spike2 reads the initial drift rate from the saved
Talker information and updates it at the end of each sampling session. If you would prefer to stick with the
value you have and not risk changing it with an atypical session, you can use the Lock talker drift rate check
box in the Sample menu->Talkers->TalkerName->Info... dialog.

Derived channels and Real Time processes

Version [10.01] added the ability to process the real time stream of data from a 1401 waveform channel to
either create a new channel, or to modify the source channel. Version [10.09] extended this to work with Talker
waveforms. Version [10.13] further extended this with activity detection for derived channels.

Derived and Processed channels

When we use this to create a new channel, we refer to this as a Derived channel. When we apply it to the same
source channel, we call this a Processed channel. Processed and derived channels are stored in the data file as
RealWave (floating point) values regardless of the original type (Waveform or RealWave) unless you use the
Activity Detect process in which case the channel is saved as a Marker. You can add up to 5 processes to a
channel (5 is an arbitrary limit). Data is piped from the source and through the processes, in order, before being
written to the data file.

Processes are applied as part of the real-time data capture thread; there will be limit on how much processing
can be applied when running data at high speed; this limit will be determined by the capabilities of your
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computer. You can get an idea of how hard the sampling thread is working from the Sample Status bar, in
particular from the CPU field.

This data processing happens in the PC, not in the 1401 interface. This means that an output sequence run in the
1401 using a CHAN command to inspect a 1401 data channel has access to the original 1401 data, not to the
processed data.

You can create and manage derived channels from the script language using the SampleDerived() and
SampleProcess () script commands.

If you modify the type of the source channel such that it cannot be used as a source channel or delete it, the
derived channel is deleted.

Alternative ways to process data

If you need to process your data continuously during data capture and the provided real time processes can
achieve the desired result you should always use them. Your alternative is to have an on-line script that tracks
data capture and does what is required. However, scripts run in spare CPU time, so are not real time. They also
require knowledge of the script system and are not as fast as a real time process. If you do not have a script
running all the time you sample, you can set scripts that run on specific trigger or timed events, or that run
periodically during data capture or when capture starts and stops.

One particularly effective method to combine real time processes and a script is to use the Activity detect
process to generate a Marker that is used as a trigger for a script that completes the processing task.

Add a Derived channel
MNew... |v You create a derived channel interactively from the Channels Tab of the Sampling configuration
— dialog by dropping down the list next to the New... button and selecting Derived. This item is
enabled when your sampling configuration contains at least one Waveform or RealWave channel. When you
select Derived, a new dialog opens (the same dialog opens when you click the Process... button in a Waveform
or RealWave channel in the Sampling configuration to add a real time process to a channel):

Derived channel X

Channel |3 v‘ Source 1: Noisy v Title ‘Ncisy

Comment ‘ Derived: Noisy example signal ‘

Units Volt = 16-bit input / 6553.6 x ‘ 3. +|0

0 processes

Process to add IIR Fllter = Add Delete Help
Clear All
Cancel

OK

The script language equivalent of this dialog is the SampleDerived () command. The initial dialog settings
are obtained by finding the first unused channel in the configuration and by selecting a source as the first
suitable existing channel. The dialog fields are:

Channel
This is the channel number of the Derived channel in the sampling configuration, which is the channel number
in the output data file.

Source

This is the Waveform or RealWave channel in the sampling configuration that is used as the source of data for
this Derived channel. If you change the source channel, the Units, scale and offset fields will also change to
match the new source channel. The Title and Comment fields will also change unless you have edited them from
the default values copied from the previous source channel. If the dialog is opened from the Process... button
of the Channel dialog, this field cannot be changed.

If this is a Derived channel, any processing applied to the source channel is ignored. For example if the source
channel has Rectify and Low pass filter processes applied, the source data used by a Derived channel will be
the original data.

4-35



Spike2 version 11 for Windows

Title, Comment

The channel title and comment are copied from the source channel when the derived channel is first created.
After this, if you change the source, these fields are preserved if you have modified them to differ from the text
copied from the previous source, otherwise they are copied from the new source. These fields can use place
holders, for example %c for the channel number.

Units, scale, offset

These fields are copied from the source channel each time the source channel changes; it is unusual to edit
them. Spike2 uses the scale and offset to convert the channel values back to integers for certain situation, such
as when converting a RealWave channel to a Waveform channel for DAC output. The displayed values apply to
the input data to the channel. Waveform channels are stored as 16-bit integers (range -32768 to 32767),
RealWave channels are stored as 32-bit floating point values.

From version [10.09] onwards, when we create the data file from the sampling configuration, we modify these
values to reflect changes made by processes. For example, a Difference process (see below) multiplies the scale
by the sample rate, sets the offset to 0.0 and adds "/s" to the units. Adding a process does not change the
displayed values in this dialog. The line below ("0 processes" in the example above) lists any of the units, scale,
offset and sample rate that the processing modifies.

Process to add
The area below Process to add starts off empty and holds a list of the processes that have been attached to this
channel. The Process to add field is a drop down list of the processes that can be added:

1IR filter You can add Low pass, High pass, Band pass, Band stop and resonator IIR filters. The IIR
processing is relatively time-consuming compared to the other processes and the time taken per
point depends on the order of the filter; Band pass/stop filters take double the time of low and
high pass filter. When you Add an IIR filter, this opens the Digital filter dialog in IIR mode
where you can design the filter to apply. If you add a high-pass or band-pass filter, this sets the
channel offset to 0.

Note: You are not allowed to add an unstable IIR filter. However, if you add a filter, then
change the channel sampling rate, it is possible for the result to be unstable. This is detected
when you prepare to sample and sampling will not start until you adjust the filter.

Rectify Full wave rectification replaces negative data values -x with +x and leaves positive values
unchanged. You can also select various half-wave rectification modes. We do not allow you to
follow a Rectify processes with another as this is pointless. You set the rectification mode in
the Rectification mode dialog.

Difference Each data value is replaced by the sample rate multiplied by the difference of the current value
with the previous value. This is equivalent to the instantaneous slope of the signal. This will
tend to be noisy, so you will usually follow it with a Low pass filter to smooth the result. This
also modifies the channel scale, offset and units.

Down sample  This process takes every n sample from the data stream. You set the n in the Down sample
dialog that opens when you Add this process or double-click the process in the list of added
processes. We do not allow you to add two down sample processes together as this is
inefficient; set a larger divide ratio for one process.

This will usually be preceded by a Low pass filter to remove input frequencies that exceed half
of the resulting sample rate. For example, if the source channel is noisy, with noise components
up to 1 kHz, but we are only interested in signal frequencies of up to 30 Hz, we could sample it
at 2.5 kHz, Low pass filter it to 30 Hz, then down sample by a factor of 25 to get an effective
sample rate of 100 Hz.

Activity detect Derived channels only. This process takes a waveform as input and converts it to a Marker
channel. There are 4 modes available: Activity, Peak detect, Trough detect, Peak and Trough
detect. Adding a process or double-clicking an existing Activity process opens the Activity
detect dialog where you can configure the process.

Add

Click this button to add the currently selected process to the end of the list of processes. This button is disabled
if the list is full (we allow up to 5 processes to be added), or if the proposed process is Rectify or Down sample
and the last added process was the same. The Rectify and Difference processes add immediately. The others
open dialogs to configure the added process.
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Delete
This is enabled when there is at least one item in the list of added processes. Click the button to delete the
selected item from the list.

Clear All
This is enabled when there is at least one item in the list of added processes. Click the button to remove all
processes from the list.

Edit a process

The example, below, shows the dialog with two added processes. The processes are set to low pass filter the
input and down-sample the result by a factor of 10. As this changes the channel sample rate, the information
line displays the changed rate.

Derived channel X

Channel |3 v‘ Source 1: Noisy ~ Title ‘Ncisy

Comment ‘ Derived: Noisy example signal ‘

Units Volt = 16-bit input / 6553.6 x ‘ 3. +|0

2 processes, rate: 100

Process to add IIR Fllter = Add Delete Help

Low pass Butterworth 30 Hz, fourth order Glear All
Dewn sample by 10 -

Cancel
l OK ;

You can edit the IIR filter, Down sample and Activity processes by double-clicking them in the list of
processes.

Down sample waveform dialog

This dialog opens when you Add a down sample process to the channel configuration or double-click the down
sample item in the list of real-time processes attached to a channel.

Downsample waveform X

Input sample rate 100 Hz Output sample rate 50 Hz

Downsample ratio | 2 Nyquist frequency 25 Hz

The input signal should contain no frequency components at or
above the Nyquist frequency.

Cancel OK

The dialog displays the input and output sampling frequencies and also the Nyquist frequency (highest
frequency that can be represented with this sample rate). You can either type in a down sample ratio or use the
up and down arrows to change the value.

It is your responsibility to check that there are no higher frequencies in the input than the displayed Nyquist
frequency. One convenient way to do this is to include a low pass filter before the down sample process for this
channel. You can test the frequencies in the channel by sampling it at a relatively high frequency with no
channel processes and running a power spectrum on the channel.

Rectification mode dialog

Rectify waveform X

Rectify mode  Full wave v

Help Cancel

This dialog sets and edits the rectification mode set for a real-time channel process. There are 4 possible modes:
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A -V

Mode Name Effect

0 Full wave Replaces negative data with positive data of the same magnitude.
1 Half wave Replaces negative data with zero values.

2 Negative half wave Replaces positive data with zero values.

3 Inverted half wave  Inverts the data and replaces negative values with zero values.

You are not allowed to add a rectify process directly after a rectify process as this would make little sense.

The script language equivalent of this dialog is the SampleProcess (chan%, 1, mode%) command.

Activity detect dialog

The activity detect dialog configures the methods that convert a sampled waveform to a Marker channel that
signals detection of activity and peaks and or troughs. This process changes the basic type of the channel from
waveform to a Marker and we allow this only when used with a derived channel. The script language equivalent
is the sampleProcess () command with a proc% argument of 4. This was added at Spike2 [10.13] as an
experiment; the details may change based on user experience.

You can use the generated Marker channel to turn data sampling on and off in real time on one or more
channels, which can be very useful in a long term recording to reduce the quantity of recorded data.

All methods share the same dialog, which is divided into three sections:

Time constants

All detection methods start with a simple DC removal (high-pass filter) phase with a user-defined time
constant (this operates in a similar manner to the DC Remove Channel process). The effect of this is to remove
wandering baselines. If you do not want the offset removed, set a time constant of zero (which is treated as a
special case). The longer the time constant, the longer the process will take to recover from a sudden change of
the input offset.

The second field in this area is either Peak decay (for Activity mode) or Peak width for all Peak/Trough
detection. These are described below.

Trigger and off level

All methods use the Trigger level field, which is always set as a positive value, even when used in Trough
mode (when it is negated). This is the level that the input signal must cross to transition away from a mothing
happening' state. The value in this field is in the units of the waveform input to this process.

The Off fraction is the proportion of the trigger level (for Activity mode) or of the signal peak/trough that
marks the end of activity or confirms a peak or trough. This must be greater than 0 and less than 1.0.

Note that you can use the Channel process DC Remove and Rectify options to visualise the effect of the
processing as an aid to setting useful trigger levels.

Codes

The Activity mode can set the Marker codes for the start and end of a detected activity. The peak and trough
modes can set Marker codes for peak and trough. Codes are entered as either a single ASCII printing character
or as two hexadecimal codes. You can also set the second code (where present) as blank, for no code.

Activity detect mode
This field sets how Spike2 processes the input waveform to generate a Marker channel. You can set it to one of
Activity, Peak, Trough, or Peak and Trough.

Activity

This mode detects periods of activity in a signal that is usually quiescent. One application of this is to detect
input on a microphone channel to turn recording on and off on the channel to save disk space. Another is to
detect activity on a recorded channel, perhaps to trigger a script to run to generate a response. This process can
generate two marker codes: the Trigger code when the input signal crosses the Trigger level, and the Off
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code when the activity is determined to have ceased. You can set one (but not both) of these codes to an empty
field (not to a space character, which is a Marker with the hexadecimal code 20), if you do not need one of the
conditions to generate an output.

Activity detect

Activity detection mode

Time constants (seconds)
DC remove 1 |
Trigger and off level

Trigger level | 0.1 |

Codes (blank for none)

Activity v

Peak decay ‘ 0.1 ‘

Off fraction

Help

Trigger code |01 2 Off code ‘W =

cocs

This process works on a rectified version of the input signal after DC removal. It works as a state machine with

3 states:
State

0

1

Action
Wait for the processed signal to be less than the Trigger level. When it is, set state 1.

Wait for the processed signal to cross the Trigger level. When it does, output the Trigger code and
record the level as the current Peak, set State 2.

Decay the Peak by the Peak decay time constant. If the current processed input exceeds the Peak, set
it as the new Peak. If the Peak is less than the Off fraction times the Trigger level, output the Off
code and go to state 1, otherwise do nothing.

The Peak decay must be in the range 0.001 to 1000 seconds. This value is related to how long after input
activity falls below the Off fraction of the Trigger level the Off code (if set) is transmitted.

Peak

This mode detects signal peaks that are larger than a threshold value and have a width (time from the Peak to
the time that the signal crosses a defined fraction of the Peak) that is less than the Peak width time set in the
dialog. The single Marker output code will be at the position of the peak, but will not occur (in real time) until
the peak is confirmed by the signal crossing the Off fraction of the peak level.

Activity detect x

Activity detection mode

Time constants (seconds)
DCremove |1 |

Trigger and off level
Trigger level | 0.4 |

Codes (blank for none)

Peak code 01 Z

Peak v

Peak width ‘ 0.1 ‘

Off fraction ‘ 0.5

Help

cocs

This process works on the input signal (after DC removal). It works as a state machine with 3 states:

State
0
1

Action
Wait for the signal to be less than the Trigger level. When it is, set state 1.

Wait for the signal to cross the Trigger level. When it does, record the level as the current Peak and
the time as the Peak time, set State 2.

If the current input exceeds the Peak, set it as the new Peak and record the Peak time. If the signal is
less than the Off fraction times the Peak level, output the Peak code and go to state 1 or 0 depending
on the level. If we are more than the Peak width past the Peak time go to state 1 or 0 depending on
the level, otherwise remain in state 2.
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Trough
This is identical to Peak mode except with everything inverted. One oddity is that the trigger level is set as a
positive value, but minus this value is used as the level. The Codes field title is Trough code.

Peak and Trough

This behaves as Peak mode if the signal crosses Trigger level or as Trough mode if it crosses -Trigger level.
There are two code fields: Peak code and Trough code. If you leave Trough code empty (setting it to the
space character is not empty), the trough code used is the Peak code plus 1.

Time resolution

The Resolution page of the sampling configuration dialog sets the time resolution of the document and the
ADC sampling rate. To get the best possible results, you should read all this section. However, to get started
quickly, follow these “cookbook” instructions:

1. Set the Output file format field (set 64-bit smrx unless your files need to be read by old software).

Set the Type of 1401 field to the 1401 type you will use.

Set Optimise to Partial: fixed time units.

Set Groups to Keep same sample rate groups.

Set Microseconds per time unit to the smallest value that gives you the waveform sample rates you need
(usuallyl). If you selected a 32-bit file type in step 1, set Microseconds per time unit so that the Longest
run time field is at least as long as the time you want to sample for.

6. Clear all the Disable for compatibility section check boxes (the state of disabled boxes does not matter).
7. If the Burst check box is visible, set it unchecked unless you know that you need burst mode.

wkh v

M Sampling configuration _ O %

Channels Resolution Mode Sequencer Play waveform Automation
Optimise waveform rates

Optimise  Partial: fixed time units v []Burst

File format 64-bit smrx (no size limit) -

Time resolution and ADC rate

= roseconds r rar 1 o 50
Microseconds per time ‘ 1 - :
Groups Keep same sample rate groups hd
5 =
ADC will convert at 200000 Hz # Hz E% Type  Channelrate
1 1000 oK Q Worst: 0%
2 1000 ok S 3 dummy
Typeof 1401 |Micro14014 » 3 20000 oK Wi
& 20000 OK w4 Wn=WaveMark
; Fae. =Quick waveform
Disable for compatibility 8 =3Iow WaverGin
[_] 64-bit optimisation C =Copy WaveMark
[]10 MHz clock [] waveMark divider
[[] Copy channels [_] Dummy channels Suggest

Cancel Run now Help

This dialog controls how Spike2 optimises the sampling rates. Spike2 minimises the sum of the proportional
errors between the desired and the actual rates for the waveform and WaveMark channels. By proportional we
mean that an error of 200 Hz in a sampling rate of 10 kHz is the same as an error of 2 Hz in a rate of 100 Hz.

Output file format
Spike2 is optimised to create and work with 64-bit . smrx data files. Unless you have a requirement to use 32-
bit . smr files (for example because you use third-party programs that do not read . smrx files to analyse your
data or your collaborators are using a version of Spike2 that cannot read smrx files) you should set this field to
64-bit. See Data file types, below, for full details. The script language equivalent of this field is
SampleBigFile ().

Type Name Comments
64-bit *.smrx 64-bit data files that are limited in size only by the capabilities of the operating system
and have no time limitations. This allows both high timing resolution and long run
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times. Spike2 version 8 is optimised for this format. Use this unless you need
backwards compatibility.

32-bit big *.smr 32-bit data files limited in size to 1TB and in time to 2 billion clock ticks. This is
compatible with Spike2 version 7 and can be read by version 6.11 onwards.

32-bit *.smr 32-bit data files limited in size to 2 GB and in time to 2 billion clock ticks. This is the
most compatible format for old versions of Spike2.

Microseconds per time unit

This field sets the time units for a new data file in the range 1 to 10000 microseconds. All data of any type
stored in the file occurs at a multiple of this time unit. If you have selected a 64-bit file you will want to set this
to the lowest value possible (giving the best time resolution) compatible with the desired sampling rates
(usually 1). If you have selected a 32-bit file, you will have to balance the desire for timing accuracy against
how long you need to sample for, see below. To edit this field, set Optimise to None or Partial. If you select a
Power1401 or Microl1401 mk II or -3 in the Type of 1401 field, you can set this field to a resolution of 0.1
instead of 1 microsecond.

Setting the resolution to non-integral microseconds prevents 32-bit files being read by versions of Spike2 prior
to 4.02. 64-bit files cannot be read by versions prior to 7.11c.

Longest run time

This field is visible if you selected a 32-bit file in the Output output file format | 32-bit smr Big file (1 TBmax) |
file format field. With a 32-bit file, as in the example to the A
right, the maximum sample time is 2,147,483,647 ticks of  Time resolution and ADC rate

the Microseconds per time unit field and the Longest run  Mjcroseconds per time unit 1 =
time field displays this duration in years, days, hours, Longest run time 00:35:47
minutes and seconds for the current time units. If this period

is shorter or longer than you require for your work you can adjust the Microseconds per time unit field to
give you the duration you need.

There is a length limit for 64-bit files but it is so large (256 thousand years at 1 microsecond resolution) that it
is of no practical concern.

Time units per ADC convert

This sets the ADC (Analogue to Digital Converter) clock interval in the units set by Microseconds per time
unit. Each time the ADC is clocked either one sample is taken (non-burst mode) or a group of samples is taken
(burst mode). To edit this field set Optimise to None. The ADC will convert at field is the equivalent rate in
Hz for normal mode; it changes to ADC burst rate in burst mode.

Type of 1401

Members of the 1401 family have different capabilities. Although you cannot use the 1401plus or the original
microl1401 to sample, you can still select them in the list in case you need to match previous settings. The
choice you make here sets the absolute maximum settings for sampling.

There is no guarantee that the maximum settings are achievable. The maximum rate depends on the entire
sampling configuration, the input data load, the speed of the 1401, the speed of the interface connection and on
the capabilities of the host computer. For example, if your 1401 is plugged into a USB 1 port (or has a USB 1
interface), the maximum continuous sample rate to the host is 400 kHz (or less), which will limit your aggregate
ADC rate to a maximum of 200 kHz.

Regardless of what you set here, when you sample with a 1401, Spike2 will detect the 1401 type and warn you
if you have sampling settings that cannot be achieved by the detected 1401.

You can set:

General compatibility

Any 1401 except a 1401plus with the old analogue card (an upgraded standard 1401). This is a lowest common
denominator setting with a maximum waveform sampling rate of 166 kHz and does not assume that your
monitor firmware is the most recent. This option is preserved so that you can match old sampling rates with a
modern 1401.
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1401plus, old ADC (not supported for sampling)
If your 1401plus was upgraded from a standard 1401 without an upgrade of the analogue card you must select
this option. This option is preserved so that you can match old sampling rates with a modern 1401.

micro1401, 1401plus (not supported for sampling)
This setting is for a micro1401 or a 1401plus with an up-to-date monitor. This option is preserved so that you
can match old sampling rates with a modern 1401.

Power1401, Power1401 625 kHz

These settings are for the Power1401. You can set Microseconds per time unit in steps of 0.1, and Time
units per ADC convert to 1 and sets the maximum ADC convert rate to 400 kHz (625 kHz with the later
Power1401 625 kHz). Selecting any Power1401 or the Micro1401 mk II enables additional optimisations when
calculating waveform rates (10 MHz clock, WaveMark divider, Copy channels and Dummy channels).

Micro1401 mk Il, Micro1401-3

Select this option to take advantage of all the capabilities of the Microl401 mk II and -3. This allows
Microseconds per time unit to be set in steps of 0.1, Time units per ADC convert to be set to 1 and sets the
maximum ADC convert rate to 500 kHz. All optimizations are available.

Power1401 mk Il, Power1401-3, Micro1401-4
This setting allows Microseconds per time unit to be set in steps of 0.1, Time units per ADC convert to be
set to 1 and sets the maximum ADC convert rate to 1 MHz. All optimizations are available.

Disable for compatibility

If you replace a 1401 with a more recent model or upgrade Spike2 from before version 6.05 you may get
different waveform and WaveMark sampling rates. The new rates will be closer to the requested rates, but if
you are half way through a study, compatibility with earlier data may be more important. This section of the
dialog disables new features so you can match the original rates. Fields that do not apply to the device selected
in the Type of 1401 field are disabled. The settings of disabled fields are ignored. The fields are disabled for
the 1401plus and the original micro1401 as these devices did not support any of the following features.

64-bit optimisation

Check this box to disable new optimisations added in version 8 that take advantage of 64-bit times. With a 64-
bit file, when searching for acceptable Microseconds per time unit values, we take the lowest value that
minimises sampling rate errors. With a 32-bit file or with this option selected, we take the highest value.

10 MHz clock
Check this box to force the Microseconds per time unit to be an integral number. Before version 6.05 this
control was available as part of the Groups field as / MHz, same sample rate groups.

WaveMark divider

Previously, if you had WaveMark (spike shape) channels, the sampling rate of the WaveMark data set the
maximum sample rate for all other waveform channels. Now, we allow waveform channels to be sampled faster
than WaveMark channels by taking 1 in every n WaveMark points (dividing the WaveMark rate by n).

Copy channels
If you sample the same channel as both a waveform and as a WaveMark, we sample the data for the WaveMark
channel and take a copy for the waveform channel. Check the box to sample each channel separately.

Dummy channels

With older versions of Spike2, it was sometimes possible to get a better match to the desired sampling rates by
adding more channels and then ignoring the data in them. For example, if you requested 7 waveforms at 10 kHz
each you got 9.99 kHz. Adding another waveform channel produced 10 kHz again. Dummy channels do this for
you automatically, and do not waste any time moving data back to the host. Dummy channels are not used (or
helpful) in burst mode.

Optimise waveform rates

The Optimise field sets the parameters Spike2 changes to minimise sample-rate error. In full optimise mode,
Spike2 chooses the time resolution, the base ADC sample rate, and the best mix of slow, quick, copy and
dummy channels. In many situations you will want to specify the time resolution and let Spike2 do the rest.
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Sample rate error is defined as (rate - ideal)/ideal, where ideal is the rate you asked for and rate is the rate
you got. This is negative if the rate is too slow and positive if it is too high. The optimise command minimises
the sum of the absolute value of the errors.

None: use manual settings
You have control over the values in the Microseconds per time unit and Time units per ADC convert
fields. In this mode click the Suggest button to change the fields to values that minimise sample rate errors.

Partial: fixed time units

You set the Microseconds per time unit field and Spike2 adjusts the Time units per ADC convert field to
minimise the sampling rate errors. If there is more than one solution, Spike2 chooses the one with the slowest
ADC convert rate.

Full: time units can change

Spike2 sets the Microseconds per time unit and Time units per ADC convert fields. If all channels have a
slow rate, this can take a long time, especially in burst mode. The Microseconds per time range fields set the
acceptable range of time units. If there are multiple solutions, Spike2 chooses the one with the largest
Microseconds per time unit when writing to a 32-bit . smr file (to maximise the run time) and the one with
the smallest when writing to a 64-bit . smrx file. In a complicated sampling situation with a lot of channels this
can take quite a while as there can be a huge number of combinations to check.

Microseconds per time in range

This field is usually set for a range of 1 to 50 microseconds. However, if you are sampling to a 64-bit smrx file
you can usually set this to the range 1 to 2 microseconds. This allows a better time resolution and also reduces
the time Spike2 spends searching for possible clock settings.

If you upgraded from an old version of Spike2 you may find that the lower figure is set to 2 or more, which,
unless this is really what you want, will be a severe constraint.

Groups
This field places additional restrictions on how Spike2 maps the requested sample rates for all the waveform
and WaveMark channels into achievable sampling patterns.

Version 3 compatible

This gives the same waveform rates for a given Microseconds per time unit and Time units per ADC
convert as version 3. Only use this if you upgrade from version 3 and it is vital that sampling rates match old
data files.

Keep same sample rate groups
If you select this option, Spike2 will make sure that all waveforms channels with the same ideal sampling rate
have the same actual rate. You will normally use this option.

Ignore same sample rate groups

This option gives the smallest sampling rate errors. The price you pay is that channels with the same ideal
sampling rates may get actual sampling rates that are different. Some data analyses, such as waveform
correlations, multiple channel averages and power spectra demand that channels have identical sampling rates.

1 MHz, same sample rate groups

This setting was present before version 6.05 but no longer exists. You can achieve this now by disabling the 10
MHz clock in the Compatibility section and selecting Keep same sample rate groups. If you read an old
configuration that used this setting it will be translated to work in the same way.

Burst mode

The Burst check box is visible if you select any type of Power1401 or a Micro1401 mk II, -3 or -4. If you
check it, instead of sampling the ADC at equal intervals synchronised to the 1401 clock, it samples a burst of
channels at a time, each burst being synchronised to the clock. When you check the Burst mode box, the ADC
will convert at field changes to ADC burst rate.

Burst mode sampling can be useful when you sample more than 1 waveform or WaveMark channel. If you have
n waveform and WaveMark channels, the advantages of burst mode are:
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¢ You may be able to run the Spike2 clock (set by Microseconds per time unit) n times slower. This allows
longer sample durations if you sample to a 32-bit file; this is not a consideration for 64-bit files (where you
should normally set the resolution between 1 and 1.9 microseconds).

e You may be able to achieve sample rates per channel that are n times higher for the same Spike2 clock rate
or much closer to the requested rate.

M Sampling configuration: EAWINSPIKE\SonHelp11\manual11.s2cx* — O x

Channels Resolution Mode Sequencer Play waveform Automation Script

File format  32-bit smr (2 GB max) ~ | Optimise waveform rates
Optimise  Full: time units can change ~  [v]Burst
Time resolution and ADC rate it ? e T e 5
Microseconds per time =5 = icroseconds per time in range to
Longest run time 1 Day, 05:49:34 Groups Ignore same sample rate groups &
ADC burst rate 20000 Hz # Hz Err% Type | Channelrate
1 1000 OK S Worst: 0%
2 100.0 OK S
5 20000 oK wi
Type of 1401 P 1401-3 &4
H a Sk 6 20000 oK w4 Wn=WaveMark

Q =Quick waveform

Disable for compatibility S =Slow waveform

[ 64-bit optimisation C =Copy WaveMark
[]10 MHz clock [[] WaveMark divider
[[] Copy channels [C] Dummy channels Suggest

32-bit .smr output file Cancel Run now Help

In this example, setting burst mode allows us to run for more than 1 day when sampling to a 32-bit file (1
Waveform at 1 kHz, one at 100 Hz, a WaveMark channel with 1 trace at 20 kHz and another with 4 traces).
Without burst mode, the time resolution has to be 5 microseconds, which limits the run time to just under 3
hours. Of course, if you target a 64-bit file, you can run at 1 microsecond resolution with no practical time limit.

The disadvantages of burst mode are:

e Waveforms are sampled at times that may fall between Spike2 clock ticks. Channels are sampled at precisely
the correct interval, but each channel is shifted sideways by up to half a Spike2 clock tick from when it was
sampled. In many applications this will not matter, and the benefits of a better sampling rate may outweigh
this. From version 8 onwards, where you can have a very small clock tick, this may not matter at all.

e If you are sampling to a 32-bit file (not recommended), and have used Burst mode to extend the sample time,
you will also have reduced the time resolution. In the example, above, the time resolution is 50
Microseconds. You can improve the time resolution at the expense of the run time by adjusting the to field in
the Microseconds per time in range. For example, settng it to 10 reduces the maximum run time to under 6
hours.

Burst mode is most effective when you sample to a 32-bit file and have a large number of waveform and
WaveMark channels. With a 64-bit file and multiple waveform and WaveMark channels you may be able to get
closer to a desired Ideal sampling rate.

If you set the Optimise field to None, for full manual control, you will normally set the Time units per ADC
convert field to 1 as higher values tend to reduce the benefits of burst mode.

Warning
Checking this box is a suggestion, not an order. In some cases, particularly at low sample rates with small
numbers of waveform channels that all are marked as S =Slow waveform, Spike2 will ignore this check box.

Data file types

Spike2 is optimised to use and sample data to the 64-bit SON64 filing system. It can also use and sample data
into the original 32-bit SON filing system. We would recommend that you use the new format unless you have
pressing reasons for using the old. Not all sampling features are supported by the old filing system and at some
point we will remove support for sampling to it. You can read the file format version with the FileInfo ()
script command.
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The 32-bit file system (*.smr)

The original Spike2 data format was first released as version 1 around 1988 and the original design has been
extended several times since; we are currently at version 9 (the final version). Each revision has added new data
types and/or new filing system features. Changes were incremental; older versions of Spike2 would read newer
files as long as they did not use new data types or features that the older versions did not know about.

The original design was based on the idea that all items in the file were located in time at an integer multiple of
a basic clock period and that there are two fundamental types of data: waveforms (equally spaced in time data
samples) and events (items at defined times with other data attached). There is some crossover between these
types; waveforms can have gaps and events can have waveforms attached to them. You can download a manual
explaining this library plus interface software from our web site.

32-bit original format

There are two limits to the size of a 32-bit Spike2 data file: the number of clock ticks in the file (limited to
2147483647) and the physical size of the file. The physical size before version 7 was limited to 2147483647
bytes, or 2 GB. These limits are related to the maximum size of a signed 32-bit number. For many users these
limits are not a problem. However, it is possible to run out of disk space before you run out of clock ticks. For
example, if you set the Waveform sample rate to be one clock tick and sample one channel, each sample point
uses 2 bytes of data. If you set Burst mode sampling in the Resolution tab with n channels, each taking one
sample per clock tick, then each clock tick is using 2n data bytes. This means that your maximum possible run
time is limited to 2147483647/2n clock ticks.

Before Spike2 version 7, if you were sampling 32 channels of data at 31.25 kHz each, in non-burst mode you
would need to set the clock tick to 1 microsecond, giving a clock tick limit of some 35 minutes of sampling.
However, the file size limit would be hit in around 17 minutes. If you changed to burst mode sampling, the
clock could be run at 32 microseconds per tick, which extends the clock limit to 19 hours, but the file size limit
is still 17 minutes.

32-bit big files (Spike2 version 7 onwards)

If you set the file type to 32-bit big, the maximum . smr file size is increased by a factor of 512, and with the
example given above (32 channels at 31.25 kHz each in burst mode), you could sample for the full 19 hours
allowed by the clock tick period. However, your timing resolution is now 32 microseconds. This would
generate a huge file (128 GB) which would be slow to navigate.

32-bit limitations
The 32-bit system served us well, but has limitations due to the 32-bit nature of the format:

1. Times are stored as 32-bit integers, limiting us to a maximum of 2 billion clock ticks per file. At a
resolution of 1 ps (microsecond) the maximum duration is 35 minutes and 47 seconds.

2. The file size was originally limited to 2GB. This was later extended to 1TB, but at the cost of making data
recovery harder.

3. It can take a long time to locate data in the middle of a file. Finding data was speeded up by including
lookup tables, but the methods used were limited by the requirement for backwards compatibility.

4. Waveform data with gaps is not stored efficiently as each gap starts a new disk block, so short waveform
fragments use a lot of disk space.

5. There are limits on the number of characters used for channel titles (9), units (5) and comments (71) and file
comments (79). Further, these are 8-bit characters, so if you take advantage of character codes outside the
ASCII range, these will take two or more UTF-8 characters to store. This can be a problem, particularly for
the Units. For example, if you decided to replace "uvolt™ with "uvolt™, and saved this to a 32-bit file, it
would be truncated to "uvol" as the code for the Unicode character 1 is U+03BC which is coded in UTF-8
as Oxce, Oxbc.

The 64-bit filing system (*.smrx)

The new 64-bit filing system was designed to be logically compatible with the 32-bit system; by this we mean
that it can hold the same types of data as the original without information loss, though some of these types are
extended. It is also likely that we will add further data types, as required, in the future. Features include:

1. Times are stored as 64-bit integers. At a time resolution of 1 ns (nanosecond, 10 seconds), the maximum
duration is around 256 years.
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2. The file size is limited only by the capabilities of the operating system and by the size of a file that you can
manage conveniently for archival. As I write this, disk drives have a maximum size of a few TB.

3. The file format is designed to make recovery of damaged files relatively straightforward.

4. The files have a built-in data lookup system designed to minimise the number of disk reads required to
locate data on any channel.

5. The overhead for severely fragmented waveform data has been reduced to a few bytes per fragment.

We have removed many of the limits on things like the number of channels in a file and the length of channels
comments and units. Before Spike2 version 8.03 the program enforced the original limits on the length of
strings (but treated as Unicode characters). From version 8.03 onwards, a 64-bit smrx file in Spike2 can have
20 Unicode characters of channel title, 10 of channel units and comments can be up to 100 characters. The
underlying file format does not impose a fixed limit, but practical considerations make it useful to define them.

How older versions of Spike2 cope with 64-bit (.smrx) files

Spike2 version 7.11c¢ onwards can read (but not modify) the new 64-bit file system if the son64.d11 file is in
the Spike2 version 7 folder. Of course, if the file is longer (in clock ticks) than the old file system can read, only
the start of the file will be visible. No other older versions of Spike2 can read them.

How older versions of Spike2 cope with 32-bit (.smr) files

Spike2 version 8 can read files with more than 400 channels, but ignores channels 401 upwards. Spike2 5.15
onwards can read files with up to 400 channels. Versions from 5.00 to 5.14 read files with up to 256 channels.
Version 4.03 onwards reads files with up to 100 data channels. Versions before 4.03 can read files with up to
32 channels. You can use the File menu Export command to write channels from a data file to a new file with a
suitable maximum channel limit so that it can be read by older versions of Spike2. If you check the Big file box
you will not be able to open any generated file with versions of Spike2 before 6.11. Spike2 version 6 revisions
that can open the file will treat it as read only.

Technical details of 1401 sampling

There is a master clock in the 1401. The Microseconds per time unit field sets the tick period of this clock.
All times in a Spike2 data file are multiples of this time unit.

The Analogue to Digital Converter (ADC) samples one input at a time and is shared between all the waveform,
RealWave and WaveMark (spike shape) input channels sampled by the 1401. The table below lists the
maximum sampling rate in multi-channel mode for the ADCs in each 1401 when used in Spike2 and also if the
1401 supports Burst mode sampling. Items marked * are not supported in Spike2 version 11 but are preserved
for reference. Using a slow interface (for example USB 1.0) will reduce the maximum rates.

1401 type Maximum rate Can burst
1401plus* 166 kHz No
micro1401* 166 kHz No
Power1401 400 kHz Yes
Micro1401 mk 11/-3 500 kHz Yes
Power1401 625 667 kHz Yes
Power1401 mk Il 1 MHz Yes
Power1401-3/3A 1 MHz Yes
Micro1401-4 1 MHz Yes

To illustrate the difference between non-burst mode and burst mode, we will consider what happens when we
set Microseconds per time unit to 10 and Time units per ADC convert to 2 with five waveform channels in
both non-burst mode and in burst mode. In the diagrams, the numbered circles represent the ADC sampling
each channel and the horizontal position of the circle represents the time at which the sample occurs.

Non-burst mode

In non-burst mode, the Time units per ADC Spike2 clock (10 ps)
convert field sets how often the ADC samples in

units of clock ticks. For example, with 10 ADC clock (20 ps)
microseconds per tick (but see Improvements at L L
version 8, below) and the Time units per ADC @ @
convert field set to 2 (once every 20 : :

@ =
. —
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microseconds), the ADC sample rate is 50 kHz. In a simple case with five waveform channels, the fastest each
channel could be sampled is 10 kHz. Each sample is synchronised to the Spike2 clock and the pattern repeats
every five samples.

Burst mode

In burst mode, the Time units per ADC convert Spike2 clock (10 ps)
field sets how often a burst of ADC samples is

taken. With the same settings of 10 microseconds ADC clock (20 ps)
per tick and the Time units per ADC convert
field set to 2, the burst rate is 50 kHz. In a simple
case with five waveform channels, five channels
would be sampled in a burst, each channel
sampled at 50 kHz. The interval between
samples in a burst depends on the 1401 hardware
and is typically the interval implied by the maximum sampling rate for the 1401 hardware.

As you can see, the ADC samples no longer fall exactly at Spike2 clock times. The times between samples on a

channel are exact, but the entire channel may be displayed time shifted by up to half a Spike2 clock as it is
timed to the nearest tick. In this case, channels 1,2, 3 and 4 would probably be timed for the tick just before
them, and channel 5 for the next tick.

Cycle of channels

To generate the sample rates, the ADC samples a cycle of channels. In burst mode all the channels in a cycle
are sampled in a burst, in non-burst mode they are sampled one at a time. WaveMark channels are sampled
once every time around the cycle. Some waveform channels are set as Quick and are also sampled every time
round the cycle. The other waveform channels are set as Slow, and these share one position in the cycle. Quick
and Slow channels save every n’ data point (n in the divisor in the range 1 to 2147483647). The Version 3
compatibility setting in Groups sets all waveforms as Slow channels and the maximum divisor to 65535.

With a Micro1401 mk IT or -3 or any Power1401, there are further features (unless Version 3 compatibility has
been set):

WaveMark This enables down-sampling (taking 1 point in n) of WaveMark data. This allows you to sample
divider Waveform channels faster than WaveMark channels.

Copy If you sample a waveform channel on the same 1401 port as a WaveMark channel, we can use the
channel same data twice, once for the WaveMark channel and once for the waveform. These Copy
channels behave exactly like a Quick channel, but are more efficient.

Dummy Adding additional channels to the sampling loop sometimes gives a more accurate approximation

channel to the desired sample rates. Adding a Quick channel would waste time transferring unused data to
the host; a Dummy channel just throws the data away. Spike2 adds dummy channels automatically
if they improve the channel sampling rates. Dummy channels are not added in burst mode.

The diagram shows a possible cycle for two
WaveMark channels and seven waveform channels of
which 2 are the same as the WaveMark channels.

Each time around the main loop, the 1401 samples all @ @ @ @

WaveMark, Quick and Dummy channels and one W = WaveMark, C = Copy.in=1inn " 7
Slow channel. ~ When waveform and WaveMark @ =Quick, §= Slow, D= & Dhicies @@

channels are sampled together, the fastest waveform
rate is the same as the WaveMark sample rate.

Spike2 searches all ADC rates allowed by the Optimise setting and the Type of 1401 field for the best
combination of Quick, Slow, Copy and Dummy channels and the best value of n for each channel to get as
close as possible to the ideal sample rates. With slow waveform rates there can be millions of combinations to
search. If the Channels Tab feels very sluggish, set Optimise to None, set the channels, then restore the
Optimise value. Impossible combinations display a warning in the lower left corner of the dialog.

If you check boxes in the Disable for compatibility section, this stops Spike2 taking advantage of optimisations
that are not available for all 1401s. You might want to do this if you upgraded your 1401 and discovered that
the sampling rates with your new 1401 were not the same as with the old one. Of course, the new rates would be
closer to what you had asked for, but it might be important that they matched the old rates exactly.
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The table to the left of the Suggest button lists the channels in order of descending sample rate error, showing
the actual sample rate, the error as a percentage of the desired rate or OK if there is no error, and the channel
type (WaveMark, Copy, Quick or Slow) and the number of Dummy channels.

Improvements at version 8

Version 8 of Spike2 allowed you to use 64-bit data files in place of the 32-bit files used in all previous versions.
For 32-bit files, the maximum sample time is 2,147,483,647 clock ticks (2 x 10%). At 2 microseconds per tick
this is 71% minutes, at 10 this is almost 6 hours, and at 1000 this is nearly 25 days. For 64-bit files, the
maximum sample time is 8,070,450,532,247,928,832 clock ticks (8 x 10'®). This is so large that we need not
worry about running into the limit. Several of the limitations in sampling in previous versions of Spike2 were
caused by the requirement to maximise the Microseconds per time unit field to give long run times; selecting
a 64-bit file format removes these limitations.

In the examples above, the Spike2 clock is shown as running at 10 us per tick, which was a commonly-used tick
rate with the old 32-bit time file system as it allows a run time of around 6 hours per data file, but at the cost of
restricting the ADC sample rate, or forcing the use of burst mode. If you choose a 64-bit data file, you can
usually run the Spike2 clock at 1 microsecond per tick, with a much wider choice of sample rates and no
limitations on run time.

Sampling mode

The Mode page of the sampling configuration dialog determines when data captured by Spike?2 is saved to the
disk system. In all modes, time passes at a constant rate, even when nothing is written to disk. When reviewed,
areas of a file with no saved data are empty. There are three sampling modes: Continuous, Timed and
Triggered. The script language equivalent of this dialog is the SampleMode () command.

M C:\Users\greg.CED\AppData\LocaNCED\Spike TO\LAST.s2cx* - ] X
Channels Resolution Mode Sequencer Play waveform Automation Script

Sample mode |Triggered > Video FPS when not saving (0 for unset) ‘ 0

Trigger 1 Trigger 2

Chan 31 Keyboard ~ | code|[1,3,5,7,9] Chan None v

From (01 [To[4 | off 024681 | 0 To| 1

Chans‘ 1 ~ |

Script None > At End Script None ~ At End

Trigger 3 Trigger 4

Chan None v Chan None v

0 1 0 | 1
Script None & At End Script None N At End
Cancel Run now Help

Whichever sampling mode you select, the Sample control bar Write check box lets you disable data saving to
the data document on all channels while sampling. Script users can enable and disable data saving channel by
channel with the SampleWrite () command. If the Sample control bar or the SampleWrite () script
command disables writing on a channel, nothing is written on that channel regardless of the sample mode set in
this dialog. Once the channel is enabled again, the sample mode then determines when data is saved to disk.

Right-click (Context) menu

Within this dialog, you can right-click to open a Context menu with options to copy the sample mode settings as
text to he clipboard or to the Log view. If a script is defined, right-click within the Trigger or Timer group box

for an option to open the script in a Script window.

Continuous mode

The simplest sampling mode is Continuous mode, which records data continuously unless disabled by the

Sample control bar or by a script.
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Timed mode

In Timed data capture mode, data is saved at intervals. You set the period  Timing

for which data is saved and how often to save the data. The times at which g, [s0 Gl
the blocks were requested are saved in the keyboard marker channel. ———
Marker code 00 is placed at the start of each timed block and marker code =" = |
01 is placed at the end of each block. If you use a 32-bit output file you  Seript|Nene ~ | AtEnd
should read the 64-bit and 32-bit file differences section, below.

Minutes v

From version [10.09] you can also nominate a sampling script to run either at the start or at the end of each
sampling period. See the Script tab for sampling script limitations. If a script is selected, right-click to open it
in a script window.

Triggered mode

In Triggered capture there are four triggers. Each has a channel list (that can be empty) and an optional script.
A trigger is an event or marker that causes data to be marked for writing to disk in a time range relative to the
trigger and can run a nominated script (as long as no other script is running). Data Triggers are additive, that is
if a new trigger occurs while data is being written due to a previous trigger, the trigger period is extended.
Script triggers cause a script run request for every event. There is also an optional Off event that stops the disk
writing before then end of the time range.

In triggered mode, any channel that is not associated with a trigger is recorded continuously. Each trigger has
the following fields:

Source This should be set to None to disable the trigger or you can select a channel from the drop down
list. You can trigger on any event, Marker or WaveMark channel in the sampling configuration.
Before Spike2 version [9.01] you could not trigger on a channel generated by a Talker. You can
select only channels that exist in the current sampling configuration.

Code If the trigger source is a Marker, WaveMark, RealMark or TextMark channel, you can choose to
trigger only if the marker code matches the marker mask specification defined by this field. Set
the field empty to match all codes. Codes 00, 01 and 02 in the keyboard marker channel are
special and will not cause triggers.

From This value is the offset from the trigger to the start of the area to record, in seconds. Negative
values define pre-trigger start times, positive values start recording after the trigger. If you set
too long a pre-trigger time, the data may have been discarded before the trigger is seen. Spike2
normally attempts to use an 8 MB data buffer, so this is not often a problem. To save time, we
do not redraw data before the trigger if the From time is negative; we cancel the Not saving to
disk colour from the time the trigger was seen, not before.

To This value is the offset from the trigger to the end of the area to record, in seconds. It must be
greater than the time in the From field.

Off Enabled if a marker mask specification is set in the Code field. If a Trigger channel marker
code matches the marker mask specification defined by this field, sampling is disabled from the
marker time on the Channel field channels and any script in At End mode will run at the next
opportunity. This was added at version [10.13].

Channels  You can either select All Channels from the drop down list, or type in a channel list, for
example 1..4, 6,8 for channels 1, 2, 3, 4, 6 and 8. These are the channels that will be written
to disk each time the trigger event is detected. To set no channels set the field empty or select
No channel. No check is made in this field that the channels you type exist; non-existent
channels are ignored at sample time.

Script From version [10.09] you can select a sampling script to run each time the trigger event occurs.
See the Script tab for sampling script limitations. The drop down list remembers the last 10 used
trigger scripts. If a script is selected, right-click to open it in a script window. There are no
guarantees on when a script will run after the trigger event. On a lightly loaded system with no
other Spike2 activity (other than sampling), delays of order ten milliseconds or so are usual.
However, if the Edit menu Preferences Scheduler sets a long delay between Idle cycles, or if
other actions are taking place, delays can be much longer. You must test this in your sampling
situation.

At End This check box is enabled when a script is set and the To time is greater than 0. Checking this
box causes the script to run at the To time past the trigger rather than at the trigger time.
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Running a script At End means that triggered data from a 1401 will be available to the script.
This is not guaranteed to be the case for data from a Talker (Talker data can arrive delayed, the
delay depends on the Talker).

Triggered sampling is often used with fast waveform or WaveMark channels to save disk space in situations
where only small sections of the data are interesting. However, if you use a 32-bit output file you should read
the 64-bit and 32-bit file differences section, below.

Video FPS when not saving (0 for unset) [10.06]

If you use the s2video application to capture video, from version [10.06] you can set this field non-zero to
switch into the Slow frame rate mode when data is not written to disk. Not writing to disk happens
automatically in Timed mode and when you pause writing to disk on all channels. We take no action in
triggered mode (though we may add this in the future).

The standard state, with this feature disabled, is to set the field to 0. To enable this feature, set the desired slow
frame rate. For example, set 1 for 1 frame per seconds, 0.1 for one frame every 10 seconds.

Special keyboard trigger features
If the user changes the state of the Write check box in the Sample control toolbar, a marker code is written to
the Keyboard channel to indicate that writing to disk is enabled (code 00) or disabled (code 01). If a change is
made to a signal conditioner, code 02 and an explanation is written to the TextMark channel, but if this is not
present, code 02 is written to the keyboard channel. If the keyboard channel is used as a trigger, writing codes
00, 01 or 02 does not trigger sampling.

Display during data capture

In all data capture modes, the on-line display shows newly sampled data, even when you are not saving to disk.
Recent data is saved in a memory buffer in these modes so the current data is always available. However, if you
scroll far enough back into an unsaved time region, the display will become blank as the memory buffer has a
limited size.

64-bit and 32-bit file differences

If you use triggered or timed mode with the 64-bit filing system, triggered or timed channels will save only the
data implied by the timing or the trigger, as you would expect. Note that Level event channels are always saved
in their entirety, regardless of the saving state, to ensure we track the levels correctly. This may be revised in a
future revision by adding code to make sure that an even number of edges are dropped.

However, the 32-bit system can only save complete blocks of waveform data and each block is around 16000
data samples. If you select a 32-bit file output file, you will always save at least the data implied by the trigger
or timing, but with waveform channels you will usually get more data than asked for. Further, if your triggers or
timing periods are closer together than 16000 data points, you will save continuous data.

Sequencer

The Sequencer page of the Sampling configuration dialog sets the output sequence to use during sampling.
The sequence can either be a *.pls text sequence file stored on disk or it can be a graphical sequence created
from this dialog. From version [10.15] it can also be a text sequence stored as part of the sampling
configuration.

The main control is the Output selection drop down list. The option available are:

None
There is no output sequencer used in this sampling configuration.

Select a text sequence file

Opens a file selection dialog in which you can choose a text output sequence file (*.pls) that will be used
when you sample. These files are created with the output sequence text editor or by exporting graphical editor
sequences as text.
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Use graphical sequence editor
This reconfigures the dialog to display the graphical sequence options.

Use text sequence: filename

This option is present when a sequence file is selected for use. The dialog displays the first few lines of the
sequence (if it can be read) and you can click the Open button or double-click the displayed sequence to open
it in a pulse editor view. If you want to edit the sequence you will have to close this dialog; alternatively you
can hold down ctr1 and click Open or double-click the sequence to close the dialog and open the sequencer
for editing.

M Sampling configuration = ] X
Channels Resolution Mode Sequencer Play waveform Automation
Output selection Use text sequence: Trapezoidal hold time variable i
Minimum Instruction | 1000 ‘ and Table space | 20 ‘ Jump control Keyboard and control panel -
C:\Users\Greg\Documents\Trapezoidal hold time variable.pls Open
SET 5.000 1 @ ;set 5 milliseconds per step ~
VAR V1,TrLevel=1000 ;set some level to start with
VAR V2,Data ;the data value we read
(3 [Te[UR (R [SN— 0] ;make sure bit 8 is low (the re
—sToP: ‘s JUMP  stop ;Stop! no output >Waiting to
I
—Go: g CHAN Data,1 ;Gol >Running
BLT Data,TrLevel,go ;test level >Running
DIGOUT [....... 1] ;give reward >Reward
DELAY ms(500)-2 ;to generate a 580 ms pulse >Rel
DTGEOLT T Al en end reward SRunning ¥
< >
Cancel Run now Help

Save text sequence ‘filename' as part of configuration

This option is present when a text sequence file is selected for use. If you choose this option, a copy of the file
is stored in the sampling configuration as text and the selected option will change to Use text sequence in
sampling configuration. Storing the sequence as part of the configuration means that you only have the
configuration file to keep track of rather than it and an output sequence file. However, using sequencer text
stored in the configuration is usually used by script writers who generate sequences dynamically as it saves the
need to write them to a file. This feature was added at version [10.15].

Use text sequence in sampling configuration

The display will show the first few lines of the sequence stored in the sampling configuration. If you double-
click the displayed sequence or click the Open button, it will be written to the file S2CFGSEQS.PLS in the
current user data folder. You must close the dialog to modify the sequence. If you use the Current button in the
output sequence editor view and the file name is set to S2CFGSEQS . PLS, this will update the sequence stored in
the configuration. If the sequencer text is empty and you close the dialog, the Output selection will revert to
None. This feature was added at version [10.15].

Recent: filename
The list of options ends with a list of recently-used output sequence file names that you can select.

Minimum Instruction and Table space

Spike2 reserves space in the 1401 for the instructions and table space used by the sequence set in the sampling
configuration. However, if you load new sequences during sampling or edit the graphical sequence during
sampling, the replacement sequences may need more space. These two fields reserve extra space; the space set
is the larger of that required for the initial sequence and the values you set in these fields. Unless you intend to
replace the initial sequence with a text sequence during sampling you should set both these fields to 0. The
script equivalent of these fields is SampleSeqCtrl ().

Jump control

The sequencer can be commanded to jump to specific places by keyboard commands, the Sequencer control
panel , the Create TextMark dialog, the serial TextMark input and always by a script. You can limit the
interactive options to prevent accidental jumps. Choose from:
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Keyboard Control panel Script
Keyboard and sequencer control panel Yes Yes Yes
Sequencer control panel No Yes Yes
Script commands only No No Yes

Lower portion of the dialog

If a text sequence file is selected it is displayed in the lower portion of the dialog. To modify an output
sequence file you must open it; the easiest way to do this is to double-click in the displayed file. You must close
the Sampling Configuration dialog before you can edit the sequence.

If you select the graphical sequence editor, the lower portion of the dialog displays graphical sequencer control
settings.

Changing the sequence during sampling

If you have selected the graphical sequence editor, you can change the editor settings and apply them during
sampling by using the Sampling menu Graphical Sequence Editor... command. Each time you apply the
settings, the sequence restarts with the new settings.

You can also use the Sampling menu Change Output Sequence command to apply a different Text Sequence
during sampling.

In both cases, your new sequence must use the same, or fewer resources than the original sequence, or you must
have set a Minimum Instruction and Table space, as described above.

Arbitrary waveform output

You can replay arbitrary waveforms during data capture. Up to 62 (20 with Micro2 and Micro3) different “Play
wave” areas can be defined for output. Each area outputs waveforms on 1 to 4 DACs and is identified by a key
code (in the range Chrs (3) to Chr$ (127)), typically a printing character such as “A”. No two areas may have
the same code. You do not have to use a printing character, you can use a two digit hexadecimal code if you
prefer, however codes 00, 01 and 02 are not allowed, nor are codes above 7f. The format of this code is the
same as for marker codes. Because you can trigger waveform output by recording keyboard markers with this
code you should make sure that your code usage is compatible with key codes used in the output sequencer. We
suggest that you confine yourself to alphanumeric characters (upper and lower case A-Z and 0-9).

From [11.00] you can also trigger waveform areas with TextMark data, either from the Create TextMark dialog
or from serial line TextMark data.

The waveforms are played from 1401 memory and are copied there just before sampling starts (when the Time
window to display sampled data is created). This reduces the memory available for recording data. The
maximum data you can store in the 1401 for replay is the free space in the 1401 less 256 KB which is the
minimum Spike?2 reserves for recording. The maximum size of a waveform area is 32 MB (assuming your 1401
has sufficient memory). Script users can update the memory dynamically during replay, so huge memories are
not necessarily required!

The table summarises the capabilities of arbitrary waveform output for different 1401 types.

1401 Type Micro2 Micro3 Micro4 Power1 Power2/3 Power3A
Wave space | 0.7/1.7 MB 3.7 MB 31 MB 32 MB 32 MB 32 MB
Areas 20 20 62 62 62 62
Fastest rate 167 kHz 250 kHz 500 kHz 500 kHz 500 kHz 500 kHz
Slowest rate | 0.00024 Hz | 0.00024 Hz 0.048 Hz 0.00024 Hz | 0.00024 Hz | 0.00024 Hz
Resolution 0.1 ps 0.1 us 0.05 us 0.1/0.2 us 0.1 us 0.05 us
Best 44.1 kHZ| 44.053 kHz | 44.053 kHz | 44.101 kHz | 44.247kHz | 44.053 kHz | 44.101 kHz

Wave space The maximum memory space you can use to stored arbitrary waveform data in the 1401. Using
the maximum space may make high-speed data capture more prone to overrun for Micro1401s
as it leaves only 256 kB for data buffering. The 0.7 Micro2 figure is for IMB of main memory,
the 1.7 MB is for 2 MB of memory.
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Areas The maximum number of separate play wave areas you can define. The sum of the sizes of
these areas must fit in the Wave space.

Fastestrate = Measured replaying two waveforms while sampling one at the same rate. If you sample or
replay more channels or use the output sequencer, the maximum rate may be lower.

Slowest rate  The slowest the 1401 clock hardware can be programmed to run; around one sample every 20
seconds for the Micro4 and one sample every 400 seconds for all the other 1401 types.

Resolution The accuracy that the output waveform clock can be set to.

Best 44.1 kHz The closest we can get to one of the standard audio output rates due to the output clock tick
resolution.

The final sample of the waveform area sets the output level after waveform output ends, so it is usually a good
idea to make sure that the waveform output ends with a zero value. Note that the VDACO-VDAC7 sequencer
variables are not updated by arbitrary waveform output.

Frequency resolution

The 1401 DAC output rate is derived by dividing down from a fixed frequency clock. The fixed frequency can
be chosen from 1, 4 or 10 MHz for all 1401s and the Micro4 and Power3A also support 200 MHz. The division
is by the product of two integers, both in the range 1 to 65535, except for the Powerl which uses the range 2 to
65535). Although you can request any rate, the actual rate will be the closest that the 1401 hardware can get to
the requested rate.

The table shows the timing resolution for output rates over 1 Hz (for slower rates, the resolution can drop as
low as 1 microsecond). These limitations can be significant, particularly if you replay imported data. For
example, 44.1 and 48 kHz (often used in .wAV files for sound recording) cannot be represented exactly. The
table shows the closest each type of 1401 can get to 44.1 kHz. This is calculated as the clock rate divided by
two divisors. The divisors are in the range 1-65535 for all but the Power1401-1 which is limited to the range 2-
65535.

For example, if your 1401 has a sample rate resolution of 0.1 microseconds, and you wanted to achieve 44.1
KHz, the divisor from 10 MHz (the internal clock rate corresponding to 0.1 microseconds) is 10000000/44100
which is 226.76 to two decimal places. The closest divisor we can get is 227, so instead of 44.1 kHz you would
get 44.053 kHz, an error of approximately 0.1%. In the case of the Power1401-1, as 227 is prime, the closest
we can get is 226 (2 x 113), hence the larger error. The Micro4 and Power3A have a 200 MHz clock available,
and they can get much closer to the desired rate.

You can use the ChanSave () script command to re-sample waveform data to a different rate using cubic spline
interpolation if the sample rate error is significant for your application. During data capture you can use the
PlayWaveSpeed () script command to read back the actual output rate.

You should never have any problem matching sampling rates when replaying data that was recorded with your
1401.

Play waveform toolbar

There is a dockable toolbar associated with the waveform output. This is | play wave &
enabled when you are sampling data with waveforms defined. The toolbar can
be docked on any edge of the application and can be resized when it is floating.
You can assign your own labels to the buttons, or you can let Spike2 generate
labels itself of the form Wave 0, Wave 1 and so on. The first button in the
toolbar is used to stop a currently playing waveform.

|Noouiput|l Testy || Testy |

| TestZ || Convert | | Fie |

The order of the buttons in this toolbar is the order of the waveforms in the Sampling configuration Play
Waveform tab. From [10.17a] you can change the order in the configuration by dragging the items.

From [10.03] you can disable this panel from starting waveforms from the Sampling configuration Play
waveform Tab and also with the PlayWaveCtrl () script command.

From [10.20], if you hover the mouse pointer over a label, any comment for that item is displayed. If no
comment is set, the tool tip displays the key for the area and the source of the waveforms.

Channels and DACs
Each play wave area contains from 1 to 4 data channels. You can select the 1401 DAC (Digital to Analogue
Converter) each channel plays through. The maximum DAC number you can set varies with the type of 1401.
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All Power1401 models allow DACs 0-7 and all variants of the Micro1401 allow DACs 0-1. It is not an error
with a Power1401 to select DACs 4-7 when they are not present; of course, there is no output.

With multiple channels, all channels play at the same rate and all DACs update together. You can play data
from waveform and WaveMark channels in a Spike2 data file, or data generated by a script. When data comes
from a Spike2 file, the channels need not all have the same sample rate; Spike2 takes the rate of the first
channel and interpolates data from the subsequent channels to make the rates the same. Script users can play
arbitrarily long data by updating the waveforms in the 1401 online with the P1ayWaveCopy () command.

The rate at which a wave plays can be modified in the range 4 times slower to 4 times faster than normal (as
long as your hardware can output fast/slow enough). From a script, you can change the rate during sampling,
even while the wave is playing.

Waveform storage
Waveforms for output can be stored in the sampling configuration several ways:

Reference to channels in a data file

This is efficient, as it uses very little space in the configuration file. It has the disadvantages that the data file
must exist in the same location when sampling starts and that if you refer to a memory buffer channel or a
Virtual channel, the data file must be open in Spike2 when recording is initiated.

Stored in the configuration

You can convert a file reference to the output waveform and save it in the sampling configuration. This can be
convenient for short waveform fragments, but can become very bulky with large ones, particularly as
configuration files store data as XML (basically as text).

As a promise that the script will fulfill
You can reserve space for output waveforms, expecting that a script will be running during data capture that
will set the data for output using the PlayWaveCopy () command.

Waveform scaling
The 1401 DACs play 16-bit waveform data. The source of DAC data can be a Waveform, WaveMark or
RealWave data channel, or can be set from the script language with the PlayWave. .. () family of commands.

Waveform or WaveMark channel

When the source of a waveform is a Waveform or a WaveMark channel, this data is already stored as 16-bit
integer data. The source channel values are copies, as is, to the DACs. The current channel scale and offset
values make no difference. If you want to scale the result, one way to do this is to make a copy of the channel as
a RealWave channel (either as a channel saved to disk or as a memory buffer channel or as a Virtual channel).
To convert a channel from Waveform to RealWave, the first step is usually to make a Virtual channel using the
Waveform channel as a source, then Save the channel to disk or import it into a Memory buffer.

RealWave channel

When the source of a waveform is a RealWave channel, this is stored as 32-bit floating point values. We use the
channel scale and offset to convert these values to 16-bit values to play from the DACs. If the result of this
conversion exceeds 16-bit range, the values are limited to 16-bit range (-32768 to 32767). Because of this
conversion, you can scale and shift the data by changing the source channel Scale and Offset values.

Imported data

If you import data (often from a text file) into Spike2 and want to replay it, it is easy to get confused by the
scaling. If you import text data as a Waveform, the importer scans the data to find the range, then maps this into
the 16-bit data range (from +32767 to -32768) so that the entire range of the data is represented and allowing
for a little headroom. The channel scale and offset are set so that the displayed data matches the input values. If
you select this channel for output, it will replay at whatever size it was saved at and the maximum amplitude
will lie somewhere between half and full scale.

If you import text data as a RealWave channel, the data is saved as the values read from the channel. The scale
and offset are set so that if the signal were converted to 16-bit data, it would use the full 16-bit range (with the
proviso that if the signal crosses zero, the offset is set to zero). If you play this signal, the DAC output will
likely go to positive or negative full scale (or both). However, by changing the scale (and offset) you can make
the DAC output span a lesser range.
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A concrete example may make this easier to understand. The standard range of the 1401 DACs is from minus 5
Volts to just under 5 Volts. Let us imagine you have imported a text file that holds a waveform with the desired
output values, in Volts. Let us suppose that these values are in the range -1 to +1 Volts. If you import this
channel as a RealWave channel, it will import and display the data in the range -1 to +1 Volts, as you would
expect. However, the channel scale factor will be 0.2 and the offset 0. These are set to give the best possible
(most precise) representation of the data if the channel were converted to a Waveform. However, if the channel
were output, this scaling would cause it to span the entire range of the DAC. To make the DAC output span the
range -1 to 1 Volt you must set the channel scale to 1.0.

If you imported this channel as a Waveform, the channel is already stored as 16-bit data. If you play this
channel, the output will span between half and all the DAC range. To make the replayed waveform match the
input you must convert the channel to a RealWave channel (as described above) then set the scale factor to 1.

Setting waves from a script

You can use PlayWaveCopy () to move a real or integer data array to an area for output. If you use an integer
array, values in the range -32768 to 32767 are written to the DAC (spanning the full range). Values outside this
range are limited to -32768 or 32767. If you use a real array, we assume that the DAC output range spans -5 to
just less than 5 Volts and map the values accordingly, limiting values outside the range -5 to 5 to the limits. If
your 1401 is set to a 10 Volt range the mapping is the unchanged, the output in Volts is doubled.

Playing waves
There are several ways to initiate output of a wave during data sampling:

Click the associated button in the Play waveform toolbar

Record the associated key code or key set by PlayWaveKey2$ () in the Keyboard marker channel
o Use the script language SampleKey () command to record the key code
o Use the output sequencer WAVEGO command

Unless you use the output sequencer to start the output, the associated key is recorded in the Keyboard channel
and marks the time at which output was requested.

When a wave starts to play, there is a time delay of one waveform output between the moment that output is
requested and the first data point appearing. This is not usually important, but at a slow replay rate, a one
sample delay could be significant. This delay can be useful if you are using the output sequencer as it gives the
output sequencer the opportunity to know about a change in the DAC outputs before it happens.

Triggered output

Each wave you play can be marked as “Triggered”. In triggered mode, when the waveform play is requested,
output does not start immediately. Instead, the 1401 hardware waits for a trigger input (high to low edge) on the
Trigger input for the Micro1401 and Power1401 unless this is routed to the rear panel Event connector pin 4
(Ground is pins 9-15) by the Edit menu Preferences. In triggered mode, the first data point is output at the
time of the trigger.

If you use the output sequencer you choose between triggered and non-triggered in the WAVEGO instruction. You
can also trigger the wave from the sequencer with the WAVEST instruction and detect if the wave has started to
play with the WAVERBR instruction.

Repeated plays and links

Each wave can be set to play cyclically for a set number of times. You can also link waves together if they have
the same DAC output list. Linked waves play at the rate of the first wave, that is the sample rate of subsequent
waves is ignored.

For example, you might have a sound output that needs to ramp up, stay at a constant level, then ramp down.
This could be done with three waves. The first holds the ramp up waveform, the second which repeats
cyclically many times would hold the constant sound, and the final part would ramp down.

Scripts and the output sequencer can command a wave with many cycles to finish the current cycle then
continue to the next linked area. You could use this to simulate a blood pressure signal with an occasional
errant beat by having two waves, one with a normal beat set to repeat many times and one with the errant beat
set to play once. By linking the two areas to each other, you get one errant beat after a fixed number of normal
ones. Further, by using the randomization functions in the output sequencer you could produce errant beats
randomly and mark the times at which they occurred.
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Script-only features
The PlayWaveCopy () command allows you to modify the contents of an area while sampling is in progress.

PlayWavePoints () allows you to change the size of an area dynamically (but sizes can only be less than or
the same as the original size). This lets you allocate an area, then use it to play back waveforms of different
lengths. The PlayWaveKey2$ () command lets you associate a second key with an area. This can be used to
play the area, just as the standard key code does, but this code can be changed dynamically, enabling separate
key codes for different waveforms played from one area.

Play waveform

The Sampling configuration Play waveform tab lists waveforms for on-line output. Add waves with the
Sample menu Offline waveform output dialog Add to Online button and by scripts. The settings are used the
next time you sample. Spike2 moves waveforms to the 1401 when the Sampling document is created; this can
take a noticeable time if there is a lot of data. Script users can update waveforms during data capture.

@j C:\Users\greg.CED\Documents\Spike10\test.s2cx = [} X

Channels Resolution Mode Sequencer Play waveform Automation Script

Playwave output control  Keyboard, Tool bar, Sequencer and Script ~

Key  Label DACs Rate Bytes Cycles  Source
)L [long [0 | 25000 | 10.4kB | 1 [Cricket Song (12.30-12.50) 1
S Short 0 25000 2382 1 Cricket Song (10.70-10.75) 1

Source C:\Users\greg.CED\Documents\Spike10\Data\Cricket Song.smr

Key|L ‘ Label | Long ‘ ;ycles‘ 1 : DACs

| . 0 2 Convert
[ITrigger  Link [No ~ Speed | 1.00 =
Comment ‘ Train of continuous pulses Delete

Cancel Run now Help

The order of the waveforms in the list determines the order of the buttons in the Play waveform toolbar that can
be used during sampling to command the waves to play. From Spike2 version [10.17a] you can change the
order by clicking on a waveform and dragging to a different position in the list.

Playwave output control (new in [10.03])
This field controls which methods can be used to select the current wave for output. There are 4 possible ways
to command a wave to play:

1. By a keyboard key press when the sampling time view has the input focus or from [11.00] from the Create
TextMark dialog or from TextMark data from a serial line.

2. By clicking in the Play waveform tool bar to select a wave.
3. By the SampleKey() script command of from [11.00] by the SampleText () script command
4. By an output sequencer command (graphical or text).

We presume that any action by a script or sequencer is always allowed, but you may want to prevent
keypresses, or even inadvertent clicks on a toolbar from disturbing the waveform output. The standard state
before [10.03] was to allow all methods. You can now disable the keyboard, or the keyboard and the play wave
toolbar. The script language equivalent of this field is PlayWaveCtrl (). Note that triggers from the TextMark
dialog or from serial line TextMark data have separate enables and are not affected by this control.

Modify selected wave
Editable fields for the currently selected wave are at the bottom of the dialog:

Key Wave identifier. A character or two hexadecimal digits in marker code format; you may not repeat a
code or use 00. It is added to the Keyboard marker channel on a Play wave toolbar button click.
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Label

DACs

Rate

Size

Cycles

Source

Trigger

Link

If a wave is checked in the list, space is reserved for it in the 1401 and if a waveform is defined, it is
copied to the 1401 before sampling starts. It can take a noticeable time to copy many megabytes.

Up to 7 characters to label buttons in the Play wave toolbar. If you use &, the next letter is
underlined and you can use it as a short-cut to the key when the toolbar has the input focus.

A list of the Digital to Analogue Converters to play your waveform out of. You can change the list
with the drop down lists inside the group. You cannot set two channels to use the same DAC output.

The number of samples to output per second per channel, set when the wave is added to the list.
You can vary the replay rate with the Speed control in the range 0.25 to 4.00. If the speed control is
set to any value other than 1.00 the Rate field shows the multiplying factor as well as the rate. The
graphical sequence editor takes account of Speed when displaying waves, but does not (currently)
adjust the wave duration to allow for it.

This is the number of bytes of 1401 memory needed to hold the wave.

The times to play the wave. Use 0 for a very large number (about 4 billion). The graphical sequence
editor assumes Cycles is 1 when displaying waves.

Where the waveform (if supplied) is stored. Below, Name is a data file name, sTime and eTime
are the start and end times of the data and chans is the list of channels to read the wave from.

Name (sTime-eTime) chans: a wave in a data file. The full path appears in the Source field. If
the data file is open in Spike2 the channels can be any channel, including Virtual channels, memory
channels, duplicate channels and channels with attached channel processes. If the file is not open in
Spike2, only disk-based, permanent channels can be used.

Wave from Name (sTime-eTime) chans: a wave originally read from a file, held in memory and
saved in the sampling configuration. The full path to the file appears in the Source field. You can
release the memory and revert to reading data from the file with the Convert button.

Wave from script: a script generated wave, held in memory, saved in the sampling configuration.
Place holder for script: a script has reserved space. The wave will be generated on line by a script.

Check this box for waveform output that is enabled by play requests and that starts on the Trigger
input. If this is not checked, a play request starts the waveform playing immediately.

You can link waves with identical DAC channel lists together. Linked areas play in order with no
time gap between them at the rate set by the first wave played. The graphical sequence editor does
not allow for links when displaying waves.

Comment If you set a comment, it is used as the tool tip for the corresponding button in the Play wave bar.

Convert

Update
Delete

Automation

The comment an be read and set with the P1ayWaveComment$ () script command.

This button changes data held in a file into data held in memory and vice-versa. If this option fails
because the channels numbers refer to a virtual or duplicate channel, you may be able to make it
work by opening the file within Spike2 to create the missing channels.

Applies any changes you have made to the current wave.

Delete the current wave.

The sampling configuration dialog Automation page sets the file path and name for automatic data filing, sets
the security parameters for new data files and restricts the total sampling time and the size of the data file. It
also contains the label and comment used when you add the sampling configuration to the Sample bar.
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M C:\Users\Greg\AppData\Loca\CED\Spike9\DEFAULT.s2cx* = O X

Channels Resolution Mode Sequencer Play waveform Automation

Automatic file name generation

Directory path ‘ C:\Users\Greg\Documents\oscillation ‘ Browse...

Name template ‘ test%y%m%d_000 >> Repeat count ‘ =

Data security Starting and stopping

Flush to disk every‘ 5 2 minutes Triggering Use previous ~

[] Comment file at end of sampling Stop at time | 10 minutes

Save file at end of sampling [CIstop at file size | 1 MByte
Output Reset ...

Sample bar

Label | Manual Comment | Example configuration used in the manual

Cancel Run now Help

Automatic file name generation

Spike2 samples data to temporary files in the folder set by the Edit menu Preferences. Unless you set a
Name template, these files have names like Datal, Data2 with no extension. When sampling ends, you save
the file to a name of your choice. You can automate file naming by setting a Name template of up to 40
characters (Spike2 versions before [9.01] limited this to 23 characters) or using the SampleAutoNames$ ()
script command, and Spike2 will generate a sequence of names from it. A blank Name template disables
automatic name generation. The file extension is determined by the Output file format set in the Resolution
page and should not be set here.

If the template does not end in a number, 000 is added before using it. To make a file name, Spike2 increments
the number until a name is formed that is not in use in the Directory path folder (which must exist and cannot
be blank).

A template of test generates test000 to test999. A template of test10 generates test10 to test99. The
Directory path must be less than 200 characters long. If the folders set by Directory path and in the Edit menu
Preferences option are in the same disk volume, sampled files are renamed rather than copied, which can save
a lot of time, especially if you are using automatic sampling on a sequence of files.

The script equivalent of Directory path is the FilePathSet () command with opt$ set to 3.

With a file name template set, the generated name is used when the data file is saved. A different name can be
specified using the File Save As... command. If there are no free names, or the path set for file saving does not
exist or is blank, you are not allowed to close the dialog until you fix the problem or use Cancel.

lllegal file name characters
You may not use any of the following characters in the file name template: < > : ™ / \ | ? *

Date and time specifiers

Within the file name template, the character sequence % followed by one of v, m, d, H, M or S is converted into a
two digit representation of the year, month, day, hours, minutes or seconds. %Y is replaced by the year as 4
digits. 3D is shorthand for $y%m%d and $T is shorthand for $H3M%S (we set the digits this way so that sorted
names are in time order). If the name ends with a date or time specifier, Spike2 adds _ to the name so that a
date or time is not incremented when searching for an unused file name. Of course, as the name does then not
end in a number, 000 is also added. For example, if you set the Name template to test$D and you use it on
December 19, 2013, the name expands to test131219 000. The >> button to the right of the field lets you
insert date and time specifiers at the caret or to replace the selection in the Name template field. You may not
use the slash (/) character to separate date fields or the colon (:) character to separate time fields; these are
not allowed in file names (see the lllegal file name characters, above).

Automatic sampling of a sequence of files

If you set a Name template and a Directory path, check the Save file at end of sampling box and one or
both of the Stop at time or file size boxes, you can enable automatic sampling of a sequence of files by setting
the Repeat count field. Values of 0 or 1 sample a single file, larger numbers sample a file sequence.
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Sampling each file starts and stops based on the conditions in the Starting and stopping box. For each file
except the last, when sampling stops the file is closed, and all result and XY views created by processing from
it are closed. Sampling resumes with the next file in the sequence. The file sequence stops when:

The number of files set in the Repeat count have been sampled

There is no free disk space

The name template cannot be incremented or there are no unused names
There is an error during sampling

The user clicks on Stop or Abort in the sampling control panel.

Data security

For efficient sampling and to allow us to retrospectively choose to save data, Spike2 buffers several megabytes
of the most recently sampled data in memory and writes data when the buffers are full. The operating system
then buffers this data and writes it to disk whenever it chooses. So, if the power failed, unwritten data would be
lost.

The Flush to disk every n minutes field sets how often the data buffered in memory is forced out to the
physical disk to guarantee that your data is safe. There is a significant time penalty for doing this (can be
seconds) and it interacts with turning write to disk on and off. If you want the fastest possible sample rate you
should turn this feature off (by setting a zero period). However, with it on, even if the computer power is lost or
the computer crashes, your data should be safe up to at least the last flush time; you will be prompted to save
the interrupted file the next time you start Spike2. You must run S64Fix (for 64-bit files) or SonFix (for 32-
bit files) on such a data file to complete the data recovery and to tidy up data blocks written after the last flush.

From version [10.07] onwards you can set this field to -1 to request Write through mode. This requests that all
writes to the file to be written to disk immediately, so should be slower. However, if you are writing a sequence
of files at a high sample rate, this can greatly reduce the time gap between the end of one file and the start of the
next as this limits the quantity of unwritten data when the file closes to the size of the internal Spike2 data
buffer (used for retrospective write to disk decisions, currently 8 MB) rather than to all the data written since
the last flush. However, it means that in the case of a power failure, up to 8 MB of data could be lost (which in
the case of a sparse event channel could be all the data).

If the shortest interval between repeated files is important, you should test the difference between using the
values -1, 0 and 1 for the Flush to disk every field.

If the Comment file at end of sampling box is checked, you will be prompted to provide a file comment
when sampling finishes. This is disabled when sampling a sequence of files as prompting for a comment would
interrupt the sequence.

If the Save file at end of sampling box is checked, the new data file is saved to disk automatically when
sampling finishes. If automatic file name generation is in use, the generated file name is used, otherwise the
usual prompts for a file name are provided. This box must be checked if you want to sample a sequence of files
automatically.

Starting and Stopping

When you sample with a 1401 interface, you have the options of starting to sample on a digital pulse on the
front panel Trigger input, or the rear panel E3 event input. The Triggering field allows you to preset the state
of the sampling control toolbar Trigger check box:

Use previous Uses the current state of the Trigger check box

Not Triggered Forces sampling to start immediately; clears the Trigger check box
Triggered The first sampled file is triggered, any repeats are untriggered

All triggered  The first file and all repeats are triggered

Stop sampling

You can cause sampling to stop automatically at a set run time, or when the data file is a set size. If you do not
check a box, the associated limit is not used. In general, you will get a little more data than implied by an active
time or data limit as data buffered in the 1401 at the time the limit was reached will be added to the file. To
sample a sequence of files automatically you must check at least one of Stop at time or Stop at file size.

Output Reset...
You can choose to have the DAC and digital outputs set to known values when a sampling configuration is
loaded, and more usefully just before sampling starts and after sampling ends. Click this button to open the
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Output Reset dialog. Values set from here are stored in the sampling configuration and override application
settings set from the Edit menu Preferences in the Sampling tab.

Sample Bar

The Automation page also holds a label of up to 8 characters and a comment of up to 80 characters for the
Sample bar. When configurations are saved to a .s2cx file, they can be added to the Sample bar by the
Sample menu Sample Bar List... command and any label or comment is used to provide information about
the configuration.

If you include an ampersand (&) in the label, the following character can be used with the A1t key as a short-
cut to load and run the configuration. See the Script bar documentation for details and caveats.

Once a configuration is in the Sample bar, you can open a new data file with a mouse click or A1t+key.

Output Reset

The normal reset state of a 1401 is all DAC outputs at 0 Volts and all digital outputs set low. Spike2 leaves all
1401 outputs alone except when sampling. However, in some situations it can be important that the 1401
outputs are returned to a known state after sampling in case sampling was interrupted; this is where you would
use the Output Reset dialog.

There are two sets of Output Reset information. One is associated with the Spike2 application, the other with
the sampling configuration. The effect of the two sets of information is as if the applications settings were
applied followed by the sampling configuration settings.

Not all features are implemented. The Ramp DACs feature is a future enhancement and is likely to require
hardware changes to allow it to be implemented, so will be for specific 1401 types only.

Feature Application Sampling Configuration

Opened from Edit menu Preferences Sampling tab  Sampling configuration Automation tab
Dialog title Application Output Reset Output Reset

Where is data saved  In the registry In the sampling configuration

Apply on load When the program starts When sampling configurations load

Priority Values may be over-ridden Values are always used

Use for State you always need applied State dependent on the sampling configuration

The image shows the dialog when opened from the Sampling Configuration: Automation tab. When opened
from the Edit menu Preferences: Sampling tab the dialog title changes to Application Output Reset and the
Apply when sampling configuration is loaded check box becomes Apply when application starts.

DAC values

Spike2 supports up to 8 DACs per 1401 interface. You can set the reset value (in Volts at the 1401 output) for
each DAC. Only DAC:s that are checked (and exist in your interface) will be reset. The normal reset level is 0
Volts, but you can set any value within the range of the DACs.

Dig Out bits
This field sets the reset values for bits 15-8 (from left to right) of the digital outputs as 8 characters. Each
character can be 0, 1 or x standing for low, high and no change.

Dig Low bits
This field sets the reset value for bits 7-0 (from left to right) of the digital outputs as 8 characters. Each
character can be 0, 1 or x standing for low, high and no change.

Ramp DACs to desired voltage over ... seconds (if possible)
Currently this field is inoperative and the DACs change to the reset value in one step. When implemented, the
DACs will ramp from their current value to the reset value over the time period specified.
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Script

Apply...

If you do not check any of the Apply... boxes, this dialog has no effect. You can choose when to apply the reset
state: when the Output Reset information is loaded, before sampling starts, after sampling ends, or at any
combination of these times.

The Sampling configuration Script tab (new at [10.09]) allows you to associate a script file with the sampling
configuration. This sampling script runs at user-defined times during sampling. This script will typically run for
a short time and end. Only one script can run at a time, so if another script is running, the script will not run. A
typical use of such a script would be to save sections of a large data file periodically to allow other programs to
analyse data while the data is sampled. Another use would be to run a particular stimulation or analysis protocol
during a long sampling session.

An advantage of running a script periodically rather than having a script that runs all the time and allows idle
time for the user to interact with the data is that between script runs, there is no limitation on user actions. The
user can even run other scripts as long as they do not prevent the Sample Script from running. A disadvantage is
that any information that must be carried between script runs must be saved separately, usually using the
Profile () script command or in a file.

You can also set scripts associated with Timed and Triggered sampling from the Sampling configuration Mode
tab.

il c:\Users\greg.CED\AppData\Loca\CED\Spike10\LAST.s2cx - - i

Channels Resolution Mode Sequencer Play waveform Automation Script
Sampling Script  Use script: maxtime >
Run []On file Create [v]At time |60 | seconds [Vlthen Every | 60 seconds [_| After sample Stop

E:\Users\Greg\Documents\maxtime.s2s

'Example Sampling script that prints current time and status
var vh% := SampleHandle(®);
[-]if ViewKind(vh%) then
vh% := SampleHandle(-1); 'Try for last stopped
if ViewKind(vh%) then printlog("No sample window\n"); halt endif
—endif
View(vh%);
printlog("maxtime %.5f, status %d\n", MaxTime(), SampleStatus());

Cancel Run now Help

If a script is selected, it is displayed in the large panel that occupies most of the display. If you double-click in
this panel, this will open the script in a separate window. Above this is a line of check boxes where you can
choose when the script runs.

Sampling Script
If you drop this list down, you have a choice of None, Select script file, the current script (if any) and up to 10
previously used scripts.

None
No script is used.

Select script file

This opens up a file selection dialog in which you can choose a script to add to the sampling configuration. It is
entirely up to you what this script does; it has full control over the system. If the script runs for any appreciable
time, it should release some idle time, otherwise the display of sampled data will not update.

Use script: ScriptName
This has no effect as it selects the current script.
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Recent file: Name
There can be up to 10 of these entries. These are scripts that you have used previously. The list of used script is
saved in the registry.

Run

This section determines when the script should run. For a script to run, Spike2 must have idle time and a script
must not be running already. Note that it can take a while for a script to run after the request is made, especially
if Spike2 is busy with other tasks. When the script runs you can get a handle to the active/first view of the
sampling file with the SampleHandle () script command. You can use the SampleStatus () script command
to get the sampling state. Scripts can be set to run at various times by checking the boxes:

On file Create

The request to run the script is made when the file opens and before it starts to run. If this is part of a repeated
sequence of files, this is only called for the first file of the sequence. When a file is in the created state, but
sampling has not yet started, the MaxTime () value is returned as one clock tick less than zero and
SampleStatus () returns 0.

At time
You can choose a time into sampling, in seconds, at which to request that the script runs. You can set any time
that is in the range 0.0 to 1,000,000,000.0 seconds (a bit under 30 years).

then Every

Check the box to run multiple times. The Every field is how often to attempt to run the script after the first
time. The shortest interval we currently allow is 1 second. Each time a request is made to run the script, the
time for the next run is calculated as the next multiple of the Every time after the At time. If the script takes
longer than the Every time to run and the script releases no idle time, it is possible to hang up, much as a script
that loops forever with no idle time. You can use the Esc key to break out of the script.

After sample Stop

This requests that the script runs when sampling stops (including after each file in a repeated sequence). If no
file is sampling, SampleHandle (0) will return 0, but you can use SampleHandle (-1) to get the handle of
the last sampled file, as long as it has not been closed.

Sampling scripts

From Spike2 version [10.09] you can nominate scripts to run at specific times during sampling from both the
Sampling configuration Mode tab and from the Script tab. There are three ways to set this up:

Mode tab Timed sampling
In timed sampling mode you can nominate a script that is run at the start of each timed data capture, or at the
end of each timed data capture.

Mode tab Triggered sampling
In triggered sampling mode, each trigger can have an associated script that runs at the trigger time, or at the end
of the associated data capture (if it is at a later time than the trigger).

Script tab

The Script tab can set a script that runs at user-selected times: each time a data file opens, when sampling stops,
at a particular time during sampling and at given intervals after that time. This script can run in addition to the
timed or triggered scripts.

Although it is possible to have multiple scripts set, there is some timing advantage to running with a single
sampling script. This is because Spike2 'caches' the last compiled script, so if you have a single script, there is
no need to compile it each time it runs. This saves the compilation time, which though usually a fraction of a
second, can be significant if you are running a script in response to a fairly rapid event.
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Script limitations

Sampling scripts are no different from any other script, so there are no limitations on what they can do.
However, to be useful, they need to be written carefully so as not to mess up the sampling. Most sampling
scripts will take very little time to run. They will perform whatever action is required, then exit.

Unless they are set to run when the sampling file opens and before sampling starts, or at the end of sampling,
they usually have no user interface. This is particularly true for scripts that run frequently, such as triggered
scripts or scripts run by a timer.

Useful script functions

Each time a sampling script runs, it starts with a clean slate of script variables. Scripts run in the context of the
user interface thread of execution but may be requested to run from the sampling thread of execution (for
example when triggered on an event). Script running will be delayed by the time needed to complete
outstanding Windows messages and ongoing drawing operations and compilation (if required) of the script. In
my test cases (with relatively slow sample rates and a pre-compiled script), scripts run around 20 milliseconds
from the request. The worst case delays can be considerably more and scripts will not run at all if another script
is running and releases idle time (Yield (), Toolbar (), Interact (), D1gShow () ...).

You need to locate the sampling file and know the current state of sampling. Remember that time has passed
since the event that caused the script to run. In the worst case, the data file may not exist. The following
routines are useful:

SampleStatus ()

This lets you know the current state of the sampling system. If you set a script to run when the data file opens,
and SampleStatus () returns 0, you can use SampleStart () to begin sampling. If sampling is shutting
down, you may want to wait for it to have stopped (if you wait in a loop, remember to call Yield () inside the
loop to release time to allow the system to close down the file).

SampleHandle (0)

This locates the current sampling window, which you will usually require. Note that when sampling stops, there
will no longer be a sampling file, but you can use SampleHandle (-1) to get the handle of the last sampled file
as long as it has not been closed. In the case of sampling an automated sequence of files, each file in the
sequence keeps the same sample handle. This also requires care as although the file handle remains the same,
the file it refers to can change.

SampleRepeats (-1)

If you automate sampling of a sequence of files you can use this command with a negative argument to get
information about the repeats done and remaining and the current file number. The automatic sequencing
requires idle time to work. Some care needs taking with file sequencing as if the user opens a Modal dialog (a
dialog that requires closing before the program will continue), the automatic file sequencing will stop until the
dialog closes. Similarly, running a script that does not release idle time will cause automatic sequencing to
pause at the end of a file until idle time becomes available.

Profile ()
This command can be useful when you need to save information about a program state between runs. Larger
amounts of data can be saved in text or binary files.

Example Script tab script

The following script is suitable to be set in the Script tab with the At time and Every fields checked and set to
at least 10 seconds. Each time the script runs it saves the last tSave (set to 10 in the example) seconds of data
to a file. If the file already has a name (for the case of a set of file names defined in the Automation tab), the
saved name is formed by adding a sequence number to the file name. Otherwise, we use a sequence of files
called 0.smrx, 1.smrx etc in the folder set for Spike2 sampled data files (FilePath$ (1)), and if that is not
set, in the folder for Spike2 data (FilePaths$ (-4)).

'$ExportlLast[Script to save recent data to a file as a Script tab timed operation

const first := SampleScript(-2); 'Time in seconds at which to save first
const every := SampleScript(-3); 'Interval to save at
const tSave := 10; 'Length of data to save (< first and every)

if (tSave > first) or (tSave > every) then PrintLog("bad tSave\n"); halt endif;

if (SampleStatus() <> 2) then halt endif; 'must be sampling
var sh% := SampleHandle(©); 'Get the handle of the file
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if sh% <= @ then halt endif; 'If none, then give up
View(sh%);

var tNow := MaxTime(); 'Where we have reached
var n% := (tNow - first) / every; 'file number of save file
if n% < @ then halt endif; 'Calculate file 1index
var tSaveEnd := first + n% * every; 'End of save

'Set output file name

var fName$ := FileName$(-3); 'Get current file path (if set)

if Len(fName$) = @ then fName$ := FilePath$(1) endif; 'data folder

if Len(fName$) = @ then fName$ := FilePath$(-4) endif; 'user data folder

fName$ += Str$(n%) + ".smrx”; 'Build output file name
ExportChanList(1); '"Export each file at time @
ExportChanList(tSaveEnd - tSave, tSaveEnd, -1); 'Save all channels
var ok% := FileSaveAs(fName$, 0, 1, ""); '"Export to match source

if ok% < @ then

PrintLog("Save failed to: %s\n%s\n", fName$, Error$(ok%));
else

PrintLog("%3d %6.0f %s\n", n%, tSaveEnd - tSave, fName$);
endif

Data buffering

When sampling, Spike2 keeps several megabytes of the most recently sampled data in memory. Having
buffered data allows you to run with "write to disk" disabled, yet still allowing you to see recent data and giving
you the possibility of retrospectively deciding if data is worth saving or not. How this is done is different
between the old 32-bit files and the newer 64-bit files. In both cases, buffer space is allocated to channels in
proportion to the expected data rates for each channel (as set, by you, in the sampling configuration). For
waveform channels, the expected rate is the sample rate multiplied by the size of each sample. For Event,
Marker and extended Marker data (TextMark, RealMark, WaveMark), the expected data rate is the Maximum
event rate field multiplied by the size of each item. It is important that you set this field to a realistic peak
event rate over say 10 seconds; setting the peak instantaneous rate will result in inefficient allocation of
resources.

Having buffers allows us to allow retrospective changes to what data should be saved. Changes are additive;
that is you can have saving logically disabled then mark regions for saving with the SamplewWrite () script
command or triggered or timed sampling.

The details of buffering depend on which output file format was selected in the Resolution tab of the Sampling
configuration dialog.

64-bit (.smrx) file buffering

During sampling, each channel is allocated a circular buffer to hold the most recent data. The channel also has a
save/no save state and list of times at which the save/no save state changes. When the circular buffer becomes
full, the oldest data is ejected from the buffer. If it is not marked for saving, it is lost. If it is marked for saving,
the data is added to the channel write buffer (a 64 kB buffer that is an image of a disk block for the channel).
When the channel write buffer becomes full, it is written to the disk. If you use the Modified (0, x) command
or set automatic flush to disk, it has the effect of forcing all data marked for saving to the channel write buffer
(which causes it to be written if it becomes full) and then if the channel write buffer is partially full, the partial
buffer is also written. Times before the last saved data time are removed from the save/no save list (as once data
is committed to the channel write buffer you can no longer change the save/no save state for earlier data).
However, any data in the circular buffer that is not marked for saving is preserved.

64-bit data saving is sample accurate. Only data marked for writing is saved.

32-bit (.smr) file buffering

Buffer space is allocated in terms of complete disk blocks, as written to the data file. These blocks are typically
a multiple of 4096 bytes up to a maximum size of 32768 bytes. Each channel has a list of buffers it can use, and
these are filled in sequence. Each buffer can be marked for saving or not saving. When all buffers become full
and more data arrives, the oldest block is written to disk if it is marked for saving, then that block is used for
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new data. If any data in a block is marked for saving, the entire block is saved. If you use the Modified (0, x)
script command or set automatic flush to disk, and it causes any data to be saved, any older blocks that were
marked as not saving are emptied.

32-bit data saving is by data block; if any data in a block is marked for writing, all data in the block is written.

Flushing data to disk

On modern operating systems, when an application writes data to a disk file, this will not usually write data to
the physical storage medium immediately. For performance reasons, data is written into a complex buffering
system which is designed to keep the entire system responsive. Should the application crash, the operating
system will close down open files and the files will be intact. However, if the system fails (due to power loss or
a system crash), all the buffered data in the system does not get written, which can cause significant data loss.

To work around this, Spike2 supports an automatic flush to disk option or you can use the Modified (0, 1)
script command to request that the file data is transferred to the physical disk.

This used to work well, but more modern disk systems now include huge memory buffers internally. It turns out
that if you have a "primitive" disk system, when you ask the operating system to flush the buffers for a file
through to the disk, this works very quickly as the system "knows" which buffers belong to the file and need to
be written to which physical disk sectors. Unfortunately, when the disk itself buffers vast quantities of data, the
disk has no idea which buffers refer to which files. The only way to guarantee that the data for a file is on disk
is command the disk to write ALL buffered data. We had one case of a user who upgraded to a new, vastly
faster computer and found that the first disk flush took 15 seconds when their previous, ancient machine did it
instantly.

If you hit a problem like this, one way around it is to make sure that your disk has an uninterruptible power
supply and then use Modified (0,0) at suitable moments to get data through to the operating system without
triggering the flush to disk. Even if your system should fail, the disk should be able to complete the physical
writes. You could consider using Modified (0, 1) before you start sampling in case there is a lot of pending
data.

Opening a new document

Once you have set the sampling configuration you can open a new data document. Select New from the File
menu, then Data Document for the file type. Data documents differ from all other Spike2 documents as they
are always stored on disk. Other document types are kept in memory until you save them. We keep data
documents on disk because they can be very large. When you save a new data document after sampling, Spike2
moves it to the disk volume and directory you specify. When you use the File menu New command, Spike2
creates a temporary file in the directory specified in the Edit menu Preferences. If you do not specify a
directory in the preferences, the location of the temporary file is system dependent.
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The exact appearance varies, depending on the configuration. Sampling begins when you click Start in the
Sample control toolbar (the Sample menu duplicates the controls in this window). If the Trigger box is
checked, sampling waits for an external signal.

If your sampling configuration includes talkers that take a while to become ready to sample a window may
appear with information about the reason for the delay. If talkers experience problems loading or preparing to
sample a message box may appear describing the error(s) with the option to Continue (without the talker) or
Cancel.

You can set the display and analyses required before sampling. For example, to set an interval histogram you
can select that analysis exactly as you did in the Getting started chapter. There is a difference, however. When
you click on New, a new dialog appears.

Process dialog for a new file

You create result views with the Analysis menu New Result View command | process measure to channel 2001 (Data1)
in the same way as when working off-line. However, the Process dialog,

. . . (® Automatic () Gated b ts () Manual
which controls when and how to update the result window, has additional | = o o Y ST e

options to work with a data file that grows in length. The radio buttons select
Automatic, Gated by events or Manual updates (see the Analysis menu for a
full description).

The standard on-line mode is Automatic. This mode adds new data to the
result at a user-defined interval. You can choose to accumulate a result for all
the data, or produce a result for the last few seconds. The other two modes are
for specialised uses and should not be used unless you are certain they are what
you want.

This dialog disappears once you select either OK or Cancel, however you can
recall it with the Process command in the Analysis menu.

Sample control toolbar

Update window every seconds
10.0 seconds

Process (® Last
O All data

Leeway for processing | 0.5 ‘ seconds

Clear result data before process
Optimise axes after process

Close Settings Apply oK

The Sample control toolbar holds several buttons and a check box and controls the data sampling process. You
can dock this bar to any edge of the Spike2 application window or leave it floating. The toolbar becomes visible
(if it was invisible) whenever sampling starts unless the start command comes from the script language or the
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Edit Preference to prevent this is set. The position of the toolbar is saved in the sampling configuration.
However, if it is visible and docked, we do not reposition it as we assume it is where the user wants it.

Initial display

Normally, when you create a new file to sample, the sampling process holds waiting for
Sample control bar you to click the Start button, or for the script SampleStart () command. The Start
text moves from side to side to remind you that sampling is waiting for you. The
Trigger field controls whether sampling starts immediately when you click Start or if it
Abort | LlTrigger  waits for a low-going TTL compatible trigger pulse. If you have selected the Sample
and Play wave trigger on rear events option in the Edit menu Preferences, the Trigger
text is replaced by E3 Trig to remind the user that the rear panel trigger is selected. The Triggering field in the
Automation tab of the sampling configuration dialog sets the initial Trigger state. If you are sampling without
a 1401, the Trigger check box is disabled and the text is replaced by (Trigger) or (E3 Trig) as triggered start
requires a 1401 interface. If you use the Sample bar to select between sampling configurations, you can skip
this initial display by setting the Immediate start option.

Start Write

Display after Start with trigger enabled
If you click Start with Trigger (or E3 Trig) checked, Trigger (or E3 Trig) flashes in
Sample control bar place of the Start button and sampling holds at time 0 until a suitable signal is applied
to the Trigger input. Both the front panel Trigger and rear panel E3 input (Events
connector pin 4, pins 9-15 are grounds) expect a low-going TTL compatible pulse of at
Abort Reset least 1 microsecond duration; connecting the Trigger or E3 input to ground will work.
The Trigger (or E3 Trig) check box is replaced by a Reset button Use this method to
synchronize the start of sampling with an external event. Sampling starts within 1 or 2 microseconds of the
external signal. Currently, using a triggered start requires a 1401 interface.

Trigger Write

Display during sampling

Once sampling has started, the Start button is replaced by a Stop button and the

Sample control bar Trigger (or E3 Trig) check box is replaced by Reset. You can use the Write check box

to decide which portions of your data are to be saved on disk, and which portions are of

only transitory interest; you can read more about the Write control, below. The controls

Abort Reset  are duplicated in the Sample menu; however the Sample control toolbar needs fewer
mouse clicks.

Stop Write

Button actions
Start  This is displayed before data capture starts. Click the button to start sampling. If Trigger is checked,
Spike2 waits for the trigger before continuing.

Stop  This is displayed while data is sampled. Click this button to stop sampling and keep the data. If no
data was saved, the empty file is discarded. If you attempt to close the file after stopping you will be
prompted to save it unless the file is less than 5 seconds long.

Abort  This button is used to abandon sampling and discard the new file. You can use this button before
sampling starts, or while sampling is in progress. If you use this interactively, you will be asked if you
are sure you want to lose sampled data if any data has been captured and you have been sampling for
at least 5 seconds.

Reset This button appears when you click Start. It stops sampling, discards any saved data, and waits for
you to start sampling again with the same document. You are warned that you will lose data if you
have captured any data and have sampled for at least 5 seconds.

Write check box and Not saving

The Write check box is normally checked, to save data to the data document. If you clear this box, no data is
saved until it is checked again. If you are running in Triggered or Timed sample modes, clearing this check box
will also disable writing for these modes (even if a trigger or time interval occurs).

Spike2 keeps a certain amount of data in buffers in memory, so it can display recent data on screen even if you
have decided not to save it to disk. This saved data is used in triggered mode to save pre-trigger data and can
also be marked for saving with the Samplewrite () script command.

You can write enable and disable individual channels from the Samplewrite () script language command.
This command can also mark data regions for saving when the channel save state is set to not saving. If you use
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this command to set a state where some channels are enabled and some are disabled, the check box is drawn in
an intermediate state (neither checked nor clear).

Whenever you change the state of the check box or use the script command to enable or disable all channels, a
marker is added to the keyboard channel (code 00 when writing is enabled and code 01 when it is disabled).

Whenever any channels are not saving, the Write text moves from side to side to alert you and new data for
those channels (apart from WaveMark data and Sonograms) draws in the Not saving to disk colour as a
warning that data is not being saved.

Save data file

When you stop sampling, all data that is held in memory buffers is written through to the data file. Unless you
have enabled Automatic file naming in the sampling configuration, your file is held on disk in the folder set in
the Edit menu Preferences Sampling Tab with the name datan (n is a sequence number) and no file extension.
You can use the File menu Save As... command to give this file a name.

If you attempt to close the file without using the Save As... command, and the file holds some data and was
sampled for at least 5 seconds, you are prompted to save the file. If you don't choose to save it, the file is moved
to the Recycle Bin (just in case you really did mean to save it). The Recycle Bin will allow you to use up a
sensible fraction of your free disk space to save files; you can adjust the Recycle Bin Properties to limit the
disk space to be used in this way. There are instructions to recover a data file in the Frequently Asked
Questions.

Although it is a bit wasteful of disk space to keep all sampled data, it is surprising how many users accidentally
fail to save their data!

If you Abort sampling, and confirm that you really want to abort, we do not save the file.

Disaster during sampling

The most common disaster is loss of power or a large electrical transient causing the computer to lock up. If
this happens and you are forced to restart the computer without saving your file, you still have the possibility of
recovering the data that was written to disk. The next time you start Spike2, it will detect that the last file
sampled was not closed and will offer to recover it for you. Once recovered, you will likely need to fix the file
by running S64Fix (for a . smrx file) or SonFix (for a . smr file).

High sampling rates

The code that transfers sampled data to disk runs in a separate, high priority thread. This ensures that data is
saved unless another program creates a higher priority process that uses all the computer time. Buffer overflow
can occur if the data rate is so high that the 1401 device driver cannot empty 1401 memory before it has
become full. This should not occur with USB2 interfaces unless the overall data rate is very high or there are
bandwidth bottlenecks in the disk system. Spike2 detects buffer overflow and stops sampling if this happens.

If you suffer from buffer overflow problems, please check the following:

e Check that you have the latest 1401 firmware. The Help menu About Spike2 dialog box will tell you if more
recent firmware is available. Spike2 will refuse to sample if your firmware is seriously out of date.

e If you use USB to connect your 1401 and your 1401 has a USB2 interface, make sure it is connected to a
USB2 port on your computer. Using a USB1 port (some older computers have both USB1 and USB2 ports)
will reduce the maximum transfer rate by a factor between 5 and 40 depending on the type of 1401.

e You can get a measure of the fastest data transfer rates available for your combination of 1401, interface and
computer by using the Tryl1401 program. Select Show estimated transfer speeds in the Tests menu
Settings command and then run the DMA test.

If the 1401 detects that the host computer is slow writing to disk, it requests a “catch-up” mode where Spike2
abandons on-line display of new data (the display for new data is greyed out) to avoid competition between
writes and reads in the disk system.
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If the 1401 detects that the input event rate is too high for the 1401 to process, the special keyboard marker
code FF is added to the keyboard channel. Sampling does not stop, as subsequent event times will be correct. If
this happens, check that you have set realistic expected sample rates for the event channels.

The Sample Status bar

The Sample Status bar gives you an indication of how | rive: 100% isk: 99% 1401:4.3% CPU: 0.6% kifs: 47 Note: 0
hard the 1401 and the host PC are working to capture and
transfer data to disk. The bar also displays how much sampling time and disk space remains before sampling
will stop. If the bar is not visible during sampling you can show it from the Sample menu or by right-clicking in
the toolbar area and selecting Sample Status. The bar is normally made visible when a data file is opened for
sampling unless the data file was created by a script or an Edit menu Preferences option is set to prevent it
opening. The bar shows five values:

Time Percentage of sampling time remaining before sampling stops. You can limit the sampling time in the
Automation tab of the Sampling Configuration. If you do not limit the time, you can run for up to 8 x
10'® clock ticks when sampling to a 64-bit file or for some 2 billion clock ticks when sampling to a
32-bit file (you can see how long this is in years, days, hours minutes and seconds in the Resolution
tab of the Sampling configuration).

Disk Percentage of disk space remaining before sampling stops. You can limit the disk space in the
Automation tab of the Sampling Configuration. If you do not limit the disk space, for 32-bit files the
limit is set to 1 TB in big file mode or 2 GB if not in big file mode and no limit for 64-bit files. The
free space on the disk is checked just before sampling starts and the limits are reduced if there is less
free space than the limit. Sampling will stop if you get within a few megabytes of the free disk space
when you started. If other activities are also filling the disk sampling may stop sooner, and possibly in
a less controlled manner.

1401 The percentage of the available time that the 1401 interface is using to transfer captured data back to
the host computer and match any spikes to templates. This should be fairly constant with waveform
channels, but will increase when the rates of event or WaveMark channels increases. It can also be
increased by a slow host interface or problems with the host computer disk system. If it heads towards
100% you are in trouble.

CPU The percentage of the available time that the data capture thread in the computer is using to process
the incoming data from the 1401 and write it to the data file. If you have a computer with multiple
processors, this is the proportion of the time on a single processor. This will usually be less than 10%.

kB/s The number of kB (kilobytes) of sampled data that is being transferred to the host per second.

Note The number of warning messages written to the Sampling Notes log. Double click this field to open
the Sampling Notes window during sampling.

The 1401, CPU and kB/s fields display as n/a if the 1401 firmware is not sufficiently up to date, but this
should never happen as we refuse to sample if old firmware is detected. You can download firmware updates
from the CED web site firmware page.

Saving configurations

It would be very tedious if you had to set up the exact screen configuration you wanted each time you sampled
data. To avoid this, you can save and load sampling configurations from the File menu. The saved sampling
configuration file has the extension . s2cx and defines:

e The position and size of the application window

o The list of channels set for sampling and their sampling parameters

e Derived channels and real-time channel processing.

o The position of all windows associated with the new file

o The displayed channels and event display modes of the channels in time windows

e The name of any output sequence document to be used during sampling

o The list of waves and any associated waveform data for on-line waveform output
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e Script files to run at specific times or on specific events during sampling
¢ File automation controls that allow you to sample a sequence of files
e The processing and update modes and positions of all result windows

The configuration does not include the contents of result windows. Whenever sampling finishes, the application
saves the configuration as LAST.s2cx. When you run Spike2, it searches for and loads the configuration file
DEFAULT.s2cx. If this cannot be found, it uses LAST.s2cx. These files are kept in the user application data
folder (in old versions of Spike2 they were kept in the folder from which Spike2 was run). Remember that you
can always recall the configuration that you used most recently, even if you forgot to save it.

If you have several configurations that you use very regularly, you can add them to the Sample bar with the
Sample menu Sample Bar List... command. Once you have done this you will be able to start sampling with
a saved configuration by clicking a button on the Sample bar (see the Sample menu chapter for a full
description of the Sample bar). Alternatively, you could keep short cuts to configuration files on your desktop
and start Spike2 by double clicking them.

You can also see a list of the last used 10 configuration files from the File menu, Load configuration command.

Warning

We suggest that you do not rely on LAST. s2cx for important sampling configurations as it is overwritten each
time you sample. It is better to save your configuration to a named file and load it using the File menu or the
Sample Bar or by double clicking the file. From [10.07], Spike2 saves the last-known configuration that the
current configuration was derived from and this can be accessed by right-clicking the Sampling Configuration
dialog title bar and with the SampleConfig$ (-1) script command.

Search order for the last and default file

Over time, there have been several places where the 1ast and default files were stored. We attempt to not
break older installations by searching for a configuration to use in the following order. Note that we always
write last.s2cx to the user application data folder.

default.s2cx in the user application data folder.

default.s2cx in the application data folder.

default.s2cx in the folder from which Spike2 was run (for backwards compatibility).
last.s2cx in the user application data folder.

last.s2cx in the application data folder.

last.s2cx in the folder from which Spike2 was run (for backwards compatibility).

Sk W=

The search stop at the first found file. If you are in doubt as to where your current configuration came from,
open the Sampling Configuration dialog. The path is shown in the dialog title (and can be copied to the
clipboard by right-clicking on it). At some future version we will stop searching the folder from which Spike2
was run.

Old format .s2c configuration files

Versions of Spike2 up to 7.10 (December 2009) used binary configuration files with the extension .s2c.
Although compact, this file format was inflexible (often being a copy of the memory structures used inside
Spike2), and made adding new features and enhancing old features more difficult than it needed to be. Spike2
versions from 7.11 onwards write configuration data to .s2cx files, which are coded in XML and though
somewhat verbose, make it relatively easy to add new features. Spike2 versions 7.11 onwards and all versions
of 8 still read the old .s2c formats, but do not write them. Spike2 versions 9.00 and later do not read .s2c
files, which allowed us to simplify and rationalise a lot of code. If you come across . s2c files, they are likely to
come from Spike2 version 6 (from 2006) or earlier as a version 7 user who kept up to date would be using the
new format.

How to convert a .s2c file to .s2cx

To do this run Spike2 version 8 (supplied on the same disk as Spike2 version 11) and use the File menu Load
Configuration command to open a .s2c file, sample data (briefly), then use the Save Configuration command
to write the equivalent . s2cx file.

See also
Change to Resources
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Symbolic names in sampling configuration path

At Spike2 version [10.15] we added an experimental feature to configuration files to use symbolic names in file
paths that are part of the configuration. These are paths to: output sequencer files (*pls), script files (*.s2s)
and data files for arbitrary waveform output (*.smr, *.smrx). As this is experimental, you can disable this
feature with a new Edit menu Preferences, Compatibility Tab option.

When saving a sampling configuration, Spike2 now scans the file paths, and if these start with a path to a
known place, we replace the known place with $ (SymName) . Spike2 also saves the path without this change so
that the configuration file is compatible with previous versions of Spike2. When a configuration loads, if there
is a symbolic path for a file, we try that first, but if this does not locate the file, we try the original path.

This should have three effects:

1. It should make it easier to move configuration files between users when referenced files are stored in folders
with locations that depend on the user account name.

2. It should make it easier to move configuration files between Spike2 versions as several paths include
Spike<Version>.

3. If you keep your configuration file (*.s2cx) and associated output sequence and arbitrary waveform files
in a folder, moving the folder should leave the configuration file in a working state.

List of Symbolic paths
The initial list of paths that are replaced by symbolic names includes the following.

SymName Typical value in Spike11

Here Path to the configuration file that holds the symbolic name
AppData "C:\ProgramData\CED\Spikell\"

AppShared "C:\Users\Public\Documents\SpikellShared\"
UserLocalData "C:\Users\<User>\AppData\Local\CED\Spikell\"
UserAppData "C:\Users\<User>\Documents\Spikell\"
MyDocuments "C:\Users\<User>\Documents\"

Desktop "C:\Users\<User>\Desktop\"

Install Spike?2 installation path

<User> stands for the user name (and domain). The list is searched for matches in table order, so longer
matches are preferred, but paths relative to the configuration file are always matched first.

Why have we done this?

There is a common problem when a user shares a configuration file with another user that the configuration
fails to load because a referenced file, often the output sequence, cannot be found. This can be perplexing,
especially when the file was saved in the same folder as the sampling configuration file, and still is in the same
folder, only the user has changed. The problem is that configuration stores the full path to the file, so if user
John in domain XYX saves a file in his Documents folder, it may have the path: cC:
\Users\john.XYZ\Documents\Test\sequence.pls, but user Sarah at domain ABC will be using C:
\Users\sarah.ABC\Documents\Test\sequence.pls, so the configuration will not be able to find it, even
though the files have the same relative positions.

After the change, we will still save the original path, but we also store: $ (MyDocuments)
Test\sequence.pls, which should work for both users if they both have a Test folder in their Documents
folder with the sequencer file.

We also allow paths to be relative to the sampling configuration file as users commonly put all the files used for
sampling in the same folder.
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Sequence of operations to set the configuration

This section describes a sequence of operations that build a new sampling configuration from scratch. You will
find that once you have built a few configurations, it is much simpler to load an existing configuration and
change the sections that do not fit your requirements, rather than re-build entirely. The steps are:

Open the Sampling Configuration dialog from the Sample menu.

In the Channels tab set the channels to be sampled and their sampling rates.

Set the Resolution values to give the best fit of run time and sampling rates for waveform channels.

Select the appropriate Sampling Mode for your needs.

In the Sequencer tab select an output sequence file or create a graphical sequence or select None.

Set the Automation values as required by your application.

In the Play waveform tab select any waves needed for waveform output.

Click the Run now button.

Arrange the time view as you require and add any duplicate windows.
. Add required Analysis processes generate result windows, set their update mode and screen position.
11. Add Measurement processes to generate XY views or send their results back to the original time view.
12. Use the File menu Save Configuration command to save the configuration.

A S A i

—_
=]

Once you have saved a configuration, you can re-use it by loading it before you use the File menu New
command to start a new data file. You can combine the loading and opening a new file by adding the saved
configuration to the Sample bar with the Sample menu Sample Bar List... command; this lets you open a new
file (and even start sampling) with a single mouse click or A1t key combination in the Sample Bar.

Recording sampling setup as a script
You can generate a script only version of the sampling configuration (with some limitations, for example Talker
setup does not record), by adding two steps to the actions above:

o After step 7 open the Script menu and select: Turn Recording On.
o After step 11 open the Script menu and select: Turn Recording Off.

It is usually easier to save the desired configuration as a configuration file, the use the FileOpen$ (name$, 6) ;
command to load the configuration followed by the FileNew (0, 3) ; command to generate a new file, ready to
sample.
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Output sequencer

While sampling data you can generate precisely timed digital pulses and analogue voltages, monitor your
experiment and respond to input data in real time with the Spike2 output sequencer.

Overview

An output sequence is a list of up to 8191 instructions. It runs at a constant, user-defined rate of up to 100
instructions per millisecond (250 with the Power3). The sequencer has the following features:

¢ It controls digital output bits 15-8 with changes on the next clock tick and bits 7-0 as unclocked changes.
e It controls the 1401 DACs (Digital to Analogue Converters) to produce voltage pulses and ramps.

e [t can play cosine waves at variable speed and amplitude through the DACs.

e [t can play trains of digital pulses that run in parallel with other operations.

e It can test digital input bits 7-0 and branch on the result.

e It can record the digital input state or an 8-bit code to the digital marker channel.

o [t supports loops and branches and can randomise delays and stimuli.

o It has 256 variables (V1 to v256) that can be read and set by on-line scripts.

e It supports a user-defined table of values for fast information transfer from a script.

¢ You can command the sequencer to jump to particular actions with keyboard commands, TextMark input and
from the script language.

e [t can read the latest value from a waveform channel and the number of events from an event channel. Using
this information, real-time (fractions of a millisecond) responses to input data changes are possible.

¢ It can control and monitor the arbitrary waveform output.

e You can replace the output sequence with a different sequence during sampling.

You write sequences with the text editor where each line of text generates one instruction or with the graphical
editor where each graphical item generates one or more instructions. Text sequences are usually held in files
with the extension .pls. From Spike2 version [10.15] onwards you can also save a sequence as text as part of
the sampling configuration; this avoids the problem of a sampling configuration getting separated from the file
holding the required sequence and can be more convenient when a script is used to generate a sequence.

Sequencer control panel

You show and hide the control panel with the Sequencer Controls option in the Sample menu

or by right clicking on any toolbar to activate the context menu. You can also dock it on any edge |sten 0oo1

of the Spike2 application window. When undocked, the control panel displays sequence entry

points as the key that activates them and a descriptive comment. When docked, the keys display | © tostart

as buttons and the comment is hidden; move the mouse pointer over a key to see the comment as IT' m
pop-up text. Click the mouse on a key and the sequencer will jump to the instruction associated —— ——
with the key. The key is also stored as a keyboard marker. This is equivalent to pressing the same ~ Side dock
key in the time window or using the script language SampleKey () routine.

The control panel displays the next sequence step and any display || | P i
string associated with it. You can use display strings to prompt the | s ORGE Pl et |i| |£| |
user for an action or to tell the user what the sequence is doing. Docked to top or bottom edge
Display strings are set with the text editor or the graphical editor by

appending >Display text to the end of a comment. The sequencer always starts at the first instruction. You
cannot re-route the sequencer until sampling has started.
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The control panel is usually displayed if you start sampling from a Spike2
menu command. If the sample command comes from the script language or
an Edit Preference is set to prevent it opening, the control panel visible state | | sten ooo1 G to start
does not change. The control panel position is saved in the sampling
configuration. However, the position is restored only if the control is
currently invisible or floating, and the saved position was floating; if the
control panel is docked, we assume it is positioned where you want it. When Not docked (floating)
floating, you can resize the control to display longer comments.

Sequence control |§|

|5 Resetoutputand stop
|G Pulse outputs

Special keyboard characters
Please note that keyboard marker codes 00, 01 and 02 and codes above 7F do not trigger other actions as they
are reserved for special purposes.

Sequence jump disable

Sometimes you may want to stop users activating sequence sections with the keyboard or from the control
panel. The Sequencer jumps controlled by field in the Sequencer tab of the Sampling configuration
dialog lets you do this. The script language sampleKey () command can always activate sequencer sections;
from [11.00] the Create TextMark dialog, serial line TextMark input and the SampleText () command can
activate sequencer actions as an option.

Creating sequences

There are two ways to create output sequences: as an output sequence text file with the .pls extension or as
part of the sampling configuration using the graphical sequence editor. The table lists the main differences

between them.

Text sequence Graphical sequence
Edited with Built-in text editor Built-in graphical editor
Visualise output No Yes
Create with script Yes No
Stored as .pls text files or in configuration Part of the sampling configuration
Implemented by Machine code like language Drag and drop editing
Ease of use Takes time to learn Very easy to learn and use
Flexibility All sequencer features available Uses pre-set building blocks
Timing One instruction per text line Several instructions per item
Update during sample Yes; load new .pls sequence/text Yes; interactive edit and apply

Graphical sequences are much easier to generate than text sequences. However, they have limitations and you
can write more complex sequences using all sequencer features with the text editor. Sequences produced by the
graphical editor are converted internally to the .pls file format before they are used. You can save a graphical
sequence as a .pls file that you can edit with the text editor; you cannot convert a .pls file into a graphical
sequence.

The rest of this chapter describes the graphical output sequence editor, then the text editor, and finally the low
level instructions used by both. You do not need to read about the low level instructions to use the graphical
editor. However, knowledge of how the sequencer works will give you a better understanding of its capabilities
and limitations.

Sequencer speed

The output sequencer runs at a rate set by a clock inside the 1401. You set the clock rate in milliseconds per
tick in the Sequencer Tab of the Sampling configuration dialog when using the graphical editor or using the
SET or SCLK directives in the text editor. The script command SampleSeqClock () can also change the rate.
Supported 1401s allow intervals from 0.01 (Power3 and Micro4 allow 0.004) up to 3000 ms (older 1401s had a
lower limit of 0.05 ms). If you set intervals less than a millisecond or use the sequencer text editor you should
read the following information.
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Sequencer technical information

The sequencer clock starts within a microsecond of recording time zero and is time locked to the 1401 event
timing and waveform channel recording. Each clock tick books an interrupt to run the next sequencer
instruction and updates digital output bits 15-8 if they were changed by the previous instruction.

An interrupt is a request to the 1401 processor to stop what it is doing at the earliest opportunity and do
something else, then continue the original task. The time delay between the interrupt request and the instruction
running depends on what the 1401 is doing when the clock ticks and the speed of the 1401. This delay is
typically less than a microsecond so instructions do not occur precisely at the clock ticks; changes to digital
output bits 15-8 are set just after a clock tick and occur exactly on the next tick (clocked changes). Changes
made by the sequencer to the 1401 DACs and digital output bits 7-0 occur after the clock tick.

The sequencer runs one instruction per interrupt. At the start of each interrupt the sequencer checks to see if
there are any cosine output, RAMP or digital pulse train outputs running and takes care of these before running
the instruction.

The table shows the minimum clock interval, the timing resolution, the approximate time per step, the estimated
extra time used for cosine, ramp and digital pulse train output and the time penalty for using the relatively slow
DIV and RECIP instructions for the Power3, Powerl and the Micro2 and 3. The Power2 lies between the
Powerl and Power3 in speed, the Micro3 is about 20% faster than the Micro2. The Micro4 is several times
faster than a Micro3 and has a built-in divide instruction. Notice that the first two are in units of milliseconds
(as you set the period in ms) and remainder are in microseconds.

Power3 Power1 Micro2/3 Micro4
Minimum tick interval .004 ms .010 ms .010 ms .004 ms
Tick interval resolution .001 ms .001 ms .001 ms .001 ms
Time used per tick <1 us <1 us ~1 us <1 us
Cosine cost per tick per channel 2 us 0.55 us ~1 us <1 us
RAMP cost per tick per channel 1 us 0.5 us 0.7 us 1 us
DIGPS cost per tick per bit 1 ps 0.5 ps 0.7 ps 1 us
DIV, RECIP penalty 2 us <1 us <3 us none

The Minimum tick is the shortest interval we allow you to set. The Time used per tick is how long it takes to
process a typical instruction. The Cosine penalty/tick is the extra time taken per cosine output. The Ramp
penalty/tick is the extra time taken per ramped DAC. Time used by the sequencer is time that is not available
for sampling, spike sorting or arbitrary waveform output. To make best use of the capabilities of your 1401 you
should set the slowest sequencer step rate that is fast enough for your purposes.

The interval you set must be a multiple of the Resolution field for your 1401. This is 0.001 ms for the
Power1401 and Microl401. Spike2 will not use a sequence if the interval is not an exact multiple of an
achievable resolution for your 1401 as this would lead to inaccurate timing.

What happens if you run the sequencer too fast

There are many competing processes within the 1401 interface, and if you try to do too much at the same time,
some of these processes have to wait. If the output sequencer cannot complete a step in the clock time you set
(this will usually be due to other activities such as event or digital marker input or arbitrary waveform output),
the next step is delayed. If this happens, it is detected by the 1401 hardware as a problem. What happens next
depends on the type of the 1401 and the revision of the Spike2 software.

Power3, Power2, Micro3, Micro4

The error is detected, and Spike2 sets a marker into the Keyboard marker channel. The first marker code is
OxFF and the second is 0x02. When sampling ends, a warning message is displayed. The time of the marker
will be the current time as seen by the sampling program, which is typically a few milliseconds behind the 1401
time. The time at which the error was detected can be before or after this time, usually within a few
milliseconds.

Power1, Micro2
Sampling stops with an Interrupt overrun error message.

Sequencer clock output
The output of the clock that controls the sequencer is available on the 1401 front panel Clock connector. This
TTL output signal starts high and the sequencer steps are synchronised with the rising edges of this output. The
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minimum pulse width is 1 microsecond. If you are upgrading from a 1401plus (last supported for sampling in
Spike2 version 7), note that this had the inverse output.

) T | v

Micro1401 and Power141 14 plus

This clock runs whenever you sample with an output sequence. It can be used to synchronise external
equipment. For example, if you connect this output to a counter, and place the counter in the field of view of a
video camera that is used to record some other aspect of your experiment, the number on the counter links
visual data with an exact time in the Spike2 file. If your sequencer ran at 1 millisecond per step, the counter
would display sampling time in milliseconds.

Digital input and output

The 1401 family has 16 digital inputs and 16 digital outputs. Digital input bits 15-8 are the event ports and are
not used by the output sequencer. Digital input bits 7-0 are used for the Digital marker channel; you can also
test these bits from the sequencer.

The sequencer controls digital output bits 15-8 individually to generate accurately timed pulses. Output bits 7-0
can be set with the DIGLOW instruction. The on-line template matching code can also use bits 7-0 of the output
to signal spikes that match templates.

In a text-based sequence, the digital outputs are controlled by the DIGOUT and DIGLOW instructions and the
digital inputs are tested with DIBxx, WAIT, DIGIN and REPORT. The graphical editor controls output bits 15-8
and tests input bits 7-0 with the delay and branching instructions.

Digital input bits Digital output bits
7—»] 15 Power1401 and Micro1401 front panel 15 D
6—p| 14 14 —>
s— »l 13 Event Inputs  Digital Outputs 13
4—»| 12 12 >

Event port

0 1 0 1
=il oo 00| |iE=
| I

Y
DIGOUT
graphical editor

22— 10 9 >
1—»| 9 | s —»
o—»| 8 NDR |——»
=z 7 Qo= 7 F—p)
= =S ¢ —_
29K 5 B 2 5 —» =
=R 2273 =z
EHA 4 g M N h=
g@g 3 -ESE 3 >LD<'-
SE- ; 18 E 2 (2=
I y | E
i i . 5E o b—| £
a g5 NDRL|—

The digital input and output ports are 25-way connectors. The data and ground pins are the same on both. See
your 1401 Owners Manual for full details of all pins. The output connector is a socket (with holes), the input
connector is a plug (with pins).

Bit 15114 (131211 [10]9] 8|76 |5]4]13[]2]1]0]GND
Pin | 1 |14[2 |I15] 3 [16]4]17]5]18]6]19]7]120]|8]21 13

Digital Inputs Digital Outputs

13 13
000000000000 000000000000
® & 6 6 60 006 0 0 0 0 ® 0 6 6 060 00 0 0 00
14 25 25 14

Digital output bits 8 and 9 are connected to the front panel as Digital Outputs 0 and 1 in addition to the rear
panel. If you have a Spike2 top box (Microl1401 and Power1401), the remaining digital output bits 10-15 are
also available on the front panel as Digital Outputs 2 to 7. The NDR output (New Data Ready, output
connector pin 12) pulses for 1 microsecond after a change to the digital output bits 8 to 15. NDRL (output
connector pin 23) pulses for 1 microsecond after a change to output bits 0 to 7. The pulses are low-going for a
Power1401mk 1 and high-going for all other 1401s.
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Digital input bits 8 and 9 are also connectable to the front panel as Event inputs 0 and 1. They can also be
routed to the rear via a preferences option. The Micro1401 Spike2 top box also brings digital input bits 10-15
to the front panel. See the Marker data description for details of digital marker data capture.

The graphical editor

With the graphical editor, you can generate complex sequences without any knowledge of the underlying
control language as used in the output sequencer text editor. You can also modify the graphical sequence while
you are sampling. There are limits on what can be achieved with the graphical editor. For example, the
graphical editor does not have access to tables of values. In complex cases you can use the graphical editor to
generate most of the code, then use the text editor for the final touches.

The graphical sequence is converted to a text sequence, just before it is used. However, unless you are really
interested in how it works, or you want to extend the sequence beyond the capabilities of the graphical
sequence, you never need to look at this. You might need to look at the sequence if timing latencies are very
important to you. You can generate a text sequence version using the Write as text sequence... button in the
Sequencer Tab of the Sampling Configuration.

Structure of a graphical sequence

A graphical sequence is defined in Sections. Each section has a duration, a repeat count, an optional key that
can jump control to the section and an action to take when the end of the section (and any repeats) are
completed (stop, or jump to another section). There is a list of up to 27 sections that you can define: the Initial
section (which runs when the sequence starts and may be the only one you need) plus 26 more called Section
A, Section B, and so on to Section Z. Most graphical sequences use only a few sections.

Structure of a Section

Most sections are quite simple and contain timed digital output and DAC changes. If you assign a key to a
section, the section can be started by a user key press or by clicking the appropriate button in the sequencer
control panel. Most sections run linearly from start to finish executing the instructions that you have configured
in time order. You can make a section non-linear in two ways:

1. By making the section wait for a condition (during which period the section time base is effectively paused)

2. By making the section branch to a label within the section, or to the start of another section

Getting started

If you are new to the graphical editor, start by following the Getting started tutorial, which will introduce you to
graphical editing. You can then work through the more detailed reference that follows, starting with a
description of the Graphical editor Tab and then the section on Graphical editing and the Graphical palette.

Getting started

To get accustomed to the graphical editor, we will produce 10 millisecond wide TTL pulses at 1-second
intervals from digital output bit 8 (available on 1401 front panel Digital Output 0). We will associate the key G
for Go with the pulses, and the key s for Stop will stop them.

Open the Sampling configuration dialog Sequencer tab and select Use graphical editor. Click the Clear
graphical editor button to remove any previous sequence. Set the Sequencer time resolution to 10
milliseconds and check the Show time as milliseconds box. We do not need any DAC outputs, so clear all
the DAC outputs check boxes. We only need one digital output, so check the digital output 8 box and clear all
the others. Now click the Graphical editor button.

At the top right of the new dialog there is a drop down list to select the current sequence section. A section has
a length and repeat count. When the repeats are done, the section either stops or jumps to another section. To
start with, make sure Initial is selected as the Current section. The Initial section always runs first and it sets
the initial conditions.

The graphical representation of a section always contains a control track drawn as a thick line at the bottom.
We choose output on digital bit 8 only, so there is a single digital output in the remainder of the space. There is
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always one item selected in this area; the selected item has a grey rectangle around it. You can change to
background and foreground colours of the graphical region from the Application colours dialog.

Click on the control track now.

B " Graphical sequence editor X
> Del | | Copy... Current Section Initial 'S v =
D
1 Pulse
G

0ms o 1000

—ij Section length and repeats Key ‘ S |
. Hel

1l ISV Tel o Length (ms) | 1000 ‘ Repeats 1 | Then Halt v 28
m aal A Cancel
S 3 p 47 Comment ‘ Reset output and stop ‘ oK

In addition to setting the initial state, we will use this section to stop our pulse output, so set the Key field to s,
and set the Comment field to Reset output and stop. This comment will appear in the sequencer control
panel for the s key. You can leave the Length, Repeats and Then fields at their default values (1000, 1 and
Halt).

The next task is to create the pulse train and associate it with the G key. Select Section G in the Current
section field (or any other section apart from Initial). The control track will be selected; click on it if it is not
selected. Set the Key field to G. Set Repeats to 0 to mean repeat forever and the section length to 1000
milliseconds. The Then field will grey out as the repeats never end. Set the comment to Pulse outputs.
There is no intrinsic link between section G and the G key; however, it is often convenient to use sections with
the same identifier as the key used to trigger them.

There is a palette at the bottom left of the dialog; you can drag icons from the palette and drop them on the
DAC, digital output and control tracks. Click on the top left item in the palette and drag it to the digital output
track and release it to create a pulse. Edit the start time of the pulse to 50 and the length to 10 milliseconds.

If you have multiple Digital or DAC outputs enabled it can be useful to give them names rather than numbers.
To do this, click the mouse on the port number and type a label of up to 5 characters (we have set it to Pulse in
the example).

This completes the pulse set up. Click the OK button to return to the Sampling configuration dialog. Click the
Run now button to start sampling with the output sequence you have just created. The sequencer control panel
will display two items that you can select: G Pulse outputs and S Reset output and stop.

B! Graphical sequence editor X

< || > || Del | | Copy.. Current Section Section G'G v |~
D Il
1 Pulse
G 4.k

0 ms - 1000
Il Square pulse DIG 0 (Pulse) at 50 to 70 ms Label ‘ |
7 OK

I1 A r1~ Start (ms) | 50 = [ Noreturn
I aml A Length (ms) | 20) = Cancel
G B3 R4 Help

Start sampling — the sequencer will run the Initial section, which sets the starting values for all the digital and
DAC outputs we have chosen to control. We did not request any other action in this section so nothing will
happen until you use the G button in the sequencer control panel or select the sampling window and press the G
key to start the output pulses from digital output 8. You can stop the pulses with the S button in the control
panel or the s key on the keyboard.

Modify sequence while sampling

You can open and display this dialog during data acquisition if sampling starts with an active graphical
sequence. If you do this, the OK button changes to Apply and you can edit the sequence. Each time you click
Apply, the sequence will start again at the Initial section. We anticipate that this will be used to "tweak"
settings, such as pulse widths.
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To try this out, use the Sampling menu Graphical Sequence Editor... option, select Section G. Click on the
pulse shape in the DIG 8 track, edit the Length field to 100 ms, then click on Apply. This will transmit the
updated sequence to the 1401 and run the Initial section. If you use the G button the pulse will now be wider.

Adyou can also open the graphical sequencer during sampling by clicking this button in the system toolbar.

Space is reserved in the 1401 for the sequencer based on the size of the sequence set when sampling starts. If
you want to add instructions to the sequence while sampling you should reserve extra space using the Sequencer
tab of the Sampling Configuration dialog.

Graphical editor tab

To view the graphical editor, open the Sampling configuration dialog and select the Sequencer tab. Then
select Use graphical editor from the Output selection drop down list. The editable fields in this dialog set
values that apply to the entire sequence:

M C:\Users\Greg\AppData\Loca\CED\Spike10\LAST.s2cx - ] X

Channels Resolution Mode Sequencer Play waveform Automation

Output selection  Use graphical sequence editor s
Minimum Instruction ‘ 0 ‘ and Table space ‘ 0 | Jump control Keyboard and control panel ~
Graphical sequencer timing DAC settings

Graphical sequencer time resolution (ms) ‘ 1
Full-scale 5

[1Show time as milliseconds in the graphical editor

Zero ‘ 0 ‘
Outputs to display in sequencer timing diagrams Units ‘ v ‘
1> g [ Absolute pulse levels
Sequence uses digital output bits OOoOoOooOodg P
7 0
Sequence uses DAC outputs OOoOoOoog
Graphical editor... Clear graphical editor Write as text sequence...
OK Cancel Run now Help

Sequencer jumps controlled by

This field applies to graphical and text sequences. It allows you to stop interactive control of sequence jumps to
prevent accidental changes caused by a user key press or mouse click in the sequence control panel. The
SampleKey () script command can always cause the sequence to jump. You can choose from: Keyboard and
sequencer control panel, Sequencer control panel and Script commands only. The script language
equivalent is SampleSeqCtrl ().

From [11.00], sequencer jumps can also be commanded by the TextMark channel, both for manually entered
TextMark data and for TextMark data logged from a serial line. These have separate enables and are not
affected by this contol.

Sequencer time resolution

This sets the time resolution of your sequence and the clock interval of the sequencer clock. This is also the
minimum duration of any pulse. All actions in the sequence occur at integer multiples of the time you set here.
You can set values in the range 0.01 to 3000 milliseconds. You need a Power1401 or Micro1401 mk II or -3 to
set values less than 0.05 milliseconds. Some actions take more than one clock interval.

Show time as milliseconds
Check this box to display and edit time in the graphical editor as milliseconds and not seconds. This is purely
for your convenience; if your sequence sections are all less than a second you will probably find it more
convenient to use milliseconds.

Sequence uses digital output bits

Check the boxes for the dedicated digital outputs that you will use. Only these outputs will appear in the editor,
reducing visual clutter. If you do not require any digital outputs, clearing all the check boxes will save an
instruction at the start of each sequencer section. The sequence uses the upper 8 digital output bits (15-8). Bits 8
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and 9 are available on the 1401 front panel as Digital outputs 0 and 1. All bits are also available on the 1401
rear panel Digital Output connector.

Sequence uses DAC outputs

Check the boxes for the Digital to Analogue Converters (voltage output devices) that you will use in your
sequence. Unused DACs are not included in the graphical editor (to reduce visual clutter) and no sequence code
is generated for them, which saves instructions at the start of each sequence section.

If you use one or more DACs for arbitrary waveform output only do not include them here unless you want to
be certain that they have a defined value when you enter a sequence section. All 1401s have at least DACs 0
and 1; the Power1401 has DACs 0 to 3. Top boxes allowing more DACs can be added to Power1401s. The
sequencer supports DAC numbers 0-7.

DAC full-scale, zero and units

You can define the DAC outputs in units of your choice. 1401 DACs normally have a range of =5 Volts, but
+10 Volts systems exist. Set Units to the units you want to use. Set Full-scale to the value in these units that
corresponds to the maximum DAC output. Set Zero to the value in your units that corresponds to a DAC output
of 0 Volts. For a +5 Volt system calibrated in Volts, set Full-scale to 5, Zero to 0 and Units to v. If you want
the output in millivolts, set Full-scale to 5000, Zero to 0 and Units to mv.

Absolute pulse levels

The DAC pulses take their starting level as the current DAC value at the pulse start time. The DAC then
changes to another value, then back to the original level. Normally you define pulses in terms of the pulse
amplitude relative to the starting level and all pulses add. If you check this box, then you set the absolute level
for the DAC to change to. Data is written for each sequencer section that has any output defined or that has a
key set.

Write as text sequence...

You can use this button to output the graphical sequence as a text sequence. You might do this if the graphical
interface almost does what you need and you need to hand-edit a few extra instructions, if you want to run
multiple graphical sequences, or if you need to save the sequence for documentation purposes. A file selector
dialog opens for you to choose a name for the . pLS file.

When you use a graphical sequence, the first thing that happens is that it is converted to a text sequence, which
is saved in the file S2PSEQS$.PLS in the current user application data folder. This is then loaded for use in
exactly the same way as a user-written text sequence.

Clear graphical editor...
This wipes all graphical sequences. You must confirm this action as you cannot undo it. This also clears the
keys associated with each section.

Graphical editor...
This opens the editor so you can make changes to the sequence.

Graphical editing

To open the graphical editor, select Use graphical editor and click the Graphical editor... button in the
Sequencer tab of the Sampling configuration dialog. You can resize the dialog by clicking and dragging an
edge. Double-click the title bar to maximise the dialog, double-click again to minimise it. The editor window
has five areas:

1. awindow with a graphical representation of the output sequence

2. above the graphical window are controls to iterate through and delete selected items, a message area and the
Current Section selector

3. the lower left-hand corner holds a palette of items to drag into the graphical window
4. the lower right hand corner has control buttons
5. the settings for a selected graphical item lie between the palette and the buttons
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The OK and Cancel buttons both close the dialog. OK accepts all changes, Cancel rejects all changes. The
Help button displays the information you are reading!

B ! Graphical sequence editor X
> Del || Copy..| Timing faults: 1 Current Section Initial 'S =
D1 L1
A
co u_l—lm_‘_‘_l_l_,_l_\/\/\—
? 1 1 1
0 ] ]
E !
’ I
0ms 1000
sl Voltage ramp DAC 1 at 510 to 610 ms Label ‘

T A 1™ Fom ) 0 Start (ms) | 510 2 [ Noreturn Ok
mn wl A To (V) 5 Length (ms) | 100 = Cancel

O 3B Help

Graphical editor

Sections

There are 27 sections: Initial and Section A through Section Z. The Current section field sets the section to
display and edit. There are 27 possible sections, named Initial then Section A through Section Z. If a section
has an associated Key, this is displayed to the right of the section name, for example Initial 'S. To make it easier
to identify empty sections in the Current Section drop down list, sections without a Key or any added items
have their names in brackets, for example (Section A).

The Initial section runs when the sequence starts; in some cases this may be the only section you need. The
remaining sections are optional. A section displays a representation of the output for each DAC and digital
output that is set for use in the Sequencer tab of the sampling configuration. There is a thicker line at the
bottom for the control track, which holds all other sequencing actions.

Selecting items

Click an item in the graphical view to select it. A grey rectangle marks the selected item and the item settings
appear below the display. The < and > buttons at the top left select the previous and next item on the current
track; they are very useful when items overlap. If you hover the mouse over one of the digital or DAC tracks a
tool tip will tell you the track name, the number of items in the track and remind you that you can click to select
an item or double-click the track to zoom it. The first item in a digital or DAC track spans the entire track
length and sets the initial track level. Any additional items are additions to the track, for example pulses or
pulse trains.

Section settings _
Click on the control track clear of any dropped items. You can — )
now set the associated key, the section length, number of oo Tl o B Then a7
repeats, action when the repeats are done, and a comment that
is displayed in the sequencer control panel to identify sections !
with keys. You can set a section length up to 10000 seconds and up to 1000000 repeats! If you want a section
to repeat forever, set the repeat count to 0. The Then field determines what happens when the section ends.
You can stop the sequencer with Halt, or select another section to run.

Comment Pulse outputs

Comments and display strings
You can set a display string that appears in the Sequencer control panel when the instruction associated with the

comment is displayed by adding it to the end of the comment preceded by a > character. For example: Pulse
outputs>Start pulsing

Key field

In an empty graphical sequence, no section has a key assigned. If you assign a key to a section, that section can
be activated by a user key press (if enabled) and the section will be listed in the sequencer control panel
together with the section comment. You can set the key to any of A-7, a-z or 0-9 (upper and lower case are
different). Only one section is allowed to use any particular key.
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Adding and deleting items

The graphical palette at the bottom left-hand corner of the dialog contains all the items that you can add to the
display. Move the mouse over an item so see a short description. Click an item and drag it to a suitable track,
then release to add it to the section. The Del button on the top line of the dialog removes the selected item. You
cannot remove the control track or the lines that represent the initial state of the DACs and digital outputs.

Change track labels

From version [10.07] you can change the default track labels (0-7) to a label of your choice of up to 5
characters. This label is visible within the graphical editor only and the only purpose is to remind you of the
function of each Digital or DAC output. To edit a label, click the label (next to the vertical DAC or DIG). The
mouse pointer changes to show Aa when you are over editable text. You may not set a blank label.

Dragging and duplicating an item on a track

To move an item, click on it and drag to the destination and release. To duplicate an item, hold down the ctr1
key, click on the source item and drag it to the destination position; you must keep Ctrl held down when you
release the mouse button or the duplicate operation will become a drag. While dragging, the positions are
quantized (for example a 1 second section drags in 10 ms steps). You can hold down the shift key to remove
this, allowing positioning as accurately as the pixel grid allows. For fine tuning of positions you will need to set
the position as text.

Timing faults

The sequencer attempts to match the timing you request. If this cannot be done, timing conflicts are marked by
a red vertical line below the control track and the number of conflicts is given in the message area. You will get
a conflict if you try to position any action at the start of a section. This is because the first instructions in a
section set the initial digital output and DAC state. You can choose to ignore timing faults; the sequence will
run with the changes as close to the requested time as possible. The sequencer time resolution field of the main
sequencer page sets how close the next instruction can be to the place you asked for.

Zoom a track

If you double-click any track except the control track, it zooms in size to occupy the display area. Double-click
it again to display all tracks. A Z appears at the upper right corner of the graphical window when the window is
zoomed. If you double-click an arbitrary waveform item this does not zoom the track; instead it refreshes the
choice of arbitrary waveform.

Copy section
The Copy button opens a dialog where you can copy tracks in the current section to a range of sections.

Setting initial DAC and digital levels

To set the initial DAC and digital levels, click on a track clear of any added items. The initial digital output
level is 0 or 1; the initial DAC level is in the units set by the Sequencer tab of the Sampling configuration.
Every section starts with the instructions that set these levels, so output changes caused by them will be as close
to time O in a section as possible. The fact that these levels may not be set at exactly time zero is not considered
a timing fault.
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Copy section dialog

The Copy button opens a dialog where you can copy items | copy current section %
in the current section to a range of sections. This makes it

. .. . . Items to copy Copy to sections
easy to create lists of similar stimuli. iz s
. . . Digital outputs Start section Initial v
The left-hand side of the dialog sets the items to copy; the 7 0 ] -
DAC outputs End section SectionZ

right-hand side sets the destination. If you clear the Section
Length check box, the length of the target sections does not | Msection Length [ Control track Cancel
change, otherwise the target sections are set to the length of
the source section.

If you check the Control track box, the Section Length box is ignored and the length is always copied. For
any item selected for copying, the corresponding item in the target section is first deleted, then the source item
is copied.

Graphical palette

MAa rl~ The palette contains 11 items you can drag and drop in the graphical window to generate a
sequence. There are three dropping zones: a digital output, a DAC output and the control
1) track. Items will only drop onto suitable targets. For example, you cannot drop a sinusoid on
,»  adigital track. There is no need to drop the items at exactly the right time point; you can edit

sl B 2 the position afterwards.

The palette is replaced by an error message if you set an illegal value for a pulse; you must fix the error before
you can add more items.

Dragging and duplicating an item on a track

To move an item, click on it and drag to the destination and release. To duplicate an item, hold down the Ctrl
key, click on the source item and drag it to the destination position; you must keep ctrl held down when you
release the mouse button or the duplicate operation will become a drag.

Common editable fields
When you select an item in the graphical window you can edit the fields that relate to it. The following are
described here to avoid repeating the descriptions.

Label

This field is normally blank. Use it to label the selected item so that you can branch to it. A label can be up to 6
alphanumeric (A-Z, 0-9) characters long and is case insensitive; abc23 and ABC23 are the same. Labels must
be unique in each section, but you can have the same label in a different section.

You cannot set a label for the initial levels of the digital and DAC tracks or for the control track as these items
all start at time 0 and can be branched to by referring to the section name. You cannot set a label for arbitrary
waveform output as this would prevent an important optimisation required when the sequence is generated.

Start time/At

All digital and DAC change items have a Start time field and all items on the control track have an At field.
The time is in units of seconds or milliseconds, as set by the Graphical editor settings, and is relative to the
start time of the sequence section. There is a spin control to nudge the time on or back by the sequencer time
resolution.

If you add items to the control track that take an unknown time to complete, for example a random delay or a
wait for an input signal to achieve a set value, the At time determines where the items are drawn in the graphical
editor. In this case the sequencer will maintain the time intervals between items wherever possible.

For pulses, ramps, sinusoidal and arbitrary waveform output, the sequencer attempts to produce the first output
change at exactly the time you specify. For other item types, the sequencer attempts to run the first instruction
of the item at the specified time.
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Length

Several items have a length in seconds or milliseconds. For all the pulse types, this is the period for which the
pulse changes to the amplitude or level you set before it reverts to the original level. For a ramp and a sinusoid,
this is the length of the output. For arbitrary waveform output, this is set to the length of the arbitrary wave you
associate with the command. You can set it to be less than the length of the wave, in which case the output is
stopped after the time you have set. There is a spin control to nudge the time on or back by the sequencer time
resolution.

Interval
For the pulse train items, this is the time between pulse starts in seconds or milliseconds.

Level (units)/Size (units)

These fields are used with DAC pulse outputs. The field you see depends on the state of the Absolute pulse
levels check box in the Graphical editor settings. The Size field sets the amplitude of a pulse; the Level field
sets the absolute level of a pulse. You set the value in the DAC units set in the Graphical editor settings.

No return

Normally the output from single pulses, ramps and sinusoidal output returns to the background level at the end
of the item. If you check this box, the output change produced by this item is not removed at the end of the
item. To indicate this, the grey rectangle surrounding the item extends to the end of the section. You could use
this to ramp a DAC up to a value and leave it there.

Overlapping items
If digital pulses overlap, the result is the logical OR of the pulses.

If DAC items overlap on the same channel, the output depends on the state of the Absolute pulse levels check
box in the Graphical editor settings. If it is clear, the result is the sum of the outputs. If it is checked, the
output level is set by the last item in the overlap. There is an exception: arbitrary waveform output overrides all
other items.

When adding pulses and pulse trains where the result would exceed the DAC range, the output is limited to the
DAC range. However, pulses with an amplitude change on repeats can exceed the DAC range and wrap around.
A value that goes off the top of the range will reappear at the bottom; a value that goes off the bottom of the
DAC range will reappear at the top.

Graphical palette items

Some of the following descriptions say that a time value is 'limited to 31 bits of sampling clock ticks'. This is
because the sequencer variables are 32-bit signed values. Values stored in them range from about minus 2
billion (-2,000,000,000) to plus 2 billion (2,000,000,000). At a time resolution of 1 microsecond, 2 billion ticks
represents 2,000 seconds, which is usually sufficient. Other items may be limited to 31 bits of sequencer clock
ticks for the same reason, but as the fastest sequencer rate is 5 microseconds per tick, this is unlikely to cause a
problem.

3t Single pulse

You can drag this item onto either the digital or the DAC outputs. For a digital output, this sets the output to be
the inverse of the initial level set for this output in this section. For a DAC output, you set the amplitude of the
pulse with the Size field or the absolute level with the Level field.

A Single pulse amplitude change on repeat

You can drag this item to a DAC output. It is for use in a repeated section. The Size/Level field sets the initial
amplitude or absolute level of the pulse the first time the section runs. The Change field sets the amplitude
change to apply on each subsequent repeat. You set the number of repeats by selecting the control track and
editing the Repeats field. The changes are calculated in real time in the 1401. If the initial level plus the
number of changes times the number of repeats exceeds the DAC range, the output wraps around.
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b Ramp
You can drag this item to a DAC output. The From and To fields set the initial and final amplitudes or levels of
the ramp depending on the state of the Absolute pulse levels check box in the Graphical editor settings.

™ Sinusoid
You can request sinusoids on DACs 0 to 7 in the Power1401 mk II and -3. However, Micro1401s can only
generate them on DACs 0 and 1 and the original Power1401 can use DACs 0 to 3.

The Size (units) field sets the sinusoid amplitude; this is not affected by the Absolute pulse levels check box.
You can offset the sinusoid with the Centre (units) field. If the Absolute pulse levels check box is clear, the
sinusoid and offset are added to the DAC value. If the check box is set, the DAC output is defined by the
sinusoid and offset.

The Period field sets the time for one cycle of the sinusoid in seconds or in milliseconds. Alternatively, you can
use the Frequency (Hz) field to set the frequency. The Phase field sets the initial phase in degrees. The output
is a cosine, so a phase of 0 means start at maximum amplitude. A phase of =90 or 270 produces a sine output.

L pyise train
You can drag this to a DAC or digital output. It generates a train of pulses defined by the number of pulses
(Pulses field), the length of each pulse (Length field) and the interval between each pulse and the next
(Interval field) or the pulse Frequency (Hz) field. For a DAC output you can also set the amplitude with the
Size/Level field.

This method is inefficient if you need to generate a large number of pulses as each pulse takes several
instructions. You should consider setting up a single pulse as a section and repeating the section to create the
pulse train. The maximum number of pulses you can set in one train is 1000 (was 400 before 8.03).

il pulse train with varying amplitude

You can drag this to a DAC output. It generates a train of pulses defined by the number of pulses (Pulses
field), the length of each pulse (Length field) and the interval between pulse starts (Interval field) or the pulse
Frequency (Hz) field. You set the amplitude of the first pulse with the Size/Level field. The pulse size
changes by the value in the Change field for each repeat.

This method is inefficient if you need to generate a large number of pulses as each pulse takes several
instructions (each pulses takes 4 instructions). You should consider setting up a single pulse with changing
amplitude as a section and repeating the section to create the pulse train. The maximum number of pulses you
can set in one train is 1000 (was 400 before 8.03).

1 Arbitrary waveforms

Drag this item to the control track to start playing a waveform through the 1401 DAC outputs. You cannot drag
this item if no arbitrary waveforms exist. You can play arbitrary waveforms through any combination of DACs
0-3 (DACs 2 and 3 do not exist on all 1401s). The DACs used are set when you create the waveform and can be
edited in the Play Waveform tab of the Sampling configuration. Create the arbitrary outputs with the Sample
menu Output Waveform command or from a script.

If more than one waveform is defined in the sampling configuration, you are prompted to choose one from a
list. Double-click the dropped item in the control track to redisplay the list and reset the waveform length. Each
waveform is identified by a code; this is either a single alphanumeric character or two hexadecimal digits.
When you set this in the Key field or by selecting a waveform, the Length field is set to the waveform length or
to a lesser value if the wave is longer than the section or to 0 if there is no matching wave. Set the length shorter
than the entire wave to truncate the output.

Arbitrary output takes appreciable time to set it up; times in excess of 10 milliseconds are possible. When
generating the output, this set up is moved as far forward in the sequence section as possible so that the output
starts at the exact time you set. If the preparation has not completed by the time you request output to start, the
sequence stalls until it is ready.

When the arbitrary output ends, the DAC outputs are returned to the background level as soon as possible. If
the arbitrary waveform has more than one channel, there will be one sequencer clock period between each DAC
changing to the background level. You can edit the duration of the wave, but only to be shorter than the
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nominal length. The nominal length is not affected by the replay speed (you can change this in the Play
Waveform tab).

Linked and repeated waves and speed changes

If you have set the wave to play more than once or to link to another wave, or you have adjusted the waveform
replay speed to be less than 1.00, you must add a Wait for time, condition or variable before the end of the
waveform to extend the time it has for running. If you do not, the waveform will stop at the end of the time slot
allocated to it. Currently there is no way to wait for the repeats to end; if you want this functionality you must
use a text sequence.

Drawing the waveform
If the arbitrary waveform is stored in memory, or (from [10.10]) the waveform is stored on disk and not too
long, Spike2 draws it in position. Otherwise, the waveform is represented by a black rectangle.

G Wait for time, condition or variable

You can drag this item to the control track only. It pauses the sequence until a condition is
met. The duration of this item may be unknown,; it is drawn as if it were of zero width and is
always treated as if it had a duration of 1 tick. This means that all Wait for... instructions
cause a hiatus in the time base. This is indicated by drawing a vertical blue line through all
the DAC and DIG traces. A Wait also stops all other sequencer activity apart from
previously started Sinusoidal output, Ramps and Arbitrary waveform output, which continue
during the wait.

0O >0
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i
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You can select the following delay types:

Fixed delay

Set the time to wait in the Delay field. This is useful in sequences with short active periods separated by long
delays (so the active periods occupy a reasonable proportion of the visible time base). Even though we know
how long the delay is, we treat it as if it were 1 tick when drawing. Another way to achieve this is to use
multiple, linked sections; use a long empty section for the delay.

Random delay

This holds the sequence for a time between Min time and Max time seconds or milliseconds. All delays
between the minimum and maximum have equal probability (within the capabilities of the sequencer). You will
get the best result for delay ranges that are long compared to the time resolution.

Poisson delay
This generates a delay with a Poisson statistic; the delay has the same probability of ending at any time during
it. The Time const field sets the average delay length.

Digital input high/low

You can wait for a nominated digital input bit in the range 0-7 to be high or low. These are not the same bits as
used for the event inputs (which are digital inputs 8-15). If you want to synchronise to a bit changing you must
wait for it to be in the opposite state to the one you want first. If you need the sequence to perform actions while
you wait, use a branch item. You can wait for combinations of input bits with the text sequencer.

From [11.00] you can add an optional time out, after which time the sequence will branch to a nominated label
or Section. If you do not want a time out, set the field to 0. If you set a time out, the code loop to do this takes
two instructions, so the timing accuracy of the change detection is 2 sequencer clock ticks, rather than 1
(without the time out).

Channel above/below/outside/within

You can wait for a nominated waveform channel sampled by the 1401 to be above or below a level set by the
Threshold field, or to be outside or within a pair of levels set by the Lower and Upper levels fields. The levels
are set in the channel units, as stored in the sampling configuration. If you subsequently change the channel
type, the results will not be harmful, but the sequence will not operate as intended!

Next event

You can wait for the number of events set by the Count field to occur on a nominated event, marker or
WaveMark channel that is sampled by the 1401. When this delay item is reached, the sequence notes how many
events have been sampled on the channel and waits until the number increases by the count.
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Time reached
Waits until the sample time reaches the set time. There is no wait if the time has already passed the set value.

Cosine phase 0
This item waits for the next time that cosine output on the nominated DAC channel passes through phase zero.

Variable comparisons

You can wait for various conditions based on sequence variables 1 to 25. The remaining variables are used to
implement the sequence sections. Variable values are 32-bit integers. You can manipulate the variables in the
Variable arithmetic item. Variables are described in detail for the text sequencer.

Event burst

This item monitors an event, marker or WaveMark channel sampled by the 1401 for a group of events with a
user-defined maximum separation. The Intervals field sets the number of gaps to check and the Max time field
sets the maximum acceptable interval. If any interval is greater than the maximum, the sequence starts the
search again. From the detection of the last event in a burst, there is a latency of 10-12 sequencer instructions
until the next sequencer action can occur.

For this to work well, the maximum interval must be significantly greater than the time resolution of the
sequence. The total burst duration is limited to 31 bits of sampling clock ticks.

£ Branch on condition, probability or variable

With this item you can break the normal flow of the sequence and branch to a different section or to a label you
have defined for an item in the current section. All branches have a Branch destination field in which you can
select a section to branch to, or you can type the name of a label in the current section.

When you branch, the timing to the target may not be exactly what you expect. The sequence will take one or
more steps to implement the branch and the target instruction may require preparatory steps. Such effects are
small unless you use arbitrary waveform output where the preparatory steps can take several milliseconds. If
you need the tightest possible control over branch timing you should consider using the text sequence editor.
The branches you can set are:

Probability
Percent sets the probability of the branch, 0% never branches, 100% always branches.

Digital input high/low
The Bit to test field sets the digital input bit number in the range 0-7 to test.

Channel above/below/outside/within

You can branch if a nominated waveform channel sampled by the 1401 is above or below a level set by the
Threshold field, or is outside or within a pair of levels set by the Lower and Upper levels fields. The levels
are set in the channel units, as stored in the sampling configuration. If you subsequently change the channel
type, the result is not harmful, but the sequence will not operate as intended! It takes two (or three for the
outside/within cases) sequencer instructions to do the check, so make sure that the sequencer is running fast
enough to detect the changes you seek.

Variable comparisons

You can branch on the result of comparing sequence variables with constant values and other variables. Some
variables have special uses. Variable values are 32-bit integers. You can manipulate the variables in the
Variable arithmetic item. Variables are described in detail for the text sequencer.

Unconditional
This always branches to the destination.

Time comparisons
You can compare a variable plus a time offset with the current time and branch on the result. You can set the
variable to the current time (plus a time offset) with the variable arithmetic current time instruction.

Response with timeout

You can wait for a new data item in an event, marker or WaveMark channel sampled by the 1401. The branch
is taken if a new item is detected within the time out period. The time out period is limited to 31 bits of
sampling clock ticks.

5-16



Output sequencer

p Generate digital marker channel event

This adds an event to the Marker channel (if it is enabled). You can set the marker code with the Marker code
field or check the Record data box to record the state of digital input bits 0 to 7 (these are not the same bits
used for event inputs). The Marker code field should be set to one character or to two hexadecimal digits.

3% Variable arithmetic

Although the use of variables is more commonly done with the text editor, you can perform basic variable
manipulation here. You can use variables 1 to 25. Variable values are 32-bit integers. In all cases, the variable
that is changed is set by the Target var field. Where operations involve time (in sampling clock ticks) you must
remember that sequencer variables are 32 bits and times can now be up to 64 bits. This means that once the
sample time exceeds around 2 billion clock ticks, the values stored will no longer represent the time in a useful
way (though you can still use differences of times as long as the difference is less than 2 billion sampling clock
ticks). Operations are:

Set to value/variable
Replace the target variable with the contents of the Value field or of a variable.

Add/subtract value/variable
Adds or subtracts the contents of the variable or value.

Muiltiply by value/variable
Multiplies the target variable by the variable or value.

Random value

This replaces the target variable by a random number that is from 1 to 30 bits long, set by the Bits field. The
possible values for an n bit number are 0 up to 2**n minus 1. For example, if the Bits field is 4, the possible
results are 0 to 15.

Current time (deprecated)

The variable is set to the current sample time plus a time offset, in Spike2 clock ticks, as set in the Resolution
tab of the Sampling configuration. As the current time can occupy more than 31 bits, the value stored in the
variable will, in general, only be useful for the first 2 billion sampling clock ticks. This is retained for
compatibility with Spike2 version 7, but should be avoided.

Fixed time

The variable is set to a time, in Spike2 clock ticks, as set in the Resolution tab of the Sampling configuration.
As variables can only store positive values up to 31 bits in length, this is only useful for a fixed time that is less
than around 2 billion sampling clock ticks. This is here for compatibility with version 7, but should be avoided.

Select arbitrary waveform

This dialog opens when you drag the arbitrary waveform output icon onto | g available waveforms X
an output track and there is more than one arbitrary waveform to choose

. : : : Key Label Points Hz Seconds
from or when you double click an arbitrary waveform output item in an | | er e o S

output track. You can add items to this list from the Offline waveform | Short 1191 25000  0.0476
output dialog accessed from the Sample menu or with the
PlayWaveAdd () script command.

Select one of the waveforms in the list and click OK to add the wave into | Single short pulse

the sequencer output or click Cancel to close the dialog. You can adjust Help Cancel
the length of the played data in the graphical editor. The line of text
above the buttons displays the comment associated with the selected item.
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The text editor

The output sequencer text editor gives you full control over the output sequencer. The price you pay for this is
that you become responsible for calculating the timing of everything. Unlike the graphical editor, where you
can deal with items like pulse trains, in the text editor you must construct pulse trains edge by edge; fortunately,
this is not as difficult as it sounds. Even if you plan to use the graphical editor, some understanding of how you
would program with the text editor is useful as it will help you understand why some features of the graphical
editor work in the way they do (as all graphical sequences are converted to text sequences before they are used).

The text output SEQUENCE | e pp Firck ol ==
is stored as a text file with | = : e
the extension .pls. From | MeETors,&Lines compied Labels ] [keys =] [[2E]

[10.15] you can also store SET 10.000,1,0 ;10 milliseconds per step
a sequence as text in the S5TCP: ) .E'. DIGOUT [000000001 } ;.:sESEt,
HALT sS5top the seq

sampling  configuration. PULSE: 'G DIGOUT [....... 1] ;Pulse
You can open existing SEBOEE £ 5515 .. 0] ;Set output low
Spike2 output sequence DELAY 97,PULSE ;wait 98

files or create new ones |l ° - i
with File menu New...

You can also open this window by double-clicking on a displayed sequence in the Sampling configuration
dialog Sequencer tab.

et et
oo BB B

If the folding margin is displayed as in this example (if not, see the View menu Folding command and select a
folding style), you will see that you can fold up the window text based on the keyboard codes as folding points.
The Keys and Labels drop downs show a list of all the keyboard codes and labels in the file; select one to
navigate to them. If you load a sequence from a read only medium or the file is marked read only, you are not
allowed to change it in the editor.

There are five buttons at the top of the window:

-

*2%] Format
Th(lis ahgps the lgbels, keg 15 MyFirst pls
codes, instructions and | — : ==
any arguments, output text | Fermattngbone Labeis v [kevs =] [
and comments and . SET i0.000,3,0 10 milliseconds per step
removes step numbers. It o HIOEE. 2 E;EEJT . :
. . 3 I 1
will a'lso do basic syntax E PULSE: G DISOUT [.:::s:n 1]
checking of the sequence; F DIGOUT [ 0] ;
undefined labels are not s DELAY 857, PULSE ;wait 98 steps, loop *¥5 to Stop

flagged but there must be
no other errors. If there
are errors, the first offending line is flagged and formatting stops. You will normally want to have your
sequences formatted as it makes them much easier to read and understand. However, it is usually much quicker
to type sequences in unformatted, then use the Format command to tidy them up.

[233=
123 Format with step numbers
This does the same job | ..

- MyFirst.pls
as the Format button, = :

and also starts each line | Fermatting Done Labels ~ | [Keys ~ |%|

with the step number. SET ;10 milliseconds per step
Step numbers can be Fr; 0000 STOPE: 'S5 DIGDUT [ ;Reset output and stop

. -~ ‘0001 HALT ;5 ) e sequencer >G
useful as they give an B 0002 PULSE: 'G DIGOUT [....... 1]
indication when you are F 0003 DEGET L g s 500 0]
running out of space - 0004 DELRY 97,PULSE

(there are a maximum of
8191 instructions
allowed) and can pinpoint the line where your sequence is not behaving as you expect. When your sequence is
running, the sequencer control panel displays the current sequencer step. A number at the start of a sequencer
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line is completely ignored when sequences are compiled, so you need not worry about editing a sequence that
has step numbers. Just format the sequence to clean up the changes.

[=F .
==| Compile
This checks the Sequence | iy gt ol v ==
to make sure that it is | — . e
correct with no labels | Baddatali/opattern (Lobels ~| [keys =] ¥
missing or duplicated and SET 10.000,1,0 ;10 milliseconds per step
no duplicated key codes [ 0000 STOP: '5 DIGOUT [000CoD00O] ;Beset output and stop

. ' ~- 0001 HALT ;5top the sequencer >G to startc
The plctur§ ShOWS a ] 0002 PULSE: 'S DIGOUT [....... 1] ; 5 stop
sequence with a simple 0003 THGOIT A, 5 5 00 0] >3 stap
error (the 0 in the second =-0005 A G T HEC
line should be a zero). |!° = '

The line in error is

marked by changing the background colour and an explanatory message is shown at the top of the screen. Any
edit to the sequence will remove the background colour change. The compiler stops at the first error it finds. If
the compiler completes without error is display the number of sequencer lines (instructions) that were compiled.
The compiler always adds a HALT instruction to the end of the sequence, so the count will be one more than the
number of listed lines.

[E' Current

This compiles the sequence and if it compiles without error, the sequence is saved. If there is any error, it is
reported and the command ends. If there is no error, what happens next depends on whether Spike is sampling
data or not:

Not sampling The name of the sequence file is set in the sampling configuration and the sequence will be used
when you next sample data. You can also set the output sequence file from the Sampling
Configuration dialog accessed from the Sample menu. From version [10.15], if the file name
iS S2CFGSEQ$ . PLS (this is the name given to temporary files used to edit sequences stored as
text in the sampling configuration), this will update the sequence stored as text in the sampling
configuration.

Sampling Spike attempts to replace the current sequence. This will fail if there is no current sequence, or
if the sequence or table size is larger than the current size or the size reserved in the Sequencer
tab of the Sampling configuration dialog. If a sequence is replaced, it runs from the first
instruction. Any variables that are declared with initial values are updated as are all initialised
table values. The Sampling configuration is not updated with the name of this sequence file.

You can also change the current sequence file from the Sample menu and with a script.

A message indicating the outcome of the operation is displayed at the top of the window.

? Help

This is the Help button. It opens a window holding a list of the sequencer topics for which help is available.
You can copy and paste text from the help window into your sequence.

Loading sequencer files for sampling

The name of the output sequencer file to use during sampling is part of the sampling configuration. The file
name, including the path to the folder containing it, must be less than 200 characters long. You set the file name
either with the Current button, as described above, or in the Sampling Configuration dialog. When you start
sampling, Spike2 searches for any output sequence file named in the sampling configuration.

From version [10.15], you also have the option of storing the output sequence text as part of the sampling
configuration.

Spike2 compiles output sequence files whenever you use them. If a file contains errors you are warned and the
file is ignored.
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Getting started

The sequencer runs instructions in order unless told to branch. It can be re-routed during data acquisition by
associating an instruction with a key on the keyboard. Each time the key is pressed or the associated sequencer
control panel button is clicked or the script language sampleKey () command is used, the sequencer jumps to
the associated instruction. Spike2 records keys pressed during sampling, so you have a record of where in the
document you switched to a new portion of the sequence.

Here is a simple sequence that will pulse digital output bit 0 for 10 milliseconds once per second. You can start
and stop the pulses with keys or by clicking buttons. You will find this in the Sequencer\MyFirst.pls file
(in the User data folder) to save you typing it in.

SET 10 ;10 milliseconds per step
'S DIGOUT [©0000000 ] ;Reset output and Stop
HALT ;Stop the sequencer >G to start
PULSE: 'G DIGOUT [....... 1] ;Pulse outputs >S to stop
DIGOUT [...v... 0] ;Set output low >S to stop
DELAY 97,PULSE ;wait 98 steps, loop >S to stop

Open MyFirst.pls and click the Check and make current sequence button at the upper right of the
window (leave the mouse over each button for a second or so to see the descriptive text). Open the Sampling
configuration dialog, and set a configuration with one event channel on port 0. To record the output pulses you
must connect the digital output to the event input. This is easy with the Micro1401 and Power1401 as you can
connect Digital output 0 to Event input 0 on the front panel. You do not need to make the connection to follow
this description.

Click the Run now button in the sampling configuration, and then click the —
Start button. The sequencer control panel is now visible. It displays Step Sequence control |E|
0001 in the top left window and G to start to the right. If the control panel
is docked there are two buttons labelled S and G, otherwise you can see the
text S Reset output and Stop and G Pulse outputs. To start the output, | ||S Resetoutput and stop
click on the G or type G on the keyboard. While it runs, the display will ||| & Pulse outputs

change to Step 0004 (with occasional flickers) and S to stop. If you have
connected the digital output to the input, you will see your pulses recorded,
once per second. Click the S or type s on the keyboard to stop the output.

Step 0001 G tostart

As this is our first

A St MyFirst.pls =nEs]
sequence we will explain | — : ——e e —
it in detail. Click the | FomattngDone [iabets +] [kevs =] [

Format and add Step SET i0.000,1,0 ;10 milliseconds per step
numbers button at the E oooo STOP: 'S DIGOUT [00000000] :Re T
- poo1 HALT :5t
top of the sequencer E 0002 PULSE: 'G DIGOUT [....... 1] :Pu
window. All the lines get 0003 DEGOUT L5 5544 o] :Se
a step number CXCCpt the - 0004 DELAY 57, PULSE swait

4 T} 3

first. This is the step
number displayed in the
control panel. You can remove step numbers with the Format button. Lines that get a number are part of the
sequence run by the 1401. The SET line tells the sequencer how fast to run, in this case 10 milliseconds per
step, and is not part of the sequence run by the 1401. A SET or SCLK directive is usually the first line in the
sequence.

The next line (step 0000) is the first to run when you start sampling. The 'S means jump to this line every time
the S key is pressed during sampling (as long as the data window is the current window). To allow you a wide
choice of keyboard jumps, lower case s and upper case S are treated as different keys.

The instruction on this line is DIGOUT [00000000], which sets 8 digital outputs (bits 15 to 8 of the digital
output) to the low state, nominally 0 Volts. The remainder of the line is a comment. Because there is a keyboard
jump set for this line, the comment is also used as a label for the sequencer control panel.

The next line, (step 0001) holds a HALT instruction. This stops the sequencer and nothing will happen until the
sequencer is told to jump to one of the steps labelled with a key code. The sequencer control panel displays the
text to the right of the > for the current step. When the sequencer halts, it stays at step 0001, so you see the
message G to start.
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Steps 0002 and 0003 set digital output bit 8 high (nominally 5 Volts) and low again. The sequencer is running
at 10 milliseconds per step, so the pulse is 10 milliseconds wide. Step 0002 starts with a label, PULSE:, so we
can branch back here in the next step.

Step 0004 has the instruction DELAY 97, PULSE to make the sequence wait for 97 extra step times in addition
to the step time that every instruction takes, and then branch to the instruction labelled pULSE. This instruction
takes 980 milliseconds, and together with the 20 milliseconds taken by steps 0002 and 0003, this makes 1000
milliseconds for the loop. Instead of 97 we could have written s (1) -3. The s (1) function returns the number
of sequencer steps in 1 second.

Time delays can also be implemented with the TICKS instruction, which gives you access to the underlying tick
count used by the Spike2 sampling.

The remainder of this chapter is organised as a reference manual for the sequencer instructions. You can find
more information about the output sequencer in the Spike2 Training Course manual.

Sequencer compiler error messages

When you use the Format or Compile buttons in the sequence editor, Spike2 displays the result of the
compilation or format operation in the message bar at the top of the window. The messages report either
successful operation or the cause of the problem.

No errors, N lines compiled

Your sequence has been checked and is syntactically correct. This means that it will certainly run, but it is up to
you to ensure that the sequence of codes produces the desired effect. If your sequence runs off the end of the
defined instructions, it will stop as the compiler adds a HALT instruction to the end of every sequence. The
number of lines compiled is a count of the number of instructions generated, which is one more than the number
in the sequence text as Spike2 adds a HALT instruction to the end of the sequence.

Formatting done
The format operation has completed and all lines of instructions are syntactically correct in themselves. There is
no check that a label referenced in an instruction exists.

Invalid label format, or same as Opcode, VAR, CONST or function
A colon was found, indicating a label, but the characters before the colon are not legal. A label starts with an
alphabetic character (2-2) and is followed by alphanumeric characters (A-z and 0-9) and is terminated by a
colon. Case is not significant in labels. The label can be up to 8 characters long. It must not be the same as an
instruction name, a variable name, a constant name or a built-in function.

Invalid key definition
A quote mark was found, but there was no acceptable character following the quote, or there was more than one
character.

Unknown command used

A group of characters was found in the correct position to be an instruction, but they were not recognised.
Change them to a correct instruction mnemonic. This can also be caused by a missing colon at the end of a
label.

The first/second/third/fourth argument is invalid
The instruction argument is either missing, invalid or was too long to be correct. If the argument included a
table reference, the offset may be too large or too small.

Internal error, contact CED
This is caused by a serious system error. If you can reproduce this problem please contact CED for advice.

Out of memory

Spike2 has run out of memory while processing the sequence. Close any non-essential windows in the Spike2
application and try again. If this does not allow compilation, close any other applications and retry. As you are
most unlikely to exhaust your memory when compiling it may mean that something has gone badly wrong.
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Label or table size defined twice

A label has been defined on more than one line. Remember that the labels are converted to upper case, so two
labels that differ in case only will cause this error. This error is also given if you use TABSZ more than once in a
sequence.

Unexpected characters at end of line
The most common cause of this error is a missing semicolon to introduce a comment.

Couldn't find branch destination
The label used by the instruction is not defined anywhere in the sequence. Define the label, or correct the label
name.

Invalid numeric value
A numeric argument was expected, but an invalid number or one that was outside the permitted range for the
argument was found.

Probability out of range
The probability field of the BRAND instruction must be set to a number in the range 0 to less than
1.0000000000; correct the number.

Bad digital i/o pattern
Whenever a digital i/o pattern is expected, exactly 8 characters must be present, one for each bit of the digital
i/0. The characters are restricted to “0”, “1” and “.”, plus “c” for DIGIN and “i” for DIGOUT.

A label, key or display string but no instruction

Labels, key definitions and display strings may only occur on lines that have an instruction. If you really want
an instruction that does nothing, use NOP. Blank lines and lines consisting entirely of comments are allowed and
ignored.

Too many instructions

You have defined more than the maximum allowed number of instructions (8191), so you must shorten your
sequence. You may be able to significantly shorted your sequence by using variables and the
SampleSegVar () script instruction. You can also split a sequence into sections and load these one at a time.

Input line too long; shorten and try again
Each line of the file must be no more than 100 characters long. Shorten the offending line and try again. This
limit in old versions of Spike2 was less, so it is a good idea to keep to short lines wherever you can.

Unexpected end of file encountered
This shouldn't happen and probably means that something has gone badly wrong.

Variable name too long, unknown, badly formed or missing
A variable name used to replace the v1 to V256 built-in names is incorrectly formed.

Please use a single character or 2 hexadecimal digits as wave code
The waveform codes for the WAVEGO command must either be a single character or two hexadecimal digits. A
hexadecimal digit is one of the characters 0-9 or a-f.

Bad branch code: C=Cycles, A=Area, S=Stopped, T=Triggered, W=Wait for WAVEGO
The branch code for the WAVEBR command was not one of the allowed characters listed, or the branch code was
more than one character.

Bad start or stop code: S=Stop now, C=one more cycle, T=Trigger now
The code given for the WAVEST command was not one of those listed, or there was more than one character in
the code.

Bad flags: T=Triggered, W=Wait until hardware is ready
The flags for the WAVEGO command were not those listed, or more than two flags were used.
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Variable name already defined as Opcode, label, function or CONST

Old versions of Spike2 allowed a variable name to be the same as a label or an Opcode. This is no longer
allowed. Also, the name is not allowed to the same as a built-in function, for example VvAngle or the same as a
CONST item. Change the variable name.

Label already exists as Opcode, variable, function or CONST
Old versions of Spike2 allowed a label to be the same as a variable name or an instruction name. This is no
longer allowed. The name may not match a built-in function or a constant. Change the label.

The DAC value exceeds the DAC output range

You have entered an expression for a DAC value that when scaled and offset by the values in the SET directive,
produces a result that exceeds the DAC range. Check that the SET directive scale and offset are correct and that
you have not mistyped the value.

More table entries than set by TABSZ
You have used the TABDAT directive to create table entries. There is either no TABSZ directive, or you have
generated more table data than you allocated with TABSZ.

Compatibility with previous versions

Sequences from all previous versions still work, with the following provisos on sequences written for Spike2
version 3 and earlier:

1. Variables and labels may not share names nor be the same as instruction codes.

2. DELAY 0 no longer hangs up for a long time. It now has the same effect as NOP.

3. If a version 3 sequence relied on looping back to the start after 256 steps, this no longer works as all
sequences have a HALT instruction automatically added to the end. You must add a label at the start and a
JUMP instruction at the end.

4. BRAND set the probability to an accuracy of one part in 256. It now sets the probability to a very high
accuracy. This might affect your results.

5. DACn and ADDACn now insist that any value you use lies within the range of the DAC.

6. ADDACnh previously expressed your increment as a 16-bit integer. It now generates a much more accurate
32-bit integer. However, this means that ramps generated with ADDACn may have a different slope
(probably much closer to the intended slope).

If you want to write a sequence that will run on previous versions of Spike2, either refer to the manual for the
previous version, or write the sequence using the previous version to be certain of complete compatibility. Use
of any of the following features will prevent the sequence working on version 6 or earlier:

1. Use of more than 1023 sequencer instructions or more than 64 variables.

2. Useofthe ASz () or vSz () expressions.

3. Use of a label in an expression

4. Use of the JUMP (Vn) or JUMP LB (Vn) instructions

5

Use of new instructions: TABADD, TABSUB, ABS, AND, ANDI, OR, ORI, XOR, XORI, DIGPC, DIGPS,
DIGPBR

6. Use of #include to include other files.
7. Use of the = directive to define a constant.
8. Use of more than DACs 0-3 in the sinusoidal output or RAMP instructions.

If you use the sTk64h () or sTk641 () instructions or refers to VTickOL or VTickOH, your sequence will only
run in version § onwards.

Instructions

These are the Spike2 output sequencer instructions. Instructions in brackets are obsolete and should be avoided
in new sequences.

Digital (TTL compatible) input and output
DIGOUT Write to digital output bits 15-8
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DIGLOW

DIBNE, DIBEQ
DISBNE, DISBEQ
WAIT

(DIGIN)
(BZERO, BNZERO)

Write to digital output bits 7-0

Read digital input bits 7-0, copy to V56 test and branch
Test last read digital inputs (in V56) and branch

Wait for a pattern on the lower 8 digital inputs

Read and test digital inputs

Branch as result of DIGIN test

DAC (waveform/voltage) outputs

DAC
(DACn)
ADDAC
ADDACn
RAMP

Set DAC value (for DACs 0-7)

Version 3 compatible, set DAC n (0-3) to a value
Increment DAC by a value

Version 3 compatible, increment DAC n (0-3) by a value
Set automatic DAC ramping to a target value

Sinusoidal waveform output

SZ
SZINC
RATE
RATEW
ANGLE
WAITC
RINC
RINCW
PHASE
OFFSET
CLRC

General control
DELAY

DBNZ

(LDCNTn, DBNZn)
Bxx

CALL

CALLV, (CALLn)
RETURN

JUMP

HALT

NOP

Variable arithmetic
ABS

ADD
ADDI, (ADDIL)
MOV

MOVI, (MOVIL)
MUL, MULI

NEG

SUB
DIV,RECIP

Variable logic
AND, ANDI

OR, ORI
XOR, XORI

Table support
TABLD, TABST

TADADD, TABSUB
TABINC

Set the cosine output amplitude (CSZ, DS7)

Change the cosine output amplitude (CSZINC, DSZINC)
Set the cosine angular increment per step (CRATE, DRATE)
As RATE, but waits for phase 0 (CRATEW, DRATEW)

Set cosine angle for the next step (CANGLE, DANGLE)
Branch until cosine phase 0 (CWAIT, DWAIT)

Change the cosine angle increment per step (CRINC, DRINC)
As RINC but waits for phase 0 (CRINCW, DRINCW)
Defines what phase 0 means (CPHASE, DPHASE)

Offset for sinusoidal output (COFF, DOFF)

Clear the new cycle flag (CWCLR, DWCLR)

Do nothing for a set number of steps

Decrement a variable and branch if not zero

Load counter 1 to 4 (Vv61-v64), decrement, branch if not zero
Compare variables and branch (xx = GT, GE, EQ, LE, LT, NE)
Branch to a label, save return position

Like CALL, but load a variable (counter 1-4) with a value
Branch to instruction after last CALL, CALLV or CALLn
Unconditional branch to a label

Stops the sequencer and waits to be re-routed

This does nothing for one step (No OPeration)

Take the absolute value of a variable

Add one variable to another

Add a constant value to a variable

Copy one variable to another

Move a constant value into a variable
Multiply two variables, multiply by a constant
Move minus the value of a variable to another
Subtract one variable from another

Division and reciprocal of variables

Bitwise AND of variables, variable and constant
Bitwise OR of variables, variable and constant
Bitwise exclusive OR of variables, variable and constant

Load a register from the table and store a register to the table
Add a table value to a variable or subtract it from a variable
Increment a register and branch while within the table

Access to data capture

REPORT, MARK
CHAN

Simulate an external E1 pulse to record/set a digital marker
Get the latest waveform value or event count from a channel
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TICKS

Load a variable with the time in Spike2 time units

Randomisation
BRAND, (BRANDV) Random branch with a probability

MOVRND
(LD1RAN)

Load a variable with a random number
Load counter 1 (v61) with a random number 1-256

Arbitrary waveform output

WAVEGO
WAVEBR
WAVEST

Start or prepare arbitrary waveform output area
Test arbitrary waveform output and branch on the result
Start or stop arbitrary waveform output

Instruction format

Blank text lines and lines with a semicolon as the first non-blank character, are ignored. Instructions are not
case sensitive. Each instruction has the format:

num lab:

num

lab:

'key

code

argl, ..

comment

>display

Expressions

'key code argl,arg2,... ;Comment >display

An optional step number in the range 0 to 8190, for information only. A number at the start of an
instruction line is ignored.

An optional label, up to 8 characters long followed by a colon. The first character must be
alphabetic (A-Z). Labels are not case sensitive. Labels may not be the same as instruction codes,
variable names, constants or expression function names. Labels can be used in expressions, and
have the value of the instruction number in the sequence; the first instruction is number 0. Labels
are used by branching instruction to change the flow of control through a sequence. From version
[11.00] we allow branches to use relative jumps by specifying +n or -n (n is the number of
sequencer steps to jump) in place of a label.

In this optional field, key is one alphanumeric (a-z, A-Z, ©-9) character. When this character is
recorded as a keyboard marker during data capture, the sequencer jumps to this instruction. Each
key can occur once. Upper and lower case are distinct. The key appears in the sequencer control
panel together with any comment. The key must be followed by white space and a code. For
reasons of backwards compatibility, we also accept :key and lab:key, however this syntax is
deprecated and converted to 'key when the line is formatted.

This field defines the instruction to be executed. It is not case sensitive.

Instructions have up to 4 arguments that are separated by commas or spaces. These are described
with the instructions. If an argument can be represented in different ways, they are separated by
vertical bars (read as "or"), for example: expr |Vn| [Vn+off]. In this case, the argument can be
an expression, a variable or a table reference.

The text after the semicolon is to remind you of the reason for the instruction. If a key is set, this
comment also appears in the sequencer control panel.

When a sequence runs, text following a > in a comment is displayed in the sequencer control
panel to indicate the current instruction. Spike2 is notified every few milliseconds of the current
instruction and the control panel is updated whenever there is free time, so the display is only a
sampling of what is going on. The special combination >" means use the same display text as for
the previous instruction. This can save you some typing when a group of instructions in a loop
need the same display. If there are several instructions in a row that use this, Spike2 searches
backwards until it finds an instruction with a display string that is not >". The special combination
>= means make no change to the display string. This might be used in a code section that is called
as a subroutine from several different places.

Many instructions allow the use of an expression in place of a constant value, indicated by expr. An expression
is formed from constants, numbers, labels, round brackets ( and ), the operators +, -, * and /, and sequencer
expression functions. Labels have the value of the instruction number in the sequence; the first instruction is

numbered 0.
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The operators * and / (multiply and divide) have higher priority than + and - (add and subtract). This means
that 1+2*3 is interpreted as 1+ (2*3) and not as (1+2) *3. Apart from this, evaluation is from left to right
unless modified by brackets.

The sequence compiler evaluates expressions as real numbers, so 3/2 has the value 1.5. If expr is used as an
integer, for example DELAY expr, it is rounded to the nearest integer. Values in the range 3.5 to 4.49999... are
treated as 4. Before version 4.06 the result was truncated, so 3.0 to 3.9999... was treated as 3. From [11.00]
there are new expression functions Ceil (), Floor (), Round () and Trunc () to force how fractional numbers
are treated.

You cannot use sequencer variables (Vnn) in an expression. Variables exist when a sequence runs within the
1401 interface. Expressions are evaluated when a sequence is compiled inside your computer.

Sequencer expression functions
These functions can be used as part of expressions to give you access to Spike2 clock and sequencer step timing
and to convert between user units and DAC and ADC values and to calculate table indices.

s (expr) The number of sequencer steps in expr seconds, milliseconds or microseconds. For example,
ms EeXPr; with a step size of 200 milliseconds, s (1.1) returns 5.5. This is often used with the DELAY
us (expr

instruction. Each instruction uses 1 step, so use DELAY s (1)-1 for a delay of 1 second.
These expressions assume that the sequencer runs at the rate set by the SET or SCLK
directives at the start of the sequence.

sTick (expr)  The number of Spike2 sample clock ticks in expr seconds, milliseconds and microseconds.

msTick (eXPr) The result is in the same units as returned by the TICKS instruction, so TICKS

usTick (expr) V1,sTick (1) sets V1 to the value that TICKS will return 1 second later. The result is a
signed 32-bit value, so is limited in magnitude to 2 billion (2000000000) sample clock ticks.
If you run sampling at a resolution of 1 microsecond, this is a range of -31 minutes to 31
minutes. At 2 microsecond resolution it is plus or minus an hour, and so on. These
expressions assume that the sequencer runs at the rate set by the SET or SCLK directives at
the start of the sequence.

sTk64h (expr) [8.00]. These converts a time in seconds into Spike2 sample clock ticks as a 64-bit number,

sTk641 (expPr)  then returns either the upper 32 bits (sTk64h) or the lower 32 bits (sTk641). If you need to
do 64-bit arithmetic with these values you should be aware that the lower 32 bits is
effectively an unsigned number, so if you add a 32-bit value to it you may need to detect if
the result overflowed, and if it did overflow add 1 to the upper 32 bits. There are currently no
64-bit arithmetic instructions in the sequencer instruction set, but you can emulate them (with
some effort) by looking at the signs of the values before and after addition.

Hz (expr) The angle change in degrees per step for a cosine output of expr Hz. For a 2 Hz cosine on
DAC n,use RATE n, Hz (2). To slow the current rate down by 0.1 degrees per step use RINC
n,Hz (-0.1). Use in RATE, RATEW, RINC and RINCW instructions.

VHz (expr) The same as Hz (), but the result is scaled into the 32-bit integer units used when a variable
sets the rate. MOVI V1, VHz (2) followed by RATE n, V1 will set a 2 Hz rate.

VAngle (expr) Converts an angle in degrees into the internal angle format. The 32-bit integer range is 360
degrees. The result is expr * 11930464 .71. For use with ANGLE and PHASE.

VDAC16 (expr) Converts expr user DAC units so that the full DAC range spans the full range of a 16-bit
integer. Use with variables for the obsolete DACn and ADDACn. For example, MOVI
V1,VDAC16 (2.5) then DACO V1 has the same effect as DACO 2.5.

VDAC32 (expr) Converts expr user DAC units into a 32-bit integer value such that the full DAC range spans
the 32-bit integer range. Use this to load variables for the DAC and ADDAC instructions. For
example, MOVI V1,VDAC32(2.5) then DAC 0,V1 has the same effect as DAC 0,2.5
(setting the DAC 0 output to 2.5 user DAC units).

ASz (expr) Converts expr user DAC units into a value suitable for use with the sz and SzINC
commands. That is, it converts an amplitude or amplitude change in user DAC units to a
value in the range 0 to 1. It does this by dividing the value you supply by the (DAC scale
factor * 5).

VSz (expr) Converts expr user DAC units into a variable value suitable for use with the sz and SzZINC
commands. That is, it converts an amplitude or amplitude change in user DAC units to a
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value in the range 0 to 32768. It does this by multiplying the value you supply by 32768/
(DAC scale factor * 5).

TabPos () The number of table data items defined at this point in the sequence by TABDAT. This is also
the index of the next table data item to use. You can use this to define constants that
reference table indices.

DRange () The DAC output range (usually 5.0 for a £5 Volt system or 10.0 for a £10 Volt system).
When the sequence is built for use during sampling, this value is taken from the DAC output
range of the attached 1401, otherwise, this is taken from the Voltage range set in the Edit
menu Preferences option.

Ceil (expr) Integral values are unchanged, but all non-integral values are set to the next higher integral
value. Think ceiling.

Floor (expr) Integral values are unchanged, but all non-integral values are set to the next lower integral
value.

Round (expr)  Round expr up or down to the nearest integral value.
Trunc (expr)  Remove the fractional part of expr.

Used with care, the built-in functions allow you to write sequences that operate in the same way regardless of
the sequencer step time or DAC scaling values. Note that Ceil (), Floor (), Round () and Trunc () were
added at version [11.00].

Variables

You can use the 256 variables, V1 to v256, in place of fixed values in many instructions. In the sequencer
command descriptions, Vn indicates the use of a variable. Where a variable is an alternative to a fixed value
expression we use expr | Vn. Variables hold 32-bit signed integer numbers that you can set and read with the
SampleSeqVar () script command. There are instructions that can be used to perform arithmetic on variables.
If you need more than 256 variables, you could consider using a Table.

Variables exist in memory in the 1401. Scripts can set their values and read them back, which involves the
transfer of data between the 1401 and the host computer, typically taking a few milliseconds to do. Variables
allow you to perform calculations and store and recall information with a running sequence. You can also use
them to control a running sequence.

When an instruction includes a shift of a variable (described as >> shift), the shift is arithmetic (that is it
preserves the sign).

Variables with pre-defined uses

Some variables have specific uses and pre-defined symbolic names (which are easier to remember than V1 to
v256). If you use these variables for other purposes you can rename them (see below), but once renamed, the
pre-defined name is no longer available.

Variable  Pre-defined name Comment

V56 VDigIn This holds the last bit pattern read from the digital inputs with the DIBxx or
DIGIN instructions.
V57-vV64  VDACO-VDACT These hold the last value written by the sequencer to DACs 0-7. These

variables are not updated by arbitrary waveform output so if you use it, you
cannot rely on VDACnH for the current DAC value.

V6l-ve4 These are used to emulate the counters for the obsolete LDCNDn and
DBNZn instructions (which you should NOT use). If you avoid these
instructions, the variables are free for use. This use overlaps with the
VDAC4-VDAC7 use.

V255 VTickOL This holds the first (lower) 32-bits of the zero time used by the TICKS
instruction and set by the TICKO instruction. This is an unsigned 32-bit
number, which makes it tricky to use in comparisons.
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V256 VTickOH This holds the second (upper) 32-bits of the zero time used by TICKS and
set by TICKO.

Variables v57 through v64 hold the last value written by the sequencer to DACs 0 through 7 (and can also be
referred to as VDACO through VDAC7), V56 holds the last bit pattern read from the digital inputs with the DIBxx
or DIGIN instructions, V61 through v64 are also used to emulate the v255 and v256 store the zero time used
by the TICKS instruction and are set by the TICKO instruction.

VAR directive

You can assign each variable a name and an initial value with the VAR directive. Names must be assigned
before they are used, usually at the start of the sequence. Each variable can be assigned a name once only, and
the name must be unique and not the same as a label, a constant, an expression or an instruction. The syntax is:

VAR Vn, name=expr ;comment

VAR does not generate any instructions. It makes the symbol name equivalent to variable vn and sets the initial
value when the sequence is loaded. Anywhere in the remainder of the sequence where vn is acceptable, name
can be used. name can be up to 8 characters, must start with an alphabetic character and can contain alphabetic
characters and the digits 0 to 9. Variable names are not case sensitive. A variable name must not be the same as
an instruction code, a constant or a label.

There is no need to specify a name or an initial value. If no initial value is set, a variable is initialised to 0 even
if not included in a VAR statement. Spike2 automatically assigns V56 the name VDigIn and variables v57
through vé64 the names VDACO through vDAC7. If no symbolic name is set, any pre-defined name for the
variable is cleared. The following are all acceptable examples:

VAR V1,Waitl=ms(100) ;Set name and initial value

VAR V2,UseMe ;Set name only, so value is ©

VAR V3=200 ;No name, initialise to a value

VAR V4 ;No name, initialised to ©

VAR V56 ;No name, the pre-defined VDigIn is cleared

When a variable is used in place of a bit pattern in a digital input or output instruction, bits 15 to 8 and bits 7 to
0 have different uses. In the expressions that describe these operations we write vn (7-0) and vn (15-8) to
describe which bits are used. BAND means bitwise binary AND (if both bits are 1, the output is 1, otherwise 0),
BXOR means bitwise exclusive OR (if both bits are different the output is 1, otherwise 0)

When a variable is used in place of a voltage value in a DAC or ADDAC output instruction, the full 32-bit range
of the sequencer variable value corresponds to the full range of voltages that can be generated by the DAC, so
-2147483648 corresponds to the lowest possible output voltage (-5 or -10 volts), 0 corresponds to a 0 output
and 2147483647 corresponds to the highest possible output voltage.

When used in the DACn or ADDACH instructions, only the lower 16 bits of each value are used, so the value -
32768 (0x8000) corresponds to the lowest possible output, 0 corresponds to a 0 output and 32767 (0x7{ff)
corresponds to the highest output. Adding multiples of 65536 (0x10000) to the variable value has no effect on
the output.

When used in one of the cosine output angle instructions, the 32-bit variable range from 2147483648 to
2147483647 represents -180 up to +180 degrees. The vVarvalue script in the Scripts folder calculates
variable values for the digital and the cosine instructions.

Prior to version 7, you could change the name of a variable part-way through a sequence. From the point of the
change, the old name was hidden. This now generates a multiply defined error.

Script access to variables

Scripts can set and read the variable values with the SampleSegVvar () script command. You can set initial
values from the script as long as you set the values after you create the new data file, but before you start
sampling. Values set in this way take precedence over values set by the VAR directive.

Constants

It is often useful to define a numeric value as a named constant. For example, when referencing a table value
[V1+Slope] is easier to understand than [v1+23]. It also helps to maintain code; if you need to change a
numeric value that is used often make it a named constant and just change the constant once. The = directive
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does not generate any instructions, it just makes a name equivalent to a number, and the name can be used
anywhere a numeric expression is valid. The syntax is:

name = expr ;comment

The name must start with an alphabetic character and can contain alphabetic characters and the digits 0 to 9.
The name can be up to 8 characters long. Numeric constant names are not case sensitive and must not clash
with label, instruction, variable or built-in function names. Examples of use:

Waitl = ms(100)
Wait2 Wait1*1.3
DELAY Waitl-1 ;Use constant in an instruction

The expression values are calculated and stored as floating point numbers. If they are used in a context that
requires an integer value, the fractional part of the number is ignored.

The = directive was added at version 7.00.

The SET SCLK and SDAC directives

These directives control the interval between sequencer clock ticks and the DAC output units. Directives are
not part of the sequence and do not occupy a step. These directives should occur before any step-generating
code. The scLK and SDAC directives were added at version [6.03] to separate setting the tick rate from setting
the DAC output units.

SET msPerStep, DACscale, DACoffset
SCLK  msPerStep
SDAC DACscale, DACoffset

The msPersStep field sets the milliseconds per step in the range 0.004 to 3000. The table shows the minimum
step times and timing resolution for each type of 1401. To ensure accurate timing, msPerStep must be an
integral multiple of Resolution or Spike2 will not sample. This is checked each time Spike2 samples data.

Power3 Power1-2 Micro2-3 Micro4

Minimum step (ms) 0.004 .010 .010 0.004
Resolution (ms) .001 .001 .001 .001

If there is no SET or SCLK directive, the sequence runs at the default rate, which is 10 milliseconds per step
unless the script command SampleSeqClock () has changed it. If there is no SET or SDAC directive,
DACScale is 1 and DACOffset is 0 for a £5 Volt system and DACScale is 2 for a £10 Volts system. The
sequencer expression functions s (), ms (), us (), Hz () and VHz () use the msPersStep value. If you use these
functions, the SET or SCLK directive must occur first in the sequence.

DAC scaling

The DACs in the 1401 are implemented so that the full range maps onto the full range of 16-bit signed integer
numbers (-32768 to +32767). If you have 16-bit DACs a change of 1 changes the output by the smallest step
possible. With 12-bit DACs (Micro1401 mk II), the smallest step is a change of 16. For most purposes, it is
easier to work in units such as Volts or millivolts rather than these DAC units. However, the 1401 works in
DAC units and if you set DAC values using variables, the variable values are based on DAC units. In the SET
and SDAC directives, the DACscale and DACoffset fields define the conversion from user units into DAC
units. The standard values of 1.0 for the scale and 0.0 for the offset make the full scale DAC values run from —5
to +4.99985. As most systems have +5 Volt analogue systems, the standard scale and offset let you work with
the DACs in Volts.

DACScale The number of user units that correspond to an output change of 6553.6 DAC units (1 Volt for a
+5 Volt system, 2 Volts for a £10 Volt system). The standard value 1.0 is used if you omit
DACScale. To work in millivolts, set the scale to 1000.

DACOffset The user units that correspond to 0 DAC units (0 Volt output). The standard value 0.0 is used if
you omit DACOf fset.

Please remember that DACScale and DACOffset do not change the DAC outputs in any way. They are a
convenience to allow you to enter values in units that are appropriate to your application. The sequencer
expression functions VDAC16 () and VDAC32 () use DACScale and DACOffset, so they must come after the
SET or SDAC directives.
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For example, consider the case where the DACs drive a patch clamp amplifier where a change of 2.5 Volts into
the amplifier causes a 200 mV potential at the cell and 0 Volts into the amplifier is 0 mV at the cell. For a +5
Volt system, 2.5 Volts is 16384 DAC units, so DACScale is 200 * 6553.6/16384, which is 80. DACOffset
is 0, as an output of 0 produces 0 mV at the cell.

If you have both £5 and +10 Volt systems, and you want to specify the output in Volts, you can use:
SDAC  DRange()/5, ©

which will set the DACScale value to 1.0 on a £5 Volt system and to 2.0 on a +£10 Volts system.

Table of values

From Spike2 version [5.06] onwards the sequencer supports a table of 32-bit values.

Declaring the table
You declare that a table exists with the TABSZ directive, which normally occurs at the start of your sequence:

TABSZ expr

Where expr is an expression that sets the number of items in the table. The table size must evaluate to a
number in the range 1 to 1000000. Each table item is a 32-bit integer and uses 4 bytes of 1401 memory. The
maximum size in a 1401 with IMB of memory, and assuming that there is no arbitrary waveform output, is
around 150000 items. If your 1401 has more memory, you have potentially more table space. The first table
item has an index number of 0, the second item is index 1, and so on.

Setting table data

From the script language you can move data between an integer array and the table with the
SampleSegTable () function. You can also preset table data from the sequence with the TABDAT directive,
which must come after the TABSZ directive:

TABDAT expr
TABDAT expr,expr,expr...

Where expr is an expression that evaluates to a 32-bit integer. Each TABDAT directive adds data to the table,
starting at the beginning. The sequencer compiler will flag an error if you define more data that will fit in the
table. Table data declared in this way is stored separately from the sequence and is transferred to the 1401 when
you create a new data file to sample. If you do not set the table data with the TABDAT directive or from a script,
the values in the table are undefined.. The TabPos () expression has the value of the number of data items that
have been defined at the point where it is used. For example:

TABDAT TabPos() ;a table item that holds its own index.

Accessing table data

Although you can move data between one of the variables and the table with the TABLD and TABST instructions,
many instructions access the table directly. It takes more time to use a table than to use a variable (this is not
usually significant).

All references to the table use the contents of one of the variables as an index into the table plus an optional
offset as: [Vn] or [Vn+off] or [Vn-off]. The offset of f is an expression that evaluates to a number in the
range —1000000 to 1000000. For example, if v1 holds 10, [v1] refers to the contents of index 10, [V1-10]
refers to index 0 and [v1+10] refers to index 20. Out of range table indices read 0 and are non-destructive.

The TABINC instruction makes it easy to increment a variable used as a table index and branch until the
increment generates an index outside the table. The following example generates five DAC outputs at 5
different intervals:

SET 1,1,0 ; lms per step, normal scales

3
TABSZ 10 ; table of 10 items
oMs = TabPos () ; offset to milliseconds
TABDAT ms(1000)-3 ; 1000 ms in sequencer steps-3
oVolt = TabPos () ; offset to Volts
TABDAT VDac32(1) ; 1 Volt
oNext = TabPos () ; offset to next set of entries
TABDAT ms(100)-3,VDac32(2) ; 100 ms, 2 Volts
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TABDAT ms(50)-3,VDac32(3) 5 50 ms 3 Volts
TABDAT ms(500)-3,VDac32(-1) ; 500 ms -1 Volt
TABDAT ms(200)-3,VDac32(0) ; 200 ms © Volts

MOVI V1,0 ; use V1 as table index, set ©
TLOOP: DELAY [V1+oMs] ; programmed delay

DAC 0, [V1+oVolt] ; set DAC @ to the value

TABINC V1,oNext, TLOOP ; add 2 to V1, branch if in table

In this case, we could just as easily have set oMs to 0, ovolt to 1 and oNext to 2, or used the values 0, 1 and 2
in the code. However, by using constants, we make it easy to extend the number of items per step. For example,
if we decided to insert a new value in the table, making three items per step, we could do so without having to
work through our code to check if each occurrence of 0, 1 or 2 was correct or needed changing.

Long data sequences

To output a very long data sequence, you can use the table as a buffer. The basic idea is to divide the table into
two halves and use the SampleSeqTable () script command to transfer new data into the half of the table that
the sequence is not using. To find out where the sequence has reached, look at the value of the variable used as
an index with SampleSeqvar (). Set a large enough table size so that the time taken to use half the table is
several seconds.

Including files

There are times when you will want to reuse definitions or code in multiple projects. You could do this with
copy and paste, but it can be more convenient to use #include to include files into a sequence. A file that is
included can also include further files. We call these nested include files. Only the first #include of a file has
any effect. A subsequent #include of the same file is ignored. This prevents problems with files that include
each other and stops multiple definitions when two files include a common file. The #include command must
be the first non-white space item on a line. There are two forms of the command:

#include "filename" ;optional comment
#include <filename> ;optional comment

where filename is either an absolute path name (starting with a \ or / or containing a :), for example C:
\Sequences\MyInclude.pls, or is a relative path name, for example include.pls. The difference
between the two command forms lies in how relative path names are treated. The search order for the first form
starts at item 1 in the following list. The search for the second form starts at item 3.

The folder where the file with the #include command lives. If this fails...

The folder of the file that included that file up to the top of the list of nested include files. If this fails...

Any \include folder in the Spikel1l folder inside your My Documents folder . If this fails...

Any \include folder in \Users\Public\Public Documents\SpikellShared. If this fails...

Any \include folder in the folder in which Spike?2 is installed. If this fails...

6. Search the current folder.

kb=

Included files are always read from disk, even if they are already open. If you have set the Edit menu
Preferences option to save modified scripts and sequences before running, modified include files are
automatically saved when you compile. If this option is not set, the output sequencer compiler will stop with an
error if it finds a modified include file. You must save the included file to compile your sequence.

There are no restrictions on what can be in an included file. However, they normally contain constant and
variable definitions and possibly user-defined code. It is usually a good idea to put all #include commands at
the start of a sequence file so that anyone reading the source is aware of the scope of the sequence.

The #include command for output sequences was added to Spike2 at version 7.00 and is not recognised by
any version before this. A typical file using #include might start with:

#include <sysinc.pls> ;my system specific includes
#include "include/proginc.pls" ;search relative to source folder
set 1,1,0 ;start of my code...
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Opening included files
If you right-click on a #include command line, and Spike2 can locate the included file, the context menu will
hold an entry to open it. The search for the file follows that described above, except that it omits step 2.

Errors in included files

If an error is detected during the compilation of an included file, an error message is displayed at the top of the
original window indicating which included file has a problem, and the included file is opened (if it can be
found) and the offending line is highlighted.

Changing the sequence during sampling

As long as sampling starts with a text or graphical sequence running, it can be replaced during sampling. The
Sampling menu Change Output Sequence command lets you choose a text sequence file on disk and the
Current button in the Sequence editor sets the current document as the sequence. When sampling starts, Spike2
allocates sufficient space in the 1401 for the first sequence and for any table space it uses. If you want to load
sequences during sampling that are larger or needs more table space you must reserve space using the
Sequencer tab of the Sampling configuration dialog.

When a new sequence loads, all DAC values, digital output values, variable and table values are preserved
except variables that are given initial values by the VAR directive and table values that are given values with the
TABDAT directive.

Sequencer instruction reference

Each instruction is followed by an example. The examples show a preferred format, however the system is
flexible. For example, a comma should separate arguments, but a space is also accepted. The patterns used for
digital ports should be enclosed by square brackets, however you may omit the brackets if you wish.

Many of these instructions allow you to use a variable or a table entry in place of an argument. In this case, the
alternatives are separate by a vertical bar, for example:

DELAY expr|Vn|[Vn+off],OptLB

This means that the first argument can be an expression, a variable or a table entry. There is no explicit
documentation for the use of the table, except in TABLD and TABST. Where table use is allowed it is written as
[Vn+off]. If you use a table value in an instruction, the effect is exactly the same as using a variable with the
same value as the table entry.

Changes at [11.00]

You can now branch and jump relative to the current instruction +n or -n (n is the number of steps) in place of
a label name to branch to n steps after or before the current step. To loop on the current instruction you can use
+0 or -0. This can be used anywhere that an instruction description uses LB or OptLB.

There are new expression functions Ceil (), Floor (), Round () and Trunc ().

Digital 1 O

These instructions give you control over the digital output bits and allow you to read and test the state of digital
input bits 7-0.

DIGOUT Write to digital output bits 15-8

DIGLOW Write to digital output bits 7-0

DIBNE, DIBEQ Read digital input bits 7-0, copy to V56 test and branch
DISBNE, DISBEQ Test last read digital inputs (in v56) and branch

WAIT Wait for a pattern on the lower 8 digital inputs

(DIGIN) Read and test digital inputs

(BZERO, BNZERO) Branch as result of DIGIN test

DIGPS Play a digital pulse sequence independently of the sequencer
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DIGPC
DIGPBR

DIGOUT

Control the sequence started by DIGPS.
Branch on the state of the DIGPS sequence

The DIGOUT instruction changes the state of digital output bits 15-8. The output changes occur at the next tick
of the output sequencer clock, that is, they are precisely timed (unlike DIGLOW).

pattern

OptLB

DIGOUT [pattern]|Vn|[Vnzoff],OptLab

This determines the new output state. You can set, reset or invert each output bit, or leave a bit in
the previous state. The pattern is 8 characters long, one for each bit, with bit 15 at the left and bit 8
at the right. The characters can be “0”, “1”, “i” or “.” standing for clear, set, invert or leave alone.
You may omit the square brackets, however the Format command will insert them.

DIGOUT [....001i] ;clear bits 3 and 2, set 1, invert ©
DIGOUT [....... i] ;invert @ again to produce a pulse
DIGOUT Vie ;use variable V10 to set the pattern

With a variable the new output is: (old output BAND Vn(7-0)) BXOR Vn(15-8). The
variable equivalent of [....001i] is 241+256*3,andof [....... i] is 255+256*1. If you use
a table value, set the same value in the table that you would use for a variable. You can use the
VarValue script in the Scripts folder to calculate variable or table values.

If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example produces ten 1 millisecond pulses 100 milliseconds apart.

LOOP:

DIGLOW

SET 1 s;run at 1 ms per step

MOVI V1,10 ;V1 holds the number of pulses
DIGOUT [....... 1] ;bit @ high >Pulsing
DIGOUT [....... 0] ;bit o low >Pulsing
DELAY ms(100)-4 ;4 inst in the loop >Pulsing
DBNZ V1, LOOP ;count down >Pulsing
HALT ;finished >Done

DIGLOW changes the state of the 1401 digital output bits 7-0. Unlike DIGOUT, the output changes occur
immediately, they do not wait for the next sequencer clock tick. You can take advantage of this to change all 16
digital outputs almost simultaneously (within a few microseconds) by using DIGOUT followed by DIGLOW.

pattern

OptLB

DIGLOW [pattern]|Vn|[Vn+off],OptLB

This determines the new output state. The pattern is 8 characters long, one for each bit, with bit 7 at
the left and bit 0 at the right. The characters can be “0”, “1”, “i” or “.” standing for clear, set,
invert or leave alone. You may omit the square brackets, however Format will insert them.

DIGLOW [....001i] ;clear bits 3 and 2, set 1, invert ©
DIGLOW [....... i] ;invert @ again to produce a pulse
DIGLOW V1o ;use variable V10 to set the pattern

With a variable the new output is: (old output BAND Vn(7-0)) BXOR Vn(15-8). The
variable equivalent of [....001i] is 241+256*3,andof [....... i] is 255+256*1. If you use
a table value, set the same value in the table that you would use for a variable. You can use the
VarValue script in the Scripts folder to calculate variable or table values.

If this label is present it sets the next instruction, otherwise the next sequential instruction runs.
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DIBEQ DIBNE

These instructions test digital input bits 7-0 against a pattern. DIBEQ branches on a match. DIBNE branches on
no match. Both instructions copy digital input bits 7-0 to V56 (VDigIn), for use by DISBEQ and DISBNE.

pattern

Vn

LB

DIBNE [pattern] |Vn| [Vn+off],LB
DIBEQ [pattern] |Vn| [Vn+off], LB

9

This is 8 characters, one for each input bit. The characters can be “0”, “1” and “.” meaning match 0
(TTL low), match 1 (TTL high) or match anything. The bit order in the pattern is [76543210]. You
may omit the square brackets, however the Format command inserts them.

With a variable (input BAND Vn(7-0)) BXOR Vn (15-8) is O for a match, else is not a match.

The branch destination label if the input is a match (DIBEQ) or is not a match (DIBNE). From [11.00]
you can use +n or -n (n is the number of steps) to branch to n steps after or before the current step.

This example waits for a pulse sequence in which the falling edges of two consecutive pulses are less than
2*v1+2 sequencer clock ticks apart. It waits for a falling edge, waits for a rising edge with a time out and then
waits for the next falling edge with a time out. If timed out, we start again. If the input signal has high states less
than three ticks wide, or low states less than 2 ticks wide, this example may miss them.

WHI :
SETTO:
WLO:
TOHI:

TOLO:

GOTIT:

DIBNE [eenennn 1],WHI ;wait until high >Wait high
MOVI V1,24 ;set 50 step timeout >Wait low
DIBNE [eenennn 0],+0  ;wait for falling >Wait low
DIBEQ [....... 1],TOLO ;wait for high >Wait high
DBNZ V1, TOHI ;loop if not timed out >Wait high
JUMP WHI ;timed out, restart >Restart

DIBEQ [....... 0],GOTIT;jump if found events >Wait low
DBNZ V1,TOLO ;loop if not timed out >Wait low
JUMP SETTO ;timed out, restart >Restart

s;here for 2 close pulses

DISBEQ DISBNE

These instructions test digital input bits 7-0 read by the last DIBEQ, DIBNE or WATIT against a pattern. DISBEQ
branches on a match. DISBNE branches if it does not match.

pattern

LB

DISBNE [pattern]|Vn|[Vn+off],LB
DISBEQ [pattern]|Vvn|[Vn+off],LB

6

This is 8 characters, one for each input bit. The characters can be “0”, “1” and “.” meaning match 0
(TTL low), match 1 (TTL high) or match anything. The bit order in the patternis [76543210]. You
may omit the square brackets, however the Format command inserts them.

With a variable (input BAND Vn(7-0)) BXOR Vn (15-8) is O for a match, else is not a match.

The branch destination label if the input is a match (DISBEQ) or not a match (DISBNE). From
[11.00] you can use +n or -n (n is the number of steps) to branch to n steps after or before the
current step.

This example shows a typical use of this instruction. We run trials signalled by external equipment that writes
the trial type to digital input bits 1 and 0; 00 means no trial, 01, 10 and 11 select trial types 1, 2 and 3.

TRWAIT:'W DIBEQ [eeenns 00], TRWAIT ;Wait for trial >Wait...
DISBEQ [...... 01],TRIAL1
DISBEQ [...... 10], TRIAL2
DISBEQ [...... 11], TRIAL3
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WAIT

DIGPS

The WAIT instruction causes the sequence to wait until bits 7-0 of the 1401 digital input match a pattern. The
digital input port is sampled once every sequencer clock tick until the pattern is found, or until the sequence is
sent elsewhere by a keyboard command. WAIT copies digital input bits 7-0 to V56 (VDigIn) for use by DISBEQ
and DISBNE. It is usually a good idea to have a display message explaining what you are waiting for.

WAIT [pattern]|Vn|[Vn+off]

pattern This is the input condition to match before the sequence can continue. It is 8 characters long, one for
each input bit. The characters can be “1”, “0” or “.” indicating that the input bit in that position
must be a one, a zero or don't care. The bits are given in the order [76543210]. You may omit the

square brackets round the pattern if you wish; the Format command will insert them.

WAIT [eeeenns 1] ;wait for bit @ set>Wait for bit ©
WAIT [0...... 0] ;wait for 7 and @ clear>Wait 7&0 low
Vn With a variable, (input BAND Vn (7-0)) BXOR Vn (15-8) must be 0 to continue.

This instruction is shorthand for:

HERE : DIBNE [pattern]|Vn|[Vn+off],HERE

This command together with DIGPC (to start and stop output and clear the pulse cycle flag) and DIGPBR (to test
for start of pulses and output done) were added at [10.06] to generate trains of digital output pulses that run
independently of other sequencer operations. Pulses are on digital output bits 15-8 (9-8 for Micro2 and
Micro3); these are the same bits that are controlled by the DIGOUT instruction. The output is defined in pulse
cycles. The digital output sets at the start of each pulse cycle and clears after a duration. The cycle length and
pulse duration are set in sequencer steps. By default, set means high output and clear means low, but you can
choose to invert the output state. Output changes are calculated at the start of each sequencer step and occur on
the sequencer clock tick after the step that changes them. If you HALT the sequencer, the output stops.

— +—— Cycles —— >
= ‘«Duration : <— Interval —»
Output { { { { :

Runflag |

StepS | — 1 T 1 T T T 1 T T T T T 1 T T T T 1T i 1
Cycle flag set A : A A :

DIGPS prepares the digital pulses for running and adjusts the state of the pulse output. Pulses are defined by
four parameters: the interval between repeats of the pulses, the duration of each pulse, the direction of the
pulses and the number of pulses.

DIGPS n,op,value[Vn|[Vn+off],OptLB

n The output channel to use in the range 0-7 corresponding to the digital output bits 8-15. 0 and 1 will
appear on the 1401 front panel unless routed to the rear panel. The Micro2 and 3 support only
channels 0 and 1.

op From 1-2 option characters. One of these must be s, P, I, D or C. There is an optional flag: R
intended to qualify the s and P options but can be used with the other options.

value The number of sequencer steps to set for the S, P, T or D options or the number of cycles to run for
in the C option. You can also use a variable or a table entry to provide this parameter.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

Options characters
You must include one of the following options:

op value Purpose
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DIGPC

S Interval Set up a square wave. value sets the repeat interval in sequencer steps. The pulse
duration is set to value/2 steps. This resets the command so that a pulse starts
immediately when told to go (or on the next step if already running). This does not
change the cycle count (use the R flag to reset it so that the pulse train runs for 232
cycles).

P Interval Sets up a pulsed output. value sets the repeat interval in sequencer steps. The pulse
duration is set to 1 step. This resets the command so that a pulse starts immediately
when told to go (or on the next step if already running). This does not change the cycle
count (use the R flag to reset it so that the pulse train runs for 232 cycles).

I Interval Changes the interval between pulses and has no other effect (does not change the
duration). If used while the output is running it has no effect until the end of the current
pulse cycle. If you set the interval to the same or less than the duration the output will
not clear. If you intend to change the interval dynamically you should probably set a
pulse duration of 1 (P option).

D Duration Changes the width of each pulse and has no other effect. Setting the width greater than
or equal to the interval will not work. Changing the width while running is not
recommended as it can cause an extra long pulse.

C  Cycle count Change the number of cycles to be done. Setting a cycle count of -1 sets 232 cycles,
which will run for a long time (this is what the R flag does). Setting the count to n while
running requests n more cycles after the current cycle ends. Setting the count to 0 while
running stops output at the end of the current cycle.

The flag character is:

R Reset the cycle count to the maximum value (more than 4 billion cycles, effectively run forever).

Use of the commands

We expect you to use one the S or P option first to prepare to output a pulse train. This is likely followed by the
C option to set the number of cycles unless you want to run until stopped. You start the train with the DIGPC
n, G command. You can test the state of the output with the DIGPBR command. To run continuously until
stopped you might use:

DIGPS ©,SR,s(1) ;Square wave, 1 Hz, run continuously

DIGPC 0,G ;Start (output changes 2 steps later)
DIGPS 0,C,0 ;Request stop at end of current cycle
WEND: DIGPBR ©,S,WEND ;Wait for stopped > Wait for stop

To run a fixed number of cycles you could use:

DIGPS ©,P,ms(50) ;1 step pulse every 50 milliseconds
DIGPS 0,C,4 ;Run 4 cycles
DIGPC ©,G ;Start

Performance considerations

Each channel of output consumes 1401 time at the start of each sequencer step (in the same way as sinusoidal
output and RaMP output). The overhead per channel per step is similar to the RAMP instruction and less than the
sinusoidal output.

The D1GPC command (DIGital Pulse Control) enables and disables the pulse train output and clears the pulse
cycle start flag. This command together with DIGPS (to set pulse train parameters) and DIGPBR (to test for start
of cycles and output done) were added at [10.06] to generate trains of digital i/o pulses.

DIGPC n,op,value,OptLB

n The output channel to use in the range 0-7 corresponding to the digital output bits 8-15. 0 and 1 will
appear on the 1401 front panel unless routed to the rear panel. The Micro2 and 3 support only
channels 0 and 1.
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op From 1-2 case insensitive option characters that must include one of: G to start the pulse train, S to
stop the pulse train or C to clear the pulse cycle flag. There is an optional flag character: I to invert
the output, used with the G option.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

G Enable train

The G option enables the pulse train for the output channel (if not already enabled). When used after the DIGPS
S or P options, the next sequencer step will set the output, but the effect of this is synchronized to the following
sequencer clock tick, so the output changes 2 sequencer steps after the G option is used. When used after the
DIGPC s option the sequencer resumes from wherever it had just reached.

S Suspend train
The S option suspends the pulse train. You can resume it from the same state with the G option.

C Clear pulse cycle flag
The cycle flag is set at the start of each output cycle, one sequencer step before the output changes. The C
option clears the cycle flag (it is also cleared by testing it with the DIGPBR n, C command).

| Invert output

Normally, the designated output goes high at the start of each cycle and low after the pulse duration. If you
include this flag with the G option, the output goes low at the start of each cycle and high after the duration. The
flag is ignored with the S and C options.

DIGPBR

The DIGPBR command (DIGital pulse BRanch) tests if the pulse train is running and the state of the cycle flag.
This command together with DIGPS (to set pulse train parameters) and DIGPC (to control the pulse train) were
added at [10.06] to generate trains of digital i/o pulses.

DIGPBR n,what,Label

n The output channel to use in the range 0-7 corresponding to the digital output bits 8-15. 0 and 1 will
appear on the 1401 front panel unless routed to the rear panel. The Micro2 and 3 support only
channels 0 and 1.

what A single character, one of C to test the cycle flag or S to test for stopped.

Label Where to branch to if the condition tested is not true.

C flag

If you test the new cycle flag, the branch is taken if the pulse train is running and the cycle flag is not set. The
sequence continues to the next instruction if the pulse train is not active or if the new cycle flag is set. This
instruction also clears the new cycle flag. Note that the cycle flag sets one sequencer step before the output
changes.

S flag
If you test the S (Suspended) flag, the branch is taken if the pulse train is running and runs the next instruction
if the pulse train is not running.

Example
The following sequence runs 4 cycles of pulses at 1 second intervals, waiting for the first 3 pulses, then waiting
for the sequence to end:

SET  1,1,0

DIGOUT [....... 9] ;Set initial state
'G DELAY s(2) ;Delay 2 seconds
DIGPS 0,P,s(1) ;Pulse every second
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DIGPS 0,C,4 ;Run 4 cycles
DIGPC ©,G ;Go
Wo: DIGPBR ©,C,W0 ;C flag will be set so no wait
W1: DIGPBR 0,C,W1 ;Wait 1 second here
W2: DIGPBR 0,C,W2 ;Wait 1 second here
WE: DIGPBR ©,S,WE ;Wait 2 seconds here

DIGIN BZERO BNZERO

These obsolete instructions are provided for backwards compatibility. DIBNE and DIBEQ are more efficient.
DIGIN reads digital input bits 7-0, compares them with a pattern and saves the result. The result can be tested
with the branching instructions BZERO and BNZERO. The comparison result is saved until the next DIGIN.

DIGIN [pattern]|Vn|[Vn+off] ;Test input state
BZERO LB ;branch to LB if result is zero
BNZERO LB ;branch to LB if result non-zero

I3

pattern This is 8 characters, one for each input bit in the order [76543210]. The characters can be “.”,
“0”, “1” and “c”. For “0” or “1”, the result for that bit is O if the input bit was the same, or 1 if it
was different. “c” means copy the input bit to the result (this is the same as “0”"). The result for “.”
is always zero. You may omit the square brackets round the pattern, however the Format command

will insert them.

Vn With a variable the result is (input BAND Vn(7-0)) BXOR Vn (15-8). The variable equivalent
of [0.c0110.]1s 190 + 256*12. The varvalue script calculates values equivalent to patterns.

LB The branch destination if the last DIGIN produced a zero (BZERO) or non-zero (BNZERO) result.
From [11.00] you can use +n or -n (n is the number of steps) to branch to n steps after or before the
current step.

Loop: DIGIN [©.c0110.] s;assume input is 01101011
BZERO GoOn ;result is 00100110 so no branch
BNZERO Loop ;This will branch

GoOn:

DAC outputs

The output sequencer supports up to 8 DAC (Digital to Analogue Converter) outputs. The Power1401 has four
DACs and the Microl1401 has two. However, the Power1401 can be expanded with up to 8 DAC outputs and
the Micro4 with up to 4. The last value written to DACs 0-7 is stored in variables V57-v64 (you can also refer
to these variables as VDACO0-VDAC7). The values are stored as 32-bit numbers with the full 32-bit range
corresponding to the full range of the DAC. This high resolution allows us to ramp the DACs smoothly. If you
write to a DAC that does not exist in your 1401, the variable associated with the DAC is set as if the DAC were
present.

Constant values written to the DACs are expressed in units of your choice. The SET or SDAC directive
determines the conversion between the numbers you supply and the DAC outputs. The standard settings for a
system with £5 Volts DACs is to set the DAC outputs in Volts. If you use sequencer variables to update the
DACs, you must scale the user units into suitable values; see the DAC and ADDAC instructions for details.

The Power1401 DAC 2 and 3 outputs are on the rear panel 37-way Cannon D type Analogue Expansion
connector. DAC 2 is pin 36 and DAC 3 is pin 37. Suitable grounds are on adjacent pins 18 and 19. If you have
a Power1401 top-box with additional front panel DACs, the two rear DACs are mapped to the two highest
numbered DACs. For example, with a 2709 Spike2 Top Box, DACs 2 and 3 are available as front panel BNC
connections, and the rear panel DACs become DAC 4 on pin 36 and DAC 5 on pin 37.

DAC Set DAC value (for DACs 0-7)

(DACn) Version 3 compatible, set DAC n (0-3) to a value

ADDAC Increment DAC by a value

ADDACn Version 3 compatible, increment DAC n (0-3) by a value
RAMP Set automatic DAC ramping to a target value
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DAC ADDAC

The DAC instruction can write a value to any of the 8 possible DAC outputs. The ADDAC instruction adds a value
to the DAC output. The output value changes immediately unless the DAC is in use by the arbitrary waveform
output, in which case the result is undefined.

DAC n,expr|Vvn|[Vn+off],OptLB
ADDAC  n,expr|Vn|[Vn+off],0ptLb

n The DAC number, in the range 0-7. Variable 57+n is set to the new DAC value such that the full
DAC range spans the full range of the 32-bit variable.

expr The DAC value to write or to add. The value units depend on the SET or SDAC directive; the
standard units are Volts. It is an error to give a value that exceeds the DAC output range.

Vn When a variable is used, the full range of the 32-bit variable corresponds to the full range of the
DAC. You can use the VvDAC32 () function to load a variable with a constant value using user-
defined DAC units. See the script example, below, to calculate non-constant values.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example sets DAC 2 to 0 Volts, then ramps it to 4.99 Volts in 1 second using steps of 0.01 Volts. The
example also shows how to do the same ramp using variables. You can also use RAMP to ramp a DAC.

SET 1,1,0 ;1 ms per step, DAC scaled to Volts
'R DAC 2,0 ;Ramp @ to 5 >Ramping
MOVI V1,499 ;499 steps >Ramping
RAMP1: ADDAC 2,0.01 ;0.01V increment >Ramping
DBNZ V1,RAMP1 s;count increments >Ramping
HALT ;task finished >Done

'V MOVI V3,VDAC32(9) ;Use variables >Ramping
MOVI V2,VDAC32(@.01) ;increment in V2 >Ramping

MOVI V1,499 ;499 steps >Ramping
DAC 2,V3 ;set initial value>Ramping
RAMP2: ADDAC 2,V2 ;add increment >Ramping
DBNZ V1,RAMP2 s;count increments >Ramping
HALT ;task finished >Done

It is a property of the signed integer numbers we use that if you add 1 to the maximum possible positive
number, the result is the minimum possible negative number. If you use ADDAC repeatedly to add the same
value, eventually you will run off the end of the DAC range and come back in at the other end.

Physical DAC units run from -32768 to +32767. In a +5 Volt system with 16-bit DACs, this is -5.0000 to
+4.99985 Volts. The DAC unit value for +5 Volts is +32768, but this number does not exist in 16-bit signed
integers and wraps around to -32878. Because it often happens that users want to set the DAC to full scale, for
the DAC command used with expr (not with vn), we change requests to set +32768 units to set -32767 units.
When used with a variable (vn), the top 16 bits of the 32-bit variable are physical DAC units, the lower 16 bits
provide extra accuracy when ramping the DACs.

This script shows how to convert a user value into a value that can be assigned to a sequencer variable for use
in the DAC and ADDAC sequencer commands.

const DACScale := 1.0; 'Values for user DAC units 1in Volts
const DACOffset := 0.0; 'on a 5V 1401

"Convert a value in user units to a 32-bit DAC value
Func Dac32%(user)

const dMin := -32768%*65536, dMax := 32767*65536;
var d32 := (user - DACOffset)*6553.6*65536/DACScale; 'DAC value as 32-bits
if _Version >= 1017 then
d32 := Clamp(d32, dMin, dMax); " If using Spike2 10.17 or Llater
else
d32 := (d32 > dMax) ? dMax : ((d32 < dMin) ? dMin : d32); ' older
endif
return round(d32);
end;
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Unlike the digital outputs, the DAC output changes when the instruction runs, not at the next sequencer clock
tick. This means that the changes may have a time jitter of a few microseconds.

DACn ADDACn

RAMP

These commands provide backwards compatibility with old Spike2 versions and should be avoided in new
sequences. The DACn and ADDACn commands (with n = 0, 1, 2 or 3) set and change the 1401 DAC outputs.
expr is the new DAC output level, or change in level. Variable 57+n is set to the new DAC value such that the
full DAC range spans the full range of the 32-bit variable. These commands do not support table use.

DACn expr|vn,OptLB
ADDACn  expr|Vn,OptLB

expr The value to assign to DAC n (DACn instruction) or to add to the output level (ADDACH instruction).
The units of the DAC values are usually Volts, but can be changed by setting a scale factor with SET
or SDAC.

Vn Variable values -32768 to 32767 correspond to the full DAC range. You can use VDAC16 () to load

a variable using user-defined DAC units. See the script example, below, to calculate non-constant
values or the varvalue script. The value saved in V57+n is Vn*65536.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

The important difference between these commands and DAC and ADDAC is where a variable is used. The
bottom 16-bits of the variable are written to the DAC. In the case of the DAC and ADDAC commands, the upper
16 bits of the variable are written to the DAC. This command is sometimes useful with the CHAN command
when reading a waveform or a DAC channel, as it reads values in the range -32868 to 32767.

This script converts a value in user units to a value that you can assign to a script variable for use in the DACn
and ADDACn sequencer commands.

const DACScale := 1.0; 'Values for user DAC units in Volts
const DACOffset := 0.0; 'on a 5V 1401

'Convert a value in user units to a 16-bit DAC value
Func Dacl6%(user)

var d16 := (user - DACOffset)*6553.6/DACScale; 'DAC value as 16-bits
if _Version >= 1017 then

dié := Clamp(di6, -32768, 32767); " If using Spike2 10.17 or later
else

die := (dle6 > 32767) ? 32767 : ((d16<-32768) ? -32768 : di16); ' older
endif
return round(d16);
end;

This command starts a DAC ramping, with automatic updates on every sequencer step. If the DAC was
generating cosine output, the cosine output stops. The DAC ramps from the current value until it reaches a
target value, when the DAC cycle flag sets. You can use WATITC to test for the end of the ramp. The RATE
instruction stops a ramp before it reaches the target value.

RAMP n,target|Vn,slope|Vs|[Vs+off]
n The DAC number in the range 0-7 for the Power1401 or 0-1 for the Micro1401.

target This is the DAC value at which to end the ramp. The units of the DAC values are usually Volts, but
can be changed by setting a scale factor with SET or SDAC.

Vn When a variable is used for the target, the full range of the 32-bit variable corresponds to the full
range of the DAC. You can use the VvDAC32 () function to load a variable using user-defined DAC
units.

slope This expression sets the DAC increment per sequencer step. The sign of the value you set here is
ignored as the sequencer works out if it must ramp upwards or downwards to achieve the desired
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target value. If your DAC is calibrated in Volts, to achieve a slope of 1 Volt per second, use
1.0/s(1.0) for the slope.

Vs You can also set the slope from a variable or by reading it from the table. In this case, the full range
of the 32-bit value represents the full range of the DAC. The absolute value of the 32-bit value is
used to change the DAC on each step. To get a slope of 1 user unit per second, us
VDAC32(1.0) /s (1.0) as the value.

This example ramps the DAC 1 from its current level to 1 Volt over 3 seconds, waits 1 second, then ramps it
down to 0 Volts over 5 seconds.

RAMP 1,1.0,1.0/S(3) ;start with zero size
s;other instructions during ramp
WT1: WAITC 1,WT1 swait for ramp to end >Ramp to 1

DELAY S(1)-1 ;wait for a second >Wait 1 sec
RAMP 1,0,1.0/S(5) ;ramp down
WT2: WAITC  1,WT2 swait for ramp >Ramp to @

The OFFSET command has an example that uses RAMP with cosine waves.

Arbitrary waveform output
You cannot use this command to ramp the output after arbitrary waveform output as it does not save the last
value output to each DAC for performance reasons.

Cosine output control instructions

The sequencer can output cosine waveforms of variable amplitude and frequency through Power1401 DACs 0
to 7 and Microl401 DACs 0 and 1 (and 2 and 3, if fitted in a Micro4). Attempts to use unimplemented
Mirco1401 DACs 2 and 3 are treated as NOP; attempts to use Microl401 DACs 4 to 7 are flagged as errors.
When enabled, the cosine value is computed and output every step; if you HALT the sequencer, the cosine
output will stop. The output (in a 5 Volt 1401) is:

output in Volts = 5 4 Cos(0+¢) + offset

where: A4 is an amplitude scaling factor in the range 0 to 1
0 an angle in the range 0° to 360° that changes each step (set by ANGLE)
) is a fixed phase in the range -360° to 360° (set by PHASE)

offset  a voltage offset set by the OFFSET instruction

0 changes every step by 80. A cycle of the cosine
takes 360/30 steps. You can change the angle
increment immediately, or you can delay the change
until the next time 6 passes through 0°. You can set
00 in the range 0° up to 360° to an accuracy of
about 0.0000001°. With the sequencer running at 1
kHz, you can output frequencies up to 500 Hz with
a frequency resolution of around 0.00012 Hz.
Ideally the output would be passed through a low
pass filter with a corner frequency at one half or less
of the sequencer step rate to smooth out the steps in Cos(0+¢)
the cosine wave.

-180° 90° 0° 90% 180° 270°

By adjusting ¢ you control the output cosine phase where 0 passes through zero. Unless you set the value
(PHASE), it is zero and the zero crossing occurs at the peak of the sinusoid. To have the output rising through 0,
set the phase to —90.

Each time 0 passes through zero a new cycle flag sets. The RAMP, RATEW, RINCW, WAITC and CLRC instructions
clear the flag.

S7 (CSZ,DSZ) Set the cosine output amplitude
SZINC (CSZINC,DSZINC) Change the cosine output amplitude
RATE (CRATE, DRATE) Set the cosine angular increment per step

RATEW (CRATEW, DRATEW)  As RATE, but waits for phase 0
ANGLE (CANGLE, DANGLE) Set cosine angle for the next step
WAITC (CWAIT, DWAIT) Branch until cosine phase 0
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SZ

SZINC

RATE

RINC (CRINC,DRINC) Change the cosine angle increment per step
RINCW (CRINCW,DRINCW) As RINC but waits for phase 0

PHASE (CPHASE,DPHASE) Defines what phase 0 means

OFFSET (COFF, DOFF) Offset for sinusoidal output

CLRC (CWCLR, DWCLR) Clear the new cycle flag

Obsolete commands

Before Spike2 version 5.06, the cosine output instructions supported 2 DACs through the Cxxxx and Dxxxx
instructions. The Cxxxx family used DAC 1 on the Power1401 and Micro1401 and DAC 3 on the 1401plus.
The Dxxxx family used DAC 0 on the Powerl401 and Microl401 and DAC 2 on the 1401plus. The
descriptions include the old forms of the commands, marked Obsolete. The DAC numbers next to obsolete
commands show the 1401plus DAC number in brackets. There are no plans to remove the old commands, but
new sequences should avoid them.

This instruction sets the waveform amplitude. If a wave is playing, the amplitude changes at the next sequencer
step. The amplitude is set to 1.0 when sampling starts.

Sz n,expr|Vn|[Vn+off],OptLB ;DAC n
CSz expr|Vn| [Vn+off],0ptLB ;DAC 1(3) - Obsolete
DSZ expr|Vn| [Vn+off],0ptLB ;DAC 0(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
expr The cosine amplitude in the range 0 to 1. A cosine with amplitude 1.0 uses the full DAC range.
Vn Variable values 0 to 32768 correspond to amplitudes of 0.0 to 1.0; values outside the range 0 to

32768 cause undefined results. If you are getting strange results, check the range of variable
values you are setting.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

These instructions change the waveform amplitude. The change is added to the current amplitude. If the result
exceeds 1.0, it is set to 1.0. If it is less than 0, the result is 0.

SZINC n,expr|Vn|[Vn+off],OptLB ;DAC n

CSZINC expr|Vn|[Vn+off],OptLB ;DAC 1(3) - Obsolete

DSZINC expr|Vn|[Vn+off],OptLB ;DAC 0(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
expr The change in the waveform scale in the range -1 to 1.
Vn A variable value of 32768 is a scale change of 1.0, -16384 is -0.5 and so on.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

You can gradually increase or decrease the wave amplitude. For example, the following increases the amplitude
from zero to full scale (we assume that the waveform is playing):

SZ 0,0.0 ;start with zero size
MOVI V1,100 s;proceed in 1% increments
loop: SZINC 0,0.01 ;a 1% increase

DELAY ms(100)-2 ;show some of the waveform at this size
DBNZ V1,loop ;loop 100 times

This sets the angle increment in degrees per step, which sets the cosine frequency. If the nominated DAC was
ramping, this cancels the ramp. You can stop the cosine output with a rate of 0. Any non-zero value starts the
cosine output.
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RATEW

ANGLE

RATE n,expr|Vvn|[Vn+off],OptLB ;DAC n

CRATE  expr|Vn|[Vn+off],0OptLB ;DAC 1(3) - Obsolete
DRATE  expr|Vn|[Vn+off],OptLB ;DAC 9(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
expr The angle increment per step in the range 0.000 up to 180 degrees. The Hz () function calculates

the increment required for a frequency.

vn For a variable, the value 11930465 is an increment of 1 degree. The vHz () function can be used to
set a variable value equivalent to an angle in degrees.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example starts cosine output at 10 Hz, runs for 10 seconds, and then stops it. This is then repeated using a
variable to produce the same effect:

SET 1,1,0 ;1 ms per step
'C RATE 0,Hz(10) ;start output at 10 Hz
DELAY S(10)-1 ;delay for 10 seconds >Sine wave

X: 'S RATE 0,0 ;stop output
HALT >Stopped
'V MOVI V1,VHz(10) ;set V1 equivalent of 10 Hz
RATE o,V1 ;start at 10 Hz

DELAY S(10)-1,X j;delay then goto exit >Sine wave

This instruction performs the same function as RATE, except that the change is postponed until the next time
Theta passes through 0 degrees. RATEW cannot start output; a sinusoid must already be running to pass phase 0.
It can stop output, but does not remove the overhead for using cosine output. This instruction clears the new
cycle flag (see WAITC).

RATEW n,expr|Vn| [Vn+off] ;DAC n
CRATEW  expr|Vn|[Vn+off] ;DAC 1(3) - Obsolete
DRATEW  expr|Vn|[Vn+off] ;DAC 9(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
expr The angle increment in the range 0.000 to 180 degrees. The Hz () built-in function calculates the

increment required for a frequency.

Vn For a variable, the value 11930465 is an increment of 1 degree. The VHz () function can be used to
set a variable value equivalent to an angle in degrees.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.
This example starts cosine output at 10 Hz, runs for 1 cycle, changes to 11 Hz for one cycle, then stops:

SET 1,1,0 ;1 ms per step

ANGLE 0,0 ;make sure we are at phase 0@

RATE 0,Hz(10) ;start output at 10 Hz

RATEW  ©,Hz(11) ;request 11 Hz next time around
CYCLE10: WAITC ©,CYCLE1@ ;wait for the cycle>10Hz
CYCLE11: WAITC ©,CYCLE1l1 ;wait for the cycle>11Hz

RATE 0,0 ;stop output

This changes the cosine angular position. It takes effect on the next instruction when the angle increment is
added to the value set by this instruction and the result is output.

ANGLE  n,expr|Vn|[Vn+off],0ptLB ;DAC n

CANGLE expr|Vn|[Vn+off],0ptLB ;DAC 1(3) - Obsolete
DANGLE expr|Vn|[Vn+off],0ptLB ;DAC 9(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
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PHASE

OFFSET

expr The phase angle to set in the range -360 up to +360.

Vn For a variable, the value 11930465 is a phase of 1 degree (to be precise, 4294967296/360 is a phase
of 1 degree). The vAngle () function converts degrees into a suitable value for a variable.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example sets the phase angle to —90 degrees directly, and by using a variable. There is no need to use the
VAngle () function; we could have set v1 to —1073741824. However, VAngle (-90) is much easier to
understand.

ANGLE 1,-90 ;set the DAC 1 cosine angle directly
MOVI V1,VAngle(-90)
ANGLE 1,v1 ;set using a variable

This changes the relative phase of the cosine output for the next cosine output. A common use is to change the
output from a cosine (maximum value at phase zero) to sine (rising through zero at phase zero).

PHASE  n,expr|Vn|[Vn+off],OptLB ;DAC n

CPHASE expr|Vn|[Vn+off],0ptLB ;DAC 1(3) - Obsolete
DPHASE expr|Vn|[Vn+off],0ptLB ;DAC 0(2) - Obsolete

n The DAC number in the range 0-7 (available DACs depend on the 1401 type).

expr The relative phase angle to set in the range -360 up to +360. The relative phase is set to 0 when
sampling starts. Set —90 for sinusoidal output.

Vn For a variable, the value 11930465 is a phase of 1 degree (to be precise, 4294967296/360 is a phase

of 1 degree). The vAngle () function converts degrees into a suitable value for a variable.
OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.
This example plays a 1 Hz sinusoidal output (assuming that the output is not running).

PHASE  2,-90 ;set the DAC 2 phase angle directly
ANGLE 2,0 s;prepare to start as a sine wave
RATE 2,Hz(1) ;start the sinusoid

This changes the cosine output voltage offset for the next cosine output.

OFFSET n,expr|Vn|[Vn+off],0OptLB ;DAC n

COFF expr|Vn| [Vn+off],0ptLB ;DAC 1(3) - Obsolete
DOFF expr|Vn| [Vn+off],0ptLB ;DAC 0(2) - Obsolete
n The DAC number in the range 0-7 (available DACs depend on the 1401 type).
expr The offset value for sinusoidal output. The units of this value depend on the SET or SDAC directives;

the standard units are Volts. It is an error to give a value that exceeds the DAC output range.

Vn When a variable is used, the full range of the 32-bit variable corresponds to the full range of the
DAC. You can use the VDAC32 () function to load a variable using user-defined DAC units.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example ramps DAC 0 from 0 to 1 Volt, the runs 5 cycles of a sine wave at 1 Hz, and finally ramps the
data back to 0 Volts.

SET 110 ;1 millisecond per step

DAC 0,0 ;use DAC @ for all output

OFFSET 0,1.0 ;set DAC @ offset

SZ 0,0.2 ;1 V sinusoid

PHASE 0,-90 ;Prepare sinusoid

ANGLE 0,0 ;set start point

RAMP  0,1.0,1.0/s(1) ;ramp to 1 Volt in 1 sec
RAMPUP : WAITC ©,RAMPUP s;wait for ramp >Ramp up
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END:

RAMPDN :

WAITC

RATE ©,HZ(1) ;start sinusoid

DELAY S(4.9) ;Sinusoid >Sine
RATEW 0,0 ;stop at cycle end

WAITC ©,END ;wait for end >Wait end
RATE 0,0 ;stop now

RAMP  0,0.0,1.0/S(1) ;ramp to © Volt in 1 sec

WAITC ©,RAMPDN s;wait >Ramp down
HALT

Each time the phase angle of a cosine passes through 0°, or a ramp terminates, a new cycle flag sets. There is a
separate flag for each DAC. This flag is cleared by CLRC, RATEW, RINCW and when tested by WAITC.

n

LB

WAITC n,LB sDAC n
CWAIT LB ;DAC 1(3) - Obsolete
DWAIT LB ;DAC ©9(2) - Obsolete

The DAC number in the range 0-7 (available DACs depend on the 1401 type).

A label to branch to if the new cycle flag is clear, otherwise the sequencer clears it and continues.

This instruction can produce a pulse one step after the start of each waveform cycle. The following sequence
outputs 4 cycles of waveform at different rates on DAC 1, and changes the digital outputs for each cycle.

wl:

w2:

w3:

w4 :

RINC RINCW

SZ 1,1.0 ;make sure full size

ANGLE 1,0.0 ;make sure we start at phase ©
RATE 1,1.0 ;1 degree per step to start with
DIGOUT [00000001] ;so outside world knows

RATEW 1,1.2 ;next cycle faster, clear cycle flag
WAITC 1,wl swait for cycle >1 degree cycle
DIGOUT [00000010] ;announce another cycle

RATEW 1,1.4 ;next cycle a bit faster

WAITC 1,w2 s;wait for cycle >1.2 degree cycle
DIGOUT [00000011] ;yet another one

RATEW 1,1.6 ;last cycle a bit faster

WAITC 1,w3 ;wait for cycle >1.4 degree cycle
DIGOUT [00000100] ;last cycle number

WAITC 1,wd ;wait for end >1.6 degree cycle
RATE 1,0.0 ;stop waveform

These instructions behave like RATE and RATEW except that they change the output rate (angle increment per
step) by their argument rather than set it. RINCW clears the new cycle flag.

expr

OptLB

RINC n,expr|Vvn|[Vn+off],OptLB ;DAC n
RINCW  n,expr|Vn|[Vn+off],OptLB ;DAC n

CRINC  expr|Vn|[Vn+off],0OptLB ;DAC 1(3) - Obsolete
CRINCW expr|Vn|[Vn+off],OptLB ;DAC 1(3) - Obsolete
DRINC  expr|Vn|[Vn+off],OptLB ;DAC 9(2) - Obsolete
DRINCW expr|Vn|[Vn+off],OptLB ;DAC 9(2) - Obsolete

The DAC number in the range 0-7 (available DACs depend on the 1401 type).

The change in the angle increment per step. You can use the built-in Hz () function to express the
change as a frequency.

For a variable, the value 11930465 is a change of 1 degree. You can use the Varvalue script in the
Scripts folder to calculate variable values.

If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example starts cosine output at 10 Hz and lets you adjust it from the keyboard.

SET 1,1,0 ;1 ms per step
RATE  1,Hz(19) ;start output at 10 Hz

5-45



Spike2 version 11 for Windows

CLRC

wt: JUMP  wt sHALT stops all output>P=+1Hz, M=-1Hz
'P RINC 1,Hz(1),wt;1 Hz faster
'M RINC  1,Hz(-1),wt;1 Hz slower

These instructions can be used to produce waveforms that change gradually in frequency. The following code
generates a linear speed increase every two steps on DAC 1:

SZ 1,1.0 ;make sure full size
ANGLE 1,0.0 ;make sure we start at phase @
RATE 1,1.0 ;1 degree per step to start with
MOVI V1,900 ;in 900 steps of...

loop: RINC 1,0.01 ;...1/100 degrees to...
DBNZ V1,loop ;...10 degrees per step

The next example produces 90 cycles using V10 as a counter, increasing by 0.1 degrees per step per cycle.

SZ 1,1.0 ;make sure full size
ANGLE 1,0.0 ;make sure we start at phase ©
RATE 1,1.0 ;1 degree per step to start with
MOVI V10,90 ;in 90 steps of...

loop: RINCW 1,0.1 ;...1/10 degrees to...

wait: WAITC 1,wait ;...(wait for next cycle)...
DBNZ V10, loop ;...10 degrees per step

This instruction clears the cosine output new cycle flag. If you have been running for several cycles and you
want to stop the next time phase 0 is crossed use this instruction immediately before using WAITC.

CLRC  n,OptLB ;DAC n
CWCLR OptLB ;DAC 1(3) - Obsolete
DWCLR OptLB ;DAC 0(2) - Obsolete

n The DAC number in the range 0-7 (available DACs depend on the 1401 type).

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This example starts a sinusoid and then stops at the next phase 0 crossing after the user requests a stop. Because
the sinusoid passes phase 0 in the WATTC instruction and does another step in the RATE 1,0 instruction, we
offset the phase by 2 steps. However, this would cause the start of the sinusoid to be 2 steps wrong, so we
change the start angle to match.

'G PHASE  1,-2*Hz(2) ; compenstate for ending

ANGLE  1,2*Hz(2) ; so we start in correct place
RATE 1,Hz(2) ;5 2 Hz output
HERE : JUMP HERE ; output is running >Running
'S CLRC 1 ; Stop output
WT: WAITC  1,WT ; wait for cycle end>Waiting
RATE 1,0,HERE ; stop and then idle

General control

These instructions do not change any outputs or read data from any inputs. They provide the framework of
loops, branches and delays used by the other instructions.

DELAY Do nothing for a set number of steps

DBNZ Decrement a variable and branch if not zero

(LDCNTn, DBNZn) Load counter 1 to 4 (v61-V64), decrement, branch if not zero
Bxx Compare variables and branch (xx = GT, GE, EQ, LE, LT, NE)
CALL Branch to a label, save return position

CALLV, (CALLn) Like cALL, but load a variable (counter 1-4) with a value
RETURN Branch to instruction after last CALL, CALLV or CALLn

JUMP Unconditional branch to a label

HALT Stops the sequencer and waits to be re-routed

NOP This does nothing for one step (No OPeration)
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DELAY
The DELAY instruction occupies one clock tick plus the number of extra ticks set by the argument. It produces
simple delays of 1 to more than 4,000,000,000 sequencer steps.
DELAY  expr|Vn|[Vn+off],OptLB
expr The extra sequencer clock ticks to delay in the range 0 to 4294967295. The s (), ms () and us ()
built-in functions convert a delay in seconds, milliseconds or microseconds into sequencer steps.
vn Variable or table index from which to read the number of extra clock ticks.
OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.
This example uses display messages to tell the user what the sequence is doing.
SET 1.00,1,0 ;run with 1 millisecond clock ticks
DELAY 2999 swait 2999+1 milliseconds>3 second delay
DELAY s(3)-1 ;3 seconds -1 tick delay >3 second delay
DELAY Vi,LB ;wait V1+1 ms, branch >variable delay
DELAY  [V1+9] ;V149 is table index >table delay
DBNZ

DBNZ (Decrement and Branch if Not zero) subtracts 1 from a variable and branches to a label unless the counter
is zero. It is used for building loops.

DBNZ Vn, LB
Vn The variable to decrement and test for zero.

LB Instruction to go to next if the result of the decrement is not zero. From [11.00] you can use +n or -
n (n is the number of steps) to branch to n steps after or before the current step.

DBNZ is often used with MOVT to set up loops, for example:

MOVI V2,1000 ;set times to loop

WT: DIGOUT [00000000] ;set all digital outputs low
DIGOUT [11111111] ;set them all high
DBNZ V2,WT ;1loop 1000 times

LDCNTn DBNZn

These obsolete instructions use variables V61 to V64 as counters 1 to 4. These instructions are preserved so that
ancient sequences can still be used (but we urge you to recode them). New sequences should use MOVI and
DBNZ, which can use any variable. LDCNTn loads a counter. DBNZn (Decrement and Branch if Not Zero)
decrements a counter and branches while the counter is not zero. v61-v64 also store values for DACs 4-7.

LDCNTn expr|Vn

DBNZn LB
n The counter to load or decrement in the range 1 to 4, using variables V61 to vé64.
expr The 32-bit integer value to load into the counter.
Vn When a variable is used the counter is set to the 32-bit variable.
LB Instruction to go to next if the result of the decrement is not zero. From [11.00] you can use +n or -

n (n is the number of steps) to branch to n steps after or before the current step.
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CALL CALLV CALLn RETURN

JUMP

These instructions run a labelled part of a sequence and return. CALL, CALLV and CALLn save the next step
number to a return stack and jump to the labelled instruction. The RETURN instruction removes the top step
number from the return stack and jumps to it. CALLV also sets a variable to a constant. CALLn (n=1 to 4) is
obsolete and sets the value of the variables that emulate the four counters, V61 to V64. These four variables are
also used to store the outputs set for DACs 4-7.

CALL LB ; use LB as a subroutine
CALLV LB,Vn,expr 5 Vn = expr, then call LB
CALLn LB,expr ; V32+n = expr (n=1, 2, 3 or 4) deprecated
RETURN ; return to step after last CALL
LB The next instruction to run. This section of code should end with a RETURN. Programmers refer to

called sections like this as subroutines. From [11.00] you can use +n or -n (n is the number of
steps) to branch to n steps after or before the current step.

Vn CALLV copies the value of expr to this variable. The obsolete instructions CALL1 sets V61, CALL2
sets V62, CALL3 sets V63 and CALL4 sets V64.

expr A 32-bit integer constant that is copied to a variable. For CALLn only, if expr is 0, the variable is set
to 256 to be compatible with previous versions.

You can use CALL inside a called subroutine. This is known as a nested CALL. If you call a subroutine from
inside itself, this is known as a recursive CALL. The return stack has room for 64 return addresses. If you use
more than this, the oldest return address is overwritten, so your sequence will not behave as you expect.

This example generates different pulse widths from DAC 0. The sequence is written to be independent of the
sequencer rate (it must be high enough so that the widths are possible). In this case the rate is set to 5 kHz. The
example sets DAC 0 to zero, then pulses for 20 milliseconds twice, once using CALL and once using CALLV.
Then after a delay, there is a 50 millisecond pulse.

SET 0.2,1,0 ; Run at 5 kHz, normal DAC scale

DAC 0,0 ; make sure DACO is zero

MOVI  V3,ms(20)-2 ; these two instructions...

CALL PUL ; ...have the same effect as...

CALLV PUL,V3,ms(20)-2; ...this one. 20 ms pulse

DELAY s(1)-1 ; wait 1 second, then...

CALLV PUL,V3,ms(50)-2; ...a 50 ms pulse

HALT ; So we don't fall into PUL routine
PUL: DAC 0,1 ; set DAC value

DELAY V3 ; wait for time set

DAC 0,0 ; set DAC back to zero

RETURN ; back to the caller

CALL/CALLV and RETURN let you reuse a block of instructions. This can make sequences much easier to
understand and maintain. The disadvantage is the additional steps for the CALL and RETURN. If you need to set
a variable, use CALLV and there is only the overhead of the RETURN instruction.

The JuMP instruction transfers control unconditionally to the instruction at the label. Many instructions allow
the use of an optional label to set the next instruction, so you can often avoid the need for this instruction. You
can also jump using the contents of a register as the destination, or relative to a label (LB):

Jump LB 5 Jump to label
JUMP (Vn),OptLB ; use MOVI Vn,LB to set target
JUMP  LB(Vn),OptLB ; Jump to instruction LB+Vn

LB The label to jump to. From [11.00] you can use +n or —-n (n is the number of steps) to branch to n steps
after or before the current step.

(Vn) The value of variable vn sets the instruction number to jump to.

LB (Vn) Jump to the instruction given by label LB plus the contents of vn.
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HALT

NOP

OptLB An optional label to jump to if (Vn) or LB (Vn) is not an instruction number. The first instruction is 0,
the last depends on the size of the sequence. From [11.00, 10.22] you can use +n or -n (n is the
number of steps) to branch to n steps after or before the current step.

State machine

You can use the JUMP instruction to implement a state machine. A state machine is characterised by activities in
each state, and transitions between states. State machines are a convenient way to tidy up a complicated
sequence of operations involving conditions such as the level of an input signal. For example:

State Activity Transition
0 Wait for digital input O to be low To state 1
1 Wait for digital input O to go high  To state 2 on high
2 Wait for digital input 0 to go low To state 3 on low, digital output high on change
3 Wait for 10 seconds To state 0, digital output low on change
This could be coded as:
SET 1.000 1 ©
VAR V1,State=State@ ;initial state
VAR V2,Until=0 ;Used to time state 3

VAR  V3,Now

IDLE: ;background actions >=
JUMP  (State) s;run state machine »>=
STATEO: DIBNE [....... 0],IDLE ;wait for low >State ©
MOVI State,Statel,IDLE ;move on >"
STATEL: DIBNE [....... 1],IDLE ;wait for high >State 1
MOVI  State,State2,IDLE ; >"
STATE2: DIBNE [....... 0],IDLE ;wait for low again >State 2
DIGOUT [....... 1] ;Digital out high >"
TICKS Until,sTick(1l) ;1 second ahead >"
MOVI  State,State3,IDLE ; >"
STATE3: TICKS Now,© ;get current time >State 3
BLT Now,Until,IDLE ;wait for 1 second >"
DIGOUT [....... 9] ;Digital out low >"
MOVI State,Stateo, IDLE
The ... at label 1DLE stands for instructions that you want to run in the background while the state machine

runs. Of course, the more background instructions you include, the less frequently the state machine checks the
state of the inputs.

The HALT instruction stops the output sequence and removes all overhead associated with it. It does not stop the
sequencer clock, which continues to run. Any cosine output will stop, but will restart when the sequence
restarts. To restart the sequencer, press a key associated with a sequence step or click a key in the sequencer
control panel. If you associate a display string with this instruction, it appears in the sequencer control panel.

HALT >Press X when ready

The NOP instruction (No Operation) does nothing except use up one sequencer clock tick. It can be thought of
as the equivalent of DELAY 0.
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Variable arithmetic

These instructions perform basic mathematical functions while a sequence runs. You can also compare
variables and branch on the result.

ABS Set a variable to the absolute value of another
ADD Add one variable to another

ADDI, (ADDIL) Add a constant value to a variable

MoV Copy one variable to another

MOVI, (MOVIL) Move a constant value into a variable

MUL, MULI Multiply two variables, multiply by a constant
NEG Move minus the value of a variable to another
SUB Subtract one variable from another

DIV, RECIP Division and reciprocal of variables

Compare variable

MOV

These instructions compare a variable with a variable or a 32-bit expression or a table entry and branch on the
result. All comparisons are of signed 32-bit integers.

XX

Vn

Vm

expr

Bxx Vn,Vm, LB ;compare with a variable
Bxx Vn, expr, LB ;compare with a constant
Bxx Vn, [Vm+off],LB ;compare with a table entry

This is the branch condition. The xx stands for: GT=Greater Than, GE=Greater or Equal, E0=Equal,
LE=Less than or Equal, .T=Less Than, NE=Not Equal.

The variable to compare with the next argument.
A variable to compare vn with or table index variable.

A 32-bit integer constant to compare Vn with.

This example collects the latest data value from channel 1 (assumed to be a waveform), waits for it to be in a
preset range for 1 second, then outputs a pulse to a digital output bit.

START: CHAN Vi, 1 ; get channel 1 data
BGT V1,4000,START ; if above upper limit, wait
BLT V1,0,START ; if too low, wait

IN: MOVI V2,S(1)/4 ; timeout, 4 instructions/loop

INLOOP: CHAN Vi, 1 ; to check if still inside
BGT V1,4000,START ; if above upper limit, wait
BLT V1,0,START ; if too low, wait
DBNZ V2, INLOOP ; see if done yet

REWARD: DIGOUT [....... 1] ; Task done OK
DELAY S(1) ; leave bit set for 1 second
DIGOUT [....... 9] ; clear done bit

; next task...

We want the data to be in range for one second. There are 4 instructions in the loop that tests this, so we set to
the loop to run for the number of steps in a second divided by 4. For this to work correctly, the sequencer must

be running

fast enough so that 4 steps are no longer than the sample interval for the waveform channel.

This instruction moves an integer constant into a variable. MOVIL is an obsolete instruction that does exactly the
same thing. The syntax is:

Vn
expr

OptLB

MOVI Vn, expr,OptLB ; Vn = expr
A variable to hold the value of expr.
An expression that is evaluated as a 32-bit integer.

If this label is present it sets the next instruction, otherwise the next sequential instruction runs.
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MOVT is not the same as the VAR directive. The VAR directive sets the value of a variable when the sequence is
copied to the 1401 and does not occupy a step. The MOV instruction is part of the sequence and set the value of
the variable each time the instruction is used.

MOV ABS NEG

ADDI

The MOV instruction sets a variable to the value of another with the option of adding a 32-bit number and
dividing by a power of two). The NEG instruction is identical to MOV except that the source variable is negated
first. ABS is also the same, except that the absolute value (negative values become positive) of the variable is
taken first. ABS was added at version 7.00. The syntax is:

MOV Va, Vb, expr,shift ; Va = (Vb + expr) >> shift
NEG Va, Vb, expr,shift ; Va = (-Vb + expr) >> shift
ABS Va,Vb,expr,shift ; va = (|Vb| + expr) >> shift
Va A variable to hold the result. It can be the same as vb.
Vb A variable used to calculate the result. It is not changed unless it is the same variable as Va.
expr An optional expression that is evaluated as a 32-bit integer. If this argument is omitted, it is treated
as 0.

shift An optional argument in the range 0 to 31, set to O if omitted. For all numbers except -1, the effect
of one shift is equivalent to division by 2. The result of shifting -1 is always -1. Shifting is faster
than division by a power of 2.

The following examples assume that v3 holds 1000:

VAR V6,Result

MOV Vvi,V3 ; set V1 to 1000
NEG Vvi,V3 ; set V1 to -1000
MOV V1,V3,-8 ; set V1 to 992
NEG Result,V3,0,4 ; set V6 to -63
ABS Result,Result ; set V6 to 63
MoV Result,V3,4,1 ; set V6 to 502

This instruction adds a 32-bit integer constant to a variable. ADDIL is an obsolete instruction that does exactly
the same. There is no SUBI as you can add a negative number. The syntax is:

ADDI Vn,expr,OptLB ; Vn = Vn + expr
vn A variable to hold the result of vn + expr.
expr An expression that is evaluated as a 32-bit integer.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs..

The following examples assume that v1 holds -1000:

VAR V1,Result=-1000
ADDI Result, 1000 ; set V1 to O
ADDI V1,-4000 ; set V1 to -5000

ADD SUB

The ADD instruction adds one variable to another. The SUB instruction subtracts one variable from another. In
both cases you can optionally add a 32-bit integer constant and optionally divide the result by a power of two.
The syntax is:

ADD Va,Vb,expr,shift ; Va = (Va + Vb + expr) >> shift
SuB Va,Vb,expr,shift ; Va = (Va - Vb + expr) >> shift
Va A variable to hold the result. It can be the same as vb.
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Vb A variable to add or subtract.
expr An optional expression evaluated as a 32-bit integer. If omitted, O is used.
shift An optional argument in the range 0 to 31, set to 0 if omitted, that sets the number of times to divide
the result by 2.
The following examples assume that v1 holds -1000, v3 holds 1000, v6 holds 100:
VAR V6,Result=100
ADD Vv1,V3 ; VI = 0 (-1000 + 1000 + O)
SUB Vv1,V3 ; VI = -1000 (0 - 1000 + 0)
ADD Vv1,V3, -8 ; V1 = -8 (-1000 + 1000 - 8)
SUB Result,V3,0,2 5 V6 = -225 (100 - 1000 + 0)/4
ADD Result,V3,4,1 5 V6 = 389 (-225 + 1000 + 4)/2

MUL MULI

MUL multiplies a variable by another variable, then optionally adds a 32-bit integer constant and divides the
result by a power of two. MULT multiplies a variable by a 32-bit integer constant and divides the result by a
power of 2.

MUL Va,Vb,expr,shift ; vVa = ((Va*Vb)+expr) >> shift
MULI Va,expr,shift ; Va = (Va*expr) >> shift
Va A variable to hold the result. It can be the same as Vb.
Vb A variable used to calculate the result.
expr An expression that is evaluated as a 32-bit integer. It is optional for MUL and required for MULI. If

this argument is omitted, it is treated as 0.

shift An optional argument in the range 0 to 31, set to 0 if omitted, that sets the number of times to divide
the result by 2.

The following examples assume that v1 holds —10 and v3 holds 10:

MULI V1,10 ; vl
MUL V1,V3,-8 ; vl

-100 (-10 * 10)
-1008(-100 * 10 -8)

DIV RECIP

D1V and RECTP divide variables. These are relatively slow instructions in most 1401s; they take around .4 ps in
a Power2, 0.2 us in a Power3, around 1ps in the Powerl I, 3 ps in a Micro2 and Micro3. The Micro4
implements hardware division, so has very little division overhead.

DIV Va, Vb ; Va =Va / Vb
RECIP  Va,expr ; Va = expr / Va

If the numerator is 0, the result is 0. If the denominator is 0, the result is 2147483647 if the numerator is greater
than 0 and —2147483648 if it is negative. The 1401 truncates all results towards 0. So, 7/3 or —=7/-3 is 2, and —
7/3 or 7/-3 is 2.

If you are dividing by a power of 2, it is faster to use a shift (see the ADD, SUB, MOV, ABS and NEG
instructions). When dividing by a fixed value it is often faster to multiply and shift.

Variable Logic

These instructions perform basic bitwise logical functions between two variables or a variable and a constant
while a sequence runs.

AND, ANDI Bitwise AND of variables, variable and constant
OR, ORI Bitwise OR of variables, variable and constant
XOR, XORI Bitwise exclusive OR of variables, variable and constant
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AND, ANDI

OR, ORI

These instructions bitwise AND a variable with a variable or a 32-bit expression. A bitwise AND means that each
bit of the 32-bit result is 1 if both corresponding source bits are 1, otherwise the result bit is 0. For example, 3
AND 1is 1, 0x55 AND OxAA is 0.

AND Va,Vb ; Va = Va AND Vb
ANDI Va,Vb,expr ; Va = Vb AND expr
Va The variable to hold the result.
Vb A variable to AND with va or with the expression.

expr A 32-bit integer constant to AND with Vb.

This example waits for the digital input to have bit 4 set, then branches based on the digital input value (placed
in VDigIn or V56 by WAIT).

WAIT [...1....] ; wait for bit 4 set >Wait for Bit 4
ANDI V1,VDigIn,0x0f ; isolate bits ©0..3 (value ©-15)
JUMP ACTION(V1) ; branch based on the result

ACTION: JUMP ACTO ; action for value ©
JUMP ACT1 ; action for value 1
JUMP ACT15 ; action for value 15

These instructions bitwise OR a variable with a variable or a 32-bit expression. A bitwise OR means that each
bit of the 32-bit result is 1 if either corresponding source bit is 1, otherwise the result bit is 0. For example, 3 OR
1 is 3, 0x55 OR OxAA is Oxff.

OR Va, Vb ; Va = Va OR Vb
ORI Va,Vb,expr ; Va = Vb OR expr
Va The variable to hold the result.
Vb A variable to OR with va or with the expression.

expr A 32-bit integer constant to OR with Vb.

XOR, XORI

These instructions bitwise exclusive OR a variable with a variable or a 32-bit expression. A bitwise exclusive
OR means that each bit of the 32-bit result is 1 if the corresponding source bits differ, otherwise the result bit is
0. For example, 3 XOR 1 is 2, 0x55 XOR 0xAA is Oxff.

XOR Va,Vb ; Va = Va XOR Vb
XORI Va,Vb,expr ; Va = Vb XOR expr
Va The variable to hold the result.
Vb A variable to xOR with va or with the expression.

expr A 32-bit integer constant to XOR with Vb.

Table access

Tables are declared with the TABSZ directive and can be populated with data using the TABDAT directive. Most
access to tables is through the [Vn+off] method, but there are also instructions for loading and storing a
variable in a table and for incrementing or decrementing a variable used as a pointer into the table.
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TABLD, TABST Load a register from the table and store a register to the table
TABINC Increment a register and branch while within the table

TABLD TABST

These two instructions load a variable from the table and store a variable into the table. Many instructions can
load arguments from the table, so TABLD is not often required.

TABLD  Vm, [Vn+off],OptLB ; load Vm from the table
TABST  Vm, [Vn+off],OptLB ; store Vm into the table

Vm The variable to load from the table or store into the table.

+off An optional expression that evaluates to an integer in the range —1000000 to 1000000. If omitted, 0
is used.

Vn The variable value plus the offset is used as a table index. If the index lies in the table, vm is loaded

from the table or stored in the table at the index. If the index is not in the table, TABLD copies 0 to
vm and TABST does nothing.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

TABADD TABSUB

TABINC

These two instructions add a table value to a variable or subtract a table value from a variable. These
instructions were added at version 7.00.

TABADD  Vm, [Vn+off],OptLB ; add table value to Vm
TABSUB  Vm, [Vn+off],OptLB ; subtract value from Vm

Vm The variable to add data to or subtract it from.

+off An optional expression that evaluates to an integer in the range —1000000 to 1000000. If omitted, 0
is used.

Vn The variable value plus the offset is used as a table index. If the index lies in the table, vm is

changed. If the index is not in the table, the instruction does nothing.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

This instruction adds a constant to a variable and detects if the result is a valid table index. If it is a valid index,
the instruction branches. If it is not, the result is reduced by the table size if it is positive and is increased by the
table size if it is negative, and the instruction does not branch. This gives you an efficient way to work through
the table in either direction.

TABINC  Vn,expr,OptLB
Vn This variable is assumed to hold a valid table index.
expr This expression evaluates to a positive or negative number that is added to vn.
OptLB If present, branch to this label if vn+expr is a valid table index.

For example, the following codes plays pulses through DAC 0 based on data in the table. The table data holds
groups of three items, holding the time for the DAC to stay at 0, the DAC amplitude and the time to stay at the
amplitude. Some example table data is given, but the data could also be set with the SampleSegTable () script
command.

SET 0.100 1 0 ;run at 10 kHz
TABSZ 12 ;4 sets of 3 items
TABDAT ms(50)-2,VDAC32(1),ms(50)-3

TABDAT ms(100)-2,VDAC32(1.3),ms(70)-3
TABDAT ms(200)-2,VDAC32(1.5),ms(90)-3
TABDAT ms(400)-2,VDAC32(1.9),ms(110)-3
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'G MOVI V1,0 ;use V1 as the table pointer
LOOP: DAC 0,0 ;strt with the DAC low
DELAY  [V1] ;wait for first period>Low
DAC 0, [V1+1] ;get the DAC value
DELAY  [V1+2] ;wait for second period>High
TABINC V1,3,LO00P
DAC 0,0 ;tidy up the dac

Access to data capture

CHAN

Most activities in the sequencer are independent of the sampling process. However, there are times when you
need to know the value of a channel to decide what to do next. The CHAN command gives you the latest
waveform value or number of events on a channel. The TICKS command tells you the current time in terms of
the sampling clock ticks.

The sequencer can also send information in the other direction. If the digital marker channel is active you can
force it to record the current digital input state with REPORT, or you can force it to record a marker of your own
choosing with MARK.

REPORT, MARK Simulate an external E1 pulse to record/set a digital marker
CHAN Get the latest waveform value or event count from a channel
TICKS Load a variable with the time in Spike2 time units

TICKO Sets the zero time used as a reference for TICKS, new at 8.00

This instruction gives the output sequencer access to sampled data on a waveform channel and to the number of
recorded events on all other channel types. You can also use this command to get the most recent value written
to the DAC outputs. The variable value is 0 if the channel is not being sampled. You cannot use this command
on channels 30 and 31 (Text marker and Keyboard marker) as these channels do not exist in the 1401.

CHAN Vn, chn 5 Vn = ChanData(chn)

chn The channel number is 1 to 100 for sampled channels or 0 to -7 for the last value written by the
sequence to DAC 0 to 7. The result is the most recent data available. For a slow waveform channel
this could be a long time in the past. In triggered sampling mode, waveform data is available
between triggers.

Waveform and DAC data are treated as 16-bit signed values from —32768 to 32767. You also have more
efficient access to DAC values as 32-bit data in variables V57 to V64 (VDACO to VDAC7) without the need to use
the CHAN instruction.

This example waits for a signal to cross 0.05 volts and produces a pulse. We assume that channel 1 is a
waveform.

SET 0.100 1 0 ;run at 10 kHz
VAR V1,level=VDAC16(0.05) ;level to cross
VAR V2,data ;to hold the last data
VAR V3, low=VDAC16(0.9) ;some sort of hysteresis level
DIGOUT [00000000 ] ;set all dig outs low
BELOW: CHAN data,1 ;read latest data >wait below
BGT data, low,below ;wait for below >wait below
ABOVE: CHAN data,1 ;read latest data >wait above
BLE data, level,above ;wait for above >wait above
DIGOUT [....... 1] ;pulse output...
DIGOUT [....... 0],below ;...wait for below

DAC values and arbitrary waveform output

You can only read back the current DAC value when you set it with a sequence instruction (DAC, ADDAC,
rAMP, Cosine output). If you use arbitrary waveform output, this uses a separate, more efficient mechanism; the
price you pay for the increased efficiency is less knowledge of exactly what the DACs are doing.
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TICKS

TICKO

Event count overflow in version 8 onwards

You should be aware that when using CHAN to count events it is possible for the event count to exceed the 32-
bit range of the variable. That is, the count will start at 0, then increase up to 2147483647 (Ox7fffffff, the most
positive number in 32-bit twos complement coding). The next event increments the number to 0x80000000,
which is -2147483648 (the most negative number in 32-bit twos complement coding). The value will continue
to increment by getting more positive and will reach 0 (again) at 4294967296 events, after which the cycle will
repeat.

For example, if your events have an average rate of 100 Hz, the first wrap around happens after some 500 hours
(more than 20 days). If this is likely to be a problem for you, you can probably reorganise your code to use
differences of event counts.

This instruction sets a variable to the current sampling time past the current zero time set by the TICKO
instruction in Spike2 time units (microseconds per time unit set in the sampling configuration) and adds an
expression or 0 if expr is omitted. It can detect if the result does not fit in a signed 32-bit variable. Typical use
of this instruction is to wait for a defined time while performing other sequencer actions, avoiding the need to
carefully count sequencer instructions.

TICKS  Vn,expr,ovLab 5 Vn = Spike2 time + expr, branch on overflow

Vn A variable to hold the time past the current zero time plus expr. This may NOT be v255 or V256 as
these are used to save the current zero time. Remember that variables are 32-bit signed numbers, but
the time in clock ticks can be up to 64-bits in size. This means that there is a limit to the result that
can be stored in vn. Put another way, the result in vn can overflow (see ovLab for a way to detect
this). If overflow occurs, the value in vn is full scale maximum (2147483647 or Ox7f£££££f) if
the result is too large to fit in 32 bits or full scale minimum (-2147483648 or 0x80000000) if the
result is too negative.

expr An expression that evaluates to a constant 32-bit signed number of clock ticks that are to be added to
the result of the current time less the current zero time set by TICKO. This expression may be
omitted in which case the value 0 is added. The sTick (), msTick() and usTick() expression
functions can be used to make the sequence independent of the microseconds per time unit value.

ovLab If present, this is a label that is branched to if the result of "current time - zero time + expr" does
not fit in a 32-bit signed variable. If omitted, the next instruction runs regardless of overflow.

This can be used with the CHAN command and variable related branches to check the timing of external pulses.
The sequencer runs under interrupt, and competes for time with other interrupt driven processes in the 1401
interface. This causes some “jitter” in the timing. The jitter is typically only a few microseconds.

Changes at Spike2 8.00

Because the time in Spike2 clock ticks no longer fits in a 32-bit variable, you should be aware that the result
can overflow. To allow for this, the command is extended as described above to allow you to detect overflow
and the new TICKO sequencer command and the SampleSeqTickO0 () script command are added to give you
control of where the TICKS result is relative to.

This instruction sets the zero time used as a reference for the TICKS instruction to the current sampling time in
Spike2 clock ticks (the timing resolution of the sampling data file). This was added at Spike2 version 8 as
sampling can run for many more clock ticks than can be stored in a 32-bit sequencer variable.

If you have existing sequences, and you sample for less than 2147483648 clock ticks you can ignore this
command and the old sequences will continue to work. However, if you sample for longer than this (31 minutes
at 1 microsecond resolution, 5 hours at 10 microseconds resolution...) and you use TICKS, you should rewrite
your old sequences to periodically use TICKO and time relative to this.

The zero time is stored in v255 (bits 0-31) and v256 (bits 32-63). Be very careful if you modify these variables
using other sequencer instructions if you want TICKS to give useful results.
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TICKO expr,OptLB

expr An expression that evaluates to a constant 32-bit signed number of clock ticks that are to be added to
the current time to generate the new zero time. This expression may be omitted in which case the
value added is 0. The sTick (), msTick() and usTick() expression functions can be used to
make the sequence independent of the microseconds per time unit value.

OptLB An optional label that sets the next instruction to run.

REPORT MARK

The REPORT instruction records a digital marker (if the digital marker channel is enabled) as if there were an
external pulse that triggered a digital marker. The MARK instruction does the same, except it takes the argument
as the value to record. REPORT has no arguments.

REPORT OptLB
MARK expr|vn|[Vn+off],0ptLB

expr The argument should have a value in the range 0 to 255. If a variable or table is used, the bottom 8
bits of the value are used.

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs.

WAIT [eeennn. 1] >Waiting for bit ©
REPORT ;save a marker when this is set
MARK 12 ;set code 12 as a digital marker

Time resolution

There is a restriction in Spike2 that events on a channel should all be at different times. If the Spike2 data file is
running with a time resolution that is similar to the speed of the output sequencer, it is possible that two
consecutive MARK or REPORT instructions could be logged at the same time. This will cause Spike2 to report an
error when sampling ends. If you get such an error you must either reduce the data file time resolution or
increase the gap between the sequencer instructions.

Randomisation

BRAND

These functions use a pseudo-random number generator. The generator is seeded by a number that is based on
the length of time that the 1401 has been switched on.

BRAND, (BRANDV) Random branch with a probability
MOVRND Load a variable with a random number
(LDIRAN) Load counter 1 (v61) with a random number 1-256

BRAND branches with a probability set by the argument or by a variable. This could be used when several
different stimuli are required, but in a random sequence. BRANDV is an obsolete name for the same instruction.

BRAND LB, expr|Vn|[Vn+off]

LB Where to go if the branch is taken
expr This is the probability of branching in the range 0 up to (but not including) 1.
Vn When a variable or table entry is used for a branch, the value is treated as a 32-bit unsigned number;

0 means a probability of zero and 4294967295 (the largest 32-bit unsigned number) means a
probability of 0.9999999998.

BRAND LB,0.5 ;branch with 50% probability

To produce a multiple way random branch you use more BRAND instructions. A three way equal probability
branch to LA, LB and LC can be coded:
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BRAND  LA,0.33333 ;Split the first route with p=1/3
BRAND LB,0.5 ;0.6667 to here * 0.5 is 0.3334 (1/3)
LC: ;If neither of the above, comes here

The following shows the sequence for a five-way branch with equal probabilities:

BRAND LA,0.2 ;5 way, LA probability is 0.2 (1/5)
BRAND FX,0.5 ;Probability to here=0.8, so to FX=0.4
BRAND LB,0.5 ;Probability to here=0.4, so to LB=0.2

LC: 50 ;Probability to here=0.2
FX: BRAND LD,0.5 ;Probability to here=0.4, so to LD=0.2
LE: 600 ;Probability to here=0.2

The best technique is to reduce the branches to a power of two as soon as possible. Case 1 of the five-way
branch is split off (probability of 0.2), leaving 4 ways. The 4 ways are split with a probability of 0.5 (0.4 for
each division) then the last two routes are split, again with a probability of 0.5 (0.2 for each division).

Poisson process
In a Poisson process, the probability of something happening per time interval is constant. You can generate a
delay with a Poisson statistic by:

POISSON: BRAND  POISSON,prob ; poisson delay

The probability is given by prob = 1.0 - 1.0/ (mDelay*S (1)), where mDelay is the mean delay required
in seconds and S (1) is the built in function that tells us how many steps there are per second. If you would
rather express this in terms of a rate, then prob = 1.0 - rate/S (1), where rate is the expected rate in Hz.

TENHZ: BRAND TENHZ,1.0-10/S(1) ;10 Hz mean rate
DIGOUT [....... 1] ;set output high
DIGOUT [....... 0], TENHZ ;set output low, goto TENHZ

This example generates a digital output that pulses to produce an approximation to a Poisson distributed pulse
train with a mean frequency of 10 Hz. The approximation improves the shorter the step time. The mean interval
between pulses is 100 milliseconds plus the time for 2 steps and the shortest gap between pulses is 3 sequencer
steps.

Scripts and variables

From a script you can set sequencer variables as 32-bit signed integers. For the range 2147483648 to
4294967295 we must use negative numbers. This script example shows you how to convert a probability into a
variable value and pass it to the sequencer:

func vrand%(prob)

if (prob >= 1.0) then return -1 endif;

if (prob <= 0.0) then return 0 endif;

if (prob >= 0.5) then prob := prob-1.0 endif;

return prob * 4294967296.0; 'is converted to an integer
end;

Proc SetBrandVar(prob, v%) 'prob is probability, v% is variable
SampleSeqVar(v%, vrand%(prob));
end;

MOVRND

This instruction generates a random number in the range 0 to a power of 2 minus 1, then adds an integer
constant to it and stores the result in a variable.

MOVRND Vn,bits,expr

Vn The variable to hold the result.

bits The number of random bits to generate in the range 1 to 32. The generated random bits fill the
variable starting at the least significant bit. Bits above the highest numbered generated bit are set to
0.

expr An optional expression that evaluates to a 32-bit integer number, that is added to the random bits. If

this is omitted, nothing is added.
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Expressed in terms of the script language, the random number is one of the numbers in the range expr to
expr+Pow (2,bits) -1. For example, MOVRND V61,8,1 emulates the obsolete LDIRAN instruction that
generates a random number in the range 1 to 256.

The following code fragment implements a random delay of between 1 and 2.024 seconds (assuming a 1
millisecond clock).

MOVRND V1,10,998 ;load V1 © with (@ to 1023) + 998
DELAY V1 ;this uses 999 to 2023 steps

LD1RAN

This obsolete instruction loads counter 1 (v61) with a pseudo-random number in the range 1 to 256. It is
implemented as MOVRND V61,8, 1. Do not use this instruction in modern code. V61 is also used to store the
last value written to DAC 4.

Arbitrary waveform output

In addition to generating voltage pulses, ramps and cosine waves through the DACs, Spike2 can play arbitrary
waveforms. The sequencer can start waveform output, test it and branch on the result, stop output or set one
more output cycle. Each waveform has an associated code (often a keyboard character). The sequencer uses the
code to identify the arbitrary wave to replay. The waveforms are stored in 1401 memory and can be updated
during sampling with the PlayWaveCopy () script command.

WAVEGO Start or prepare arbitrary waveform output area
WAVEBR Test arbitrary waveform output and branch on the result
WAVEST Start or stop arbitrary waveform output

WAVEGO

The WAVEGO instruction starts output from a play wave area, or prepares the output for an external trigger.
Starting output can take more time than we want to allocate to a sequencer step so WAVEGO sets a flag and
output starts as soon as the 1401 has free time (usually within a millisecond). See WAVEST for a precisely timed
start to output.

WAVEGO code{,flags{,OptLb}}

code This is either a single character standing for itself, or a two digit hexadecimal code. This is the code
of the area to be played.

flags These are optional single character flags: w, T and - meaning no flag. The flags are not case
sensitive. Use T for triggered waveform output (either an external hardware trigger or using WAVEST
T). Use W to make the sequencer wait at this step until the 1401 has prepared the hardware to play.
The - flag was new at versions [10.0, 9.08, 8.17] and is required if you have a label and no flags.

Examples:

WAVEGO X, -,Label j;area X, no wait, no trigger, go to label
WAVEGO 23,T ;area coded hexadecimal 23, triggered
WAVEGO O,WT ;area '@', wait until trigger armed
WAVEGO 1,W ;area '1', wait until play started

OptLB If this label is present it sets the next instruction, otherwise the next sequential instruction runs. It
can be useful to issue the WAVEGO command with no flags and a label; to do this, use - or -- as the
flags: WAVEGO X, -, OptLB.

If you need to know when the output started, use the WAVEBR T option. If you need to know that the request to
start the playing operation has been honoured, but you do not want to hang up the sequencer with the w option,
use the WAVEBR W option.

WAVEGO cancels existing output just before the new area starts to play. If you use WAVEBR after the play request,
unless you use the WAVEGO or WAVEBR W option to be certain that the new area is active, the WAVEBR result may
be based on the previous area.
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Warning

It is quite common to have a key associated with the WAVEGO command so that a key press can trigger the
waveform output. Keypresses as also associated with play wave areas and can trigger them. It can be tempting
to use the same key code for both a play wave area and for the WAVEGO command; this will cause a race between
the code that starts the play wave area due to the key (which will win) and the sequencer code. The area will
start to play, then stop, then start again.

WAVEBR

The WAVEBR instruction tests the state of the waveform output and branches on the result. No branch occurs if
there is no output running or requested.

WAVEBR LB, flag

LB Label to branch to if the condition set by the flag is not met. From [11.00] you can use +n or -n (n
is the number of steps) to branch to n steps after or before the current step.

flag An optional single character flag to specify the branch condition:
W branch until a WAVEGO request without the w flag is complete.

branch until the play wave area or cycle count changes.

branch until the play wave area changes.

branch until the current output stops.

branch until output started with WAVEGO begins to play.

H n ¥ Q

The following sequence tracks the output when we have two play areas labelled 0 and 1. Area 0 is set to play 10
times and is linked to area 1. The sequence below will track the changes. Play wave DAC output happens one
play wave clock tick after the output is changed, so the sequencer can know that a DAC output is about to
change.

WAVEGO ©,WT area 0, wait for armed

3
MOVI V1,5 ; load variable V1 with 5
WT: WAVEBR WT,T ; wait for external trigger>Trigger?
W5: WAVEBR W5,C ; wait for cycle >Waiting for cycle
DBNZ V1, W5 ; do this 5 times »>Waiting for cycle
WA: WAVEBR WA, A ; wait for area >Wait for area
WE: WAVEBR WE,S ; wait for end >Wait for end

The WwAVEGO command requests a triggered start and waits until the trigger is armed before moving on. It then
waits for an external trigger at the wT label. Next the sequence tracks the end of 5 output cycles. At label wa the
sequence waits for the area to change and finally the sequence waits for output to stop.

WAVEST

The WAVEST instruction can start output that is waiting for a trigger and stop output that is playing, either
instantly, or after the current cycle ends.

WAVEST flag
flag This are optional single character flag and specifies the action to take:
T Trigger a waveform that is waiting for a triggered start.
S Stop output immediately, no link to the next area.
C Play to the end of the current cycle, then end this area. If there is another area linked it will play.

The following code starts output with an internal trigger and then stops it after a delay.

WAVEGO X, TW arm area X for trigger, wait for armed

5
WAVEST T ; trigger the area
DELAY 1000 ; wait
WAVEST S ; stop output now
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New File

File menu

The File menu is used for operations that are mainly associated with files (opening, closing and creating) and
with printing. The menu ends with a list of recently used files.

This command creates a new Spike2 data file for sampling based on the | yey Fie %
current sampling configuration, a grid view, an output sequence file, a
script file, text file or an XY file. The command opens a New File dialog
box in which you choose the type of file to create. You can activate this ||
command from the menu and from the toolbar. The script language gz;‘i?g::‘gjc":mem Gaien

equivalent is FileNew (). | Text Document l—‘
q 0 —

File types: Help

[1size grid

|XY Document

You can make files of six types: data, grid output sequencer (pulse) files,
script files, text files and XY files. Double-click a file type, or select a file type and click OK; Spike2 will open
a window of the specified type. Each file type has its own file name extension.

Data Document

A Time view opens plus additional windows set by the sampling configuration. The time view holds the set of
channels defined by the current sampling configuration and is ready to start sampling. Data documents are not
stored in memory, unlike most new files, but are kept on disk. Until they are saved after sampling they are
temporary files in the directory set in the Edit menu Preferences. The file name extension is .smrx (or .smr
for the legacy format). Only one sampling document can be open at a time.

ek

€=You can also open a new file, ready to sample, by clicking this button on the system toolbar or by using the
Run Now button in the Sampling Configuration.

Grid Document [columns X rows]

Select this option to open a grid view with a default number of rows and columns. You can create a grid view
with your choice of rows and columns from the script language. The file name extension is . s2gx. When you
select a grid view in the dialog, a new check box, Size grid, appears. If this box is checked, OK leads to the
Grid Size dialog, to modify the size of the new grid. Otherwise, the grid is created with the current size.

Script Document
A script editor window opens in which a new script can be written, run and debugged. The file name extension
is .s2s.

Sequencer Document
A new window opens in which you can type, edit and compile an output sequence. The file name extension is
.pls.

Text Document
Text files can be used to take notes, build reports and to cut and paste text between other windows and
applications. The file name extension is . txt.

XY Document

XY windows are used to draw user-defined graphs with a wide variety of line and point styles. The Windows
file name extension is .sxy. They can be generated by scripts, or from the Analysis menu for trend plots.
Although we allow you to open them from the New File command, there is little point as you cannot do much
with an empty XY view.

Result document
Result documents are NOT generated from this menu. Instead, they are generated from Data documents
displayed in a Time view using the Analysis menu New Result View commands.
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Grid Size dialog

Open

The Grid Size dialog is used from the New File dialog to set the initial | change grid size %
size of a grid view and from the Grid view View menu Grid Size...
command to resize an existing grid. The dialog display the initial grid
columns and rows; modify these values as required and click OK to |[ g
set the new grid size.

Columns ‘ 20 * | Rows ‘ 20 = Cancel

Columns must be in the range 1 to 1000, rows in the range 1 to 1000000. As each cell in the grid occupies
memory, setting a huge number of cells will result, in the best case, with slow operation and in the worst with
Spike2 running out of memory. It will also make saving grids to disk and reading them back slow if a large
proportion of the cells are not blank.

This file menu and toolbar option opens a [ ceen S
dialog in which you can select a file. The dialog | €(_)=[= + Librries » Documents » « [ 43| [ Search Dosuments 2]
features depend on the operating system. You || owenice~  Newfolder =- @
can open six file types with this command: a T Documents library T
Spike2 data file, a Spike2 result view, a text Includes: 2 Jocations =
file, a script file, an output sequence file or an || == = Date modfed <
XY file. The type of the file is selected with the 3 it j:pknntt":‘
Files of type field. = 5l % SpikeDotasmne

= iz spike2_V2.smr
When you select a data file, Spike2 looks for a || &' ;"Li.m_va.smr
resource file of the same name, but with the file || ® compuer ::z'r::re;ms’w
extension .s2rx or .s2r. If this is found, the i i squarewavesmr
new window displays the file in the same state i S ol
and screen position as it was put away. Several 7l ,
windows may open if the file was closed with File name: 10943124 -
the ctrl key held down. See the Close B A R—
command details. \ eene e (5

Script Files (%.s25)

Spike2 opens an appropriate window type to iy

match the selected file type.

You can also open files by selecting them from the Most Recently Used list at the end of the File menu.

Read only files

Import

You can open Spike2 data files that are read-only, but you are not allowed to write any changes back to the file.
Read-only data files have [Read only] added to the window title. Unless the file is on a read-only medium
(such as CD) you can usually clear the read-only state by opening the Property page of the file (right click on
the file name or a list of selected files) and clear the Read-only check box. If you copy files from a read-only
drive such as a CD, the copied file is marked read-only.

Read-only text-based files open normally, but you cannot edit them.

Some commands that rely on writing will not work with read-only files.

Spike2 can translate data files from other formats into Spike2 data files. We make our best efforts to import
data, but can only import data that is compatible with Spike2 and for which we have knowledge of the input
format.

The File menu Import command is a pop-up menu with two option: Import and Options. Import leads to a
standard file open dialog in which you select the file type and file name to convert. Options opens a separate

6-3



Spike2 version 11 for Windows

dialog to set options that are common to all import types. Spike2 remembers the last importer you used and
offers that by default.

We are open to adding additional formats. To do so we need a description of the format and some example
files. Items marked NO LONGER SUPPORTED are not tested (as we have no example data files) and will be
removed in the future unless we get some indication that they are still useful (which will require example files
for import).

Import dialog
You then set the file name for the result; Spike2 will suggest the same name with the extension changed to
. smrx. The details of the conversion depend on the file type.

Supported formats include text files with data in columns, the CFS files used by CED programs such as Signal
and SIGAVG, Spike2 for Macintosh files as well as data from many third party vendors. Spike2 searches the
import folder in the Spike?2 installation folder for CED File Converter DLLs. The script language command to
convert files is FileConverts ().

We will write the new files as a 64-bit . smrx file. If you want the output as a 32-bit . smr file you can export
the result, or use Spike2 version 7 to import the data.

Data import has two main phases:
1. Scanning the input files to detect the file contents, channel types and data and time ranges present.
2. Transfer of data into a Spike2 data file.

The scanning phase is handled by the file converter DLL Data transfer is a co-operative effort between Spike2
and the converter DLL.

Display during import

Data file import can take a considerable time, [
especially if the source is very large or spread over
many files. Spike2 opens a resizeable progress || S——————
dialog displaying a summary of the import | Lioer i sidiedient e for S0 bt e
procedure; it also gives you the option of cancelling || Time base (us): 25, Channels: 32, Comment:

the import. This dialog may be unresponsive with || [uPut: < iGeoMiBBEITS_gating WN 10ms 80db.smox
older importers, particularly during the scanning || Section 1/1 at 0.000000

phase. Modern importers give feedback during
scanning but in some cases, you may not be able to

cancel import until the data transfer phase begins.  *

Transferring data...
32%

The progress dialog closes when the file has been transferred; the text contents of the dialog are written to the
Log view when the file closes, which can be useful if there were problems during the import.

Importer Configuration Files

Some importers store configuration files in the import folder; these files have the extension . icf. The last used
configuration for importer XXx is saved in XxX Last.icf. If a default format exists, it is saved in
XXX Def.icf. If the Def.icf file exists, it is used, otherwise the Last.icf file is used. Most importers
will survive without any configuration information as the built-in default settings will do something useful.
However, if you intend to import a binary or text file with the FileConvert$ () script command it is essential
that you have created configuration files, otherwise these importers will not know what to do with the data.

Import strategy
We import files of many different types. We have two basic models of external file:

1. Files with essentially independent channels that can stop or start at any time.
2. Files holding repeated frames/sweeps/episodes of data (such as captured by the CED Signal program).

The first type of file maps nicely into the Spike2 view of data, and such files usually import and look much the
same as their source. The second type can be more of a problem if the file does not specify the start time of
each sweep. For the second type, we import the sweeps (adjusting the start times so that sweeps do not overlap)
and we add a Marker channel holding the start and end of each sweep. The Marker channel is added as channel
31 (if channel 31 is not in use or if it is in use as a Marker channel), otherwise we add a Marker channel after
all imported channels.
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64-bit Spike2 build problems

Some of these importers rely on DLLs or object libraries supplied by third parties. If these DLLs or libraries
only exist in 32-bit versions, the 64-bit build of Spike2 cannot use them. These are marked as "32-bit only" in
the Notes (below); to import data for these you must install the 32-bit version of Spike2.

DLL name
The DLL column in the table below holds the name of the import DLL in the import folder and is provided for
script users who wish to force a particular DLL to be used to import your file.

File types we import

We import data from a wide variety of file types and we attempt to preserve as much of the original data
content and accuracy as we can. If there is a file type that you would like imported that is not in the list, please
contact us. To import a new type we need accurate file format information. We would like to thank the
companies that made such information available to us for their help. Some companies do not release their file
formats; in a few cases we have managed to figure out enough to extract useful information. In cases where
companies do not release the information and we have not been able to figure it out, you can sometimes export
data in other formats that we can import; of course, every change of format will tend to reduce the quality and
quantity of data that is imported.

If you find a problem in any importer, please contact us and explain the problem; in many cases the importers
were written with only a small number (sometimes 1) of examples of the source data. We will need a source
data file that fails to convert; please send us the smallest file that fails! Gigabyte-sized files are time-consuming
to transfer and analyse.

Data source Extension DLL Types imported cmd$Notes

S
ADInstruments adidat,  adi RealWave, Yes Added October 2019 wusing the
LabChart aciehe TextMark support software from LabChart

8.1.13. At [10.18] we set the date and
time of the first data section.

Allego xdat allego Waveform NeuroNexus data files. Added March
2022.
Alpha MED  DAT,MODAT alphamed  Wayeform Conductor, Performer and Mobius
Sciences data. Can import files larger than 2
GB.
Alpha Omega MAP, MPX alphaomega Waveform, Old format event data and WaveMark
Engineering WaveMark, supported. TextMark, MPX
RealMark, Event supported. Fixed y axis scaling

problem in Jan 2014. Copes with
discontinuous waveform data from
June 2015. [8.09] fixed potential
channel  alignment and  crash
problems, set file resolution as close
to 1 us as possible and made it faster.
[9.03] import Text stream comments.
[10.20] handles gain settings in recent

files.
Axon DAT,ABF  axon Waveform, (Molecular Devices) 32-bit only (so
Instruments TextMark not available in the 64-bit build of

Spike2). Imports 16-bit integer and
32-bit  float.  Library  updated
Jan/2014.

Axona BIN axona Waveform There is other information in this file
type (digital and status inputs, digital
and stimulus outputs, video tracking),
but the importer currently only
imports the 64 channels of waveforms.
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Data source Extension DLL

S
Binary data BIN, DAT
Bionic/ NEV, RND, N
Cyberkinetics  S*
Biopac ACQ
BrainVision = *.vhdr
CED CFS DAT, CFS

COLD_Datein *

CONSAM SSD, DAT

DATAPAC PAR, PBR,
PCR

DATAQ WDQ

Instruments

DataWave UFF, CUT
EWB

Data Sciences
International

Delsys Files  EMG
elmiko medical *

European Data EDF, BDF
Format(+)

Grass- BIN
Telefactor

HLR Data HLR
Format

binary

bionic

biopac

Types imported

Waveform, Yes
RealWave

Waveform, Marker,
WaveMark, Event

Waveform,
TextMark

brainvision Waveform, Marker Yes

cfs

coldadc

consam

datapac

codas

datawave

datag

delsys
elmiko

edf

polyview

hlr

Waveform,
RealWave

Waveform,
TextMark

Waveform

Waveform,
RealWave, Event

Waveform,
TextMark

Waveform,
WaveMark,
TextMark, Event

Waveform,
RealMark, TextMark

Waveform
Waveform

Waveform, Yes
TextMark

Waveform,
TextMark

Waveform,
RealMark, Event

cmd$Notes

Can import 8/16/32/64 bit signed and
unsigned integers data in big and
little-endian formats.

Can import files larger than 2 GB.
Handles version 3.0 files [10.21].

Imports 16-bit integer and 32-bit float
data. Jan 2018: Can import older-
formatted big-endian files.

Imports 16-bit integer and 32-bit float
data, plus markers.

Jan 2014: corrected marker channel
times when block has a negative time
offset.

Pulsion Medical Systems.

From Prof. D. Colquhuon. Supports
versions 1001, 1002.

Requires a .dat file holding
waveform data and events require a
.eft file.

DataQ Instruments Codas files

Imports  both
Workbench files.

Discovery  and

32-bit only. Imports files up to
version 5. You need a DSI dongle to
import version 5 files. Contact CED
for details. Files with 4 character
extensions supported. From [9.04] we
amalgamated the datagv5 and
dataq DLLs into dataq.dll. See
Ponemah importer for version 6 files.

Version 4 supported.

Since [7.06] we import dates so time
of day display can be used. Imports 16
and 24-bit data. From [8.09] we
import with a better time resolution,
convert 24-bit data to RealWave and
group annotations. [10.06] recognises
more BDF types. [10.08] fixed an
offset problem with asymmetrically-
scaled integer data.

(PolyView) We import versions from
2.0. NO LONGER SUPPORTED
(due to lack of test files).

NO LONGER SUPPORTED (due to
lack of test files). From software
Platon and Pyton version 3.00 and
4.00.
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Data source

Heka Data
Format

Intan

Multi Channel
System
(MC_Rack)

MindSet

MindWare

Motion Lab
Systems

Native ADC

NeuroScan

NewBehavior

Neuralynx

OoT
Bioelettronica

Percept PC

Extension

S
DAT

MCD

BIN

C3D

ADC

EEG, CNT

HEX

NEV, NCS,
NTT, NSE,
NST

otb+

JSON

DLL

heka

intan

mc_rack

mindset

mindware

c3d

nativeadc

neuroscan

neurolog

neuralynx

otbplus

perceptpc

Types imported

Waveform

Waveform

Waveform,
WaveMark, Event

Waveform

Waveform

Waveform, Marker

Waveform,
TextMark

Waveform, Event

Waveform

Waveform,
WaveMark,
TextMark

Waveform,
RealWave

RealWave,
RealMark

cmd$ Notes

Since [7.06] we support old format
Apple Macintosh files and time of day
display mode. From [8.12] the
experiment name can be up to 80
characters. From [9.03] we import
multiple sweeps. From [10.20] we
support floating point data import.

From [9.04] we import .rhd and
.rhs files and read digital channels
from .int files. We import
"Traditional Intan" format and not
"One File Per Channel" format.

We can import 12 and 16-bit data.
Library updated Aug/2015, when 64-
bit support was added. In order to use
the MC Rack importer you must have
the MC_Rack software from Multi
Channel Systems installed on your

computer.

Mindset (16/24) data Files: MindSet,
MindMeld

From 8.12 the length of channel units
was limited to 32 characters. From
9.03 we fixed bugs that caused
incorrect channel scales and labelling
and occasional bad data points. From
10.19 we support files with more than
65535 frames and SGI/MIPS sourced
files and import Markers. The latest
file specification and example files
can be found in the c3d.org web site.

Used by Polish universities as a
common data format. NO LONGER
SUPPORTED (due to lack of test
files).

Can read both 16 and 32-bit data.
Importer was based on file version 0.0
from May 1995.

(Neurologger) old and 2012 formats.
Jan/2014: added a dialog to select the
recording session to import. Modern
devices from this source export data
as EDF files.

Waveform channel y scaling factor
corrected Jan/2014.

Tested with files from
Sessantaquattro, Quattrocento, Due
Pro and Muovi devices.

Medtronic™ Percept PC JSON file
importer.
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Data source Extension DLL Types imported cmd$Notes
S
Plexon NEX, PLX, plexon Waveform, Can read data generated by the Plexon
Lo, s WaveMark, version 1.07 library. Spike2 9.04 fixed
TextMark, Event a problem reading files with multiple
sections. Spike2 10.14 has further
fixes.
Ponemah 6 PnmExp ponemah Waveform Yes Data is imported as RealWave.

Currently you cannot import Marker
data. Spike2 10.13 fixed a timing
problem with files with multiple
sections and allowed import filtering
by subject, channel and time range.

RC Electronics P?f’lr INX, rcelectric Waveform, NO LONGER SUPPORTED (due to
DAL TextMark lack of test files). Imports 12 and 16-
bit data.
Ripple Neuro NEV,NS*, ripple Waveform, Extends the NEV file format to handle
W WaveMark, Event, floating point data (NE* files). Special
RealWave treatment of some channels. Handles
version 3.0 files [10.21].
Text files TXT,ASC, ascii Waveform, Yes Fixed a TextMark timing issue in
CsV, TSV RealWave, Event, Jan/2014. Treats .csv files as comma
TextMark separators only, .tsv as tab
separators only.
T™S S00,Poly5 tmsi Waveform Added Poly5 extension support in
International March 2022.
Tucker-Davis TSQ, tev, tdt Waveform, You also need the . tev file to import
Technologies S€V WaveMark, Event, the data. February 2019: Added
Marker, RealWave StrobeOff events and fixed missing

WaveMark data. Added .sev import
in October 2019. Strobe value
displayed as floating point in March

2022.
WAV WAV mswave Waveform Handles 8, 16, 24 and 32-bit integer
(Microsoft) WAVE FORMAT PCM format data.
From Spike2 8.07 we handle the same
formats in

WAVE FORMAT EXTENSIBLE files.
32-bit support added at version 9.03.

WaveMetrics 1GO,IGR, igor Waveform Imports both PC and Mac files up to

Igor Pro LIS 2242 and including version 5.

LabRecorder XDF xdf Waveform, Extended in March 2022 to read
RealWave, RealMark and TextMark data and
TextMark deal with gaps in waveforms.

Xltek STC neuroworks Waveform, Event, Imports version 3.3 onwards. The

Neuroworks TextMark .stc file holds a list of all the data

files that make up the data (.erd/
.etc). We import all the raw
waveforms, an event channel of
Trigger data, and user-comments
made during sampling (.ent) and a
channel of TextMark data indicating
the original raw data file starts.
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Import DLL versions

Spike2 supports several import DLL versions from 4 to 7. Version 4 DLLs are the same as those used by
Spike2 version 7 and are limited to importing 32-bit time ranges and the output file size is limited by the 32-bit
SON file size limit of 1 TB. The version 5 DLLs were introduced to support 64-bit times and file sizes limited
only by your disk sizes and patience (though some importers may be limited by available system memory). The
version 5 import DLLs can also provide feedback into the progress dialog during the scanning phase (though
this is up to the DLL author). Version 6 DLLs are functionally the same as version 5, but have internal software
differences. Version 7 DLLs are functionally the same as version 6, but share the Spike2 system DLLs rather
than being independent of Spike2, which makes them much smaller and significantly faster to load.

When you select a file to import, you must first select a file type. If the file convert DLL is not the latest version
(7), we add [version] to the end of the file importer. For example, if you had a version 4 importer for old Spike2
data files the file type list would display:

Spike2 files (*.SMR)[4]

to indicate that this was an old style importer.

Writing an import DLL
If a data format is generally available and sufficient users want to import it, we are usually prepared to write an
import DLL to support the format.

However, you may have an exotic format of your own that no-one else uses, or you may have a private format
that you do not wish to reveal to third parties. In these cases, you may wish to write your own import DLL. To
do so you will need to be able to write code in C or C++ in the Windows environment. We have documentation
available on the DLL interface. Contact CED for more information.

Import problems

Before contacting CED with a problem, please read about importing files and read the any notes for your
particular file type.

If there are disk read problems or the input is damaged the import is likely to end with an error message.
However, there are other problems that can occur during data import that we can work around.

Data is input section by section. Some files may have only one section, others may have many. A section can
refer to a single sweep of data from a sweep-based capture system or it may refer to data captured after a
particular time marker; it is a flexible concept.

Within each section, data is captured channel by channel in ascending time order.

The output data is written in strictly ascending time order into the Spike2 data file. Spike2 data files have the
rule that within a channel, all data is in ascending time order and no two items can occur at the same time.
There is a basic quantum of time, the underlying clock tick, that all items are timed with. This is typically of
order 1 microsecond and usually no more than 50 microseconds; it can be much smaller.

When we import data, we check that all the data meets these requirements. When we import event-based
channels (event, level event, marker, WaveMark, TextMark and RealMark data), we read the data block by
block. We perform the following operations on each block:

1. If we have to apply a time offset, we do so (this can happen when importing sweep-based data where each
sweep has an independent time base)

We check that the data is in ascending order of time
If not in ascending time order we sort it into order

We delete data at negative times or at times that are beyond the tick range supported by Spike2

wok N

We delete data that occurs before the data at the end of the previous data block on this channel. This is
labelled as retrograde points. This usually indicates either a damaged or badly-written file or it could be a
fault in the importer. If this is a problem with your data you could consider contacting us about it.

6. If we have deleted retrograde points and the next point is at the same time as the last time in the previous
block, we delete that as well as it is unlikely to be useful (new at version [10.16]).
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7. We adjust the times of data that occurs at the same time as the previous data point by setting them at the

time of the previous data plus one tick. This type
of adjustment usually occurs as the result of
"bouncy switches", but this can occur
legitimately. For example, if a system wants to
drop a lot of text at a particular time it might
code the text in 80 character chunks all with the
same time stamp.

This is an example of a data file with two types of
problem. As we process each data block we generate
a message warning about deleted items and adjusted
times. Where a time is adjusted, we display the time
(in clock ticks) of the first adjusted point in the

Transferring data. ..

| 99%

Import DLL: smrdll4.dll Read data from SON format file
Source: K:\Geoff\BBB\T5_gating WN 10ms 80db.=mr
Time base (us): 25, Channels: 32, Comment:

Cutput: K:\Geoff\BBE\T5_gating WN 10ms 80db.emrx
Mode : independent channel

Section 1/1 at 0.000000

Chan 21, 5470 times adjusted first: 656185

Chan 22, 4923 times adjusted first: 1237966

Chan 23, 7526 times adjusted first: 914761

Chan 23, 4 retrograde points deleted, 2738 times adjusted first: §327¢
Chan 24, 7605 times adjusted first: 1900554

Chan 24, 2598 times adjusted first: 83279396

Chan 25, 7679 times adjusted first: 1182641

Chan 25, 6220 times adjusted first: 56292253

Summary of channel import problems

block. This can help you locate it afterwards to [| Chan 21i: 0 deleted, 5470 adjusted
. . . Chan 22: 0 deleted, 4923 adjusted

diagnose the problem. We will display up to 100 || cChan 23: 4 deleted, 10264 adjusted

warnings per channel, after which the file is || Sp=r 220 qeeter: 19203 2dlstes

processed silently. If there are any adjustments

needed, a Summary section is added to the output

(and to the Log file).

QJ

ADInstruments importer

This importer reads *.adidat and *.adicht files through a software toolkit supplied with LabChart. We
used the toolkit from version 8.1.13.

The ADI file format holds channel data in sections, and within each section the channels available can change
and so can the channel sampling rates. To allow us to import this into Spike2 where each channel has a fixed
sampling rate over the entire file and where a file has a continuous time base, though channels can start and
stop, we pre-process the ADI file as follows:

1. Scan the file to identify all channels holding raw waveform data and comments. We do not import plot
views or channels built from calculations or markers based on filters.

2. Scan all the sections to identify the highest sampling rate used for each channel within the file.

3. We import the data into a Spike2 data file holding all the identified channels sampled at the highest detected
rate.

Configuration options
There are two options that control how we map between the ADI data file and a Spike2 file: Interpolation
method and Trim gaps. These methods are set interactively by the importer Configuration dialog:

LabChart importer config

Interpolation method for upsampled sections Cubic spline o
Maximum gap length {negative for untrimmed)
Cancel

Interpolation

As the input data file may hold data sections that are sampled at a slower rate than the rate used by Spike2, we
need a method to fill the gaps. There are currently four options:

Method cmd$ Action

Cubic spline fill=cubic Ifyour data is band-limited to half the sampling rate of the section, this will
likely give the best result. It fits a cubic spline through the input data points

to generate the values between the points.

Linear fill=linear This draws a straight line between the input data points to predict the values
interpolate between them.
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Skyline fill=square This sets all the 'missing' points to the value of the previous input.

Zero fill fill=zero This sets all the 'missing' points to zero.

If your data files do not hold sections with changing sampling rates, it does not matter what interpolation
method you set as the data will not be interpolated.

Gap between sections

ADI data files hold data in sections, where each section starts at the same time across all the channels within it,
though some of the channels may hold no data. These sections can be widely separated in time, so we give you
the option of replacing all the gaps by a fixed, user-settable gap, in seconds. To set a gap from the script using
the cmd$ argument, use gap=seconds where seconds is the time gap you want in the range 0.0 to 100 seconds,
or set a negative gap to use the times in the original file. For example: gap=1.0 for 1 second maximum gaps or
gap=-1 to use the timing in the file. If you set a negative gap, you can use Time of Day mode on the Spike2 x
axis to review data by the wall clock time.

We have an example file where consecutive waveform data blocks on the same channel overlap in time by one
or more points. We cope with this by allowing the second block to overwrite the first.

TextMark import

We attempt to import comments in the file. Comment lines of more than 99 characters are truncated. You can
view the comments in a table by double-clicking a comment in the time view. We use the 4 marker codes to
store additional information. From the ADI importer version 1.03 onwards, these are:

Code Value saved
1-2  Marker codes defined by the Comment Map text file,

3-4  The channel number the comment relates to (1-32767) or O for a global or machine-generated comment.
This is coded as code2 + code3*256. If a comment was truncated, we add 128 to code 4. To decode the
channel use: code2 + 256 * (code3 band 127).

Version 1.02 of the imported used code 1 as the channel number, code 2 as the section number and codes 3-4
encoded the comment number.

We simple-mindedly expect comments to be discovered in time order and we reject retrograde comments. If
anyone finds this a problem contact us and we can try harder (by storing comments and sorting them into time
order, which may slow import down a tad). Comments that occur at the same time are spaced out by a single
clock tick; this can occur for machine generated comments at the start of the file and marking other sampling
events.

Comment Map

You can provide a text file that will set the first two marker codes in a comment based on matching text in the
text file. This is for the case where a system automatically generates comments, using the same or similar, text
for similar situations and it would be useful to give similar comments the same code. You tell the importer
which text file to use with the cmd$ option, cmap=<path to map file>. You can set this as the cmd$ option in
the FileConvert$() script command, or by typing it into the Import Options dialog. The initial
implementation expects the file to be encoded as ASCII or to hold UTF-8 encoded characters. Files generated
in the Spike?2 text editor will be suitable.

Each line of the text file is either a comment introduced by a semicolon, a directive introduced by a #, or
defines one or two marker codes and a regular expression that must match the comment text to generate the
code or codes. If there is no match, the first two codes are both set to 0. Currently there is only one directive,
which is:

#IgnoreCase
This causes all regular expressions from this point onwards to use case insensitive searches.
The format of lines holding text to match is:
<Code>,<Regular expression>

<Code> is an integer value that encodes the first two marker codes as codel + 256 * code2, so it lies in the
range 0 to 65535.
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<Regular expression> is text that follows the rules for an ECMAScript regular expression. If the regular
expression matches any part of the comment text, the first two codes of the comment are set based on the
<Code> field value. If you define multiple lines in the map, the lines are tested one at a time until one matches,
or all have failed. The time taken to search the map is proportional to the number of comments times the
number of lines in the map. You can save time by placing the most common items at the start of the list.

We use Regular expressions rather than a simple-minded left-matching search because it will let you match
lines in a pretty general manner, and will allow you to treat lines that only differ due to embedded numbers as
matching. If you only need to match the first few characters of a comment you can make a simple file, such as:

;Simple comment map that left-matches the comment text and ignores case in matching
#IgnoreCase

1,"ECG

3,ALVP

6, EMG

The ~ means match the start of the comment. Note that code 1 will be applied to comments of the form "Ecg
from Cat", "ECGraph" and so on. If you want to match the text anywhere in the comment, omit the ~. You can
also match the end of the comment with the $ symbol. If you need to match all comments that contain "Dog"
and end with "pressure” you could use:

4,"Dog. *pressure$

You are referred to the regular expression description for the InStrRE () script command for more information
on matching and that has links to web sites that explain the many intricacies and pitfalls of regular expressions.
Beware that it is possible for complex expressions to take a long time to search for matches, particularly if they
contain more than 1 wildcard (. * is an example of such a search).

Script controlled import

If you use the FileConvert$ () script command and do not provide the cmd$ argument, the default settings
are to use cubic-spline interpolation and to separate each section with a 1 second gap. To set your own
preferences, you would pass a string of the form: "fill=1inear;gap=1.5" for linear interpolation and a gap
of 1.5 seconds between sections. The £111 and gap options are not case sensitive, but we suggest that you stick
to lower case.

Binary importer

The binary importer will import blocks of data that consist of interleaved channels of waveform data of the
same type with all channels at the same sample rate. The type can be 8, 16 or 32-bit signed or unsigned integers
and 32-bit and 64-bit IEEE Real data. Data can be arranged in little endian (most common) and big-endian (e.g.
very old Apple Macintosh data). Data is expected to start at a known offset into a file (often 0) and continue to
the end. By interleaved we mean that the file holds all the channels data for the first point, then all for the
second and so on. For example if CmPm means Channel n, point number m, then a file holding three channels (0,
1 and 2) would have consecutive data elements:

COPO C1lPO C2PO COPO C1lP1 C2P1 COP2 ClP2 C2P2 COP3 C1P3 C2P3

The binary importer uses configuration files Bin Last.icfx and Bin Def.icfx. If the .icfx files are not
found, old format .icf files are used, otherwise even older .cim files are used. These files are in the current
user specific, application data folder.

The binary importer supports the following names in the cmd$ string for the FileConvert$ () command. If
any of these fields are not supplied no change is made to the existing settings, so if a configuration file is
specified, the values it sets are used unless overridden.

name value

Conf Configuration file name. If this string is not empty then the provided file name including its full
path will be used to load the configuration file. This keyword is always applied first, regardless of
its position in the cmd$ string.

Bigend Input file origin. Set to 0 if this is a little-endian file (which is almost always the case on modern
systems) or to 1 if this is a big-endian file. The default is 0. In a little-endian file, lower
significance bytes are at lower file offsets than higher significance bytes. If the 32-bit hexadecimal
number 0x87654321 was stored at the start of a binary file, the first 4 bytes would be 0x21, 0x43,
0x65, 0x87 in a little-endian file and as 0x87, 0x65, 0x43, 0x21 in a big-endian file.
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Type Input data type. Set to O for 8-bit signed integers, 1 for 8-bit unsigned integers, 2 for 16-bit signed
integers, 3 for 16-bit unsigned integers, 4 for 32-bit signed integers, 5 for single-precision floating
point numbers and 6 for double-precision floating point numbers.

Rate File sampling rate in Hz. If present it sets the overall file sampling rate.
Chans Sets the number of imported waveform channels.
Names Channel name. You provide a list of channel names for each imported channel separated by

commas, for example: Names=Resp, HR, BP.

Units Channel units. You provide a list of units for each imported channel separated by commas, for
example Units=bpm, bpm, mmHg.

Header If present, this value sets the offset to the start of the data, in bytes.

Resources are used in the following order:

1. A default state is set.

2. Bin Def.icfx is used, if it exists.

3. IfnoBin Def files are found, Bin Last.icfx is loaded.
4

If the conf keyword is used, and the nominated file exists, it is loaded and overrides the current
configuration.

5. Any other keywords are then applied.

An example

The following example imports a binary data file and passes in information as described in the table above. The
configuration is read from the file: c:/s/b.icfx, then the number of channels to import and the channel names
and units are set to override whatever was set in the configuration file. In most cases, you will set a
configuration file and not need to override any of the values set in it.

var ret$;

var src$, dest$, flag%, err%, scom$;

src$ ""; 'Blank name so user is prompted for the source file
dest$ := ""; 'Blank name so user is prompted for the destination file
flag¥% := 0,
scom$:="Conf=c:/s/b.icfx;Chans=2;Names=HR,BP;Units=bpm,mmHg";

ret$ := FileConvert$(src$, dest$, flagkh, err%, scom$);

Bionic/Cybernetics/Ripple

These importers are almost identical and are described together.

The NEV file format has seen several revisions. The basic idea is that the format supports an array of up to 256
(expanded to 512) electrodes that are all sampled at the same rate (typically 30 kHz). From each electrode
neural events (spike shapes) are detected, each of a fixed length (typically 52 points) with typically 15 samples
before the trigger point. The spikes are typically stored using either 1 or 2 bytes of data per sample point. These
channels are imported if they hold any data, that is empty channels are not imported. These channels are
imported on channel 8 upwards. They have channel titles formatted as: "Elec 101" indicating the source of
the data. The channels are calibrated in "uv". We copy any class code as the first marker code, the second
marker code is copied from a reserved byte in the file (normally 0), the other two codes are set to 0.

Some files also hold stimulus data that corresponds with the electrodes. This can potentially add 512 more data
channels holding waveforms that look like spike data, but that were outputs rather than inputs. These channels
are imported if they hold any data and follow on from the electrode channels. They have channel titles
formatted as "Stim 101" indicating the electrode that matches the data. These channels are calibrated in "v".
We copy class codes for stimuli exactly as for Electrode data except that the third marker code is set to 1 to
indicate a stimulus.

The format also allows for auxiliary channels that can be used to detect other events. There is a digital input of
up to 16-bits that is imported as marker data on channel 1 (first marker code is bits 7-0, second is bits 15-8).
There are 5 'Analog' event inputs that detect changes of state on rising, falling or both edges. These are
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imported on channels 2-6 as events or level channels, as appropriate (but see below for channel 6). There is also
a periodic event channel, imported on channel 7.

In addition to the NEV file which holds data packets representing spikes and events, there can be additional
data files holding continuous data taken from the electrodes. These files have names with extensions .NSx for
files holding integer data and .NFx for files holding 32-bit floating point data (Ripple). The x can be 1-9. Each
such file holds a group of channel taken from the electrodes that are all sampled at the same rate; these are
down-sampled versions of the electrode signals (though the down-sample ration can be 1). An early version of
the format had the extension .RND and held Raw Neural Data sampled at the same rate as the electrodes. A
more recent version of the format allows the continuous data to be turned on and off, generating data sections.
These channels are imported with the channel titles and units defined in the data file.

File versions

Version 2 files use 32-bit time stamps, typically starting at 0 at the beginning of the recorded data with a
resolution of 1/30000 of a second. Version 3 files use 64-bit time stamps, typically being the UTC time (count
of nanoseconds since January 1 1970). Waveform channels are still sampled at multiples of 1/30000 of a
second, which is a bit awkward as 30 kHz is not exactly representable in nanoseconds. We have seen files with
retrograde time steps (which we attempt to survive by ignoring overlapped data) and files that are said to be
sampled at say 1 kHz, but actually have gaps between samples of a few nanoseconds more or less than 1
millisecond. Spike2 expects files to have a constant sample interval. If we find that a cumulative error exceeds
half a sample interval, we will put in a gap in the data or we will drop a point.

How we import the data
What we do depends on which file you select for import.

If you select a *.nev file, we attempt to reassemble all the data files from the recording (*.nev and any
associated *.nsx and *.nfx files) into one Spike2 output file. We identify files by having the same file name
and having time matching internal base sampling rates and a system time (stored in the file) that matches to
within 10 seconds (though all files we have seen have exactly matching system times).

If you select any other files except a *.nev file, we import this file on its own. It will contain waveform data
with all channels sampled at the same rate. Channels will be assigned in the order we find the channels in the
input file, starting at channel 1.

There are differences depending on which importer you choose:

Bionics/Cybernetics

We expect to import files with the extensions NEV, RND and NSx. However, if you choose a NEV file and there is
a matching NFx file, we will include it. Event channel 6 (if present) is always imported as a Level event
channel.

Ripple

We import files with the extensions NEV, NSx and NFx. Event channel 6 (if present) is always imported as a
Marker channel and uses the digital input data as marker codes (first code is bits 7-0 and the second code is bits
15-8).

Problems

This format is used by a range of companies and there is no guarantee that they have all implemented the format
in exactly the same manner. If you have a problem importing a file or set of files, please contact us and describe
the problem (and send us any screen output) before sending us files. We will almost certainly need example
files, but we need the smallest file(s) that illustrate the problem (usually a few MB). DO NOT send us GB of
unsolicited data!
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BIOPAC importer

The BIOPAC importer is in two parts:

1. An importer that we wrote based on the BIOPAC Application Note 156 that can import a range of older
files with big-endian or little-endian data. We do not have examples of all possible file formats to test,
however, we have seen this import files with internal version numbers from 42 (AcqKnowledge 3.7) up to
84 (AcqKnowledge 4.1.1). We know that the current version does not import files with an internal version
of 108 (4.2.0). If you have files beyond the range 42-84 that do import, we would be interested to know so
we can update this information (the internal revision is included in the imported file comment). The latest
changes (January 2020) allowed us to import a version 38 file, which appeared to have a damaged end.

2. An importer that reads more modern BIOPAC files using the BIOPAC AcqKnowledge Software API
(ACKAPI). According to the BIOPAC web site this should read files from AcqKnowledge 4.1 - 4.4.2 and
from Biopac Student Lab 4.0 - 4.1 and 3.7.0 - 3.7.2. We think that this reads little-endian files only (it does
not read any of the big-endian example files we have).

Adding the ACKAPI support to Spike2

To import the more modern files, you must obtain the ACKAPI pack from BIOPAC. Once installed, you will
need to copy the acqfile.dll from the BIOPAC distribution for the correct build of Spike2 (either 64-bit in
the x64 distribution folder or 32-bit in the win32 distribution folder) into the Spike2 application folder. Once
this DLL is in place, the importer will attempt to open the file you wish to import with the BIOPAC
acqgfile.dll first, and if this fails, it will fall back to the CED code based on the published BIOPAC
Application Note.

If you are not sure which version of Spike2 you are running, look in the Spike2 Help menu About Spike2 box.
If this says 64-bit, you are running a 64-bit version of Spike2 on a 64-bit system. If it says 32-bit, you are
running a 32-bit version of Spike2, but you could be running on either type of system. If the C:\Program
Files (x86) folder exists, you are running on a 64-bit version of Windows.

The easiest way to find where Spike2 is installed is to use the Help menu About Spike2... command to open
the About Spike2 dialog and use the Copy button to place all the path information (including the Installation
path) on the clipboard.

On more modern versions of Windows you will need Administrator privileges to copy files into the Spike2
folder. In Windows 10 you can do the following once you have installed the ACKPAC and assuming it has
installed itself in the Program files folder:

1. Log into your system with Administrator privilege.
2. In the 'Cortana' window at the bottom left of the screen, type Command Prompt

3. A Best match should appear with "Command prompt; Desktop App". Right-click this and select "Run
as Administrator".

4. A command prompt: "Administrator: Command Prompt" will appear. You can now use the command
window copy command to move the correct DLL into Spike2. For example to copy the files on a 64-bit
version of Windows to a 64-bit copy of Spike?2:

copy "C:\Program Files (x86)\BIOPAC Systems, Inc\BIOPAC File API 3.3\x64\acqfile.dll" "C:\Program I
or to copy the files on a 64-bit version of Windows to a 32-bit copy of Spike2:

copy "C:\Program Files (x86)\BIOPAC Systems, Inc\BIOPAC File API 3.3\Win32\acqfile.d1ll" "C:\Prograr
If you are on a 32-bit operating system, use:

copy "C:\Program Files\BIOPAC Systems, Inc\BIOPAC File API 3.3\Win32\acqfile.dll" "C:\Program File:

You may wish to make a batch file to do this (save the command text in a text file called copyacq.bat, for
example) as you will need to repeat this when you update Spike2.
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BrainVision importer

The BrainVision importer can read files that adher to the document: Specification of BrainVision Core Data
Format 1.0, Version 2.5, last modified 12/December/2019. To import the data, you require the file
fileName.vhdr, which describes the data and holds the names of the marker and data files, an optional
fileName.vmrk file, that describes markers in the file and holds file Segmentation information, plus the data
file, which has the file name extension .eeg, .avg, or .seg).

The data file holds either 16-bit integer data or 32-bit floating point data. The examples we have used to
develop the importer have all held 16-bit integer data. They have also held the data in a single, continuous
segment, so we cannot guarantee that the importer will work with multi-segment files.

Channels that are imported

The format describes multiple channels of data, all sampled at the same rate. The importer copies the channel
titles, scaling and units from the files and generates a channel comment that includes any reference channel set
and the electrode position as: (radius, theta, phi). For example, the channel comment might be:

Ref=FP1, (1,90,0)
If a channel has no reference, the REF=Xxx text is omitted.

In addition to the waveform channels, an extra TextMark channel is generated holding any markers set for the
file. Markers have a Type (a text string) and a Description, plus a position, a duration and the channel they are
associated with. We encode this in the TextMark channel by setting the text to:

Type: Description

And using the first marker code to set a type. If you take no action, type codes are assigned upwards from 0
based on the whatever type is set for the marker. You can pre-set known type codes (so particular marker types
always get the same code), see Setting Type codes, below.

The Channel that is associated with the marker is encoded in the second and third marker codes. The second
Marker code holds the lower 8 bits of the channel number and the third holds the upper 8 bits (so if you have
fewer than 256 channels, the second marker code is set to the channel). These codes are set to 0 if the marker
applies to all channels (often the case).

The duration of the marker, in sample points, is saved in the extra 32 data bits that are accessable with with
LastTime (), NextTime (), ChanData () and MarkEdit (), using the optional code% [4] item.

Setting Type codes
You can pre-define a list of code types to force known types to have known type codes. To do this, create a text
file with the pre-defined types, one per line. For example, using types we have seen in examples:

; Lines that start with a semi-colon are ignored
Comment

SyncStatus

Response

Stimulus

These 4 types will be given the codes 0, 1, 2 and 3. If more types are found, these will get additional codes.
Currently the type codes are case sensitive, however we may change this if it is an issue.

You can either give this file the name Brainvision.mrk or you can use the Cmd$ argument to set a file name
(see, below). If you set a file name, and the name does not include any path information (i.e. none of the
characters /, \ or :), the importer will search for the file in the following places and use the first it finds:

1. The folder holding the . vhdr source file.

2. The current user application data folder:
(C:\Users\<User><.Domain>\AppData\Local\CED\<App>\)

3. All users application data folder:
(C:\ProgramData\CED\<App>\)

4. The current user My Documents application folder:
(C:\Users\<User><.Domain>\Documents\<App>\)
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5. The current user My Documents folder:
(C:\Users\<User><.Domain>\Documents\)

where <User> is the user name, <.Domain> is the user domain (if part of one), and <App> is Spikell or
Signals, or whatever application is being used to import data. The example paths are the ones that are used on
my machine.

FileConvert$() command cmd$ argument

From the script language and the Import Options... dialog you can preset the file used to read marker type
codes. The items are added before scanning the .vmrk file for names, so these script-added items get priority.
The syntax is:

FileMark=<filename>

<filename> should include any file extension (.mrk is suggested), and the file should be ASCII or UTF-8
format. The file name can include a path, in which case only that path is searched for the file or it can have no
path, in which case the paths listed above are searched.

DataPac Importer

Igor

DataPac files have one of three types of file header (A, B or C) stored in a .par, .pbr or .pcr file plus a
.dat data file holding waveform data and an optional .eft file holding event start and stop times. The type of
data stored in the .dat file is often 16-bit integer, but can be float (4 byte floating point) or double (8 byte
floating point). We attempt to guess the data type based on the . dat file size.

If the channel is stored as integer data, the result is the integer data value, so you will likely need to calibrate it
after reading it. If the data is stored as float or double data it will be in the original units, as stored. There are no
units stored with the data, so it will appear with units of "V", which is the default.

We can scan Igor files with a variety of extensions (IGO, IGR, IBW, PXP) for Waveform data. Not all
waveforms found in these files are useful. We import waves composed of signed 1, 2 and 4 byte integers and
32-bit and 64-bit floating point data. We do not attempt to imports unsigned integer data (though we could if it
was really important to do so) now do we import complex waves (for example the results of spectral analysis).

We have had plausible results from IBW (Igor Binary Wave) and from PXP files (though PXP files can hold
many types of information, such as Pie charts and the like, that do not lend themselves to waveform import).

MC_Rack

To use this importer to read .mcd files you need the MCStream.d11 component. You can obtain this, in July
2022, by downloading the MC Rack software from the multichannel systems web site:
https://www.multichannelsystems.com/software/mc-rack and click on the MC_Rack Setup link.
The latest version we have tested with is 4.6.2 dated 2015-02-12.

The importer uses the MCStream software to open and read the data file. If you get error -100 when you
attempt to open a file, this means that the MCStream library has failed to open the file and there is likely
nothing we can do to help you. If you get other error codes, or channels you think should be present are
missing, we may be able to help you if you send us the (smallest) data file that suffers from the problem.

In addition to analog and electrode channels, the importer recognises Spike shape channels and events. From
version [10.16] it also attempts to import digital channels, which hold up to 16 bits of digital information
sampled as if it was a waveform channel. If such a channel is located, it is imported as if it was a waveform, and
also as up to 16 level event channels. These channels are created by treating the signal as 16 separate digital
channels and looking for changes. Each change generates an event. The digital channel is preserved (for
backwards compatibility).
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Motion Labs (C3D) importer

This importer should import most generic C3D files as described in The C3D File Format User Guide available
from: https://www.c3d.org/pdf/c3dformat ug.pdf

These files contain 3D information channels and ANALOG channels. The basic idea is that the 3D information
is obtained from a video system and generates one (X, y, z, extra) value per video frame plus a list of other
channels (the ANALOG group data). The ANALOG channels can be sampled at a multiple of the video frame
rate. Files do not have to have any video data, so can be used to exchange general waveform data. All the
ANALOG channels are sampled at the same rate.

Each 3D channel generates 3 channels in the imported file holding x, y and z co-ordinate values. We append
X, Yand Z to the end of the channel names to identify them.

Each ANALOG channel generates 1 channel.

We extract the channel names, descriptions, units and scales from the Parameter section of the file, if it is stored
there. We scale the data following the rules in the Motion Lab Systems document: The C3D File Format User
Guide.

The importer can read files holding integer or float data (including data written by old systems with PDP-11
style float format).

From Spike2 version [9.04], the importer reads the up to 18 events that can be stored in the file header.

We do not read any events that are stored in the Parameter section of the file (we have no example file holding
this information). If you need to access this data and have example files holding it, contact us and we will look
into scheduling the work to implement this.

NeuroScan importer

This importer imports both .cnt and .eeg extension files. We have example . cnt files from 1995 and 2007
and .eegq files from 1995.

The .cnt file importer

This imports the files as a list of waveform channels and one Marker channel. Prior to Spike2 10.14, there was
one marker generated per waveform sample sweep, which was a lot of markers, most of which held unchanging
data. The 4 attached marker codes for each Marker hold:

Code Usage

0 Lower 8 bits of the 16-bit StimType held in each event.

1 The upper 8 bits of the StimType.

2 Keyboard input. Range 0-11 corresponding to function keys.

3 Bits 3-0 hold the coded response pad, bits 7-4 hold 0x0d for accept, 0xOc for reject.

At [10.14], to make the marker data a bit more manageable, we only log changes in the state of the events. The
first marker establishes the initial state, then there is a new marker each time something changes. If the first
marker is not at time 0, there is no information about states before this time.

The example files we have are Version 3.0, and these import OK (though we have nothing to compare the
results with).

The .eeg importer
This imports channels of waveform data.
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EDF importer

The EDF importer reads EDF, EDF+, BDF and BDF+ files. It does not implement logarithmic compression of
data (but let us know if this is essential for your use and we will consider adding it). It is targeted at reading
continuous recordings of data; it may work with discontinuous recordings, but we have no examples of this data

type.
EDF data waveforms are treated as 16-bit data with scale and offset and are imported as Waveform data.
BDF data waveforms are 24-bit data and we import them as RealWave data.

BDF files can hold a Status channel that holds up to 16 channels of digital information. If any of these channel
holds changes, we import the channel as a level event channel. Currently these channels start as low at the
beginning of the recording and each change toggles the state. These digital signals have the same timing
resolution as the waveform data.

The time resolution of the imported data file is set as close to 1 microsecond as possible while exactly matching
the file sample rate.

Annotations in EDF+ and BDF+ files

Annotations are time stamps with optional attached data and duration. We ignore annotations at negative times
(before the recording started) as this does not fit the Spike2 file model (these are permitted by the EDF+
standard but we have never seen one). Each annotation record in the raw data has the format:

[+-]Time{<21>Dur}<20>{Text1<20>}{Textn<20>}*<20><0>

[+-1] One of + or -. We ignore annotations that start with -. This is the time of the annotation in seconds
from the start of sampling.

Time  The time of the annotation in seconds, written using 0-9 and . (though we will accept almost any
reasonable number format).

{...} Anoptional block (.. . represents the contents).

<n> A byte with the value n, for example <20> is a byte with the decimal value 20.
Dur A duration, in seconds in the same format as Time.

The preceding optional block is repeated 0 or more times

Textl The first annotation text. If this is not empty and does not exceed a set length (50 characters, was 30
before [10.18]), we look it up in a table of known annotations. If it is found, we add a code to the
TextMark, if not found, we add this to the table of annotations and give it the next available code.
Text in these blocks is encoded in UTF 8 (which includes ASCII) and must not include <20> or
<21> as these are used as separators/duration markers.

Textn  Further annotations at this time with the same restrictions as Text1. We do not look these up in the
annotation table.

If we parse the annotation without error, and the annotation held text other than the time, we add a TextMark at
the given time with the annotation code, or 0 if it is too long (assumed to be free text). The standard format of
the text attached to the TextMark is:

Text1{|Textn}*{ [Dur]}

Most annotations we have seen in examples either have no text, or have just Text1 and may have a duration.
However, the format we have used should make it relatively easy to parse the text. If there is a duration, it is
added to the end of the marker enclosed in square brackets and separated from the test of the text by a space.
You can select an alternative format by using the FileConvert$ () script command with the Cmds argument.

If none of the annotations in an annotation channel hold any text or duration, we add a simple event channel
with events at the annotation times.

Standard annotation codes
The EDF format definition suggest that there is a standard list of annotations. We have implemented this list
and given them fixed codes 1 to 35:
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Code Annotation
Annotation text longer than the limit or no text
Lights off

Lights on

Sleep stage
Sleep stage
Sleep stage
Sleep stage
Sleep stage
Sleep stage

OO W NS

Sleep stage
Movement time
Sleep stage N
Sleep stage N1
Sleep stage N2
Sleep stage N3
Apnea

Obstructive apnea
Central apnea
Mixed apnea
Hypopnea
Hypoventilation
Periodic breathing
CS breathing

RERA

Limb movement

PLMS

EEG arousal

Sinus Tachycardia
WC tachycardia

NC tachycardia
Bradycardia
Asystole

Atrial fibrillation
Bruxism

RBD

RMD

Sequentially assigned codes for other annotations discovered in the file.

w
> NEOS I UCIUC IR TCRNUC I UC TN NO 2 NG T NS T NG T N T N6 T NG T NG S NG T N J Sy g Gy G G S Sy
JOROUN SO0V UNRWND SOOIV A WN LoV XXNUN DA W —O

The codes we assign to other annotations are shared between all annotation channels (files can have multiple
annotation channels and they may relate to similar signals). There is nothing significant in the codes, other than
1-35 are standard and 36 onwards are in the order of discovery. If you use the FileConverts () script
command with the Cmd$ argument you can remove these predefined annotations and define your own.

Codes are not limited to 0-255, and can extend to much higher numbers if you have many different annotations.
Markers in Spike2 have four marker codes. If the code exceeds 255, then marker code 0 is (code band 255)
and marker code 1 is (code / 256). That is, marker code 0 is the lowest byte of the integer code, marker code 1
is the next byte (and so on if you have more than 65535 codes).

EDF Cmd$ keywords

When used from FileConvert$ (), the following keywords are available through the Cmd$ argument:

name value

TMSep This can be assigned the values 0 (the default, same as omitting the keyword) and 1. If you set 0,
TextMark strings are generated to be easily human readable. Multiple annotations in one marker
are separate by the vertical bar character | and any duration is added to the end of the marker as
" [duration]". This format is can have problems if the annotation text already contains vertical
bars or square braces. If you set 1, multiple annotations are separated by the ASCII character code
Chr$ (20) and any duration is preceded by Chrs (21). For example, text might appear in one or
other of these forms:
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"Annotation 1|Annotation 2 [2.234]"
"Annotation 1"+Char$(20)+"Annotation 2"+Chr$(21)+"2.234"

You might prefer the second format if you were going to use a script to further process the
imported data and you wanted to unambiguously separate annotations and durations (characters
<20> and <21> cannot be used except as separators in a legal EDF file.

NoPreDef [f this keyword is present, all the predefined Standard Annotation Codes are removed. The next
added annotation will get code 1 unless AnBase is used.

AnBase This sets the first code to use for added annotations. Each time an annotation is added by the
AnList keyword (see below), or by encountering an unknown annotation that is not more than 30
characters in length, the annotation gets the current AnBase value, then the value is incremented
for the next item. Put another way, the annotations have consecutive codes from AnBase. If you
do not use NoPreDef, the default AnBase value is 36, if you do use NoPreDef, it is 1.

AnList You can pre-set a list of annotations. These are assigned consecutive codes, starting at the current
AnBase value. To be added, the annotation must not be more than 30 characters long. For
example:

Cmd$:="AnBase=1;AnList=0ne,Two,Three,\"this, or that\",last";

Annotations One, Two and Three have codes 1, 2 and 3, this, or that has code 4 (note use
of quotes to include a comma which would otherwise be a separator). 1ast has code 5.

AnCode Use this to set a list of annotations with defined codes. There are pairs of values assigned to the
keyword. The first of each pair is a code, the second is the annotation. For example:

Cmd$:="AnCode=49,0ne,50,Two,57,Nine";

This assigns codes 49, 50 and 57 to One, Two and Nine. These are the ASCII codes for "1", "2"
and "9".

Heka importer

Heka files have several versions. The earlier ones had a .dat file and additional files with the same base name
and different extensions that included .pgf (holding the Stimulus Templates) and .pul (holding the
Acquisition Parameters). More recent formats have a single .dat file that includes all the information. If you
import an older format .dat file and the .pgf or .pls files are missing, the importer will reject the file with
error -100. The import progress window (usually under the window with the error message) will mention the
first file that it failed to find.

Heka files are arranged in a tree. You can visualise the structure in the user dialog that is displayed when you
use the interactive File menu Import... command:

The tree from a typical file (the Heka demonstration file from their web site) is displayed on
the left with some of the branches open and some closed. Any file you open will have a similar
structure, but the names and number of the branches will vary, depending on the file contents.

The points where the branches meet the Root or the parent branch are called Nodes. Nodes of
the tree are indicated by a small box holding either a + symbol (click it to open the node and
display the contents) or a - symbol (click it to fold up the node and hide the contents).

. All nodes of the tree have a check-box. If you uncheck a node, it, and all the data that belongs
to that node will not be imported. If you unselect the Root of the tree (Demo), nothing will be
imported and you will get an error if you try to import.

A Inactiv.
CviRecov. Below the Root are the Groups. A Group is composed of (presumably) related experiments.

‘[“IThesit  However, there is no requirement that the members of a Group are compatible (in the sense
mkSingles that they can be imported into the same Spike2 data file). In this case, the names of the Groups
H]CHiber are: IV, ramps(t), Tails, Inst.IV, Gating, Sodium Ch., Inactiv., Singles, C-fiber. There is no

requirement for the names of the groups to be different, and in many cases the names will
repeat. If you uncheck a group, it will not be imported.

Within each Group are Series. A Series holds one or more Sweeps of data, and all the sweeps in a series are
compatible (in the Spike2 sense of being readable into the same file). The name of each series indicates the
protocol used to generate the data. If you uncheck a series, the data for the series will not be imported. In the
example, there are visible series with the names: 1V, i_IV, Hinf and Thesit.
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By default, all data in the tree is selected for import (unless you use the cmd$ argument to pre-select specific
items). When importing under script control, the dialog is not displayed; selections are made based on the cmds
argument.

However, having items selected does not guarantee that they are imported. When you close the dialog to import
the data, the importer searches the tree to find the first Series that is selected for import. This generates the
template that is used to create an output file. The importer then scans the tree of selected items and unselects
any Series that is not compatible with the template. Currently, being compatible means:

1. The Series has the same number of data channels as the template.
2. The channels have the same type as the template.
3. The channels have the same sample rate as the channels in the template.

A series does not have to have the same number of data points as the template (and some series may have a
channel with no data points).

Gap-free

Normally, every sweep of data is imported as a separate chunk of data and the Marker channel is used to
indicate the start and end of each sweep. If you check the Gap-free check box, the data is imported as if it was
sampled in one continuous section with no indication of where each internal sweep started or ended. This is not
usually what you want.

Group and Series TextMark channels

In addition to the waveform data channels found in the file, we add two additional TextMark channels. These
are added to the file each time a sweep is imported when the Group or Series in the original data changes. Data
is added even if the Group or Series has the same name as the previous one. The importer also keeps track of
the Group and Series name and allocates them codes, starting at 1 based on the order in which they are
discovered in the original file (without any regard to which check boxes are clicked). These codes are given to
the TextMark items to allow you to identify them. If you are running the importer from a script, you can pre-set
the identifiers using the GROUP= and SERIES= values in the FileConvert$ () cmd$ argument.

FileConvert$() command cmd$ argument

From the script language and the Import Options... dialog you can preset the codes associated with group or
series names. The items are added before scanning the data file for names, so these script-added items get codes
starting from 1. For example setting FileConvert$() command cmd$ argument to
"GROUP=Grl, Gr2,Gr3; SERIES=S1,52,S3, Series4" will pre-set three group names and 4 series names
(note that group and series name matching is case insensitive and uses ECMAScript regular expressions).

If you do not set group names, all groups are selected. If you do not set series names, all series are selected (but
only if its group is selected). If you set neither a GROUP nor a SERIES then everything is selected. The first
selected group/series combination sets the type of data that is to be imported and if any of the subsequent
selections are incompatible, they are rejected.

A match means that the regular expressions matches the group or series name. The examples given above for
GROUP will match any group name that contains any of Grl, Gr2 or Gr3. To force an exact match you would
use "GROUP="Grl$, ~Gr2$, ~Gr3s" or the more succinct "GROUP="Gr[123]1$". See the regular expressions
description to see all the (very many) possibilities.

If your matching text must include commas (which are separators), you can enclose the text in double quotes.
So, to match 10,11, 12 in a series name and also exactly match s1 you could set (from a script):

cmd$ := "SERIES=\"10,11,12\","S1$";

The \" combination is to escape the double quote within the text string (otherwise they would terminate the
string and cause a syntax error). If you type this text into the Import Options... dialog you would use:
SERIES="10,11,12", ~S1$ as there is no need to escape the double quotes.

If your choice of GROUP and SERIES ends up selecting nothing, import will fail with an error.

New features

Before version [9.03], the importer would import one sweep of data from the first selected item in the tree. It
was also limited to files with a maximum of 20 Groups and 100 Series within a group. It did not import the
names of the Groups and Series as TextMark data.
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Before version [10.20] the importer did not know about floating point data and imported it as rubbish. Also, if a
required file was missing only the . dat file was listed, so it was not clear what had gone wrong.

Before version [10.21] script import always failed. The use of regular expressions was added at this revision.

Ponemah importer

This importer reads all waveform data as RealWave. It currently does not import Marker data as this is not
supported by the DSI import software we have access to. The import code we use as the basis of the import
filter is taken from the DSI web site. The last time we checked it (November 2021), it was at:

https://support.datasci.com/hc/en-us/articles/360052428493-Reading-Ponemah-6-x-data-into-Matlab

The data file is imported with a time resolution of 0.1 microseconds (which is the resolution used to record
them). If you have any problems using this importer, see the Problems section at the end of this page for
possible solutions.

Channel information we extract

We generate channels of data from the Ponemah file in the order that the channels are found. Channels are
ordered by <Subject>, then by <ChanId>, so all the data for one subject is grouped together in consecutive
Spike2 data channels.

The channel Title is copied as supplied, as are the channel units. The channels are read as RealWave data and
the scale and offset are set so that if the channel were converted to a Waveform channel (16-bit integer), the
range of data in the channel would fit within the 16-bit range. If the data range includes 0.0, the offset value is
set to 0, otherwise it is set to give the most accurate representation of the data possible.

The channel comment is built from the following Subject fields, separated by a comma:

<Name> + ", " + <Species> + ", " + <Gender> + ", " + <SubjectId> + ", " + <ChanId>;
for example (taken from one of the Ponemah example files):

Qax6998, Dog, , 1, 3

In this case, the <Gender> field was not set.

FileConvert$() command cmd$ argument

From the script language and the Import Options... dialog you can choose to filter the data you import by
subject and channel, and you can limit the time range of imported data. This can be useful with huge files (we
have successfully imported an 80 GB file spanning 2 months of data with 100+ channels, but it took 2 hours)!

The filtering is done by defining Name=Value pairs as:
Namel=Valuel;Name2=Value2;...;NameN=ValueN

The first group of filters is used to match data by subject and channel number within the Ponemah file. The
names you are matching are those that generate the channel comment, channel title and channel units, described
above. If you have a huge file with lots of channels, use the time range filter to import a few seconds of data at
the start of the file and look at the channel comments to work out the text to match.

Matching is by a case insensitive regular expression. If you do not supply an expression, there is no filtering. If
you supply a matching expression, the channel is accepted if the field matches anything. For example, if you
want to match the subject name and you supply Rat as the match, this will match subjects called Ratl,
Rat1023 and Fraternal as these all contain a case insensitive rat. To match the entire name use the ~ and $
anchors to mark the start and end, so “Rat$ will match only rat and not rat1l or brat.

You can also match a list of alternatives, for example to match cat or dog you could use ~ (cat |dog) $. You
can find the full syntax of the accepted regular expressions at this Microsoft site: https://docs.microsoft.com/en-
us/dotnet/standard/base-types/regular-expression-language-quick-reference.

If you supply multiple matching keywords, all must match to accept the channel. Remember that keyword and
values are all case insensitive.
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Name Value

Subject The name of the subject. Only channels for the nominated subject are imported. If the subject
is not found, no data is imported. If no subject is supplied, all subjects are imported. For
example: Subject=Ratl

Species The species to match. For example: Species="Dog$

Gender We have never seen an example of a gender supplied in a file. You could try “m and ~f
(something starting with m for male and £ for female).

Subjld The subject ID, which is a number. Remember that 1 will match any number with a 1 in it, so
to match a particular number (such as 1) set SubjId="1$ as the configuration.

Chan You can use this to match a particular <Chanld> value (see above). For example, to match
Ponemah channel 12, set Chan="12$, to match channels 23 or 24 or 30 set Chan=" (23|24 |
30) $ in the configuration.

Title Match the channel title, for example, to select all channels that include EEG in the title, set
Title=EEG in the configuration.

Units You can filter channels based on their channel units. For example, to match channels with
units of mV set Units="mVs$ in the configuration.

You can also filter data by time range. The channel filters run first and these reduce the file to a list of
acceptable channels. The very first item in the file after filtering by channels determines the start time of the
file, and will be at time 0 seconds in the Spike2 file if no time range is set. If you switch to time of day display
mode, this will still show the correct time in the original time zone. You can use the tOff and tLen options to
reduce the imported time range. If you do this, the earliest imported data will still display at 0 seconds. In Time
of Day axis mode, the times will still match the original Ponemah file.

Name Value

tOff The time offset in seconds from the first data in the file to import. Only data that passes the
subject/channel filter is considered when deciding what is the first time in the file. If this is
omitted, the import starts from the first data in the file (equivalent to setting tOff=0.0. The
first data imported is at time 0.0 seconds in the imported file. The Time of Day is adjusted to
compensate for the offset. The time offset is set to an accuracy of 0.1 microseconds
(0.0000001 seconds).

tLen The length of the data to import, in seconds. If omitted or 0.0, all the data from tOff to the
end is imported. The data length can be set to an accuracy of 0.1 microseconds.

To import all data channels for the Subject called Rat3 from 1 hour into sampling for 10 minutes of data you
could use:

Subject="Rat3$;t0ff=3600;tLen=600

The length of time required to import filtered data seems to depend on the duration of the data and number of
channels (as you would expect) and also, to some extent, on how much data must be skipped to located the
imported data.

How to handle NaN (Not a Number) problems

Data transferred via a radio link can suffer from drop outs caused by poor signal strength or animal movements.
Such signals are imported as NaN (Not a Number) values. These can be a nuisance as they cause all
mathematical operations that involve them to also be marked as NaN. To work around this, you can add the
Skip NaN channel process. This replaces the bad values with missing data. You can further repair the missing
data with the Fill Gaps channel process to linearly interpolate over the gaps created by Skip NaN. You can also
consider using the Linear Predict option to permanently replace NaN values with 'likely' data values.

Problems opening the importer or error -100 when using it
If you have previously imported Ponemah 6 files with your current installation, error -100 usually means that
the file you have selected ins invalid. However, if you have never managed to import any Ponemah 6 files this
may mean that the Ponemah importer is not installed, or is damaged.
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For the importer to work correctly, the Spike2 installation folder must have within it a folder called Import.
Within this folder there must be a file ponemah.dll and a folder called ponemah which must hold the
following files:

log4net.dll, Ponemah.Logger.dll, Ponemah.WaveformFile.dll, Ponemah6xExtractor.dll,
SQLite.interop.dll, System.Data.SQLite.dll

If any of these files are missing you may get error -100 when you attempt to import, or you will not be offered
Ponemah as an import filter. These files should all be installed as part of the Spike2 installation. The
SQLite.interop.dll file has two versions, one for 64-bit and one for 32-bit Spike2 installations, so be careful if
you attempt to 'fix' installations by copying files.

Another possible reason for the import to fail is that the file Sonview.exe.config is missing (should be in the
Spikell folder in the same place as the Sonview.exe file). This is a text file with the contents:

<?xml version = "1.0" ?>
<configuration>
<startup>
<supportedRuntime version="v4.0" />
</startup>
<runtime>

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1i">
<probing privatePath="import/ponemah"/>
</assemblyBinding>
</runtime>
</configuration>

This importer requires that a minimum of .Net 4.0 is installed. If you are running Ponemah software on your
computer you are probably OK, or if you are running an operating system more modern than Windows 7 (as
surely you are). Otherwise you will need to Update your version of .Net from the Microsoft Update Centre.
Search for .Net Update on the web. Ideally you want .Net version 4.7.2 or later.

Percept PC

This importer reads files written in JSON format by the Medtronic™ Percept PC system. The data imported is
read from the BrainSenseTimeDomain and BrainSenseLfp sections of the file. The importer was written so
that it imports a particular example file (with two waveform channels and associated LFP data), and it should
import similar files, or files with additional similar pairs of channels and LFP data. From each pair of channels
and the associated LFP data, the importer generates two waveform channels, one RealMark LFP channel and
one RealMark channel holding the Therapy Snapshot data (one set of values per data block).

Channel names

The channel names used in the files are of the form: NUMBER1 NUMBER2 SIDE, for example
ZERO THREE RIGHT. When we recognise this format, we shorten it to: 03 Right so that it fits within the
expected channel title space. We shorten the LFP data to "03™ and the therapy data to "03 Thr". We preserve
the original channel names in the channel comment.

Relative timing between channels

In theory, the channels should all be timed to the nearest 50 ms. However, there appears to be a bug in the
BrainSenselLfp:LfpData: TicksInMs field that causes a discontinuity in the millisecond timing every 3276.8
seconds into the data session. Although we could make heroic efforts to work around this, we were told by the
group requesting this importer that an accuracy of "to the nearest second" was good enough, so we have not
done this. In any case, it would not be possible to always be certain that a workaround was correct. Note that
the timing within a channel should be exact (unless data was lost in a transfer, which we assume does not
occur).

What we import

We attempt to import the time domain waveform channels and the associated LFP and Therapy Snapshot data.
We do not attempt to import patient and clinical data, setup or calibration data. The waveform channels in the
file (two in the example file we were given, called ZERO TWO LEFT and ZERO TWO RIGHT) are imported as
RealWave channels (with the titles 02 Left and 02 Right). Each LFP trace holds the LFP data from a
left/right pair of channels (with channel title 02) plus 4 additional values, being the LPF and current in mA
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values for the Left and Right channels. The LFP trace also holds one set of TherapySnapshot data per data
block.

The data we read from the JSON file is as follows:

BrainSenseTimeDomain

This section holds blocks of data, each holding waveform data for a single channel. The data blocks are in time
order, so if a channel has multiple blocks, the later blocks are at a later time that previous blocks and do not
overlap with them. Each channel identified in this section generates a RealWave data channel.

The fields we use are:

Channel

This field holds a channel number, of the format "ZERO TWO LEFT" or "ZERO TWO RIGHT". We use this
field to form the channel title, but we shorten the name to 02 Left and 02 Right to we more compatible with
Spike2. It is likely that this data will always occur in channel pairs, but we can import any channels. We use the
channel name to identify the number of different channels.

FirtsPacketDataTime

This field holds the time and data of the first data packet of this block of data to an accuracy of 1 seconds:
"2023-01-18T08:57:26.0002". There is also a field that contains the times of arrival of each data packet in
milliseconds (this time seems to be relative to the start of the session). We have not made use of the millisecond
timer to align packets, though this would be possible.

SampleRatelnHz

The sample rate of the channel in Hz: 250. For data import to function the channel rate must not change within
a file. If the rate does change, the importer will reject blocks with a rate that differs from the first rate seen for a
channel. Different channels can have different rates (likely not an issue with this file type).

TimeDomainData]...]
This field is an array of data values, representing the channel data in uV sampled at the SampleRatelnHz rate.
There are likely to be many tens of thousands of values in the array.

Fields we do not use are:

Pass
Blank in our example. We do not know what this is.

GlobalSequences, GlobalPacketSizes, TicksInMses

These fields hold text with lists of integer numbers separated by commas. Each list is the same length and hold
the packet sequence number (modulo 256), the data items in each packet, and the packet time in milliseconds
(always a multiple of 250 ms in the example we have). The packet sequence numbers have gaps in the
numbering ("0,1,2,3,5,6,7,8,10...") where a packet with LFP data is inserted.

Gain
This is an integer field that is 225 in our example file (but we have seen values of 224 and 220 in other sections
used for setup and calibration).

BrainSenseLfp

This section contains data relating to pairs of channels. Each data item has a sequence number, and then ma and
LFP data for Left and Right. Each pair of channels we identify generates one RealMark channel with 4 attached
data values. The channel title is set to "nm" where n and m are the common numbers from the Channel field, for
example "02". The attached data values and indices we generate in the RealMark data are:

# Name Contents

0 LFPr The right channel LFP value (arbitrary units).
1 Ir The right channel current, in mA.

2 LFPL The left channel LFP value (arbitrary units).
3 Il The left channel current, in mA.

The fields we use to collect this data are:
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Channel

This field holds a pair of source channel numbers, of the format "ZERO TWO LEFT, ZERO TWO RIGHT". We
use this field to form the channel title, but we shorten the name to 02 as the data relates to both the left and right
channels. It is likely that this data will always occur in channel pairs. We use the channel name to identify the
number of different channels.

FirstPacketDataTime
This field holds the time and data of the first data packet of this block of data to an accuracy of 1 seconds:
"2023-01-18T08:57:27.0002".

SampleRatelnHz

The sample rate of the LPF data, in Hz. This has the value 2 in the example file we were given. We assume that
the data is a continuous waveform (no gaps) starting at the FirstPacketDataTime at this sample rate. If the
TicksInMs field is repaired (see below), we could use that to give more accurate timings.

LfpDatal...]
This is an array of data blocks from which we extract the values that we return for each RealMark data point.
Each block has the following fields:

Seq The block sequence number. In our example file, these values were the ones missing from the
GlobalSequences values mentioned above.

TicksInM This should be the data block session time, in milliseconds to an accuracy of 50 ms. Unfortunately,
S this resets back to 0 every 3276.8 seconds, which makes it a lot less useful. If this is ever fixed, or
we figure out a way of using this reliably, we may make use of this as the item time.

StatusBy A string holding "00 00 00 00" that we guess are 4 byte values expressed in hexadecimal that we
tes read and store as the 4 marker codes associated with the data item in each RealMark item.

Right The right hand channel data values for LEP and ma data.
Left The left hand channel data values for LFP and mA data.
Note that the LPF values are in arbitrary units. There are also occasional huge values (4,294,967,295: the
maximum possible 32-bit unsigned integer) which we presume to mean invalid data. Valid LPF values are
positive, so we have chosen to replace these invalid data markers with the value -1, which makes the channel

data much easier to deal with; at the very least it allows you to Optimise the display without causing all the LFP
data to become invisible.

TherapySnapshot

This part of the BrainSenseLfp section holds the settings used for the associated data block. We generate a
separate data channel called, for example "02 Thr", that holds RealMark data. There is one data point per
LFP data block and each data point has 22 attached items that are read from the TherapySnapshot. The data
stored in each index is given in the table. Where there is a range of indices, 2-3 for example, the lower has the
left channel data, the higher has the right channel data.

# Data stored in the index

0 The High-pass filter setting in Hz
1 Sensing blanking duration in microseconds
2-3  Pulse width in microseconds.

4-5  Rate in Hz.

6-7  Lower limit in mA

8-9  Upper limit in mA

10-11 Frequency in Hz

12-13 Frequency index

14-15 Upper LFP threshold

16-17 Lower LFP threshold

18-19 Averaging duration in milliseconds
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20-21 Detection blanking duration in milliseconds

We expect that this data will be useful to users who write scripts to analyse data and who wish to track how
changes to these parameters affect it.

The example data file we worked with had 7 data capture episodes spread over 75 minutes with data channels
02 Left and 02 Right sampled at 250 Hz, the LFP data for these 7 episodes was sampled at 0.5 second
intervals and we generated 7 Therapy Snapshot data samples, one at the start of each of the 7 episodes, timed to
match the LFP data. In terms of Spike2 channel numbers we generate 4 channels:

ChannContents

el

1 The LFP data points with 4 attached values per point at 0.5 second intervals.

2 The waveform data from channel ZERO TWO LEFT sampled at 250 Hz.

3 The waveform data from channel ZERO_TWO_RIGHT sampled at 250 Hz.

4 The TheraphySnapshot data with 22 attached values, one data point per data capture episode.

Example script to list therapy data
The following script reads and displays the therapy data (assumed to be held in channel 4):

var code%[4]; '"Item codes (unused for this channel)
const chThr% := 4; 'The channel holding therapy data
var thr[22]; 'Space for the data values
var t:= -1; 'start time of the search
repeat
t := NextTime(chThr%, t, code’%, thr[]); ' Get next set of data
if (t >= 9) then '"If we got data, display it
PrintLog("%6.1f %g\n", t, thr[])
endif;
until t < 9; 'until no more data found

The output of this, with the example data file, was:

1.0 1,2000,60,60,125,125,0.6,1.4,1.8,2.4,18.55,17.57,19,18,30,30, 20,20, 3000, 3000, 2000, 2000

469.0 1,2000,60,60,125,125,0.6,1.4,1.8,2.4,18.55,17.57,19,18,30, 30,20, 20,3000, 3000, 2000, 2000
1106.0 1,2000,60,60,125,125,0.6,0,1.8,2.4,18.55,17.57,19,18,30,30, 20,20, 3000, 3000, 2000, 2000
1661.0 1,2000,60,60,125,125,0,0,1.8,2.4,18.55,17.57,19,18,30, 30,20, 20,3000, 3000, 2000, 2000
2638.0 1,1470,60,60,145,145,0.6,1.4,2.4,2.8,18.55,17.57,19,18,30, 30,20, 20,3000, 3000, 2000, 2000
3221.0 1,1470,60,60,145,145,0.6,0,2.4,2.8,18.55,17.57,19,18,30,30, 20,20, 3000, 3000, 2000, 2000
3734.0 1,1470,60,60,145,145,0,0,2.4,2.8,18.55,17.57,19,18,30, 30,20, 20,3000, 3000, 2000, 2000

The first column is the time offset, in seconds, from the start of the file (which begins with the first recorded
data block). The following columns are the 22 data values.

Text importer

When a user imports a text file interactively, the last user configuration is saved as an XML format file called
Ascii Last.icfx in the current users application data path. If you rename this (in the same place) to
Ascii_ Def.icfx, then this will always be used to set the initial configuration unless you use the Conf option
(described below). You can save configuration files with your choice of name from the text import dialog that
appears when you use the text importer interactively.

Configuration files are applied after doing an initial scan of the file. They can only make changes that are
compatible with the data that is discovered by the initial scan; they cannot create additional channels.

The text importer has its own interactive Help file with more information about supported text file formats. If
your file holds a header followed by a rectangular table of columns, each column representing equally spaced
data (waveforms), then you should have little difficulty importing it. You will need to refer to the specific text
importer help to cope with columns containing event times or TextMark or RealMark data.

The most common channel type is a waveform, which is recognised as a column of data containing numbers. If
the first column holds numbers that increase with a fixed spacing, this is assumed to be a timebase. In addition
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to numbers, the text 'NaN' is recognised as a number and evaluates as 0.0. Otherwise, any non-numeric text in a
column causes the column to be treated as text.

The text importer supports the following names in the cmd$ string for the FileConvert$ () command.

name value

Conf Configuration file name (including the .icfx extension). If this string is not empty then the
provided file name including its full path will be used to load the configuration file. This
keyword is always applied first, regardless of its position in the cmds string.

Find

In cases where the text holds data blocks of different types you can change how the initial scan
chooses the block that is most typical of the data, which determines the number of columns. You
can set the values:

0 This is the default. The block with the largest number of numeric items (columns-first
numeric column)*lines.

1 The block with the largest number of items (columns * lines).

2 The block with the most lines.

3 The block with the most columns.

What to do if the importer does not recognise your file

If your text data does not meet the rules for import by the importer, you could consider writing a script to do the
task. This is usually not very difficult (as long as you can use the script language); the complications of the
general text importer come from the fact that it has to cope with a wide variety of data formats.

Files you want to import will usually be in a fixed format that you know well. You will usually have multiple
columns of data and possibly a file header. The commands you will need to use will include:

FileOpen To open input files of type 8 (external text files with no associated window).

FileNew To create a new output data file of type 7.

FileSaveAs To save the resulting data file; use type -1.

ReadSetup To configure the Read () command so you can easily split the lines in the file into columns

Read To collect a single line of input and convert it into variables. If you need to inspect the lines
first (to detect the line type), use Read () to collect an entire line into a string, followed by
ReadStr () to extract columns of data from suitable lines.

ReadStr To convert a string holding a known format into variables.

ChanNew Create a channel in a data file, usually for writing to with ChanwWritewWave (). If you are
creating a non-waveform channel, use MemChan ().

ChanWriteWave Write data to a Waveform or RealWave channel created with ChanNew (). You can also use
memory channels to create waveform data.

MemChan Create a memory channel of any type to write to with MemSetItem ().

MemSetItem Add a data item to an existing memory channel.

MemSave

To save a memory channel to a disk channel to make it permanent.

The advantage of writing your own importer is that it allows you to extract all the information from the file. If
you use our importer, you are restricted to importing files that match our expectations and we only allow you to
read channel titles and units from any file header, and these only when they match the data columns.

As long as the files are not too large, copying read data into memory channels and saving the result as disk
channels is usually the easiest approach as this leaves Spike2 to sort out any effects due to gaps or overlaps in
waveform data.

XDF (eXtensible Data Format)

Also known as LabStreamingLayer. A mixture of XML meta-data and binary wave data. Does not import 64-bit
integer ADC data. You can find a description of this format here. The importer can handle the example files on
this site plus some additional files from a user.
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This data format makes provision for multiple data streams from different devices which may have time bases
that run at slightly different speeds, which can become significant for long files. The current importer does
NOT attempt to compensate for this. It would be possible to do this should this become a significant problem.

The format stores data as streams. Each stream holds one or more channels of data of the same type. Each
stream is either regularly sampled (as interleaved waveform data) or holds time stamped data. We import time
stamped data either as RealMark data (where channels become items in each RealMark), or as TextMark data
(we expect only a single channel per stream).

Xltek Neurowork importer

This importer expects to find all the files for one import in a folder. All the files (and the enclosing folder) have
a common (and somewhat long) name. This is usually of the form:

User-defined XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX

where the xxxx are hexadecimal digits. There can be problems if the full path name to a file reaches 260
characters, which is not that difficult to achieve when the folder name and file name account for more than 100
characters.

A typical set of files in a folder could be:

User-defined XXXXXXXX—XXXX-XXXX-XXXX-XXXXXXXXXXXX.eeg
User-defined xXXXXXXXX—XXXX-XXXX-XXXX-XXXXXXXXXXXX.ent
User-defined XXXXXXXX—XXXX-XXXX-XXXX-XXXXXXXXXXXX.EpO
User-defined xXXXXXXXX—XXXX-XXXX-XXXX-XXXXXXXXXXXX.erd
User-defined xXXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXx.etc
User-defined XXXXXXXX—XXXX-XXXX-XXXX-XXXXXXXXXXXX.SNC
User-defined xXXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXxX.Stc
User-defined XXXXXXXX—XXXX-XXXX-XXXX-XXXXxxXxxxxxXx 001.erd
User-defined xXXXXXXXX-XXXX-XXXX-XXXX-XXxXxxxxxxxx 001l.etc
User-defined XXXXXXXX—XXXX-XXXX-XXXX-XXXXxXxxxXxxXx 002.erd
User-defined xXXXXXXXX-XXXX-XXXX-XXXX-XXxXxxxxxxxx 002.etc
User-defined xXXXXXXXX—XXXX-XXXX-XXXX-XXXXxXxxxxxXx 003.erd
User-defined xXXXXXXXX-XXXX-XXXX-XXXX-XXxXxxxxxxxx 003.etc

The .erd and .etc pairs hold the raw data and there can be many pairs of these files. The importer looks for
the .stc file as the key to the import process as this file holds the information to tie the experiment together.
For our importer to work, the file names must all be correct and match the . stc file name (but we do not care if
the folder name is different). We import all the raw waveforms, an event channel of Trigger data, and a channel
of TextMark data indicating the original raw data file starts.

In addition to importing data from the .erd/. etc files, we also parse the . ent files, which hold descriptions of
montages and user comments and automated comments. These comments are imported as a TextMark channel.
Each comment in this file has a type (Comment/Data/Type), and we use the type to set the first marker code of
the TextMark. We observe that user-entered comments seem to be given a type of "Custom", and these are
given type code 00. Any other types seen are given sequential type codes from 00, in the order that we
encounter them in the file. We can assign additional fixed codes to other types, if required. There is an
additional field (Comment/Origin) that we have observed set to "Acquisition” or "Review". If this is "Review",
we set the second type code to 01, otherwise it is 00.

Big-endian and Little-endian

These terms refer to how the bytes that make up data values that use more than one byte of storage are arranged
when stored into memory and when written to disk. Consider the 32-bit integer value (4 8-bit bytes of data)
written in hexadecimal as 0x03020100. Traditionally, data is stored in memory with the bytes in the order of
their significance. If they are written with the least significant byte first, the data is said to be little-endian, if it
is written with the most significant first, it is said to be big endian.

Storage byte index 0 1 2 3
Little-endian 0x00 0x01 0x02 0x03
Big-endian 0x03 0x02 0x01 0x01
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As long as you write and the read data with the same endianism, there is no problem. Data on Windows and
Intel-based Macintosh computers is stored in little-endian format, but data from other system may be big-
endian. In particular, the older Motorola/PowerPC based Macintosh computers used big-endian formats. You
can read more about endianism here.

Import options dialog

Import options X

Minimum number of channels in imported file 32 =

| tOff=10000 ‘

Help Import... Cancel

This dialog (File menu->Import->Options...) sets the minimum number of channels in each file imported by
the Import command and optionally, the configuration string that is used by some importers for additional
control over the import process.

Channels

Extra channels are useful if you intend to further process the files and need channel working space. The
minimum number of channels in a Spike2 data file has always been 32. Spike2 version 9 onwards supports files
with up to 2000 channels. Setting more channels that you really need is wasteful of disk and memory space.
System memory or resources may limit the number of channels.

When you import a file with n source channels, Spike2 creates an output file with n*3/2 channels or the
number of channels you set in this dialog, whichever is the larger. The maximum number of channels is
currently limited to 2000. Do not set huge numbers of channels unless you really need them as each channel
uses up file header space.

The number you set here is stored in the Preferences section of the Registry under the title: "Minimum
channels in imported file". Seethe Profile ()script command for details.

Configuration

This field (added at [10.13]) sets importer-specific options in the same way as the cmd$ argument of the
FileConvert$ () script command. The string is of the form:
namel=valuel;name2=value2;name3=value3 where the names are case insensitive. It is entirely up to the
importers what names they recognise and what they do if you type rubbish; most importers will ignore anything
they do not recognise. For more information about specific importers click here and then find the importer in
the table. If the importer supports a command line, the emd$ column contains Yes. Click the Yes for details of
supported keywords.

If in doubt, leave this field empty. The text entered here has no effect on the FileConvert$ () script
command.

The text you enter here isstored in the Preferences section of the Registry under the title: "Import
configuration". See the Profile () script command for details.

Import...
Click this button to close the dialog and run the importer with these options.
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Global Resources

If the current view is a time, result or XY view, this File menu command appears as Resource Files->Global
Resources..., otherwise it appears as Resource Files....

Normally, each Spike2 time, result and XY data file has an [ gionai file resources ] |
associated resource file with the same name and .s2rx or .s2r
extension. These per-file resources remember the screen layout,
cursor positions, active cursor parameters and other settings.

|¥#] Use global resource files

Resource file to be used

. Name of file (.52 wil be added Global
They allow each file to open with exactly the same screen || — & ik o, e
appearance it had when it closed at the cost of an extra file on || Heleton  |Data fie folder only 3]
disk. Only use global resource file if...

. [¥] Data file is within path shown below
However, per-file resources do not let you use the same display

and cursor settings for a sequence of files. If you enable global
resource files, you can use a single resource file (or one || [Patafiedoesnothave its own resource file
resource per folder) to control the screen appearance of
multiple data files. This is particularly powerful when you
review data stored on a read-only device such as a DVD drive.

c:\Spedall, |Browse

|H%E4IJ| | Cancel || oK ]

4

Global file resources dialog

Unlike the per-file resource files, which are updated automatically whenever you close a resource file, global
resource files are never updated automatically. Use Update Global Resource to update the current global
resource and Save Resources As to create a new resource file with the current settings for the current view.

The use of global resources is managed from the Global file resources dialog, which has these fields:

Use global resource files

Check this box to use global resources. If this is unchecked, no global resource files are used and each data file
has its own resource file. Please remember that using this dialog makes no difference to the resources used by
any open time view. It changes the resource file that is used when a saved time view opens. If you check this
box and no global resource file is found, Spike2 behaves as if the box were not checked.

Name of file
This field sets the name of the resource file. The name should not include a path or the file extension. These are
added automatically, as required. If this field is blank, no resource file is used.

File location

This field sets where to search for the global resource file. You have three choices: Spike?2 installation folder
only, Data file folder then Spike2 folder, Data file folder only. The Spike2 installation folder is wherever the
sonview.exe application file is located. The data file folder is the folder from which the data file is opened.

Only use global resource file if
If you do not check any boxes in this area of the dialog, global resource files are applied to all data files. This
dialog area allows you to restrict the files that use the global resource file in place of the per-file resources.

Data file is within the path shown below

If you set a path and check this box, only files that lie within this path are considered for global resources. For
example, if you only wanted to apply global resources to files read from your DVD drive, you might set this to
E:\ (if £:\ is the path to your DVD).

Data file does not have its own resource file
Check this box if you would prefer to use the per-file resources if a resource file with the correct name and in
the same folder as the data file exists.
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Resource Files

This menu item replaces Global Resources when the current view is a time, result or XY view. It opens a
pop-up menu from which you can select Global Resources, Apply Resource File, Save Resources As and
Update Global Resource.

Apply Resource File

This command applies a user-chosen resource file to the current time, result or XY view. You can use this to
apply a complex window arrangement or active cursor measurement to multiple files. The script language
equivalent is FileApplyResource (). You can also use the Global Resources command to automatically
apply a specific resource file.

Note

Resources are saved to disk when the view they belong to closes. If you try to apply resources from an open
view to the current view, you will apply the last saved resources of the view, not the current state (which might
be different). You can use the File menu Save Resources As... interactive command or the
FileSaveResource () script command to ensure that resources have been saved before applying them.

Save Resources As
This command saves the resources associated with the current time, result or XY view to a resource file. The
command opens a file save dialog for you to set the file name.

Update Global Resource

This command is enabled for the current time, result or XY view if global resources are enabled and a global
resource file name is set. It updates the global resource file with the current view settings. If the global resource
file does not exist, one is created in the folder set by the Global Resources dialog (or in the application folder if
both the data file folder and the application folder are allowed).

Utility programs

This menu item allows you to run additional programs that are installed with Spike2. Selecting a program from
this menu item is equivalent to locating the program with the Windows Explorer and running it. Programs are
listed if they are found in their expected locations. The list of possible programs includes:

Repair 64-bit .smrx file
This launches the S64Fix program that can recover data from a damaged .smrx file. You should consider
running this program if Spike2 reports an error with a file or if data appears and disappears depending on where
the display starts in the file.

Repair 32-bit .smr file
This launches the SonFix program that can recover data from a damaged . smr file.

S2Video
Launches the S2Video program, used to record video from a Microsoft DirectShow™ compatible
camera/device during data sampling.

Offline compress MP4/AVI file
If you record video/audio uncompressed you can use these programs to compress the files after sampling.

Test CED 1401 interface

If you suspect a problem with your CED 1401 interface you can use this program to verify that the device
passes its self-test. If you have suitable equipment, you can use this program to calibrate the analogue system
and check the integrity of the Event inputs and outputs.
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Test CED 1902 conditioner
If you have installed the Signal Conditioner support and have a CED 1902 conditioner, you can use this
program to check that it is operating correctly.

SoundCard Talker
This option runs an example Talker that allows you to sample waveform data from a Windows audio input as
part of data sampling.

Example Talkers
Spike2 is supplied with example Talkers that can be used to familiarise yourself with the general principles of
Talkers (TalkerEx) and that can sample the Mouse position as a waveform (MouseTalk).

Close, Close and Link

This command closes the active window. If you use this command on an unsaved window, you are prompted to
save it before closing the window. However, if the Edit menu Preferences option is set to not prompt to save
modified result and XY views, you will not be prompted to save these views and they will be lost when you
close them.

Close all associated windows

If you hold down the ctr1 key and click on the File menu when a time view is the current window, the Close
command becomes Close and Link. Select this to close the time view plus all associated windows. This does
not work with a newly sampled file, save it first. If the Edit menu Preferences option is set to not prompt to
save result and XY views, associated result views are deleted. However, in addition to saving the state of the
data file in a . s2rx resource file, Spike2 also saves the state and contents of associated result view windows in
the resource file. Next time you open the data file the result views are recreated from the resource file in the
same state as they were closed.

Close an unsaved sampled data file

If you attempt to close a time view that has sampled data and has not been saved, and the sampling session ran
for at least 5 seconds and some data was sampled, Spike2 will ask you if you really want to close an unsaved
file and tell you the duration. This dialog is deliberately arranged to look different from dialogs you see in other
circumstances asking if you want to save files, to make the default action non-destructive. This is because a user
complained that they lost a valuable sampled file by keeping accepting default actions when half asleep during
an all night sampling session! Note that you can still recover such a file by exiting Spike2 and restarting it,
when it will notice that there is an unsaved sampled data file and offer to recover it.

Close a time view with memory channels

This is a potentially destructive act as it may have taken you time and effort to create the memory channels and
they will be lost if you close the file. There is an option in the Edit menu Preferences, General tab to
configure if you are warned or not. The recommended setting is to not be warned if the file close command
came from a script.

Revert To Saved

You can use this command with a text file, a script file or an output sequence file. The file changes back to the
state it was in at the last save.
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Save and Save As

These commands are available when the current window is a text, script, output sequence, result or XY view or
a time view holding newly sampled data that has not been saved or a time view that was created by the script
command FileNew (7, ...). Save writes the file with its current name unless it is unnamed, in which case
you are prompted for a name. Save As writes the file with a different name and gives you the option of saving
the data as a different type.

Time view files are kept on disk, not in memory, as they can be very large. Changes made to these files are
permanent as they are made on disk. When you save a newly sampled data file, you give the file a name
(replacing a temporary name). If you save it to a different drive from that set in the Edit menu Preferences,
Spike2 copies the file to the new drive, then deletes the original. Moving a large file can take several seconds.

Saving an unsaved time view causes Spike2 to recalculate the file length, which determines the time range that
can be displayed on the x axis. Spike2 only considers channels that have been written to disk, so memory
channels and virtual channels are not taken into account.

Sequence, text, result, XY and script files are held in memory. Changes made to these files are not permanent
until the file is saved to disk.

Save As for Result and XY views
In addition to saving Result and XY views in their native format, you can also choose to save them as text or as
an image. The available formats are:

Text file
This is the same as the Edit menu Copy As Text command, but with the output sent to a text file and not the
clipboard. This writes selected channels or all visible channels if no channel is selected.

Bitmap file, JPEG image, Portable Network Graphic file, Tagged Image Format file

These options copy the screen area containing the window to a file; the result is a copy at the screen resolution.
If you need to scale the image, or want to edit it, a Metafile copy is often better. The Portable Network Graphic
format will usually be the smallest on disk unless the screen contains a real-word image or a sonogram, when
JPEG may be smaller (but at the cost of artefacts around axis lines and text). Bitmap images will usually be the
largest.

Metafile

This option copies the window as a Windows (Placeable) Metafile (*.wWMF) or as an Enhanced Metafile
(*.eMF). Enhanced Metafiles are theoretically better as they support the cubic spline and sonogram drawing
modes. However, some graphics programs do not import Enhanced Metafiles very well. The default format is a
Windows Metafile. To output in enhanced format, set the file extension to .EMF. For example, to save to the
file fred as a Windows Metafile, set the file name to fred or fred.wmf but to save as an enhanced metafile
set the file name to fred.emf.

These file formats can be scaled without losing resolution and are the preferred format for moving Spike2
images to drawing programs. The Edit menu Preferences... option lets you increase (or decrease) the output
resolution. This can be important when saving time view and result view data as the number of vectors
produced when drawing high resolution may stop some drawing programs from reading the file.

Export As

This menu item replaces Save As when the current window 1S save as type: [Data File (64-bit) (.smng v
a saved time view and opens a File Save dialog. You can Data Fi |
choose from: Data file (64-bit) (*.smrx) to export as a new Data file (32-bit) (s}

W . . _hi * Text File (*.txt)
64-bit Spike2 'ﬁle, .Data file 32-bit) ( .S_mr) to export as an [ bl N
old-style 32-bit Spike2 data file, Text file or Spreadsheet e e Metafile (*wmf, *.emf) (use *.emf for enhanced)
text (*.txt), Metafile (*.wmf or *.emf) for a scalable image Bitmap (*.bmp)

: : : : JPEG image (*.jpyg, *jpeg)

and a variety of bitmap image formats. More types are listed Borabla Nensork Guaphis tpna)
(for example export to a MATLAB file) if you have installed Tagged Image Format (*.tif, *.£iff)
external exporters. The script equivalent is FileSaveAs (). MATLAB (*.mat)
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Choose a format and either select an existing file to overwrite or type a new file name, then click Save. What

happens next depends of the export format:

Data file (64-bit or 32-bit)

A dialog opens in which you select channels and data
sections to export. Output is to a 64-bit . smrx file unless
the selected file name ends .smr, when it is to an old-

Export from Demo.smrx

Channel or channel list | 1 Sinewave (Waveform) *

v add

format 32-bit file. Unless you require compatibility with | 7™ "o E=E v] to[Cursor@) v] ssconds

Spike2 version 7 or older or with third party software that ||# From Upto Chaniels Delete
2 6.05966 7.87756 31,4.1

does not support . smrx files, we suggest you use the new ||, o071 sso158 1 [JAs Set

format. 3 84.1156 86.35011 All Channels

If any selected channels are modified by marker filters or Help

by channel processes, these modifications will apply tO | yogified channels: 1

the output. The dialog displays a list of modified channels | 1 Time shift data so that first exported range starts at 0 seconds
as a warning; the drop down list of channels marks ' [JExport RealWave channels as 16-bit Waveform channels
modified channels with an asterisk (*).

Cancel

The output file will have 32 | channels... Export

The dialog builds a list of time ranges with associated channels. The list displays in order of start times. Time
ranges are allowed to overlap. Time ranges can be typed in as x-axis dialog expressions or inserted from the
drop down list.

You can choose channels from the drop down list or type in a channel specification. You can export channels
from the original file plus memory and virtual channels; duplicated channels are not listed.

If you select one of the Range n items, the channel list and time range fields update to match the selection.

Add

Set channels and a time range with the top section of the dialog and click Add to insert into the range list. Do
this as often as required. Bad entries in the channel list or time range or a to time less than the start of the range
disable the Add button.

Click Delete to remove a selected list entry.

As Set

When you click the Add button, the Time range ficlds are evaluated and both the evaluated times and the
original contents of the range fields are saved in the range list. If you check the As Set box, the time range list
displays the same text as you used when you clicked Add, otherwise it displays the time range in seconds
calculated when Add was used. This also affects what is copied back to the Time range fields when you select
one of the entries in the list of time ranges.

Modified channels

This field lists all the channels that are currently selected for output that are modified by having a marker filters
or a channel processes applied. The exporter writes the modified version of these channels, which may not be
what you intend.

Time shift data...

Check this box to time shift the output data so that the Range 1 From time becomes 0.0 in the output file. If
the source file stores the sampling start time of day and you shift the time base, the same shift is applied to the
start of sampling time.

Export RealWave channels as 16-bit Waveform channels

Check this box to convert RealWave channels (normally stored as 32-bit floating point values) to 16-bit
integers using the channel scale and offset. This is usually only required when exporting as a 32-bit file so that
versions of Spike2 before 4.03 can read the data. This field is omitted when external exporters use the dialog.

Channels...
This button opens a dialog in which you can set the maximum number of channels in the output file, from 32 to
2000. External exporters omit this field. 32-bit . smr files can only have up to 400 channels.

Big file
This field is visible when you export to a 32-bit . smr file. Check the Big file box if you want the file written in
Big file mode. As files written in this mode are not compatible with versions of Spike2 before version 7 you
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should not check this box unless your output file is likely to exceed 2 GB in size. If you export to a 64-bit file
this field is omitted as there are no size restrictions. External exporters also omit this field.

Export

Once you have formed a list of times and channels, click Export to write the selected time ranges and channels
to the new data file. If the As Set box is checked, all the time ranges are re-evaluated using the current state of
the data file, display positions and Cursors. Channels are written in order of ascending channel number. Where
possible, channels are copied to the same channel number in the output file. If this is not possible, for example
for a memory channel, the channel is written to the lowest numbered unused channel in the output file. If the
export process takes more than a couple of seconds, a progress dialog appears and you have the option of
cancelling the export.

Tidy up a data file or add extra channel space

If you create new channels in a data file and then delete them, the space allocated on disk for the new channels
is not released and still belongs to the file (and will be reused if more channels are written). You can use the
Export As command to generate a new copy of the file that does not include this extra space. You can also use
this dialog to add more channel space for data proessing. Follow these steps:

1. Open the file to clean up and select the File menu Export As command.
. Choose a suitable file name and click Save.

. In the new dialog click on Add to export All Channels from 0 to MaxTime().

2
3
4. Clear the Time shift... check box (unless you want the data shifted).
5. Set the number of channels if you want to increase it.

6

. Click Export. The new file is added to the File menu most recently used list.

The script language equivalent of this can be found in the description of the FileSaveAs () command.

Text file
This is the same as the Edit menu Copy As Text command, but with the output sent to a text file and not the
clipboard. This writes selected channels or all visible channels if no channel is selected.

Locale (using comma for decimal point)

In some counties, the character used to separate the integer part of a floating point number from the fractional
part is a comma, not a decimal point. If your computer system is set to a locale where this is the case (in
Germany, for example), you can enable locale-based text formatting in the Edit menu Preferences General tab.

Spreadsheet text file
Copy a time view as a text file for easy import to a spreadsheet. This is the same as the Edit menu Copy
Spreadsheet command, but with the output sent to a file. This writes selected channels or all visible channels
if no channel is selected.

Bitmap, JPEG image, Portable Network Graphic, Tagged Image Format file

These options copy the screen area containing the window to a file at the screen resolution. If you need to scale
the image, or want to edit it, a Metafile copy is often better. The Portable Network Graphic format will usually
be the smallest on disk unless the screen contains a real-word image or a sonogram, when JPEG may be smaller
(but at the cost of artefacts around axis lines and text). Bitmap images will usually be the largest.

Metafile

This option copies the window as an Enhanced Metafile (*.emf) or as a Windows (Placeable) Metafile
(*.wmf). Enhanced Metafiles are better as they support the cubic spline and sonogram drawing modes and
larger file sizes. The default format is as Enhanced Metafile. To output in the older format, set the file extension
to .wmf. For example, to save to the file fred as an Enhanced Metafile, set the file name to fred or fred.emf
but to save as an old-style Windows Metafile set the file name to fred.wmf.

These file formats can be scaled without losing resolution and are the preferred format for moving Spike2
images to drawing programs. The Edit menu Preferences... option lets you increase (or decrease) the output
resolution. This can be important when saving time view and result view data as the number of vectors
produced when drawing high resolution may stop some drawing programs from reading the file.
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Which Metafile format to use?

The Windows Metafile format (WMF) was the original and dates back to 16-bit Windows 3.0; it is no longer
recommended for use. Enhanced Metafiles (EMF) date back to 1993 and were the 32-bit Windows replacement
for the WMF format. It used to be the case that WMF was well supported by graphics programs and EMF less
so. However, nowadays we observe that the reverse is the case, so we strongly recommend that you use the
Enhanced Metafile format unless you have strong reasons for using the older format.

Other vector graphics fromats

We are often asked to write images in other formats, for example SVG. There are programs that will convert
EMEF files to SVG, for example Inkscape can import EMG and then write it as SVG. However, Spike2 images
tend to be composed of a large number of vectors and drawing programs are not usually optimised to work well
in these cases.

External exporters

These use the same dialog as for exporting to a data file to select channels and a single time range. There may
be additional dialogs depending on the target format. See the Export folder for additional printed
documentation for external exporters or here in the help system. The only external exporter currently defined is
for MatLab files.

MATLAB external exporter

If you selected MATLAB support when installing Spike2 you can export a time view, result view or an XY
view to a MATLAB file. Choose MATLAB data as the Save As type in the Export As dialog in a time view or
in the Save As dialog for result and XY views. You can also control export to MATLAB format from a script.

Working with large files

The writing to MATLARB files is done by calls into MATLAB-supplied routines. There are limits on the size of
MATLAB objects that can be written. Use format version 7.3 for huge files (beware that they are compressed,
which slows export). You need a 64-bit MATLAB to read gigabyte sized files. If you intend to export large
files you must be realistic about how long it may take (several minutes).

Alternatives to exporting data as MATLAB files

It is possible to read (and write) both old format . smr and new format . smrx files from MATLAB using the
SON64 interface for MATLAB that is downloadable from our web site. This package uses the same library as
Spike2 for manipulating the data files and allows you to access all the data regardless of file size.

Another alternative is to use the MATLAB script support routines to exchange data with a MATLAB engine
via the script language.

Export fails after MatLabOpen() used
If file export works, but fails after you use a script that calls MatLabOpen (), see the MatLab Script support,
Matlab problems page.

Workspace variable naming

The workspace variables in a mat-file must have names that are both unique and legal. If a variable name is not
unique it will overwrite the workspace data with the same name. MATLAB cannot read variables with illegal
names. Spike2 mat-file export creates variables with names based upon the source view name and the channel
name. You can independently select if either of these is to be used. This produces variable names that are both
useful and unique. The default setting is to use the source view name but not the channel name. The variable
name settings are used to build the variable name as follows:

If the source view name is to be used, it is placed at the start of the variable name followed by an underscore
character ° ’. Following this a channel identifier is added. This is either the channel title (if using the source
channel name is selected and the name is not blank) or Spike2 builds a name using ‘Ch’ followed by the channel
number. For example, when exporting a view (of any type) called Exptl containing 3 channels; channel 1
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called ‘ECcG’, channel 3 called ‘AP’ and channel 7 with a blank name we would get the following MATLAB
variable names:

Using source view and channel name: Exptl ECG, Exptl AP, Expt Ch7

Using source view name only: Exptl Chl, Exptl Ch3, Expt Ch7
Using channel name only: ECG, AP, Ch7
Using neither name: Chl, Ch3, Ch7

Having generated a name using these rules, Spike2 checks and, if necessary, modifies the name to guarantee
that it is legal. The rules for a legal name are that it must not be more than 63 characters, must begin with an
alphabetic character and must only contain alphanumeric characters and the underscore character ¢ ’. Spike2
modifies the name by appending a ‘v’ to the start of the name if it does not begin with an alphabetic character,
converting all illegal characters to underscores and finally truncating if more than 63 characters long.

WARNING: If you end up with variable names that are the same, the variables will overwrite each other when
you read the file into MATLAB and you will only see the last read variable.

To export data as a MATLAB file, open the File menu Export As command from a time view or the Save As
command from a result or XY view and select MATLAB data (*.mat) in the Save as type drop-down list. Set
a file name and click Save to proceed to the next dialog where you choose the data to export and the format to
export it in. The details of the new dialog depend on the source view type:

Time view data

When exporting time view data, you first get a dialog that allows
you to select the channels to export and the time range that you
want to export over. There is also a check box that selects | compatibility Latest version (currently 7.3)
offsetting the start of the time range being exported to zero. This
dialog is a simplified version of the dialog used to select data to
export to a SON file, however you can only select a single set of
channels and time range. (] Align and bin all data at 100

Matlab export settings X

Use source name in MatLab variable names

[ ] Use source channel name in variable names

. Wavef ti
Note that, when exporting waveform data to a mat-file, only the e

first contiguous section of waveform data within the selected | 2¥eutoptions [Waveform only -
time range will be exported. The export data format cannot Waveform data as Float (32-bit) v
manage more than one section of contiguous waveform data. Export all data (not just first contigous block)
When you have selected your channels and time range you are Force same peint count per channel

then presented with a second dialog that controls mat-file export
options. These options allow you to set which MATLAB file
format to use, how the MATLAB workspace variables will be
named, what data is generated for different channel types and the TextMark channels as | TextMark v
format used for various types of Spike2 data. These options are

Marker options

Marker channels as Marker v

: . . RealMark channels as  RealMark ~

also available when you export using a script.
RealMark data as Double (64-bit)
Compatibility WaveMark channels as | WaveMark v

If you are using an older version of MATLAB, you must use the WaveMark wave data as  Double (64-bit) ~
compatibility field to select a suitable output file format. Version
7 and 7.3 files are compressed, which can be slow. Help Caresl

Use ... in variable names
These two options in the dialog control how the mat-file variable names are constructed as described
previously.

Align and bin all data at

If you check this box, the field to the right of the text is enabled and you can set the frequency at which the
output data is generated on all channels. Waveform data and RealMark data draw as a waveform are re-sampled
to this frequency using cubic spline interpolation and all other event and marker data is converted to binned
event counts using the specified frequency to set the bin width. The options for event and marker channels also
change; this is described below.
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Waveform options
These controls specify how Waveform and RealWave data is handled.

Layout options
The Layout options item can be set to Waveform only or Waveform and times, if the second option is
selected then an array containing all of the sample times is created as well as the array of waveform values.

Waveform data as

The Waveform data as item sets the type of data created for waveforms, it can be set to Integer (16-bit),
Float (32-bit) or Double (64-bit). Integers use least memory (but need scaling to user units), float has the full
accuracy of the data and is recommended. If you choose Integer for RealWave data, the values are converted to
integer using the channel scale and offset (limited to the range -32768 to 32767).

Export all data (not just first contiguous block)

Waveforms channels in Spike2 data files can contain gaps. Normally, data export stops when a gap is
encountered. If you check this option, the export ignores the gaps. If you select this option and your data does
contain gaps, you will probably want to set the layout option to Waveform and times so that you can detect
where the gaps are.

Force same point count per channel

This option is available when all the waveform channels have the same sample rate. Unless all the channels are
aligned to the same sample time, in an arbitrary time range some of the channels will have n data points and
some will have n+1. If you check this option, the end time for the data export is adjusted forwards in time by up
to one sample period so that all the waveform channels will have the same number of points. This can only be
successful if the waveform data on all channels is contiguous (no gaps) over the time range set for export and
the end time does not hit the last data point on any channel.

Marker options

The rest of the dialog sets how the various types of marker data are handled. The controls labelled Marker
channels as, TextMark channels as, RealMark channels as and WaveMark channels as define what
data is generated for the specified type of channel. If these items are set to Event then the channels are treated
as events and a single array of times is generated. If they are set to Marker then an additional array containing
the marker codes is generated, and (for the extended marker types only), setting them to TextMark, RealMark
or WaveMark means that another array containing the additional marker information is also created.

The remaining two controls labelled RealMark data as and WaveMark wave data as set the type of data
produced for these channel types, RealMark data can be exported as 32-bit floats or 64-bit doubles while
WaveMark wave data can be exported as 16-bit integers as well in the same manner as Waveform data.

If your check the Align and bin all data at check box, the options for markers are replaced by a single check
box labelled Generate times for binned data. Check this to generate an array of bin times as well as the bin
counts in the same way as for the Layout options item for waveform data.

Error handling

If there is an error in the underlying channel data (for example, if the data file associated with a time view is
damaged), the damaged channel will not be exported and you will get an error message. You can recover
damaged smr files with SonFix and damaged smrx files with S64Fix.
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Result view data

When exporting a result view to a mat-file you are first presented
with a simple dialog to select the X axis range of the data to be

eXPorted. Compatibility Latest version (currently 7.3]

Matlab export settings X

This is followed by a second dialog that sets mat-file export | [v|Use source name in MatLab variable names
options. Use the Compatibility field to select the file format to | [Juse source channel name in variable names
use. Unless you have an older version of MATLAB you should
select the Latest output format. Layout options Bate saly ~

The next two controls are check boxes to control the channel Help Cancel
variable naming as described above. The only other control,
labelled Layout options, can be set to Data only if you only want to export the result bin values or Data and
times if you want to export both the bin values and the bin x axis positions.

XY view data

For an XY view you do not get a dialog to control what data is
exported; all the visible channels are exported and only data
points that lie within the displayed X and Y axis ranges are used. | compatibility Latest version (currently 7.3,

Matlab export settings X

A dialog is provided to control how the data is exported. This is Use source name in MatLab variable names
a simplified version of the result view export options dialog; it
contains the two standard check boxes to select the use of the

[_]Use source channel name in variable names

source view name and channel names to create the MATLAB Help Cancel
variable name plus the choice of which version of the file system
to use.

Mat file data format

A mat-file represents a collection of MATLAB variables rather than simple data values, which allows for a
complex representation of Spike2 data within MATLAB. Each Spike2 channel exported into a mat-file is
represented by one variable This variable is a structure containing fields that hold information about the
channel and the channel data. For example, a structure holding data from a waveform channel has the fields
title, frequency and start each of which is a simple (scalar) datum holding the channel title, the sampling
frequency in Hz and the time of the first data point. In addition there is a field called wave that is a n x 1 matrix
holding the waveform data values and an optional field called times which is a n x 1 matrix holding the
sample time for each of n waveform points. The structure varies according to the channel type, though some
fields are common to all channels.

Time view
Exported time view data also exports a structure called £ile that contains two fields:

name A string variable holding the complete path and name of the SON file.

start A 6x1 matrix of 16-bit integer data holding the date and time at which sampling of this file started (time
0 in the file), as year, month, day, hours, minutes, seconds. This format is suitable for use as a
MATLAB datetime value.

Waveform RealWave and binned RealMark data drawn as a waveform

Waveform data is exported as a 1-dimensional array of waveform values with an optional associated array of
sample times. The fields in the channel structure are:

title a string holding the channel title.
comment a string holding the channel comment.
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interval a double holding the sample interval or bin width in seconds.

scale a double holding the channel scale factor. The scale and offset values convert 16-bit ADC
data to real values using the equation:
real = (ADC * scale) + offset.

offset a double holding the channel of fset value (see above).

units a string holding the channel units.

start a double holding the time of the first waveform point in seconds

length a double holding the number of waveform items.

values a length x | array holding the waveform values, either raw or produced by interpolating to

the bin times. Depending upon the output options selected, this array could be double or
single-precision real values or 16-bit integers.

times a length x 1 array of doubles holding the sample times of the waveform values in seconds.
This field is only present if waveform times are selected.

If you choose to export a RealWave channel as 16-bit integers, the Spike2 channel scale and offset (as seen by
double clicking the channel title in Spike2 or accessed from the Spike2 script language with the ChanScale ()
and ChanOffset () commands) are used to convert real values into integers. If the result exceeds the 16-bit
signed range (-32786 to 32767), the result will wrap around.

Event channels binned and un-binned

Event data is represented as a 1-dimensional array of event times with (for Level channels) a corresponding
array of levels. If the data is binned, this is replaced by an array of bin counts and an optional array of bin
times. This format is used for all types of marker channel if they are exported as event data as well as for event
channels. If the data has been binned, this format is used for all types of marker. The fields in the channel
structure for both types of data are:

title a string holding the channel title.
comment a string holding the channel comment.
length a double holding the number of events or binned values.

For un-binned data, the extra fields are

resolution a double holding the underlying timing resolution in seconds.

times a length x 1 array of doubles holding the event times in seconds.

level a length x 1 array of byte values holding the level for level channels only. The value is 1 if
the transition at the corresponding time was upwards, 0 for a downwards transition

For binned event and marker data these fields are replaced by:

interval a double holding the bin width in seconds.

start a double holding the time of the first bin in seconds.

values a length x | array of doubles holding the binned event counts.

times a length x 1 array of doubles holding the times in seconds for the corresponding bins. This

field is present if bin times are selected.

Marker channels

Marker data is represented in the same way as simple event channels but with the addition of an extra length-
by-4 byte array of marker codes. This format is used for all types of extended marker channel if they are
exported as markers. The fields in the channel structure are:

title a string holding the channel title.

comment a string holding the channel comment.

resolution a double holding the underlying timing resolution in seconds.

length a double holding the number of markers.

times a length x | array of doubles holding the marker times in seconds.
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codes

TextMark channels

a length x 4 array of byte values holding the marker codes.

TextMark data is represented in much the same way as simple markers but with the addition of an extra 2
dimensional array holding the marker text. The fields in the channel structure are:

title
comment
resolution
length
items
times
codes

text

RealMark channels

a string holding the channel title.

a string holding the channel comment.

a double holding the underlying timing resolution in seconds.

a double holding the number of markers.

a double holding the maximum number of characters in each marker.
a length x 1 array of doubles holding the marker times in seconds.
a length x 4 array of byte values holding the marker codes.

a length x items array of char values holding the marker text.

RealMark data is represented similarly to simple markers but with the addition of an extra 2 dimensional array
holding the real values and units information. The fields in the channel structure are:

title
comment
resolution
units
length
items
times
codes

values

a string holding the channel title.

a string holding the channel comment.

a double holding the underlying timing resolution in seconds.

a string holding the channel units.

a double holding the number of markers.

a double holding the number of real values per marker.

a length x 1 array of doubles holding the marker times in seconds.
a length x 4 array of byte values holding the marker codes.

a length x items array holding the marker values. These are either single or double-
precision real values, set by the export option selected.

WaveMark channels

WaveMark data is represented in the same way as simple markers but with the addition of an extra 3
dimensional array holding the waveform values and additional calibration information as provided for
waveform values. The fields in the channel structure are:

title
comment
resolution
interval

scale

offset
units
length
items

trigger

a string holding the channel title.

a string holding the channel comment.

a double holding the underlying timing resolution in seconds.
a double holding the waveform sample interval in seconds.

a double holding the waveform scale factor. The scale and offset values convert 16-bit ADC
data to real values using the equation:
real = (ADC * scale) + of fset.

a double holding the waveform offset value (see above).

a string holding the waveform data units.

a double holding the number of markers.

a double holding the number of waveform values per trace per marker.

a double holding the offset to the trigger point within a trace in the waveform data. This value
will be from 0 to items-1;
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traces a double holding the number of traces within the waveform data (normally the number of
electrodes).

times a length x 1 array of doubles holding the marker times in seconds.

codes a length x 4 array of byte values holding the marker codes.

values a 3-dimensional array (length x items x traces) holding the marker waveforms. For

single trace data the third dimension is 1 so it becomes a length x items matrix. Depending
upon the output options selected, this array could be double or single-precision real values or
16-bit integers.

Result channels

Result data is represented in much the same way as waveform data but without any calibration information.
Extra information is provided about the X axis. The fields in the channel structure are:

title a string holding the channel title.

units a string holding the channel (Y axis) units.

xunits a string holding the X axis units.

interval a double holding the result bin width in the appropriate X axis units.

start a double holding the X axis value of the first bin.

length a double holding the number of result bins.

values a length x 1 array of doubles holding the result bin values.

times a length x | array holding the X axis values for the corresponding bins (these are not always

time values). This field is only present if result bin times are selected.

XY channels

XY data is represented as two 1-dimensional arrays of X and Y data plus ancillary information. The fields in
the channel structure are:

title a string holding the channel title.

units a string holding the Y value units.

xunits a string holding the X value units.

length a double holding the number of XY points.

xvalues a length x 1 array of doubles holding the x values of the data.
yvalues a length x 1 array of doubles holding the y values of the data.

Script export to mat files

Export to mat-files is also available from the script language by using the FilesaveAs () function with the file
type set to 100. With this type in use, the file name selection dialog (if provided) will use a ‘* .mat’ file name
filter, an extra exp$ argument becomes available to allow MATLAB-export specific options to be set and the
time range and channels to be exported are set by ExportChanList (). Only the first set of time range plus
channels is used, and ExportChanList () is additive in action, so you should first use ExportChanList ()
with zero (or one) arguments to clear out any stored sets of information before setting the time range and
channels you want. The extra exp$ argument that sets options is a string of the form:

name=value|name=value|...|name=value

where name specifies some export option and value sets it’s value. You can include as many options as you
want, options that you omit are set to the default value. Option names are not case-sensitive. It is not an error to
use an unknown option.

BEWARE: If you set UseCName to 1 and you have channels with duplicated names, Spike2 will write the data,
but MATLAB will only see the last channel as each variable with the same name overwrites the previous one
when data is read.
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Time view export options

UseSName

UseCName

BinFreqg

BinTimes

WaveTimes

WaveData

WaveAll

WaveSameN

MarkAs
TMarkAs

RMarkAs

RMarkData

WaveMarkAs

WaveMarkData

selects use of the source name in the channel variable name. Set 1 (default) to use the source
name, 0 if not.

selects use of the channel name in the channel variable name. Set to use the channel name, 0
if not. The default is 0.

selects binning of the data. Set 0 (default) for un-binned, otherwise set to the binning
frequency in Hz.

selects generation of an array of the times of the bins (ignored if the data is not being binned).
Set 1 for bin times, 0 if not. The default is 0.

selects generation of an array of waveform sample times in the channel variable. Set 1 for
times, 0 (default) for none.

selects the data type generated for waveform channels. 0 for 16-bit integers, 1 for single-
precision real data and 2 for double-precision real data. The default is 2.

Set to 0 to stop waveform or RealWave export at a gap. Set to 1 to ignore gaps. The default is
0.

Used when all waveform channels have the same sample rate. Set to 1 to adjust the end of the
time range so that all channels have the same number of points. Set to 0 (default) to use the
time range as supplied.

sets how marker data is exported. Set to 0 for events and 1 for markers. The default is 1.

sets how text marker data is exported. Set to 0 for events, 1 for markers and 2 for text
markers. The default is 2.

sets how real marker data is exported. Set to 0 for events, 1 for markers and 2 for real
markers. The default is 2.

selects the data type generated for the real values in RealMark channels. 1 for single-
precision real data and 2 for double-precision real data. The default is 2.

sets how wave marker data is exported. Set to O for events, 1 for markers and 2 for wave
markers. The default is 2.

selects the sort of data generated for the waveform in WaveMark channels. Set to 0 for 16-bit
integers, 1 for single-precision real data and 2 for double-precision real data. The default is 2.

Result view export options

UseSName

UseCName

BinTimes

selects use of the source name in the channel variable name. Set to 1 if you want to use the
source name, 0 if not. The default is 1.

selects use of the channel name in the channel variable name. Set to 1 if you want to use the
channel name, 0 if not. The default is 0.

selects generation of an array of result bin times in the channel variable. Set to 1 if you want
bin times, 0 if not. The default is 0.

XY view export options

UseSName

UseCName

Compatibility

Compat

selects use of the source name in the channel variable name. Set to 1 if you want to use the
source name, 0 if not. The default is 1.

selects use of the channel name in the channel variable name. Set to 1 if you want to use the
channel name, 0 if not. The default is 0.

Sets which version of the MATLAB filing system to support. 0 (default) for the most recent
MATLARB file format known to the system, 1 for version 4 and earlier, 2 for version 6, 3 for
version 7 and 4 for version 7.3 (supports files > 4 GB).

Channels in the exported file

The Set... Channels... button in the Export As dialog opens the Set channels in new data files dialog. The
minimum number of channels in a data file is 32 and the maximum is currently limited to 2000 (64-bit files
have a theoretical limit of 65535 channels, but this is not yet supported by Spike2).
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Set channels in new data files X

-

Maximum number of channels in the new file | 32

WARNING: Spike2 4.01 and earlier read data files with 32
channels. Before 5.15, up to 256 channels were supported.
Before 9.00, up to 400 channels were supported.

s | ox

Setting a larger number of channels increase the size of the file header, which holds the channel title and any
units and sample rate information. It does not allocate data space in the file, so apart from an increase in the
channel header size and in memory usage per file, there is no other penalty. The 32-bit filing system does not
allow you to change the number of channels once the file is created. The 64-bit filing system theoretically can
add more channels after the file has been created and used, but there is no support for this in Spike2 yet. It is a
good idea to allocate enough channels for your foreseeable data analysis needs.

If you will share your files with people using older versions of Spike2 you should be aware that before Spike2
version 4.02, only (32-bit) data files with 32 channels were readable. Version 5 reads 32-bit files with up to 256
channels (5.15 onwards can read 400 channels). Version 8 can read 64-bit .smrx files with up to 400 data
channels. You need at least version 9 to read files with more than 400 channels.

Load and Save Configuration

These commands manage Spike2 configuration files (.s2cx extension). Configuration files hold the full
sampling set up including any output sequence file, waveform output and window arrangement and the types of
on-line analysis required.

Load Configuration
You cannot update the sampling configuration if Sampling is in progress. This opens a sub-menu with the
options Open..., Load Default... and a list of recently loaded configuration files.

Open... This opens a file select menu from which you can select a configuration file (extension . s2cx)
holding a full sampling configuration, or you can select a Spike2 data file (.smr or .smrx
extension) and Spike2 will do the best it can to extract a sampling configuration that would
generate a similar data file to the selected file.

Load This option is new in Spike2 [11.00]. It attempts to load the default configuration. This is the

Default... same configuration file that Spike2 loads on start up. The seatch is first for the file
DEFAULT.s2cx (unless this is disabled in the Edit menu Preferences), then for the file
LAST.s2cx. Each file is searched for in the User data folder, then the Local Application data
folder and finally in the Spike?2 installation folder.

File list From Spike2 [10.13] you can also select from a list of up to 10 recently-used configuration files.
Files are added to this list when they are loaded or saved. The most recently used file is at the
top of the list.

The script language equivalent of this command is to use FileOpen () with a file type of 6.

After reading a configuration, the Sampling Configuration dialog opens to display it. If you wish to sample
immediately, click the Run Now button.

You can also click a button in the Sample Bar to load a pre-set configuration and start sampling.

Spike2 ignores application window and dialog positions held in . s2cx configuration files if less than 25% of
the window is on the screen area, or if the window title bar would be above the screen (as this makes it very
difficult to move the window).

Limitations of reading configurations from data files

Data files hold only the channel settings; they do not hold window arrangements, output sequencer, waveform
output, Talker or data processing settings. Select Data files (*.smrx;*.smr) in the dialog to read a data file in
place of a configuration file. There is no guarantee that a configuration read in this way will exactly match
the data file; you must check the result carefully and you may need to adjust the resulting configuration. If the
waveform rates do not match the file rates, navigate to the Resolution tab and experiment with setting Burst
mode and using the Suggest button.

6-46



File menu

You cannot reconstruct the sampling configuration for Talker-based, Derived or Processed channels from a
data file.

Problems reading configurations

If Spike2 detects a problem reading the configuration it opens a message box with an explanation. If the
message box has a Help button, this leads to an explanation of what has gone wrong and may have suggestions
for fixing it. For example, loading configurations with uninstalled Talkers can lead to problems.

Save Configuration
This command saves the current sampling configuration to a .s2cx configuration file. It opens a File Save
dialog in which you can choose where to save the configuration.

Save Default Configuration

This command is normally hidden. You activate it by holding down the ctr1 key before you select the File
Menu. This saves the sampling configuration to the file DEFAULT.s2cx in the current users application data
directory. Once you do this, each time Spike2 starts it will load this configuration unless you set the Ignore
Default Configuration check-box in the Edit menu Preferences Sampling tab. Choosing this option clears the
Ignore Default Configuration flag if it is set. Alternatively, locate the DEFAULT . s2cx file and delete it.

Tip: to get the path to the current configuration on the Windows Clipboard, open the Sampling Configuration
dialog and right-click on the title bar and select the option to Copy the path to the file.

Default configuration files: DEFAULT.s2cx, LAST.s2cx

If the configuration file DEFAULT . s2cx is found, it is loaded when Spike2 starts. To save this file, hold down
the control key while activating the File menu and use the Save Default Configuration command. The
standard file LAST. s2cx holds the last configuration that was used for sampling. If DEFAULT . s2cx cannot be
found, and LAST . s2cx exists, LAST . s2cx is loaded. Spike2 saves LAST . s2cx each time sampling stops. If no
file is found, Spike2 starts up with a standard configuration with no data channels set.

Prevent default files from being used
There is a setting in the Edit Menu->Preferences in the Sampling Tab to disable the use of all default files to
ensure that the last used sampling configuration (LAST . s2cx) is always used.

Where does Spike2 search for these files?

Spike2 is normally installed into the Program Files folder, but we want to remain compatible with old versions
of Spike2, which were stored in a user-selected folder. To do this, we search a list of places to find the
default and last files. The search order is:

1. The application data directory (but read below for what this means)
2. The directory in which Spike?2 is installed

Prior to Spike2 version 9, we searched each directory for the s2cx file first, then for the s2c file (for
backwards compatibility). However, version 9 onwards no longer supports . s2c configuration files (so if you
want to use one, last written by Spike2 version 7.10, you should open it in version 8, use it to sample data,
which converts the format, then save it). The application data directory is the first of the following that exists:

1. The current users application data directory
2. The all-users application data directory
3. The "My Documents" folder

Double-click .s2cx files to open in Spike2

The Spike2 installation program attempts to set the system file associations so that double-clicking a
configuration files opens it in Spike2. If double-clicking a .s2cx file in the shell (desktop or a file folder
window) does not open the file in Spike2, or opens an old version of Spike2, you should check that the file
association are set correctly. If you have Administrator right the simplest way to set file associations is to run
Spike2 as Administrator by right-clicking the Spike2 icon and selecting Run as Administrator. You should
only need to do this once.

If you run in User mode on an administrated system you will have to ask your IT department to temporarily
give you enough rights to do this.
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Exit
This command closes all open files and exits from Spike2. If there are any text or output sequence files open
that have not been saved, you will be prompted to save them before the application terminates.
If there are newly sampled and unsaved time views, you will be asked if you are sure that you want to exit
without saving in the same way as if you had attempted to close the Time window.

Send Mail

If your system has support for Mail installed (for example Microsoft Exchange), you can send documents from
Spike2 to another linked computer. This option vanishes if you do not have compatible mail support.

Text-based documents and result views can be sent, even if they have not been saved to disk (Spike2 writes
them to a temporary file if they have not been saved).

You can send a Spike2 data file, but only if you are not sampling to the file and it has been saved on disk and is
unmodified. Spike2 makes a temporary copy of the file in the system temporary folder before mailing it to
avoid problems with mail programs that will not send a file if it is open in another application. You must have
enough spare disk space for at least 2 copies of the data file.
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Printing

Page Setup

Page Headers and Footers

Print Preview

Print Visible, Print and Print Selection
Print Screen

Page Setup

This opens the printer page set up dialog. The dialog varies
between operating systems and printers. See your operating
system documentation for more information. The important
options that are always present include the paper
orientation (portrait or landscape), the paper source (if your
printer has a choice), and the printer margins.

The Orientation option (portrait or landscape) applies to
all output except the Print Screen option, which has its
own selector for the output orientation.

The printer margins will appear in inches or in millimetres,
depending on the locale set for your computer. These
margins are used for all printed output. The left and right
margins are applied to everything, including headers and
footers. The top and bottom margins apply to everything
except headers and footers, which have their own top and
bottom margin settings (see the Page Headers
description). The top and bottom margins you set here are
further modified if a header or footer would collide with
them.

Most printers have an unprintable area near the paper edge. If you set margins smaller than the unprintable area,

Page Setup

Paper

Size:

Source:

Orientation

@ Portrait

() Landscape

Help

[na

|A|.rtomatically Select - |

Margins (millmeters)
Left:

Top:

10 Right: 10
10 Bottom: 10
| ok || Cancel |

¥

the margins are increased so that all your output is visible. If you set margins that reduce the printable area too

much, the margins are ignored.

Registry use

Spike2 saves the page margins in units of 0.01 mm in the system registry. You can find them in the
HKEY CURRENT USER\Software\CED\Spike2\PageSetup folder as REG DWORD values: LeftMargin,

RightMargin, TopMargin and BottomMargin.

Page Headers and Footers

You can apply headers and footers [ printed Header and Footer

==

to all printed output. The headers set
in this dialog are used with all Time,
Result, XY and text-based views.

Header

Space above to paper edge

7

The header and footer text is Text Spike2 data file|f]%c

displayed in the page format set by

the Page Setup command.
Foote
Other printed output (for example o

from the Print Screen command)
uses all these settings except the
header and footer text, which is
provided by each of the other

printing commands. | b |

Space below to paper edge

7

SetFont,.. | [Arial, 12Pt, Bold

Text CED 2013|Page &p of &nlPrinted: %#c

| Set Font... Arialll, 12 Pt

Line below thickness i Thick: - |
=

@ File Time | System Time

Line above thickness |_Medium - |
=

() File Time (@ System Time

[ cancel |[ ok |

Page Header and Footer dialog
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Header and footer positions

The horizontal position is set by the left and right margins in the Page Setup dialog. The vertical positions are
set by the space above the header and the space below the footer fields in inches or millimetres, depending on
the locale. If your header or footer encroaches on the top and bottom margins set in the Page Setup dialog, the
top and bottom values are adjusted to keep the output clear of the header and footer.

Line thickness

You can choose between: None, Hairline, Thin, Medium and Thick. A Hairline is the thinnest line possible on
the output device. The other settings should be self-explanatory. The header line is drawn below any header
text, the footer line is drawn above any footer text. If there is no header or footer text, no line is drawn.

Text

This is the text to display as the header or footer. If this field is empty, the header or footer is omitted (including
any line). You can split the text into left-justified, centred and right-justified sections with the vertical bar
character. You can also insert codes that are replaced by document and time information. The simplest way to
do this is by clicking the >> button to the right of the text and choosing an option.

Set Font
Click this button to choose a font for the header and the footer. Font sizes are limited to 2 to 30 points.

File/System Time

You can insert times into both the header and the footer. However, you have to choose between the current time
and the file time. This allows you to display the file time in the header and the current time in the footer, or vice
versa.

Document information
The following codes are replaced by document information:

&f File and path &F Upper case file and path
&t Document title &T  Upper case document title
&p  Page number &n  Total number of pages

&& The ampersand sign (&)

Time and date codes

You can insert times and dates using % followed by a character code. The combination is replaced as described
in the table. You can also use $#c and %#x for a long version of dates and times. You can remove leading zeros
from numbers with #, for example %#7.

%a  Short day of week (Mon) 5P Indicator for A.M or P.M.

52 Long day of week (Monday) %S  Seconds as number (00-59)

5b  Short month name (Jan) 50U Week of year, Sunday based (00-53)
5B Long month name (January) W Week of year, Monday based (00-53)
5c  Date and time for locale 5w Sunday based weekday (0-6)

5d  Day of month (01-31) 5x  Date formatted for locale

SH Hour in 24 hour format (00-23) %X Time formatted for locale

51 Hour in 12 hour format (01-12) 5y  Year without century (00-99)

%3 Day of year (001-366) 5Y  Year with century, e.g. 2004

sm Month as number (01-12) %z/Z Time zone name

M Minute as number (00-59) 5% The percent sign (%)

Registry use

Spike2 saves the header and footer settings in the system registry. You can find them in the folder
HKEY CURRENT USER\Software\CED\Spike2\PageSetup as strings: Header, Header info, Footer
and Footer info. The Header and Footer items hold the text strings. The two info items are strings that
code up the font name, point size, bold and italic settings, distance to the paper edge in units of 0.01 mm, line
thickness (O=none, 1=Hairline, 2=Thin, 3=Medium, 4=Thick), and File time (0) or System time (1).
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Print Preview

B e
[__Print.. ] [Mext Page | | Frev Page | [ One Page | [ Zeemln ]| Zoom Out | [ Cese
ikeZ data file C:\llsers\GregiDocument s.Dema. smr 15/07/2013 11:01:35 ike? data file C:\lsers\GregiDocument s\Dema.smr 15072043 11:01:35 -
Keyboard t h h i s i
Textmark O 1
Ropomse W] T L W R TR,
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TEDZOTT P ToiT Frnted, 27 August 2013 185523 TEDTOTY Foge 20 Frnted: 27 Augus 2013 185503

This option displays the current time, result, XY and text-based window as it would be printed by the Print
option. You can zoom in and out, view one or two pages, step through pages of multi-page documents and print
the entire document using a toolbar at the top of the screen. Close leaves this mode without printing.

The preview takes place inside the frame of the time, result or XY view. You can access the File menu to
change the headers and footers and print margins.

Print Visible, Print and Print Selection

These commands print time, result, XY and text-based windows. Any scroll bar at the bottom of the window is
not printed. The Edit menu Preferences dialog sets the line widths used on screen and for printing. Print
Selection prints the selected area of a text window. Print Visible prints the visible data in the current window.
Print prints a specified region of a time, text or result view; each printed page holds the x axis range of the
window. Print in an XY view is the same as Print Visible.

Print
To print an entire data file, set the width of the time window holding the | pyint time range [
file to the page size required in the print, then select Print. Set the start
time to zero and use the drop down list to set the end time to
Maxtime(). Beware that Print could require several hundred miles of ||Endtme  Cursor(2) ~ | seconds
paper to complete the printing job in the worst case! If you displayed 10
milliseconds of data across the screen in a file that is 1000 seconds long,
there are 100,000 pages to print.

Start ime  Cursor(1) - seconds

| Cancel | [ Print |

Print Visible
This is equivalent to the Print command with the x axis range set to the displayed x axis (except for XY views,
where it is identical to Print).
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After selecting Print

Both commands open the standard print dialog for your printer. You rspikez

can set the print quality (in general, the better the quality, the longer the
print takes) and you can also go to the set up page for the printer. Once Printing
you have set the desired values, click the Print button to continue or the Document : - Demo smr

Cancel button to abandon the print operation. ol San
Printer :  Adobe PDF

During the print operation (which can take some time, particularly if Pot: COM?;
you selected a lot of data) a dialog box appears. If your output spans [ Cancel |
several pages, the dialog box indicates the number of pages and the :

current page, so you can gauge progress. If you decide that you didn't
want to print, click the Cancel button.

Print Screen

The Print Screen command prints all time, [ pint screen

S

result, XY. Grid and text based views to one
printer page. The views are scaled to occupy the
same proportional positions on the printed page

Page
Header -Spikezisa'eendump!'u'ersion 8.00

=

J

as they do on the screen. The page margins are || Eeoter CED2013] [Printed: %3d =
those set by the Page Setup and Page ) Portrait (@ Landscape
Headers dialogs.

Views
The command opens a dialog with two regions: || [¥IPrintTiles [[PrintBorders  [T|Preserve text view character Aspect ratio
Page and Views. In the Page region you can set
a page header and footer and choose to print in | bep | | cancel | | ox

Landscape or Portrait mode. The header text is *

printed with an underline across the width of the page. The footer text is printed with a line over it across the
page width. The fonts used and line thickness are as set in the Page Headers dialog. If the header or footer is

blank, both it and the associated line are omitted.

You can divide the header and footer into a left justified, centred and right justified sections with the vertical
bar character, for example: Left|Centered|Right. You can include the current date and time in the header or
footer by including, for example %c, as described for the Page Headers and Footers dialog. The >> button

can be used to insert the time and date and vertical bar separators into the header and footer.

In the Views region you can choose to print view titles and draw a box round each view. You can also ask
Spike2 to attempt to preserve the aspect ratio of characters in text windows. This feature is currently not

supported.

Registry use

Spike2 saves the Print Screen settings in the system registry. You can find them in the
HKEY CURRENT USER\Software\CED\Spike2\PageSetup folder. The text strings are saved as PSHeader
and PSFooter. The remaining values are saved as REG_DWORD values of 0 (not selected) and 1(selected):

PSViewTitle, PSBorder, PSScaleText and PSLandscape.

6-52



7: Edit menu



Spike2 version 11 for Windows

Edit menu

This menu holds the standard Edit functions that all programs provide. The majority of the menu is associated
with commands that move data to and from the clipboard.

Undo and Redo

Cut

Copy

In a text, script or output sequence window this is used to undo or redo the last text edit operation. You cannot
undo operations that have been saved to disk or text operations that were done by a script.

In Time, Result, XY and Grid windows, you can undo most operations that change the appearance of the
window. Cursor movements do not undo; this is by design so you can zoom in, adjust a cursor, then undo to
zoom out, leaving the cursor adjusted.

You can cut editable text to the clipboard in any position in Spike2 where the text pointer is visible. You cannot
use this command in Spike2 data document windows or in result windows.

You can copy editable text to the clipboard plus selected fields from the Cursor Regions and Cursor Values
dialogs. If you use this command in a time, result or XY window, the contents of the window, less the scroll
bar, are copied to the clipboard as both a bitmap and as a metafile. See also Copy As Text.

Metafile output

To export an image to a drawing program for further annotation and manipulation, you can paste the image as
either a bitmap or as a metafile. Metafiles are usually the preferred choice as you can treat the image as lines
and text for further work. You can set the metafile scaling and if the image is saved as a Windows Metafile or
as an enhanced Metafile in the Edit menu Preferences.

Other formats (PDF, SVG, EPS, ODF...)

The free open source program InkScape will accept the output of the Copy command from a Time, Result or
XY view as an image, or you can save the image to a file as a metafile and import it into InkScape. You can
then export the image in a wide variety of formats.

7-2



Edit menu

Copy for Spreadsheet

This copies selected time view data channels to the clipboard as text. [ spreadshest format text output = |
Use Export As to copy to a text file. If there are no selected channels, eriation
it copies visible channels. The Channels area displays how the SR 100

channels were chosen (Visible or Selected) and the list of channels || . e mterpolation method

N Lingar v|
that will be output.
. . . . Time range
The data is written in columns. The first column holds the time of || g tfme 0 =
each row (in seconds). The remaining columns hold the data, one S reee— =

column per channel.
|| Time shift output so first line is at 0.0 seconds

Format

Channel output format Stringdelimiter ©  Separator [Tab |
Where possible, the output matches the display. Channels drawn with —
a y axis output values that match the display. Channels drawn in State
mode output the state code as text. Sonogram draw mode is output as || channels
waveform mode. Visble 53,521

[¥|Export channel tiles [ | Expart channel units

From [10.12], Level event channels (unless drawn as a Rate or Mean |
frequency) display the level at the time of the output line (as 1 or 0).
Prior to this version, they drew in the same way as Event- and
Event+ channels.

Help | Cancel | | OK J

All other drawing modes output the number of events from the time of the current line up to the time of the next
line.

Interpolation
Spike2 allows each channel to have independent rates and types. To make Spike2 data easily accessible to other
programs we re-sample the data to a common rate, set by the Output sample rate in Hz field.

In general, the sample rates of Waveform, RealWave and WaveMark data will not match the output rate you
have chosen and the program must interpolate. You can choose between Linear, Cubic spline interpolation, or
use the value at the Nearest data point. Waveform data drawn in Sonogram mode is treated as a waveform.
All other channels that need interpolation use linear interpolation.

Time range
The Start time and End time fields set the time range to copy. You can also shift the data so that the first line
has a time of 0.0 to make comparisons of time ranges easier.

Format

Values are written in numeric or text columns. There is a separator between columns; choose from Tab, space
or comma in the Separator drop down list. The String delimiter character is placed around text output. If you
check the Export channel titles box, the first line of output holds titles to identify the columns (the channel
number and title string). If you check the Export channel units box, the second (or first if the titles box is not
checked) output line holds the units of each column.

Copy As Text Result view

This command is available in result views. It copies the bin values in the window for all visible channels to the
clipboard as text. To copy all bins, double click the x axis and select Show All, then copy. The first output
column holds the x value at the left of each bin. Each channel contributes one column of bin contents plus a
column of error bar sizes if error bars are enabled and a column of bin counts if bin counts are enabled. The
first line holds column titles. This command does not copy channels drawn as raster data. The first example is
from a result view holding two waveform averages:

"Time" "Filtered" "Sinewave"

0 0.84302088 3.2980477

0.01 0.27032173 2.2613753

0.02 -0.45484864 1.043198

0.03 -0.74969506 0.63429488
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The columns are separate by Tab characters. The second example is from the same data with error bars enabled

and drawn in SEM mode.

"Time" "Filtered" "SEM" "Sinewave" "SEM"

0 0.84302088 0.038987886 3.2980477 0.032728175
0.01 0.27032173 0.021425654 2.2613753 0.036360926
0.02 -0.45484864 0.027970654 1.043198 0.056437311
0.03 -0.74969506 0.037386934 0.63429488 0.050863126

Copy As Text XY view

This menu item is available in XY views. It copies the visible points for visible channels to the clipboard. If the
view has one channel or the Measurement system created it with the All channels use same X option, the
output is a rectangular table with the first line holding column titles. There is one column of x values followed
by one column per channel for each y value. The columns are separated by a tab character:

"X" "Channel 1" "Channel 2"

0.244140625 0.0170616301

3.122558594 ©0.0001053187043

2.211914063 ©0.0006319122258

1.889648438 -0.0005265935215

0.8642578125 -0.0005265935215

oo hrNO

In all other cases, channels are output separately. For each channel, the first output line holds “Channel : cc
nn” where cc is the channel number and nn is the number of data points. The data points are output, one per
line as the x value followed by the x value, separated by a Tab character.

Channel : 1 : 5

0.0170616301 0.244140625
0.0001053187043 3.122558594
0.0006319122258 2.211914063
-0.0005265935215 1.889648438
-0.0005265935215 0.8642578125
Channel : 2 : 5

(7] 0.0170616301

2 0.0001053187043
4 0.0006319122258
6 -0.0005265935215
8 -0.0005265935215

Copy As Text Time view

In a time view the command opens a dialog in which you specify the | fime view text sutput e |
time range of data to copy, how you want the data to be copied and |4 - c

the output format. Select the channels to copy in the time view before Start time (seconds) | 0.0] 7
you use this option. If you select no channels, Spike2 copies visible || _ .. (seconds)  MaxTme0 -

channels. Text representations of sampled data can be very large and
awkward to manipulate with the clipboard. Alternatively, you can || Format

write the text output to a file with the File menu Export As command. || [/Header  [ViSummary — Columns 1

Separator |Tab -

You can enable and disable a header section for the entire output and || ST deimit=r

a summary section of all the channel information. You can also set the Channels
number of columns to be used when writing waveform and event || Vsble 31,4.1
times and the separators used between fields and to delimit text. For Eypds Nt 8 To-fs

. form [ | fo
each type of channel you can enable the channel synopsis and data Haetorm J - J avetorm
output. You can also choose to dump a channel type in its native || =" ¥ M et
format, or in any compatible format. Output sections are preceded by || ™Merker @ [warer -
a keyword so that other programs can parse the file. ViAVERenis = |Wa"e’“‘a’k7'|
RealMark [V [  |RealMark -

. TextMark [V [7] | Textvark -
Time range ————
Select the time range of data to copy as text in this dialog. Either type [ree] Cema ] [ox ]

in the range, or use the drop down lists to select start and end times for
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Format

the data output. When you are satisfied with the range, click on
Cancel or OK to start the output.

Spreadsheet format

It is sometimes more convenient to export data as text in a spreadsheet format. This does not attempt to export
every data sample and event; instead it resamples the data at a user-defined rate to generate a rectangular table
with columns for channels and rows for time. This is usually much simpler to interpret and import into other
programs than the somewhat complicated format required to describe the raw data.

The Format section of the dialog selects which items are output and how they are separated and delimited:

Field types, Separators and String delimiters

All time view Copy As Text information is written in fields. Each field is either numeric or text. Between each
field there is a separator, which can be set to be a Tab character, a blank or a comma in the Separator drop
down list. Most programs that accept tabulated numbers will accept space, a Tab or a comma. The examples
below use space as a separator.

A numeric field holds numbers only, either floating point numbers with a decimal point, or integer numbers. A
text field is a sequence of characters that may include spaces. Text fields may hold numbers, but numeric fields
cannot hold text. You can mark the start and end of a text field with a special character (usually ") so that a
program reading the field can include blanks (spaces) and punctuation within a field without confusion. All
keywords are treated as text fields. You can set a one character delimiter in the String delimiter field, or leave
it blank for none. The examples use " as a delimiter.

All output sections start with a keyword that can be used to identify them. All sections apart from the first are
preceded by 1 or more blank lines.

Columns

You can choose to have the data for waveform channels and Evt+ and Evt- times written in multiple columns.
This does not write one channel per column (use Copy Spreadsheet for that format). The standard format is to
write one item per line for these data types. Before version [10.12], Evt+- channels were written in multi-
column format, now they include the first marker code (level), and are written as one item per line. You can
force the old format with an Edit Preferences option in the Compatibility tab.

Header

The first part of the output is a header that displays information about the data file. This is given after the
keyword INFORMATTION. The header consists of the file name followed by a minimum of 5 and up to 8 lines of
the file comment followed by an empty line. The header block (if present) is always at least 8 lines long; trailing
blank comments after the first five are skipped. Prior to version [10.12], only 5 lines were written; A smrx file
allows up to 8 lines of comments.

"INFORMATION"

"demo.smrx"

"These five lines are always present and"

"contain"

"the file comment"

“for this"

"data."

"More lines, up to 8, can be displayed for .smrx files"

Summary

The summary section starts with the keyword suMMARY followed by a summary of the channel information for
each selected channel and ends with an empty line. From [10.12] we display the same information for each
channel, though some of the columns may not apply to all channel types. The columns and types are:

Column Chan# Type Title Rate  Units Scale Offset Points Traces Pre Comme
nt
Format Text Text Text Real Text Real Real Integer Integer Integer Text
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Example output

"SUMMARY"

"1"  "Waveform" "Sinewave" 100 "mx" ©.584 ©0.84 © © @ "Variable frequency sinewave"
"2"  "Evt-" "Stimulus" le@e "" 1 0 @ 10 "Stimulus pulse, once per cycle"
"3" "Evt-" "Events" le0 " 1 0 © 10 "Created"

"4"  "TextMark" "Textmark" 1 " 1 0 36 10 "

"5" "RealMark" "Gas||02|N2" 30 "Pa" 1 (%] 3 10 ""

"6" "TextMark" "Comments" 0.27 "" 1 0 40 10 ""

"7"  "WaveMark" "nw-1" 100 "mv" 1000 © 32 1 10 "Created 01/08/2019 from channel 1"
"8" "WaveMark" "Tetrode" 100 "mv" 1000 © 32 4 10 ""

"31" "Marker" "Keyboard" 1 " 1 0 © 10 "Keyboard"

"vl" "RealWave" "Virtual" le0 " 1 0 1 10 "

"v2" "RealWave" "Virtual" le0 " 1 0 1 10 "

Chan#

This is formatted as text as some channels (virtual, memory and duplicate have channel identifiers that are not
numeric: v1, m1, 2a

Type
This test field holds the channel type as one of the strings: Waveform, Evt-, Evt+, Evt+-, Marker,
WaveMark, RealMark, TextMark and RealWave.

Title

The channel title as text. In the case of RealMark channels, this can be subdivided by vertical bars. The first
section is the generic title, for use when no specific trace is intended. The following sections hold the title for
each attached value. If a section is blank, the generic title is used.

Rate

For Waveform, RealWave and WaveMark channels this is the sampling rate of the waveform (per trace for
WaveMark channels). For all other channel types it is the expected maximum event rate (averaged over several
seconds) that was used by Spike2 to set the input buffering requirements. If this channel was not sampled by
Spike2, this field could be meaningless.

Units

For Waveform, RealWave and WaveMark channels this holds the channel units. It is blank for other channel
types. In the case of a RealMark channel, the units can be subdivided by vertical bars in the same manner as the
title.

Scale, Offset

These are the values used to convert between 16-bit waveform samples and user units. For a RealWave channel
these are the values Spike2 uses to convert the 32-bit floating point values to 16-bit integers (when required).
See the description of channel scaling for details of how to use these factors.

Points

This field is the number of values attached to each RealMark, the maximum number of characters attached to
each TextMark or the number of waveform points per trace attached to each WaveMark. Other channel types
show this field as 0.

Traces
This is the number of waveform traces attached to each WaveMark channel (1, 2 or 4), otherwise is unused
(and set to 1).

Pre
This is used with WaveMark data only and is set to the number of pre-trigger points per trace. This will be in
the range 1 to the number of points per trace minus 1.

Comment
The channel comment.

Old Summary format
This is the format used before version [10.12]. You can force this format from 10.12 from the Edit Preferences
dialog Compatibility tab. The information given for the channel varies with the channel type. The first three
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Channel

fields are the same for all channels, being the channel number, the channel type and the channel title. The
remaining fields are:

Waveform Units, Ideal rate, Actual rate, Scale, Offset

RealWave Units, Ideal rate, Actual rate, Scale, Offset

WaveMark  Units, Ideal rate, Actual rate, Scale, Offset, Points, PreTrig
Event Predicted mean rate

Marker No other information

Here is some typical output. The SUMMARY section is terminated by a blank line.

"SUMMARY"

"1" "Waveform" "Sinusoid" "Volts" 100.0 100.0 1.0 0.0

"2" "Evt-" "Synch" 5.0

"4" "WaveMark" "Shapes" "Volts" 100.0 100.0 1.0 0.0 30 5 1
"31" "Marker" "untitled"

information

The Channel section of the Time view text output dialog holds controls to control the output based on the
channels types. For each channel, the output starts with a channel information section that is introduced by the
keyword CHANNEL, followed by the channel number. The channel number is a text field. If the Synopsis box
that matches the channel type is checked, the channel data type, comment and title are output on the next three
lines. The channel information block ends with a blank line.

"CHANNEL" "1"
"Waveform"

"Signal generator"
"Sinusoid"

The information that follows the channel information varies with the channel type and is only output if the Data
field is checked for the channel type. If a channel type is derived from a Marker, you can choose to output the
data as though the channel were a simpler type to reduce the quantity of information. For example, if you were
only interested in the times of WaveMark data, you can copy it as though it were Event data.

Waveform

A channel containing waveform data has the channel information followed by the data. The data starts with the
channel units and ideal sample rate. The next line contains the keyword START followed by the start time of the
data in seconds and the time increment per data point, also in seconds. It is possible for gaps to occur in the
waveform data. A gap is shown by a line with the word GaP followed by the start time of the new section and
the time increment. The data then follows as a list of waveform values.

"CHANNEL" "1"
"Waveform"

"Signal generator"
"Sinusoid"

"Volts" 100.0000
"START" 0.00 0.01
-3.7208
-3.8356

"GAP" 4.23 0.01
-2.2901
-2.6075
-2.8858

Event

Event data comes in three types, rising edge, falling edge and both edge triggered (Evt-, Evt+ and Level).
Since version [10.12], Level events are output in their own format (you can force the older format with an Edit
menu Preferences option). The Evt- and Evt+ types are represented in the same way as a channel header
followed by a blank line, then a list of times terminated by a blank line. The times are written with the number
of columns set in the Format section of the dialog.
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"CHANNEL" "2"
"Evt-"
"Synchronisation pulse from Signal generator"
"Synch"

0.2022
1.3209

Level (Evt+-)

In the case of an event channel triggered on both edges, the state before the first transition is shown at the start
of the data, by one of the words HIGH or L.OW. HIGH means that the first time in the list represents a code 1 to 0
transition, LOW means the reverse. If there are no times in the list, these labels are the state in the period (Low
for code 0, HIGH for code 1). For each event, the time is followed by a number (usually 1 or 0). 0 means the
data was low at this time, any other value (which will be 1 for data sampled by Spike2) means the data was high
at the time. Prior to version [10.12] this was part of the Event format and there was no number following the
time to indicate the level.

"CHANNEL" "2"

"Evt+-"

"Synchronisation pulse from Signal generator"
"Synch"

"LOW"
0.2022 1
0.2138 0

Note that in a modern 64-bit smrx data file, Level data is stored as a Marker. Each event has a time and 4
marker codes. The displayed value is the first marker code. In the old 32-bit format, Level data was stored as a
list of event times. Each stored data block had a marker to indicate if the first event time in the block was high
or low and the state was assumed to alternate.

Marker

Marker data consists of a series of times and 4 bytes of marker information. The channel synopsis is as for other
channels, and the data is displayed as a time followed by a string of 4 characters which represent the 4 bytes of
information. If the bytes are non-printing characters a ? is shown instead. The 4 bytes are also displayed as
numbers after the string. You can force marker data to be dumped as event data or as level data.

"CHANNEL" "16"

"Marker"

"The comment for this channel”
"Title"

1.0906 "pr??" 11
3.0336 "ar??" 9
5.9802 "u???" 11
6.9018 "1???" 10

RealMark

The first line of RealMark data output holds the channel units, the expected mean RealMark rate and the
number of real values attached to each event. This is followed by lines holding the same data as for a Marker
followed by the list of RealMark values. You can force RealMark data to be dumped as marker, level or event
data.

"CHANNEL" "5"

"RealMark"

"This is the RealMark channel comment”
"Memory"

"Units" 30 2
1.0906 "????" 112

923 4.8567
1.8603 "????" 113 2

0 001.8
0 0 0 1.8224 4.123
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TextMark

The first line holds the channel units (usually an empty string as TextMark channels have no units), the
expected mean rate and the maximum number of characters allowed per item in this channel. The following
lines hold data for each TextMark in the time range. The line starts with the same format as for Marker data,
followed by the text string. You can force TextMark data to be dumped as marker, level or event data.

"CHANNEL" "4"

"TextMark"

"Comment for TextMark channel”
"Title"

"" 1 100

0.5234 "????" 112 © @ @ "This is where I added the secret ingredient"
9.8603 "????" 113 © @ @ "Control point 1"

You can also export this data type by double clicking any TextMark and copying from the TextMark dialog.

WaveMark

WaveMark data is structured as a marker plus a short section of waveform data. You can force a WaveMark
channel to be dumped as though it were a marker, level, event or waveform channel. When displayed as
WaveMark data, the channel synopsis is the same as for waveform data, but also has the number of waveform
points associated with each event and the number of pre-trigger points. The dump of data starts with a line
holding the channel units, the ideal sampling rate, the number of data points, the number of pre-trigger points
and from [10.12] onwards, the number of traces:

Units, Ideal rate, Points, PreTrig{, nTrace}

This is followed by blocks of data, one for each WaveMark event in the time range. The first line of the block
holds the keyword WAVMK, followed by the time of the first data point in the event, the time interval between
waveform points and the four marker bytes. This is followed by the WaveMark data values and a blank line:

WAVMK,eventTime,adcInt,mark0,mark1,mark2,mark3
data values (1 column per trace)
blank line

This block is repeated for each event in the time range. A typical WaveMark channel begins:

"CHANNEL" "1"

"WaveMark"

"Channel comment for demonstration"
"Title"

"mv" 100.0 30 5 1

"WAVMK" ©.0210 ©0.00005 1 0 0 0
-0.03098

0.03189

0.09430

"mvV" 0.8110 ©.00005 3 0 0 O
0.15610
0.21713
0.27710

Multi-trace data

Prior to [10.12] a channel with n traces and p points per trace was displayed as all p points of the first trace
followed by all p points of the second, and so on. Each trace started on a new line (if the columns were set to
more than 1). Now, the data is displayed as p lines of data with n columns per line, one per trace:

"CHANNEL" "8"
"WaveMark"

"Comment goes here"
"Tetrode"
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"Units" 30 32 10 4

"WAVMK" ©.00000 0.01000 0 @ 0 0
-0.03098 -0.64331 -1.75903 -1.75903
0.03189 -0.67657 -2.24762 -2.24762
0.09430 -0.70694 -2.41455 -2.41455

Paste
You can paste the text on the clipboard into a text, script or output sequence document. When you paste text,
Spike2 checks that each pasted line ends with the correct end of line characters (for example, Macintosh and
Windows use different sequences). The paste operation corrects incorrect sequences. To correct text that has
come from a different operating system and that looks strange, select all the text, cut, then paste.
You can visualise the end of line characters in a Spike2 text window by opening the appropriate text settings
window with the View menu Font command and check Line ends.
Delete
This command is used to delete the current text selection, or if there is no selection, it deletes the character to
the right of the text caret. Do not confuse this with Clear, which in a text field is the equivalent of Select All
followed by Delete.
Clear
When you are working with editable text, this command will delete it all. Clear removes everything; Delete
removes the current selection.
If you are in a result window, this command will set all the bins to zero and redraw the window contents.
In an XY view, this command removes all data points, leaving all channels empty and redraws the window.
Select All

This command is available in all text-based windows and selects all the text, usually in preparation for a copy to
the Clipboard command. The short-cut keyboard command is Ctr1+A.

Find, Find Again, Find Last

The Edit menu Find command opens the Find Text dialog. If fingtext X
there is a single-line selection in the text window, this sets the

initial contents of the Find what field. The dialog is shared Fndwhat: [EE8 3
between all text-based views. It is closely linked to the Find and D=t
Replace Text dialog and shares all its fields with it; opening this | Match vhole word only Ot e
dialog closes the Find and Replace dialog. Click Replace... to [/Matchcase & ovin

Regular expression None () Wrap Cancel

swap to the Find and Replace dialog. There is also an Edit
Toolbar with buttons (and short-cut keys) to control bookmarks Replace... Help
and searches.

A successful search moves the text selection to the next matching string. Searches are done line by line; you
cannot search for text that spans more than one line. The InStrRE () script command can search across line
ends in a text string.

Find Next starts a search for the text in the Find what field. The Mark All button sets a bookmark on all lines
that match the search text, but does not move the selection. Searches are insensitive to the case of characters,
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unless you check Match Case. Check the Match whole word only box to restrict the search so that the first
search character must be the start of a word and the last search character must be the end of a word.

The script language equivalent of this dialog is the EditFind () command.

Search direction

Select Up to search backwards, towards the start of the text. Select Down to search forwards towards the end of
the text. Select Wrap to search forwards to the end, then wrap around to the start and stop when you reach the
current position. Searches do not include the currently selected text.

Regular expression
Regular expressions provide a powerful syntax for searching text for patterns. You can set this field to three
value:

None  No use of regular expressions. Searches must be a match for what you type. You can choose to match
whole words only. The meaning of a word depends on the type of the file that is being edited, but is
usually just what you expect.

Simple This uses the simple regular expression syntax that has always been supported by the Spike2 text
editor.

ECMA This used the more complex ECMAScript regular expression syntax that is supported in this dialog
from version 9 onwards.

If you select either regular expression grammar, this disables Match whole word only as regular expressions
have their own way to match word starts and word ends. It enables the >> button, which displays a list of
regular expressions to insert into the search string; the regular expressions listed depend on the grammar.

Find Again, Find Last
The Edit menu Find Again and Find Last commands repeat the current search forwards or backwards.

Simple regular expressions

The text editor has always supported a simple (but non-standard) regular expression syntax that has fewer
features than the ECMAScript regular expressions that can also be used. This topic describes the simple regular
expression syntax, it is similar to the Basic syntax available in the TnStrRE () script command.

The simplest pattern matching characters are:

Start-of-line marker. This character must be at the start of the search text. The following search text will
only be matched if it is found at the start of a line.

$ End-of-line marker. This must occur at the end of the search text. The preceding text will only be matched
if it is found at the end of a line.

Matches any character.

To treat these special characters as normal characters with regular expressions enabled, put a backslash before
them. A search for “~\~.\.” would find all lines with a “~” as the first character, anything as a second
character and a period as the third character.

You can use \a, \b, \f, \n, \r, \t, \v to match the ASCII characters BELL, BS (backspace), FF (form feed),
LF (line feed), CR (carriage return), TAB and VT (vertical tab). Searching for \n and \r will not normally
match anything as \n or \r\n mark line ends and the search is of complete lines ignoring end of line markers.

To search for one of a list of alternative characters, enclose the list in square brackets, for example [aeiou]
will find any vowel. For a character range use a hyphen to link the start and end of the range. For example, [a-
zA-70-9] matches any alphanumeric character. To include the - character in a search, place it first or last. To
include ] in the list, place it first. To search for any character that is not in a list, place a ~ as the first character.
For example, [“aeiou] finds any non-vowel character.

There are search characters that control how many times to find a particular character. These characters follow
the character to search for:
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Match 0 or more of the previous character. So 51*2 matches 52, 512, 5112, 51112 and h.*1 matches
hl, hel, hail and B[aeiou] *r matches Br, Bear and Beer.

+ Match 1 or more. The same as “*”, but there must be at least one matching character.

? Match 0 or 1 of previous character. So 5122 matches 512 and 52; Bee?t matches Bet and Beet.

Put a backslash before these characters to treat them as normal characters in a regular expression.

You can search for the start and end of a word with \< and \>. Word characters are the set [a-zA-Z0-9], or
[a-zA-70-9%$] in script views. For example, the regular expression \<[a-zA-2z]+\> will match a text word,
but not if it contains numbers. You can also use \w to match a word character and \w to match not a non-word
character. Likewise, \d matches a decimal number and \D to matches a non-number character and \ s matches
white space (space, TAB, FF, LF and VT) and \s matches non-white space. You can use \w, \W, \d, \D, \s
and \ s both inside and outside square brackets.

You can match a character with a particular code using \xnn, where nn is the character code in hexadecimal.

You can also tag sections of matched text by wrapping it in \ ( and \). You can then insert the tagged text later
in the regular expression (or in the replace text in the Find and Replace dialog) using \n, where n is 1 for the
first remembered text, up to 9 for the ninth. For example, \ (foo\) -\1 matches foo-foo. More interestingly,
the regular expression \ (\<[a-zA-Z]+\>\)-\1 matches Jim-Jim, plum-plum and the like.

Replace
The Edit menu Replace command is available when the current | fing and Replace Text X
view is text-based. It opens the Find and Replace Text dialog in T
which you can search for text matching a pattern and optionally Fnd“hat == a|-|
replace it. If there is a single-line selection in the text window, this = Replace with:| Proc Wibble( v >
sets the initial contents of the Find what field. The search part of Direction
. S . ) . Find Next
the dialog is identical to the Find Text dialog. The search pattern = Match whole word only Up
set by the Find what field can be a simple match, or can be a [IMatch case ® Down Beic
regular expression. In regular expression searches, the replacement = Regular expression Simple | O Wrap Replace Al
text can refer back to tagged matches in the search text. See the
. . . . Help Cancel
Find dialog for details of regular expressions and tagged matches.
The >> buttons are also enabled in regular expression mode and let you insert expressions into the search and
replace text.
The script language equivalent of this dialog is the EditReplace () command.
Replace with
This field holds the text to replace the matched search text. In a regular expression search, you can include
tagged matches from the search text using \1 to \ 9 as described for the Find dialog. For example, suppose you
have variables named fred0 to fred17 that you want to convert into an array fred[0] to fred[17]. You
can do this by setting the Find what field to \<fred\ ([0-9]+\) \> and the Replace with field to fred[\1].
Replace
The Replace button checks that the current selection matches the Find what field and if it does, the field is
replaced by the Replace with text field and the selection is moved to the next match. If the current selection
does not match, Replace is equivalent to Find Next.
Replace All
This button searches for all matches in a forward direction starting from the beginning of the text to the end,
and replaces them.
Edit toolbar

The Edit toolbar gives you access to the edit window bookmarks and = | (o] A
short cuts to the Find, Find next, Find previous and Replace ‘ /‘l 3 /%I Eﬁ—'l !ﬁl MJ # i "'hI
commands. If you are unsure of the action of a button, move the mouse pointer over the button and leave it for a
second or so; a “Tool tip” will reveal the button function and any short-cut key associated with it.

7-12



Edit menu

The four bookmark functions toggle a bookmark on the current line, go to the next or previous bookmark and
clear all bookmarks. The Edit menu Find command can set bookmarks on all lines containing a search string.

If the Edit toolbar is not visible, right-click on an empty area of a toolbar or of the Spike2 main window. Then
select Edit bar in the pop-up menu. You can use the same procedure to hide it. The bar can be docked to any
side of the application main window or dragged off the application main window as a floating bar.

The short-cut keys are:

(23tr 1+F Toggle bookmark on the current line

F2 Go to next bookmark
Shift+ Go to previous bookmark
F2

Alt+F2 (Clear all bookmarks
Ctrl+F Open the Search dialog
Ctrl+G Find next

Ctrl+S Find previous
hift+G

Ctrl+H Replace text

Auto Format

Automatic formatting is available for script views and applies standard formatting while you type and lets you
reformat entire scripts or selected regions. Formatting is done by indenting lines of text based on the script
keywords, so it depends on the script making syntactic sense. An indented line is one that starts with white
space. The indenting is in units of the Tab size set for the view in the Script Editor Settings dialog.
Indentation is done with Tab characters if you have chosen to keep Tabs in the view, otherwise indentation is
done with space characters. There are two sub-commands:

Apply Formatting

If any text is selected in the current view, all lines included in the selection are formatted. If there is no
selection, the entire document is formatted. If text is selected, you can right-click in the text view and choose
Auto Format Selection from the pop-up menu to activate this option.

Settings...
The Automatic Formatting Setup dialog controls how text is [ automatic Formatting Setup ) |

formatted. Formatting is based on the same scheme that is used for :

folding text. Each script keyword that starts a block construction ?'ﬂmahc outdent

(proc, func, if, docase, while, repeat, for) increases the :"{!PmandFuncmdfilmen el

indent, and the keywords that complete blocks decrease the e ;-}'Eendme
indent. || until [¥] next

The standard CED formatting is to have all the boxes checked, || mdentation method atend ofine |Automatic =
however, it makes no difference to the script operation so, what

you choose is a matter of personal taste. It is a good idea to use | cancel | [ ox |
consistent indenting as it helps you to understand the structure of 4
the script.

Proc and Func body
If this box is not checked, all text within a function or procedure is indented. Check the box to outdent the text
between the Proc or Func and the end.

end...next

If we modelled the indentation on the folding with no exceptions, the keyword that marks the end of a block
would be indented. Some people like this style, others do not. If you would prefer the keyword that ends a
block to align with the keyword that starts the block, check the box. You can choose to outdent any line that
starts with one of the keywords end, then, else, endif, case, endcase, wend, until and next.
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Indentation method at end of line
This field determines what happens to the indentation of the current line and the new line when you type the
Enter key. The settings are:

None No automatic formatting is applied. The new line is not indented.
Maintain  The new line is indented to match the indentation of the current line.
Automatic The indentation of both current and new lines is adjusted based on the Auto Format settings.

Toggle Comments

This Edit menu command is available in script and text sequencer views, and is also available in the context
menu when there is a selection. It adds or removes a comment marker at the start of the line for all lines in the
current selection. It decides what to based on the first character of the first line in the selection, so this will not
work for indented comments.

Auto Complete

In any script, you will find that you are typing the same text items
repeatedly. The editor can save you some time by popping up lists

‘now save the file and free th
‘make new file current

write the data

View(nh%):

of known words that match your typing. The matching is done by
looking for a word break in the text before the text caret, then

HMemSave (mw%, ch);
C’hanD{

free up the channel

matching your typing against various categories of words known to

. ; . ChanDelete en mIM3:=0 endif; 'Hdi
the script. See Word lists, below, for the categories that can be re;cnanpupiicate
matched. Matched words are displayed in alphabetical order and
the current word is highlighted.
You can use the up and down arrow keys to choose an item in the [ auto completion Setup e |
list and the Enter key to select an item or double click an item to ;
Minimum characters for auto complete display 3 =

enter it. The Esc key cancels the list. Alternatively, you can just
keep on typing, which will narrow the choice of words to match.
The Edit menu Auto Complete Setup dialog gives you some
control over the words that are matched and when the auto-
completion lists appears.

Initial size (ines) of the matching words list box 15
Do not display if more matching words than 30 =

[ Automatically insert when only one matching word
[ Also select when user types (o [in addition to Enter

"] Enable auto complete in comments

. Word lists
Word lists il;?rKe:words [#] Built-n procs
The Word lists section of the dialog lets you choose the categories 7] Script text [#] Induuded files

of words to match your typing against. If you do not want to
display auto-completion lists, clear all the categories. |

You can choose from script keywords (Proc, Func, EndCase, ...),
built-in functions and procedures (App, NextTime, ...), words that already exist in the script and user-defined
Func and Proc names in included files and global symbols in included files.

Cancel | | CK ]

k

You may wish to disable the Script text option if you are working with a huge file and you notice an
appreciable delay after typing before the list appears. Similarly, you may wish to clear the Included files option
if you use a large number of included files and there is a noticeable time lag before any list appears.

Minimum characters for auto complete display

This sets the number of characters in a name that must be typed before the list will appear. You can set this to 1
to 12 characters. Setting a low value can cause the pop-up display to become annoying. You need to choose a
count that gives you enough help, but not too much. Try a value of 3 to start with.

Initial size (lines) of the matching words list box

This field sets the maximum number of words to display at a time in the range 1 to 40. If there are more
matching words, the list contains a scroll bar. After the list appears, you can re-size it by clicking and dragging
on the horizontal edge furthest away from the matched text.
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Do not display if more matching words than
If there are more matching words than you set here, the list is not displayed. You can set this value in the range
1 to 200 words.

Automatically insert when only one matching word

Because of the design of the script language, apart from variable declarations, all words you type in are likely to
have been defined already. If you set this option, once your typing has reduced the list size to 1, the word is
automatically inserted. You may want to increase the Minimum characters for auto complete display if you
enable this option.

Also select when user types ( or [

Normally, the list text is inserted when you type the Enter key or double-click the list text. If you check this
option, the currently selected matching text is inserted when you type an opening round or square bracket,
followed by the bracket you typed.

Enable auto complete in comments
Normally, automatic word completion is disabled in a comment. However, if you need to refer to script
functions in your code documentation you may find it useful to check this box.

Preferences

General

The Edit menu Preferences dialog has tabs for general settings, display and sampling options, signal
conditioner, time scheduling and for compatibility with previous Spike2 versions. Preferences are stored in the
Windows registry and are user specific. If you have several different logins set for your computer, each has its
own preferences. You can use the Profile () command to change the preferences from a script.

This tab holds editor preferences and general settings for saving modified views and to control what happens
when an error is found in a running script.

Spike2 preferences X

General Display Sampling Conditioner Scheduler Compatibility

Do not prompt me to save unsaved result and XY views

Save modified scripts and sequences before they run
Enter debug on script error

Ignore resource file X range in large data files for fast inital display

Text export: Use locale for number format [ I Maximum numeric accuracy
Warn if file close would lose memory channel Always g
Text view settings

—_—

Maximum text lines in Log window (set 0 for no limit) o

Script files... | Sequencer files...| Other files... Print |Screen colours v

Do not prompt me to save unsaved result and XY views

As it is often possible to recreate result and XY from the raw data, you can check this box to suppress the
normal Windows behaviour of prompting you to save unsaved data. This only applies to interactive closing
when the view has never been saved (so has no associated disk file). The script FileClose () command has a
flag for prompting the user to save unsaved data and pays no attention to this setting
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Save modified scripts and sequences before they run

If you check this box and run a modified script or sequence, it will be saved first. If the script has no name, the
File Save dialog opens to prompt you for a file name. From [11.01], modified scripts will also be saved if you
drop down the Functions list or a Tip is displayed. This is because the scanning process to find display
information for included files reads the files from disk, so if the files are not saved, stale information is
returned.

Enter debug on script error

Normally, if a running script has a problem, it stops with an error message in the script window and Log view.
If you check this box, the script debugger is activated on a script error and you can inspect the local and global
errors and the call stack at the time of the error. You are not allowed to continue running the script.

Ignore resource file X range in large data files for fast initial display

Normally, when Spike2 opens a data file with an associated resource file, it shows the same x range as was
visible when the file closed. If the file is very large this initial display can take several seconds. If you check
this option, when you open a data file that is more than 50 MB in size, Spike2 displays the first second of data
and not the range displayed when the file closed.

Text export: Use locale for number format

Normally, Spike2 uses standard compatibility options for all text output. If you check this option the number
formatting settings defined in the operating system are used for data exported to the clipboard or file as text.
The main effect is that if your operating system is set to use a comma character as the decimal point, you can
now export numbers using this. This has no effect on data input and no effect on the script language. The
operating system settings that are associated with your country or language are collectively referred to as the
"locale".

Text export: Maximum numeric accuracy

Normally, when copying Time, Result and XY view data as text to the clipboard or file, Spike2 uses sufficient
decimal places to give a reasonable representation of a floating point value. Check this box to force full
accuracy. This may cause numbers you expect to see as 0.1 appear as 0.09999999999999998, however it means
that no precision is lost if you transfer data as text to another program. Prior to [10.20] this option was not
applied to Time view data. In a Time view, you may get better results for RealWave channels by adjusting the
channel Scale factor.

Warn if file close would lose memory channel data [8.02]

Memory buffer channels only exist while the data file is open and are lost when you close the file. In many
cases you will not care about this, however, if you have put considerable effort into creating a memory buffer
you may wish to be warned that you are about to lose one. You are not warned if there are memory channels,
but they contain no data. There are three warning levels:

Never You will never be warned. This was the state before Spike2 version 8.02.

Not from script You are warned unless the file is closed with the script FileClose () command (regardless
of the state of query%). This is the default warning level.

Always You are always warned unless the file is closed with the script FileClose () command and
query$% is setto -1.

Text view settings

These controls configure text-based views (script, sequencer, log and script-created text views) on screen and
when printing. The dialogs accessed by the Script, Sequencer and Other files buttons apply changes globally
(to all open files of the selected type and to all future files). You can use the same dialogs from the View menu
Font commands to change the current view (there is a button to apply changes to all views).

Maximum text lines in Log window
This field prevents huge amounts of text accumulating in the Log view. If there are more lines than set here in
the Log view and a script writes more, the oldest lines are deleted to leave this number. To avoid deleting lines
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every time a line is added (which is very slow), each time the line count exceeds the number of lines set here,
the excess lines plus 10% of the maximum lines are deleted so that the view can grow normally for a while. Set
0 for no line number limit. Lines are not deleted as a result of interactive typing in the window. The script
language equivalent is the ViewMaxLines () command.

Print

This sets how to print coloured text from a text view. The choices are:

Screen colours
Invert light

Use the displayed screen colours; this uses a lot of ink if the background is not white.
If you display your text as a light colour on a dark background, this setting prints on a

white background and inverts the text colours.

Black on White
Colour on White

Script file text settings

Open the editor settings dialog from Edit menu
Preferences General tab to change settings for all
views of the current type, or from the View menu
Font command for the current view; you can use

. Consolas 10 % Point [v]Bold [ talic Change Font...
Apply to All to apply changes to all views. The ‘:‘
Reset All button returns all values to standard Background Case None v [JUnderine  ResetStyle

settings. The bottom half of the dialog holds
example text to preview any changes.

Please note that most of the items in this dialog are
not script-controllable. However, a script can set the

features covered by the Style (see FontSet () and | | Selection befCavet line [EERE | Match | Background
FontGet ( ) ) Language settings

Call tips Fulltext ~ | Format... |Auto-Complete... Folding Squares v
Style . Line Wrapping
Each view type supports one or more text styles. For
each style you can set a font (including | “apmede Nene ISt L

proportionally spaced fonts). The font includes the
size in points (in the range 2-256) and bold and

[for i% := @ to 100 do
italic settings. You can also choose to force upper or ‘ e Singi% / 109.?)5
: : y := Cos(i% /100.0);
lower case and underlines for all text in the style. | - 3.7, "7 5 - b S B

You can set a foreground and background colour for
the style by clicking on the Foreground and

Prints black text on a white background.

Prints in screen colours on a white background.

Script editor settings X

Style
Default

Tabs

Tab Size |4

Selection and Highlights

var fred$, i%, x, y;

L endi Func PrintLog(form$|arg0, arg, ...)

~ | The other styles, text caret colour and Tab sizes are based on this

Show

[IKeep Tabs [Jindents [ ]White space [ ]Line ends

‘A comment on a line

PrintLog("Maths problem at %d\n", i%);

Background rectangles. 7"“?;;_5 ‘torms égrﬁ‘patm:gliitfl;ll}}?":t?;ﬂ'!jg[he comment
In a Script view, you can control the appearance of
many different aspects of the display, based on the | © ’
syntax of the language. There are settings for: Help | | ResetAl Applyto Al [Jvirtualspace | Cancel
# Name Usage
32 Default The basis of all other styles and sets the text caret colour. The Tab size is based on the
width of a space in this style. If you change any aspect of this style, all other styles that
match that aspect will also change. The background colour sets the view background
colour.
0 White space Spaces, tabs, control characters and anything not covered elsewhere.
1 Comment The style used when displaying comments.
2 Numbers The style to use when displaying numbers.
3 Keywords The style to use for script keywords, such as for, next and end.
4 String The style for literal strings, such as "This is a string".
5 Function Used for built-in script functions, such as PrintLog ().
6 Operator The style for script language operators, such as +, - and +=.
7 ldentifier The style for function, procedure and variable names created in a script.
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8 Preprocessor #include and any future items introduced by #.

33 Line numbers The style used for line numbers and the gutter. When you select this item, line numbers
will appear in the example text area.

38 Call tips The style for pop-up call tips. This style has an extra Tip highlight colour field, used to
highlight the current argument in a function. This replaces the Bold, Italic, Case and
Underline fields, which are not displayed.

34 Braces The style for matched square and round brackets () and []. When the text cursor is next
to a bracket, the editor searches for the matching bracket and applies this style if it is
located.

35 Bad braces  The style to use when the text cursor is next to an unmatched bracket.

The # column is the style% argument value for FontSet () and FontGet () .

Reset Style and Reset All
The Reset Style button reverts the current style to standard settings. Reset All reverts all styles.

Tabs

This dialog region controls the size of tabs (set in units of the width of a space character in the Default style)
and if Tabs are implemented by saving a Tab character in the text (check Keep Tabs) or are implemented as
multiple spaces (clear the Keep Tabs check box). If you use a fixed pitch font, such as Courier New, then it
does not matter too much if you choose to keep Tab characters or not. If you use a proportional font for
anything except comments, it is better to keep the Tab characters. When automatically formatting a script, the
Keep Tabs setting determines if indents are generated with Tab characters or spaces.

Show
In addition to displaying the text, you can also choose to display information about the white space in your file.
The settings are:

Indents It can be useful when manually lining up indented loops in a script to see the indent level. Check
this box to display vertical lines at each tap stop in the leading white space of each line.

White space Check this box to display spaces with a centred dot and tabs as right arrows.

Line ends Check this box to see the Carriage Return (CR) and Line Feed (L.F) characters that mark the end
of a line. This is useful when working with scripts that move the caret around.

Selection and Highlights

You can modify the background colour used to indicate the selected text and optionally to indicate the line
holding the caret and to mark complete 'words' that match the current selection. You can always modify the
selection colour. This was added at Spike2 version [10.10].

Selection

You select text by holding down the left (usually) mouse button and dragging or by double-clicking to select a
word or triple-clicking to select the current line. The selection in indicated by a change of the background
colour. Before version [10.19] the background colour changed to a dark grey when the window was not active.

Caret line

You can highlight the line holding the text caret by checking the Caret line box and changing the background
to a colour of your choice. This will usually be set close to the background colour to avoid being too visually
disruptive. The colour you set is drawn transparently at around 40% intensity; this allows any background (such
as an error marker in a script view) set in the line to be visible. The highlight is removed when the view is not
active.

Match

Check the Match box to highlight complete words that match the text selection. For example, if you double-
click a variable name in a script to select it, this will highlight all visible uses of the variable (including inside
quoted strings). If the selection includes non-word characters, no highlighting occurs. The Background colour
you set is mixed with the normal colour of the matching text at 40% intensity. If you set the same colour as for
the selection you will get a result that is similar to the selected word, but with a less intense background.
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Language settings

This area of the dialog is used by script and output sequencer views. It sets your preferences for call tips,
automatic formatting, automatic text completion and folding. The Format and Auto Complete buttons
duplicate Edit menu commands, and are described separately.

Line wrapping

This section was added as an experimental feature at Spike2 version [10.18]. Text files used by Spike2 for the
script and the output sequencer are not expected to have much use for this feature, but we have had occasional
requests to make it easier to cope with external text lines with very long lines. Note that script commands such
as MoveTo () and MoveBy () will continue to operate in terms of lines and characters and ignore the wrapping
mode. Text layout of large documents with long lines can be noticeably slower with wrapping enabled.

Wrap mode
This control determines if wrapping is enabled, and how it is done. There are four settings:

None The standard mode. There is no text wrap and long lines end at the edge of the display area.
There is a horizontal scroll bar to navigate to the end of long lines.

Word If a line is too long to fit, it is split at the nearest word or style break (as defined for the current
view type) to the end of the available space. If there is no suitable break, the line splits at the last
character that fits.

Character The line splits at the last character that fits in the available space. This can be useful for
languages that do not use white space to separate words.

White space The line splits at the nearest white space to the end of the available space. If there is no white
space, the line splits at the last character that fits.

Wrap marker display
You can display an indicator to show that a line is wrapped. You can chose a combination of three places to
mark wrapped lines:

Start Displays a wrap mark at the start of each continuation line. This offsets the text slightly to the
right.

End Displays a wrap mark at the end of each line that is wrapped.

Margin This is only of use if you display the line number margin. A wrap symbol appears under the line

number on each wrapped line.

Folding

Script views and output sequence views can display a folding margin, and allow you to fold the code by
clicking in the margin, from the View menu Folding command, and by right clicking in the view and
selecting Toggle all folds. In a script view, fold points are based on a lexical analysis of the script text. You
can choose from one of four folding styles, or have no folding margin.

Call tips

A Call tip is a block of text that pops up in a script view when you type the opening brace of a function or
procedure name or you hover the mouse pointer over a procedure or function name. You can choose from
None (no tips), Single line (the command name and arguments) and Full text (includes a command synopsis).
If you select the Call Tip style, you can set the text and background colour of the tip and also the colour of the
highlight used to emphasise the current argument.

Virtual space

Check this box to enable virtual space in the editor. This allows you to move the text caret beyond the end of a
line by clicking with the mouse or by using cursor keys; you can position text (for example comments) without
the need to use tabs or spaces to position the caret. If you type with the caret in virtual space, the editor inserts
spaces up to the caret position and the position becomes "real". However, allowing virtual space may force you
to use extra key presses to move to the real start or end of a line (Home/End keys) when you press cursor up and
down to move vertically through the text.
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Change History

This check box is visible when this dialog opens from the Edit menu Preferences. If you check the box the
script editor will display marks in the margin to indicate changes to the code. This affects edit windows that are
opened after this change is made; it has no effect on script windows that are already open. This was added as an
experimental feature at version [10.16]. The marks in the margin are:

Orange Modified. Marks edits to code that have not been written to the file.
box

Green Saved. Edits that have been written to the file.
rectangle

Green- Saved changes that have been reverted (undone).
yellow

Cyan Saved, then reverted to a previous modified state.
rectangle

Anything other than a green rectangle marks text that differs from the saved state. Note that the change tracking
uses the Undo system to track changes between the displayed text and the last saved state. If you manipulate the
view text with a script, this disables the Undo system (on the assumption that script-based changes are
permanent), so change tracking will not work.

Apply to All

This button shares space with the Change History check box and is displayed when you open this dialog with
the Font button or Menu command. If you click this button, the current state of the dialog will be applied to all
open and future Script editor windows.

Call tip details

For function and procedures, the call tip text contains the || viewl
command name and arguments and a synopsis of the command. = '0-
If the tip appears as a result of typing the opening brace, the | .
editor attempts to highlight the current argument in the tip and if
the command has multiple variants, you can select the variant to display by clicking on the arrows in the call
tip. In Single line mode (not when opened by hovering the mouse pointer) you can click on the body of the tip
to show the full text.

iew and returns the last

Call tips for built-in functions
For built-in functions, the call tip text holds the command name and arguments plus one sentence of
description. This information comes from the text file script.tip in the folder where Spike2 is installed.

Call tips for user-defined functions

For user-defined Proc and Func items, the arguments are taken from the line containing the Proc or Func
keyword (expected to be the first item on the line). If the line before the Proc or Func is a comment, up to 10
lines of comment are used as a description. This works for Proc and Func items in the current source and in
any included files. If the line before is blank, and the line after is a comment, up to 10 lines following are used
as a description. Putting the comments after the Proc or Func line has the advantage that the comments can be
folded within the Proc or Func.

The search is terminated by any "divider" lines. A divider line is one that is at least 10 characters long (after
removing the initial comment mark ') and with no more than 2 characters being different. Here are some
example divider lines:

If you document your functions and procedures as in this example, they will generate tidy call tips:

'This is an example of how to document for a nice call tip
'argl If the first word on a line is followed by more than one
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space or a tab, the rest of the line is indented. If a line
starts with two or more spaces or a tab, it is indented.
'arg2 Description of second argument

'arg3 And something about the third argument

Func Example(argl, arg2, arg3)

var x,y; ‘'the start of the code

The example text above would produce a call tip looking like this.
The comment markers at the start of each line are removed, and the
multiple spaces after the first word or at the start of each line are
replaced with a Tab character.

If you do not want a Proc or Func to have a call tip see the
section, below, Disable call tip for an item. If you disable a call tip in an include file, this will also stop it
appearing in an Auto-completion list.

Call tips for const and var names [8.03]

We also provide call tips for names defined in const and var statements and argument names defined in the
first line of a Proc or Func statement. The tip will be the entire text of the line that includes the definition. Any
tab characters in the line are replaced by space characters, then runs of space characters are replaced by a single
space to make the tip a short as possible.

Call tips for included files and Auto Complete
You can have tips for global symbols for items in included files. You must enable this in the Edit menu Auto
Complete command by checking Included files. Call tips and Auto Complete use the same internal logic

Go to declaration

If an item has a call tip, it also will have a right-click menu option. For user-defined items, this will let you Go
to the declaration of the item. For built-in items, this will open Help for the item (as long as the help file is
available).

Limitations

Call tips and Auto Complete have to work on scripts that are works in progress and that may not be
syntactically correct (i.e. they may not compile). This means that we cannot use the same syntax analysis engine
that the script compiler uses. To generate a useful result, we make the following assumptions when parsing
scripts for user-defined Proc, Func, const and var statements:

e The Func, Proc, const or var keyword is the first non-white space symbol in a line.
e The end keyword that terminates each Func or Proc is the first non-white space symbol in a line.

¢ For symbol names to be detected, they must be on the same line as the Func, Proc, const or var keyword
that introduces them.

It is important that the end keyword is recognised as we use this to skip over user-defined functions when
searching for a global symbol.

Disable call tip for an item

Although having call tips is generally very useful, you may sometimes want to hide user-defined Func, Proc,
var or const names from the call tip and Go to systems. For example, you might have an include file that
implements some useful functionality through a single user-defined Func, but that has several helper functions
and global var and const items that you do not want to be generally visible as they just cause clutter. There
are two ways to do this. The simplest is to start a comment on the same line with an exclamation mark.

const kPrivateConst := 1.234; '/ No call-tip or autocomplete

The second way is to separate the keyword (Proc, Func, const, var) from the symbol names that it
introduces. However, it is possible that we will further develop the parser so it does not rely on text being on a
single line, so this method may not work forever. We mention this as this method was documented in older
versions of Spike2.

Proc
PrivateFunction() 'This is only used within this file
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end;

Sequencer file text settings

The editor settings dialog for output sequencer files is very similar to that for script files. The example text in
the lower half of the dialog displays some typical sequencer code, and there is no support for Call tips, auto
formatting or automatic completion.

Style
There is a list of styles that you can apply to the different elements of the sequencer text. The Default style is
used in exactly the same was as for script views as The remaining styles are:

# Name Usage

32 Default The basis for all other styles and as the font that is measured to set the Tab size and sets
the view background colour.

0 White space Style used when drawing spaces, tabs and control characters (normally the same settings

as Default).
1 Comment The style used when displaying comments.
2 Number The style to use when displaying numbers.
3 Keyword The style to use for standard output sequencer instructions.
4 Display Text introduced by > for display on screen during sampling.
5 Directive Items such as SET and VAR that do not generate output instructions.
6 Operator The style for mathematical operators like +, -, * and /.
7 Identifier The style for user-defined variable names and labels.
8 Step The style for the optional step numbers at the start of an instruction line.
9 Key The style for keyboard links introduced by a single quote, for example 'H
10 Functions The style for built-in conversion functions like ms ().
11

Deprecated  Items that work, but that we suggest you no longer use, such as CRATE.

w
w

Line numbers The style used for line numbers and the gutter. When you select this item, line numbers
will appear in the example text area.

34 Braces The style for matched square and round brackets () and []. When the text cursor is next
to a bracket, the editor searches for the matching bracket and applies this style if it is
located.

35 Bad braces  The style to use when the text cursor is next to an unmatched bracket.

The # column is the style% argument value for FontSet () and FontGet () .

Folding support
The output sequencer editor supports code folding based on the keyboard link entry points. That is, you can
fold up all code from a line holding a keyboard link up to the next line holding a link.

Change History
The output sequencer editor supports tracking changes in the same way as the script editor, if this is enabled.

Other text file settings

The editor settings dialog for all views except script and sequencer views is the same as the dialog for script
views, except that there are no language settings and there are fewer styles:

# Name Usage

32 Default The basis of the other styles and sets the text caret colour. The Tab size is based on the
width of a space in this style. If you change any aspect of this style, all other styles that
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match that aspect will also change. The background colour sets the view background
colour.

0 Normal General text, spaces, tabs, control characters and anything not covered elsewhere.

33 Line numbers The style used for line numbers and the gutter. When you select this item, line numbers
will appear in the example text area.

The # column is the st yle% argument value for FontSet () and FontGet () .

Display

This dialog tab contains options for data display, printing and image export.

Spike2 preferences X

General Display Sampling Conditioner Scheduler Compatibility

Line thickness: Axes 1.5 Pt v Data |1 Pt M VMark 1.5 Pt v
High DPI aware System DPI Aware Colour scales
[] Axis drag may not invert axis Use Direct2D in text editors

Do not change colours that are similar to the background Fill cursor labels
[_] standard Display shows lowest numbered channel at the top

Log axis default decades ‘T 2 Round dot minimum size (0=none) ‘ 1 =
Metafiles —

Metafile output resolution for picture export  Same as screen image ~
Use enhanced metafile format (EMF) [ ] Use lines not rectangles to draw axes

[ 1 No waveform compression when many points per pixel

Cancel Apply Help

Line thickness: Axes, Data and VMark (Vertical Markers)
Choose from Hairline (as thin as possible) and a list of point sizes. A point is 1/72nd of an inch, which is
typically about the size of a screen pixel. If coloured lines do not print on a monochrome printer, increase the
line thickness or use the View menu Use Black and White command. Click Apply to redraw screen images to

show the effect of any change. WARNING: wide lines take longer to draw than a single pixel line.

You can override the line thickness for particular channels with the Pen Width and XY Draw Mode dialogs.
Channels drawn as dots set the dot size as a multiple of the pen width for data set in this dialog; so if you set a
thick pen here, you will get large dots on screen.

High DPI aware

When Spike2 was originally written, screens typically had a resolution of 96 Dots Per Inch (DPI) or less.
Nowadays screens have resolutions of 96, 120, 200 or higher DPI. To accommodate this, Spike2 has 3 sets of
bitmaps for most buttons and icons. When Spike2 starts up, it makes a decision about which set to use
depending on what it detects as the screen resolution. This works well for a single monitor and for multiple
identical monitors. However, if you have multiple different monitors with different DPI values this may not
work too well when you drag the application between monitors..

If you have a single monitor or multiple monitors with the same DPI and set to the same scaling, you need not

read on. Set System

DPI Aware and this should give the best result.

Microsoft has made several attempts at methods for applications to use to work around monitors with differing
DPI values. This field allows you to choose the method to use:

Unaware

System DPI Aware

All graphics are rendered at 96 DPI and Windows stretches them to the actual

resolution. This results in a slightly blurry look on all non-96 DPI monitors.

All graphics are rendered at the resolution of the main monitor and then mapped onto
the screen at the resolution of the monitor on which the majority of the application
window resides. This is the method that Spike2 is currently designed to use. Screens
with different DPI/scale to the main monitor will have a slightly blurry appearance.
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Per Monitor Windows 10 1607 onwards. All windows and dialogs draw at the screen resolution (so
look as crisp as possible). It is up to Spike2 to handle changes when the window
changes monitor (which it currently does not) so items change size when you drag to
screens of different DPI values.

Per Monitor V2 Windows 10 1703 onwards. A more advanced version of Per Monitor with better
handling of system components. This can work well for some dialog boxes and for the
text of text-based views (scripts, log, output sequencer), but other screen elements (such
as bitmaps, picture buttons) will be the wrong size and it will require program changes
to get them to work.

Unaware Scale GDI Windows 10 1807 onwards. The same as Unaware, but some system elements are
rendered at screen resolution.

Currently we suggest that you use System DPI Aware unless this causes unacceptable problems, in which case
use whichever of the other modes works best for you.

Before [10.06] this option was called System DPI Unaware and allowed a choice of the first option, else the
second was set.

Fill cursor labels (new at [10.05])

If you check this box, cursor labels are drawn with a solid background, which can make the labels easier to read
against a busy signal background. If this box is unchecked, labels are drawn with a transparent background by
XORing (inverting the colour) of text pixels.

Caveats

XORing the label is faster. A second XOR removes the effect of the first, avoiding a redraw of the data under
the label when it is moved. Using a solid background is not perfect; when horizontal and vertical cursors cross
each others labels and you swap from dragging one to dragging the other this will leave the moved line behind
in the non-moved label. We disable solid backgrounds if you display so much data that redrawing becomes
slow.

Axis drag may not invert axis

If you check this box, a drag of a y axis or the x axis in an XY view to change the scale (a drag starting in the
number label region) is not allowed to change the direction of the axis. If you check the box you can still edit
the axis limits to invert the sense of the axis by double clicking the axis to open the axis dialog.

Use Direct2D in text editors

The text editor we use (Scintilla), can use either the standard GDI method of drawing text or a potentially
hardware accelerated Direct2D method (in Windows Vista onwards). The two methods should appear more or
less identical; Direct2D may be faster.

Colour scales

Before Spike2 9.06 the Colour scale dialog was available from Sonogram displays and Clustering dialogs. As
colour scales are now more generally useful (see ArrMapImage () and Spline2D () script commands) you can
open the dialog from Edit Preferences.

Standard display shows the lowest numbered channels at the top

You can change the order of time and result view channels by clicking and dragging channel numbers. This
field sets the order when you use the Standard display command or create a new channel. When a file is
opened it affects the order in which the channels in the file are added to the view. If the box is unchecked, lower
numbered channels are at the bottom.

Do not change colours when that are similar to the background

Spike2 checks how similar the colours of items such as channel data and text are to the background. If they are
too similar, your colour choice is ignored and a more visible colour is used. Check this box to disable the
colour check.

There are two levels of contrast: high-contrast is used when you need to read text or when dealing with very
small dots, normal contrast is used for everything else. In high-contrast mode, if the foreground and background
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are similar in brightness, the foreground is set to white or black, whichever is most different from the
background. In low-contrast mode, the foreground colour is modified by adding or subtracting a light grey from
the colour (this attempts to preserve some idea of the original colour).

Log axis default decades

This field sets the number of decades to display when you swap an axis to logarithmic mode from the X or Y
axis dialogs or Optimise the Y axis and the low limit is less than or equal to 0. On a logarithmic scale, negative
numbers do not exist (as real numbers), and log(0) is minus infinity. In these cases, the low axis limit is set to
be the high axis limit divided by 10 to the power of the number of decades you set here. For example, with 4
decades, if the upper value was set to 400, the lower value would be set to .04 (that is, 400/Pow (10, 4)).

Round dot minimum size

You can choose to draw round rather than square dots in time and result views. This field sets the minimum size
(in pixels) at which to do this or you can set the value 0 to always draw dots as squares (to match older versions
of the program). Not that printed output will typically have a much smaller pixel size that the screen, so dots
that draw as squares on the screen may draw as circles when printed if you enable this option.

Metafiles

Spike2 saves time, result or XY views as pictures in either bitmap (a copy of the screen image) or metafile
format. A metafile describes an image in terms of drawing operations. Many drawing program can import
metafile as images, allowing you to scale, edit and annotate pictures without losing quality. We would suggest
you use InkScape to display Spike2 metafile images and export them to a wide range of other formats including
SVG, PDF, ODF and EPS. The Metafile group of display options relates to saving images from Spike2 as
pictures either to the clipboard or to external files.

Metafile output resolution . )
Although metafile output is usually in terms of lines rather than bitmaps, the lines are still |Same asscreenimage v
drawn on a grid. You can set the resolution of the grid, to give a higher picture quality

than can be obtained with a bitmap of the screen. The higher the resolution, the more Eﬁﬁﬁ‘; :Ezgiii

detail in the picture. Screen image x &
Screen image x 16

A problem for time and result views with many data points is that the higher the gl il ~bn
resolution, the more lines need to be drawn, and many drawing programs have limits on |Width scaled to 1000 units

. . . . Width scaled to 2000 units
the number of lines they can cope with. You can use multiples of the screen resolution, Or |width sealed to 4000 urits
fixed resolutions. If you are not sure what setting to use, start with Same as screen image |Width scaled to 8000 units

. . . Width scaled to 16000 units
and adjust it as seems appropriate.

Use enhanced Metafile format

Spike2 supports two metafile formats: Windows Metafile (wMF) and Enhanced Metafile (EMF). WMF is a relic of
16-bit Windows and has limitations, but is widely supported. EMF is the standard for 32-bit programs and has
many more features. However, some graphics packages do not support this fully.

With EMF format you can export waveforms in cubic spline mode and sonogram data as part of the metafile.
With wMr format, waveforms in cubic spline mode export as plain lines and sonograms will be blank.

Use lines not rectangles to draw axes

This affects metafile output. Some graphics programs cannot cope with axes drawn as rectangles; check this
box to draw axes as lines. We use rectangles to make sure that axes drawn with pens of other than hairline
thickness join neatly.

Do not compress metafile waveform output

When Spike2 draws waveform data, it does not waste time with lines that make no visual difference to the
output. If there are more than 3 data points per horizontal pixel, Spike2 draws one vertical line per horizontal
pixel to give the same visual effect as all the separate lines. However, when you export an image as a metafile
this may not look correct as it relies on a perfect match between the vertical line width and separation.

If you check this box, no compression is done when data is saved as a metafile. For the most precise image, set
the Metafile output resolution to 16000 units and check this box. When you import a metafile, most drawing
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programs will preserve the waveform as connected lines. Spike2 writes long sequences of data points in blocks
of up to 4000 points. The last point of a block is at the same position as the first point of the next.

Sampling

This tab sets preferences associated with sampling data and the 1401.

Spike2 preferences X

General Display Sampling Conditioner Scheduler Compatibility
Settings
[_]Event ports 0 and 1 on rear digital input connector (Micro and Power1401)
[ ]Sample and Play wave trigger on rear events (Micro and Power1401)
[] Use fast online auto-scroll display update (may not draw all data)
1 Do not show hidden sampling toolbars when a sampling window opens
[_]Ignore DEFAULT sampling configuration
Minimum duration to Recycle unsaved file | 10 : seconds

Output Reset... | Voltage range for 1401 ADCs and DACs 5 Volts v

Directory for new data files (temporary location during sampling)
E:\Users\Greg\Documents\Spike10\Data\

Cancel Apply Help

Event ports 0 and 1 on rear digital input connector
You can source event ports 0 and 1 from the front panel or the digital input connector. Check the box to use the
rear panel. Leave it unchecked to source your event signals from the front panel Event 0 and 1 inputs.

Sample and Play wave trigger on rear events

You can trigger sampling and on-line waveform output with the front panel Trigger BNC, or on the rear panel
Events connector pin 4 (GND is pins 9-15). Check the box to use the rear connector. The normal trigger is a
high to low TTL pulse or a switch closure. See the Owners manual for your 1401 for the electrical specification
of these signals.

Use fast online auto-scroll display update

The online automatic scrolling of new data into the display during sampling can make the host computer feel
unresponsive, especially in complex display modes at high sampling rates. Check this box to use a faster (but
incorrect) algorithm to decide how much of the screen to repaint when the view scrolls during sampling. We
may remove this option.

In the faster mode, Spike2 does not properly allow for changes in already drawn data that depend on newly
sampled data that has just scrolled into the display. This is particularly visible with sonograms and channels
with channel processing options such as time shifts.

Do not show hidden sampling toolbars when a sampling window opens

When you open a data file for sampling, Spike2 will normally also show the Sample control toolbar, the Sample
Status toolbar and the Output Sequence control bar (if there is an output sequence). If you check this box, these
toolbars remain in their current state. You may wish to do this to prevent the toolbars changing the screen
arrangement.

Ignore DEFAULT sampling configuration [9.02]

When Spike?2 starts it searches for saved sampling configuration. Normally, if a configuration set as the default
exists it will be selected, otherwise the last used configuration is selected. If you check this box, any default
configurations are ignored. Saving a default configuration clears this option as we assume that you intend to use
the default.
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Minimum duration to Recycle unsaved file [10.20]

Previously, if you did not save a time view file that you had created, it was automatically moved to the Recycle
bin when it closed. This was a safety feature to stop accidental data loss. This can lead to the recycle bin filling
up with a lot of files, which can slow down the system. Also, emptying the recycle bin of a lot of files is a slow
process. This field allows you to specify the minimum file duration to save. Files shorter (in time) than the
number of seconds you set here will not be recycled if closed without saving. Set O for the old behaviour that
Recycled all unsaved files.

Voltage range for 1401 ADC and DACs

Most 1401s have a +5 Volt input range, but some have +10 Volts. Spike2 detects the range of connected
Powerl1401s and Micro1401s automatically. Choose from 5 Volt, 10 Volt and Last seen hardware. You are
warned if Spike2 detects a conflict between user settings and installed hardware. The voltage range affects
scaling in the sampling configuration and DAC output values in the output sequencer. It has no effect on scale
values in previously sampled data files.

Output Reset...

This button opens a dialog in which you can choose to have the Digital and DAC outputs set to known values
when Spike2 starts, before sampling and after sampling. Values set from the Edit menu Preferences can be
overridden by values set in the sampling configuration Automation tab.

Directory for new data files

This is the directory/folder where Spike2 stores files data created by File menu New during sampling. Click
. to select or create a new folder interactively. If you do not set a directory, Spike2 uses the current

directory, which may not be where you expect, so it is a better to set one. If you have more than one disk drive,

choose a folder in your fastest drive. Do not use a networked drive. New data files in this folder do not have a

file extension. The folder you choose must exist.

When you close a new data file, Spike2 prompts you for a file name. What happens next depends on where you
choose to save the file. If the file is on the same drive as the directory/folder set in the here, Spike2 renames the
file (quick). If the drive is not the same, Spike2 copies the file (slow), and deletes the original.

Do not choose a place that requires administrator privilege unless you understand the implications of this.

Conditioner

This tab configures the Programmable signal conditioner types to use, or to exclude them from use. It also sets
the mapping between 1401 ADC ports and the conditioner channels.

Spike2 preferences X

General Display Sampling Conditioner Scheduler Compatibility

Conditioner Type «CED 1902 w [ | Exclude from use

Conditioner settings

COM port for conditioner control Communications Port (COM1) v
[]Log Diagnestics Start at ADC port| 0 = | First 0 = Last| 0 =
Status

CED 1502 signal conditioner support found

CED 1902 conditioner, channels detected on ADC ports 0

Conditioner Type
Select the conditioner that you want to configure. There may be a delay after selecting a conditioner (or before
this dialog page appears) as Spike2 searches for an installed conditioner of the selected type. You can track
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how this is progressing with the Status area. There are two areas of Status reports. The upper area reports on
the search for the signal conditioner support software, which should always succeed unless you have deleted the
signal conditioner support DLL from the Spike installation folder. The lower area reports if the conditioner
hardware was detected, and if so, which ADC ports have support.

Backwards compatibility with Spike2 versions before [10.17]

Older versions support use of a single signal conditioner type, which is selected by this field. If you want to
maintain compatibility you must make sure that the conditioner you want to use with the old versions is the last
one you set and that the Start field is set to 0.

You can select None as the conditioner type. This is for backwards compatibility with Spike2 versions that
supported a single conditioner where setting None meant no use of signal conditioners.

Exclude from use

If you check this box, Spike2 will not use the selected signal conditioner type for sampling and will not load the
conditioner support or test for the conditioner being present. It will save you some time (and system memory)
when using Spike2 to check this box for all conditioners that you do not use. This is particularly the case for the
serial line controlled CED 1902 and Axon CyberAmp, where the scanning process can be time consuming,
especially if the First and Last fields are set to unfortunate values. Also, the scanning process sends data
through the selected COM port, which could have unfortunate consequences if other equipment is connected.

COM port for conditioner control

This is enabled for the CED 1902 and the Axon CyberAmp and sets the communication port used to control the
device hardware. You can select a port from the drop down list of detected ports. A change to the port initiates
a scan for connected and powered devices. The result of the scan appears in the Status field. You cannot detect
a device if it is not powered.

WARNING: We have seen cases where selecting a badly-configured serial port emulator has caused Spike2 to
hang. See here for recovery instructions.

Log Diagnostics

A CED engineer may ask you to check this box to help diagnose problems connecting to a device. It sends
information about the connection process to the Log window. For example, typical output with a single CED
1902 might be:

About to open serial port 4 for use with 1902s
Found 1902 channel © OK
Timed out waiting for response for 1902 channel 1

Start at ADC port (Not Power1401 with ADC gain option)
This field was added in Spike2 version [10.17] and if you set it non-zero, the signal conditioner settings saved
will still work for older Spike2 versions, but they will behave as if Start were set to 0.

This field sets the first ADC port that the zeroth conditioner unit of the selected type is connected to. This port
will expect to have a conditioner unless the First field (see below) is set non-zero, in which case the first ADC
port with a conditioner is the Start field plus the First field times the number of conditioned channels per
device. In almost all cases, First is 0.

You will most often set this field when you have more that one type of signal conditioner and you must arrange
that they process different channel ranges.

Note that a Power1401 with the gain option does not use this field as the gain is an integral part of the ADC
port and cannot be mapped.

First and Last (CED 1902 and CyberAmp only)

These fields are used with the CED 1902 and the Axon CyberAmp to speed up scanning for devices. Both these
devices can be assigned unit numbers (starting with 0) with switches. These values control which unit numbers
are scanned for. CED 1902 devices have one channel per device and Axon CyberAmp devices have either 8 or
2 channels per device. If you use multiple CyberAmp devices, we assume they all have the same number of
channels as the first device. If there are c channels per device, the ADC port number associated with the first
channel on device with unit number n is:

Start + n * ¢
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This means that if your devices have consecutive unit numbers starting at 0, these devices span a range of ADC
ports beginning at Start. However, you have a free choice of unit numbers (as long as they are all different),
so other arrangements are possible.

The First field sets the lowest unit number to scan for. Devices with lower numbers will not be detected. In the
case of the CyberAmp, this device must be found, otherwise no further devices will be searched for.

We scan for devices in ascending unit number, starting at First until a device with a unit number greater than
Last does not respond. Most users set consecutive unit numbers and leave Last set to 0.

From version [10.17] you can also set Last to minus the first device you do not want to search. This must be
greater than -First or it is ignored. This avoids waiting for a device to time out to terminate the search.

The Status panel gives information on the selected signal conditioner support. If Spike2 can detect a signal
conditioner, it also holds information about the channels that have conditioner support.

Using multiple conditioner types

Spike2 version [10.17] onwards supports the use of multiple signal conditioner types at the same time. Prior to
this, only one conditioner type was supported, and this was selected here. Now, support for all types is loaded
(unless you Exclude them) and each conditioner type is assigned a range of channels. You are warned if you
attempt to close this panel with more than one conditioner assigned to any ADC port.

if you have multiple conditioner types, it is your responsibility to ensure that there is a maximum of one
conditioner per 1401 ADC port. The dialog will warn you if it detects more than one conditioner active for an
ADC port.

Fix hang due to bad serial port

We have noticed that it is possible to hang up Spike2 by selecting a serial port (1902 and CyberAmp) that is
connected to a badly configured serial port emulator, so we have to presume that this could happen with other
serial ports. This usually occurs when you select the port in the conditioner dialog and subsequently, Spike2
hangs up during start up while searching for conditioners with the message:

Search for signal conditioner DLLs

To fix the hang you must edit the registry to change the COM port or to exclude the conditioner. To do this you
need to run RegEdit, for which you may need Administrator privilege. Beware: careless editing of the Registry
can damage your system; you do this at your own risk.

1. To run the Registry Editor you need to type RegEdit into the system search panel and Windows will
suggest "Registry Editor". Click on this to open the Registry Editor.

2. In the tree control on the left, navigate to: Computer->HKEY_CURRENT_USER- >SOFTWARE - >CED- >CEDCond

3. Under this key you will find entries for installed signal conditioners. We are interested in 1902 and
CyberAmp. If you know which of these you modified to select the bad port, that is the one to modify. If you
do not know, you must repeat the following for both ports. We will assume that the 1902 port is at issue.

4. Select the 1902. The panel on the right will list the port properties. If the Exclude property is present,
double-click it and set its value to 1 and you are done. As an alternative, if you know the 'good' COM port
value, double-click on Port and set the correct COM port.

5. Close RegEdit and Spike2 should start without hanging.
If you do not know a good COM port and there is no Exclude property and you must create it:

1. Right-click in the right-hand panel and select New->DWORD (32-bit) value and a new value will appear
with the title New Value #1.

2. Double-click this title and edit the name to Exclude and the values to 1.
3. Close RegEdit.

You should now be able to start Spike2 and in Edit->Preferences->Conditioners you can adjust the settings.
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Scheduler

Spike2 preferences X

General Display Sampling Conditioner Scheduler Compatibility
Background routine limits

Minimum gap between timed update routine end and next start | 1 : ms
Maximum script idle time before Spike2 sleeps (0=no limit) 10 Zms
Maximum script idle cycles before Spike2 sleeps (0=no limit) 0 :

The background routine runs pericdically to update displays and to keep script
idle-time functions active. This page limits the time used by Spike2, so that the
system feels responsive and other applications get a chance to run.

You must close this dialog to see the full effect of any changes.

This tab limits the processor time consumed by the Spike2 user thread while sampling and idling with a script
running. If Spike2 takes too much time, the system feels unresponsive. The tab does not affect the time-critical
threads used for data capture or the threads used for multimedia. You can read more about threads below.
Spike2 runs a background routine when it has idle time and also periodically on a timer. The background
routine handles the following tasks:

e When sampling or rerunning, it gives windows a chance to detect that the maximum time in a sampled data
file has changed, which may cause windows to scroll and processing to occur. Any invalidated windows will
update the next time Spike2 gets idle time.

e If a script is running, it gives any "idle function" in the script a chance to run. See ToolbarSet () and
DlgAllow () and DlgMouse () to set idle functions.

¢ In automatic file naming mode it starts the next file running.

There are three fields that limit the time used in the background routine. They have no effect on the time used
when Spike2 runs a script that does not idle (see the Yield () or YieldSystem() script commands for this).
The standard values work for most cases.

Minimum gap between timed update routine end and next start

If the time interval set by this field passes without the background routine running, it is scheduled to run as soon
as possible. You can use values in the range 1 to 200 milliseconds. The standard value is 10 milliseconds. The
lower the value, the more time Spike2 will spend on background processing relative to other applications. This
field also limits the time that Spike2 will sleep for (see the discussion of threads, below).

If you rely on background processing during sampling, for example for the Sampling mode Script Trigger
[10.09] or the Measurement to Keyboard channel feature [10.10], you will likely want to set this to a lower
value (maybe 5 milliseconds).

Maximum duration of script idle before Spike2 sleeps

When Spike2 gets idle time (see the discussion of threads, below), you can limit the time it uses before Spike2
goes to sleep. Spike2 uses idle time to run script idle routines, such as those created by ToolbarSet (0, ...).
You can set from 0 to 200 milliseconds (0 means no time limit). The standard value is 10 milliseconds. The
larger the value, the more the script idle routine runs at the expense of other applications.

Maximum script idle cycles before Spike2 sleeps

As an alternative to limiting the script idle routine by elapsed time, you can limit it by the number of times it is
called. You can set from 0 to 65535 times (0 means no limit). The standard value is 0. Setting both this and the
Maximum duration... field to 0 is unkind to other applications. Setting this to 1 is the most generous to other
applications.

7-30



Edit menu

Threads

A thread is the basic unit of program execution; a thread performs a list of actions, one at a time, in order. To
give you the impression that a system with one processor can run multiple tasks simultaneously, the system
scheduler hands out time-slices of around 10 milliseconds to the highest priority thread capable of running.
Tasks at the same priority level share time-slices on a round robin basis. Lower priority tasks rely on higher
priority tasks "going to sleep" when they have nothing to do or when they are blocked (for example, waiting for
a disk read). If this did not happen, low priority tasks would not run.

There are also very high priority tasks, usually associated with hardware device drivers, that can interrupt the
scheduling system to respond to external events within microseconds. These interrupts usually only last a few
microseconds; if a device driver needs a longer period of time it will request a time slice to complete its work
and wait for it to be granted.

When Spike2 gets a chance to run, it processes pending messages such as button clicks, keyboard commands,
mouse actions and timer events and then updates invalid screen areas. Finally, Spike2 is given idle time until it
says it does not need any or new messages occur. If Spike2 needs no more idle time it sleeps until a new
message appears in the input queue, which wakes it up again. The Minimum gap... timer wakes up Spike2 if
nothing else happens. All these activities happen in a single, user thread.

This single user thread can also generate special threads that perform specific actions. These special threads do
not process pending messages or update the screen. These separate threads are typically used to monitor
activities that need fast responses (cannot wait for the single user thread to have idle time) or that can take a
while and would make the user thread feel unresponsive. Examples of these are:

e Real-time sampling thread that moves data sampled by a 1401 into the Spike2 data filing system.
e Real-time thread to move data from Talker devices to the data file.
e Multiple threads used for the video capture and replay system.

e Thread used to calculate FIR filter coefficients in the filtering dialog. This can take a detectable time, which
would make dragging items in the dialog feel unresponsive, so we calculate in a separate thread and update
when calculations are done.

These operations can overlap with the user thread actions. In a single processor system, the processor swaps
around between all available threads, assigning time to them based on their priority. If your system supports
multiple processors or multi-core processors or hyper threading, then threads can run simultaneously, and you
will feel the benefit of this in smoother and faster system operation, particularly when sampling data or
recording video. Of course, we have to be careful that the threads do not mangle each others data.

Compatibility

Spike2 preferences X
General Display Sampling Conditioner Scheduler Compatibility

[ ] Waveform measurements do not depend on the drawing mode to match 5.11
[1De not use the flicker-free drawing method for data to match 5.11

[_1 Do not overlap Power spectrum sweeps to match 7.09

[ ]Use old default dialog font for backwards compatibility

[_] Count() script command includes the end time to match 8.03

[_] Allow float script var to be passed as integer reference matching 8.04

[ ] Do not rescale saved templates to match target channel to match 10.00
[]Use old format for Time view Text Output to match 10.11

[_] Allow script forward references to be unterminated to match 10.14

[]No use of symbolic names in configuration files to match 10.14

Check boxes for compatibility with deprecated Spike2 features. Please modify
scripts that depend on these options; they will be removed in future revisions.

Cancel Apply Help

This tab lets you disable new program features that have changed the way that Spike2 works and that might
affect your results. We reserve the right to remove these options in future releases. If you need to check any of
the boxes, please let us know so we have some idea of the number of users who depend on the old behaviour
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(no-one has ever done this!) These settings are saved in the system registry and are read when they are needed.
You can modify the settings with the Profile () script command

Waveform measurements do not depend on drawing mode
Before version [5.12], measurements from waveform channels returned the nearest data point. Now they return
what you see on screen. Check the box for the nearest data point.

Do not use the flicker-free drawing method
Version [5.12] implements a new buffered drawing method that reduces screen flicker on updates. However,
this may impact the display speed. Check the box for the old method.

Do not overlap Power spectrum sweeps to match 7.09

From version [7.10], we overlap the Power spectrum sweeps. This will tend to weight the data more equally and
can give more consistent results at the cost of more time spent transforming the data. Check this box for the old
behaviour.

Use old default dialog font for backwards compatibility

Version [8.03] sets the equivalent of D1gFont (1) each time the script starts rather than the old default of
DlgFont (0). This generates better-looking text. However, it is possible that this will change the layout of
user-defined dialogs, which can cause text to vanish, making a dialog difficult to use. Check the box to force the
old behaviour.

Count() script command includes the end time to match 8.03

At version [8.04], the Count () command was changed so that the range did not include the end position. This
ensured that if t1<t2<t3, Count (chan%,tl,t2)+Count (chan%,t2,t3) was the same as Count (chan
%,t1,£3). Check the box to restore the old behaviour.

Allow float script var to be passed as integer reference matching 8.04
For reasons of backwards compatibility, we allowed the following code to compile and run:

Proc OddBehavior(&integer%)
Message(integer%);

integer% := 23;

end;

var notInteger := 1.23;
oddBehavior(notInteger); '8.65 onwards give an error here

From [8.05] onwards we no longer allow this and insist that reference arguments must match in type (as Nature
intended). You can set this option to allow the old behaviour, but we urge you to modify the script to use the
correct type of variable. We will likely remove this compatibility workaround at some future release.

Do not rescale saved templates to match target channel

From version [10.01] onwards, when a saved template does not match the channel scaling of the target channel
(for example if the amplifier gains were adjusted), we now rescale the template (where plausible to do so) to
match the target channel. To do this, the channels should have the same units, or at least recognisable units (mv,
uVv etc). Check this box to disable scaling, to behave the same as all previous versions of Spike?2.

Use old format for Time view Text Output to match 10.11

Versions [10.12] onwards have changed the Time view Text Output SUMMARY section to show the same
information for all channels, which should make it easier to write an importer for the format. We have also
revised the output of Level event channels and WaveMark data. Check this option to revert to the old format
(for example if you have an importing program that relies on the old format).

Allow script forward references to be unterminated to match 10.14
Versions [10.15] onwards flag the following script as incorrect:

Test() 'Call to procedure that has not yet been defined
halt; '"Error at start of this line, 'Missing ;'
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Proc Test()
end;

However, previous versions of the compiler accepted this, so we have added an option to force the compiler to
accept it. The fix is easy; add a semicolon to the first line:

Test();
halt;

No use of symbolic names in configuration files to match 10.14
Version [10.15] introduces the experimental use of symbolic names in sampling configuration files (*.s2cx).
If you suspect a problem with this feature, check this box to disable it and report this to CED.

Removed compatibility options
The following options have been removed from the Compatibility dialog to make space for new options.

Use old-style colour mechanisms

Before version [5.04] in 2003, the colour palette was saved in sampling configuration files; loading a sampling
configuration set the colour preferences. We now save the palette in the registry. Check this box to save the
palette to configuration files and read colours from configuration files (if there are any), as before. This option
is still supported and can be set using the Profile () script command with the "Use old colours" option
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View menu

This menu controls what you see in Spike2 data views and how Spike2 displays the data. Views are generally
divided into two basic categories: data-based views (time, result and XY views) and text-based views (script,
output sequence, text and log views). The contents of the menu changes depending on the type of the view. The
menu also has commands to control the Toolbar and the Status bar.

Toolbar and Status bar

System Toolbar
Spike2 - Demo.smrx _ 0 <

File Edit View Analysis Cursor Sample Script Window Help
2 & tBRE BEAMAEMENN VI IREOFS &85 7

The system toolbar is normally docked below the Spike2 application menu, but can be dragged to become a
floating window or docked to any side of the application window. The toolbar contains short-cuts to some of
the commonly-used menu commands. When the Spike2 application is active, and you move the mouse pointer
over one of the buttons, the Status bar will display a reminder of the buttons function. If you hover the mouse
pointer over a button, a tool tip will appear with a short reminder. Buttons that are not currently enabled
(because of the current view) are drawn in grey.

The Toolbar command in the View menu lets you show and hide the system toolbar bar. Script users can get
the system toolbar handle with App(1) and show and hide the system toolbar with:

View (App(l) ) .WindowVisible (show%); 'Show%=1] to show, 0 to hide

To dock and position the toolbar, use the Window () script command. The xHigh argument sets the docking
edge.

Status bar
rFor Help, press F1 Ln 2, Col 1 CAP NUM OVR REC ‘

The Status bar occupies the very bottom of the Spike2 application when it is enabled. The left hand end of the
bar contains text that describes the currently selected menu command, or a reminder to use F1 to get help. The
next field displays the line number and column number of the text cursor when a text view is current, or when a
Time, Result or XY view is current it display the last known mouse position as [channel,] x position],
yposition] (items in square brackets are omitted if they do not apply). The remaining fields are:

CAP  The Caps Lock key is active. Press Caps Lock on the keyboard to disable.

NUM  The Num Lock key is active. Press Num Lock on the keyboard to disable.

OVR  Over type mode is active in a text-based view so that typing replaces text. Press the Ins key to disable
(this only has an effect when the current view is a text-based view).

REC  Script recording is enabled. You can Turn Recording Off in the Script menu.

The Status bar command in the View menu lets you show and hide the status bar. Script users can get the
status bar handle with App(2) and show or hide the bar with:

View (App(2) ) .WindowVisible (show%); 'Show%=1] to show, 0 to hide

Enlarge View Reduce View

These two commands duplicate the two buttons at the lower left of time and result windows. The enlarge
command, short cut Ctr1+E, doubles the x axis data region and the reduce command, Ctr1+R, halves the
region. The left hand window edge is fixed unless enlarging would display data beyond the end of the data, in
which case the displayed area is moved backwards. If enlarging would display more data than exists, all the
data is displayed. Short cut keys Ctr1+U and Ctr1+I zoom about the screen centre. You can also change the
view size by clicking and dragging the x axis numbers.
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Y Axis Range

This dialog sets the y axis range and style for visible time, result [y gange
or XY view channels. The Channel field chooses one, all or
selected channels or you can type a list of channels. If more than || Chemnel 1Snenave Waveform)  ~ [ | optimise |

one channel is selected, the displayed settings are for the first | |0 [{F2fs | [ showal |
visible channel that matches the displayed channel units. Bottom [75] -5 il [oraw |
_, lockaxes Groupoffset 0O | = |
Optimise [ Large tick spacing ———
Click Optimise to draw the visible data scaled and offset to fill || [/Ticksubdivisions 4 Cance
the available space. In most cases, we allow an extra 5% of the logarithmic ~ Autounits [SEprefixc »| [ Close |
space at the top and bottom which avoids a 'cramped' look and & J

allows a little headroom from channels drawn in cubic spline mode (where the peaks can be above the range of
channel values). If the extra 5% of space crosses the value 0.0, the axis stops at the zero, for neatness. From
version [10.02], if you draw grouped channels in Lock axes mode with a non-zero Group offset, we do not
apply any extra space so that all available space is used, which looks better with a large number of grouped
channels.

Show All

Click Show All to set the y axis to display the maximum possible range for waveform channels and from 0 to
the estimated event rate for event channels drawn with a frequency axis. Both these buttons close the dialog.
You can optimise without opening the dialog with the keyboard short-cut Ctr1+0Q and by right-clicking on a
channel and selecting the Optimise option from the context menu. In logarithmic mode, values of zero or less
cannot be displayed.

Top and Bottom

The Top and Bottom fields set the values at the top and bottom of the axis. The buttons to the left of these
fields make the axis symmetric about zero. The units of the values are displayed to the right of these fields. If
there are multiple channels selected, and the channels have different units, you can select the units or <any> to
match any units. Click Draw to apply changes to the Top, Bottom and Group offset fields. These changes are
only applied to channels that match the displayed units; select <any> as the units to apply the values to all
channels in the list.

Cancel undoes any changes and closes the dialog. The Close button closes the dialog; it does not apply
changes to the Top and Bottom fields.

Lock Axes and Group offset/factor

The Lock axes and Group offset/factor fields are visible when the current channel shares its y axis with other
channels. The fields are enabled when the current channel is the first in the group. If you check the Lock axes
box, the grouped channels not only share the same space, they also share the y axis of the first channel in the
group. The Group offset field sets a per-channel vertical display offset to apply to each locked channel so you
can space out channels with the same mean level. If the axis is logarithmic the field becomes Group factor as a
constant shift becomes a multiplicative factor.

Tick spacing and subdivisions

When preparing data for publication you may wish to set the spacing between the major tick marks and the
number of tick subdivisions. If you prefer a scale bar to an axis, you can select this in the Show/Hide channel
dialog. You can control the Large tick spacing (this also sets the scale bar size) and the number of Tick
subdivisions by checking the boxes. Your settings are ignored if they would produce an illegible axis. Changes
made to these fields take effect immediately; there is no need to use the Draw button.
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Auto units

The Auto units field is present when the Logarithmic box is not checked.

There are three options: _ dod o ow0d 10
Off The axis behaves normally, using the standard y axis units. Za0md 22 o4 Zx o0
x1000s If the axis range becomes numerically very large or very small and @ o @” g @ i

scaling makes sense, the axis units are multiplied by a power of a
thousand and the y axis units are displayed with the power of ten
after the units. [
Sl prefix The same as x1000s, except that the y axis units are prefixed by a SI scaling prefix (M, k, m, u, ...). If
the units already start with an SI prefix, this is removed (and taken into account) before display.
Any change made to an axis by this field is purely cosmetic; it has no effect on the values seen by Spike2 or by
a script. It changes the visible axis values and the values displayed on screen by horizontal cursors and by
vertical measurements made by holding down the 21t key and clicking and dragging in a channel.

v| [xtoos =] [stprefix ~]

Logarithmic and Show Powers

If the units are scaled, cursor labels and on screen measurements taken by holding down A1t and clicking and
dragging are also changed. Apart from these cosmetic effects, all other measurements remain in the original
axis units.

The Logarithmic check box can be used in Result and XY [] Large tick spacing x 10
views to change the y axis to logarithmic mode. In logarithmic - =
mode, the large tick spacing field becomes a multiplying | [ ] Tick subdivisions 9
factor between large ticks and is usually set to 10. The Group -
offset field also changes to Group factor. You can use all Logarithmic [ ] Show Powers
drawing modes with logarithmic axes; however, straight or
cubic-splined lines between points will not pass through the
same values as with linear axes. If either end of the axis is less than or equal to zero when you set logarithmic
mode, the axis limits are adjusted.

The Show Powers check box is present in logarithmic mode and replaces the Auto-adjust units field. With
this box checked, the axis labels at major tick marks are displayed as powers of 10 (or of the value set in the
Large tick spacing field).

Axis adjustments in logarithmic mode

See the Edit menu Preferences dialog Display tab to set the number of decades to display when an axis switches
from linear to logarithmic mode or you Optimise in logarithmic mode and the low limit is less than or equal to
0.

X Axis Range

The X Axis Range dialog is opened from the View menu or by double- | x ayis Range

clicking on the x axis of a time, result or XY window. The dialog sets the x =

axis range to display and also controls the display units and the style of the = %% = [l
axis. Not all features of the dialog are available in all view types; " = al

logarithmic axes are not allowed in time view, for example. Right  [18.924 ~]
Clwidth  7.9662138 Help

You can close the dialog in two ways: the Close button closes the dialog
and accepts any pending changes. Cancel undoes any changes made with
the dialog and closes it.

[ ] Large tick spacing 2.0

[ ] Tick subdivisions 1 2 Cancel

Logarithmic Auto units Off v Close

Units

The Units field in a time window selects Seconds, hh:mm:ss (hours, minutes, seconds), Time of day or
milliseconds display mode. Time of day works for files created by Spike2 version 4.02 onwards; for older
files with no saved creation time it is the same as hh:mm:ss. In result and XY views, the Units field display

whatever the X axis units are set to. If the x axis units are "s" or "seconds", you can also choose milliseconds
as your units.
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The Time of day axis mode draws times as hh:mm:ss on the x axis that are the time of day at which the data
was collected plus the time offset into the file. This is for display purposes only; all times used within Spike2
are times in seconds from the start of sampling. All times entered into dialogs are relative to the start of the file.
From [10.11] you can type numbers that match the axis by following them with tod, for example
12:00:00tod.

The milliseconds selection changes how the axis labels are displayed. Internally, Spike?2 still uses seconds for
all measurements and commands related to the axis. If you select milliseconds, all the time-based fields in the
dialog (Left, Right, Width and Large tick spacing) change to milliseconds. When recording actions, if you
use expressions (for example Cursor (1) +1) in milliseconds mode that would evaluate to a different result in
seconds mode, these will record as the result of the expression in seconds.

The script language equivalent of this field is the XxAxisStyle () command.

Left, Right and Width

The Left and Right fields set the window start and end. You can type in new positions or use the drop down
lists next to each field. The drop down list contains the initial field value, cursor positions, the minimum and
maximum allowed values and the left and right edges of the window (XLow () and XHigh () ). The Width field
sets the window width if the Width box is checked.

Click the Draw button to apply changes in these fields to the window. The Draw button is disabled if the dialog
range matches the current range or if the dialog range is invalid (badly formatted number or the range exceeds
the range of available data in the file).

If you type a number in these fields, it is interpreted in the units set for the Units field. In a time view, you can
follow a typed number by s, ms or us to force the number to be interpreted as seconds, milliseconds or
microseconds regardless of the settings in the Units field. In Time of Day mode, numbers typed in need to be
expressed in time of day format or as the time of day expressed in seconds.

The script language equivalent of these fields are the Draw () and XRange () commands.

Show All

Show All in Time and Result views expands the x axis to display all the data the dialog. In an XY view, it sets
the x axis range to show the full range of data channels that are not hidden plus a little extra space at the ends of
the axis (unless one of the ends is at 0, when 0 is set). Show All closes the dialog. If all the points are at the
same X position it centres the axis on the position.

Tick spacing

In normal use, you will let Spike2 organise the x axis style. However, when preparing data for publication you
may wish to set the spacing between the major tick marks and the number of tick subdivisions. If you prefer a
scale bar to an axis, you can select this in the Show/Hide channel dialog.

You can control the Large tick spacing (this also sets the scale bar size) and the number of Tick subdivisions
by ticking the boxes. Your settings are ignored if they would produce an illegible axis. Changes made to these
fields take effect immediately; there is no need to use the Draw button.

From a script, you can control the tick spacing with the XAxisStyle () command.

Auto units
The Auto units field is present when the Logarithmic box is not T T T
; . L 000066 000067 000068 [~
checked and the Units field is not set to milliseconds, hh:mm:ss or seconds (@]
Time of day. There are three options: . . :
. . N 66 67 68
Off The axis behaves normally, using the standard x axis units. seconds 10° (X1000s ]

x1000s If the entire axis in time or result views or the visible axis in T T T
an XY Yiew becomes numerica1.1y very large or very small g & us&gf’lds
and scaling makes sense, the axis units are multiplied by a
power of a thousand and the x axis units are displayed with the power of ten after the units.

|SI prefix v|

Sl prefix The same as x1000s, except that the x axis units are prefixed by a SI scaling prefix (M, k, m, u, ...).
If the units already start with an SI prefix, this is removed (and taken into account) before display.

If the units are scaled, cursor labels and on screen measurements (hold down A1t and click and drag) are also
scaled. Apart from these cosmetic effects, all other measurements remain in the original axis units.
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Logarithmic

The Logarithmic check box can be used in Result and XY views to change the x | [largetick spacing x 10

axis to logarithmic mode. In logarithmic mode, the large tick spacing field becomes | [JTick subdivisicns 9 =
a multiplying factor between large ticks and is usually set to 10. You can use all | Hiogarithmic ~ []Show Powers
drawing modes with logarithmic axes; however, straight or cubic-splined lines
between points will not pass through the same values as with linear axes. Furthermore, you can generate
apparently blank axes in logarithmic mode. For example, if the data range of the axis was 61 to 69 units,
changing this to logarithmic mode will generate a blank axis as the nearest minor ticks are at 60 and 70 and the
nearest major ticks are at 10 and 100.

The Show Powers check box replaces the Auto-adjust units field in logarithmic mode. Check this box to
display the axis labels at major tick marks as powers of 10 (or the value set in the Large tick spacing field).

Script language equivalents to this dialog

The xAxisAttrib () script command is the equivalent of the Logarithmic and Show Powers check boxes
and the Auto units selector. The XAxisStyle () command sets the Units and the tick spacings and number of
subdivisions of major ticks. The xRange () and Draw () commands set the displayed range. You can show and
hide axis features with xAxisMode (). You can record your actions in this dialog by turning recording on,
using the dialog, closing it and turning recording off.

Short cut keys and mouse wheel

Short cut keys that control the x axis are: Home and End move to the start and end of the data, Left and Right
arrow scroll by one pixel, Shift+Left and Shift+Right scroll by several pixels and Ctrl+Left and
Ctrl+Right move by half the screen width. The mouse wheel will also scroll the x axis one pixel at a time;
add shift or Ctrl to scroll by larger numbers of pixels.

Jump to event

In a time view you can jump to the next or previous event by selecting the event channel, then using
Alt+Right/Left arrow. Spike2 searches for the nearest event to the centre of the screen to the right or left. If
more than one event channel is selected, all channels are scanned for the nearest event. Spike2 beeps if none is
found.

You can jump to any TextMark from the TextMark dialog. Double-click any TextMark to open the dialog,
click the >> button, select the marker from the list and click Show.

X Axis Extra Time

During sampling, the final length of the data file is unknown and we pretend that it is the maximum length
possible. To make navigation through the file with the horizontal scroll bar work in a reasonable manner we
'pretend' that the file length is the current time into sampling. When the current sample time reaches the right-
hand size of the screen the display starts to scroll to the left to maintain the current sample time.

This is usually what you want as there is no sampled data (yet) in the future.

Occasionally, however, you may want to write data into a non-sampled channel in the future. For example, in
some training tasks you may want a subject match a template waveform with a force or breathing pattern. For
them to do this, they need to see the waveform ahead of the current time. To allow for this, you can set extra
time at the end of the X axis.

You can set this time with the View menu X Axis Extra Time... command, or by hovering the mouse over the
X axis of a sampling Time view and selecting the X Axis Extra Time... command to open the Extra time at
view end dialog:

Extra time at view end X
Automatic scrolling during sampling keeps the most recent data at the right of the
screen. Extra time leaves space for 'future data'. There is no sampled data here, but you

can display data you have created; for example as a tracking target.

Extra time to show at end of file when scrolling during sampling seconds

Help Cancel OK
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The script language equivalent of this is the ViewExtraTime () command; it is likely that this feature will
generally be used from a script as you will probably want to write a training waveform into the file. The
following script generates a Sinusoidal waveform on channel 2 and places channel 1 on top of it:

SampleClear(); 'Set standard state (32 channels, 64-bit smrx file)
SampleOptimise(@, -1, 9); 'No optimise, set 1401 type, (do first)
SampleUsPerTime(10);

SampleTimePerAdc(1000);

SampleStartTrigger(-1); 'Set trigger to start sampling

"Channel recording definitions (adjust as required)
SampleWaveform(1l, 0,100); ' chan, port, rate of 100 Hz
SampleTitle$ (1, )

SampleTextMark(80);

SampleTitle$ (30, )s

SampleComment$ (30, )

SampleTitle$(31, )

SampleComment$ (31, )

SampleOptimise(1,1,9,1,50); 'Set optimise mode (do this Llast)
SampleMode(1); 'Continuous sampling

'Create data file for sampling

var fh:=FileNew(9, 1); ' Create Data view

if fh <= 0 then Message( ,» fth, Error$(fh)); halt endif;
ViewExtraTime(4); " Display 4 seconds into the future

PrintLog( » ViewExtraTime());

XRange(9, 6); ' Set display width to 6 seconds

View(SampleHandle(1)).WindowVisible(1); 'Show sampling controls

var wave[100]; Space to hold a sinusoid
ArrConst(wave[1l:], 2*_pi/20); '20 points per cycle

ArrIntgl(wave);

Sin(wave); ' generate sinusoid

ArrMul(wave, 4); ' scale to +- 4 Volts

ChanNew(2, 9, 0, 0.1); ' Make a channel sampled at 10 Hz
ChanTitle$(2, );

ChanWriteWave(2, wave, 0); ' Write 10 seconds of data at time ©
ChanPenWidth(2, 2); ' Make channel 2 draw thicker

ChanColoursSet(2, 1, 0.9, 0.9, 0.9); ' Channel primary colour: Light gray
ChanShow(2); ' Make channel 2 visible

ChanOrder(1, 0, 2); " Group with and under channel 1

YAxisLock(1l, 1,0); ' Set group y axis lock so they kReep the same scale
Yield(3); ' Pause at the start

SampleStart(); " Sample now (or omit for a manual start)
Yield(10); ' Wait 10 seconds

ChanWriteWave(2, wave, 15); ' Write next training wave at 15-25 seconds
Yield(15); " Wait for 15 seconds

SampleStop(); ' Stop sampling

The script illustrates how the training waveform on channel 2 can be written before sampling starts and after
during sampling. Using vield () is a simplistic way to allow the system time to scroll the display. A real
application script would probably use a Toolbar () command to allow user interaction and control.

Standard Display

This command sets the current time, result or XY view to a standard state. The script language equivalent is
ViewStandard (). The x and y axes are displayed with all user options for grids, tick spacing and special axis
modes turned off. In time and result views, duplicate channels are deleted and all channels are displayed in a
standard mode and size and ordered as set in the Edit menu Preferences, all special channel colours are reset
and any channel processing is removed. In an XY view, all channels are made visible, the point display mode is
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set to dot at the standard size, the points are joined, the x and y axis range is set to span the range of the data
and all the channel Z Order values are set to 0.

All cursors are removed regardless of values set by the CursorFlags () script command. This is the only non-
script way to get rid of vertical cursors that are fixed in position and have the cursor flags set for no interactive
delete.

In a time view, Marker derived channels all display the first marker code. WaveMark channels are set to always
display markers in hexadecimal format, all others will show printing characters. Any extra time set for the x
axis is removed.

In a text-based view it removes any maximum line limit except in the Log view, where is applies the line limit
set in the Edit menu Preferences option. It also hides line numbers, displays the gutter and the folding margin
(for views that support folding). All the text styles are set to the default values (equivalent to opening the Font
dialog and using Reset All) and any zooming is removed.

In a Grid view, the grid is set to a standard state as if it had just been created. The grid data is preserved.

Show/Hide Channel

This dialog sets the channel list to display in time, result and XY views. It also controls the display of axes,
grids and the horizontal scroll bar in time and result windows. You can resize the dialog vertically to make
room for long channels lists and you can filter the channel list to show a sub-set of channels.

Display for Demo.smrx

Y Axis X Axis
[V]31 Keyboard (Marker)

¥ ¥
7 -1 (WaveMark) Numbers Numbers
6 Comments (TextMark) Title Title
5 02 (RealMark) [~] Units ] Units
4 Texmmark (Texthlark) Small ticks Small ticks
3 Events (Event-) i
2 Stimulus (Event-) LJon Right Scroll bar
1 Sinewave (Waveform) [ Scale Bar []Scale Bar
[l Grid []Grid

[ Axis in data [] Axis in data

Y axis horizontal labels

[1Enable Centre units
8

Centre

All channels Channel numbers

Show Hide Draw Help Close  Listed

Channel list and filtering

The left-hand half of the dialog lists the channels in the same order as they are displayed in the view. If there
are more channels than will fit in the visible area, you can either scroll the channel list to see them all or resize
the dialog by dragging the size box or the top or bottom edge of the dialog.

The channels are identified by a text string that includes the channel number, title and type. Views can hold
hundreds of channels, so there is a filtering mechanism to reduce the displayed channels based on matching text
in the channel list. To apply a filter, type text to match into the box to the right of the Filter check box. As you
type, the channel list changes to only show channels where the filter text is found in the channel identification
string. The matching is case sensitive and uses ECMAScript regular expressions. Clear the Filter check box to
disable filtering.

There is a drop-down list of up to 20 previously used filters available. Filter strings are added to the list each
time you change the state of a check box with an active filter. There are separate filters for Time, Result and
XY views. The strings are stored in the registry (HKEY CURRENT USER\Software\CED\Spike2\Settings
in the keys: Time chan filter, Result chan filter and XY chan filter). They are read each time
the dialog opens and saved when the dialog closes. You could manipulate the keys with the script Profile ()
command.

You can ctrl+click the Filter check box to add or remove the filter text from the drop-down list. If the text is
not in the list it is added, if it is already in the list it is removed.
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Check boxes, Show and Hide buttons

There is a check-box to the left of each channel identifier string. When you open the dialog, the box is checked
if the channel is visible, unchecked if it is hidden. You can check or clear the boxes one at a time, or you can
click and drag a range and then click a box to set the check state for all selected channels. You can also use the
Show or Hide buttons to check or clear all the listed channels. These actions do not have any effect until you
click the Draw or OK buttons.

All Channels

The All Channels check box gives you information about the overall channel list (including channels that are
filtered out of the displayed list). If all channels are marked for display the box is checked, if none are marked
for display the box is clear. If some are marked for display and some are not, the box is filled in (as in the
image). You can click the box to set the state of all the channels (even with a filter set).

Draw

Most changes made in this dialog will require the associated data view to redraw, which can take a noticeable
time. Because of this, changes are not applied until you close the dialog with the OK or Listed button. You can
apply changes without closing the dialog with the Draw button. This button is disabled if the view settings
match the dialog.

Listed

This button makes all the listed channels visible (hiding any channels that are not in the filter) regardless of the
state of the check boxes. It is equivalent to clicking the All Channels check box to remove all channels, then
clicking the Show button and then OK. The idea behind this is that if you have a saved filter setting to display
channels that match a specific filter, you can open the dialog, select the filter string, then use Listed to display a
new set of channels. If you prefer keyboard commands to using the mouse, you can perform this operation from
the data view with:

Ctrl+H Open the Channel Show/Hide dialog

Tab Make the Filter text the current item

Alt+Down Drop the list of filters

Down Use the down arrow key to move to the desired filter text
Alt+L Display only the channels in the list and close the dialog

Y Axis, X Axis, Grid

You can show or hide the axes and you have control over how the x and y axes are drawn. You can hide or
display the grid, numbers on the axes, the big and small ticks and the axis title and axis units. You can also
choose to show the y axis on the right of the data, rather than on the left and choose if the Scroll bar is visible
for the x axis (not in an XY view). You can change the width of the lines used for the axis and ticks in the Edit
menu Preferences Display tab.

Title, Units, Small ticks

These check boxes allow you to show and hide various axis features. If you disable both the Units and the
Titles, the vertical space used by the x axis reduces. The Small ticks are the sub-divisions between the axis
labels.

In a Time view, the Title area is at the left-hand end of the x axis and is used in Time of Day mode to display
the date at which the file started.

Scale bar

For publication purposes, it is sometimes preferable to display axes as a scale bar. If you check *

the Scale only box, a scale bar replaces the selected axis and any grid set for that axis will vanish.

You can remove the end caps from the scale bar (leaving a line) by clearing the Small ticks check

box. The size of the tick bar can set by the Large tick spacing option in the Y Axis Range or X ° 4} 4
Axis Range dialogs, or you can let Spike2 choose a suitable size for you. -

Ay axis will automatically switch to draw as a scale bar if there is not enough vertical space to -4
display numbers for the tick marks.
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Axis in data [10.07]

For publication purposes, you may prefer to display axes in the data area. If you check these boxes, the selected
axis, or both, are drawn on top of any grid and under the data. The x axis is drawn along the line of 0 on the y
axis. The y axis is drawn along the line of 0 on the x axis. Selecting these options does not turn off the standard
x and y axes; you may wish to use these to adjust the display before turning them off. We expect these
additional axes to be used with XY views. We do not expect these extra axes to be useful in a Time view; they
may have a use in a Result view.

Y axis horizontal labels

Normally, the Title and Unit text for the y axis is presented vertically unless there is very little vertical space
available. If you check Enable, the y axis text is presented horizontally and the other controls in this region
become active. The channel title is left aligned when the axis is on the left and right aligned when the axis is on
the right. The script language equivalent of this dialog section is YAxisMode (). The other controls are:

Centre units
If checked, the units are centred on the channel title. If clear, the units are aligned to match the title.

Label space

You can set the horizontal character space to reserve for the channel title and units. This is in terms of a
representative character width, currently in the range 2-33. If you set more than 17 characters, any saved
resource with this value read into a version of Spike2 before 8.12 will set a different width in the range 2-17.

Vertical alignment
You can choose to position the text at the top, centre or bottom of the available vertical space.

Channel numbers
The three check boxes at the top of the dialog control if channel numbers and the x and y axes are drawn.
Channel numbers are never drawn in an XY view as all channels share the same y axis.

Short cut to display a single channel or channel group

In a time or result view, you can double-click a channel with a y axis to hide all the other channels; the channel
expands to fill the entire window. A second double-click restores the display. ctr1+double-click displays the
channel plus all duplicates. If the clicked channel holds a group of channels, all channels in the group expand to
use the display area and if ctr1 is held down, duplicates of all channels in the group are displayed.

Filter regular expressions

Regular expressions are too huge a topic to cover in detail here. When used with the channel dialog you will
likely only use a small subset of the available possibilities. This following is just to get you started.

The first thing is that most characters stand for themselves and match themselves. So cat matches the middle
letters of scatty, which is just what you would expect. However, there are several special characters that do not
match themselves (unless you put a backslash before them to remove their specialness). You can also use \t to
match a tab character. You can use \d to match a single decimal digit.

Match any single character except a newline

[chars] Match a single character that is in the list of characters chars. The list can include a range as a-z,
for example. To include - in the list put it first or last. [0-9] matches any numeric digit.

[~ chars Match a single characters that is not in the list of characters.
]

(exp) Parentheses enclose a "capture group" and gives it a number (starting with 1). You can then back-
refer to the group: (cat)\1 matches catcat. To use ( and ) as ordinary characters you must use
\ (and \).

Matches the preceding element 0 or more times. So x*Y matches v, XY, XXY, xXXY and so on. Use \*
to match a *

+ Matches the preceding element 1 or more times. So x+Y matches Xy, XXy, XxxY and so on. Use \+ to
match +.
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Matches the preceding element O or 1 times.

Matches either the regular expression to the left or the expression to the right. cat | dog will match
either cat or dog. You can use parentheses to limit the range of matching: gr (a|e) y matches grey
or gray.

If you want the full details of regular expression searches, start here.

Vertical Markers

The View menu Vertical Marker command is available in a Time view and opens the Vertical Markers dialog.
Vertical markers are vertical lines drawn under or on top of the channel displays, rather like vertical cursors,
expect that their positions are set by the times of event or marker data points on a channel. If the channel is a
TextMark, you have the option of displaying the text of the marker in a variety of styles. Vertical markers are
not drawn if the display is in 3D overdraw mode, nor are they drawn over the Overdraw WM area of a Time
view.

10 TextMark i
2 s [ ————————
: S
g :
E
5
T T T T T T T T T T T
135 160 165 170 175 180 183 190 195 200 205
3
The picture shows an example of the use of vertical markers with a [ yersical markers =

TextMark channel being drawn in both state mode and as a vertical :
marker. Vertical markers are often used in place of vertical cursors || Yertical marker channel |10 Textmark (TextMark) |

where you need a marker that cannot be moved by the user. If you use || [#/bran vertical markers on top of all data
a memory channel as the vertical marker channel, you can edit the [7] Set colour based on Marker codes
position by adding and removing items in the memory channel. Fetitic ety
You can set the width of the vertical line in the Edit menu || [¥/DsplayText TextDiection|Upnard =)
Preferences dialog and the default colour in the View menu Set [T No textEl Justify |Left -
Colours dialog in the Application Colours section. The dialog fields [ Hide fine Place text [Belowline  + |
are: Arial 9 pt Regular

|. Reset Font I Set Font... |
Vertical marker channel
You can select any channel that holds event, Marker, RealMark, | tep | [ cancel | [ gose |

WaveMark or TextMark data. You can also select No channel to -
disable the display of vertical markers.

Draw vertical markers on top of all data
Check this box to draw the vertical markers after the channel data. Leave the box clear to draw it before the
channel data. Leaving this box unchecked places the markers on top of any background (including channel
background colours and grids) but under the data. Drawing is faster if this box is checked if you have grids or
individual channel background colours defined.

Set colour based on Marker codes

There is a set of 9 colours in the colour palette that are used to display WaveMark data in colours based on the
marker code. These colours can also be used for vertical markers if the marker channel is based on a Marker
data type. Check the box to enable the use of WaveMark colours.

TextMark display
The remainder of the dialog fields are concerned with TextMark data. If the channel is not of TextMark type all
the remaining fields are disabled unless No channel is selected, when all fields can be set.

Display Text
Check this box to display the text stored in a TextMark data channel.




Spike2 version 11 for Windows

No text Fill

Normally, the area behind the text is drawn in the colour set for the vertical marker and the text is drawn in
white or black, whichever provides the most contrast. Check this box to draw the text in the vertical marker
colour with no background fill.

Hide line
When text is drawn, you can choose to hide the vertical line by checking this box.

Text Direction
You can choose to run the text upwards (to match the text for channel labels on channels with a y axis) or
downwards.

Justify
The text can be Left, Centre or Right justified within the scrollable area of the view.

Place text
The text can be aligned to be Below, On or Above the vertical marker line.

Set Font...

Click this button to open a Font select dialog where you can choose the font to use for the vertical marker text.
The current font, size and style displays above the Reset Font button. The font size may be slightly different
from the requested size as it displays the actual size of the font as rendered on screen.

Reset Font
Click this button to revert the vertical marker font to the font set for the view. The text above this button will
show Use font set for view if the font has been reset.

Cancel
The view changes dynamically to show the effects of any changes. If you close the dialog with the Cancel
button, all changes made are removed before the dialog closes.

Close
This closes the dialog, accepting any changes. If you have made a change and recording is enabled, script
commands are saved that reflect the new state. You can use Undo to remove changes after the dialog closes.

TextMark List

|:| The standard way to display TextMark data is in Dots mode, and comments are shown in the file as a

small rectangle. The colour of the rectangle depends on the first marker code associated with the marker.
If the code is 00, the rectangle is yellow. Otherwise, codes use the same colours as WaveMark data, set by the
View menu Change Colours command. Other modes are available, such as Text and State. You can see the
text associated with a TextMark by moving the mouse pointer over the rectangle and waiting a moment. The
text appears as a tool tip. Any movement of the mouse pointer hides the text.

Opening the TextMark list dialog
You can open the TextMark dialog in several ways:

e With the View menu TextMark List command. If there are multiple TextMark channels this opens the
lowest-numbered selected channel, otherwise the lowest-numbered channel.

¢ By double-clicking on a TextMark data item. The clicked-item is selected in the dialog. If you hold down the
ctrl key when you double-click, the dialog opens with the list area displayed, otherwise it opens with the
list hidden.
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¢ By right-clicking on a TextMark channel and selecting View TextMarks... from the context menu. The
nearest item is selected.

e By clicking on the system toolbar TextMark button or using the Ctrl+T keyboard shortcut when not
sampling data. If you are sampling data, this opens the online Create a TextMark dialog.

Editing and reviewing the marker text

To edit the comment text and marker codes, use one of the methods above to open the Edit TextMark dialog. If
your open method selected a marker or right-clicked on a TextMark channel, the selected marker or the nearest
marker to the click is displayed. Otherwise, the first marker from the start of the displayed data is selected.

B ! Edit TextMark for Demo.smr[32-bit] channel 10 X

| Start decrease of output amplitude

Codes |06 = 00 -5 (00 -2 (00 - at 2.06391 seconds Cancel Apply 0K >>

The >> and << buttons at the bottom right of the dialog show and hide the list area.

¥ ' Edit TextMark for Demao.smr[32-bit] channel 10 X

‘ Start decrease of output amplitude

Codes[06 300 3 00 ;00  at 2.06391 seconds

Seconds’ co Text ~

2.06391 06 Start decrease of output amplitude [ISNaT : cul+c |

8.74128 01 Start Increase of output amplitude Copy Title +8 Ctrl+T

14,08317 02 Start Increase of output frequ_ency Copy Spreadsheet Gtil+S

35.32933 06 Start decrease of output amplitude .

51.71922 01 Start Increase of output amplitude Copy Quoted Title Ctrl+Q

58.76081 04 Start Decrease of output frequency Select All Ctrl+A

74.90789 02 Start Increase of output frequency

75.75773 06 Start decrease of output amplitude e i

86.44152 01 Start Increase of output amplitude Code 1 Ctri+1

94.45436 03 Start Decrease of output frequency Code 2 Ctrl+2

99.18921 06 Start decrease of output amplitude Code 3 Ctrl+3

99.55343 02 Start Increase of output frequency

104.53111 02 Start Increase of output frequency

105.50236 01 Start Increase of output amplitude v
Help Show Cancel Apply (0]4 <<

Double-click an item in the list to edit it and save any changes to the item that was previously displayed. The
Show button sets the time view time range to span the currently selected items. If you have made multiple
selections, the first marker is displayed at the left edge of the screen and the last one at the right edge.

The marker codes display in the format set for the source channel (Hex only or using printing characters).

Right-click in the list to control how many marker codes to display and to copy data to the clipboard. If you
choose Copy for spreadsheet, text strings and marker codes are enclosed in quotation marks so that the data
will import easily into spreadsheet programs. You can change the sort order of the data in the list by clicking
the column titles. Initially, the items are sorted based on the first column (holding the time of each item).

The list area displays the same markers as the channel does, depending on the current settings of the Marker
filter for the channel. You can open the Marker Filter dialog from this dialog by double-clicking on Codes (to
the left of the four marker codes). The time of the items displays in the same format as is set for the x axis of the
associated Time view. The number of decimal points displayed for the seconds depends on the tick spacing in
the x axis at the time the list was last updated; the more you zoom in, the more decimal places. The list updates
if the data changes or if you change the x axis units (seconds, milliseconds, hh:mm:ss, Time of day) or if
you change the associated time view x axis width so that the number of decimal places changes.

Modifying the selected item

If you click on an item in the list, the text and codes are displayed in the upper part of the dialog. You can edit
the text and codes, however nothing is saved until you click the Apply button or open the dialog for a different
TextMark channel in the same file. Initially, the codes display in the format set for the channel. However, you
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can change the code if it is in the 'printable character' range to two hexadecimal digits or one printing character
by right-clicking on the marker code field and choosing the appropriate setting.

Navigating to TextMark data

You can move the associated Time view to the currently selected TextMark in the list by clicking on Show. If a
single TextMark item is selected, the Time view stays the same width but scrolls to get the selected time as
close to the centre of the window as possible. If multiple markers are selected, the display changes to start at the
earliest marker and end at the latest. If you double click on an item in the list, this is equivalent to single-
clicking it to select, then clicking the Show button.

If the dialog is open you can navigate to an item in the list by a single left-click on a TextMark data item in the
time view window.

Context menu commands
Right-click on the list of comments to see the context menu. All items have a keyboard shortcut listed in the
menu. The options are:

Copy, Copy Spreadsheet

These options copy the selected items in the list to the clipboard with each field (column) separated by a Tab
character. If all items are selected this also copies the column headings. The Spreadsheet option places
quotation marks around each field to group the field data (this should stop Spreadsheets attempting to identify
marker codes as numbers, to avoid translating code 00 to 0, for example.

Copy Title, Copy Quoted Title
These options copy the title line from the list, or a version with each column title in quote marks.

Select All
Selects all items in the list.

Code 0..3
These options toggle the visible state of the columns holing marker codes 0 to 3. If you want to change the state
of more than one item it is quicker to use the keyboard short-cuts.

Large numbers of TextMark items

The list box is limited to 12000 items, centred on the time of the item double clicked to open the dialog. If you
work with a large number of TextMark items, avoid opening the file across a network; network access is
typically much slower than local file access and some operations, such as sorting the TextMark data items (by
clicking on the column titles in the dialog) can be slow on large, networked files.

Pen Width
The Pen Width dialog in a time or result view allows you to override the | pen width X
standard pen width set for data in all channels in the Edit menu Preferences :
dialog. The dialog can be opened as a context menu when right-clicking on | el [ 1 Sinewave (Waveform) -
a channel, or from the View menu. Changes made with this dialog can be |&renwidth 129 % Points
undone and recorded as a script. The script language equivalent of this Pen width taken from channel value
dialog is the ChanPenWidth () cpmmand. For XY views, use the XY e cancel
Draw Mode dialog to set the pen width of a channel.

Channel
You can select a channel from the drop-down list or type in a channel or a list of channels. If more than one
channel is set, the displayed information will be for the first channel in the list.

Pen Width

If you check the box, you can set a pen width in points; this will be applied to all the channels in the list when
you click OK or when you use the spin control. If you clear the box, the standard pen width for data (set in the
Edit menu Preferences Display tab) will be applied on OK and you cannot edit the value. A point is 1/72 of an
inch, which used to be about same size as a screen pixel, but on a high-resolution display might be several
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pixels. If you set a size of 0, the pen size will be 1 pixel on all devices (which can be a very thin on a printer or
high-resolution screen). You can set a fractional point size, but the output pen will always be at least 1 pixel
wide.

The spin control changes the points size in screen pixel increments and applies the changed value immediately.
The text below the Pen Width field indicates the source of the pen width: Pen width taken from Edit menu
Preferences or Pen width taken from channel value.

If you edit the pen width value, it is applied on OK.

File Information (Time View)

This displays information about the current time view, including five lines of comments and the time and date it
was created (if available). You can edit the comments unless the file is open in read only mode. You can cause
this window to open automatically when sampling ends from the Automation tab of the Sampling
Configuration dialog.

New format .smrx files allow 8 comments internally, but we only display the first 5 to be compatible with the
old format files. We are reserving use of the remaining comments for future extensions.

Originally, comments were limited to 100 characters. From version 8.09 we allowed much longer comments to
be used in smrx files (up to 2000) characters. The intent is to allow more information to be stored, and this is
likely to be useful to script users. This is an experimental change and the dialog has not been modified to
accommodate huge comments. We may make provision for easy editing of multi-line comments in a future
Spike2 version.

File Information (Result View)

This command displays information about the current result view window including the number of channels,
bins and bin width. In particular, it displays the number of sweeps that have been added into a PSTH,
correlation or waveform average, the number of data blocks in a power spectrum, the number of cycles in a
phase histogram and the number of intervals that have been processed to build an interval histogram (including
intervals that fell outside the histogram).

Channel Information...

Channel Information (Time view)
Channel Information (Result view)

Channel Information (XY view)

Channel Information (Time view)

Use this dialog to view and edit time view channel information. You can open it with a double-click on a
channel title, from the View menu or right click the channel to open the context menu. You can edit the Title
and Comment of the channel set by the Channel field. The remaining fields are hidden or displayed
depending on the channel type. The Reset, Apply and OK buttons are disabled until you make a change to one
of the fields. The Close button closes the dialog and does not apply any changes.

Changes made in this dialog have no effect on your data | channel information for drug.smr %
until you click the Apply button or OK (which is the same
as Apply then Close). Changes to all fields except Title
apply to all duplicates of the channel and to the channel |Tile | Spikes | Rate: 12.5 kHz Points: 100 Pre-trig: 50

and its duplicates in any window duplicated from the | comment [ Example sampled spike shape channel ‘
current window. If you change channel without applying |, . BT | Scle [10 oo |
changes, any changes are lost. —

Waveform range: -50 to 50 mV

Channel | 1 Spikes (WaveMark) MIES

Changes to the Title field are applied to duplicate channels || Help Reset Apply Close
if the duplicate has not been given its own title. If you set
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the title of a duplicate channel, it has no effect on any other channel. If you clear the title of a duplicate channel,
it takes the title of the channel from which it was duplicated.

The Reset button restores any changes you have made to the channel settings unless you have used Apply. To
undo applied changes, close the dialog and use the Edit menu Undo command (Ctr1+2).

From version 8.09 we have allowed much longer comments to be used (up to 2000) characters. The intent is to
allow more information to be stored, and this is likely to be useful to script users. This is an experimental
change and the dialog has not been modified to accommodate huge comments. We may make provision for
easy editing of multi-line comments in a future Spike2 version.

Scale, Offset and Units

For waveform, RealWave or WaveMark channels, extra fields show the Scale and Offset values and the
channel user Units. The scale and offset convert between the 16-bit integers used to store waveform and
WaveMark data and user units. They also convert RealWave values to integers, when required.

Real value in user units = 16-bit value * Scale / 6553.6 + Offset
Integer value = (Real value in user units - Offset) * 6553.6 / Scale

When the Scale and Offset fields are present, the Waveform range field displays the range of values that a
16-bit waveform channel could span. You can read more about scaling in the documentation for the sampling
configuration dialog. Both the scale and the offset must be smaller than 10 billion. The scale may not be set to 0
or very close to 0. If the channel scale or offset is edited into an illegal state, a warning message appears in the
dialog and you cannot Apply the changes. If you want to calibrate a channel, it is often easier to use the
Calibrate option of the Analysis menu.

The Scale value is numerically the same as the value in the Sampling configuration when data is captured by a
1401 interface that has a =5 Volt input range. If your unit has a £10 Volt range, the scale value is double that in
the Sampling configuration.

If the Scale and Offset fields are disabled and "No rescale" appears in the channel information to the right of
the Title field, you have applied a channel process that has changed the calibration or is non-linear. At the time
of writing, Rectify and Fill Gaps are both non-linear processes. To change the channel scaling, remove the
process.

If you want to take advantage of SI prefixes for your channel units, see the Y axis dialog to enable this feature.

Data index (RealMark channels) [9.02]
RealMark channels have an extra field (Data index) to | channel information for Demo.smrx %
choose which set of titles and units are displayed. If there
are n attached data items, you can choose from Default or
Item O to n-1. The Default titles and units apply to all |Tte  Gasses | Values per marker: 4
data indices that have no specific title or units set (are | comment | Channel vith 4 attached values
blan). When stored in the data file, the various titles and | D

units are stored as: "Default|Item O|Item 1]...". e
This means you cannot use a vertical bar character in
RealMark channel titles or units.

Channel | 5 Male (RealMark) v |2 Dataindex Default v

Help Reset Apply OK Close

If this is a duplicate channel, you can also choose Duplicate (which allows you to edit the Title that belongs to
the duplicate), otherwise the Title and Units fields are disabled. You must select the original channel to edit
these fields. Once a duplicated channel has a title set, this over-rides any per item title until it is cleared. To
clear the title, delete all characters in the field and click Apply.

This field does not change the displayed data index; use the Draw mode dialog Data index field to do this. The
script language sets separate titles and units with the ChanTitles$ () and ChanUnits$ () commands with the
extra index$% argument.

Rescale

The Rescale button appears for RealWave channels. Click it to set the Scale and Offset fields so that the full
range of data could be represented by 16-bit data. The offset is set to 0 if this does not lose too much precision.
Some routines in Spike2 treat RealWave data as 16-bit integer, and the scale and offset you set determine how
the conversion from 32-bit real to integer is done.
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Channel Information (Result view)

Use this dialog to view and edit result View [ channeis settings for INTH(drug) [=5=)
channel information. You can open it with a
double-click on a channel title, from the View
menu or right click the channel to open the || Tt -1
context menu. You can edit the Title, Units || ys Coit
and Comment of the channel set by the
Channel field. The Reset, Apply and OK
buttons are disabled until you make a change ||[ pap Reset aoply [ cose
to one of the fields. The Close button closes |-——— J
the dialog and does not apply any changes.

=

Channel | 10 nw-1 {Result) v| =

Comment  From 10: Created on 27/04/2010 at 15:03:48 from channel 1

Changes made in this dialog have no effect on your data until you click the Apply button or OK (which is the
same as Apply then Close). Changes to all fields except Title apply to all duplicates of the channel and to the
channel and its duplicates in any window duplicated from the current window. If you change channel without
applying changes, any changes are lost.

Changes to the Title field are applied to duplicate channels if the duplicate has not been given its own title. If
you set the title of a duplicate channel, it has no effect on any other channel. If you clear the title of a duplicate
channel, it takes the title of the channel from which it was duplicated.

The Reset button restores any changes you have made to the channel settings unless you have used Apply. To
undo applied changes, close the dialog and use the Edit menu Undo command (Ctr1+2).

Channel Information (XY view)

Use this dialog to modify the XY channel titles and the X and Y
axis titles and units. You can open the dialog from the View
menu, by double-clicking on the axis title and units area or from | Channel titles

the XY view context menu. The OK button is disabled until you | . /1 channel 1 e
make a change. Changes are not applied until you click OK, at
which point all the changes you have made are applied. If you
click the Cancel button, no changes are applied. Changes you

make in this dialog can be recorded and can be undone. Y Axis
Title ‘ Y axis title ‘

XY titles, units and Z Order X

Title ‘ My window title ‘

Channel titles

Each channel in the XY view can be given a title. If a channel
does not have a title, it is listed as Channel n, where n is the | X Axis
channel number. You can select the channel from the drop Iit|6‘Time ‘
down list, or by using the spinner control. All changes you make
are saved in the dialog until you click OK or press the Enter
key. We allow you to enter up to 50 characters. Channel titles
are visible in the Key. The script language equivalent of this Z Order

field is ChanTitle$ (). Z value (higher values draw over lower) \12—/

Help Cancel
Y Axis

An XY view draws multiple traces using the same set of x and y axes. The displayed y axis title and units do
not belong to any particular channel, so (unlike Time and Result views), the y axis title and units are
independent of the channels. You can set titles and units of up to 50 characters, though no more than 10 will
display. When a result view is saved, the text strings for the x and y axis titles and units have to fit in a
restricted space (for reasons of backwards compatibility). There is sufficient space for 50 ASCII characters, but
if you use non-ASCII characters you will have room for fewer. For example, there is typically space for 17

Units ‘ Y axis units ‘

Units ‘ Seconds ‘

Japanese or Chinese characters. The script language equivalents are ChanTitle$ (0, ...) to set and get the
title and ChanUnits$ (0, ...) for the units.
X Axis

You have a free choice of text for the x axis title and units in an XY view. The same comments about the length
of the text apply as for the Y Axis. The script language equivalents are xTitle$ () and XUnitss$ ().
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Z Order

From Spike2 version [10.17] you can control the order in which channels are drawn (not to be confused with
the order that data is drawn within a channel, which is set by the XY Draw Mode dialog). Each channel has a Z
value and channels are drawn starting with the lowest Z value. In the event of a tie, lower numbered channels
draw before higher numbered channels. When a channel is created, it has a Z value of 0.0; you can set negative
or positive values. This value has most effect when a channel is drawn in a filled mode, so channels drawn later
can mask channels drawn earlier. The script language equivalent of this field is xYzOrder ().

The View menu Standard Display command resets all the Z values to 0.

Channel Image

You can set a bitmap as the background to any channel in a Time, | gzckground Bitmap =50
Result or XY view. This can be very useful in an XY view when |[,___ e 2] i (i)
the XY view is being used to map activity. For example, when the || 0
view is showing where spiking activity occurred in a maze, or Reitreie

when tracking a target. This can also be used to display the result ™0 5

of the ArrMapImage () command. The menu command opens a left O Rght 7.3
dialog: (] ot s =
The dialog is used to select a channel and then link the channel to a

bitmap file on disk. Any channel in the view can be associated with || ™™ A

an image. The name of the file appears in the Image file section of || [ tep | [ cear || paste | [Erowse.. | [ cancel |[ close |

the dialog. The image is rendered on top of the channel
background colour, but below all other items that are drawn. When channels are overdrawn, the image appears
when the background colour of the channel would be drawn. The dialog fields are:

Channel

You can select any channel in the current view. However, if you are in an XY view, all channels share the
background, so the choice of channel makes no difference. When you change channel, any Rectangle region
changes that have not been applied are lost and the current settings for the new channel appear in the dialog.

Mode
There are three mode settings: No display, Fill Background and Fill Rectangle.

No display No image is displayed. This allows you to have an image loaded, ready to display. This will
save the time needed to load the image from a disk file.

Fill Background The image is scaled so that it fills the available channel rectangle. You would use this when
you want to display the entire image as a background for the channel. Scrolling a view with
an image in this mode will cause flickering as the image must be redrawn for every
movement. We disable background images in Fill Background mode when sampling or
rerunning.

Fill Rectangle = The image is scaled so that it fills a rectangle defined in x and y axis units. You would use
this when the image must be aligned with the axes. For example, if the x and y axes
represented co-ordinates in a maze, the image could be a picture of the maze. There is no
problem with scrolled displays in this mode.

Changes made to the mode field are applied immediately, so you can see the effect.

Opacity
This field is a slider control that you can drag to the left to make the image transparent and to the right to make
it opaque. Changes made by dragging are applied immediately.

Rectangle

The fields within this area are disabled unless the mode field is set to Fill Rectangle. The Left, Right, Top and
Bottom fields refer to the x axis and y axis co-ordinates of the image. In the current implementation, you cannot
invert or reflect the image; if you do it will not appear.
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Fetch
This button sets the Left, Right, Top and Bottom fields to the values that would make the image fill the channel
background.

Apply
This button is enabled when in Fill Rectangle mode and the current rectangle settings are legal number and do
not match those of the channel. Click the button to apply the new values.

Browse...
Click this button to open a file dialog in which you can browse for a suitable image file. You can choose
between windows bitmaps, JPEG and GIF images, PNG files and TIFF files.

Paste

This button is enabled if the clipboard holds a bitmap image. Click to paste the image to the current channel.
The Image file name will display as <CB>. Setting the clipboard as the source can have unexpected results as
each time a saved window opens it will copy whatever image happens to be on the clipboard. Clipboard images
are more useful to scripts, for example to copy a multimedia view video frame using EditCopy (), then setting
the image with ChanImage (), avoiding the need to write the image to a disk file.

Clear
Click this button to clear any image set for the channel. This releases any resources used to hold the bitmap.

Cancel
Click this button to close the dialog and undo any changes made since the last channel change.

Close
Close the dialog, leaving the associated channel in the current state.

This command is experimental and is implemented in a simplistic manner. If you reuse the same image for
multiple channels we do not notice, and store the image multiple times, which could be a problem if you use
huge images on many channels.

Info windows

The View menu Info windows command display a pop-up | @i infopemo.smm) X
menu that allows you to create a new Info window attached |,

to the current Time, Result or XY view, or to select an
existing Info window belonging to the current view and

bring it to the front. Info windows were added to Spike2 at . .
version [10.00]. a & i

Each Info window owns a timer, a user-defined text string,
an optional background image and has configurable text and
background colours and font. You can hide the window title
bar and/or the buttons to reduce screen clutter. With the title

bar hidden, a small area remains at the top of the window for 9
. ° .

The text string (see the Settings dialog) usually contains one
or more special fields that are replaced by a timer value or
by other data extracted from the associated data view and
updated at user-defined intervals. You can resize the
window, and the window contents automatically scale to fill the available space. This makes Info windows
useful for real-time work in busy experiments by providing easily read (from a distance) experimental
information.

Reset Settings...

Drag area

You can set the Info window to speak the displayed text. This can be useful in online situations where you are
required to use a microscope or cannot see the screen while capturing data.
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You can attach up to 10 Info windows to each data view.

If you close a view that owns Info window(s), the settings are preserved in the view resource file. When you
open a view from a disk file we also restore any Info windows that were saved.

In addition to the interactive use described here, there are script language commands to create, configure,
control and delete Info windows.

Create New Window

Use the Create New Window sub-command to this command to create a new information window. The newly
created information window is attached to the current time, result or XY view. Other sub-commands can be
used to select an already existing information window.

Using the information window

You can resize the information window by dragging the bottom-right corner of the window or any edge; the
font size adjusts according to the window size so that the window text fills the window unless the Lock font
size option is active.

Button bar commands
These commands are also available from the right-click context menu.

Start Visible and enabled when the timer expression (%t) is part of the window text and the time is
not running. Click to start the timer.

Stop Replaces the Start button when the timer runs. Click to stop the timer.

Reset Resets the timer. The timer starts if you have set the Settings dialog Start on reset option.

Settings Opens the Info Settings dialog where you set the text string and configure the timer. You can

hide this button with an option in the Info Settings dialog.

Context menu commands
Other options are provided by a menu obtained by right-clicking on the window. The context menu commands
are:

Copy Copy the displayed information window text to the clipboard.
Close Close the information window.

Start/Stop Start or stop the clock or timer. This is the same action as the Start/Stop button at the top of

the window.
Reset Resets the clock or timer. This is the same action as the Reset button at the top of the window.
Deblock Re-enable timed-out expressions (fields that display {time}).
Settings... Open the information window settings dialog.
Colours... Open the colour selection dialog to change the colours for this information window. The main

colour selection dialog can also be used to set the colours for all information windows or all
those associated with the current parent view.

Font... Open the font selection dialog to change the information window font. Note that the font size is
set automatically according to the size of the window.

Image... Open the Info Image dialog allowing you to set an image that will be displayed in the
information window.

Speak... Opens the Info Speak settings dialog to configure speech output of the Info window contents.
Title visible  Check the box to display a title bar at the top of the information window.

Buttons visible Check the box to display the Command buttons. The same commands are available from this
pop-up menu.

Lock font size Check the box to fix the Info window display font at the current size.
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See also:Toolbar and Status bar, Enlarge View Reduce View, Y Axis Range, X Axis Range, X Axis Extra
Time, Standard Display, Show/Hide Channel, Vertical Markers, TextMark List, Pen Width, File Information
(Time View), File Information (Result View), Channel Information..., Channel Image, XY Key Options, XY
Autoscale, Trigger/Overdraw, Channel Draw Mode, Multimedia files, Spike Monitor, Font, Use Colour and
Use Black And White, Change Colours, Colour scale dialog (Sonogram, Density map colours), Folding, Show
Gutter, Show Line Numbers, ReRun, Annotate, Grid view commands

Info Settings dialog

The Info window settings dialog configures the text to process to | nfo window text and timer settings x
generate the display, controls the Info timer and can hide o _
unwanted items from the window. Any changes you make in this | & dsplayin the info window Litackfonce=a
dialog are applied immediately. The script language equivalents it e G
of this dialog is the InfoSettings() command or the  Timetoprocess 2:0220 e e A 0. 010 R DX 0 359
InfoOpen () command to create a new window. The window is | Timer controls
divided into several regions: pesstLme ey 0.0 [Istartonresst ~ Reset
[Ostopat(s) 0.0 [l Count down Stop

. . . . Close on stop
Text to dlsplay in the |nf0 window Update every 0.1 second ~ | Show time as |HH:MM:SS ~
At the top you type in the text that generates the Info window |
display. You can make thi.s text span m.ultiple. lines by including fiide [ all upper buttons [ Settings button [ Title bar
the sequence \n to add a line break. This text is usually scaled to
fit into the Info window rectangle; the bigger the window, the || HeP Lancel

larger the text. You can defeat this scaling by checking the Lock
font size box.

You can embed special sequences in the text that are replaced with values based on the current time of day, a
controllable timer and measurements made from the associated Time, Result or XY view using Dialog
expressions. You can find the full details of the Text to display... field below. The >> button opens a menu of
commonly-used special sequences.

Timer controls

In addition there are a number of settings to control how the timer value is displayed and how the timer
behaves. The timer can be reset manually (with the Reset button) or automatically during sampling when a new
sweep starts (for a file view parent) or when new data is processed into the memory view (for memory or XY
view parents). The timer can be started and stopped using the Start/Stop button, or automatically on a reset.
The timer controls available in the dialog are:

Reset time (s) Sets the time in seconds to load into the timer on a reset.

Start on reset Check the box to start timers automatically (if stopped) on a reset.

Count time Check the box to run timers backwards.

downwards

Stop at (s) Check the box to stop the timer at the time set in the field to the right of the check box.

The time is in seconds. This box enables the Close on stop check box. If this box is
not set, the timer will continue past the Stop at time.

Close on stop If this box and the Stop at check box is set, the Info dialog closes when the counter
stop condition is reached (as long as no dialogs opened from the Info window are
open). This is not expected to have any use from the Settings dialog; it is intended for
use when the Info window is opened from a script and you want it to display for a
fixed period, then close (for example to display a message that disappears after a short
period). This field was added at [10.15].

Update every This selector sets how often the displayed time is updated and the smallest unit of time
that is shown. You can choose between every 0.1 second, Second, Minute or Hour.
For example, if you update every 0.1 seconds then the displayed time show tenths of a
second. If you update every minute, the seconds value is not shown.

Show time as Sets how times are displayed. You can choose from 0.1 seconds (a count of 100
millisecond intervals), Seconds (a count of seconds), MM:SS and HH:MM:SS. The
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Update every selector also affects how the time is displayed - parts of the time
display that are shorter than the Update every interval will not be shown.

The dialog displays error messages if any of these values are contradictory (e.g. counting down from 0 but want
to stop at 1) or illegal and disables the OK button.

Hide
The Hide region allows you to conceal features of the Info window that you do not want the user to see. You
can hide:

All upper buttons Check this box to conceal the button bar in the Info window holding the Start/Stop,
Reset and Settings... buttons.

Settings button Check this to conceal the Settings... button. Checking the All... button disables this
control.

Title bar Check this to remove the Title bar from the Info window (usually used when

displaying a pop-up message from a script).

OK and Cancel

The OK button is disabled if there is a problem with the current dialog settings. An error message drops down
from the bottom of the dialog after a couple of seconds to explain what caused the error. Some errors, such as a
syntax error in a dialog expression, are marked in the information window output as they are not detected by the
parser in this dialog. The associated Info window is kept up to date with the contents of this dialog; clicking Ok
accepts the current state and closes the dialog.

The Cancel button undoes any changes you have made in the dialog and closes it.

See also:Info Image dialog, Info Speak dialog

Info window Text field

The text entry field is the template for the Info window display. You can embed special text fields that are
replaced by measured data values. You can split the line of text into multiple lines for display by inserting \n
into the text. Drawing text is relatively slow, so you will want to minimise the text in the window, particularly if
you are updating often.

Special fields in the text are introduced by a % character, or enclosed in curly braces, for example %t or {xC0}.
These fields are evaluated each time the window updates and the field is replaced by whatever value the
evaluation generates or by <reason?> if it cannot be evaluated where reason indicates what failed when
attempting to evaluate the special field. The two type of special field are:

% special fields

Fields introduced by a % are more efficient (take less time to process) than curly brace fields, but less flexible
in use. All values in them (channel and point numbers) are provided as decimal numbers and are fixed. You
cannot use symbolic channel names (v1, m1 and so on) or refer to cursor numbers.

To make it easy to generate these fields, you can click on the >> button to build them interactively.

These fields are parsed (checked for validity) when you type them, but the check only verifies that the text
matches the pattern of each command. View types, channel numbers and point indices are verified when the
field is evaluated. You can find the full details of the fields below.

{x..}, {y...} and {=...} special fields

The text within these fields are passed to the dialog expression evaluator for the current view. These fields are
parsed every time they are evaluated, which makes them slower to evaluate than % special fields. However,
they have more data processing options and deal with x axis co-ordinates in x axis units, not in data points. To
make it easy to generate these fields, you can click on the >> button to build them interactively. However, we
have not automated the contents of the fields; you have to type in the dialog expressions yourself. You can find
the full details of the fields below.
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Format control

Unless you specify otherwise, Spike2 displays the measured values in a default format. You can change the
format for the items marked with a 'y' in the Fmt column of the table by following the item immediately (no
white space) with "{flags}{width}{.precision}format" where items in curly braces are optional and
format is one of £, F, g or G. This is a restricted version of the script language format specifier for real values
with the leading % omitted. If you do not specify a format, you get the equivalent of "£", which is fixed point
with 6 decimal places. To make this easy, the >> button leads to an option to insert a format interactively.

>> (insert special field)

The button opens a pop-up menu in which you can select items to insert into the text Local Time %l
box, replacing the current selection. The items are grouped into three section: time Timer Reading %t
related insertion, data measurement insertions and data formatting insertions. The Qiien/jime/ins) %9

insertions are either % special fields, { dialog expression } special fields, or format = PointMeasure...
fields X Dialog Expression {x}

Y Dialog Expression iy}
Format fields surrounded by double quotes (for example ".3f") and are recognised  Dialog Expression (=}
only when they immediately follow a special field that supports formatting with no Formivalle =
white space between the final character of the special field and the " character that "' L
introduces the format field. If you insert a format field in a position where it is not
recognised, or if the format text is not recognised as a valid format string, the text of the format field appears in
the Info window output.

You can insert the following:

Local Time The current time of day, formatted as HH:MM: SS.

Timer Reading The current timer value, formatted as set in the Timer controls section.
Sweeps Valid for Result views, the sweep count.

Query time (ms) Time (in ms to 3 decimal places) to calculate the previous update.

Point Measure... Opens the Measurement dialog to select a channel-related measurement.

X Dialog Expression Inserts {x } and sets the text caret ready for you to type an expression.
Y Dialog Expression Inserts {y } and sets the text caret ready for you to type an expression.
Dialog Expression Inserts {= } and sets the text caret ready for you to type an expression.
Format value... For use immediately after a special field. Opens the format dialog.

New line Inserts the new line sequence \n

Time to process

This line in the dialog displays the time taken, in milliseconds, to process the last update of the Info window
and the minimum and maximum times taken since the last change to the text. The update time is the same value
as displayed by the g expression.

Each display update recalculates all the $ and {...} expressions, which can take substantial time. For
example, if you include:

{y Mean(0,Maxtime(),1)}

in a sampling time view to calculate the mean value of all the data in channel 1, this will take longer and longer
to compute as time passes. Eventually it will take so long that the program will feel sluggish and unresponsive.
We combat this by timing how long the computation of each dialog expression takes (these are usually the
slowest items). If any item exceed 100 milliseconds, it is disabled and the output from that expression is
replaced by {time}. You can re-enable the fields with the Info window right-click context menu Deblock
command.
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Info window Point Measurement

This Info Settings dialog >> button Point Measure... command opens | info window Point Measurement %<
this dialog which allows you to generate a % special field interactively.
The current result of your dialog settings can be seen and the dialog will
not let you generate syntactically incorrect fields. However, you can
generate references to data points that do not exist. These will cause the g Result:  %ry1

text <point?> to appear in the output. Help —

Channel 1 Sinewave i

Measurement  |Last data point v | Ox

(@

)Y

Channel

You can select any channel in the data file from the drop-down list of channels. If you want to use a symbolic
channel number, such as v1, this cannot be done with % special fields. You must use the {...} dialog expression
fields to do this.

Measurement

This field chooses the data item that you want to measure. You can choose from the following:

Last data point The last data point on a channel. Usually used with an XY or a Time view.
Previous data point The second to last data point in the channel.

Difference of last points Use the final two points in the channel and subtract the value from the second to
last from the value for the last.

Indexed point The value at a particular indexed into the channel. The first point on a channel is
index 1. Indices from 0 downwards are backwards from the end. In a time view
you can only use indices from 0 downwards to -1999. In Result or XY views you
can use forward or backward indices.

Last point - Indexed point  Subtract the value at a particular index from the last value on a channel.

Number of channel points Valid and useful for an XY view channel. Valid for a Result view. This is not
implemented for a Time view and generates <view?> if you use it.

Index data

Select the Indexed point or Last point - Indexed point measurements to enable this field. Positive values,
from 1 upwards, index the channel point from the start of the channel. The index value 0 is the last point, -1 the
one before the last and so on, indexing backwards from the end. In a time view, you may only index backwards
from the end, and only up to 1999 points backwards (to limit the length of time spent searching through data). If
you want to access your data by x axis value rather than by point number, you can do this using the { dialog
expression } special fields.

XorY
You can choose to measure either the X or Y value associated with a particular point on a channel. This field is
not valid for the Number of channel points measure, and is disabled when you select this measure.

Result
This field displays the text that would be inserted if you clicked the OK button.

Cancel and OK

The Cancel button closes the dialog without inserting any text. The OK button closes the dialog and accepts
the current value, which is inserted in the settings dialog to replace the current text selection. Invalid entries in
the Index data field will disable OK.
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% special field details

In the table, items in <angle> brackets stand for channel <ch> and point <pt> numbers. Channel numbers are
the channel numbers displayed when you view the channels have values from 1 upwards. Fields with a numeric
result and a yes in the Fmt column can be followed (with no intervening white space) by "<format>" to set a
specific numeric format when they are expanded.

Point numbers can be used in some commands. The first point in a channel is 1, the second 2 and so on. Point
numbers greater than 0 are generally only used with XY views. Point number 0 means the last point of a
channel, -1 is the point before it and so on. Point numbers of 0 or less can be used with both XY views and
Time views to access the most recently added data. Using point numbers much greater than 0 or with large
negative values in a time view can be very slow to evaluate.

We detect the end of a number by finding a character that cannot be part of the number. This can lead to
ambiguity if you want to follow a field by a numeric character. We allow you to enclose numbers is brackets,
for example (10) to avoid any problem. So, $rx3 and %rx(3) are both acceptable as the rear x value of
channel 3.

The fields you can set are (<ch> stands for a channel number, <pt> is a point index as described below):

Coded as Fmt Replaced by

51 The local system time, displayed as HH:MM: SS.

st The current value of the view timer in the format set by the dialog.

sn<ch> Replaced by the number of items in the channel (for use with XY views, also works
with Result views).

W Result views only. Replaced by the sweep count for the result view.

%q Query how long it took in milliseconds to evaluate the previous window update. If an
update takes too long, we may reduce the update rate or even disable the display.

Srx<ch> yes The most recent/rear x value from the channel. Example: $rx1 get the last x position
of channel 1.

Sry<ch> yes The most recent/rear y value from the channel. Example: %ry3 gets most recent

channel 3 value. From version [11.00] if the channel is a Marker, the y value is the
current marker code set for the channel, if the channel is a TextMark, the data is the
marker text.

spx<ch> yes The penultimate x value from the channel. $px2 gets second last x position on channel
2.
spy<ch> yes The penultimate y value from the channel. $py20 gets the second to last value from

channel 20. From version [11.00] if the channel is a Marker, the y value is the current
marker code set for the channel, if the channel is a TextMark, the data is the marker

text.
sdx<ch> yes The difference of the last two points x co-ordinates; last value - previous.
sdy<ch> yes The difference of the last two points y co-ordinates; last - previous.

sc<ch>px<pt> yes The x data at index <pt> on channel <ch>.

sc<ch>py<pt> yes They data at index <pt> on channel <ch>.

sc<ch>rx<pt> yes The x position difference between the last point and the data at index <pt> on channel
<ch>. That is (last x position - X position of <pt>).

Sc<ch>ry<pt> vyes The y value difference between the last point and the data at index <pt> on channel
<ch>. That is (last y value - y value of <pt>).

You must use lower-case letters for the codes; if you use upper-case, the codes will not be recognised.

The <pt> field

The <pt> field is a 1-based point index into the channel. You can use index 0 to mean the last point, and
negative points to refer to points before the last point. To stop the command taking too long, we limit the
backwards indexes to -1999.

In an XY view, you can index into any of the points held in a channel. In a Result view, you can index to any of
the data bins in the channel. In a time view, we currently allow only backwards indexing from the end, so <pt>
values greater than 0 do not work. You can use dialog expressions (see below) to display values at any x value
in a channel.
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The <ch> field

The <ch> field is a numeric channel number. If you want to refer to virtual or memory channels you must use
the numeric channel number, or use a dialog expression (below), which does understand channel numbers such
as vl.

Errors
It is possible to type in % expressions that are syntactically correct, but not valid. If you do this, the result of
evaluating the expression can be:

<view?> The expression is not valid in this owning view. For example, requesting the number of points
in a Time view channel is not supported.

<channel?> The requested channel number does not exist.

<point?> The requested point does not exist or is not supported in the current view.

Syntax errors in the text results in a display up to the point where the error was detected.

Dialog expression fields

Dialog expression fields have the format:
{<type><optional spaces><dialog expression>}

The <type> is one of x, y or = and determines the type of the dialog expression that can be used. The text
within the curly braces is not modified, other than replacing % fields, before being passed to the expression
evaluator. Leading white space before the dialog expression is ignored. You can select between:

type Fmt Replaced by

{x...} yes The ... stands for an x-axis dialog expression. For example {x C1} is replaced by the
position of cursor 1, expressed as a number.

{y...} yes The ... stands for a y-axis dialog expression. For example {y At (C1,2)} is replaced by
the displayed y value of channel 2 at cursor 1.

{(=...} yes The ... stands for a non-view numeric expression. You might use this to perform arithmetic

on the results of % special fields. For example: {=Abs (%ry2) } is replaced by the absolute
(rectified) value of the final point of channel 2.

The difference between these types comes down to the list of functions that are recognised at the top level of
parsing. For example, C1 or Cursor (1) is allowed as an x-axis dialog expression, but not as a y-axis
expression. However, At (C1,1) is allowed as a y axis expression as the cursor 1 reference is in a context
where an x-axis value is required. Both x-axis and y-axis expressions can use any of the features of the non-
view based numeric expressions.

The dialog expression evaluator parses the . .. expression each time it is evaluated, which makes it slower than
% expressions. The {y. ..} can be slow to evaluate, especially if the measurement requires scanning a range of
data. Spike2 may disable an Info window if the evaluation takes a significant time as this might compromise
data acquisition.

Dialog expression can be combined with operators, for example:
{y abs (At (Cl,vl) - At(C2,v2))}

This computes the absolute value of the difference between the y values of the first virtual channel at cursor 1
and cursor 2.

You can enclose special fields introduced by % within curly brace special fields and these will be evaluated and
converted to text before passing the curly brace field contents to the dialog expression evaluator. If you do this,
you must consider the format you choose for the values. In a time view, x positions should be expressed to the
time resolution of the time window, which is typically or order 1 microsecond, so the default format (equivalent
to . 6f) is probably OK. In other view types, you only need enough x axis resolution to locate the data items, so
a lesser resolution may be suitable. The resolution for y positions can often be very different, and depends on
the channel and measurement type.

{= 1/%dx1}
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This calculates the reciprocal of the difference in x values of the last two points on channel 1.

Dialog expressions can be followed by a format specifier.

Errors

If we fail to parse a dialog expression, the output in the Info windows shows the Dialog expression that failed
and parsing stops after the failure. The effect of this is that as you type in a dialog expression, the output
displays what you type until you type the terminating } at which point the expression is passed to the dialog
expression evaluator. This will either succeed, in which case the result is the value, or it can fail and the output

displays:
{=?} The dialog expression evaluator could not evaluate the expression.
{time} The expression was evaluated, but took too long be allowed to run repeatedly. You can allow

it to run again with the context menu Deblock command or by changing the Info window
source text.

Info format dialog

This dialog opens from the >> button of the Info Settings dialog. It is | fo format %
used to build a format expression of the form:

Format Fixed v~ Sign Negativeonly
"<f|agS><WIdth><.preCISIOn><f0rmat>" Minimum Width  Default ~ Precision  Default ~
where all the fields in angle brackets are optional except the format. |[Jieftjustify  [zerofil [ 1Keep decimal point
This the Spike2 script language Result: "f" Example: 1.234560
Format expression are valid when they follow immediately after a % Help Cancel

expression or a {...} dialog expression field (with no spaces between
them) and they are syntactically correct. This dialog will not generate a bad format. The Result field displays
the output with the current settings. The Example field shows how the number 1.23456 would be displayed
with the current format. The OK button accepts the current state and inserts it, the Cancel button closes the
dialog and does not insert it.

If you do not supply a format, the default is equivalent to a format specifier of "f".

Format
This sets the <format> part of the format expression and is a choice of:

code Description

Engineering € The value is expressed as a number with one digit in the range 1-9 before the decimal
point followed by the number of decimal places set by the Precision field, followed
by an exponent, such as e+03, being the power of ten to multiply the result by to
obtain the value. Example: 1.234560e+00

Fixed f A fixed number of decimal places, set by the Precision field. Example: 1.234560

General g  Either the e format or the £ format, whichever is shorter. The Precision field sets the
number of significant digits. Trailing 0's after the decimal point are removed unless
the # flag (Keep trailing Zeros) option is used.

Sign
Negative values always start with a minus sign, but you have a choice of how we deal with positive numbers.
The choice you make here adds a <flags> field character unless you choose Negative only:
flag Prefix for positive numbers
Negative only = none None

Always +  Plus sign, for example +1.234560
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space or - space A space character. This is often used in Fixed format to align the decimal point for

columns of numbers.

Minimum width

This sets the optional <width> part of the format. The default state (with no <width> field) is to use the
minimum field width possible to satisfy the requirements of the other format fields, equivalent to setting a
minimum width of 0. If this field sets a width that is more than that required by the rest of the format, the output
is padded on the front (after any sign characters) with either space characters or 0's until the minimum width is
achieved. We allow you to set a minimum with of up to 20 characters.

Left justify (-)
Check this box to add a - to the <flags> field. This forces the output of the format, before any space or 0
padding, to be left justified in the width field.

Zero fill (0)
When the Minimum width exceeds the required space, the extra space on the left is usually filled with spaces.
Check this box to fill with Os (after any sign character). This adds a 0 to the <flags> field.

Keep decimal point/Keep trailing zeros (#)

The name of this check box changes according to the selected format. In e and f format it preserves the decimal
point, even when Precision is set to 0 (which normally removes it). In g format, it preserves trailing 0s. When
checked, this adds # to the <flags> field.

Info Image dialog

You can display an image on top of the Info window background, behind
the text that scales with the Info window. To make it easier to display text
over the image we allow you to change the image opacity with a slider.

Info window Image setup

X

‘ C:\Users\Greg\Documents\test.png

‘ Browse...

There is also a control to hide the image. The image can be positioned | opacity I [Hide
anywhere within the Info window and scales with it, so you may need t0 | ynage postion as percent of display area

add several new lines (\n) to the text window to make the output
rectangle have a reasonable aspect ratio.

Lt |0 T [0 |

Width | 100 | Height | 100 |

Dialog changes affect the display as you make them, so you can evaluate

the effect. Help Cancel
The script language equivalent of this dialog is the InfoImage ()

command.

Hide image

Check this box for no image display. When script-controlled, this can be useful to show an image on an error
condition.

Image file name and Browse...

You must select an image for display. The Browse... button opens a file selection dialog in which you can
select a suitable image. This causes an immediate Info window update. We support the common bitmap file
types: BMP, PNG, JPEG, and TIFF. If you edit the file name, the change happens when you click elsewhere in
the dialog.

Opacity

The image draws under the text and can make the text difficult to read. You can make the text more or less
transparent with the Opacity slider. Setting the slider control to the right sets an opaque image, moving it to the
left merges the image into the background colour and setting the slider to the left results in an invisible image.
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Image position

The values for the image left and top corners and for the width and height set the position of the image within
the background area of the info window. All of these values are a percentage of the information window height
and width, from 0.0 to 100.0.

OK and Cancel
The OK button accepts the current dialog state and closes the dialog. The Cancel button undoes all the changes
made by the dialog and closes it.

Info Speak dialog

Open the Info Speak dialog from the Info window SpeaKk... | nf speak settings %
context menu (right-click). This dialog configures the Info _

window to output the displayed text as speech (if supported by | 7= ©n change Kl S o)
your computer and sound card). You can choose when (and if) | ¥olume ¥ w0
to output the text, the minimum time gap between speech | Rate | 4

utterances and the volume and rate of the output. e o

The InfoSpeak () script command has the same capabilities
as this dialog.

Speak mode
You can choose one of the following settings from the drop-down list to choose when speech output should

occur:
Off Never. This is the default setting.

On change When the output text changes.

Continuous Start reading as soon as the previous output ends. Negative Silence values are treated as

0.

On change, repeat When the output changes, and repeat after the period of silence.

Silence

Left to itself, the Microsoft speech output engine inserts around 1 second of silence after each utterance with
the standard speech rate. This field lets you insert additional silence. When this field is set to a positive value,
we wait for the speech output engine to tell us that the previous speech output has ended (including the built-in
silence). We then insert the number of seconds of silence you have requested before looking for the next speech
trigger.

You can set this field to -1 to mean: do not wait for the previous utterance to end. For example, if you want a
10 second countdown to be spoken (set the output text to t, Update every to Second and Show time as to
Seconds in the Settings dialog) you will find that with Silence set to 0, the speech plus built in gap takes too
long to speak every number (10... 8... 6...). Set Speak mode to On change and Silence to -1 to achieve the
full count.

Note that in Continuous mode, negative values of Silence are treated as 0 (otherwise there is no output as the
speech is continuously restarted).

Rate

This slider controls the speed of the speech. The central position is the standard speed (0), fully to the right (10)
is approximately 4 times faster (just about understandable) and fully to the left (-10) is approximately 4 times
slower (painfully slow). The Rate also affects the duration of the gap between utterances. On my Windows 10
PC, a Rate of 4 allows a ten second count down to work with a Silence value of 0, rather than -1, which is
required for all Rate values less than 4.
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Volume

This slider controls the output volume. Fully to the right (100) sets the loudest output, fully to the left (0) is no
output. Of course, the actual volume will depend on your sound card (assuming you have one) and how it is
connected to the loudspeakers. Please consult the documentation for your computer to connect up your sound
card and to select a voice for speech.

XY Key Options

This command is for XY windows only and opens the XY Key options xy ey for XYPlot2(P3 B39 warmup) *
dialog. The command is available from the View menu and also by right-

clicking in the XY view or by double-clicking on the XY Key. The dialog Show key Key with border
has a check box that controls the automatic expansion of the axes when
new data is added. It also controls the XY window “key”. The key is a
small region to identify the data channels that you can drag around within = [/Do not show example channel data
the XY window. For each visible channel it display the channel name and r

draws the line and point style for the channel. Help Canesd

[]Key with transparent background

The key is intended for use with a relatively small number of channels.

Auto expand axis range

If this is checked, each time new data points are added to the XY view that lie outside the currently displayed
area, the axis ranges are changed to display all the data and the view is marked invalid so that it updates at the
next opportunity. The script language equivalent of this is XYDrawMode (-1, 5, autoExpand%) ;.

Show Key

Check this box to display the XY view key, clear it to hide the key. The script equivalent of this is the
ChanKey () command using flags% value of 1 to show the key. You can also control the key visibility with
XYKey ().

Key with border

Check the box to have a rectangular border drawn around the key, clear the box to remove the border. The
script equivalent of this is the ChanKey () command using £1ags$ value of 4 to show the border. You can also
control the border visibility with xYKey ().

Key with transparent background

Check this box to show the contents of the XY view through the key. Clear the box for an opaque background.
The script equivalent of this is the ChanKey () command using £1ags$% value of 2 to for a transparent key. You
can also control the key transparency with XYKey ().

Do not show example channel data

Check this box to remove the example data traces from the key. These examples are drawn to the right of the
channel titles and are usually needed to identify the traces. However, some users like to set descriptive text for
the entire view in the channel titles and do not want the example channel data. The script equivalent of this is
ChanKey (0, 1, 1) to hide the example channel data.
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Example XY view

This example XY view, (generated by the clock.s2s script in the Scripts
folder in the User data folder) shows the key. You can make the key visible by
opening the XY Options dialog as described above.

In this example, several channels use filled mode. The channel fill colour displays
below the line in the key. You can set the key background transparent or opaque
and choose to draw a border around the key. You can experiment with the XY
Draw Mode dialog to see the effect this has on the key.

If you move the mouse pointer over the key, the pointer changes to an open hand.
Hold down the mouse button and the pointer changes to a closed hand to show
that you can drag the key around the XY view.

Scripts\clock.s2s

XY Autoscale

This option is for XY views only and opens the XY view Autoscale dialog. aytoscale XYPlot2(P3 B39 warm... %
This dialog determines how the x and y axes of an XY view behave when _
new data points are added to the XY view. You can use this to have the XY | Basedon Al visible points %
view automatically track your data, displaying either all of it, or
concentrating on the most recently added points.

X axis Track data g

. . Y axis Track data &
There are two common methods used to add data points to XY views:

Automatic scaling happens when new

1. Using the Analysis menu Measurements->XY view command. data points are added to an XY view.
. . . . Processing to an XY view can also scale
2. Adding points using the script language. the display; do not use both options!

If you are adding data using the Measurements to XY view command, the

ass};ciated Procegss dialog has its own method for Optimising the axes, bk Cancel
which will take precedence over any automatic scaling you set in this

dialog. If you enable both methods, the Process dialog optimise will win, and the time spent calculating the
Autoscale will be wasted.

What does Autoscale do?

An XY view holds multiple channels of data. Each channel is a list of (x,y) data points that can be drawn in a
variety of ways. From the script language you can both add data to a channel and delete data points from a
channel. The Measurements to XY view process can also add (and remove) data points.

Each time data is added to an XY view from whatever source, Spike2 gives the XY view the opportunity to
rescale the x and y axes. This is done based on three screen rectangles that enclose:

3. all the visible data points (including those just added)
4. only the newly-added data points
5. The current visible drawing area

The settings you make in this dialog determine which rectangles are used and how they are used to rescale the x
and y axes (which can have different scaling modes).

The script equivalent of this dialog is XYDrawMode (-1, 5, autoScale%); you can record any changes you
make in this dialog as a script.

Based on
This field determines which set of data points are passed to the x and y axis optimise routines. You have the
following options:

No automatic scaling This turns off automatic scaling. The x and y axes are not changed by adding data
to the XY view.

New points + visible Y The screen rectangle used for optimising holds the full range of visible data points
in the y direction, but only the newly added points in the x direction.
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New points + visible X The screen rectangle used for optimising holds the full range of visible points in
the x direction, but only the newly added points in the y direction.

All visible points All the visible points in the XY view (added and existing points).
New points only Only the points that were added this time.

The most common settings will be No automatic scaling and All visible points. To use the other settings you
will usually have an axis setting that has a fixed size, or that has a minimum size.

X axis, Y axis
These two fields have identical options and determine how the x and y axes change using the x and y
dimensions of the rectangle generated by the Based on field. You can choose from:

Expand only If any point in the data passed is not visible, the axis range is increased so that it is
visible.
Track data The axis is set to display the entire range of the data selected by the Based on

field. If the range has no size (for example there is only one point), the axis scale
is unchanged and the axis is centred on the new point. You would normally use
this with All visible points mode.

Fixed size following data The length of the displayed axis is saved the very first time data is added and the
axis is kept at this length. The axis is shifted so that the mid point of the data
selected by Based on is in the middle of the axis. You can use this with the New
points options to track the most recently added data.

Track with zoom in limit  The length of the displayed axis is saved the very first time data is added. This
then behaves as the Track data option except that the range of the axis is not
allowed to be less than the saved size.

No automatic scaling The axis is not changed by the data.

Cancel and OK

Changes made in this dialog are applied immediately you make them so that you can see the result. If you use
the Cancel button, any changes made are removed. If you use OK and have made any change, the original state
is added to the Undo queue and if you are recording your actions, the changes are recorded.

Backwards compatibility

Up to Spike2 version 8.09b, the autoscale option was much simpler, being either off (equivalent to No
automatic scaling) or on (equivalent to the New points + visible Y and both axes set to Expand only). If the
resources of a previous data file are read, off works as you would expect and on is read as the exact equivalent.
If an old version of Spike2 reads the resources created by this version, it will treat anything being set as on,
otherwise as off.

Trigger/Overdraw

This View menu command is for time views only and opens a pop-up menu that leads to | Display Trigger...
commands for controlling triggered displays, display overdrawing and 3D (three dimensional) | —OverdrawList..

displays of sweeps of data identified by trigger events: O\’_erdraw ol

Display trigger This is the overall set up dialog for triggered and overdrawn displays. Overdrawn displays
use a stored list of trigger times.

Overdraw List A quick way to overdraw using an event channel as a source of multiple trigger times.

Overdraw 3D Controls how frames are shifted and scaled to give a 3D effect.

Clear List Empty the stored list of trigger times.
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Display Trigger

The display trigger is used with Time views to provide an
oscilloscope style trigger, paged display on-line, display
overdraw, a 3D display and a means of easily moving back and | Trigger channel Noeranrells et v
forward to the next or previous trigger both on-line and off-line. i ! )

The script language equivalent of this command is frs thuedepley ans Gocanal 101
ViewTrigger (). This dialog holds items that define how to | Minimum display hold (seconds) D
select the sections of data to display, what to do on each trigger

Display trigger Demo.smr[32-bit] X

Cursor zero action Move and iterate v
event and controls overdraw. i —
Hold off iteration (seconds) 0 ‘
Note that the width of each triggered section is controlled by the
g8 Y Enable trigger Zero x axis at trigger

standard view X Axis Range controls, you do not set it in this
dialog. When using this dialog, you will most likely want to | Overdraw (needs Enable trigger and Zero x axis)
enable the Width control and leave the Left and Right values

. . Maximum overdrawn frames (0=no Iimit)| 100
alone. Alternatively, use the Enlarge/Reduce View controls. -

Maximum Span in seconds (0=no limit) |0

Tn igge’j channel Colour of overdrawn data Fade to background ~
The Trigger channel field sets an event, Marker, WaveMark,
TextMark or RealMark channel to be used as the trigger. You
can select Paged display for a permanent trigger (for on-line :

paged displays rather than a scrolled display). This field can also | &P OPLst..| 3D... || Close
display No channel is selected if the overdraw trigger list

contains times from a mix of data channels.

Enable Overdraw Enable 3D display

Pre-trigger display time

The Pre-trigger display time field sets the time before the trigger to show each time a trigger occurs. This
dialog does not set the width of the time view; that is set by the normal time view mechanisms. If you set the
pre-trigger display time larger than the displayed time view width or negative, the trigger point will not be
visible. Negative pre-trigger times move the trigger point off the screen to the left of the display.

Minimum display hold time

The Minimum display hold field is used on-line and sets the minimum time that data is displayed after the
current time passes the right-hand edge of the screen. This allows you to see individual data frames with a high
frequency trigger. A value of 0 means wait until the current screen is displayed before looking for new triggers.

Cursor zero action
The Cursor zero action field has three setting that control what happens to cursor 0 and any active cursors that
depend on it when the view triggers:

No action Cursor 0 state is unchanged.
Move to trigger Cursor 0 moves to mark the trigger point, active cursors do not move.

Move and iterate  Cursor 0 moves to mark the trigger point, active cursors 1-9 move. The Hold off iteration
field is made visible.

Hold off iteration

This field appear when Cursor zero action is set to Move and iterate. It is used online and sets a time, in
seconds, to delay the active cursor iteration after the trigger. This allows you to search for data features after the
trigger point when sampling or rerunning (when data after the trigger has not yet been sampled).

Zero x axis at trigger

The Zero x axis at trigger check box changes the x axis so that 0 lies at the trigger time. This is purely a visual
convenience; all measurements are still in the original x axis units. You must check this box if you want to use
display overdraw or 3D display modes. Script users can find the current zero position with the
ViewTrigger (4) command.

Enable trigger

Check the Enable trigger check box and click OK/Apply to allow display triggering. Two extra E EI
buttons appear in the area to the left of the x axis scroll bar. These buttons can be used on-line and off-

line to move to the previous and next trigger. With Paged display set, they move by the time between the
trigger point and the right hand screen edge. If you use these buttons on-line to move to a trigger, this disables
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the automatic tracking of new triggers. You can re-enable automatic tracking by scrolling to the end of the view
or pressing the End key.

OD List... and 3D...
These buttons open the Overdraw list dialog and the Overdraw 3D dialogs.

Keyboard control
In addition to clicking the buttons, you can also step to the next and previous trigger point with the
Alt+Shift+Right and Alt+Shift+Left key combinations.

Overdraw
2 Stimuhs | S

._.
Sinewave
mV

10 -0.05 0.00 0.0 0.10 015 02
An example of overdrawn data

The overdraw section of the dialog is enabled when both Enable trigger and the Zero x axis at trigger are
checked. In overdraw mode, data sections identified by triggers are drawn over each other in time order, oldest
first up to the current time. We call each overdrawn section a frame. You can change the displayed time range
as normal, but trigger times are ignored if time before 0 or time after the end of the file would be displayed.
Each new trigger time is added to a list of previous times. If you step backwards, all trigger times after the time
you step to are forgotten. You can also add trigger times with the Overdraw List dialog. Accepting the dialog
settings with OK clears the list if the new settings are incompatible with the old settings (for example if the
channel is changed).

Overdraw is just a display mode. All measurements, cursor positions and the like behave as if the overdrawn
frames are not present.

Maximum overdraw frames

You can limit the number of overdrawn frames of data. Values up to 4000 are allowed, or 0 meaning no limit
on the number of frames. It takes time to draw each frame, and you will experience significant screen update
delays if you display huge numbers of overdrawn frames of data over long time periods. You can break out of
such long displays with the Ctr1+Break key combination. If you set a limit, this can be used in 3D mode to set
a z axis of constant length. We suggest that you set a limit to the number of frames, particularly for on-line use,
to limit the drawing time.

Maximum span in seconds

You can also limit the time range of the overdrawn frames with this field. Each time you add a trigger time, all
trigger times after the new time and any trigger time that is more than the Maximum span before are discarded.
You can set the value 0 for no time limit. If you set a limit, this can be used in 3D mode to set a z axis of
constant length.

Colour of overdrawn data
The last frame drawn (which corresponds with the current trigger time, that is the time for which the x axis is
showing 0) is always in the standard colour. You can choose how the remaining frames are drawn from:

No change Draw in the normal colours.

Half intensity A equal mix of the normal colour and the background colour.

Fade to background A gradual fade from the normal to the background colour. In 3D mode, the colour
depends on the z axis value, otherwise it depends on the frame number.

Fade to secondary A gradual fade from the normal to the secondary colour. If no secondary colour is set,
this is the same as Fade to background.
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Enable Overdraw

Check this box to enable overdraw mode. You must also have checked Enable trigger and Zero x axis at
trigger. Frames are added to the overdraw list by stepping to the next trigger event or with the Overdraw List
dialog or the ViewOverdraw () script command.

Enable 3D display

Instead of overdrawing the frames of data exactly on top of each other, you can choose to draw them offset both
vertically and horizontally to create a three-dimensional effect. Check this box to enable this drawing method.
The 3D drawing only occurs if you have also checked Enable trigger, Zero x axis at trigger and Enable
Overdraw. The screen arrangement of channels and frames in 3D drawing mode is controlled by the Overdraw
3D dialog.

On-line and Rerun use of triggered displays

When enabled, incoming trigger channel data is searched until a trigger is found when the display will hold with
the pre-trigger time shown before the trigger until another trigger occurs. The hold time will be at least as long
as the Minimum display hold field from the point where the display reaches the right-hand edge of the screen.
In Overdraw mode, the display hold time limits the number of frames that will be overdraw as if you trigger at
time ¢, the earliest time the next trigger will be used is: # + w - p + & where w is the screen width, p is the pre-
trigger time and / is the display hold time.

If you use the buttons at the bottom of the window to move to a previous trigger, automatic display updates on
new triggers are suspended to allow review of previous triggers. You can re-enable automatic trigger updates by
scrolling to the end of the time view. The easier way to scroll to the end is to use the End key.

With Paged display selected, sampling begins as normal, then each time the right-hand screen edge is reached
and the hold time has passed, a new sweep starts. The pre-trigger time sets the overlap between the sweeps. In
overdraw mode, each new sweep adds a new trigger time.

Overdraw List

In a time view you use this View menu command to add
a list of trigger times to a time view based on the settings
in the Display Trigger dialog. If the time view is not in | Event Channel 2 Stimulus (Event-) v | [Trigger...
overdraw mode, the dialog displays a warning message

Overdraw triggers for Demo.smr[32-bit] X

Start time ‘ 0.0 v ‘ seconds

and a button to open the Display Trigger dialog where 3D...
you can set overdraw mode. Dialog controls are: End time  MaxTime() + | seconds

91 triggers from 101.496710 to 119.324070 seconds
Event Channel Help Clear list Replace Add Close

An Event, Marker or Marker-derived channel in the time
view to use as a source of trigger times to add to the list held by the time view. You can also select No channel
to add trigger times by typing them in.

Start time, End time

The time range to search for events to add to the list. All events found in the time range are used as trigger
times. If you select No channel as the source, the End time field is hidden and the Start time field sets a
trigger time.

Clear list
Delete all the items in the list.

Replace

Click this button to clear any existing times from the list before adding new times. If the Event Channel is not
the same as the channel set in the Display Trigger dialog, the Display Trigger dialog channel is changed to
match.
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Add

Click this to add times identified by the channel and the time range to the list. Unlike manually adding times by
stepping to the next or previous event when the last added time causes all later times to be deleted, added times
are merged into the list in ascending time order. The current time display is set to be the last time in the list.

Trigger... and 3D...
These buttons open the Display trigger and Overdraw 3D dialogs.

Undo
Actions in this dialog are added to the Undo list of the view. To Undo changes made in this dialog, click in the
view and use Edit->Undo or ctrl+z.

Display Trigger dialog interaction

If you add events to the trigger list such that the event times come from a mix of channels (or if you add times
not associated with a channel using a script), the Display Trigger dialog channel will change to No channel is
set. If you replace events such that the trigger list holds times from a single channel, the Display Trigger dialog
will show that as the current channel.

Overdraw 3D

In a time view you use this View menu command to open the 3D dialog to
control the 3D drawing effect. The script language equivalent is
ViewOverdraw3D (). This dialog does not enable 3D drawing; use the | X axis space for 3D effect
Display Trigger dialog to do that.

3D for Demo.smrx X

E

A Rf (L] Rl el €]

wul
o

Y axis space for 3D effect

To create the 3D effect, each frame is drawn inside a rectangle and the
position and size of the rectangle depends on a notional z axis. The z axis
is based on the frame number or the trigger time of the frame. The z axis | Perspective Y size ‘ 50
can be set to a constant frame count or time range, or it can vary
depending on the current list of frames to display.

Perspective X size 0

o

Z axis is scaled by the frame Number
In example, below, there are three frames of data. The Front rectangle, ] Display fixed frame count/time range
used for the most recent trigger (the trigger with the maximum time), is | [] Automatic display update on any change

always positioned at the bottom left of the channel area.
Help Close
The front rectangle always

holds the x and y axes (if they are displayed).

Y axis

SRR B Y N Rfﬁ‘r rwf\:gle The Rear rectangle, used for the oldest trigger time (trigger with
"-,‘ / \\ .I.f b I,.-’ W | I,f ' the minimum time), is always positioned at the top right of the
. Wt Ngp N W A channel area. The middle frame (and all other displayed frames)
B also has a rectangle that is calculated by a linear interpolation
between the front and rear rectangles based on the z axis

¢ position of the frame.
% Front rectangle «%» When this dialog is open, the top and right edges of the Front
o Oll] nrrerr 0'2 T 0'4 Y rectangle and the left and bottom edges of the Rear rectangle are

3D drawing rectangles drawn and can be clicked on and dragged with the mouse.

The dialog fields control the positioning of the front and rear rectangles:

X axis space for 3D effect

This field sets the percentage of the width of the channel area to use for the 3D effect. The larger the value, the
smaller the width of the front rectangle. Set this and the Perspective X size fields to 0 to make all frames draw
vertically aligned.

Y axis space for 3D effect

This field sets the percentage of the entire view vertical space to share between all the channels to generate the
3D effect. All channels are given exactly the same space so that the 3D effect is the same for all channels. The
larger the value, the smaller the height of the front rectangle.
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Perspective X size
This sets the width of the rear rectangle as a percentage of the width of the front rectangle in the range 0 to 100.
Setting a value less than 100 gives a perspective effect.

Perspective Y size
This sets the height of the rear rectangle as a percentage of the height of the front rectangle in the range 0 to
100. Setting a value less than 100 gives a perspective effect.

Z axis is scaled by the frame...
The position of each frame of data (between the Front rectangle and the Rear rectangle) can be set either by the
frame number (giving equally spaced frames), or by the frame trigger times. Choose from Number or Time.

Display fixed frame count/time range

If you check this field and you have a set a maximum number of overdrawn frames (for z axis scaled by
Number) or a maximum time span (for z axis scaled by Time) in the Display Trigger dialog, the z axis will be
of a fixed size. If you do not check this box, or there is no maximum number of frames or the time range set, the
length of the z axis is taken from the number of frames in the list or the time span of frames in the list.

Automatic display update on any change

If you check this box, any change made to the dialog will cause the display to update. If your display does not
take long to update you probably want to check the box, but if you have a lot of data to draw you may prefer to
update with the Apply button. If this box is checked, dragging the Front or Rear rectangles will repaint the view
data during the drag, otherwise the repaint will wait until you release the mouse button.

Apply
This button is enabled when Automatic display update has been disabled and the dialog state differs from the
view state.

Undo
Actions in this dialog are added to the Undo list of the view. To Undo changes made in this dialog, click in the
view and use Edit->Undo or ctr1+z.

Notes

The 3D display mode behaves in exactly the same way as the Overdraw mode except that the overdrawn
frames are offset and scaled. There is one other difference; if there are no frame trigger times in the list, then
nothing is displayed. There is no restriction on the drawing modes you can use (other than your own common
sense). Overdraw WaveMark and Sonogram modes are unlikely to be useful.

The 3D display mode makes no difference to any measurements you may make. There is still a current time
range that is displayed (this corresponds to the frame of data that is at the front of the display).

Clear List

This command from the View menu Overdraw/Trigger pop-up menu removes all stored times from the list
used for overdrawing.

Time view overdraw details

Each time view maintains a list of overdraw times. The list of times is always held in sorted time order with the
smallest time first and the largest time last. There are no duplicated items. The size of the list can be limited to a
maximum number of items and to a maximum time span between the first and the last item. If you do not limit
the size or time range and the list becomes very long, it can take a long time to draw the data. You can break
out of drawing with the Ctr1+Break keyboard command.
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Adding items to the list
Items can only be added to the list when the time view is in overdraw mode. There are two modes used when
adding times:

Normal This is the mode used when you step interactively between trigger times using the keyboard
commands Alt+Shift+Left/Right or use the trigger step buttons at the bottom of the time view.
The new time is added to the list (if it is not already present), and all later times in the list are deleted.
The added time becomes the current time, the x axis is set to display 0.0 at this time and the display
is updated to show the pre-trigger time before the new event. If there is a time range set or the list is
full, the first (the oldest) time in the list is deleted to make room for the new event.

Merge This is the mode used when you use the Overdraw List menu command to add a list of times from
an event channel. New times are merged into the list in time order. If a time range is set and the new
time causes other times to be out of the time range or if the list is full, the event in the list furthest
away in time from the new time is deleted to make room. The last item in the list sets the current time
for drawing as described for Normal mode.

Users of the script language ViewOverlay () command can choose the mode to add times.

Source channel changes

Normally, the trigger times are taken from a single channel. If this is the case, the commands to step to the next
and previous event (Alt+Shift+Left/Right) work as normal; each step adds the time of the event to the list
as described for Normal mode. However, if you add events to the overdraw list from a mix of channels, or use
the script language to add a list of times (so there is no channel), these commands step backwards and forwards
through the times in the list without adding or deleting any times and any previously set channel is ignored. The
ViewTrigger (-1) command returns -1 if there is a list, but no channel.

Channel Draw Mode

This menu item is available when the current window holds a Spike2 data document or result view and sets the
data channels display mode. You can set the mode for a single channel, all channels, or selected channels. The
dialog changes, depending on the channel type and display mode. The Draw button is common to all modes
and updates the display without closing the dialog box.

There are different controls for Time views, Result views and XY views.

Time view drawing modes

The top line of the dialog is always the same and holds | @i praw mode Demo.smrx _ x
controls to select the channel and the drawing mode to apply.

You can select multiple channels by typing in a channel list, ! 6 Comments (TedMark) - | State ul [t
selecting All channels or by selecting channels in the time 55""‘” eace Draw
Show text

view and choosing Selected. If you select multiple channels,
the displayed settings are from the first channel in the list.

Marker 0 ~ | []Hexonly

The Close button shuts the dialog without making any change, Draw applies the current settings and leaves the
dialog open. OK accepts the current settings and closes the dialog. The remaining controls vary with both the
channel type and the drawing mode.

Edges

In some modes the Edges field appears if you choose a channel of event level data. You can =
select Rising, Falling or Both edges of the data. If you select both edges, then the display s
modes that show frequency count both the rising and falling edges of the event signal in their —Fallinﬁ r-
rate calculations. You would normally count only one edge, so select the edge you prefer. Pl .|

For Marker, RealMark, TextMark and WaveMark channels, the Marker and Hex only fields may appear.
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Marker

The Marker button/field appears if the marker code is displayed or sets the colour of Marker 0 ~ | []Hex only
the displayed items. Normally the first code (0) is used, but you can choose any of the

four codes. If you select a code other than 0, the channel number field turns red as a warning of a non-standard
display mode. Click the Marker button to open the Marker Filter dialog.

Hex only

The Hex only field appears if the marker code is displayed. Check the box to display all codes as two
hexadecimal digits, unchecked to display codes 0x20 to Ox7e as single characters (the ASCII character with
that code). The View menu Standard Display command sets Marker code 0 and the appropriate Hex only
setting for the channel type. If this is a TextMark channel, this setting also applies to the Edit TextMark dialog.

Dot size

Dotsize |3 ~| If the display will show the data as dots, the Dot size field appears and you can set any dot size
from O (the smallest mark possible) to 1 to 9 times the thickness of the lines set for drawing data
in the Display tab of the Edit menu Preferences. If you set a size to match or exceed the Round dot
minimum size field in Edit menu Preferences, the dots will be drawn as circles. Round dots take longer to

draw that square dots.

Data index

This field appears for RealMark channels to set which of the data items to display. This is a 0-based index to
the item. The script language equivalent of this field is the ChanIndex () command. You can set separate
channel titles and channel units for each data index in the Channel Information dialog. You can also set the
Default channel title and units for all data indexes that do not have specific titles and/or units set.

Decoration
The Decoration button appears for RealMark data drawn as a waveform. Click the Decoration button to open
the Channel Decoration dialog.

Dots and Lines mode

B ' Draw mode Demo.smrx = X
I “H I I“ I : H : “I H I ” Channel | 3 Events (Event-) ~ | Dots 2 Close
| 71— T ETEnenes Dotsize |3 || Draw

rrrrrrre prrrrrrees | M B R prrrrrrres | REREAER | R

1] 0,03 0.0 0.15 0. 2o 0,25
The simplest event channel draw method is dots. You can choose large or small dots (small dots can be very
difficult to see). You can also select Lines in place of Dots. The picture shows the result of both types of

display on an event channel. The dots are drawn in the Application colour set for Events as dots or in the
channel Primary colour if it is set.

Marker channels displayed as dots also show the currently selected marker code. In this case the dots or lines
are drawn in the Application colour set for Markers or overridden with the channel Primary colour. The text is
drawn in the Application Marker colour or overridden with the channel Secondary colour.

If you select lines for a marker channel, the display of marker codes is suppressed. In Lines mode you have the
option to draw a central horizontal line with the Centre line check box. The line colour can be overridden with
the channel Secondary colour.

You can also select Dots mode for a waveform channel.
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Mean frequency

100 ¥ ' Draw mode Demo.smrx = X
[ Channel ‘ 3 Events (Event-) v \ Mean Frq ¥ Close
20 Time width \Z/ seconds Draw
23 ["]Per minute

0 | R, S e L P O L N T 0 T Y P s I e T [

1] 20 40 a0

The mean frequency is calculated at each event by counting the number of events in the previous period set by
Time width. The result is measured in units of events per second with channel units of Hz unless the Per
minute box is checked for events per minute (which changes the channel units to BPM). The mean frequency
at the current event time is given by:

(n-1)/(te-t]) if (te-t1) > th/2

n/tb if (te-t1) <= tb/2

where:

th is the bin size set, te is the time of the current event, ¢/ time of the first event in the time range and # is the
events in the time range

A constant input event rate produces a constant output until there are less than two events per time period. You
should set a time period that would normally hold several events.

Instantaneous frequency

3000 ® ' Draw mode Demo.smrx = X
2000 Channel ‘ 3 Events (Event-) ~ | |Inst Frq 4 Close
| oo o Dotsize 0 v Draw
: ] Per minute As[Dots  ~
a

&0

Instantaneous frequency is the inverse of the time interval between an event and the previous one on the same
channel. Check the Per minute box for a rate per minute rather than per second. You can display the result as
Dots, Line (linking the dots) or Skyline (horizontal lines between dots). In Dots mode you can choose the dot
size. You can display the frequency as events per minute rather than per second.

40

Interval
1.0 B ! Draw mode Demo.smrx = X
05 i Channel | 2 Stimulus (Event-) ~ | |Interval ¥ Close
v Dotsize 0 v Draw
0.0 | LI N B I RN B S I LI N B I RN B S I Tl Il lIrnrro.r I T AS Def |t .
0 20 40 60 i

This mode draws the time interval between an event and the previous one on the same channel. The interval is
measured in seconds. If you are dealing in short intervals, set the Y axis for the channel to display the units in
ST units or factors of 1000. You can display the result as Dots, Line (linking the dots) or Skyline (horizontal
lines between dots). In Dots mode you can choose the dot size. This mode was added at version [10.05].

The DrawMode () script command mode value is 17.
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Rate histograms

100 B ' Draw mode Demo.smrx = X
79 Channel | 3 Events (Event) v | [Rate v | Close
a0 Time width D seconds Draw
-

1] 3 10 15 20 25

Rate mode counts how many events fall in each time period set by the Time width field, and displays the result
as a histogram. The result is not divided by the bin width. This form of display is especially useful when the
event rate before an operation is to be compared with the event rate afterwards.

Raster display
1.00 B ' Draw mode Demo.smrx = X
.73 : ! ! . ;hannel‘ 7 nw-1 (WaveMark) v \ Raster ¥ Close
g.s0 I : i i : s Trigger | 2 Stimulus |8 Dotsize 0 ~ Draw
B ; ' ’ L Marker 0 v
N o o
a 2 4 f

Raster mode shows the event positions relative to trigger times. Each trigger event defines time 0 in the y
direction for the sweep. The Y Range dialog sets the time range to display in the y direction; negative times
show pre-trigger events. For each trigger, events are drawn no further back in time than the previous trigger and
no further forward in time than the next. The trigger events are also drawn at y axis time 0.

If the channel is marker-based, events are drawn in the colours set for the selected WaveMark code otherwise
they are drawn in the channel primary colour. The trigger events are drawn in the channel secondary colour.

0.5
® ' Draw mode Demo.smrx = X
0.0 = - === | Channel | m1 Spikes (WaveMark) - | |Overdraw WM~ Close
Dot size 3 v
05 D Draw
Marker 0 ~ As Dots -~ OK
O e -

1] 3 1 15 20 25

Overdraw WaveMark mode draws WaveMark data as superimposed waveforms. Channels drawn in this mode
are moved to the top of the window and separated from the x axis (which does not apply to them) by a hatched
bar. If this mode is used during data capture and the screen is scrolling to show the latest data, new WaveMark
events are added, but old events are not erased (to stop the display flickering). Click on the x axis scrollbar
thumb to force an update.

As and Dot size
From version [10.05] you can draw WaveMark data in Dots mode. Setting any mode other than Dots draws the

data as a cubic spline.

Find with cursor 0

To locate an event, right-click on its waveform at a point where it is clear of all other waveforms and select
Find with cursor 0 in the pop-up menu. This locates the event nearest to the clicked position and moves cursor
0 to it. If the Edit WaveMark dialog is open, this will display the event. Any active cursors will iterate.
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Set WaveMark codes

Hold down A1t+Ctrl and click and drag a line over the events you want to identify. Once you have started to
drag you can release the Alt+Ctrl keys. If you continue to drag and hold down the shift key, the line is
constrained to be horizontal. On mouse up, a dialog opens in which you can set codes for the intersected events.
If the channel has multiple traces the line must only extend over a single trace. This also works when the spikes
are drawn in Waveform and WaveMark drawing modes.

Sonogram display
50

|IIII|IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII‘I.IIIIII
0 5 10 15 20 25 30 3 40 45 50 5% 60 65

Sonogram mode shows how the frequency content of a waveform channel changes with time. The y axis units
are Hz (frequency) and useful results are available for the frequency range 0 to one half of the sampling rate for
the waveform channel. You can control the colour scale used for the sonogram and display a key to indicate
how the colours map to intensity.

B ' Draw mode Demo.smrx = X
Channel ‘ 1 Sinewave (Waveform) ‘ Sonogram 2 Close
Top dB EI x Pixel inc E Window Hanning ¥ Draw
Range dB E‘ [Iskip FFT Block size 256 ~

By default, intensity of the frequency content is indicated by a grey scale, the darker the image, the more
intense the signal. However, you can choose a colour scale, or create your own scale in the Edit menu
Preferences Display tab. You can set:

Top dB The signal intensity that maps to the top of the sonogram colour scale. dB means decibels, which
is a logarithmic measure of ratio, usually of amplitudes or power. 20 dB is a factor of 10 in
amplitude. Spike2 stores waveform data as 16-bit integers, and we measure the amplitude with
respect to 1 bit, so 96 dB is the maximum possible level. For RealWave channels, (stored as 32-
bit floating point values) the range is much greater, but the 0 dB is still taken as the value that
corresponds to 1-bit if the data were converted to 16-bit integer using the current scale factor.
That is the 0 dB level is scale/6553. 6 where scale is the channel scale factor.

If you display the sonogram key you can choose the signal amplitude that is drawn as 0 dB in the
key. This is purely a convenience for interpreting the data and has no effect on how colours map
to the intensity of the signals.

8-42



View menu

Range dB The range of data to display as a colour map. Signals with an intensity of Top dB - Range dB
(or less) are displayed as the colour at the bottom of the sonogram colour scale. If you are unsure
what dB values to set for a new signal, setting values of 96 dB for both Top dB and Range dB
will display something in almost all cases!

You can be caught out with RealWave data channels. If you are not getting sensible results,
double click on the channel y axis to open the Channel information dialog, then click the Rescale
button. This will set an appropriate channel scale factor for almost any channel.

x Pixel inc  You can speed up drawing, at the expense of resolution, by setting this field to values greater than
1. It sets the number of screen pixels in the x direction to calculate at a time. A value of 1 gives
the best visual resolution (and the slowest calculation and drawing time).

Window The sonogram is calculated using a Fast Fourier Transform (FFT). As explained in the analysis
section for the Power spectrum, it is important to apply a “data window” to the signal before
taking the power spectrum, otherwise the results are difficult to interpret. We provide several
different types of window: None, Hamming, Hanning, Kaiser 30dB, Kaiser 40dB, Kaiser
50dB, Kaiser 60dB, Kaiser 70dB, Kaiser 80dB and Kaiser 90dB.

All windows are a compromise between increasing the apparent width of a spectral peak and the
ability to see small signal peaks in the presence of large ones. If you apply no window, you will
get the sharpest resolution of a single peak. However, you will not be able to see any small peaks
around it due to the “side lobes” of the window. If you are not familiar with the use of windows,
the Hanning window is a reasonable compromise. The Kaiser xxdB family of windows has the
property that the largest side lobe is xx dB below the peak. Of course, the larger the xx dB, the
wider the peaks become.

Special calculations are done where there are discontinuities (gaps) in the data and at these points
we ignore the selected window to reduce the computational effort. This effect persists up to half
the FFT block size around each discontinuity.

Block size This determines the number of data points used in the FFT, and thereby it determines the
frequency resolution (y axis) and time resolution (x axis). Like the choice of data windows, this is
also a compromise. The larger the block size, the better the frequency resolution, but the worse
the time resolution. If you are looking for a short, localised burst of changing frequency, you will
need to use a block size that is smaller than the duration of the episode you are looking for.
Alternatively, you could consider the Continuous Wavelet Transform, available through the
ArrCWT () script command.

Skip If you are analysing a lot of data, there can be many thousand data points for each screen pixel. If
you check this box, the sonogram will only analyse the first Block size points for each pixel
(normally the sonogram analyses all the points). This can save time if you have a really large file.
Of course, the result will only represent a “sampling” of the correct response.

You can export Sonograms as enhanced metafiles and as bitmaps. Printing is supported to Postscript
compatible printers. With other printer types, the intensity scale output may be quite coarse. You may obtain
better output by saving the sonogram as a bitmap and printing from specialist bitmap editing programs.

Sonogram key

To display the sonogram key, right-click on a channel displayed in sonogram mode and select Show Key from
the context menu. The key is a rectangular window that can be dragged around the time view. It holds a colour
bar with an axis, mapping the colours in the sonogram display to dB. Interactive key actions are both recordable
and can be undone with ctr1+7. The key can be controlled from a script with ChanKey ().

Key position

The key is normally positioned on top of the channel that it relates to, but you can drag it wherever you like in
the data area of the time view. When dragging the key, you will notice that if you drag it out of the channel
rectangle, it is slightly "sticky" at the upper and lowed edges of the channel rectangle. This is to let you align it
more easily with the top or bottom of the channel.

The key position is remembered either relative to the channel rectangle, or relative to the view data area. Which
it is relative to determines how the key positions itself if the view is resized or the number of displayed channels
changes. Normally, if you drag the key so the top left corner lies within the channel rectangle, the position is
remembered relative to the channel, otherwise it is relative to the view. If you hold down the ctrl key and
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drag, there is no "stickiness" when you cross a channel edge. If the ctrl key is down when you release the
mouse button, this reverses what the position is relative to.

Context menu
If you right-click on the key a context menu appears with several key-specific options.

Sonogram colours
Opens the Colour scale dialog. Currently all sonograms share the same colour scale.

Set dB offset
This opens a dialog that lets you set the signal value that is used as the 0 dB reference level for the axis.

Rotate Key
The sonogram key can be displayed with a horizontal or a vertically axis. This context menu command switches
between the two possible states.

View background
The key can be displayed with the background set to the sonogram colour for the lowest intensity signal, or you
can select this option to set the background to the background colour set for the data view.

Mirror axis
When the key is vertical, the axis is usually displayed on side that is closer to the edge of the window. This
option displays it on the side nearer to the centre of the window. This has no effect for a horizontal key.

Hide Sonogram Key
This removes the key from the display. You can restore the key with all its settings unchanged by using the
channel Show Key context menu command.

Draw Border
Check this option for a rectangular border.

Default position
Moves the key to align with the top-right of the channel rectangle.

Sonogram key dB offset

This dialog lets you set the 0 dB reference point for the axis in the sonogram key. It has no effect on how the
sonogram data is displayed (this is determined by the Draw Mode dialog).

When you display the sonogram key, the axis is graduated in dB, and you will probably find that the 0 dB level
is somewhat arbitrary (being relative to 1-bit of the equivalent 16-bit waveform). This is especially the case if
your source data is a RealWave where the concept of 1 bit does not apply (but see below). This dialog allows
you to choose a reference level in terms of the channel data. For example, if your data is calibrated in Volts,
you may want the 0 dB point to be referenced to 1 Volt rather than 1 bit. To do this, just type in 1 in the edit
box and hit OK.

To set the key back to reference 1 bit you can type 0 in the edit box and click OK or click the Reset button,
which resets the scale and closes the dialog.

Sonogram details

This section contains more technical information about the sonogram and how it is implemented.

Db scale

Sonograms show a representation of the power in a signal using a map of colour to intensity. The dB (decibel)
scale is used for this purpose. This scale describes a quantity (in our case power) with respect to a reference
value. It is calculated as:

dB = 20*log(a/Ar)
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where log(x) means log to the base 10 of x, A is the amplitude of a quantity and Ar is the reference amplitude.
An alternative representation is:

dB = 10*Log(p/Pr)

where P is a power and Pr is a reference power. As power is proportional to amplitude squared, it is easy to see
that these definitions are equivalent.

The 1-bit reference

Spike2 originally supported 16-bit integer waveform data only (in the range -32768 to 32767). Scale and offset
values convert the integer data into user values. The sonogram was set, by default, to display data with respect
to an amplitude of 1 data bit. Unless you use the Draw Mode dialog to adjust things, the top of the scale is
mapped to 96 dB (relative to 1 bit) and the range of the display is set to 96 dB. With 16-bit integer input the
maximum input amplitude for an unclipped signal relative to 1 bit is 90.3 dB (20*1og (32768)). If there is
random noise present, you can visualise amplitudes smaller than 1 bit, but for most purposes, the default
settings span the useful 16-bit waveform range. However, then we added RealWave data channels.

RealWave data

RealWave channels store data as 32-bit floating point. These channels have a scale and offset value that is used
(when required) to convert the data to integer values. Thus, there is still the concept of 1-bit of integer data, and
this is used as the reference. However, if the scale value is poorly chosen, (either far too big or far too small),
the sonogram display will not be useful (all the data at the same end of the colour range). To set an appropriate
scale value, open the Channel Information dialog for the RealWave channel and click Rescale. This adjusts the
scaling so that the data maps reasonably into integer range.

Top db and range

In most cases, the useful dynamic range of the signal (the ratio between the largest and smallest data) is less
than 96 dB and you may prefer to have a smaller range displayed in the sonogram. You will probably want to
set the Top dB field so that the biggest signal in your data is represented. For a waveform channel (or a
RealWave channel after a Rescale), a top level of 91 dB is probably sufficient for all cases; a smaller value may
be appropriate if the data does not reach full scale.

The bottom end of the displayed dB range is determined by Top db - Range dB. The smaller you set the
range, the more detail you will see, but signals below the bottom of the range will all be off the bottom of the
scale.

Waveform SkyLine WaveMark and Cubic spline

These modes apply to waveform, RealMark and WaveMark channels. Waveform mode joins the data points
with straight lines. Skyline joints points with horizontal and vertical lines (not WaveMark channels). Cubic
spline mode joins the points with smooth cubic curves based on the assumption that the first and second
derivatives of the data are continuous at the data points. Cubic spline mode becomes waveform mode in
Windows metafile output (use enhanced metafile format to preserve cubic splines).

WaveMark is for WaveMark channels only and is the same as waveform mode but also draws the selected
marker code. The marker code is drawn in the Application Marker colour and overridden with the channel
Secondary colour. Both Waveform and WaveMark modes can now use the As field to draw the spike shape
waveform as dots.

Extra fields for RealMark and WaveMark channels in Waveform mode

RealMark channels have extra fields in Waveform mode. A | 57 praw mode Demo.smrx _ %

RealMark channel can have multiple data values attached to

each point; Data Index selects the value to display (indices

start at 0). The As field specifies how to connect the waveform Data Index ‘T = Dotsize 3 1 v | Draw
oints. If Dots is selected, the Dot size field can be used; the ;

gots are drawn in the colour set for the selected Marker code. Cocoration| [Merkerp > holbee =

From [11.00] you can override this by setting the channel Primary colour. The other As options are Line,

Default (same as Line) and Skyline (which is the same as selecting Skyline as the draw mode).

Channel ‘ 5 02 (RealMark) v ‘ Waveform ¥ Close

The Decoration button opens the Channel Decoration dialog for the display of error bars and low and high
ranges. WaveMark channels treat all As modes other than Dots as line mode.
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Single trace

With a WaveMark channel that has multiple traces, an extra check box, Single trace, appears for Waveform,
Cubic Spline and WaveMark modes. Check this to display only a single trace, which will be the one set in the
Marker Filter dialog (click Marker to open it) or by the MarkTrace () script command. This can be useful
when you want to use the Ctrl+Alt+mouse drag method to intersect a line with spike traces to set marker
codes.

Set WaveMark codes

If the channel holds WaveMark data you can identify events that cross a line. Hold down a1t+Ctr1 and click
and drag a line over the events you want to identify. Once you have started to drag you can release the
Alt+ctrl keys. If you continue to drag and hold down the shi ft key, the line is constrained to be horizontal.
On mouse up, a dialog opens in which you can set codes for the intersected events. If the channel has multiple
traces the line must only extend over a single trace.

How we draw waveforms quickly

We will sometimes ignore the drawing mode you have chosen to speed up the drawing process. If the ratio of
waveform data points to screen (or printer) pixels in the x (horizontal) direction exceeds 2.1, instead of drawing
every single data point, we draw vertical lines that span the range of the data points. In most cases, this will
make no discernible difference, apart from speeding up drawing. If you notice a sudden slowing of drawing
when reducing the displayed x range, the reason is likely to be that you have just crossed from drawing vertical
lines to drawing every data point.

If you are drawing in cubic spline mode, this change may make the data look smaller in the vertical direction.

We also apply this optimisation when drawing waveforms as dots when there are 20 or more dots per screen
pixel.

State

—

® ' Draw mode Demo.smrx = X

. | Channel | 6 Comments (TextMark) - | State 52 Close

02 ar ] [ Show cod
Both m@jﬂ 04 code 05 (i3l m:@@ . Sh:x tme R
TT T 7T TT I—I—l_l_l_l_l_l_l_l_l—l—l_l_l_l_l_l_l_l_l—l—l_l_l_l_l_l_l_l_l—l— 1<
lﬂ 15 20 25 Marker 0 v [JHexonly

This drawing mode can be applied to a marker, TextMark, RealMark or WaveMark channel. The state is set by
the selected marker code and persists u